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Sugar Ultimate 10.0 Application Guide
The Sugar Application Guide introduces you to some basic CRM concepts and
helps you get familiar with the Sugar system. It describes how to access Sugar
through a personal computer and a web browser. It also describes how to perform
a broad range of customer relationship management tasks and related
administration tasks.

Last Modified: 2020-02-04 00:12:57

Introduction

Overview

Welcome to Sugar - a commercial Customer Relationship Management (CRM)
application. Strong relationships are at the core of every organization's success.
Sugar brings ease and order to the creation, development, and maintenance of
your organization's important relationships.

Sugar consists of interrelated records in modules such as Accounts, Contacts,
Opportunities, Cases, Meetings, Emails, etc. and wraps your data in an intuitive
user interface which helps make sense of these different elements of your
business. Whatever your organization's focus - sales, marketing, support, or other
ventures - Sugar's flexible modules bend to align with your business' models and
practices. Manage your relationships from inception to fruition and beyond with
Sugar's built-in modules and relationships as well as your custom modules and
configurations available to Sugar administrators.

Core Features

Sales Force Automation

Target, Lead, and Contact management to direct and organize efforts
throughout the sales life cycle
Account management to aggregate interactions with organizations and
individuals
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Opportunity management to pursue new business, share sales information,
and track deal progress
Sales Forecasting to enable sales representatives and managers to
understand upcoming business
Quote management to prepare potential sale figures including multiple line
items, currencies, and tax codes
Quoted Line Item management to capture the details of your organization's
goods and services

Marketing Tools

Target, Lead, and Contact management to support the creation of new
relationships
Email marketing campaigns to present relevant email messages to groups
of recipients
Campaign management and reporting for tracking campaigns across
multiple channels and analyzing the effectiveness of marketing activities
Target List management to organize groups of recipients for ensuring
campaign message relevance
Web-to-Lead Forms to capture lead information directly from external web
input

Customer Support

Case management to track service and resolution of customer issues
Bug tracking to identify, prioritize, and resolve product issues
Contact and Account management to track support history and enable
continuity of service
Sugar Portal to provide clients with self-service capabilities support
activities
Knowledge Base to manage information and share it externally

Record Keeping

Email, Task, Call, and Meeting management to facilitate day-to-day work
Note management to affix information and file attachments to other Sugar
modules
Document management to track living documents and their changes
Contract management to capture and maintain sales and service contracts
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Search capabilities to quickly and easily locate your data

Collaboration

Shared Email and Calendar to provide visibility across individuals and
teams
Connectors and tools to leverage third-party information regarding your
prospects and clients

Reporting

Report creation and management to gain insight into your organization's
Sugar data
Home page dashlets to display important tables and reports

Last Modified: 2020-03-10 23:59:38

Getting Started

Overview

Sugar offers users a wide range of configuration options when getting started with
the application. Your first time logging into Sugar the New User Wizard will step
through configuring some basic settings (i.e. Your Information, Your Locale). You
may skip these steps and configure these settings in your user preferences at a
later time. Please note that system administrators can also set up each user's basic
settings when creating the user in Sugar. This documentation will cover the
various options (e.g. New User Wizard, User Preferences) available when first
getting started with Sugar and accessing your account.

Note: For instances that use SugarIdentity, certain configuration options (e.g.
editing certain user fields, changing passwords) will not be available. These
differences are covered in the following sections. 

Accessing Sugar
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Prerequisites

The following will need to be installed and configured on your local machine prior
to accessing Sugar:

A supported web browser application (e.g. Chrome, Firefox) is required on
your local machine. For more information on the various supported web
browsers, please refer to the Supported Platforms page.
The web browser must have JavaScript and cookie support enabled in order
to access Sugar.
Network access to a server running your Sugar instance is required.

Logging In

Use the following steps to log in to your Sugar instance:

Note: The following steps pertain to instances that do not use SugarIdentity as
well as instances that use SugarIdentity. 

1. Enter your Sugar instance URL (e.g., https://example.sugarondemand.com)
in your web browser to access Sugar's login screen.

2. Enter your Sugar login credentials (User Name and Password) on the login
screen then click "Log In".

If you do not know your instance URL or login credentials, please
reach out to your system administrator for assistance.
If your Sugar instance is configured for single sign-on (SSO) (e.g.,
SAML), then the login screen will display a separate login button
where you will enter your identity provider (e.g., Okta) login
credentials to be authenticated and automatically logged in to your
Sugar account.

3. The New User Wizard will launch upon your first successful login to Sugar
allowing you to configure some of your basic personal settings.
Note: For instances that use SugarIdentity, the User Profile step of the
User Wizard is read-only and the displayed fields (e.g., First Name, Last
Name) will not be editable in your user profile as they can only be edited by

                        36 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Password_Management#SAML


 

administrators in SugarIdentity via the SugarCloud Settings console.

Note: If your instance has more active users than is allowed by your Sugar license,
regular users will not be able to log in and a warning will be displayed on the
screen once the user attempts to log in. Admin users will be able to log in but will
be redirected to the Users module. For more information, see the Understanding
User Types, License Types, and Sugar Licenses article.

Resetting Your Password

There may be occasions when users forget their Sugar password and will need to
reset it. If the system administrator has enabled the Forgot Password feature via
Admin > Password Management, users will have the option to request a password
reset directly from Sugar's login screen. If you do not see the "Forgot Password?"
link on your login screen, please reach out to your system administrator for further
assistance.

System administrators can either enable the Forgot Password feature, send a
system-generated password to the user, or manually change the user's password
via Admin > User Management. For more information on how to set up and
manage passwords in Sugar, refer to the Password Management documentation.
Please note that the outbound mail server for the system must be configured via
Admin > Email Settings and users will also need to have their personal email
settings configured in their user preferences in order for the temporary password
information to be emailed. For more information on setting up the system email
settings, refer to the Email documentation in the Administration Guide.

Note: For Sugar instances that use SugarIdentity, administrators will not be able
to configure the Forgot Password option, change the user's password, or manually
send a system-generated password to the user.

Resetting Your Password Without SugarIdentity

The following steps cover requesting a new password to receive a temporary
system-generated password for a Sugar instance that does not use SugarIdentity:

1. Click the "Forgot Password?" link on the bottom left of Sugar's login dialog
box.
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2. Enter your Sugar user name and primary email address on file, then click
"Request Password". If submitted successfully, a message will appear that
your request has been submitted.

3. A temporary password will be emailed to your primary email address.
Note: If the administrator has disabled the System-Generated Passwords
feature, then the password reset email will instead contain a link you can
click to reset your password.

4. Enter the temporary password into Sugar's login screen.
Note: Be sure to change your password once logged in by navigating to the
Password tab in your user preferences.

Resetting Your Password With SugarIdentity

Use the following steps to reset your password in a SugarIdentity-enabled
instance:

1. Click the "Forgot Password?" link on the bottom of Sugar's login dialog
box.
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2. Enter your Sugar user name on file then click "Send". If successful, a
message will appear confirming that the password reset email has been
sent.

3. Click the Reset Password link in the email sent to your primary email
address.

4. Enter your new password and confirmed password making sure to meet the
password requirements listed on the screen. Click "Change password" then
click the Log In button on the following dialog box if you wish to log in to
Sugar.
Note: System administrators can configure the password requirements in
SugarIdentity via the Cloud Settings console.
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Setting Your Language

Users have the option to choose the primary language they want to be displayed in
Sugar by clicking the Language link on the bottom right of the Login screen. The
Language dropdown list will appear allowing you to select the appropriate
language you want to be displayed in your Sugar account. The out-of-the-box
default language is English (US), but administrators can change the default
language globally via Admin > Locale. For more information on configuring the
default language in Sugar, please refer to the User Interface section of the System
documentation. Once the default language is changed by the administrator, it will
display as the default selection on the login screen for all users.

Administrators can also control what languages are available to select in the
Language dropdown list via Admin > Languages. If you do not see one of the listed
languages below displayed in the Language dropdown list, please reach out to your
system administrator for assistance. For more information on managing languages
in Sugar, please refer to the Languages section of the System documentation.
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The following languages are available for use in Sugar:

Albanian Hungarian
Arabic Italian
Brazilian Portuguese Japanese
Bulgarian Korean
Catalan Latvian
Chinese (Simplified) Lithuanian
Chinese (Traditional) Norwegian
Croatian Polish
Czech Portuguese
Danish Romanian
Dutch Russian
English (UK) Serbian
English (US) Slovak
Estonian Spanish
Finnish Spanish (Latin)
French Swedish
German Thai
Greek Turkish
Hebrew Ukrainian

Logging Out

When you are done working in Sugar and wish to log out of the system, simply
click your user name on the upper right of Sugar and select "Log Out". This will log
you out completely from Sugar and you must log in again in order to access your
account.
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Automatic Log Outs

While working in Sugar, a user may be automatically logged out of the system.
There are several valid and expected reasons that this may occur, primarily for
security purposes. For more information and steps to troubleshoot this behavior,
please refer to the Troubleshooting Sugar Logging Out Unexpectedly Knowledge
Base article.

Please note that users can have multiple tabs of Sugar pages open within the same
web browser (e.g. Chrome) without getting logged out of the system. For example,
this is useful when working with multiple Sugar pages or records without
navigating away from previous pages.

New User Wizard

When users first log in to Sugar, they will step through the New User Wizard to
configure some basic settings (i.e. User Profile and User Locale Settings). If the
system administrator already configured your basic settings when adding you as a
user to Sugar, the fields in the wizard will be populated with the provided
information. You can update your information as you go through the New User
Wizard to make any necessary changes. Please note that you can skip the steps in
the wizard if you wish to configure the settings via your user preferences at a later
time.

Note: For instances that use SugarIdentity, the User Profile step of the User
Wizard is read-only and the displayed fields (e.g. First Name, Last Name) will not
be editable in your user profile as they can only be edited by administrators in 
SugarIdentity via the Cloud Settings console. 

Accepting Cookies
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In order to log in to Sugar, you must accept the use of cookies in the application.
You will only be asked to accept the first time you log in, and any time there are
changes to the privacy policy. To accept, click the checkbox then click "Continue"
to advance to your user profile information:

Configuring Your Information

The User Profile step of the New User Wizard allows you to enter basic information
(e.g. name, email address, phone) about yourself to be stored in your user profile.
Please note that the information provided in this step can be updated in your user
preferences at a later time if desired. For more information on configuring your
personal information, please refer to the User Preferences section.

Note: For instances that use SugarIdentity, the User Profile step is read-only and
the displayed fields (e.g. First Name, Last Name) will not be editable in your user
profile as they can only be edited by administrators in SugarIdentity via the Cloud
Settings console. 

The following options are available to configure your user profile:

First Name : Enter your first name.
Last Name : Enter your last name.
Email : Enter your primary email address.
Phone : Enter your office number.

Please note that all required fields will indicate "Required" in the field and must be
completed prior to moving to the next step of the wizard. Once your personal
information is entered, click "Next".

                        43 / 1.116



 

Configuring Your Locale

The User Locale Settings step allows you to configure the date, time, and name
format you want to be displayed in Sugar based on your current geographical
location. Please note that the information provided on this page can be updated in
your user preferences at a later time if desired.

The following options are available to configure your locale settings:

Time Zone : Select the time zone based on your current geographical
location.
Date Format : Select the format you want the date stamps displayed in
Sugar.
Time Format : Select the format you want the time stamps displayed in
Sugar.
Name Format : Select the format you want the concatenated name fields
displayed in Sugar's list view and record view.

Once your locale information is entered, click "Next".
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The following page will confirm that your set up is complete and that you are ready
to use Sugar. You can access the various support resources (e.g. Documentation,
Knowledge Base) available by clicking one of the boxes in the dialog box. Please
note that you can click "Start Sugar" to go directly into your Sugar account.

Tour

You can launch the Welcome to Sugar tour on the Home page if you wish to see
key features of the user interface. Simply click the Help link in Sugar's footer then
click "Tour" in the help pane. The Welcome to Sugar window will appear and
include links that provide access to additional resources (e.g. training,
documentation). Click the appropriate link in the window to be directed to the
specific page (e.g. Support page) in a separate tab. To begin the tour, simply click
the Right arrow and a bubble will appear to point out the various parts of the
application such as where to access the dashboard and activity stream, perform a
global search, etc. You can click the Left arrow at any time during the tour to go
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back through the key features again. Once you have completed viewing the tour,
click the Done button to exit the tour. Please note that you can launch the tour
again by clicking the Tour link in Sugar's help pane at any time. For more
information regarding the Tour link, please refer to the User Interface
documentation. As you navigate around Sugar, you can launch the tour for any of
the Sidecar modules (e.g. Accounts, Leads, Contacts) by clicking the Tour link in
the help pane to view key features of the list view and record view.

User Preferences

There is a wide range of configuration options available to users when setting up
their profiles in Sugar. The User Preferences section gives users the ability to view
and update their basic information, personal email settings, etc. To access user
preferences, click your user name on the upper right of Sugar and select "Profile".

Note: For instances that use SugarIdentity, certain fields (e.g. First Name, Last
Name, Work Phone, Title) in the user's profile are read-only and can only be edited
by administrators in SugarIdentity via the Cloud Settings console.
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User Profile Tab

The User Profile tab displays basic information such as your name, license type,
email address, etc. If the New User Wizard was completed, the information you
entered will appear under the User Profile tab. For Sugar instances that use
SugarIdentity, the User Profile step of the User Wizard is read-only and the
displayed fields can only be edited by administrators in SugarIdentity via the Cloud
Settings console. The system administrator can also enter the user's basic
information when creating the user via Admin > User Management. For more
information on creating new users, please refer to the User Management
documentation. Your personal information on this tab is grouped by default into
the User Profile, Employee Information, and Email Settings sections. To enter or
update your information, simply enter the appropriate values for the fields then
click "Save" to preserve the changes.

For instances that use SugarIdentity, the following fields under the User Profile
tab are read-only and can only be edited by administrators in SugarIdentity via the
Cloud Settings console:

First Name
Last Name
Work Phone
Address Street
Address City
Address State
Address Postal Code
Address Country
Primary Email Address

User Profile

The User Profile section displays your Sugar name, user name, status, user type,
avatar, and license type. Of these fields, regular users can only modify First Name,
Last Name, and Avatar; the rest are set by Sugar administrators as described in
the User Management documentation. Each user must have one or more Sugar
products selected in their License Type fields. This field controls what functionality
you may access. When working in Sugar or learning about the features available to
you, view your profile to confirm your license type(s). A list of functionality
available for each license type is listed in the User Management documentation.
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Employee Information

The Employee Information section displays your employee status, title, phone
number, address, etc. If you completed the Your Information step of the New User
Wizard, the information you entered will appear in this section. You can update
your address, phone number (e.g. Work Phone, Mobile), description, IM Type (e.g.
MSN, Yahoo!), and IM Name in this section accordingly. Please note that only
system administrators can change your employee status, title, department, and
supervisor information. For instances that use SugarIdentity, administrators will
need to access SugarIdentity via the Cloud Settings console in order to update the
Title and Department fields. For more information on administrator updates to the
Employee Information section, please refer to the User Management
documentation.

Email Settings
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The Email Settings section contains your primary email address and preferred
method for sending mail from Sugar.

Note: For instances that use SugarIdentity, the user's primary email address can
only be edited by administrators in SugarIdentity via the Cloud Settings console.

The Email Settings section contains two fields:

Email Address : Enter your primary email address.
Sugar refers to the primary email address in the user's profile to
send messages such as password-reset emails, record-assignment
notifications, and workflow alerts to users.
Users can add multiple email addresses in email settings, but only
one can be marked "Primary".
If the administrator has enabled the system email account for users,
the primary email address will be displayed when the user sends
outbound emails via the system email account.
Outgoing email accounts (e.g. support@example.com) that are used
to send outbound email messages will get added to the Email
Address field as Sugar links the user to that email address since
they used it to send an email message through Sugar.

Email Client : Select how you would like to send email from Sugar.
Sugar Email Client (most common) : To send messages through
the Sugar application and automatically archive them in Sugar, you
must select "Sugar Email Client" from the Email Settings section of
your user profile. This is the default setting.

Note: To send email from Sugar, you must configure your
outbound email server via Emails > Email Settings or, if
using the system email account to send email, the system's
outbound email server must be configured by an
administrator via Admin > System Email Settings.

External Email Client : Users can choose this option if they would
like to send email from an application outside of Sugar (e.g.
Microsoft Outlook, Gmail). If you choose the External Email Client
option, emails sent to contacts, leads, etc. will not be saved in Sugar
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as archived emails unless you use the Sugar Email Archiving service
(a.k.a. "SNIP") or a Sugar connector such as the Outlook Plug-in or
a third-party connector like Collabspot.

Note: The administrator may have configured the user's email settings when
adding the user to the system, but the user can always edit the options in their
profile.

Password Tab

Users have the option to change their password in Sugar by navigating to the
Password tab in their user preferences. You can use this option to change
temporary Sugar passwords, system-generated passwords for password resets,
etc. Administrators also have the ability to change or reset a user's password via
Admin > User Management. For more information on how administrators can
reset a user's password, please refer to the Resetting User Passwords section of
the User Management documentation. Please note that passwords can be changed
as often as you wish in Sugar. Updating passwords in Sugar on a regular basis is
recommended for the security of your account.

Note: For Sugar instances that use Sugaridentity, the Password tab will not be
available to change a user's password. Users will need to click the "Forgot
Password?" link on the login screen if they wish to reset their password. 

To reset your password, enter your current password, new password, and
confirmed password making sure to meet the password requirements listed on the
right. Each password requirement will be checked off in the list as the new
password meets the required conditions. Please note that the new password you
enter must meet all the restrictions in order for the password to save. System
administrators can configure the password requirements via Admin > Password
Management. They can choose the minimum and maximum lengths required for
the password, as well as indicate if any special characters are needed. Additional
requirements such as upper case, lower case letters, and numbers can also be part
of the set restriction. The password requirement set by the system administrator
determines what users will need to include when creating new passwords.
Although not recommended, administrators can choose to not set password
requirements if they wish, which will allow users to change their passwords
without any restrictions. For more information on configuring password
requirements, please refer to the Password Requirements section of the Password
Management documentation. Once you have entered the new password, click
"Save" to preserve the change.
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Advanced Tab

The Advanced tab shows information specific to the user's preferences in Sugar.
This information includes user settings, locale settings, PDF settings, calendar
options, and layout options. Users can set up, view, or change the information
under this tab based on their geographical location and personal preference.

User Settings

The User Settings section allows you to configure various settings for your account
such as default team(s), reminders, notify on assignment, etc. The system
administrator can configure these settings for you when adding you as a user in
Sugar, but you can change these settings accordingly based on your personal
needs and preference.

The options available to configure in the User Settings section are as follows:

Export Delimiter : Specify the character used to delimit exported data
from Sugar. By default, the comma is used to separate exported data in
Sugar.
Import/Export Character Set : Select the default character set used for
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data import, data export, and vCard generation. By default, UTF-8 (US or
Western Europe region) is selected as the import/export character set.

Please be sure to select the proper character set based on your
locale setting in Sugar. This will make sure that the character set
between Sugar and your local machine matches when you export
data, import data, or generate PDFs.

Show Full Names : Check this box if you would like your full name (e.g.
John Smith) instead of your assigned user name (e.g. jsmith) displayed in
Sugar. If enabled, your full name will appear in the My Activity Stream
dashlet, Assigned to fields, and on the upper right of your Sugar account.
Default Teams : Select the default team(s) that will be automatically
assigned to new records you create in Sugar. Whenever you create a
record, the team is set as your default team, similar to how the "Assigned
To" field is set to you. You can have any number of default teams. When
selecting a default team set, you must select one team as the primary team
and, if the Administrator has enabled team-based permissions, you may
optionally indicate whether the teams on each set should be automatically
set to "selected" (Additional Permissions Enabled).
Email on Assignment : Check this box to receive an email notification
when a record is assigned to you by another user. Both the outbound mail
server and personal email settings must be configured in order to receive
the notification. For more information on configuring the outbound mail
server, please refer to the Email documentation.
Email on Mention : Select this option to receive an email notification
every time your name is mentioned in a comment log.
Reminders : Mark the popup or email reminder checkbox to set default
reminders for calls and meetings. Once marked, you can select the default
reminder time (e.g. 10 minutes prior) to send reminders to invitees.

Layout Options

The Layout Options section allows users to select what modules they want Sugar to
display or hide in the navigation bar.
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The options available to configure in the Layout Options section are as follows:

Select Modules for Navigation Bar : Select which modules will be
displayed or hidden in the navigation bar by using the left and right arrows
to move modules between the Display and Hide Modules column. You can
also designate the order of the modules displayed in the navigation bar by
selecting the module in the Display Modules column and clicking the up
and down arrows.
Field Name Placement : Choose whether field names are displayed above
or beside field values in record view; by default, field names are displayed
beside the field value. This option does not apply to the Record View
dashlet.

Locale Settings

The Locale Settings section is where you can specify how you would like the data
in Sugar displayed based on your geographical location. Please note that system
administrators can set the system locale settings via Admin > Locale, which will be
the default setting for all users in Sugar. But each user has the option to change
the default locale settings for their Sugar account in their user preferences.

The options available to configure in the Locale Settings section are as follows:

Date Format : Select the format you want the date stamps to be displayed
in Sugar.
Show Preferred Currency : Mark the checkbox to convert the base
currency to user-preferred currency in list views and record views.
Note: User-preferred currency is not used in the Quotes record view or for
quoted line items. For more information, refer to the Quotes and Quoted
Line Items documentation.
Time Format : Select the format you want the time stamps to be displayed
in Sugar.
Time Zone : Select the time zone based on your current geographical
location.

Please note that if the selected time zone is different from your
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browser's set time zone, a warning message ("Your browser's
timezone does not match your saved timezone Adjust Your
Timezone.") will appear upon your next log into Sugar. You can
click the link in the warning dialog box to change the time zone in
your user preference accordingly.
Note: This Time Zone setting only applies to modules using the
Legacy user interface. Modules using the Sidecar user interface will
utilize the browser's time zone.

Name Display Format : Select the format you want the concatenated
name fields displayed in Sugar's list view and record view.
Preferred Currency : Select the default currency you wish to use when
creating new records.
Create Revenue Line Items in Preferred Currency : Mark the checkbox
to use your preferred currency when creating revenue line items based on
a product catalog item, rather than the default behavior of using the
product catalog item's currency.
System Significant Digits : Select how many digits will appear after the
decimal symbol for currencies.
1000s Separator : Enter the default character used to separate numeric
values in the thousands.
Decimal Symbol : Enter the default character used as the decimal symbol.

Note: The Quotes and Revenue Line Items modules are not available for Sugar
Serve users. For more information on license types and the functionality available
for each type, refer to the User Management documentation. 

PDF Settings

The PDF Settings section allows users to set and change the default font settings
for PDF documents generated in Sugar.

The options available to configure in the PDF Settings section are as follows:

Font for Header and Body : Select the font for the header and body of
PDF documents when generated in Sugar.
Main Font Size : Enter the default font size for the PDF header when
generated in Sugar.
Font for Footer : Select the font for the footer of the PDF document when
generated in Sugar.
Data Font Size : Enter the default font size for the PDF body when
generated in Sugar.
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Calendar Options

Sugar calendars can be shared and viewed with various iCal compatible calendar
applications such as Apple Calendar, Google Calendar, Yahoo! Calendar, Mozilla
Thunderbird, etc. The calendars are viewable as read-only in the external calendar
applications and any edits to existing calendar events (e.g. meetings, calls) can
only be done in Sugar. The Calendar Options section allows users to generate a
unique publish key to sync their Sugar calendar to external calendar
application(s). The publish key is a security feature as it prevents other users from
viewing your calendar unless they have this information. The user must have your
publish key information to view your Sugar calendar via the external calendar
application.

Publish Key : The publish key is used to uniquely identify a user's calendar
and sync Sugar's calendar to external calendar applications (e.g. Google
Calendar, Apple Calendar). A system-generated alphanumeric value (e.g.
948fc65a-9c89-a11f-b40c-5) is displayed by default, but users can change
this key (e.g. mysecretkey) to whatever they wish. The Publish at my
location site, Search location, and iCal Subscription URL all reflect the
publish key within the URL.
Publish at my location : Use this URL to sync free/busy information for
meetings from Microsoft Outlook to Sugar. This is helpful when scheduling
meetings in Sugar as you can view the user's free/busy information to avoid
scheduling conflicts.
Search location : Use this URL to sync free/busy information for meetings
from Microsoft Outlook to Sugar. This is helpful when scheduling meetings
in Sugar as you can view the user's free/busy information to avoid
scheduling conflicts.
iCal Subscription URL : Use this URL to integrate the external calendar
application with your Sugar calendar.
First Day of Week : Select the first day of the week that will display in
Week, Month, and Year views when viewing your Sugar calendar. This
setting also applies to calendar pickers which display when users are
setting a value for a date field (e.g. Expected Close Date).

Use the following steps to integrate the external calendar application with your
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Sugar calendar:

1. Navigate to the Advanced tab in your user profile and scroll down to the
Calendar Options section.

2. Copy the iCal Subscription URL then paste the value into your iCal
compatible calendar application.

For Apple Calendar:
Click "File" then select "New Calendar Subscription".

Enter the iCal Subscription URL and click "Subscribe".

For Google Calendar (https://www.google.com/calendar):
Click "Other Calendars" then select "Add by URL".
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Enter the iCal Subscription URL and click "Add Calendar".

Use the following steps to sync the free/busy information from the Sugar calendar
to Microsoft Outlook:

1. Navigate to the Advanced tab in your user preferences and scroll to the
Calendar Options section.

2. Copy the Search location URL.
3. In Outlook, go to File > Options > Calendar > Free/Busy Options.
4. In the Internet Free/Busy section, paste the Search location URL into the

corresponding box.

Please note that the settings must be configured on each user's computer. Once
configured, the invitee shows as busy for any time currently scheduled in Sugar if
the user's email address in Sugar matches the invitee email address in Outlook. 

For help troubleshooting or displaying your Sugar calendar in an external
application, refer to the Troubleshooting Viewing Sugar Calendar in Google
Calendar and Troubleshooting Feed Refresh in External Calendars articles. 

External Accounts Tab
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The External Accounts tab allows users to connect to external applications (e.g.
Google, GoToMeeting, WebEx) from Sugar. Please note that you must have an
existing account with the external application prior to connecting in Sugar.

Connecting to your Google account enables you to upload and access documents
stored in Google Drive™ from the Documents module. In addition, you can upload
and view Sugar documents via Google Drive. For more information on how to
upload and view external source documents, please refer to the Documents
documentation.

If you connect to your GoToMeeting and WebEx accounts, you will be able to
schedule meetings in Sugar to be hosted by one of these applications. Please note
that you must indicate the specific meeting type (e.g. Sugar, GoToMeeting,
WebEx) when creating the meeting in Sugar. For more information on scheduling
meetings, please refer to the Creating Records section of the User Interface
documentation.

The following steps cover connecting to the Google application as an example:

1. Click the External Accounts tab in your user preferences then click
"Create".

2. Select "Google" in the Application field then click the Connect button.
Note: If the Google option is not available to select in the
Application field, the Google connector may not have been
configured properly via Admin > Connectors. Please reach out to
your Sugar administrator to have the Google connector configured.
For more information on configuring connectors, please refer to the
System documentation in the Administration Guide.

3. After clicking "Connect", a pop-up window will appear. Click "Allow" to
grant permission for the connection to occur.

Google's login screen may appear inside the pop-up if you are not
already logged in to your Google account in the active browser
window. Simply enter your credentials then click "Allow" in the next
window.
Note: Your browser's pop-up blocker must be disabled to ensure
that the Google account connects successfully to Sugar.
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The Google application is now connected to your Sugar account and will appear
under the External Accounts tab. Please note that for Google, GoToMeeting, and
WebEx, you can only be connected to one account per application in Sugar.

Access Tab

Users can view their access information (e.g. Access table, Roles, My Teams) via
the Access tab in the detail view of their profile. System administrators can assign
users to various teams and roles depending on what each user is allowed access to
in Sugar. You will be able to view the team(s) and role(s) assigned to you via the
Roles and My Teams section in the Access tab.

Access Table

The Access table summarizes the set of permissions assigned to the user and
allows them to view the type of access they have along with the actions (e.g. View,
Edit, Delete) they can perform in Sugar. Only system administrators have the
ability to create roles and assign them to users. Users who are assigned to the role
will only be able to perform actions defined by it. Please note that users with more
than one role assigned will have the more restrictive role setting prevail on the
access table. For example, if one role allows the user to delete records in the
Contacts module, but the other role does not allow record deletion, the user will
not be able to delete records in the Contacts module. The table will list the
modules in rows on the far left with column headers representing the type of
action (e.g. Delete, Edit, Export) users can perform in each module. For more
information on the Access table column headers, please refer to the Setting
Module-Level Permissions section in the Role Management documentation.

The following setting options are available for the Access column on the table:

Enabled : The user is allowed access to this module.
Not Set : Does not restrict or grant access to this module, defaults to
having "Enabled" access when selected.
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Disabled : The user will not be able to access this module, view any of its
records, or see any trace of its existence in Sugar.

The following setting options are available for the Access Type column on the
table:

Normal : The user will be able to perform standard functions in this
module barring restrictions from other roles or team settings. The user will
not have any type of access to the Admin menu for this module.
Not Set : Does not restrict or grant additional access to this module,
defaults to having "Normal" access when selected.
Admin : The user will supersede any team restrictions for this module and
be able to view all records.

Note: User does not get access to developer tools such as Studio
and Workflow Management.

Developer : The user will be given access to the module-specific sections
of Studio, Workflow Management, Dropdown Editor and any other
necessary menus in Admin that are specific to the module.
For more information on developer tools, please refer to the Developer
Tools documentation.
Admin & Developer : The user will be given the rights defined with the
Admin and Developer role settings.

The following setting options are available for the actions (e.g. Edit, Delete,
Export) on the table:

All : The user will be able to perform this action on any and all records that
can be accessed.
Owner : The user will only be able to perform this action where the
Assigned To field is set to be this user.
Not Set : Does not restrict or grant access to this function and actions
default to having "All" access when selected.
None : The user is not able to perform this action while using this module.

Roles
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Sugar Roles define permissions for users such as what kinds of records they can
access and what level of access they are allowed. Roles work in conjunction with
teams to form a robust security model for non-admin users in Sugar. Roles control
three different layers of access for users within Sugar: module, field, and action-
level access. Please note that only users who are assigned to the specific role will
be able to perform actions (e.g. view, edit, delete) defined by it. For more
information on the various actions and setting options for roles, please refer to the 
Access Table section. Users who are not assigned to a role can access and perform
actions in any module as long as they are assigned to the record or a member of
the team assigned to manage it. System administrators have the ability to create
various roles and assign additional roles to users via Admin > Role Management.
For more information on creating and assigning roles, please refer to the Role
Management documentation.

The Roles section displays the list of roles (if any) assigned to the user. Please note
that if you are assigned to more than one role, the more restrictive role setting
prevails. For example, if you have two roles where one role allows exporting of
records in the Leads module and the other does not, then you will not be able to
export lead records due to the more restrictive role setting.

My Teams

Teams consist of one or more users who are assigned to manage records in Sugar.
The defined permissions determine what records a user is and is not able to
access. Teams are used in conjunction with roles to form a robust security model
for non-admin users in Sugar. The My Teams section displays the list of teams a
user is associated with, which determines what records the user has access to in
Sugar. Please note that every record is assigned to at least one team, but can be
assigned to multiple teams as well if different users need access to it. The default
team(s) set in the User Settings section under the Advanced tab will automatically
be assigned to new records created by the user. Users assigned to the record, as
well as system administrators can access the record regardless of team
membership. When a user is created in Sugar, they are automatically associated
with the Global team (universal team) and a Private team (users own personal
team) is created by default. System administrators can assign users to additional
teams via Admin > User Management or Admin > Team Management as
necessary. For more information on teams as well as creating and assigning teams,
please refer to the Team Management documentation.
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Downloads Tab

The Downloads tab contains the download files for the Sugar Plug-ins for Microsoft
Office (Sugar Plug-in for Outlook, Sugar Plug-in for Word, and Sugar Plug-in for
Excel) and Sugar Plug-in for IBM Notes. The Outlook plug-in allows you to archive
emails to Sugar, synchronize contacts, meetings, and tasks, as well as create new
Sugar records. The Word plug-in enables you to merge data, such as names and
addresses in Sugar to perform mail merges. The Excel plug-in enables you to
create, delete, update, or view data that is in your Sugar application. These plug-
ins are available with all Sugar products and must be installed on each Windows
computer running the Microsoft Office application where the plug-in is desired.
The IBM Notes plug-in (i.e. Sugar Plug-in for Lotus Notes) allows you to integrate
with Sugar by synchronizing meetings, tasks, and contacts, as well as archiving
emails to records in your instance. Please note that support for the Sugar Plug-in
for IBM Notes has ended as of August 30, 2020. For more information, refer to this
SugarClub post.

To download the plug-in(s), click the appropriate file that corresponds with your
version and bitrate of Microsoft Office Outlook, Word, or Excel. Please be sure to
check for the correct version and bitrate of your Microsoft Office application in
order to download the correct file for installation. For IBM Notes plug-in, the latest
version will be available for installation in the Downloads tab. For more
information on downloading and installing the Sugar plug-ins, refer to the
appropriate Plug-ins documentation.
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User Holidays

The User Holidays subpanel appears in the detail view (e.g. User Profile tab,
Advanced tab) of the user's profile. Administrators can record the days that users
will not be working so that the time off is considered when calculating project
timelines in the Projects module. To add a holiday, click the Create button and
enter the date of the holiday along with a description and then click "Save". Users
will be able to select the scheduled holiday(s) via the Project Holidays subpanel in
Projects-related modules. For more information on creating and managing
projects, please refer to the Projects documentation.
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Resetting a User's Preferences

Users can reset their user preferences back to the default out-of-the-box settings,
which will revert all changes made to the user preferences section (e.g. User
Profile, User Settings, Locale Settings). To reset your user preference, click the
Reset User Preferences button at the top of your profile in edit view or click the
Actions menu then select "Reset User Preferences" in detail view.

From edit view:

From detail view:

Accessing Support

The SugarCRM Support page provides access to various Sugar Support resources
such as the case portal, documentation, knowledge base, etc. Users can easily
access the support page by clicking the Documentation & Support link in Sugar's 
help pane. To access Sugar's Support page outside of your instance, go directly to
the SugarCRM Support site on your web browser.
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The Get Started section of the Support page provides users, administrators, and
developers with the appropriate resources to get them started in configuring,
customizing, and utilizing the application. The Documentation and Knowledge
Base sections provide access to Sugar's self-help area where you can learn how to
use various parts of the application via online documentation and knowledge base
articles. The Knowledge Base provides articles based on specific topics and areas
of Sugar while the Documentation goes over the entire Sugar application in detail.

The Resources section provides key information such as supported versions and
platforms to ensure you are running Sugar in the best performing environment,
customer resources to help you manage your Sugar subscription, view/download
purchased orders, and access the bug and case portal. In addition, it provides
guidelines for deploying Sugar on-site and requirements for setting up
development environments.

The Training section directs you to the Sugar University page where you can find a
variety of training options to help end users, administrators, and developers. You
can find self-paced videos or e-courses, live training and webinars, personalized
training, and pursue Sugar certification. The Community section navigates you to
the SugarCRM community page where you can collaborate with other users, Sugar
partners, and Sugar employees to answer questions, participate in discussions,
solve problems, etc.

Viewing Instance Information

Users can find information regarding their version and build of Sugar by clicking
their user name on the upper right of Sugar and selecting "About". For example,
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this will be useful if you need to confirm the current product and version of your
instance.

Last Modified: 2022-02-03 21:57:29

User Interface

Overview

The user interface includes all of the visible elements users see and interact with
while using Sugar including the headers, fields, subpanels, dashboards, etc.
Knowing how to properly navigate around the application along with what the
various layouts, options, and action items do in Sugar will be critical in managing
your data in the system. This documentation covers the basics of Sugar's user
interface as well as how to perform common tasks or operations in the application.

Sidecar Modules

This page covers the user interface that was introduced in Sugar 7 called
"Sidecar". A few modules continue to use the Legacy user interface which is
described in detail in the User Interface (Legacy) documentation. Custom modules
created in Module Builder will utilize the Sidecar user interface. Custom modules
installed to an instance prior to Sugar 7 that were not created in Module Builder
will use the Legacy user interface upon upgrade to 7.x and above.

Navigation Bar

All pages within Sugar display a navigation bar spanning across the top of the
screen. The navigation bar allows you to access the various modules (e.g.
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Accounts, Contacts, etc.), access your Home page, perform a global search, etc.
You can configure the navigation bar via your user preferences to select which
modules you want to display as well as their order. For more information, please
refer to the Layout Options section of the Getting Started documentation.

The default navigation bar consists of the following options from left to right:

Navigation Bar Item Description
Home Click the Sugar Cube icon on the upper

left to access your Home page
dashboards as well as your Activity
Stream.

Module Tabs Both stock and custom modules can be
displayed in the navigation bar. Click
the module name to open its list view or
click the triangle to the right of each
module name to display the Actions,
Recently Viewed, and Favorites menus.

Global Search Enter keywords into the global search
bar to search for records across all
Sugar modules.

Notifications View system notifications (if any) by
clicking the notification box. The
number shown indicates the count of
unread notifications.

User Menu Click the user profile image to open the
user menu which allows access to your
profile, the Employees module, etc.

Note: For instances that use
SugarIdentity, certain fields (e.g. First
Name, Last Name, Work Phone, Title) in
the user's profile are read-only and can
only be edited by administrators in 
SugarIdentity via the Cloud Settings
console. 

Quick Create Click the Plus icon to open the Quick
Create menu which allows you to create
records from anywhere in Sugar.
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Home

You can access your Home page from anywhere in Sugar by clicking the Cube icon
at the top left of every page. Sugar's home page houses full-page dashboards and
your instance-wide activity stream. Additionally, you can manage your dashboards
and visit recent records from the Home page actions menu. For more information,
please refer to the Home documentation.

Module Tabs

Module tabs are located to the right of the Sugar cube icon on the navigation bar
at the top of any Sugar screen. To access a specific module's list view, simply click
the module's name. You may also click the triangle to the right of the name to
display the Actions, Recently Viewed, and Favorites menus. The Actions menu
allows you to perform important actions within the module. The Recently Viewed
menu displays the list of records you last viewed in the module. The Favorites
menu displays the list of records you most recently marked as favorites in the
module.
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The number of displayed module tabs depends on your screen resolution as well as
the size of your browser window. When your available modules do not fit within the
navigation bar's width, clicking the overflow icon (three stacked dots) to the right
of the displayed modules allows you to select and navigate to the list view of the
additional modules.

If you do not see a particular module tab in Sugar, please check the following:

The module may be marked as hidden in your user preferences which will
prevent the module tab from being displayed. Navigate to your user menu
(upper right of Sugar), click "Profile", click the Advanced tab, and check
the Layout Options section. If you see the module in the Hide Modules list,
simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options
section of the Getting Started documentation.
The administrator may have disabled the module for your entire Sugar
instance. Reach out to your Sugar administrator to have the module
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displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation.

Global Search

Global search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. The Global
Search bar displays on the upper right of any Sugar page and utilizes full-text
search to search throughout most fields and modules for an enhanced search
experience.

Clicking on the search bar will expand it across Sugar's navigation bar. To perform
a search, type the search phrase into the search box, and the pop-up results will
begin appearing once you enter at least one character. Click "View all results" at
the bottom of the pop-up results to see and filter additional matches. To minimize
the search bar, simply click anywhere outside of the search bar. For more
information on using Global Search, please refer to the Global Search section of
the Search documentation.

Once expanded, you will be able to access the Modules dropdown by clicking the
down arrow on the far left of the search box. This allows you to restrict results to
particular modules (e.g. Accounts, Contacts, etc.). For more information on
configuring your global search, please refer to the Search documentation.
Administrators can also enable or disable modules as well as control additional
elements of global search via Admin > Search and Admin > Studio. For more
information on these configurations, please refer to the Field Options section of
the Studio documentation as well as the Search section of the System
documentation.

Notifications

Sugar notifications relay key messages, warnings, and alerts that are relevant to
the current user. The Notifications indicator is located in the top right corner of
the screen next to the global search bar; the number displayed represents how
many messages have a status of Unread. If you are logged in to Sugar using the
Chrome or Firefox browser, the SugarCRM cube icon in your browser tab also
displays the count of unread notifications. When the notification count changes,
the icon's count will be updated within 5 minutes of the change or upon reloading
the tab.
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Clicking the number in Sugar opens a dropdown menu displaying your most recent
unread notifications. Click any notification to open it in record view, or click "View
Notifications" to open the Notifications list view. A notification is automatically
marked as read when it is opened in record view or previewed from list view. If
you wish to toggle its status between Read and Unread, simply click the status
field in list view, record view, or preview. To change the status of multiple
notifications at a time (e.g. to mark several notifications as read), you can also 
mass update the records from list view.

If a notification requires action within Sugar, a link may be included in the
Description field, shown in record view or when previewing the notification.
Clicking the link takes you to the related record or the area where action is
needed.

Notification Severity Levels

Each notification can have one of four severity levels:

Alert (Red) : Indicates something is critically wrong with your Sugar
instance and needs the attention of a system administrator immediately
Warning (Yellow) : Indicates something in your Sugar instance needs
your attention or the attention of a system administrator to be fixed
Information (Blue) : Standard notification including reminders for
upcoming meetings, calls, or tasks. Note that for a notification to appear, a
newly created activity must be scheduled to begin at least one hour later
than the time it was created.
Success (Green) : Indicates the successful completion of an action or
configuration change

User Menu

                        71 / 1.116



 

Your profile icon appears in the upper right of Sugar; clicking it displays the user
menu where you can access your profile, the Employees page, and view important
version information about your instance. To upload a photo for your profile image,
please refer to the Getting Started documentation.

The user menu allows you to perform the following operations:

Menu Item Description
Profile View your user profile, change your

password, and personalize various
aspects of Sugar.

Note: For instances that use
SugarIdentity, certain fields (e.g. First
Name, Last Name, Work Phone) in the
user's profile are read-only and can only
be edited by administrators in 
SugarIdentity via the Cloud Settings
console. In addition, users will not be
able to change or reset their password
and will need to click the "Forgot
Password?" link on the Sugar login
screen to reset their password. 

Employees Navigate to the Employees module to
search and view employee records.
Users with administrative privileges can
also create and edit employees in the
system. For instances that use
SugarIdentity, certain fields (e.g. First
Name, Last Name, Office Phone) in the
employee's record are read-only and can
only be edited by administrators in 
SugarIdentity via the Cloud Settings
console. 
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Note: Every user is listed as an
employee; however, every employee
may not be a user in Sugar.

Admin Navigate to the Admin page to configure
and customize various aspects of your
Sugar instance.

Note: This option is only available if you
are an administrator user or have or
developer-type role access.

About Navigate to the About page to view your
instance's current Sugar product,
version, and build, as well as resources
and source code references.

Log Out Log out of your current user session.
You will be directed back to the Sugar
login page for your instance.

Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the Plus button on the upper right of any Sugar page to access
the menu. Please note that a maximum of ten modules may be enabled to display in
the Quick Create menu. Administrators can configure which modules are enabled
and the order in which they appear via Admin > Configure Navigation Bar Quick
Create. For more information, refer to the Developer Tools documentation.
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Clicking on an item in the Quick Create menu will open the record view form for
the specific module. When using quick create while viewing an existing record
where a relationship exists between the two modules, Sugar automatically relates
the new record to the one being viewed. For example, if you are viewing an
account, ABC Company, and create a new contact via quick create, the Account
Name field in the new contact will automatically populate with "ABC Company",
thus creating the link between the two records.

All required fields will indicate "Required" in the field and must be completed prior
to saving. Once the necessary information is entered, click "Save". If you do not
wish to create the record, simply click the Cancel button. Please note that
administrators have the ability to configure the record view layout via Admin >
Studio. For more information on configuring record view layouts, please refer to
the Studio documentation.

Note: Because the Quick Create drawer overlays the page from where it is
launched, using the browser's back button will appear to send you back two pages
instead of to the previous view. To return to the previous view, use the Cancel
button instead.

Footer

Sugar's footer displays the SugarCRM logo, Mobile link, Shortcuts link, Help link,
as well as links to enabled third-party integrations. Users can click these links to
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go back to their Home page, access the help pane, etc.

The following links are available in Sugar's footer:

Logo : Click the logo on the bottom left of Sugar to return to your home
page. Administrators can replace the SugarCRM logo with a custom logo
via Admin > System Settings. For more information, please refer to the 
System Settings documentation.
Widgets : Links for any installed third-party integrations will appear to the
right of the SugarCRM logo.
Mobile : When viewing Sugar via a touch-screen device, the Mobile link
will appear allowing you to view Sugar's mobile site.
Shortcuts : Access the Keyboard Shortcuts help page to view the various
shortcut keys available to use along with a description of the actions they
perform. For more information regarding the Keyboard Shortcuts help
page, please refer to the Accessibility documentation.
Help : Access the help pane via the Home page or a Sidecar module's list
view/record view (e.g. Accounts) by clicking the Help link. The top of the
help pane provides a brief introduction to the current module and includes
a link to the module's corresponding documentation. In addition, the
following learning resource and Sugar 7 tour links are available in the help
pane:

Sugar University : Opens the Sugar University page where you
can access information regarding online and live training, the Sugar
certification program, etc.
Community Forums : Opens the Community Forums page where
you can collaborate with other users, Sugar partners, and Sugar
employees to ask questions as well as participate in active
discussions, help solve problems, etc.
Documentation & Support : Opens the SugarCRM Support page
where you can access the case portal, documentation, knowledge
base articles, etc.
Tour : Launches a quick tour to show key features of the user
interface for the home page and Sidecar module page (e.g.
Accounts) you are currently viewing. For more information
regarding the Sugar 7 tour, please refer to the Tour section of the
Getting Started documentation.
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Field Types

Sugar records include a variety of field types that enable you to capture all of the
different kinds of data that are important to your organization. While many fields
are available for use on each module out-of-the-box, administrators and users with
developer-level role access have the ability to add fields of these various types to
modules via Admin > Studio as described in the Studio documentation. Studio may
also be used to configure fields by, for example, making fields required, allowing
them to be mass updated, making their values calculated, and specifying when
they should be visible.

Descriptions and instructions for editing different field types are available in the
following sections:

Checkbox Fields

Checkbox fields provide a boolean type typically used to answer a yes or no
question. Click the box to toggle whether it is checked or not.

Comment Log Fields

The Comment Log field allows users to add messages, comments, or other text to a
log appearing on the record view. To add an entry, click anywhere inside the field
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and type a message into the text area that appears. After saving the record, the
message is appended to the end of the log with a link to the user that added the
entry and the date and time the entry was created. Once saved, entries cannot be
edited or removed.

If the length of a comment log entry is longer than the maximum set by the admin
in the system settings, the text will be cut off with a "Show more..." link that
displays the remainder of the entry when clicked. Once the entry is expanded, a
"Show less..." link is displayed that collapses the text so that only the configured
number of characters are displayed again. See the System documentation in the
Administration Guide for more information.

Note that Comment Log fields cannot be created in Studio; they exist automatically
on many modules and can be added to the layout in Studio. This can be done by a
system administrator or someone with developer-level role access. On the Bugs
and Cases modules, the Comment Log field is displayed by default. For more
information on using Studio to add fields to a module's layout, refer to the Studio
documentation.

Tagging Users in Comment Log Entries

Users can be tagged in comment log entries to insert a link to their employee
record in the form of a clickable pill; the tagged user also receives a notification in
Sugar. To tag a user, type the @ symbol followed by at least the first two
characters of the first or last name. A list of matching users will appear below the
text area; select the user you wish to tag and the tag will be added to the entry.
Upon saving, the tag will be displayed as a clickable pill.
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To filter by letters in the middle or end of the first or last name instead of the
beginning, you can use the wildcard character (%) at the beginning of your
criteria. For example, "@%en" would yield Sally Bronsen, Max Jensen, and Jim
Brennan.

If the user you are trying to tag does not have access to the record, their name will
be disabled in the list of results that match your criteria. It will say "No access"
next to them and you will not be able to tag the user.

Linking to Records in Comment Log Fields

It is possible to link to Sugar records in comment log entries; the link will appear
as a clickable pill. To link to a record, type the # symbol followed by at least two
characters in the name of the record. A list of matching records will appear below
the text area; select the record you wish to link to and the link will be added to the
entry. Upon saving, the link will be displayed as a clickable pill.

If you are viewing a comment log entry containing a link to a record to which you
do not have access, the link will still be clickable but the text will say "No data
available".

Date Fields

Date fields allow users to specify a particular date by either typing a date in the
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provided format or clicking the Calendar icon and selecting it via the date picker.
Click the month and year (e.g. "January 2018") to select the desired month or use
the arrows to navigate to the desired month. To set the year, click the month and
year at the top of the picker, then click the year at the top of the picker, and then
select the desired year. Once the month and year are set, click the desired date
below to set the date and close the picker.

Datetime Fields

Datetime fields allow users to specify both a particular date and a time. The date
portion is set just like a date field as described above. The time portion can be set
by typing a time in the provided format or clicking the Clock icon and selecting it
via the dropdown.

Dropdown Fields

Dropdown fields provide a list of values where only one value can be selected at a
time. The list will be collapsed to only display the selected value except during
editing, making it appropriate for longer lists of values. Click the selected value to
see the full list. Clicking the desired value will replace it as the selected value.
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Email Address Fields

Email address fields contain one or more email addresses for a single record; email
addresses are entered by clicking in the field and typing or pasting the address.
The following options are available when editing an Email Address field:

Add/Remove : Add additional email address fields by clicking the plus
button. Click the minus button to remove the adjacent address.

Primary : A white star with a black background represents the primary
email address on a record. This will be the default address that Sugar will
find when the record is included in email campaigns and other send-
message events performed within the application. On a given record, only
one email address can be the primary one. If a record contains only one
email address, it will be set to primary by default.

Opted Out : The button with a slashed circle indicates whether or not an
email address has been opted out from email marketing campaigns. Sugar
automatically opts-out an email address when a recipient clicks the opt-out
link in an email-type campaign message. When enabled, the button will
have a black background. Administrators can configure whether new email
addresses added to Sugar records default to opted-in or opted-out by using
the "Opt-out new email addresses by default" option via Admin > System
Email Settings.
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When an opted-out email address is saved, the opt-out status is indicated
by a blue circle with a line through it. Opted-out email addresses also
display a Link button in record view. Clicking this button will copy a link to
your computer's clipboard which you can send to the email address owner
in order to request that they confirm their desire to receive marketing
emails from your organization. When the copied link is visited in a web
browser, Sugar will automatically set the email address to opted-in.

Please note that opted-out email addresses are only blocked from being
added to campaigns, so users can continue to send them transactional
emails via the Emails module. For more information about email opted-out
email addresses, refer to the Emails documentation.
Invalid : Invalid or undeliverable email addresses are represented by a
black button with a white exclamation point. Sugar automatically marks
email addresses as invalid if they are returned via the recipient's mail
server during the distribution of an email campaign. Users can also
manually toggle the invalid designation on and off by clicking the Invalid
button next to the email address. Sugar will not permit users to send
messages to invalid email addresses from anywhere within the application.

Flex Relate Fields

Flex relate fields require users to select first the module and then a record from
that module to relate to the current record. The module selector works like a 
dropdown field while the record selector works like a relate field, both of which
are described above. You can click the "x" to the right of the selected record's
name (e.g. ABC Company) to clear out the value. Please note that a module may
only have one flex relate field.
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Integer Fields

Integer fields allow users to enter whole number values (e.g. 850) by clicking on
the field and typing. Administrators can specify a minimum and maximum value for
the field via Admin > Studio.

Multiselect Fields

Multiselect fields provide a list of values where one or more values can be selected
at a time. The list will be collapsed to only display selected values except during
editing, making it appropriate for longer lists of values. Click the blank space to
the right of selected values to see additional options. Click the x on a selected
value to de-select it.

Radio Fields

Radio fields provide a list of values where only one value can be selected at a time.
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The entire list of all values will be displayed at all times, making it appropriate for
shorter lists of values. Click the circle of the desired value, and any previously
selected value will be deselected automatically.

Relate Fields

Relate fields allow users to select a record from a single module. Both relate fields
(which are visible via Admin > Studio > {Module Name} > Fields) and one-sided
relationships (i.e. one-to-many and one-to-one) are represented by the same relate
field user interface. Type the first few characters of the desired record and either
select from the type-ahead results or click "Search and Select..." at the bottom for
a more robust search.

Tags Fields

The Tags field allows users to enter keywords or phrases in order to connect Sugar
records by common attributes that may not be defined via basic database fields.
Once a new tag has been created, it can be re-used by any user in any module that
contains a Tags field. To use the Tags field, click inside the field and type a word or
phrase. Sugar will recommend existing tags as you type, but you can choose to
ignore the recommendations and create an entirely new tag. For more information
about tagging records in Sugar, please refer to the Tags documentation.
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Teams Fields

The Teams field specifies which teams of users have access to view the record. An
individual team selection works like a dropdown field which is described above.
Click the Plus button to add additional teams to the record or the Minus button to
remove a team. Click the Star button to set the primary team. For more
information on teams, please refer to the Team Management documentation.

Note: If your administrator has enabled team-based permissions, you may also see
a Lock button or a "Selected" box on the Teams field. Please refer to the Using
Team-Based Permissions section of this page for more information.

Text Fields

Text fields allow users to enter a word or brief phrase by clicking into the field and
typing. Text fields will accept any combination of characters (i.e. letters, numbers,
spaces, and symbols) but have a 100-character limit by default. Administrators can
edit the maximum character length restriction via Admin > Studio.

Text Area Fields

Text area fields allow users to enter large amounts of text by clicking on the field
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and typing. Administrators can modify the default display size of a text area field
via Admin > Studio, but this will not limit the number of characters that can be
entered by a user. Most browsers supported by Sugar will allow the user to resize
an active text area field temporarily by dragging the bottom corner of the field to
the desired width and height.

Creating Records

There are various methods for creating records in Sugar including basic creation,
quick create, duplication, and import. The same record view layout opens when
creating records by any of these methods and includes all of the relevant fields.
Please note that administrators can configure the Record View layouts to tailor
them to your organization's needs via Admin > Studio. For more information on
configuring layouts, please refer to the Studio documentation.

Basic Record Creation

The most common method of record creation is via the individual module itself
using the Create button in the list view or the Create {Module} option in the
module tab. For the Cases, Tasks, Leads, and Opportunities modules, you can also
create records using the Create button in the tile view. This opens the record view
layout in edit mode which allows you to enter all of the desired information.

The following steps cover creating a task via the Tasks module as an example:

1. Click the triangle in the Tasks module tab to open the actions menu and
select "Create Task". You can also click the Create button on the upper
right of the Tasks list view or tile view.

From Tasks list view:

From Tasks tile view:
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From Tasks module tab:

2. Enter appropriate values for the fields in the record view layout. All
required fields will indicate "Required" in the field and must be completed
prior to saving.

3. Once the necessary information is entered, click "Save".

Creating via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick-create button on the upper right of any Sugar page
to access the menu.

Note: Administrators have the ability to enable or disable a module in the Quick
Create menu. Also, some modules are not available to be enabled. For more
information, please refer to the Developer Tools documentation.

The following steps cover creating an account via Quick Create as an example:

1. Open the Quick Create menu on the upper right of any Sugar page and
select "Create Account".

2. Enter appropriate values in the fields in the record view form. All required
fields will indicate "Required" in the field and must be completed prior to
saving.
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3. Once the necessary information is entered, click "Save".

Creating via Subpanels

On record views, beneath a record's fields, subpanels appear which contain related
records from various modules. You can create a related record as well as link an
existing record directly from the subpanel.

Note: Administrators have the ability to disable a module's subpanels for the
entire instance via Admin > Display Modules and Subpanels. For more
information, please refer to the Developer Tools documentation.

The following steps cover creating a contact via a Contacts subpanel as an
example:

1. Click the Plus button on any Contacts subpanel on a related module's
record view.

2. Enter appropriate values in the fields in the record view form. All required
fields will indicate "Required" in the field and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save".

Creating via Duplication

You can also create a new record by duplicating an existing record. The Copy
option is useful if the record you are creating has similar information to an existing
record. Please note that existing subpanel relationships for the original record will
not carry over to the duplicate.

The following steps cover creating an account by duplicating an existing account
as an example:

1. Navigate to an account's record view.
2. Click the Actions menu and select "Copy".
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3. The displayed record view is pre-populated with the original account's
values. Update the necessary fields, then click "Save".

Importing Records

The import function allows you to push multiple records of a single module into
Sugar using a .csv file instead of creating them one-by-one. For more information,
please refer to the Import documentation.

The following steps cover importing accounts as an example:

1. Click the triangle to access the Actions menu in the Accounts module tab
and select "Import Accounts".

2. In Step 1, select the import file and choose "Create new records only".
Click "Next".

3. In Step 2, confirm the import file properties. Click "Next".
4. In Step 3, confirm the field mappings for the import. Click "Next".
5. In Step 5, view the import results.

The Created Records tab will show all of the new account records.
The Duplicates tab will show any records in the file that were
identified as duplicates of existing records and thus not imported.
The Errors tab will show records that were not imported due to
errors detected during import.

                        88 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Import#Importing_New_Records


 

Viewing Records

Sugar records can be viewed from a variety of locations including via the module's
list view, record view, Recently Viewed menu, dashlets, and reports. Please note
that you will only be able to see records as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation.

Viewing via List View

Each module's list view displays all of the module's records that meet the current
search criteria. To access the list view, simply click the desired module tab. While
list views only show key fields, you can click the record's name to open the record
view and access additional details. For in-depth information about list views,
please refer to the List View section of this page.

Viewing via Record View

Each record's record view displays thorough record information including all
relevant fields followed by subpanels of related records belonging to various
modules. The record view can be reached by clicking a record's name link from
anywhere in the application. For in-depth information about record views, please
refer to the Record View section of this page.

Viewing via Tile View

Tile view allows users to visualize and engage with records in an intuitive drag-and-
drop interface. Users can drag a tile from one column to another to change its
state, stage, or expected close date. Tile view is available for the Cases, Tasks,
Leads and Opportunities (with or without Revenue Line Items) modules. For in-
depth information about using tile view, please refer to the Tile View section of this
page.

Viewing via Recently Viewed

As you work, Sugar will keep track of which records you have recently viewed.
Click the triangle on the right of any module's tab to see a list of the 3 records you
most recently viewed in that module. You can also click the triangle to the right of
the Sugar cube icon to see records recently viewed from across all Sugar modules.
Clicking a record name within these lists will open it in record view.
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Viewing via Dashlets

Sugar Dashlets allow you to get a quick view of various records, activities, reports,
etc. Dashlets may be added to your Home page or to the intelligence pane of any
module's list view or record view. List View dashlets display lists of records and
their desired fields. Clicking a record's name from any dashlet will open it in
record view. For more information on using dashlets, please refer to the 
Intelligence Pane documentation.

Viewing via Activity Streams

The activity stream allows you to see record changes and user posts relevant to
records you are following in Sugar. Activity stream posts will display records when
that record was modified or when a user mentions the record in their post.
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Clicking the record's name link will open its record view. You can also preview the
record directly from the activity stream by clicking the Preview button to the right
of the post. For more information on viewing records via the activity stream,
please refer to the Activity Streams documentation.

Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.

Viewing via Preview

Record previews are accessible anywhere you see the Preview button (eye icon),
usually to the right of a record's row. Click on the preview icon to expand or
refresh the intelligence pane and view details about the record without leaving the
current page. Record previews are available from list views, subpanels, duplicate
search, Search and Select drawers, and activity stream posts.

In the preview, Sugar displays the topmost fields from the module's record view
and the record's most recent activity stream entries in the intelligence pane. To
view all of the fields that are on the record view, click "Show more...". From
module list views, left and right arrow buttons at the top of the intelligence pane
allow you to preview the next or previous record of the current list. To close a
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preview, simply click the "X" in the corner of the intelligence pane.

Viewing via Reports

The Reports module allows you to build, run, and manage reports to gather key
record information. In addition to only displaying the fields and relationships you
desire, reports can utilize complex filters to display specific subsets of your
records. Once a report is run, you can click any record's name link in the results to
open its record view. Please note that you can only directly access record views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

In addition to navigating to the Reports module and finding or building relevant
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reports, you can use the View {Module} Reports option to see only the reports
based on the desired module.

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation.
Check with your system administrator if you cannot access the Reports module.

Searching for Records

Each module's list view includes a list view search to help you easily locate records
in a module-specific manner. Matching records will be displayed in the list view
below. Global search allows users to search for information across their entire
Sugar database rather than restricting searches to a specific module. Sweet Spot
search allows users to search for information, modules, and common actions
across their entire Sugar database by using a keyboard shortcut. In each of these
three searches, Sugar automatically appends the wildcard character (%) to the end
of your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

Global Search

For a brief introduction to global search, please refer to the Global Search section
of this page. For in-depth information on both search methods as well as how
wildcards are used in each method, please refer to the Search documentation.

Sweet Spot Search

The Sweet Spot feature allows you to quickly and conveniently search Sugar from
anywhere within the application. Using the Sweet Spot feature, you can find and
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navigate to:

The Home page Actions menu
A module (e.g. Accounts, Bugs)
Common actions in the modules' Actions menus (e.g. Create Account, View
Account Reports)
A specific record
The user menu

You will only be able to see actions and records as allowed by your team
membership, user access type, and assigned roles. If you are an administrator, you
can also find and navigate to many of the sections on Sugar's Admin page.

To open Sweet Spot, use the appropriate shortcut key sequence for your operating
system:

OS Shortcut
Mac OS X shift+cmd+space
Windows shift+ctrl+space
Linux shift+ctrl+space

Once the Sweet Spot opens, begin typing your query and the search results will
update as you type. For more information on configuring Sweet Spot search,
please refer to the Search documentation.

List View Search

List view search enables users to easily search by the record's name within an
individual module and pull up matching records in the list view. The search also
provides a Filter option allowing you to narrow your search further using the
available options as follows:

Create : Create a new custom filter which you can use to filter your search
Note: You can also click "Create" to the right of the Filter option.

All "Module Name" : Returns all records in the module (e.g. Accounts) to
which you have access
My "Module Name" : Returns only records assigned to you
My Favorites : Returns only records you have marked as favorites
Recently Created : Returns only records you created in the module within
the last 7 days
Recently Viewed : Returns only records you have viewed in the module
within the last 7 days
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When you choose a filter, Sugar will return records that match both the selected
filter and any name provided in the open Search box in the filtered list view
results. For example, if you select "My Accounts" in the Filter options and enter a
query in the Search box, Sugar will only return account records that are assigned
to you and have names that match the search term. Once the search is complete,
the relevant results will populate in the list view below the search bar.

Note: The yellow highlighting in this image has been added for effect and will not
appear in the application.

When you perform a search using a filter from the filter list, the filter will continue
to apply if you navigate away from and then return to the module's list view. Any
text query entered in the open Search box, however, will not be preserved. 

To see all account records to which you have access, simply select the All Accounts
option in the filter and remove any text from the search bar:
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To clear an applied filter, click the "x" on the selected filter option (e.g. My
Accounts) in the Search box; to clear a text query from the search, click the "x" on
the right end of the search box:

To update the filtered list view with the most recent results, click on the Refresh
icon to the right of the search box:

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation. Administrators can configure what fields appear on the List View
Search via Admin > Studio for certain modules. For more information on editing
layouts, please refer to the Studio documentation.

Creating a Filter

Users can also create new filters via the Create option in the Filter list of the
search bar. This allows users to add custom, complex filter options when searching
in the module's list view. You have the option to add multiple fields to your new
filter by clicking the Plus button to the right of the filter selection dropdown lists
and set select operators along with their value(s). A filter's criteria need to be true
for a record in order for it to appear in the list view search result. Additionally,
filters with no specified values may be saved as a custom filter to act as a filter
template when a user often searches using the same fields but with varying values.
Please note that only fields you have view access for will appear in the Filter list
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when creating a search filter.

When you run a search using a created filter, the search will be preserved when
you navigate away from the module. Returning to the list view will automatically
display the results of your last filter.

The following steps cover creating a new Assigned to filter in the Accounts module
as an example:

1. Click the Filter option on the Accounts search bar then select "Create".

You can also click "Create" to the right of the Filter option.
2. Select the field you wish to add to your filter as well as the condition and

matching criteria.
Note: Only fields you have view access for will be available to add
in the Filter list.

3. To add additional fields to the new filter, click the Plus button to the right
of the filter.

To remove fields from the new filter, click the Minus button to the
right of the filter.
To clear any filter values (e.g. Will Westin), simply click the "x" to
the right of the value or select "Reset" to the left of the Save button.

The list view will automatically display results matching your filters as you create
and modify the criteria. To view the most recent matching records for an existing
filter, click on the Refresh button to the right of the search box.

Note: When filtering a relate field using "is any of" or "is not any of", you can
select up to 20 values.

                        97 / 1.116



 

Saving a Filter

Saving a filter will preserve the chosen fields as well as the condition(s) of the
matching value(s). Additionally, it will allow users to easily select previously
created and saved filters from the Filter options.

The following steps cover saving a new search by Name filter for the Accounts
module as an example:

1. Create a new filter to perform a search on your desired fields.
2. Enter a name for the new filter (e.g. "Accounts assigned to Sarah and

Will").

3. Click "Save" to add this filter to the module's Filter options.

You can also create and save a filter without entering any filter values (e.g. Sarah
Smith) if you wish to enter new values each time you utilize the filter. When re-
using the filter simply enter the appropriate filter value(s) and the list view will
display the matching results. Once you are done with the filter, click "Reset" to the
far right of the filter's name to clear the filter value(s).

The custom filter can always be edited as necessary by selecting the filter and
updating the fields, conditions, values, etc. via the filter details panel. Once the
necessary updates have been made, click "Save" to preserve the changes.

Please note that you can easily delete custom filters by selecting the filter (e.g.
Accounts assigned to Sarah and Will) from the Filter list, clicking the filter's name
on the Search bar, then clicking "Delete" on the filter details panel.

List View

A module's list view displays all records meeting the current search criteria and to
which users have access. You can view the basic details of each record within the
field columns of the list view or click the record's name to open the record view. To
access a module's list view, simply click the module tab (e.g. Accounts) in the
navigation bar at the top of Sugar.

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
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documentation.

Users with administrator or developer access have the ability to change what fields
are visible in the list view via Admin > Studio. For more information on editing
layouts, please refer to the Studio documentation.

Total Record Count

The list view displays the total count of records (e.g. "20 of 21+") on the upper left
of the page next to the module name (e.g. Accounts). The count will capture the
total number of records displayed on the current set of list view results. If there
are additional records in the list view results set, a hyperlinked number (e.g.
"21+") will display to the right of the initial count. Simply click the hyperlinked
number in the parentheses to view the total count of all records in the list view
result set.

Please note that, by default, Sugar displays 20 records per list view results set, but
administrators can change the number of records displayed via Admin > System
Settings. For more information, please refer to the System documentation.

Create Button

The Create button on the upper right of the module's list view allows users to
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easily create new record's in the module. Once you click the button, the module's
record view layout opens where you can enter all of the relevant information to
create the new record. Please note that administrators can configure the Record
View layout via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation.

List View Search

To search for a specific record within a module or for a list of module records
filtered by name, use the search bar located above any module's list view. Start
typing a word into list view search and Sugar will retrieve all records that start
with the given characters.

List view searches also support the system wildcard character (%) to retrieve
results that contain certain characters in their name or title. For more information
about performing module-specific searches via list view, please refer to the Search
documentation.

Refreshing Search Results

The list view's Refresh button provides a quick way to reload the results of any
filtered or unfiltered list view without reloading the browser or losing any filter or
search criteria you may have set. Simply click on the Refresh button to the right of
the search box to load the most current list of matching records.

Checkbox Selection
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Users can perform various types of actions on module records by first selecting the
desired records from the module's (e.g. Contacts) list view. To select individual
records from the list view, mark the checkbox on the left of each record row.

To select all records displayed on the current set of list view results, click the
checkbox to the left of the Actions menu. Please note that a dialog will appear
below the list view's column headers indicating that you have selected all records
on the list view's current result set (e.g. 20). To select all records in the search
results, click "Select all records" in the dialog.

If you wish to clear the selection for all records on the list view result set, simply
click "Clear selections" in the dialog. You can also clear the selections for all
records by clicking the checkbox option again to remove the checkmarks.

Mass Actions Menu

The Mass Actions menu to the right of the checkbox option allows you to perform
various actions on the currently selected records. Please note that the actions
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available to perform will vary between each of the modules. To access the Mass
Actions menu simply click the triangle next to the checkbox option.

For more information on the actions available within a specific module, please
refer to the list view section in the application guide pertaining to that module. The
most common actions available in the Mass Actions menu are as follows:

Menu Item Description
Email For modules which include an Email

field, send an email to one or more
records' email addresses

Mass Update Mass update one or more records at a
time

Merge Merge two or more duplicate records
Recalculate Values For modules with a calculated field,

updates calculated values to reflect
recent changes to calculated fields
made via Admin > Studio

Delete Delete one or more records at a time
Export Export one or more records to a CSV file

The following sections will cover the most common type of actions available in the
Mass Actions menu.

Favorite Designation

Users have the option to mark records as favorites via a module's list view. This
allows users to designate records that are important or will be viewed often so that
they can easily be accessed via the search filter's My Favorites option or from the
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module tab's Favorites option. In the module's list view, the star on the left of each
record's row is orange once marked to indicate a favorite record. For more
information on how to mark records as favorites, please refer to the Favoriting
Records section of this documentation.

The following steps cover marking records as favorites via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account records you wish to mark as

favorites.
3. Mark the star icon on the left of each desired account's row.
4. To remove the account as a favorite, click the star again to revert it to

white.

Column Reordering

List view provides the ability to reorder columns by dragging and dropping the
title of the column to the desired location. The new column order will remain for a
user upon subsequent visits to the module until the user's browser cache is
cleared. You can reset the column order back to the default view by clicking the
Gear icon to the far right of the list-view column headers and selecting "Reset
default view". Please note that this option only appears if the current column order
differs from the default order.

Column Resizing

Users can easily adjust the size of columns in list views per their viewing
preference. Simply place your cursor on the column divider, and when the left-and-
right arrow appears, click and drag the column to the desired size.

The set column width will be preserved when you navigate away from the page.

                       103 / 1.116



 

Sugar will render the preferred column size across sessions until the user removes
or resets the relevant browser cookies. You can reset the column width back to the
default size by clicking the Gear icon to the far right of the list-view column
headers and selecting "Reset default widths". Please note that this option only
appears if at least one of the column widths in the current list view is different
from the default column width.

Changes to the column width made by administrators in Studio are only respected
if the user has not resized the specific column in the list view. The column width
set by the user will supersede the default column width configured in Studio until
the user resets the list view back to the default widths. For more information on
how admins can set column widths, please refer to the Studio documentation.

Note: Sugar enforces a minimum width for currency fields (e.g. Best, Likely, etc.)
in list view columns to prevent the columns from being collapsed beyond this limit.

Column Sorting

Sugar's list view provides users the ability to sort all of the current search results
by a field column in either ascending or descending order. To sort by a field or
switch the sort direction, click the column header noting that the fields which
allow sorting will have a pair of arrows. You can click the column header again to
reverse the sort order.

Note: List views may only be sorted by one column at a time and cannot be sorted
by custom relate fields or the Tags field.

Column Selection

Sugar gives users the ability to personalize the list view by specifying which fields
they want to be displayed in the list view. You can click the Column Selection icon
to the far right of the list-view column headers to see the list of available fields.
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Click a field name to toggle whether or not it is included as a column in your list
view. Please note that administrators have the ability to configure what fields are
available to display in the list view via Admin > Studio. For more information on
configuring fields to display in the list view, please refer to the Studio
documentation.

Preview

Users can preview a record's details directly from the module's list view by
clicking the Preview icon to the far right of each record's row. Please refer to the 
Viewing via Preview section of this page for more information.

Record Actions Menu

The Record Actions menu to the right of each record's Preview button allows users
to edit, follow, delete, etc. specific records directly from the list view. For example,
users have the ability to inline edit the display column fields directly from the list
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view by clicking the triangle next to the Preview icon then selecting "Edit".

The options in the Record Actions menu allow you to perform the following
operations:

Menu Item Description
Edit Edit this record
Follow Follow this record
Delete Delete this record
Convert For the Leads module, convert this lead

More Records

The list view loads an initial number of records meeting the current search criteria
with the option to show additional results at the user's request. By default, Sugar
displays 20 records per list view results set, but administrators can change the
number of records displayed via Admin > System Settings. For more information
on changing the number of displayed records, please refer to the System
documentation. To load the next set of list view results, simply click the More
"Module Name" (e.g. More accounts...) link at the bottom of the list view.

Activity Stream
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The module's activity stream displays user posts made directly via the module as
well as record posts relevant to the module record. To view the module's activity
stream, simply click the Activity Stream button to the right of the list view's search
bar. For more information on how to add posts to the activity stream, please refer
to the Activity Streams documentation.

Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.

You can add comments to posts using the comment button to the far right of each
post. You can also preview the record referenced in record posts by clicking the 
Preview button to the right of each post. The activity stream can be filtered to only
display certain messages (e.g. Messages for Create, Messages for Update, etc.) by
clicking "Filter" above the post input box and selecting the desired message type.
You can also refresh the activity stream to view its latest entries by clicking the
Refresh button to the right of the filter area.

Dashboards

To the right of list views, the intelligence pane displays dashboards when not
displaying a record preview. Dashboards are sets of dashlets configured for the
specific list view to display useful Sugar data. An out-of-the-box default dashboard
will likely be initially displayed on your list view intelligence pane. Sugar admins
are able to create and push custom default dashboards to your views. You may also
create personal dashboards using the dashlets and configurations that best suit
your business needs. All dashboards can also be shared with teams of users who
can then pull the dashboards to their views as desired. Ensure the intelligence
pane is expanded using the Arrow icon at the top right of the list view. For more
information, please refer to the Dashboards and Dashlets documentation.
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Record View

The module's record view displays thorough information regarding the record such
as name, email address, phone number, etc. Beneath the fields, you can toggle
between viewing a record's subpanels of related records (e.g. Opportunities,
Leads) and the record's activity stream. The record view can be reached by
clicking a record's link from anywhere in the application including from the
module's list view.

Please note that you will only be able to view a record according to your team
membership, user type, and role restrictions. In addition, if you can view a record
but do not have the required license type to view a particular field on that record,
the field value is replaced with a pill containing the text "License Required":

For more information on teams, roles, or license types, please refer to the Team
Management, Role Management, or User Management documentation. Users with
administrator or developer access have the ability to change the record view by
configuring the layout via Admin > Studio. For more information on editing
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layouts, please refer to the Studio documentation.

Favorite Designation

Users have the option to mark records as favorites via the module's record view.
This allows users to designate records that are important or will be viewed often so
that they can easily be accessed via the search filter or from the module tab. In the
module's record view, the star to the right of the record's name is gray once
favorited.

Following Designation

Users can also choose to follow specific records to which they have access to in
Sugar by clicking the Follow button to the right of the record's name. The ability to
follow records allows each user to personalize their activity stream by specifying
which records' posts should appear on the activity streams displayed on their
Home page and in module list views. Please note that you will automatically follow
the records that you create as well as records that are assigned to you. You will
not, however, automatically follow records you import. Should a user lose access to
a record in Sugar, they will automatically stop following that record. Instructions
for toggling the Following button on a record view, please refer to the Following
via Record View section of this documentation.
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Next or Previous Record

On the upper right of the record view, there are two buttons that allow you to page
through each record in the module's list view's current search results. Clicking the
Left arrow button displays the previous record of the current search results while
clicking the Right arrow button displays the next record of the current search
results.

Actions Menu

The Actions menu on the top right of each module's record view allows you to
perform various actions (e.g. edit, copy, delete) on the current record.

Please note that certain action items (e.g. Convert Lead) in the Actions menu can
vary between the various modules. The following sections will cover the most
common action items across the modules. For more information on a specific
action not listed below, please refer to the record view actions menu section for
the specific module's documentation in the application guide.

Menu Item Description
Edit Edit this record
Share Share a link to this record via email
Download PDF Download record information as a PDF

file
Email PDF Email record information as a PDF

attachment
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Find Duplicates Locate potential duplicates of this
record

Copy Duplicate this record
Historical Summary View a historical summary of activities

(e.g. calls, meetings related to this
record

View Audit Log View a sequence of changes made to
this record

View Personal Info Display this record's fields which an
admin has designated as personal
information

Delete Delete this record

Show More

The record view typically displays a few key fields (e.g. website, mobile phone,
office phone) on the business card panel with the option to view more fields by
clicking the "Show more..." link on the bottom left. Please note that administrators
can configure the fields that appear on the business card panel via Admin > Studio
> Layouts > Record View. For more information on editing layouts, please refer to
the Studio documentation.

Subpanels

Beneath the module (e.g. Accounts) record's fields are subpanels containing
related records from various modules (e.g. Contacts, Leads, Opportunities). You
can create a related record as well as link an existing record directly from the
subpanel. Once the records appear within the subpanel, users can preview the
record's detail and edit the record's data directly from the record view. Please note

                       111 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Editing_Layouts


 

that the subpanels are viewable when you access the Data View section of the
module's record view.

Note: Administrators may choose to disable a module's subpanels for the entire
instance via Admin > Display Modules and Subpanels. For more information,
please refer to the Developer Tools documentation.

Related Record Subpanels

Subpanels under a module's record view contain its related records. Each
relationship between two modules has a type, and that type determines if the
relationship produces a field or a subpanel for each side. When a record of the
primary module can be related to only one record of a second module (i.e. 1-1 or
M-1 relationships), the relationship is displayed as a field on the primary module.
When the record can be related to multiple records of a second module (i.e. 1-M or
M-M relationships), the relationship is displayed as a subpanel instead since
subpanels can hold many records.

For example, an account may be related to multiple contacts, so the related
contacts are displayed in a subpanel on the account record. Administrators or
users with developer-level role access may choose to change a subpanel's title and
included fields by configuring the layout via Admin > Studio to provide visibility to
the most important fields. For more information on modifying subpanels, please
refer to the Studio documentation.

Related-record subpanels provide the following information and capabilities:
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Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable the sticky feature and
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation.

Column Widths : Place your cursor on the column divider and, when the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.

Note: Sugar enforces a minimum width for currency fields in list
view columns to prevent the columns from being collapsed beyond
this limit.

Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Create a New Linked Record : Click the Plus button on the upper right of
a subpanel to relate a new record to the record you are currently viewing.
Please note that the Link Existing Record option is not available when the
relationship is required in the related module (e.g. in an account's
Opportunities subpanel).

Note: Because creating a new related record opens a drawer on top
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of the current record view, you should use the Cancel button to
return to record view. Using the browser's back button will return
you to the previous page.

Link Existing Record : Click the triangle to the right of the Plus button
then select "Link Existing Record" to relate existing records to the record
you are currently viewing.

Note: Because linking an existing record opens a drawer on top of
the current record view, you should use the Cancel button to return
to record view. Using the browser's back button will return you to
the previous page.

Favorites Designation : Click the star on the left of a record's row to
toggle it as a favorite. A dark-gray star indicates that the record is a
favorite while a white star indicates it is not. For more information, please
refer to the Favoriting Records section of this page.
Hyperlink Fields : Blue field values, such as record names, may be clicked
to open the record in record view. Record view provides a complete picture
of the record and is described in detail in the Record View section of this
page. Email addresses also appear in blue and can be clicked to compose
an email to that recipient.
Record Actions Menu : Click the triangle on the right of a record's row to
access the Record Actions Menu which includes the following options:

Preview : To preview a record by displaying its fields and activity
stream in the right-hand side drawer, click the Eye icon to the far
right of the record's row. For more information, please refer to the 
Viewing via Preview section of this page.
Edit : To inline edit the record directly within the subpanel, choose
"Edit" from the Actions menu on the right of the record's row and
click "Save" to preserve the changes.
Unlink : To delete the relationship between the two records,
choose "Unlink" from the Actions menu on the far right of the
record's row. This removes the relationship but does not delete the
record itself. Please note that the Unlink option is not available
when the relationship is required in the related module (e.g. in an
account's Opportunities subpanel).
Additional Options : Some modules may have additional options
available that are covered in the individual module's documentation.

More Records : By default, Sugar displays up to five records in each
subpanel though administrators can alter the number via Admin > System
Settings as described in the System documentation. If additional related
records exist, click "More <Module Name>..." (e.g. "More Accounts...") at
the bottom of the subpanel to load the next set.

Filtering Subpanels

While in Data View, all of the related records will be displayed beneath the
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record's fields. Users have the ability to search for records that appear in the
subpanels as well as filter the view to only display a specific module (e.g. Leads,
Contacts). To locate a record by name, enter the keyword into the Search bar, and
the subpanel(s) with the matching record(s) will appear below.

To filter, simply click the Related option to the far left of the Search bar and select
the module whose subpanel you wish to view. Filter and search may be combined
to only display matching records within a selected module. To see all subpanels to
which you have access, simply select "All" in the Related options and remove any
text from the search bar. When you run a search using a saved or created filter,
the search will be preserved when you navigate away from the page. Returning to
the page will automatically display the results of your last filter. Please note that
search strings entered in the open Search box are not preserved when navigating
away.

When a Sidecar module (e.g. Contacts, Leads, Tasks) is selected from the Related
options, you have the option to filter the related subpanels further using one of the
available options (e.g. My Favorites, Recently Created). Please note that you can
also create custom filters for related Sidecar modules. Once the related module
(e.g. Contacts) is selected, either click the Filter option and select "Create" or click
"Create" to the right of the Filter option. For more information on creating a
related records filter, please refer to the Creating a Related Records Filter section
of the Search documentation.

Reordering Subpanels
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Users can easily move subpanels to a new location on the record view by dragging
and dropping the subpanel's header. The new subpanel order will remain for a
user upon subsequent visits to the module until the user's browser cache is
cleared.

Refreshing Subpanels

To refresh the results of a filtered or unfiltered subpanel view, simply click on the
Refresh button to the right of the search box. This will reset the current view of
expanded subpanels with the most current results that match your search and
filter criteria. Please note that subpanel results in a collapsed state are not
affected by the Refresh button.

Activity Stream

The record view's activity stream displays user posts and record posts specific to
the individual module record. To view the record's activity stream, simply click the
Activity Stream button below the record's fields. Users can view all posts in the
record view's activity stream even if they do not follow the record in Sugar. Please
note that you must follow the record if you wish to view the record view posts via
the Home page or List View activity stream. For more information on how to add
posts to the activity stream, please refer to the Activity Streams documentation.
You can add comments to posts by clicking the Comment button to the far right of
each post, entering your comment, then clicking "Reply". You can also preview the
record referenced in the record post by clicking the Preview button. The activity
stream can also be filtered to only display certain messages (e.g. Messages for
Create, Messages for Update) by clicking "Filter" above the post input box then
selecting the desired message type.

Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.
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Dashboards

To the right of record views, the intelligence pane displays dashboards when not
displaying a related record preview. Dashboards are sets of dashlets configured for
the specific record view to display useful Sugar data. An out-of-the-box default
dashboard will likely be initially displayed on your record view intelligence pane.
Sugar admins are able to create and push custom default dashboards to your
views. You may also create personal dashboards using the dashlets and
configurations that best suit your business needs. All dashboards can also be
shared with teams of users who can then pull the dashboards to their views as
desired. Ensure the intelligence pane is expanded using the Arrow icon at the top
right of the record view. For more information, please refer to the Dashboards and
Dashlets documentation.

Tile View

For cases, tasks, leads, and opportunities, a unique tile view is available that
displays records in an intuitive drag-and-drop interface. To access tile view,
navigate to the Cases, Tasks, Leads, or Opportunities list view and click on the Tile
View icon next to the search bar.
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New records can be created from the tile view by clicking the Create button on the
upper right. You can also edit any records displayed in the tile view by clicking the
record's name/subject link within the tile or by dragging a tile from one column to
another to change its stage, status, or expected close date depending on the
current layout. For information on configuring Tile View layouts, refer to the Tile
View Settings documentation in the Administration Guide.

Working With Records in Tile View

Tile view offers users an alternative way to view and interact with cases, tasks,
leads, and opportunities. In the tile view, records will be grouped in vertical
columns that represent the record stages or the group-by option configured by
your administrator. For opportunity records, users can toggle between two group-
by options because there is an always-on "Opportunities by Time" option. For more
information on using tile view with opportunities, refer to the Opportunities
documentation.

To further refine the tile view, users can filter the visible tiles by utilizing the
standard Sugar filter options. Simply create or select a stock or saved custom filter
(e.g., My Favorites, My Team's High-Value Opps) and the tile view display will
update in real-time. If a saved filter has already been applied to the module's list
view (e.g. Opportunities), then that same filter will be automatically applied to the
tile view and vice versa. Please note that the filter will continue to apply as you
toggle between the tile view tabs, switch between the module's list view and tile
view, or navigate away from the module and then return to the tile view again. You
can also use the search bar to refine the display by a keyword or phrase. For more
information on using filters, refer to the List View Filters section of this page.
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Note: The yellow highlighting in this image has been added for effect and will not
appear in the application.

Click and drag a tile from one column to another to change its stage, status, or
expected close date depending on the current layout. As an example, the following
screenshot illustrates how to change the expected close date of an opportunity
from a day in August 2019 to the last day of September 2019. Simply click on the
tile and drag it into the appropriate column:

For opportunities with multiple revenue line items, the expected close date will
change for all of the related line items. For more information on using tile view
with Revenue Line Items enabled, refer to the Opportunities documentation.

Intelligence Pane

Intelligence panes display on list views, record views, and to the right of the Home
page activity stream. They provide users with valuable record information via
dashboards as well as showing previews of Sugar records.

Dashboards
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Most intelligence panes have out-of-the-box default dashboards with a set of
commonly used dashlets. Admin users may also have created default dashboards
that are pushed to teams of users. In addition, individual users can create their
own personal dashboards with whichever dashlets they wish to use. Any dashboard
can also be shared with additional teams who can then pull the dashboard into
their intelligence panes for use.

Please refer to the Dashboards and Dashlets documentation for in-depth
documentation about using dashboards as well as information about commonly
used dashlets.

Previews

Users can preview a record's details by clicking the Preview icon to the far right of
a record's row or activity stream post. The preview appears in the intelligence
pane to the right of the Home page's activity stream and on list views and record
views. The preview displays the fields that have been configured by your
Administrator in Studio > Layouts > Preview View and the record's most recent
activity stream entries. For more information on editing preview layouts, please
refer to the Studio documentation.

Viewing Previews

There are various options available for viewing previews in Sugar including via the
list view, record view, and activity stream. Previewing allows users to easily view
key information regarding a record directly from the intelligence pane without
navigating away from the current page. Users can mark a record to follow or
unfollow via the preview by clicking the Follow or Unfollow button within the
record's details. Clicking the hyperlinks (e.g. account name, website, email
address) within the preview allows you to access the record view, external
company website, compose email, etc. 

Previewing From List Views

Users can view a record's topmost fields directly from the module's list view by
clicking the Preview icon to the far right of each account's row. The intelligence
pane will display the record's details with key information regarding the record as
well as any related activity stream information.
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Previewing From Record View

Users can also view a record's details from the module's record view by clicking
the Preview icon to the far right of each record row in the subpanel. The
intelligence pane will display the record's details with key information regarding
the record as well as any related activity stream information.
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Previewing From Activity Streams

In addition, you can also preview the record referenced in activity stream posts
from the Home page, list view, and record view activity stream by clicking the
Preview button to the right of each post. Please note that preview is only available
for Create, Update, Relate, and Un-relate-type posts in the activity stream. For
more information about previewing activity stream posts, please refer to the 
Previewing Posts section of the Activity Streams documentation.

Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.

The intelligence pane displays the topmost fields from the module's record view
and the record's most recent activity stream entries.

                       122 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/Activity_Streams#Previewing_Posts
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#Activity_Streams


 

Previewing From Global Search

Users can view a record's details directly from the View All Results page for Global
Search by clicking the Preview icon to the far right of each record's row. The
intelligence pane displays the topmost fields from the module's record view and
the record's most recent activity stream entries. For more information on
previewing via the View All Results page, please refer to the Search
documentation.

Show More

In the preview, Sugar displays the topmost fields from the module's record view.
To view all of the fields that are on the record view, click "Show more...". Please
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note that administrators can configure what fields appear on the business card
panel via Admin > Studio > Layouts > Record View. For more information on
editing layouts, please refer to the Studio documentation.

Previewing a Record's Activity Stream

When previewing a record via the intelligence pane, you can also view any related
activity stream posts which will appear below the record's detail. Please note that
you cannot create new posts or comment on posts via the activity stream when
previewing a record. For more information on creating posts and commenting on
posts, please refer to the Activity Streams documentation.
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Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.

Previewing Next and Previous Records

Above a previewed record in the intelligence pane, there is a Left and Right arrow
button that allows you to scroll through the next and previous records. Clicking the
Left arrow button displays the previous record's preview while clicking the Right
arrow button displays the next record's preview. When previewing from the
module's list view, you can scroll through the list view's current search results.
When previewing a related module record from a module's record view, you can
scroll through the list of related records in the specific subpanel.

Closing a Preview
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If you no longer wish to preview the records, you can simply close the preview by
clicking the "X" on the upper right of the intelligence pane. Please note that the
dashboard view will display again on the intelligence pane once you close the
preview.

Editing Records

Records may be edited at any time to modify or add information. Edits can be
made via record view or list view as detailed below. For instructions on how to edit
the various field types, please refer to the Field Types section.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information, please refer to the Role Management documentation. Check
with your system administrator if you do not see the edit options.

Editing Inline via Record View

Users can edit individual fields in record view without entering the full edit mode
by clicking the field name or value. If a field that supports inline editing is not
empty, a pencil icon appears when you hover over it. If the field is empty, the
field's label is displayed as a clickable pill with a plus (+) icon next to it. You can
click on the pencil or pill to begin editing the field. After entering your desired
values, click "Save" to preserve your changes to one or several fields.

Editing via Record View

You can edit many fields at once via the record view by clicking the Edit button on
the upper right of the page. Once the record view layout is editable, update the
necessary fields, then click "Save" to preserve your changes.
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Editing Inline via Subpanels

Beneath the record's fields are subpanels containing related records from various
modules. You can edit individual fields (e.g. Email, Office Phone) for records
directly within the subpanel without entering the full edit mode. Simply click the
Actions menu to the far right of the record's row and select "Edit".

The fields on the record's row will become editable and allow users to type or
select a new value. You can click the double arrow icon on the upper right of the
page to expand the subpanel list view's width to make editing easier. Click "Save"
to preserve your changes.

Editing Inline via List View

You can also edit individual fields on a module's list view without entering the full
edit mode. Click the Record Actions menu to the far right of the record's row and
select "Edit".

The fields on the record's row will become editable and allow users to type or
select a new value. You can click the double arrow icon on the upper right of the
page to expand the list view's width to make editing easier. Click "Save" to
preserve your changes. After saving, please refresh the page to have any list view
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filters be applied to the new record's values.

Note: Text area fields are not inline editable from list views.

Editing via Preview

Users have the option to edit fields directly in a record's preview when previewing
from the module's list view or related-record subpanel. Please note that the
preview edit feature is enabled by default, but administrators can disable this
feature via Admin > System Settings based on their organization's needs.

To edit a record via the list view preview, navigate to a module's list view and click
the Preview button to the far right of a record's row in order to open the preview.

\

To edit a record via the subpanel preview, navigate to a module's record view,
scroll down to the subpanel area beneath the record's details, and click the
Preview button to the far right of the desired record's row to open the preview.
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To edit the record's fields, simply click the pencil icon in the Preview header. The
fields on the record's preview will become editable and allow you to type or select
a new value. Click "Save" to preserve your changes.

Editing via Tile View

For the Cases, Tasks, Leads, and Opportunities modules, a unique tile view is
available that displays records in an intuitive drag-and-drop interface. Users have
the option to edit any records displayed in the tile view by dragging and dropping
tiles among columns or by clicking the record's name/subject link within the tile.
Clicking the tile will open the record view layout where you can update the
necessary fields then click "Save" to preserve the changes. For more information
on how to use tile view, refer to the Tile View section of this page.
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Mass Editing via List View

Mass Updating allows you to apply the same changes to multiple records at once.
Administrator users or users with developer-type role access can control which
fields are available during mass update via Admin > Studio. Fields with the data
type of date, datetime, dropdown, multiselect, radio, relate, flex relate, or tags can
be made available for mass updating. For more information on configuring the
mass update fields, please refer to the Studio documentation. After using list view
search to locate the desired records, you can choose individual records or use the 
Select All option to modify all of the current results. Using the Select All option will
allow you to update up to 1000 records at a time. If you wish to update more than
1000 records or update a specific group of records from the list view, use filters to
perform the updates in smaller batches.

Please note that your ability to mass update may be restricted by a role. For more
information on roles, please refer to the Role Management documentation. Check
with your system administrator if you do not see the Mass Update option.

The following steps cover mass updating account records as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the list view's list view search to identify accounts you wish to modify.
3. Select the desired accounts then choose "Mass Update" from the Actions

menu.

4. The Mass Update panel will appear below the search bar. Set values for the
field(s) you wish to alter. The following options may be available in the
Mass Update panel:
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Add Row/Remove Row : To mass update several fields at once,
click the plus icon to the right of the row.
Append {Field}(s) : When mass updating a field that may contain
multiple values (e.g. Tags, Teams), Sugar will display a checkbox
labeled "Append {field}(s)", where {field} is the name of the field
you have selected. This option is enabled by default to prevent loss
of data by adding the new values to any existing data in the updated
field. Disable the checkbox if you prefer to overwrite any existing
data in the updated field.

These additional options appear when mass updating the Teams
field:

Set as Primary Team : Use the star icons to specify which
team, if any, should be set as the primary team on the
updated records. A primary designation is required when
the Append Team(s) option is disabled.
Add Team/Remove Team : Specify multiple teams by using
the plus and minus icons adjacent to the Team selection
field.

5. Click "Update" to save the changes to all of the selected account records.

Note: If your administrator has enabled team-based permissions, you may also see
a Lock button or a "Selected" box on the Teams field. Please refer to the Using
Team-Based Permissions section for more information.

Deleting Records

If a record is invalid or should no longer appear in your organization's instance, it
may be deleted from either the record view or list view. Deleting via the record
view allows you to delete the current record while the list view allows for deleting
one or more records at a time. Deleting a record will not delete its related records
and will only remove the relationship, so you may wish to also delete any related
records to avoid orphaned records.

Please note that your ability to delete accounts in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Delete
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options.

Deleting via Record View

The following steps cover deleting an account via record view as an example:

1. Navigate to an account's record view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

Deleting via List View

The following steps cover deleting an account via list view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account record you wish to delete.
3. Click the Record Actions Menu to the far right of the record's row and

select "Delete".

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.
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Mass Deleting via List View

The following steps cover deleting one or more account records via the list view as
an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account records you wish to delete.
3. Select the desired account records then choose "Delete" from the Actions

menu.

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

You can also use the Select All feature in the list view, which will allow you to
easily select the first 1000 records in the result set. If you wish to delete more than
1000 records or delete a specific group of records on the list view, please use the 
filter option in list view search to perform the deletions in smaller batches.

Emailing Records

Sugar allows users to compose and send outbound emails to records which include
an Email Address field such as accounts, contacts, leads, and targets as well as any
custom person- or company-type modules which include an email address field.
The sections below cover the various ways to send emails to records. Accounts,
contacts, leads, and targets may also be emailed via campaigns; more information
about emailing these records via campaigns can be found on the respective
product guide pages.
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Note: Before users can send email messages from Sugar, please complete the
required configurations described in the Emails documentation. The logged-in user
must have at least one outgoing email account successfully configured in the
Emails module.

Once an email is successfully sent by a method other than workflows or
campaigns, the email record will appear in the History dashlet and Emails
subpanel on the record's record view. For more information on sending emails
from your own account, please refer to the Emails documentation.

Emailing via List View

For modules that include an Email field, the Email option in the list view's mass
actions menu enables users to send an email message to one or more records at a
time from the module's list view. Simply select the desired record(s) from the list
view then choose "Email" from the list view Actions menu. The Compose Email
window will open allowing you to enter all relevant information (e.g. subject,
body). Please note that the email will be sent to the selected record's primary
email address on file.

The following steps cover composing and sending an email from the Accounts list
view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Find and select the accounts in the list view that you would like to send an

email to.
3. Choose "Email" from the Mass Actions menu.
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4. In the Compose Email window, enter the subject and body of the email
message, edit the recipient fields (optional), then click "Send".

After sending the message, the email record will appear in the Emails subpanel
and History dashlet of each related record.

Emailing via Quick Create

Quick Create provides an easy way to send an email from Sugar to the recipient
associated with the record you are viewing. Quick Create for email messages can
be accessed from the Quick Create menu on the navigation bar, from any Emails
subpanel, or by clicking on a linked email address in Sugar list views or record
views. 

Quick creating via Quick Create menu : Use "Compose Email" in the
Quick Create menu to relate a message to the record you are currently
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viewing and automatically populate the message's "To" field with the
record's name and primary email address. If you use the Compose Email
quick-create option from any other page, simply insert the desired
recipient(s) manually as explained in the Working With Recipient Fields
section of the Emails documentation.

Quick creating via email address : The Quick Create view will also open
if you click on a hyperlinked email address inside the Sugar application.
For example, email addresses displayed in list views, dashlets, intelligence
panes, and record views can be clicked to expose the Quick Create email
compose view pre-filled with the clicked email address.

Quick create from an email address in list view:

Quick create from an email address on the record view:

Quick creating via Emails subpanel : Click the Create (+) icon on the
Emails subpanel to compose an email to the record's primary email address
and automatically relate the message to the record you are viewing.
Note: Legacy modules contain an Activities subpanel instead of an Emails
subpanel.
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To edit or override a default email recipient on Quick Create, click on the name
above the Subject field and the area will transform into the standard
From/To/Cc/Bcc form.

For more information on editing recipients, please refer to the Working With
Recipient Fields section of the Emails documentation. 

Emailing via the Emails Module

Users can compose and send messages directly from the Emails module by clicking
the Compose Email button on the Emails list view or by selecting "Compose Email"
on the Emails module tab menu. This opens up the compose layout, which allows
you to enter all of the relevant information for the email.

Use the following steps to compose an email via the Emails module:

1. Click "Compose Email" on the Emails module list view or the Emails
module tab menu:
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2. Enter appropriate values for the fields in the layout. All required fields are
marked as such and must be completed prior to saving.

3. Once the necessary information is entered, click "Send" to deliver the
message to the recipients specified in the To, CC, and BCC fields.
Alternatively, click "Save Draft" to navigate away from a message without
sending it. Email records in a draft state are only visible to the email's
assigned user and the administrator.

For more detailed information about sending email messages, please refer to the 
Emails documentation.

Emailing via Workflows

Sugar's Workflows module is available to administrators and users with developer-
type role access. With each workflow, a set of conditions triggers a combination of
actions and email alerts, including the ability to send emails to Sugar records that
include an email address. Workflows can send simple emails or can utilize alert
email templates built to include relevant data pulled from the record as well as
your organization's design and branding. For more information, please refer to the 
Workflow documentation.

Emailing via SugarBPM

SugarBPM is available to administrators and users with developer-type role
access. Process definitions created in SugarBPM may contain Send Message
events that include the ability to send emails to Sugar records that have an email
address. Send Message events utilize templates created in the Process Email
Templates module. Templates may include relevant data pulled from the record as
well as your organization's design and branding. For more information, please
refer to the Process Email Templates documentation.

Exporting Records

Exporting downloads all fields for the selected records to your computer as a .CSV
(comma-separated values) file. This may be useful when needing to use Sugar data
with other software such as Microsoft Excel or to update existing records by
exporting, making changes, then importing the altered records back into Sugar.
For more information on updating existing records via import, please refer to the 
Import documentation. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a large number of
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records. If you encounter an error when performing this action, we recommend
selecting the records in smaller batches.

Records may be exported from the module's list view by first locating and selecting
the checkboxes of the desired record. Then, select "Export" from the Mass Actions
menu. You can also export Rows and Columns-type reports if you wish to employ
more complex filter criteria and have greater control over which fields will be
included. For more information on exporting records, please refer to the Export
documentation.

Please note that your ability to export accounts from Sugar may be restricted by a
role. For more information, please refer to the Role Management documentation.
Check with your system administrator if you do not see the Export option.

Using Team-Based Permissions

In Sugar, teams are typically used to control which groups of users can access a
record. Using team-based permissions, however, an administrator may choose to
extend the purpose of teams to control who can perform certain operations on the
record (e.g. edit, delete). When enabled, regular users can use a record's Teams
field to grant access such as viewing, editing, exporting, importing, and deleting
permission to specific users or user groups.

An administrator must first enable team-based permissions and configure roles and
users for this feature. For more information, please refer to the Role Management
documentation. Once the roles are applied to users, any user who can edit the
Teams field in the enabled module can grant extra access to teams of users.

If you are not an administrator and you are not sure if team-based permissions are
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enabled for a module, simply navigate to a record view, click "Edit", and look for a
lock button next to the Teams field:

If you do not see a lock button, reach out to your system's administrator to discuss
whether team-based permissions are appropriate for your organization's business
needs.

Note: Legacy interface modules also support team-based permissions but use a
checkbox labeled "Selected" next to the Teams field to indicate whether or not the
team's members have extra access to the record.

Team-based permissions have no effect on users who have not been assigned to
roles that are configured with "Owner & Selected Teams" access. For more
information, please refer to the Record Operation Definitions section of this page.
For information on using team-based permissions on a record, please refer to the 
Role Management documentation.

To grant extra access to a record for all members of a team who have role
permission, click the lock button next to the team's name. This will enable
additional permissions according to the guidelines in the table below. To control an
individual user's access to a record, add that user's private team to the record's
Teams field and then enable or disable additional permissions according to the
guidelines in the table below. Please note that extra access will only be granted to
users who have a role that restricts their access to "Owner & Selected Teams" as
described in the Role Management documentation.

Team Setting Appearance Button Description
Additional
Permissions
Enabled

A black button with
an open lock

Members of this
team have extra
access to this
record or fields
within the record
as controlled by
their roles

Additional
Permissions
Disabled

A white button with
a closed lock

Members of this
team have no
additional team-
based permissions
as controlled by
their roles
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In the following example, members of team East have standard team access to the
record (at a minimum, view permission), while Jim and members of team West
have view permission plus extra access to do things such as working with
restricted fields, and editing, deleting, and exporting the record. Note that a user
can be an explicit or implicit member of a selected team, and if they are part of
both a selected team and a non-selected team for a record, they will be granted the
extra access.

Note: Changes made to the selected state of teams on an existing record are
audited in the record's audit log.

Locked Fields

Occasionally, you may see a lock icon (not to be confused with the Lock Button
used for team-based permissions) near one or more fields on a record in Sugar.
The lock icon indicates that the adjacent field is temporarily locked from editing
for all users. Locked fields occur as a result of SugarBPM settings that have been
configured by your system's administrator. When a record becomes involved in a
process that has locked fields, that record will respect those field locks until the
record is no longer participating in the process.

Locked fields are enforced in Sugar for imports, mass updates, and record
merging. Please note that records containing one or more locked fields cannot be
edited via list view regardless of whether the locked fields appear in the list view's
columns. To edit the record's unlocked fields, you must navigate to the record
view, which you can do by clicking on the record's link in the alert box or as you
typically would in Sugar.
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Recalculating Calculated Values

Administrators or users or developer-level role access to a module may see an
additional option in the list view's Actions menu: "Recalculate Values". This option
appears only for modules that contain one or more calculated fields. For more
information on calculated fields, please refer to the Studio documentation.

This utility allows administrators to recalculate affected field values following the
addition or alteration of a calculated field in Studio. The mass actions menu option
allows you to recalculate field values for up to 1000 records at a time. To update
more than 1000 records, perform the recalculations in multiple batches as needed.

Note: This action will not appear unless the user is an administrator or has
developer-level access to the module and there is at least one calculated value in
that module. Please note that your ability to recalculate values may be restricted
by a role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the
Recalculate Values option.

The following steps cover recalculating values for records from the Accounts list
view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the list view's List View Search to identify accounts you wish to update.
3. Select the desired accounts then choose "Recalculate Values" from the

Actions menu.
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Finding Duplicate Records

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate records to be accidentally put into the system.
Before creating a new record, the best practice is to first check that the record
does not already exist in Sugar. You can identify duplicate records for cleanup
using list view search from the module's list view.

Searching for records with similar names or other information can turn search into
a powerful, duplicates-finding tool. A wizard is also available for finding potential
duplicates and may be used as shown below. If duplicate records are detected, you
can perform a merge per the Merging Records section of this documentation.

Please note that your ability to use the Find Duplicates action may be restricted by
any role which prevents editing records. For more information on roles, please
refer to the Role Management documentation. Check with your system
administrator if you do not see the Find Duplicates option.

The following steps cover locating duplicate accounts using the Find Duplicates
option from the Accounts record view as an example:

1. Navigate to an account's record view.
2. Choose "Find Duplicates" from the Actions menu.
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3. Potential duplicate account records will be listed on the Find Duplicates
page. Select the duplicate record(s) you wish to merge then click "Merge
Duplicates".

You can preview the duplicate record's details by clicking the 
Preview button to the far right of the record's row.
You can search for specific records from the Accounts list view if
you wish to check for more potential duplicates. For more
information on performing a search, please refer to the List View
Search section of this documentation.
You can also click the Gear icon above the Preview button to change
the list of fields that display on the list view column headers.

Once you click "Merge Duplicates", the merging process with the current record
will begin. For instructions on performing the merge that follows, please refer to
Steps 3-9 of the Merging via List View section of this documentation.

Merging Records

When duplicate records are identified in Sugar, you have the option to merge two
or more into a single record. Once the merge is complete, the duplicate record(s)
will be deleted, and the primary record will remain. Please note that all
relationships belonging to the duplicate records will be merged to the primary
record meaning that any calls, meetings, cases, etc. related to the duplicate
record(s) will automatically be related to the resulting, merged record.
Note: Date Created, Date Modified, and Password field types are not supported
when merging duplicate records in Sugar.

Merging via List View
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List View Search may be used to identify duplicate records by, for example,
searching for records with similar names. Once your search has identified
duplicates, you can merge them directly from the module's list view.

The following steps cover merging accounts via the list view as an example:

1. Use the list view's List View Search to identify duplicate accounts.
2. Possible duplicates will be displayed in the list view. Select the duplicate

record(s) that you wish to merge.
Please note that up to five records may be merged at once in Sugar.
An error message ("Invalid number of records passed. The valid
range is from 2 to 5 records.") will appear if more than five records
are selected when attempting to perform a merge.

3. Select "Merge" from the Actions menu to display the Merging Records
page. The primary record's field values are displayed on the left while other
record's values are in columns to the right. For convenience, fields with
differing values will appear on the top of the list. Saving the merged
records will preserve only the field values marked with the radio button
into a single record.

                       145 / 1.116



 

If 3 or more records are selected to be merged, an X icon will appear at the
top right of each record. Clicking the "X" will remove the record from the
merge process but will not delete the record.

4. To change which record is considered the primary, drag and drop the
Primary label on the top of a different column.

5. Review the field values in each column and click the radio button to the left
of the value that should appear on the final record. You can also manually
type or select a new value for any field as necessary.

Note: Fields you do not have Edit access for cannot be edited on
the merging records page.

6. Preview what the final, merged record will contain as you work by clicking
the eye icon to display the preview in the Intelligence Pane.

7. Click "Save" once all fields you wish to appear on the single, merged record
have their radio buttons selected.

8. A pop-up message will display confirming that the duplicate record(s)
should be deleted. Click "Confirm" to proceed.

Viewing Record Historical Summaries

For modules that are related to activity records (e.g. calls, meetings, emails, notes,
and tasks), you can view quick details of the related activities via a record's
Historical Summary option. From the record view, simply select "Historical
Summary" in the Actions menu.
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The Historical Summary shows a digest of the following activity records that are
considered closed by virtue of their statuses:

Record Type Included Statuses
Calls Held, Canceled
Emails Sent, Received, Archived
Meetings Held, Canceled
Notes All notes
Tasks Completed, Deferred

Note: Calls and meetings with a Canceled status will display a status of "Not Held"
in the Historical Summary.

The Historical Summary page will display as a list view with each activity's type,
subject, status, description, etc. and allow you to click the activity's name to view
its full details. You can add additional fields by clicking the Column Selection icon
to the far right of the list view column headers. You can also preview the activity
record in the intelligence pane by clicking the Preview icon to the far right of each
record's row, providing key information as well as any activity stream information.
For more information on activity streams, please refer to the Activity Streams
documentation.

The Historical Summary list view provides the ability to reorder columns by
dragging and dropping the title of the column to the desired location. The new
column order will remain for a user upon subsequent visits to the module until the
user's browser cache is cleared. You can reset the column order to the default view
by clicking the Gear icon to the far right of the list view column headers and
selecting "Reset default view". Please note that this option only appears if the
current list view column order is different from the system's default column order.
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Users can also easily adjust the size of columns in the Historical Summary list view
per their viewing preference. Simply place your cursor on the column divider, and
when the Left-and-Right arrow appears, click and drag the column to the desired
size. The set column width will be preserved when you navigate away from the
page. Sugar will render the preferred column size across sessions until the user
removes or resets the relevant browser cookies. You can reset the column width to
the default size by clicking the Gear icon to the far right of the list view column
headers and selecting "Reset default widths". Please note that this option only
appears if at least one of the column widths in the Historical Summary list view is
different from the default column width.

Viewing Record Audit Logs

Changes made to each record are tracked over time, and users are able to view the
history of changes via each record's audit log. To access the audit log, simply
navigate to the record view and select "View Audit Log" from the Actions menu.
Please note that the audit log only tracks changes to fields that are marked as
"Audit" via Admin > Studio. For more information on designating fields for audit,
refer to the Studio documentation. The list of fields currently marked for audit for
the module will appear at the bottom of each record's audit log page.
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Once the audit log opens, the header will display the name of the current record to
better identify which record's audit log the user is viewing. Please note that the
header will just display "Audit Log" and not include the record's name if the user
does not have access to the record's name or the record's name is blank. Below the
header, the user can perform a search to retrieve log entries for specific fields
(e.g. Office Phone), old values, or new values.

The audit log contains the following fields:

Field Description
Field The name of the audited field that has a

change in value 

Note: Only fields marked as "Audit" in
Admin > Studio will be displayed in the
audit log.

Old Value The old field value prior to the data
change

New Value The new field value after the data
change
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Changed By The Sugar user who made the data
change

Source The source (e.g. Sugar user, Web to
Lead form) from which each field
change originated 

Note: The field may be blank if the
source is unknown.

Change Date The date the field change occurred

The rows of the audit log represent each time that an audited field is set or
changed, starting with values specified during the record's creation. In addition,
when any email address changes are captured in the audit log, the email audit icon
appears to the right of the email address which provides users access to the email
address audit log. For more information, refer to the Viewing Email Address Audit
Logs section below. 

In addition to the old and new values of each field change, the time and source of
the change are recorded. When a user is directly responsible for the change,
whether by editing in Sugar or via an authenticated service such as Sugar's Plug-in
for Microsoft Outlook, the user will be specifically named. However, many non-
user entities are also responsible for record changes. Potential source values are
as follows:

SugarBPM
BWC UI
Rest API
SOAP or v4_1 and older REST API
CLI
Cron Job
Logic Hook
Sugar Workflow
User
Web to Lead
Installer

Viewing Email Address Audit Logs

Email address audit log entries are generated for an email address whenever the
"Opted Out" or "Invalid" flags are modified or when an opt-in link is generated.
These changes are captured in the email address audit log which can be accessed
by clicking the email audit icon to the right of the email address on the record
audit log.
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The email address audit log contains the same fields (e.g. Fields, New Value,
Source) as the record audit log but will only display entries when there are
changes to the Opted Out and/or Invalid options for the email address. Please note
that the email address audit log will not display any data if an email address is not
marked as "Opted Out" or "Invalid" when it is initially added to the record.

Viewing Personal Information

For organizations that prioritize data privacy, fields that contain personally
identifying information for an individual are of particular importance. Admins can
designate these fields as "Personal Information" via Admin > Studio. If your
organization's data privacy procedures include providing individuals with a record
of the data you have recorded about them, the View Personal Info option provides
a valuable tool for condensing all of a record's personal information on one screen.
For more information on using this option and servicing data privacy records of
types "Send Personal Information Being Process" or "Export Information", refer to
the Data Privacy Guide.

Record PDFs

If you require a record's information outside of Sugar, you can download or email
the information in PDF form. Administrators have the ability to build multiple PDF
templates via Admin > PDF Manager for each module to ensure that the relevant
record information is being included for your specific purpose. For more
information on creating and managing PDF templates, please refer to the PDF
Manager documentation. Please note that the Download PDF and Email PDF
options will only appear in the Actions menu if there is an existing PDF template
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available for the module.

Note: If a user's email address is empty in their profile or if they have set their
email client to "External Email Client", then the "Email PDF" option will be hidden
for that user.

Downloading Record PDFs

Download record information as a PDF file via the desired record's record view by
selecting "Download PDF" from the Actions menu. All PDF templates which your
administrator has created and made available for the module will appear beneath
the Download PDF option. Simply select one of the templates to generate the PDF
file to view or save onto your local machine.

Emailing Record PDFs

Users also have the option to email record information as a PDF file using Sugar's
email client. From the originating record's record view, click the Actions menu and
select "Email PDF". All of the PDF templates that your administrator has created
and made available for the module will appear beneath the Email PDF option in the
Actions menu.

Select one of the templates to create a draft in the Emails module. Sugar will
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deliver you to the record view for the email.

The draft will have the following information pre-populated:

From : The logged-in user's outgoing default email account
Date : The date the message is being sent
To : The primary email address of the originating record (if available)
Subject : The name of the originating record
Body : "Here is the file you requested (You can change this text)"
Attachment : The PDF file created from the originating record

The file's name will appear as "Email Attachment :
{originating_record_name}_{template_name}.pdf"; for example,
"Email Attachment : Acme_25_units_Customer_invoice.pdf".

Teams : The logged-in user's default team(s)
Assigned To : The Sugar user assigned to the email record
Related To : The originating record and its module

Click "Edit" on the draft email record to reveal the Send button or to update the
fields as necessary and then click "Send". For more information on sending emails
via the Emails module, please refer to the Emails documentation.

Favoriting Records

Each Sugar user has the option to designate their own favorite records which are
important or will be viewed often so that they can easily be accessed via list view
search or from the module tab. Once records are marked as favorites, select "My
Favorites" from the Filter option next to the Search bar or select from your most
recent favorites directly from the module tab.

Favoriting via List View
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The following steps cover marking records as favorites via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the account records you wish to mark as

favorites.
3. Darken the star icon on the left of each desired account's row by clicking

on the star one time.

4. To remove the account as a favorite, click the star again to revert it to
white.

Favoriting via Record View

The following steps cover marking records as favorites via the Accounts record
view as an example:

1. Navigate to an account's record view.
2. Click the star icon to the right of the account's name in the upper left of the

record view to designate it as a favorite.
3. To remove the account as a favorite, click the star again to revert it to

white.

Favoriting via Subpanel

The following steps cover marking account records as favorites via the subpanel in
related modules as an example:

1. Navigate to a related module's record view.
2. Click the star icon to the left of the desired record's row in the Contacts

subpanel.
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3. To remove the contact as a favorite, click the star again to revert it to
white.

Following Records

Users can also choose to follow individual records. This allows each user to
personalize their activity stream by specifying which records' posts should appear
on the activity streams displayed on their Home page and in module list views.
Please note that you will automatically follow the records that you create as well as
records that are assigned to you. You will not, however, automatically follow
records you import. Should a user lose access to a record in Sugar, they will
automatically stop following that record. For more information about activity
streams, please refer to the Activity Streams documentation.

Following via List View

The following steps cover marking an account to follow via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account records you wish to follow.
3. Click the Record Actions menu to the far right of the records row and

select "Follow".

4. To stop following the account, click the Record Actions menu and select
"Unfollow".

Following via Record View
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The following steps cover marking an account to follow via the account's record
view as an example:

1. Navigate to an account's record view.
2. Click on the Follow button to the right of the account's name to change its

label to "Following".

3. To unfollow the account, click on the Following button to revert its label to
"Follow".

Sharing Records

Individual records can be shared with other users in your organization by sending
an email including the record's direct link. In the desired record's record view,
select "Share" from the Actions menu. A Compose Email window will open, and the
email's text will include the URL of the record. Enter the recipient(s) email address
in the To field then click "Send".

The recipient can simply click the link in the email to access the account record in
Sugar. Please note that the user must be logged in to Sugar in order to access the
record. Users will only be able to view the shared record as allowed by their team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation.

Using the TinyMCE Text Editor

TinyMCE is a third-party WYSIWYG editing tool used by Sugar so that users can
create content such as knowledge base articles and email messages with rich-text
formatting elements.
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TinyMCE's rich-text editor framework presents the following familiar formatting
options:

Element Button(s) Function
Source Code Bypass the rich-text editor

options and insert your
own HTML code or view
the HTML code of an
existing template to make
advanced changes.

Bold, Italic, Underline,
Strikethrough

Use these basic font
formatting options to
easily add common styles
to text in the message
body.

Bullet List, Numbered List Transform paragraphs in
the message body into a
formatted list.

Align Left, Align Center,
Align Right, Justify

Set paragraph alignment.

Text Color, Background
Color

Choose a custom font
color or highlight text with
a background font color.

Clear Formatting Clear any formatting.

Insert/Edit Image,
Insert/Edit Link

Insert or edit an image or
a link.

Font Sizes Choose a font size for the
text.

Paragraph Choose a format for
headers.
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User Interface (Legacy Modules)

Overview

The user interface in Sugar is essentially everything you see and can interact with
in Sugar. Knowing what buttons allow you to do what actions and how to quickly
add and edit information is critical to managing your customer information. This
documentation is divided into related sections in order to cover in detail, interface
options to perform specific tasks.

Legacy Modules

This documentation will cover the Legacy user interface which is carried over from
Sugar 6. Below is a list of modules that use the Legacy user interface. Other
modules use the updated Sidecar user interface which is described in detail in the 
User Interface documentation.

Calendar
Campaigns
Documents

Note: Custom modules that are created in Module Builder will utilize the Sidecar
user interface. Custom modules installed to an instance prior to Sugar 7 that were
not created in Module Builder will use the Legacy user interface upon upgrade to
7.x.
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List View

Each module in Sugar contains a list view to search and display records in a table
format. To access a module's list view, simply click the module tab (e.g.
Documents) in the navigation bar at the top of Sugar.

The list view displays all records meeting the current search criteria and to which
your user has access. By default, Sugar sorts records in descending order of their
creation date. You can view the basic details of each record within the field
columns or select the record name to view it in the detail view.

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation.

You have the option to change what fields are displayed in each module's list view
by configuring your layout options in the Advanced Search. For more information
on configuring your list view, please refer to the Layout Options section of the
Search documentation. Users with administrator or developer access also have the
ability to change what fields are visible in the list view via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation.

Basic Search

The basic search is at the top of the list view for each module and offers a few,
commonly used fields for a simplified search experience.
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From the Basic Search panel, you can also click "Advanced Search" to access
additional search functionality as needed.

The following buttons and checkboxes are common across many Legacy modules'
Basic Search panel and have the following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a name or subject, Sugar will only return records with
a matching name or subject that are assigned to you. Once the search is complete,
the relevant results will populate in the list view below the search panel. To see all
records to which you have access within the module, simply click "Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation.

Administrators can configure the fields that appear on the Basic Search for each
module via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced Search panel, you can also click "Basic Search" for simplified searching.
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The following buttons, checkboxes, and dropdowns are common across many
Legacy modules' Advanced Search and have the following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Favorites : Enable this checkbox to return only records you have
marked as favorites.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches that you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a field to search, Sugar will only return records matching
that field that you have marked as favorites. When searching by a multi-select or
dropdown field (i.e. "Assigned to"), however, Sugar will return records matching
any of these selections. Once the search completes, the relevant results will
populate in the list view below the search panel. To see all records to which you
have access within the module, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation.

Administrators can configure the fields that appear on the Advanced Search for
each module via Admin > Studio. For more information on editing layouts, please
refer to the Studio documentation.
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Selecting Records

The list view in Sugar allows you to select a single record to view by clicking on
the name or subject of the record to open it in the detail view. You can also select
multiple records at once and perform certain actions on those records.

To select or deselect records in the Legacy modules list view, use the following
methods:

Individual Selection : Mark the checkbox on the left of each record's row
on the list view you wish to select.

Checkbox Selection : To select or deselect multiple records from the list
view, use the options in this checkbox dropdown menu.

Select This Page : Selects all records shown on the current page
of list view results. You can also click the open checkbox to the left
of the Checkbox Selection menu to select all records on the current
page.
Select All : Selects all records in the current search results across
all pages of list view results.

Note: When using "Select All" you can not deselect single
records, but will have to use the Deselect All option.

Deselect All : Deselects all records that are currently selected.

When selecting records, you can page through all of the records and Sugar will
remember which records are selected. Depending on your Sugar settings you may
see the count of records being selected or you may see a plus sign (+) to refer to
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more records. Simply select the Deselect All option to remove all selected records
regardless of how they were initially selected.

Mass Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records. It allows you to perform actions
such as Delete, Mass Update, and Export for one or more records. Please note that
not all Legacy modules have these actions available. The sections below will cover
the most common actions across the modules. For more information on actions
available within a specific module, please refer to the list view section in the
application guide pertaining to the specific module.

Delete

The list view in Sugar allows you to easily mass delete records. Please note that
deleted records are not permanently removed from the database, but are marked
as deleted in the system so that it no longer appears in Sugar. These records can
be recovered by anyone with direct database access. Also, deleting records in
Sugar will not delete the related records and will only remove the relationship, so
you may wish to also delete any related records to avoid orphaned records.

The following steps cover deleting document records via the Documents list view
as an example:

1. Navigate to the Documents list view by clicking on the Documents module
tab.

2. Use the Basic or Advanced Search to find the document records you wish to
delete.

3. Select the desired document record(s) individually or use the checkbox
dropdown's options.

4. Choose "Delete" from the Actions menu.
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5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of records. If you encounter an
error when performing this action, we recommend selecting the records in smaller
batches.

Mass Update

Mass Updating allows users to make the same change to multiple records at one
time from the list view. Users with administrator- or developer-level access can
control which fields are available during mass updates via Admin > Studio.
Currently, only fields with the data type of date, datetime, dropdown, multiselect,
and radio may be altered during a mass update. For more information on
configuring the mass update options, please refer to the Studio documentation.
Due to the PHP memory limitations on the server, there may be occasions when
the application times out while mass updating a large number of records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Please note that your ability to mass update may be restricted by a role. For more
information on roles, please refer to the Role Management documentation. Check
with your system administrator if you do not see the Mass Update option.

Use the following steps to mass update records from the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the list view's Basic or Advanced Search to identify records you wish to

modify.
3. Select the desired records individually or using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.
Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add the
teams specified here to any existing team assignments.

6. Click "Update" to save the changes to all of the currently selected records.

Favorite Designation

Each Sugar user has the option to designate their own favorite records within
modules that are important or will be viewed often so that they can easily be
accessed via search or from the module tab. Once records are marked as favorites,
use the My Favorites checkbox in the Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the module tab.

Use the following steps to mark records as favorites via the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the Basic or Advanced Search to find the records you wish to mark as

favorites.
3. Mark the star icon on the left of each desired record's row.
4. To remove the record as a favorite, click the star again to revert it to white.
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Edit Option

Records may be edited at any time to update or add information to the record. You
can make changes to existing records by clicking the Pencil icon to the left of each
record's name or subject in the list view. This will open up the records edit view
layout to update the necessary fields and you can click "Save" to preserve the
changes made.

Use the following steps to quick edit records via the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.
2. Use the Basic or Advanced Search to find the records you wish to edit.
3. Click the Pencil icon to the left of the record's name or subject in the list

view.

4. Update the necessary fields on the record's edit view layout, then click
"Save" to preserve the changes.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.
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Administrators in Sugar may configure both the edit view and quick create via
Admin > Studio. For more information on configuring layouts, please refer to the 
Studio documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, simply click the column header noting that the fields which allow
sorting will have a pair of arrows. You can click the column header again to
reverse the sort order. Please note that the list view may be sorted by only one
column at a time. You can also set a default order-by column using the layout
options in Advanced Search. For more information on setting a default column
sort, please refer to the Layout Options section of the Search documentation.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation.

More Information

Additional details for each record can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional
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information in addition to what appears in the display column fields. The resulting
pop-up window will show information such as Description, etc. by default. The list
of fields appearing here may only be configured through a code-level
customization.

Detail View

The module's detail view displays thorough information including all fields which
are grouped by default into the Overview and Other panels. You can also view a
record's related records (Activities, Documents, Contacts, etc.), which appear in 
subpanels beneath the records fields.

Please note that you will only be able to view a record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentation. Users with administrator or developer access have the ability to
change the detail view by configuring the layout via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation. To access
a record's detail view, simply click on the name or subject link from anywhere in
the application including from the module's list view.

                       168 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Editing_Layouts


 

Next or Previous Record

On the upper right of the detail view, there are two buttons that allow you to page
through each record in the module list view's current search results. Clicking the
Previous button displays the previous record of the current search results while
clicking the Next button displays the next record of the current search results. The
text in between shows which record result you are currently viewing within the
total number of current results.

Actions Menu

The Actions menu on the top left of each detail view allows you to perform various
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actions (e.g. Edit, Share, Copy, Delete, etc.) on the current record. Please note that
the action items available in the Actions menu will vary between each Legacy
module.

Administrator users can also change the action items to be displayed as separate
buttons instead of a dropdown menu via Admin > System Settings. For more
information on configuring the actions menu, please refer to the System
documentation. The following sections will cover the most common action items
available across the Legacy modules. For more information on action items not
listed here, please refer to the Detail View > Actions Menu section of the specific
module's documentation.

Edit

You can edit records via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made. For more information regarding
the edit view and how to edit records in Sugar, please refer to the Edit View
section of this documentation.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management

                       170 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#User_Interface
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management


 

documentation. Check with your system administrator if you do not see the Edit
options.

Administrators in Sugar may configure the module's edit view via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation.

Share

Individual records can be shared with other users in your organization by sending
an email with the record's link directly from the record view. In the module's detail
view, select "Share" from the Actions menu which will open a Compose Email
window including the URL of the record. Enter the recipient(s) email address in
the To field then click "Send".

Users can simply click the link in the email to access the record in Sugar. Please
note that the user must be logged into Sugar in order to access the record. Users
will only be able to view the shared record as allowed by their team membership,
user access type, and assigned roles. For more information on teams and roles,
please refer to the Team Management and Role Management documentation.

Copy

You can create a new record by duplicating an existing record from the detail view.
The Copy option is useful if the record you are creating has similar information to
an existing record. Please note that any related record(s) to the original record will
not be copied to the newly created record.
Use the following steps to create a record by duplicating an existing record:

1. Navigate to a record's detail view.
2. Click the Actions menu and select "Copy".
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3. The displayed edit view is pre-populated with the original records values.
Update the necessary fields, then click "Save".

Delete

Users have the ability to delete records that are invalid or should no longer appear
in their organization's Sugar instance via the module's detail view. Deleting via the
detail view allows you to delete a single record in the module. Please note that
deleting records will not delete the related records and will only remove the
relationship, so you may wish to also delete any related records to avoid orphaned
records.

Please note that your ability to delete records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Delete
options.

The following steps cover deleting a document record from the Documents detail
view as an example:

1. Navigate to a document's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.
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View Audit Log

Changes made to each record are tracked over time, and for most modules, users
are able to view the history of changes via the audit log in each record's detail
view. To view the audit log, navigate to a record's detail view (e.g. campaigns) and
select "View Audit Log" from the Actions menu. Please note that only fields marked
as "Audit" in Admin > Studio will be displayed in the audit log. For more
information on designating a field for audit, please refer to the Studio
documentation.

Field Panels

Field panels are what hold the fields for a record in the detail view. Most modules
come with two panels defined by default: Overview and Other. Please note that the
field panels can be collapsed to hide unnecessary data.
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Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels inside the field panels as well as move,
create, and edit existing field panels via Admin > Studio to provide visibility to the
most important fields. Field panels can also be collapsed by default via Admin >
Studio. For more information on modifying field panels, please refer to the Studio
documentation.

Subpanels

Beneath the module record's fields are subpanels containing related records from
various modules (e.g. Accounts, Contacts). The subpanels that appear in a record's
detail view is based on the relationships defined for the current module as well as
the administrative settings on which subpanels are set to display in Sugar. You can
expand and collapse subpanels as well as rearrange them per your viewing
preference. For more information on changing the display of subpanels, please
refer to the Layout section of this documentation. You can create related records
as well as relate an existing record directly from the subpanel. Please note that the
actions available in the Actions menu can vary between certain subpanels.

Users with administrator or developer access have the ability to change the fields
(e.g. Status, Subject) and labels of each subpanel by configuring the layout via
Admin > Studio to provide visibility to the most important fields. For more
information on modifying subpanels, please refer to the Studio documentation.
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Activities and History

The Activities and History subpanels are special subpanels in Sugar that show data
from multiple modules based on certain criteria. For example, a meeting with a
status of "Planned" will appear in the Activities subpanel. Once the meeting is
changed to a status of "Held", it will move from the Activities subpanel to the
History subpanel. All related note and email records will appear in the History
subpanel as there are no filters on those modules, but notes and emails will never
display in the Activities subpanel. If you customize the status field for any of the
modules, the records that hold a custom status will appear in the Activities
subpanel. But code level customizations would be required to have a new status
show in the History subpanels.
Please refer to this chart for the criteria both subpanels use to query data:

Subpanel Module Status Field Filter
Activities Meetings Does not Equal "Held"

Does not Equal "Not Held"
Tasks Does not Equal

"Completed"
Does not Equal "Deferred"

Calls Does not Equal "Held"
Does not Equal "Not Held"

History Meetings Equals "Held"
Equals "Not Held"

Tasks Equals "Completed"
Equals "Deferred"

Calls Equals "Held"
Equals "Not Held"

Emails N/A
Notes N/A

Since the Activities and History subpanels contain records from many different
modules, there are some differences in the actions and record display than in
normal subpanels. Each record in both subpanels will have an icon to the far left
indicating which module the record originates from. For example, if the record is a
call, then the Telephone icon will display to the left of the subject.
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Normal subpanels typically have a Create and Select option to create or link
related records. The Activities and History subpanels have multiple actions due to
the fact that there are multiple modules involved.
You have the following actions available from the Activities subpanel:

Create Task : Creates a new task record related to the record currently
being viewed.
Schedule Meeting : Creates a new meeting record related to the record
currently being viewed.
Log Call : Creates a new call record related to the record currently being
viewed.
Compose Email : Launches the Compose Email popup window to send an
email.
Note: The email will automatically be related to the current record you are
viewing.

Note: When creating a Task, Meeting, or Call from the Activities subpanel, you
have the ability to set the Status field to "Held" or "Completed" which will place it
in the History subpanel.

You have the following actions available from the History subpanel:

                       176 / 1.116



 

Create Note or Attachment : Creates a new note record related to the
record currently being viewed.
Archive Email : Allows a received email to be entered manually on a
record for historical purposes only.
Note: This will not send an email to you or the email address on the record.
View Summary : Opens a popup window with the Subject, Status, and
Detail of all associated records in the History subpanel. This is useful as it
allows you to view a history of all activities that have taken place for the
current record.

Layout

Subpanels in Sugar can be personalized by each user to only display the most
relevant subpanels per their viewing preference.

Collapse/Expand : Click the double arrow to the left of the subpanel's
name to either collapse or expand the subpanel.

Rearrange Subpanels : Drag and drop the subpanel's header bar to move
the subpanel to a new location on the detail view.
Note: Administrators can prevent users from moving subpanels to different
locations on the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation. Check
with your system administrator if you are not able to rearrange your
subpanels.
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Actions

Related record subpanels (e.g. Contacts) also provide options to create or select
related records directly from the detail view.

Create : Choose "Create" from the subpanel's Actions menu to relate a new
record. The newly created record will automatically be related to the
current record you are viewing.

Select : Choose "Select" from the subpanel's Actions menu to relate an
existing record. The Search popup window will display allowing you to
select records to relate to the current record you are viewing.

Note: You may select multiple records in the search popup to be related to
the main record.
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Edit : Choose "Edit" on the far right of the record's row to edit the related
record in the subpanel. Make the necessary changes to the record then
click "Save" to preserve the changes.

Unlink : Choose "Unlink" from the dropdown on the far right of the
record's row to remove the relationship between the related record and
current record.

Note: This removes the relationship, but does not delete the record
itself.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation.

Column Sorting

You can sort all of the related records in each subpanel by a field column in either
ascending or descending order. To sort by a field or switch the sort direction, click
the column header noting that the fields which allow sorting will have a pair of
arrows. Please note that each subpanel may be sorted by only one column at a
time.
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Pagination

The top right of the subpanel shows which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of the set.

By default, Sugar displays 5 records per subpanel results set, but administrators
can change the number of records displayed via Admin > System Settings. For
more information on changing the number of displayed records, please refer to the
System documentation.

Edit View

The module's edit view allows records to be edited at any time to update or add
information as necessary. The Edit View layout is available for most Legacy
modules and can be accessed by clicking the Edit button on the upper left of the
detail view.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.
Administrators in Sugar may configure the edit view via Admin > Studio. For more
information on configuring layouts, please refer to the Studio documentation.
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Pagination

On the upper right of the Edit View layout, there are two single-arrow Next and
Previous buttons that allow you to page through each record in the list view's
current search results. Clicking the Left arrow button displays the previous record
of the current search results while clicking the Right arrow button displays the
next record of the current search results allowing you to edit records as necessary.
The text in between the arrows shows which record result you are currently
editing within the total number of current results. Once the necessary changes
have been made, you can click "Save and Continue" if you wish to save the details
in the current record and proceed with editing the next record.

Editing Records

Records may be edited at any time to update or add information to the record.
Once in the edit view, update the necessary fields available on the layout then click
"Save" to preserve the changes. You can click "Cancel" at any time to return to the
previous page without editing the record.

Administrators in Sugar can configure the Edit View layout via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation.

Editing Related Fields

Sugar contains many different relationships between different modules and a
couple of different relate fields for users to create relationships with.
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Relate : Most one-to-many relationships in Sugar are represented by a
relate field. Relate fields on the edit view layout display an Arrow and "X"
button to the right of the field. You can either click the Arrow button to
select a related record from the record selection window or begin typing in
the open text box to pull up a list of records matching the keyword.

Flex Relate : Allows a dynamic module and a record from that module to
be related to the current record. Users can first select the module from the
dropdown list then choose or enter the record they wish to relate to the
current record they are viewing.
Email Addresses : Email address fields can be linked to many different
email addresses for a single record. Click the Plus button to add an email
address to a record.

Note: Only one email address can be selected as the Primary. Click the
minus sign to remove an email address from a record.
Teams : The Teams field specifies which team or teams of users have
visibility of each record.

If there are multiple teams on a record, click "Show" to view all of
the teams.

Click the Arrow icon to open the team selector window, or click the
Plus icon to add a new row to use the type-ahead feature.
Click the Minus icon to remove a team from the record and select
only one team to be the primary team.
For more information on teams, please refer to the Team
Management documentation.

Note: If your administrator has enabled team-based permissions, you may also see
a "Selected" box on the Teams field. Please refer to the Using Team-Based
Permissions section for more information.

Using the TinyMCE Text Editor

TinyMCE is a third-party WYSIWYG tool that allows users to provide HTML
formatting in specific sections in Sugar without requiring any HTML knowledge.
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TinyMCE is available when composing email or email templates from the Emails
module or creating workflow email templates.

The following are some descriptions of the more commonly used features in
TinyMCE:

Text Formatting : Use the folllowing buttons to format text to be bold,
italics, underlined, or stricken through.

Alignment : Use the following buttons to change the alignment of the text
to be left, center, right, or justified.

Fonts : Use the following dropdowns to select special section formatting,
fonts, and sizes.

Layout Formatting : Use the following buttons to utilize bullet list,
ordered lists, and tables.

Links and Images : Use the following buttons to create a link, remove a
current link, or add an image.

Advanced HTML : Click the HTML button to view your content in full
HTML code. You may add and change the HTML to further refine your
content.
Not all HTML is allowed to be saved in Sugar. The following are some
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examples of HTML that will be removed when saved:
Anything outside of the <body></body> tags.
Any <style></style> tags.
Any <script></script> tags.
Any <form></form> tags.
Any <input> tags.Note: Inline CSS can be added to some elements (e.g. <p>, <pre>, and

<span>), but due to different email clients rendering HTML email in
unexpected ways, inline CSS is not allowed on some elements (e.g. <div>,
<img>, and <table>).

Using Team-Based Permissions

In Sugar, teams are typically used to control which groups of users can access a
record. Using team-based permissions, however, an administrator may choose to
extend the purpose of teams to control who can perform certain operations on the
record (e.g. edit, delete, etc.). When enabled, regular users can use a record's
Teams field to grant access such as viewing, editing, exporting, importing, and
deleting permission to specific users or user groups.

An administrator must first enable team-based permissions and configure roles and
users for this feature. For more information, please refer to the Role Management
documentation. Once the roles are applied to users, any user who can edit the
Teams field in the enabled module can grant extra access to teams of users. If you
are not an administrator and you are not sure if team-based permissions are
enabled for a legacy module, simply navigate to a record view, click "Edit", and
look for a checkbox labeled "Selected" next to the Teams field:

Note: Sidecar modules also support team-based permissions but use a lock button
next to the Teams field to indicate whether or not the team's members have extra
access to the record.

To grant extra access to a record for all members of a team who have role
permission, check the Selected checkbox next to the team's name. This will enable
additional permissions according to the guidelines in the table below. To control an
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individual user's access to a record, add that user's private team to the record's
Teams field and then enable or disable additional permissions according to the
guidelines in the table below. Please note that extra access will only be granted to
users who have a role restricting their access to "Owner and Selected Teams" as
described in the Role Management documentation.

Team Setting Checkbox Description
Additional Permissions
Enabled

selected Members of this team
have extra access to this
record or fields within the
record as controlled by
their roles

Additional Permissions
Disabled

not selected Members of this team
have no additional team-
based permissions as
controlled by their roles

In the following example, members of team East have standard team access to the
record (at a minimum, view permission), while Jim and members of team West
have view permission plus extra access to do things such as working with
restricted fields, and editing, deleting, and exporting the record. Note that a user
can be an explicit or implicit member of a selected team, and if they are part of
both a selected team and a non-selected team for a record, they will be granted the
extra access.

Note: Changes made to the selected state of teams on an existing record are
audited in the record's audit log.

Last Modified: 2020-03-11 00:03:31

Activity Streams
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Overview

Sugar's activity stream allows users to view a list of activities performed on
records, create posts, preview posts, comment on posts, etc. Users can easily track
the most recent updates across their entire organization via the record and user
posts on the activity stream. The activity stream can be accessed via the home
page, module list view (e.g. Contacts list view), module's record view (e.g.
Contacts record view), as well as the intelligence pane.

Note: Sugar's activity streams are disabled by default, but administrators can
globally enable the functionality based on their organization's needs. For more
information, refer to the System documentation in the Administration Guide.

Please note that older activity stream records may be purged from the database by
the Activity Stream Purger scheduler if enabled by your administrator. 

The modules currently enabled to generate record posts for the activity stream are
Accounts, Bugs, Calls, Cases, Contacts, Leads, Meetings, Notes, Opportunity,
Quoted Line Items, Revenue Line Items, and Tasks. This documentation will go
over the basics of the activity stream as well as the various options available when
viewing posts, creating posts, commenting on posts, etc.

Viewing Activity Streams

There are various options available for viewing activity streams in Sugar including
via the home page, dashlet, list view, record view, and intelligence pane. Users will
be able to view record posts (e.g. create, update, link, unlink), user posts,
comments, and attachments via the activity stream. Keep in mind that if you are
not the assigned user or did not create the record, you must follow the record in
order to view all related posts via the Home page and List view activity stream.

Please note that you will only be able to view and access the activity stream for
audit-enabled modules (Accounts, Bugs, Calls, Cases, Contacts, Leads, Meetings,
Notes, Opportunity, Quoted Line Items, Revenue Line Items, and Tasks) in Sugar.
Un-audited modules (e.g. Target, Target List) will not display the list view activity
stream, record view activity stream, or provide the option to follow a record.

Note: Activity streams are not available for custom modules.

Viewing via Home Page

The Home page activity stream allows users to view all posts for records they are
following in Sugar as well as all user posts created on the Home page activity
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stream. For more information on following records, please refer to the Following
Records section. You can access the Home page activity stream by clicking the
triangle next to the Sugar cube icon on the upper left of Sugar then selecting
"Activity Stream". All posts created via the Home page activity stream will be
viewable by users in your organization. For more information on creating posts,
please refer to the Creating User Posts section. You can also comment on posts by
clicking the Comment button and preview posts by clicking the Preview button to
the right of each post.

Viewing via Dashlet

The My Activity Stream dashlet displays the user's main Activity Stream within a
dashboard, eliminating the need to navigate to the Activity Streams view to
monitor the most recent stream activities. Like other Activity Stream views, the
dashlet supports inline commenting on specific stream activities, but it does not
allow record previews. The dashlet may be added to your home page or to the
intelligence page of any module's list view or record view. When added to an
Intelligence Pane, the My Activity Stream dashlet will display stream items in
context to the data within the main container of the page. For more information on
the My Activity Stream dashlet, please refer to the Dashboards and Dashlets
documentation.
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Viewing via List View

The list view's activity stream displays all posts for records being followed in the
current module as well as all user posts created on the list view activity stream.
For more information on following records, please refer to the Following Records
section. To access the list view activity stream, click the specific module tab (e.g.
Contacts) at the top of the navigation bar then click the Activity Stream button to
the right of the list view's search bar. You can view both user and record posts
relevant to the module as well as create a post and comment on posts. For more
information on creating posts and commenting on posts, please refer to the 
Creating User Posts and Commenting on Posts section. You can also preview the
post by clicking the Preview button to the right of each post.

Viewing via Record View

The record view's activity stream displays all posts specific to the current record
you are viewing. Users can view all posts in the record view's activity stream even
if they do not follow the record in Sugar. Please note that you must follow the
record if you wish to view the record view posts via the Home page or List View
activity stream. For more information on following records, please refer to the 
Following Records section. To access the record view's activity stream, navigate to
a module's record view (e.g. Avery Software Co) then click the Activity Stream
button below the module's fields.

Please note that user posts created via the Home page or List View activity stream
that reference the specific record's name will also appear in the record view's
activity stream. For more information on referencing specific records, please refer
to the Referencing Users and Records section.
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Viewing via Intelligence Pane

The intelligence pane in Sugar allows users to view a record's detail along with the
related activity stream information directly from the Home page activity stream,
module's list view, as well as the record view. To preview a record's details, simply
click the Preview button to the right of a record post on the Home page or List
View activity stream. You can also preview a record via the module's list view or
related record subpanel by clicking the Preview button to the far right of each
record's row. Any associated user and record posts will appear below the record's
detail in the intelligence pane. Please note that unlike viewing via the Home page,
List View, or Record View activity stream, you cannot create posts or comment on
posts via the intelligence pane.
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Activity Stream Views

The activity stream allows users to view a list of activities performed on records,
post messages, share external links, etc. The activity stream can be accessed via
the Home page, module's list view (e.g. Contacts list view), as well as the module's
record view (e.g. Contacts record view). For more information on viewing the
activity stream in Sugar, please refer to the Viewing Activity Streams section. The
following will cover the various options available to users when creating posts,
viewing posts, commenting on posts, etc. in the activity stream.

Post Options

There are various post options (e.g. external links, images) available to users when
creating user posts in the activity stream. You can add external links, messages,
etc. to your user post by dragging and dropping the corresponding links into the
post input box. Files saved on your local machine can also be attached to your user
post to share with users in your organization. In addition, you can mention specific
users as well as reference specific records by typing in the @ or # sign followed by
the user or record name. For more information on the various post options
available, please refer to the User Post Options section.
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Filter Options

The activity stream can also be filtered to only display certain messages (e.g.
Messages for Create, Messages for Update) by clicking "Filter" above the post
input box then selecting the desired message type. This enables users to filter the
activity stream to only display specific activity type's they wish to view. To view all
posts in the activity stream, simply select the All Activity Stream option in the
filter.

Refresh Button

The Refresh button is located to the right of the filter options and provides a quick
way to load the most recent activity stream posts without reloading the browser or
losing any filter criteria you may have set. Simply click the button to refresh the
current view.

Preview Button

The Preview button to the right of each post allows users to preview the record
referenced in record posts. The intelligence pane will display the record's details
with key information regarding the record as well as any related activity stream
information. Please note that preview is available for Create, Update, Link, and
Unlink-type posts in the activity stream. User posts that originate from the record
view's activity stream can also be previewed on the Home page and List View
activity stream as it automatically references the record in the post. To close the
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preview, simply click the "X" on the upper right of the intelligence pane. For more
information on previewing posts, please refer to the Previewing Posts section.

Comment Button

Users can respond to posts via the activity stream by clicking the Comment button
to the right of each post. Once you click on the button, simply type your message
into the comment box then click "Reply". Please note that comments are visible to
all users in Sugar unless they do not follow the record in Sugar. For more
information on following and unfollowing records, please refer to the Following
Records and Unfollowing Records section. When a comment is added, the post will
move to the top of the activity stream once the activity stream page is refreshed.
For more information on commenting, please refer to the Commenting on Posts
section.

Post Icon

To the left of each post is the Post icon which allows users to easily identify the
module that a record post is specific to, the user who created the post, etc. The
Post icons for record posts are color-coded and display the first two letters of the
module to differentiate the various record posts for modules. For example, an
update post for the Accounts module will display a green circle with the letters
"Ac", while a post for the Opportunities module will display a purple circle with the
letters "Op". User posts, as well as comments added to posts, display the user's
profile image as the post icon, which helps to identify the user who created the
post or added the comment. For more information on uploading a profile picture to
your Sugar account, please refer to the User Profile section of the Getting Started
documentation.
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Right Hand Side Drawer

On the upper right of the Home page activity stream, module's list view, and
record view, there is a double-arrow icon that allows users to expand the activity
stream to the full-screen width. The intelligence pane is hidden when the activity
stream is expanded. To reduce the activity stream's width and reveal the
intelligence pane, simply click the double-arrow icon again.

More Posts

The activity stream loads an initial number of posts with the option to show
additional posts at the user's request. By default, Sugar displays 20 posts per
activity stream view, but administrators can change the number of posts displayed
via Admin > System Settings. For more information on changing the number of
displayed posts, please refer to the System documentation in the Administration
Guide. To load the next set of posts, simply click the "More posts..." link on the
bottom left of the activity stream.
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Personalizing Activity Stream

Users can personalize their activity stream by specifying which records' posts
should appear on their Home page and List View activity streams. You can follow
specific records that you have access to view in Sugar by marking the Follow
button in the record view or the Follow option in the list view. Please note that you
automatically start following records that you mark as favorites in Sugar.

Following Records

Users can choose to follow specific records to which they have access to in Sugar.
You can mark a record to follow via the module's list view by selecting "Follow" in
the record actions menu as well as the record view by clicking the Follow button to
the right of the record's name. For more information on following records in
Sugar, please refer to the User Interface documentation. All posts appear on the
Home page and List View activity stream for records you follow in Sugar. Please
note that you will automatically follow records that you create as well as records
that are assigned to you. You will not, however, automatically follow records you
import. Should a user lose access to a record in Sugar, they will automatically stop
following that record.

Favoriting Records

Each Sugar user has the option to designate their own favorite records which are
important or will be viewed often so that they can easily be accessed via search or
from the module tab. You can mark a record as a favorite via the module's list
view, record view, and related record subpanels. For more information on
favoriting records in Sugar, please refer to the User Interface documentation.
Please note that you will automatically start following records you designate as
favorites in Sugar.

Unfollowing Records

Users can also choose to unfollow records that they no longer wish to view posts
for in their activity stream. Please note that this will prevent all future posts as
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well as the associated comments from appearing in your Home page and List View
activity stream. However, historical posts associated to the unfollowed record will
continue to appear in your activity stream. To unfollow a record via the list view,
click the Record Actions menu then select "Unfollow". To unfollow a record via the
record view, simply click the Following button again. Please note that you will
automatically stop following a record should you lose access to a record in Sugar.
Also, if you remove a record as a favorite, the Following status will not change and
you must unfollow the record accordingly.

From list view:

From record view:

Creating User Posts

Users can access the activity stream to view a list of activities performed in Sugar,
track updates, as well as post messages to other users in their organization. To
create a post, simply enter your message into the post input box at the top of the
activity stream view then click "Submit". Please note that user posts display the
user's profile image to the left of the post as the Post icon. For information on Post
icons, please refer to the Post Icon section in this documentation. In addition to the
Post icon, the timestamp of when the post was created and the user's name who
created it will display as well. There are various options available when creating
posts such as adding links, images, attachments, external messages, etc. You can
also reference a specific Sugar record or user by typing @ followed by the user's
name (e.g. @John Smith) or # followed by the records name (e.g. #ABC Company)
in your post. For more information on the different post options available, please
refer to the User Post Options section.
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Creating via Home Page

The Home page activity stream can be accessed by clicking the triangle next to the
Sugar cube icon then selecting "Activity Stream". The post input box displays
beneath the Filter option and you can enter your message then click "Submit" for
the post to appear within the activity stream. Please note that user posts created
via the Home page are viewable by all users in your organization. Posts that
reference a specific record will also appear in that record view's activity stream as
it is linked. For more information on referencing records in your post, please refer
to the Referencing Users and Records section.

Creating via List View

The List View activity stream can be accessed by navigating to a module's list view
(e.g. Accounts) then clicking the Activity Stream button to the right of the list
view's search bar. You can create a user post by entering your message into the
post input box then clicking "Submit". Please note that posts created via the list
view activity stream are visible in the record view's activity stream if the specific
record's name is referenced in the post. Also, if you reference a user (e.g. @Jim
Brennan) in your post, they will see the post on their Home page activity stream as
well. For more information on referencing records and users in your post, please
refer to the Referencing Users and Records section.
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Creating via Record View

The Record View activity stream can be accessed by navigating to a module's
record view (e.g. ABC Incorporated) then clicking the Activity Stream button below
the module's fields. To create a user post, simply enter your message into the post
input box then click "Submit". Please note that posts added via the record view
activity stream are only viewable within that record's view unless a user is
following the record. All posts appear on the Home page and List View activity
stream for records you follow in Sugar. For more information on following records
in Sugar, please refer to the Following Records section.

User Post Options
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There are various options available when posting a message in the activity stream
such as adding an attachment, external link, referencing Sugar records, etc. Users
can easily drag and drop files, links, news feeds, etc. from their local machine,
external sites, as well as Sugar dashlets. You can also mention a specific user in
your post that you would like the message targeted to as well as reference records
that you wish to link the post to in Sugar. Please note that every user in Sugar will
be able to view the post if it's created via the Home page activity stream
regardless of whether a specific user is mentioned in the post.

Adding Rich Content and External Messages

Users have the option to add external links, images, and videos as well as external
messages (e.g. tweets, news articles) into their user post. This allows you to easily
share information across the organization by posting relevant links, videos, news
articles, etc. that will be important for other users to view. For more information
on previewing posts, please refer to the Previewing Posts section.

To add external links, messages, etc., simply drag and drop the corresponding title
that's linked to a URL into the post input box. For example, to add a video from
YouTube, click the title (e.g. "How to install SugarCRM") of the video then drag
and drop the link that appears into the post input box. The URL along with the
video will appear within the post once you submit it. For external twitter feeds, you
will need to click the post date (e.g. Jan 3) of the feed then drag and drop the link
that appears into the post input box. To attach an image to your post, copy and
paste the corresponding image URL into the post input box and the image will
appear within the post once submitted.

You can also reference a specific record in the post if you wish to link the post to
the record. For more information on referencing a record in your post, please refer
to the Referencing Users and Records section.

The following steps will cover adding an external link to the Home page activity
stream as an example:

1. Go to an external site (e.g. www.support.sugarcrm.com) then select a link
(e.g. Clearing Browser Cache article) you wish to add to your post.
Note: The actual link will popup when you click the link on the site and
drag it across the page.
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2. Drag and drop the link into the post input box on your Home page activity
stream then click "Submit".

The external link will now display in the post on the Home page activity stream
and will be viewable by all users in your organization.

Adding Attachments

Users can also drag and drop files such as PDFs, .doc files, .csv files, and image
files directly from their local machine (e.g. desktop) into the post input box to
share documents related to records with other users. 

The following steps will cover adding a file from your desktop to the account
record view's activity stream as an example:
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1. Locate the file on your desktop that you wish to attach to a post.
2. Drag and drop the file into the post input box.

3. The attached file(s) will appear below the post input box. You may choose
to enter a message simultaneously, which will appear as a separate
comment-type post in the activity stream. To remove an attachment, click
the "X" on the file's placeholder. Click "Submit" to post the file to the
activity stream.

You may drag and drop more than one file into the post input box, but please note
that each file will generate two posts in the activity stream: one post showing the
file item ("Fi" icon) and another linking to the note record ("Nt" icon) in Sugar
where the file is stored. You can preview the note record in the intelligence pane
by clicking the Preview button to the far right of the note activity stream post.
Click the file name in the preview's Attachment field to instantly download the file
to your local machine.
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The newly created note record will appear in the Notes & Attachments dashlet in
the account record view's intelligence pane as well as the related Notes subpanel.
If the Notes & Attachments dashlet is not displayed in the intelligence pane, you
can add the dashlet by editing the dashboard. For more information on adding
dashlets, please refer to the Adding Dashlets section of the Dashboards and
Dashlets documentation.

When posting an attachment to the activity stream, if you choose to also include a
comment, any related records mentioned in the comment will not form a
relationship with the note record or uploaded file.

If a new note is created via the Notes subpanel or Notes & Attachments dashlet, an
activity stream post will be created indicating that a new note was linked to the
record. Please note that, when a note is created or linked via the Notes &
Attachments dashlet, you must refresh the activity stream or subpanel view in
order to view the corresponding record.
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Adding via Dashlets

Users also have the option to drag and drop news feeds directly from the RSS Feed
dashlet into user posts. The RSS Feed dashlet can be added to the list view and
record view's intelligence pane dashboard. For more information on adding
dashlets to the intelligence pane, please refer to the Dashboards and Dashlets 
documentation. Once the dashlet is added and configured, simply click the specific
news article from the RSS Feed dashlet then drag and drop the link that appears
into the post input box. Click "Submit" to post the RSS feed link.

Referencing Users and Records

Sugar records and users can be referenced within the user post if you wish to
target the message to a specific user or relate the post to a specific record. To
mention a user in your post, type @ followed by the user's name (e.g. @John
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Smith). Please note that even if a specific user is referenced, all users will be able
to view the post in Sugar if the post originated from the Home page activity
stream. If the post originated from the list view or record view activity stream,
then only the specific user mentioned in the post will be able to view the message
on their Home page activity stream. To reference a record in your post, type #
followed by the record's name (e.g. #john). Please note that only modules enabled
for full-text search via Admin > Search can be referenced in posts. For more
information on how to enable modules for full-text search, please refer to the 
System documentation in the Administration Guide. Posts that reference a specific
record in Sugar will appear in that record view's activity stream. Users can access
the referenced record and user by clicking the highlighted record or user name
within the post. Please note that you can reference more than one user and record
in the same post.

As you type in the record name or user name, the type-ahead feature will begin to
display matching results below the post input box. Simply select one of the
matching users or records from the list then click "Submit" to post your message.
Please note that a user must have view access to the record in order for you to be
able to mention them when posting via the record view's activity stream. For
example, if user Will Westin does not have access to view ABC Company, you
cannot reference Will (e.g. @will) when posting a message via the ABC Company
record view's activity stream. If you try to mention a user without view access,
their name will be displayed in gray in the results list with a message stating that
they have no access.

Please note that you cannot preview users or records referenced in the post as the
preview is disabled. You will get an error message (Preview disabled: No data
available) when you hover on the Preview button to the right of the post. For more
information on previewing posts, please refer to the Previewing Posts section.

Viewing Field Changes
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Fields in Sugar that are marked as "Audit" via Admin > Studio will generate
update posts in the activity stream whenever the field gets updated. For more
information on marking fields for audit, please refer to the Studio documentation
in the Administration Guide. Please note that only audited fields will generate an
update post in the activity stream.

Updates you make to audited fields in the record view will generate a post in the
record view activity stream referencing the field name(s) that was updated (e.g.
"Updated Office Phone on ABC Incorporated"). When you hover on the field's name
within the update post, the old and new values will display above the post.

You will also be able to view the update post via the Home page and List View
activity stream if you follow the record in Sugar. For more information on following
records, please refer to the Following Records section.

Please note that users who do not have access to view the audited field due to a
role restriction will see a generic update post (e.g. Updated ABC Incorporated) on
their activity stream as the field name will not be mentioned. For more information
on roles, please refer to the Role Management documentation in the
Administration Guide.

Commenting on Posts

Users can respond to posts via the activity stream by clicking the Comment button
to the right of each post. A comment box will appear below the post and you can
type in your message then click "Reply" to post your comment. All associated
comments will appear below the post in the activity stream and will display the
timestamp of the comment along with the user's name who added the comment.
You can mention a specific user by typing @ followed by the user's name (e.g.
@Sarah Smith) or reference a specific record by typing # followed by the record's
name (e.g. #ABC Company). For more information on referencing users and
records in your post, please refer to the Referencing Users and Records section.
Please note that comments are visible to all users in Sugar unless they are no
longer following the record. For more information on unfollowing records, please
refer to the Unfollowing Records section.
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When a user comments on a post, that post will move to the top of the activity
stream once the page is refreshed. Please note that comments you add on the List
View activity stream will appear on the Home page activity stream and vice versa
if the post exists in both places. When there are multiple comments, the latest
comment will appear on top and users can click the more comments link (e.g. 2
more comments...) to view all comments associated to the post. Once you click the
link, all comments will display in cascading order with the most recent comments
on top. To hide the comments again, simply refresh the activity stream page.

Previewing Posts

Users can preview activity stream posts by clicking the Preview button to the far
right of the post. The intelligence pane will display the record's details with key
information regarding the record as well as any related activity stream
information. Please note that preview is available for Create, Update, Link, and
Unlink-type posts in the activity stream. To close the preview, simply click the "X"
on the upper right of the intelligence pane.

Also, messages posted via the Home page or List View activity stream cannot be
previewed as records are not automatically referenced within the post. The
Preview button will be grayed out and display a message ("Preview disabled: No
data available") when you hover on the button. Messages posted via the record
view can be previewed on the Home page and List View activity stream since the
record is automatically referenced within the post. For linked and unlinked type
posts, only the primary record that is linked or unlinked to can be previewed via
the intelligence pane. For example, the below post states that Lindsay Smith is
now linked to ABC Incorporated. Since ABC Incorporated is the primary record
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that the contact is now linked to, the account record will display when previewing
the post.

Please note that records for modules using the Legacy user interface cannot be
previewed if included in the post (e.g. Link-type post) and will generate an error
message ("Legacy modules cannot be previewed") when you hover on the button.
For more information on the Legacy user interface, please refer to the User
Interface (Legacy Modules) documentation.

Also when you are viewing a record in record view, you cannot preview a post that
references the same record. For example, if you are viewing ABC Incorporated's
record view and there is an update post referencing ABC Incorporated in the
record view's activity stream, you will not be able to preview any posts where ABC
Incorporated is the primary record.
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Accessibility

Overview

Sugar enables users to quickly perform certain tasks using keyboard shortcuts to
increase productivity and accessibility. Keyboard shortcuts can be used to navigate
around the list view and record view layouts for Sidecar modules, allowing users
quickly select records, inline edit records, preview records, etc. There are also
global shortcuts available to perform tasks such as toggling the Quick Create
menu, entering the Global Search field, etc. Users can also customize the key
combinations which activate each shortcut.

This documentation will cover the various keyboard shortcuts available as well as
how to navigate around Sugar using your keyboard. For more information
regarding accessibility for Sugar, please refer to the Accessibility information. 

Shortcut Keys

There are various shortcut keys available to easily perform actions in Sugar using
your keyboard. You can use the shortcut keys to favorite a record, delete records,
etc. in the Sidecar module's (e.g. Accounts, Contacts) list view and record view
layouts. In addition, the global shortcuts can be utilized throughout the user
interface to perform actions such as opening the Quick Create menu, accessing the
Global Search field, etc.

You can access the Keyboard Shortcuts help page by either hitting the Shift and /
key or clicking the Shortcuts link in Sugar's footer. The help page will display a
table with the various shortcut keys available to use along with a description of the
actions they perform. The shortcuts displayed are contextual based on what you
are currently viewing in Sugar. For example, if you are viewing the Mass Update
panel in the Accounts list view, then the Keyboard Shortcuts page will display
shortcuts that specifically apply to this panel. Simply hit "Esc" on your keyboard or
click the Close button if you wish to exit the page. You can also customize the key
combinations for each shortcut by clicking the Gear button.
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Global Shortcut Keys

The global shortcut keys can be used to perform the following actions in Sugar's
user interface:

Windows/Linux Key Mac Key Function
c c Toggle the Quick Create

menu
esc, ctrl+alt+l esc, cmd+alt+l Exit the Global Search

field
s, ctrl+alt+0 s, cmd+alt+0 Access the Global Search

field
t t Toggle the Right Hand

Side drawer in list view
and record view

ctrl+shift+space cmd+shift+space Toggle the Sweet Spot bar
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List View Shortcut Keys

The list view shortcut keys can be used to perform the following actions in the
module's list view layout:

Windows/Linux Key Mac Key Function
+ + Add field rows in the Mass

Update or Filter panel
- - Remove field rows in the

Mass Update or Filter
panel

a a Create new record
ctrl+a cmd+a Select all records

displayed on current set of
list view results

ctrl+s, ctrl+alt+a cmd+s, cmd+alt+a Save record
d d Delete record or custom

filter in list view
e e Edit selected record in list

view
esc, ctrl+alt+l esc, cmd+alt+l Exit out of certain

elements (e.g. inline edit)
in the list view

f+a f+a Mark selected record as a
favorite
Note: Hit "f+a" again to
remove the record as a
favorite.

f+c, ctrl+alt+8 f+c, cmd+alt+8 Create a new list view
filter

f+e f+e Edit custom list view filter
f+i, ctrl+alt+9 f+i, cmd+alt+9 Place cursor in list view

search box
f+m f+m Open the list view filter

menu
f+o f+o Mark selected record to

follow or unfollow
h h Scroll list to the left
j j Select the next record on

the list view
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k k Select the previous record
on the list view

l l Scroll list to the right to
view additional fields in
the list view

m m Open the mass actions
menu
Note: Menu opens once at
least one record is
selected.

o o Open the selected record's
(e.g. ABC Company)
record view

p p Preview the selected
record

r r Clear filter values
t t Toggle the Right Hand

Side drawer
x x Mark the checkbox to the

left of each selected
record in list view

Record View Shortcut Keys

The record view shortcut keys can be used to perform the following actions in the
module's record view layout:

Windows/Linux Key Mac Key Function
ctrl+s, ctrl+alt+a cmd+s, cmd+alt+a Save the record
d, ctrl+alt+d d, cmd+alt+d Delete the record
e, ctrl+alt+i e, cmd+alt+i Edit the record
esc, ctrl+alt+l esc, cmd+alt+l Exit out of certain

elements (e.g. edit view)
in the record view

f+a f+a Mark record as a favorite
Note: Hit "f+a" again to
remove the record as a
favorite.
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f+o f+o Mark record to follow or
unfollow

h h Open the previous record
l l Open the next record
m m Open the record's Actions

menu
shift+c, ctrl+alt+u shift+c, cmd+alt+u Copy the current record
t t Toggle the Right Hand

Side drawer

Customizing Shortcut Keys

You can customize the key combinations which activate each shortcut. This is
especially useful if you use the default key combinations for other functions such
as typing special characters.

Use the following steps to customize the shortcuts' key combinations:

1. Access the Keyboard Shortcuts page by clicking the Shortcuts link in
Sugar's footer.

2. Click the Gear button on the top right of the page.

3. Update the Key value you want to change in the Contextual Shortcuts
table.

Note: Depending on your operating system, the "mod" which appears in

                       211 / 1.116



 

key combinations will be the Control key (for Windows and Linux
computers) or the Command key (for Mac). Use "mod" to indicate the use
of these keys.

4. Click "Save" to preserve your changes.

If you ever wish to revert all of your custom key combinations, click the "Restore
default" option in the actions menu.

Since the Keyboard Shortcuts page shows contextually appropriate shortcuts,
repeat these steps on various Sugar views in order to access all of the shortcuts.

Tabbing in Sugar

Using the Tab key (Alt+Tab for Safari browser) on your keyboard enables you to
easily navigate through Sugar's navigation bar which spans across the top of the
screen. Please note that the default tab order is from left-to-right. As you hit the
Tab key, each option (e.g. home, module tabs, global search, notifications, etc.) on
the navigation bar will be highlighted in blue, and you can press "Enter" if you
wish to access the module's list view, actions menu, notification's page, etc. For
example, if you press "Enter" on the triangle in the Accounts module tab, the
corresponding actions menu will open and you can use your Up and Down arrow
on your keyboard to select an option (e.g. Create Account, View Accounts, etc.). If
you hit "Tab" again while the list view actions menu is open, you will navigate to
the next option (e.g. Contacts) on the navigation bar and the current actions menu
will close.
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In addition, you can continue to tab outside of the navigation bar to highlight and
access certain elements (e.g. Create button, Search box, Intelligence Pane, etc.) of
the home page, list view, record view, etc. For example, if you continue tabbing
after you get to the end of the navigation bar while viewing the Accounts list view,
the tab will move onto the various elements on the page highlighting buttons,
actions menu, account names, etc. You can simply hit "Enter" if you wish to
perform a specific action (e.g. create a record, open the actions menu, etc.) on the
list view. The tab will go through all of the currently displayed records on the list
view then move onto the intelligence pane and footer before going back to the
navigation bar again. Please note that each link (e.g. Mobile, Shortcuts) in Sugar's
footer will be highlighted as you tab from left-to-right. Simply hit "Enter" on your
keyboard if you wish to access any of the links on the footer.

Tabbing in Global Search

As you tab through Sugar's navigation bar, you will access the Global Search bar
where you can perform a search across the entire Sugar database. Once you enter
in a search term, you can use the Up and Down arrow keys on your keyboard to
navigate through the quick search results and hit the Tab key to close the Quick
Search Results list and return to the search bar. In addition, you can also tab
through the View All Results page to highlight and access certain elements (e.g.
Search box, Intelligence Pane, Preview button, etc.) of the page as well. For more
information on navigating through global search using your keyboard, please refer
to the Search documentation. 

Last Modified: 2021-09-30 13:06:28

Dashboards and Dashlets

Overview

Sugar dashlets allow users to build specific data, insights, and useful visualizations
into their Sugar views. Dashlets live within dashboards that are available on the
Home page as well as on list view and record view intelligence panes. 

Most modules and views include out-of-the-box default dashboards which include
some commonly-used dashlets. Sugar admin users may modify these stock, default
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dashboards or create additional dashboards to push to teams of users. Users can
also create additional dashboards or pull shared dashboards onto their view from
the Dashboards module and even create duplicates of existing dashboards to
customize for their own use. If more than one dashboard is available for a
particular view, users may switch between them using the view's dashboard
selection list.

Users with a Sugar Serve license type have access to a specialized dashboard
called Service Console. It is a shared, default Home page dashboard that provides
a powerful work environment for customer service agents by incorporating SLAs
and region-specific business hours, insightful dashlets, and a cohesive case
research and action experience. 

Users with a Sugar Sell license type have access to a specialized dashboard called
Renewals Console. It is a Home page dashboard that provides a powerful work
environment for your organization's Sales agents and Customer Success Managers
to automate and streamline renewal management. The Renewals Console makes it
easy to manage accounts, quickly see the status of your current quarter's renewal
pipeline, and manage individual renewal opportunities. 

Understanding Dashboards

The following sections explain the various methods of accessing and working with
dashboards as well as provide an overview of the factors involved in sharing
common dashboards between users.

Dashboards in Views vs the Dashboards Module

Users can access dashboards in the two following ways, with each way offering
different functionality.

Dashboards in Views : Every-day use of dashboards occurs in the Home
page as well as list view and record view intelligence panes on Sidecar
modules. Accessing dashboards in these locations will be referred to as
"dashboards in views". The Dashboards in Views section of this page details
the actions you can take when using dashboards in views.
Dashboards Module : Certain actions are not available with accessing
dashboards in views, particularly actions associated with sharing
dashboards with other teams and making dashboards visible in views.
These tasks are accomplished in the Dashboards module which includes a
Dashboards list view and record view. The Dashboards list view can be
accessed when viewing any dashboard in a view by selecting "Manage
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Dashboards" from the dashboard selection list. Viewing a dashboard in the
Dashboards module does not display its dashlets or provide many of the
actions available when using them in views. The Managing Dashboards
section of this page details the actions you can take when accessing the
Dashboards module.

Shared Dashboards

Several dashboard fields control whether a dashboard is available in a user's
Dashboards module and whether it appears on the user's views.

Note: When a shared dashboard is modified, other users will see the effects of the
changes after refreshing their view or switching to the affected dashboard.

Teams Access

The Teams field controls whether or not a dashboard is available in a user's
Dashboards module. Dashboards follow the same team permissions rules as any
other Sugar module. When a user first creates a dashboard, the Teams field is
automatically set to only his or her private team, which typically makes it visible to
that user and the user's management chain. This is because private teams, by
default, only include the individual user, and Sugar recommends not adding other
users to any private team. Each user's management chain inherently belongs to
each of the user's teams. For more information, please refer to the Private Teams
and Team Membership Types sections of the Team Management documentation.

The Teams field can be modified to allow other users to see it in their Dashboards
module as described in the Sharing Dashboards With Teams section below. Once
other users have teams access, the Favorite and Default Dashboard fields
determine whether the dashboard appears for use in their views, as described in
the next section.

Note: Admin users have access to all Sugar records, regardless of team
membership. No dashboards will be hidden from admin users in their Dashboards
module. 

Favorites and Default Dashboards

Two dashboard fields factor into whether a dashboard to which a user has team
access actually appears in that user's view: the Favorites designation and the
Default Dashboards field.

The Default Dashboards field can only be edited by admin users. When it is

                       215 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management#Private_Teams
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management#Team_Membership_Types


 

checked, the dashboard will appear on the views of every user that has teams
access. This effectively pushes the dashboard to users without their involvement.
For more information, refer to the Pushing Dashboards to Teams section below.

When the Default Dashboards field is unchecked, a dashboard will only appear on
a user's views when the user has marked it as a favorite. Dashboards can be
favorited via the Dashboards list view or record view. To remove a dashboard from
the view, users can simply unmark the Favorites designation, either from the
dashboard itself or from the Dashboards module. For more information, refer to
the Pulling Dashboards to Your Views section below.

Personalizing Shared Dashboards

As an alternative to using a shared dashboard as-is, users can duplicate any
dashboard which appears in their views. One of the main benefits of this is that it
allows them to use the shared dashboard as a starting point for personalizing the
dashlets to suit their particular needs. For more information, refer to the 
Duplicating Dashboards section.

Out-of-the-Box Default Dashboards

Many modules include prebuilt dashboards that come out-of-the-box with Sugar.
Admin users have the ability to modify or remove these dashboards. By default,
most of these dashboards have the following attributes:

Name : Following the format <Module> <View> (e.g. "Accounts List")
Assigned To : Assigned to the primary admin user (ID = 1)
Teams : Global
Default Dashboard : Checked

It is important that admin users not treat these default dashboards like personal
dashboards. So long as the Default Dashboard field remains checked, any changes
made to the dashboards will be pushed to all users belonging to the associated
team(s). Since the Global team is automatically selected, changes would affect all
users. If an admin user wishes to modify the default dashboards for personal use,
they should duplicate the dashboards, then make changes to the new copy which
will be assigned to their private team and not have the Default Dashboard box
checked. For more information, refer to the Personalizing Shared Dashboards
section. Alternatively, admins can always create new dashboards from scratch for
their personal use. 

Users with a Sugar Serve license type have access to a specialized dashboard
called Service Console. It is a shared, default Home page dashboard that provides
a powerful work environment for customer service agents by incorporating SLAs
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and region-specific business hours, insightful dashlets, and a cohesive case
research and action experience. 

Users with a Sugar Sell license type have access to a specialized dashboard called
Renewals Console. It is a Home page dashboard that provides a powerful work
environment for your organization's Sales agents and Customer Success Managers
to automate and streamline renewal management. The Renewals Console makes it
easy to manage accounts, quickly see the status of your current quarter's renewal
pipeline, and manage individual renewal opportunities. 

Using Dashboards and Dashlets

Dashboards with their dashlets are available on the list view and record view of
Sidecar modules. For example, to access the Accounts record view dashboards,
click the Accounts tab in Sugar's header. Then, click one of the account names that
appear to open its record view. Ensure the intelligence pane is expanded by
clicking the arrow icon at the top right of the list view. For more information about
intelligence panes, refer to the User Interface page.

Dashboards are also available on the Home page which can be accessed by
clicking the Cube icon at the top left of any Sugar page. For more information
about the Home module, refer to the Home documentation.
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Both locations will remember which dashboard you last accessed in each view and
open it automatically when you return.

Dashboard records are also visible in the Dashboards module which can be
accessed by selecting "Manage Dashboards" from any view's dashboard selection
list. The Dashboards list view and record view offers fields and functionality not
available when viewing dashboards in intelligence panes and the Home page.
However, the dashboard's layout and dashlets are not visible via the Dashboards
module. For more information, refer to the Managing Dashboards section.

Dashboard Actions Menu

The Actions menu at the top of each dashboard allows you to perform various
actions on the current dashboard. The options in the Dashboard Actions menu
allow you to perform the following operations which are explained in more detail in
the sections below:

Option Description
Create Create a new dashboard.
Edit Rename the dashboard, delete the
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dashboard, add dashlet rows and
dashlets, and rearrange and delete
dashlet rows.

Duplicate Create and make changes to your own,
private copy of the original dashboard
without affecting what other users see.

Open All/Close All Collapse or expand all dashlets on the
dashboard at once. Note that Sugar will
remember the closed or open state of
your dashlets the next time you return
to the view.

Creating Dashboards

Create a new dashboard and build out its dashlets. New dashboards are
automatically assigned to the creating user and their private team.

Users can create dashboards in list view and record view intelligence panes and on
the Home page. By default, new dashboards will be assigned to the creating user
with the Teams field set to the creating user's private team. The dashboard will
also be automatically designated as a favorite so that it appears on the user's view
after being created. To make the dashboard available for other users, additional
teams can be added to the Teams field via the dashboard's record view. Click
"Manage Dashboards" from any dashboard selection list to access the Dashboards
list view, then click a dashboard's name to open it in record view. Admin users also
have the ability to check the Default Dashboards field to push the dashboard onto
the views for all members of the associated teams.

The following steps cover creating a new dashboard called "My Favorites
Dashboard" in the Accounts list view intelligence pane as an example:

1. Click the Create button on the upper right of the intelligence pane.

2. Enter in the name for the new dashboard (e.g. My Favorites Dashboard).
3. Add any desired dashlets by adding rows along with the number of columns

to display the dashlet(s). For more information on adding dashlets, please
refer to the Adding Dashlets section.
Note: Dashboards will support up to ten rows of dashlets.
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4. Click "Save" to finalize the new dashboard.

Duplicating Dashboards

Duplicating a dashboard will create a copy of the original with the following
attributes:

Name : Copy of <Original Name> (e.g. "Copy of Accounts List")
Assigned To : The user who performed the duplication
Teams : The private team of the user who performed the duplication
Default Dashboard : Unchecked

Duplication is recommended when you wish to personalize a shared dashboard. By
making your changes to your own, private copy, the original dashboard will not be
affected for other users. Additionally, dashboards can only be edited by their
Assigned To user and admin users. Creating a copy of a shared dashboard owned
by another user allows you to optimize the dashboard for your purposes. For more
information, refer to the Personalizing Shared Dashboards section.

Duplicating a dashboard containing a List View dashlet with custom filters applied
will duplicate the dashlet as well including the custom filter. Please note that you
can edit the dashlet but will not be able to edit the shared filter in the
Configuration Options page. If you remove the shared filter from the dashlet, you
will not be able to apply the same filter again as you do not own it.

To create a copy of a dashboard, simply select the Duplicate option from the 
Dashboard Actions menu.

Editing Dashboards

Editing dashboards from an intelligence pane or the Home page allows you to
customize it to suit your business needs. To enter edit mode, simply select "Edit"
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from the Dashboard Actions menu.

From edit mode, you can rename the dashboard, delete the dashboard, add dashlet
rows and dashlets, as well as rearrange and delete dashlet rows. For more
information, please refer to the Deleting Dashboards, Adding Dashlets,
Rearranging Dashlets, and Deleting Dashlets sections.

Dashboards can also be renamed via the Dashboards module by modifying the
Name field. For Home dashboards, users can also change the number of columns. 

Note: A dashboard may only be edited by its Assigned To user and system admin
users. Any change to a shared dashboard will update the dashboard for all users.
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Switching Between Dashboards

Select a dashboard from the dashboard selection list to switch which dashboard is
displayed.

Between default dashboards, shared dashboards, and personal dashboards, users
may have multiple dashboards active for a single Sugar view (e.g. Accounts list
view). The dashboards selection list contains all of the user's active and default
dashboards for the particular view and allows for switching between the
dashboards. In order for a dashboard to appear in a view's dashboard selection
list, the following criteria must be true:

The dashboard's Module and View fields match the user's current module
and view (e.g. Accounts list view). Each dashboard is only visible in the
module and view where it was originally created.
The user belongs to one or more of the teams selected in the dashboard's
Teams field.
The user has selected the dashboard as a favorite OR the dashboard's
Default Dashboard field is checked. Dashboards an admin has marked as
default will appear in your views regardless of being a favorite or not.

On a record view or list view intelligence pane, click the arrow next to the current
dashboard's name to view and select from the list of available dashboards.

On the Home page, click the arrow next to the Cube icon to view and select from
the list of available dashboards.
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Deleting Dashboards

When a dashboard is no longer useful, it can be deleted by the Assigned To user or
an admin user. Deleting a dashboard will make it unavailable for any other users
with whom it is shared.

Note: If a shared dashboard is no longer needed by its owner or the dashboard
owner will no longer be using Sugar, the dashboard can be reassigned, either by
editing the Assigned To field via the Dashboards module or using the Reassign
Records function in Admin > User Management.

Use the following steps to delete a dashboard from a list view or record view
intelligence pane or from the Home page:

1. Click the triangle next to the Create button then select "Edit".

2. Click the Delete button on the upper right of the dashboard and click
"Confirm" to finalize the deletion.

Dashboards can also be deleted via the Dashboards module from both list view and
record view.
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Removing Dashboards From Views

If a user no longer wishes to use a dashboard, they can unmark the Favorites
designation by clicking the Star icon. For more information on how the Favorites
designation factors into which dashboards are available in your views, please refer
to the Pulling Dashboards to Your Views section. Please note that dashboards an
admin user has designated as defaults by checking the Default Dashboard box will
remain available for use in your dashboard selection list regardless of whether or
not you have favorited the dashboard.

The Favorite designation is also available to edit via the Dashboards module. 

Adding Dashlets

Users can add up to ten rows of dashlets to existing or new dashboards to suit
their business needs. Adding dashlets can be done when the dashboard is in edit
mode either during dashboard creation or when editing an existing dashboard. 

Note: A dashboard and its dashlets may only be edited by the dashboard's
Assigned To user and system admin users. Any change to a shared dashboard will
update the dashboard for all users.

With your new dashboard in edit mode, use the following steps to add a new
dashlet in the Accounts list view intelligence pane as an example:

1. Click "+ 1 column" in the Add a Row box.
Note: Dashboards on the Home page may offer 1 to 3 columns depending
on the selected layout.

2. Click the Add a Sugar Dashlet box that appears.

                       224 / 1.116



 

3. Click the title (e.g. List View) corresponding to the desired dashlet in the
Add a Sugar Dashlet page.

4. Configure the dashlet as desired then click "Save".

5. The dashlet will now appear in your dashboard. Click "Save" at the top
right of the dashboard to preserve your changes.
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Rearranging Dashlets

Users have the option to arrange the dashlets within a dashboard to match their
viewing preferences. You can easily swap two dashlets by dragging and dropping
the dashlets in their desired locations. Simply click and drag a dashlet's menu bar
to relocate it.

You can also edit the dashboard to rearrange the dashlets. In edit mode, each
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dashboard row displays an Up and Down arrow icon on the upper right. Users can
click the icon then drag the entire row up and down within the dashboard.

Note: A dashboard and its dashlets may only be edited by the dashboard's
Assigned To user and system admin users. Any change to a shared dashboard will
update the dashboard for all users.

Editing Dashlets

Dashlets can easily be configured to display specific information users want to
view. Simply click the Gear icon at the top of the dashlet menu bar then select
"Edit", which will display configuration options specific to the dashlet. Make the
necessary changes using the available edit options then click "Save" to preserve
the change. For more information about specific dashlets and how to configure
them, refer to the Commonly Used Dashlets section.

Note: Dashlet Gear menus, including the Edit option, are only available to the
containing dashboard's Assigned To user and system admin users. Any change to a
shared dashboard will update the dashboard for all users.

Deleting Dashlets

Users can delete dashlets they no longer wish to view on their dashboards by
clicking the Gear icon at the top left of the dashlet then selecting "Remove". Prior

                       227 / 1.116



 

to deleting a dashboard, consider if other users have access to it and consider
instead reassigning the dashboard then un-favoriting it to remove it from your own
views. For more information, refer to the Reassigning Dashboards and Removing
Dashboards From Views sections.

Users can also delete dashlet rows which may contain multiple dashlets for Home
page dashboards. While editing the dashboard, click the dashlet row's Gear icon
and select "Remove".

Note: Dashlet Gear menus, including the Delete option, are only available to the
containing dashboard's Assigned To user and system admin users. Any change to a
shared dashboard will update the dashboard for all users.

Collapsing and Expanding Dashlets

Users can collapse or expand individual dashlets by clicking the Up or Down arrow
on the upper right of the dashlet. Sugar will remember the state of your dashlets
the next time you return to the view. For dashboards on intelligence panes, users
can also collapse or expand all dashlets on the dashboard by clicking the triangle
next on the upper right and selecting "Close All" or "Open All".
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Refreshing Dashlets

When users first navigate to a page in Sugar or refresh the browser window, the
page's dashlet all retrieve fresh information. To update dashlet data between page
loads, the dashlets themselves must be refreshed. Dashlet refreshes can be
performed manually or automatically.

Users can manually refresh a dashlet by clicking the Gear icon at the top of the
dashlet menu bar and then selecting "Refresh".

Users can schedule the dashlet to automatically refresh using the Auto-Refresh
option. Click the Gear icon at the top of the dashlet menu bar then select "Edit".
This will display the Configuration Options page where you can select how often
the dashlet should automatically retrieve fresh information.
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Note: Dashlet Gear menus, including the Refresh option, are only available to the
containing dashboard's Assigned To user and system admin users.

Managing Dashboards

The Dashboards module consists of dashboard records visible in the Dashboards
list view and Dashboards record view. Please note that when viewing a dashboard
in list view and record view, its dashlets are not visible. Rather, the Dashboards
module allows users to share their dashboards with teams of users, pull
dashboards to their own views, reassign dashboards, and update select fields on
the dashboard record. Admin users are also able to push dashboards to the views
of teams of users.

Note: To make changes to dashlets or the layout of your dashboard, edit the
dashboard via its Dashboard Actions menu from an intelligence pane or the Home
page.

The Dashboards module can be accessed from any record view or list view
intelligence pane or from the Home module. Simply select "Manage Dashboards"
from the view's dashboard selection list.

From record view and list view intelligence panes, click the triangle next to the
dashboard's name and select "Manage Dashboards".
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From the Home page, click the triangle next to the Home module tab (Sugar cube
icon) and select "Manage Dashboards".

Doing so will open the Dashboards module in list view. The list view will
automatically be filtered by the module and view you navigated from so that you
can quickly locate dashboards available in that view. To locate other dashboards,
simply modify or remove the filters. For more information about filtering list views,
refer to the User Interface documentation.

Note: If you do not see the desired dashboard in your Dashboards list view or
receive a permissions error when attempting to navigate directly to its record
view, you may not belong to one of its designated teams. The dashboard's owner or
an admin user will need to update the dashboard's Teams field to grant you access.
For more information, refer to the Team Management documentation in the
Administration Guide. If the Teams field includes a team to which you belong,
confirm that the dashboard's Module and View field match the module and view
(e.g. Accounts record view) where you would like it to appear. Each dashboard can
only be applied to the module and view where it was originally created. For more
information, refer to the Shared Dashboards section above.

Dashboard Module Fields

The Dashboards module includes the following fields. For information on using and
editing various field types, refer to the User Interface documentation. 

Field Description
Assigned To The Sugar user assigned to the

dashboard
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Date Created The date the dashboard record was
created

Date Modified The date the dashboard record was last
modified

Default Dashboard Specifies that the dashboard will appear
in the specified module and view for all
users belonging to the teams selected in
the Teams field
Note: Only admin users can check or
modify the Default Dashboard checkbox.

Module The module (e.g. Accounts,
Opportunities, Home) where the
dashboard appears
Note: This field is read-only for all
users. Dashboards cannot be moved
from one module to another.

Name The name of the dashboard which is
displayed in the dashboard selection list

Teams The teams whose members have access
to the dashboard in the Dashboards
module

View The view (e.g. "List" for list view and
"Record" for record view) where the
dashboard appears
Note: This field is read-only for all
users. Dashboards cannot be moved
from one view to another.

Working With the Dashboards Module

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Dashboards section describe
Dashboards-specific behaviors and functionality.

Content Link Description
Viewing Dashboards
Viewing via List View
Viewing via Record View

The Viewing Records section describes
the various methods of viewing
dashboard records, including via the
Dashboards list view and record view.
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Note: The Dashboards list view and
record view include information about
the dashboard but do not display the
dashboard's dashlets. Dashboards
including their dashlets are visible in
intelligence panes and the Home page
as described in the Dashboards in Views
section. 

Searching for Dashboards
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Dashboards module.

Dashboards List View
Total Record Count
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Record Actions Menu
More Dashboards

The List View section walks through the
many elements of the Dashboards list
view layout which contains a filterable
list of all dashboard records in Sugar.

Note: A user can only access a
dashboard's record actions menu in list
view when they are the assigned user or
an admin user.

Dashboards Record View
Favorite Designation
Next or Previous Record
Show More

The Record View section walks through
the many elements of the Dashboards
Record View layout which contains
detailed information about a single
dashboard record.

Note: The Dashboards list view and
record view include information about
the dashboard but do not display the
dashboard's dashlets. Dashboards
including their dashlets are visible in
intelligence panes and the Home page
as described in the Dashboards in Views
section. 

Editing Dashboards
Editing Inline via Record View
Editing via Record View
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
dashboard records, including inline via
the Dashboards record view, in full edit
mode on the record view, inline via the
Dashboards list view, and via the Mass
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Update option on the list view.

Deleting Dashboards
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted dashboards, including via the
Dashboards record view, an individual
record's Actions menu on the
Dashboards list view, and the Mass
Actions menu on the list view.

Dashboards can also be deleted when
viewing them in your intelligence pane
or Home page as described in the 
Deleting Dashboards section below.

Favoriting Dashboards
Favoriting via List View
Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking dashboards as favorites,
including via the Dashboards list view
and record view.

Marking a non-default dashboard as a
favorite makes it available for the user
in the specified module and view. For
more information, refer to the Pulling
Dashboards to Your Views section. Once
on a view, dashboards can be de-
favorited as described in the Removing
Dashboards From Views section.

Sharing Dashboards With Teams

When a dashboard is first created, it is automatically assigned to the creating user
and his or her private team. In order to make the dashboard available for others to
use, the Teams field must first be updated to grant those users access. Refer to the
Teams Access section for more information.

From the Dashboards list view, click a dashboard's name to open it in record view 
where additional teams can be added to the Teams field. Only the assigned to user
and admin users can edit dashboard records, including the Teams field.
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Once a dashboard has been shared with multiple users via the Teams field, those
users can then favorite the dashboard to make it visible in their own views.
Alternatively, an admin user can check the Default Dashboard field to push the
dashboard to the user's views automatically. Refer to the Pulling Dashboards to
Your Views and Pushing Dashboards to Teams sections for more information.

When a dashboard contains List View dashlets with custom filters applied, the
filters will be shared with all members of the associated team(s). So, when the user
views the shared dashboard, the List View dashlet will display a filtered list of
records using the shared filter. Please note that users will only be able to see
records as allowed by their team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.
Please note that custom filters in the List View dashlet can only be edited by the
original dashboard owner and any changes made to the shared filter will be
pushed to all users belonging to the associated team(s). If the owner later deletes
the filter, the shared filter will be removed from the List View dashlet for all users
belonging to the associated team(s), and the dashlet will no longer return results
when viewed from the dashboard.

Pulling Dashboards to Your Views

When a user wishes to use a dashboard that is available in their Dashboards
module but does not appear in the relevant view's dashboard selection list, they
can designate the dashboard as a favorite in order to pull it onto the view.
Dashboards a user has marked as favorites will appear for use in the relevant view
as prescribed by the dashboard's Module and View fields (e.g. Accounts list view).

1. Navigate to the module and view where you would like to see the shared
dashboard.

2. Select the Manage Dashboards option.
3. Locate the dashboard you wish to use.
4. Mark the dashboard as a favorite by clicking the star icon in the list view or

record view.
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5. Return to the module and view to confirm that the dashboard is now 
available for selection.

Once a dashboard is a favorite and is available for use, it can be un-marked as a
favorite from the Dashboards module or directly from the relevant view in order to
remove it from that view's dashboard selection list. Dashboards an admin has
marked as default will appear in your views regardless of being a favorite or not,
as described in the Pushing Dashboards to Teams section.

Pushing Dashboards to Teams

Sugar admin users have the ability to push dashboards to the views for teams of
users. This is a two-step process that involves first sharing the dashboard with the
desired user's teams, then checking the Default Dashboard field. For more
information on how the Teams field plays a role, refer to the Sharing Dashboards
With Teams section. When the Default Dashboard field is checked, the dashboard
will appear on the named module and view's dashboard selection list for every user
that has teams access. This effectively pushes the dashboard to users without their
involvement. Default dashboards have a checkmark on the standard dashboard
icon when viewing them in the selection list on views.

A dashboard can be pushed to its associated teams by updating the Default
Dashboard checkbox when editing the record. Only admin users can edit the
Default Dashboard field.
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Sugar includes out-of-the-box default dashboards that automatically have "Default
Dashboard" checked. Refer to the Out-of-the-Box Default Dashboards section for
more information.

Reassigning Dashboards

There are several situations in which you may need to reassign a dashboard record
to a different user. Only the Assigned To user and system admin users are able to
edit dashboards. Therefore, reassigning the dashboard record will allow a different
user to make changes to it. Additionally, because dashboards may be shared
amongst multiple users, care needs to be taken before deleting a dashboard or
removing a user account's record to Sugar. In both cases, the dashboard should be
reassigned to prevent other users from losing access unintentionally.

A dashboard can be reassigned by updating the Assigned To field when editing the
record. Only the assigned to user and admin users can edit dashboard records,
including the Assigned To field.

When the dashboard is reassigned, the following changes will automatically be
made:

The previous Assigned to user loses the ability to edit the dashboard.
If the new Assigned To user is not a member of any team in the Teams
field, their private team is automatically appended to the Teams field.
If the previous Assigned to user's private team is selected in the Teams
field, it will remain selected so that they continue to have access to the
dashboard.

Please note that a custom filter applied to a List View dashlet will not be
transferred to the new Assigned To user, but rather shared. So, the new owner can
edit the dashlet but will not be able to edit the shared filter in the Configuration
Options page. If the applied custom filter is removed from the dashlet, they will not
be able to apply the same filter again as they do not own it. 

All of a user's assigned dashboards can be reassigned at once using the Reassign
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Records field available in the User Management section of the Admin panel. This is
especially useful to preserve others' access to a dashboard when a user account is
being deactivated. For more information, refer to the User Management
documentation in the Administration Guide.

Commonly Used Dashlets

The following sections cover many commonly used dashlets that may appear on
your default dashboards or can be added to your dashboards. Please note that the
dashlets available to view and add will vary between the modules in Sugar.

Note: Dashlet Gear menus, including the Edit, Remove, Refresh, etc. options, are
only available to the containing dashboard's Assigned To user and system admin
users. Any change to a shared dashboard will update the dashboard for all users.

List View Dashlet

The List View dashlet enables users to view a filtered list of records belonging to a
specific module (e.g. Accounts, Contacts, Leads). When configuring the dashlet,
simply select the primary module (e.g. Accounts, Contacts, Leads) you wish to view
a list of records for along with the filters (e.g. columns, display rows) you wish to
apply. Please note that the dashlet title (e.g. My Accounts, My Contacts) will vary
based on the primary module selected when adding the dashlet. Certain modules
(Accounts, Contacts, Leads) in Sugar display the List View dashlet by default in
their list view's intelligence pane. For example, if you navigate to the Contacts list
view, the My Accounts dashlet will appear in the intelligence pane dashboard.

Once added, you can configure the dashlet as necessary by clicking the Gear icon
on the upper right if you wish to change the designated module for the dashlet,
apply predefined or custom filters, etc. Please note that any changes made by the
administrator to the List View layout in Studio affect the list of available fields in
the module's list view dashlet layout. The deployed changes will not display
automatically in the corresponding module dashlet and users will need to edit the
dashlet in order to view the changes in the Columns field, add new fields to the
layout, etc. For more information on editing the List View layout in Studio, please
refer to the Studio documentation in the Administration Guide.

The following are the most common options available when filtering and
configuring the list view dashlet:

Title : Change the displayed name of the dashlet.
Module : Change the module that the dashlet is displaying records from by
selecting a different module from the list.
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Columns : Choose the field columns you wish to display on the dashlet. To
remove a field column, simply click the "x" to the right of the field name.

Note: The field columns available to add to the dashlet are based on
the specified fields in the List View layout in Studio. Any changes
made to the List View layout in Studio will be reflected in the
Columns field. For more information on configuring the List View
layout, please refer to the Studio documentation in the
Administration Guide.

Display Rows : Specify how many rows or results this dashlet will display
at once. Please note that the maximum is twenty rows.
Auto Refresh : Choose a time frame to have the dashlet query
automatically refresh.
Filter : Click the Filter option to select a pre-defined filter or create a new
filter to be applied to the List View dashlet.

Note: The My filter (e.g. My Accounts) is selected by default.

The following are options that are only available when configuring a list view
dashlet on a record view:

Relate to current record : Specify if the dashlet will be filtered to only list
records related to the record you are viewing.
Linked field : This field is shown only when "Relate to current record" is
enabled; the dropdown will display all of the fields in the selected module
that link back to the current record. In most cases, there will only be one
field listed, but there are a few exceptions. For example, a Quotes list view
dashlet on the Accounts record view can link to quotes where the account
is either the billing account or the shipping account. Specify which of these
account fields should link to the current record.
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Creating a Filter

The Filters section of the Configuration Options page allows you to filter your
dashlet based on pre-defined filters (e.g. My Favorites, Recently Created) as well
as create custom filters. For example, if you select "My Contacts" in the Filter
options, the List View dashlet will only display contact records that are assigned to
you. To see all records to which you have access, simply select the All option in the
filter.

The following Filter options are available to filter the List View dashlet:

Create : Create a new custom filter which you can use to filter the List
View dashlet
All "Module" : Select this filter to display all records in the module to
which you have access
My Favorites : Select this filter to only display records you have marked as
favorites
My "Module" : Select this filter to only display records assigned to you
Recently Created : Select this filter to only display records you created in
the module within the last 7 days
Recently Viewed : Select this filter to only display records you have
viewed in the module within the last 7 day
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Users can also create new filters via the Create option in the Filter list. This allows
users to add custom, complex filter options when filtering the List View dashlet.
You have the option to add multiple fields to your new filter by clicking the Plus
button to the right of the filter selection dropdown lists. Please note that each one
of the filter's criteria needs to be true for a record in order for it to appear in the
List View dashlet. The fields available to filter the dashlet are based on specified
fields in the Search layout in Studio. Any changes made to the Search layout in
Studio will be reflected in the filter's field dropdown list. For more information on
configuring the Search layout, please refer to the Studio documentation in the
Administration Guide.

The following steps cover creating a new filter for contacts assigned to Will Westin
as an example:

1. Click the Filter option on the Configuration Options page then select
"Create".

2. Select the field (e.g. Assigned to) you wish to add to your filter as well as
the condition (e.g. is) and matching criteria (e.g. Will Westin).

Note: Only fields you have view access for will be available to add
in the Filter list.

3. To add additional fields to the new filter, click the Plus button to the right
of the filter.

To remove fields from the new filter, click the Minus button to the
right of the filter.
To clear any filter values (e.g. Will Westin), simply click the "x" to
the right of the value.
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4. Enter in a name for the new filter (e.g. "Contacts assigned to Will Westin").

5. Click "Save" to add this filter to the dashlet list view's Filter options.

The custom filter will automatically be applied to the dashlet upon save and all
records meeting the filter criteria will display. Please note that you can edit the
custom filters at any time by selecting the filter (e.g. Contacts assigned to Will
Westin) from the Configuration Options page, then clicking the name that appears
to the right of the Filter option. Simply make the necessary changes to the custom
filter then click "Save" to preserve and apply the changes to the dashlet.
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When viewing the List View dashlet, the first set of records meeting the filter
criteria will be displayed, and you can click the More link (e.g. More accounts) at
the bottom of the dashlet to display additional records. The number of records that
load each time you click the link depends on the display row number (5, 10, 15, 20)
selected in the Configuration Options page. Simply scroll down the dashlet list
view to view all records that are loaded. Please note that dashlets set to display 5
rows will show the dashlet's height increasing slightly when initially clicking the
More "Module" link to display more records at once. Any subsequent clicks on the
link will load the next set of results and be viewable by scrolling. The More link
will no longer appear once all records meeting the dashlet's filter criteria are
loaded in the dashlet list view results.

Steps to Edit a Dashlet

Every user can configure their dashlet(s) to only display the information they wish
to view via the display options and filters available in the Configuration Options
page.

The following steps cover updating the title, display rows, columns, and only my
favorites filter for the My Accounts dashlet as an example:

1. Click the Gear icon at the top of the My Accounts dashlet menu bar then
select "Edit".

2. Change the "Title" (e.g. My Favorite Accounts) and the display rows from 5
to 10.
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3. Click the "x" next to "Billing Country" to remove the field from the display
column.

To add columns, simply click your mouse in the Columns field then
select from the list of available fields that appear below the
dropdown list.

4. Click the Filter option then select "My Favorites".
5. Once the update is complete, click "Save" and the dashlet will reflect the
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changes made.
Click "Save" on the dashboards edit layout to apply the changes to
your final dashlet view.

Multiple List View dashlets can be added to the intelligence pane as well if you
wish to view the list of records for various modules. For more information on
adding dashlets, please refer to the Adding Dashlets section. You can also refresh
and remove the dashlet by clicking the Gear icon. To collapse the dashlet, simply
click the Up arrow to the left of the Gear icon.

Active Tasks Dashlet

The Active Tasks dashlet allows users to view open tasks that require attention and
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need to be completed on a future or current date. Open tasks have a status of "Not
Started", "In Progress", or "Pending Input". The dashlet is broken up into three
tabs: "Due Now", "Upcoming", and "To Do", and displays a number on each tab to
indicate the count of open tasks falling into each due-date range.

Due Now : Open tasks that are due today and open tasks where the due
date is in the past
Upcoming : Open tasks that have a due date in the future
To Do : Open tasks that have no due date specified

When placed on a user's Home page dashboard, the Active Tasks dashlet will show
all active tasks assigned to the logged-in user or all active tasks that the logged-in
user has team permission to view, depending on how the user has configured the
dashlet's settings.

When the Active Tasks dashlet is placed on the record view for a related module
(e.g. Accounts, Contacts), it will only show the active tasks that have a relationship
with the current record. For example, if the Active Tasks dashlet is placed on the
Account module's record view, when a user views ABC Account, the Active Tasks
dashlet will only show the active tasks that are related to ABC Account.

You can close tasks as completed directly from the dashlet by clicking the
Completed button to the right of the task's row. In addition, you can delete the
task's relationship with the record by clicking the Unlink button to the right of the
Completed button.

To access a task's record view, simply click the task's subject in the dashlet. There
are two buttons on the upper right of the dashlet which allow you to toggle
between viewing tasks assigned to you and all tasks to which you have access. You
can click the one person button to quickly view task records for which you are the
assigned user. To remove this filter and view tasks assigned to others as well as
yourself, simply click the group button to the right of the one person button. You
can also relate new tasks to the record by clicking the Plus icon on the upper right
of the dashlet and selecting "Create Task". Complete the Tasks record view layout
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and save to create the new task. The Gear icon to the right of the Plus icon allows
you to edit, refresh, close, and remove the dashlet. To collapse the dashlet, click
the Gear icon then select the Close option. To expand the dashlet, simply click the
Gear icon again and select "Open". 

Inactive Tasks Dashlet

The Inactive Tasks dashlet allows users to view tasks that are on-hold or have
already been completed. The dashlet is broken up into two tabs, "Deferred",
"Completed", and displays a number on each tab to indicate the count of tasks
falling into each status.

When placed on a user's Home page dashboard, the Inactive Tasks dashlet will
show all inactive tasks assigned to the logged-in user or all inactive tasks that the
logged-in user has team permission to view, depending on how the user has
configured the dashlet's settings.

When the Inactive Tasks dashlet is placed on the record view for a related module
(e.g. Accounts, Contacts), it will only show the inactive tasks that have a
relationship with the current record. For example, if the Inactive Tasks dashlet is
placed on the Account module's record view, when a user views ABC Account, the
Inactive Tasks dashlet will only show the inactive tasks that are related to ABC
Account.

You can delete the task's relationship with the record by clicking the Unlink button
on the task's row.

To access a task's record view, simply click the task's subject in the dashlet. There
are two buttons on the upper right of the dashlet which allow you to toggle
between viewing tasks assigned to you and all tasks to which you have access. You
can click the one person button to quickly view task records for which you are the
assigned user. To remove this filter and view tasks assigned to others as well as
yourself, simply click the group button to the right of the one person button. You
can also relate new tasks to the record by clicking the Plus icon on the upper right
of the dashlet and selecting "Create Task". Complete the Tasks record view layout
and save to create the new task. The Gear icon to the right of the Plus icon allows
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you to edit, refresh, close, and remove the dashlet. To collapse the dashlet, click
the Gear icon then select the Close option. To expand the dashlet, simply click the
Gear icon again and select "Open". 

History Dashlet

The History dashlet allows users to view a history of the record's related activities
(e.g. calls, meetings, emails) that have already taken place. The activity types are
broken up into three tabs (Meetings, Emails, Calls) and a number on each tab
indicates the relevant count of historical activity records. You can also filter (Last 7
Days, Last 30 Days, Last Quarter) the History dashlet to only display a specific
subset of the activities meeting the set time frame.

Clicking the Plus icon on the upper right of the dashlet displays the Archive Email
option which allows users to manually enter received emails for historical
purposes. An explicit relationship is formed between an archived email and the
current record while implicit relationships are also created to other records based
on any email addresses entered in the email. Simply enter the required information
(e.g. Date Sent, From, Subject) along with the email body in the Compose Email
window, then click "Archive" to save the email record. Please note that the
archived email will display in the record's Emails subpanel as well as in the History
dashlet. The Gear icon to the right of the Plus icon allows you to edit, refresh,
close, and remove the dashlet accordingly. To collapse the dashlet, click the Gear
icon then select the Close option. To expand the dashlet, you can simply click the
Gear icon again and select "Open".

In addition, there are two buttons on the upper right of the dashlet which allow
you to toggle between viewing the record's activities assigned to you and activities
assigned to users in other teams. You can click the one person button to quickly
view the record's calls, meetings, and emails for which you are the owner. To view
the record's activities for all users on your team, simply click the multi-group
button to the right of the one person button.
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Planned Activities Dashlet

The Planned Activities dashlet provides users with a list of open or upcoming calls
and meetings that are related to the current record you are viewing. The activity
types are broken up into two tabs (Meeting, Call) and a number on each tab
indicates the relevant count of planned activity records. You can filter the dashlet
to view either the current day's scheduled activities or upcoming activities in the
future by toggling between the Today or Future button. Please note that any open
activities where the start date is prior to the current date will display an Overdue
status for the specific activity in the dashlet. Once the activities have taken place
or are completed, they will appear within the History dashlet.

In addition, there are two buttons to the right which allow you to toggle between
viewing the record's scheduled activities assigned to you and activities assigned to
users in other teams. Please note that you can use both sets of buttons (Today,
Future, one person, multi-group) concurrently to further filter and view the
information you need. For example, you can click the one person button plus the
Future button if you wish to view all upcoming activities specifically assigned to
you for the current record.

To create a new meeting or call, simply click the Plus icon on the upper right of the
dashlet and select either "Schedule Meeting" or "Log Call". Once the Meeting or
Call record view layout opens, enter the necessary information and click "Save" to
create the activity. For more information on creating calls and meetings in Sugar,
please refer to the Creating Records section of the User Interface documentation.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, close,
and remove the dashlet accordingly. To collapse the dashlet, click the Gear icon
then select the Close option. To open up the dashlet, you can simply click the Gear
icon again then select "Open".

To the right of the meeting and call record's row is a set of buttons that allow you
to mark the activity as held, delete the call or meeting's relationship with the
current record, as well as accept, tentatively accept, or decline the call or meeting.
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Notes & Attachments Dashlet

The Notes & Attachments dashlet allows users to relate an existing note as well as
a new note record to the module record. To create a new note, click the Plus icon
on the upper right of the Notes & Attachments dashlet then select "Create Related
Record". Once the Notes record view layout opens, enter the necessary
information then click "Save". For more information on creating notes, please refer
to the Creating Records section of the User Interface documentation. To relate an
existing note, click the Plus icon then select "Link Existing Record". The Search
and Select Notes page will open allowing you to select the note record you wish to
relate to the module record.

To delete the record's relationship to a note record, click the Unlink button to the
right of the attached note post. Please note that this removes the relationship, but
does not delete the record itself.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, close,
and remove the dashlet accordingly. To collapse the dashlet, click the Gear icon
then select the Close option. To open up the dashlet, you can simply click the Gear
icon again then select "Open".

My Activity Stream Dashlet

The My Activity Stream dashlet displays the user's main Activity Stream within a
dashboard, eliminating the need to navigate to the Activity Streams view to
monitor the most recent stream activities. Like other Activity Stream views, the
dashlet supports inline commenting on specific stream activities, but it does not
allow record previews. For more information on Activity Streams, please refer to
the Activity Streams documentation.

Note: Activity Streams are disabled by default. If you cannot access activity
streams, the feature may be enabled via Admin > System Settings. For more
information, refer to the System documentation in the Administration Guide.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, and 
remove the dashlet accordingly. To collapse the dashlet, click the Up arrow to the

                       250 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/Activity_Streams
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#Activity_Streams


 

left of the Gear icon. To open up the dashlet, you can simply click the arrow again.

When added to an Intelligence Pane, the My Activity Stream dashlet will display
stream items in context to the data within the main container of the page. For
example, if you add the dashlet to a dashboard on the main Accounts module page,
the main container of the page contains the Accounts list view. Therefore, the My
Activity Stream dashlet will restrict activity stream items to only those activities
related to the Accounts module. Similarly, if the dashlet is added to the
Opportunity module's Intelligence Pane, the My Activity Stream dashlet will
restrict activity stream items to only those activities related to the Opportunities
module. If the My Activity Stream dashlet is added to any record view's
Intelligence Pane dashboard, the dashlet will restrict activity stream items to only
those activities related to the record displayed in the main container on the page.

To filter the My Activity Stream dashlet, edit the dashlet and click once on the
Filter button. Choose any of the pre-defined Activity Stream filters, such as
"Messages for Post", which will restrict the stream to only items that were posted
by users, and then click "Save". For more information on Activity Stream filters,
please refer to the Activity Streams documentation.
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It is good practice to also rename an edited dashlet accordingly so that it is clear
that this dashlet is displaying a filtered view. To change the dashlet's title, edit the
dashlet, type a new name into the text box that contains the words "My Activity
Stream", and then click "Save". 

To add a comment or reply to the Activity Stream via the My Activity Stream
dashlet, click on the Comment button next to the relevant stream entry, type your
reply, and then press the Reply button. For more information about interacting
with Activity Streams, please refer to the Activity Streams documentation.

Opportunity Metrics Dashlet

The Opportunity Metrics dashlet appears in the intelligence pane of the Accounts
record view. It provides information regarding opportunities related to the account
that are won, lost, and active along with the relevant dollar amounts. The donut
chart within the dashlet shows the breakdown of the opportunities by status and
displays the total count of opportunities related to the current record you are
viewing. The chart is color-coded based on the chart key to represent the won, lost,
and active opportunity status.

Note: The Opportunity Metrics dashlet is not available for Sugar Serve users. For
more information on license types and the functionality available for each, refer to
the User Management documentation.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, and 
remove the dashlet accordingly. To collapse the dashlet, click the Up arrow to the
left of the Gear icon. To open up the dashlet, you can simply click the arrow again.

Note: Dashlet Gear menus, including the Edit, Refresh, and Remove options in the
Opportunity Metrics dashlet, are only available to the containing dashboard's
Assigned To user and system admin users.
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Cases Summary Dashlet

The Cases Summary dashlet also appears in the intelligence pane of the Accounts
record view. It allows users to view status information for cases related to the
specific account record. The case summary is broken up into multiple tabs
(Summary, New, Pending Input, Assigned) and displays a number on each tab to
indicate the relevant count of the open, closed, new, and pending cases. Please
note that the record must have at least one related case in order for data to appear
within the dashlet and the status tabs (Pending Input, New, Assigned) will appear
if there is a related case meeting that particular status.

The dashlet is not available for Sugar Sell users. For more information on license
types and the functionality available for each, refer to the User Management
documentation.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, and 
remove the dashlet accordingly. To collapse the dashlet, click the Up arrow to the
left of the Gear icon. To open up the dashlet, simply click the arrow again.

Note: Dashlet Gear menus, including the Edit, Refresh, and Remove options in the
Case Summary dashlet, are only available to the containing dashboard's Assigned
To user and system admin users.

                       253 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Users#License_Types


 

The Summary tab displays a donut chart that shows the breakdown of open cases
versus closed cases. If you hover over the breakdown it will display the number of
open and closed cases for the record. The Pending Input tab displays a list of all
pending cases related to the current record. The New tab displays a list of all new
cases related to the current record. The Assigned tab displays a list of all open
cases related to the current record. Users can easily view the case details by
clicking the record's subject link under each tab. Please note that you can also
mark a case as a favorite by clicking the star icon to the left of the case subject
under each tab (Pending Input, New, Assigned).

Comment Log Dashlet

The Comment Log dashlet is available to add to Sidecar record views and displays
the contents of the Comment Log field for the current record. It lists the entries in
descending order with the newest at the top. You can also quickly create new
entries by typing in the open text box then clicking the "Add" button. The dashlet
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shows the three most recent entries but you can open the rest of the entries by
clicking "View All". If another user adds an entry while you are viewing the
dashlet, you must refresh the dashlet to see the new entry. For more information
about comment logs including mentioning records and users, refer to the User
Interface documentation.

Note: The Comment Log dashlet is not available for Sugar Professional.

Interactions Dashlet

The Interactions dashlet is available to add to the Accounts, Cases, Leads, and
Opportunities record views and displays the record's related calls, meetings,
emails, and notes with the most recent interactions on top. 

Note: The Interactions dashlet is not available for Sugar Professional.

Each row in the dashlet can be expanded by clicking anywhere within an
interaction's row or clicking the down arrow to the right of the row, which will
display a preview of the record. To collapse the row, simply click on the
interaction's row again or click the up arrow.
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You can also create new interactions by clicking the Plus (+) icon in the dashlet
header and selecting the type of record (e.g. email, call, meeting, note) you wish to
create. A quick-create drawer will open where you can enter the necessary
information to create the new interaction. Please note that the new record's
Related To field will be automatically populated with the name of the current
record you are viewing. Refer to the Calls, Emails, Meetings, and Notes
documentation for more information on creating these records.

Record View Dashlet

The Record View dashlet is available to add to most Sidecar record views and uses
a tabbed view to allow users to see records related to the one they are viewing. If
the current record can only be related to one record of the selected module (i.e.
one-to-one and many-to-one relationships), the tab displays the single related
record's detail view. For relationships to many records of that module (i.e. one-to-
many and many-to-many relationships), a list view is displayed. Users can
configure which of the current record's relationships to display in up to six total
tabs.

Note: The Record View Dashlet is not available for Sugar Professional.

The Record View dashlet is available on all Sidecar modules except the following:
Quotes, Calls, Meetings, Opportunities, Revenue Line Items, Emails, and
Forecasts.

To open a different tab, click the name of the tab across the top. When viewing a
single record tab, the record can be edited directly in the dashlet by clicking an
individual field or clicking the Edit button. Once you are done editing, click the
Save button to preserve your changes.
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To configure the tabs on the dashlet, click the Gear icon in the top right corner and
select "Edit". On the screen that opens, you can change the dashlet's title, and the
Tabs field across the top allows you to specify which tabs you would like displayed.
The first option will start with the word "This" and represents a record view tab of
the record currently in focus. When applying the dashlet to a record view, it is
recommended to remove the "This..." tab so that information is not duplicated on
the screen and a related records tab can be shown first. Click the Tabs field to
select more tabs or click a tab's X icon to remove it. Beneath the Tabs field, a
preview of the dashlet is available. Clicking each tab allows you to view how the
tab will be displayed and, for list view tabs, allows you to configure the tab. You
can specify which columns to display, how many rows to display, and how often the
list view data should be automatically refreshed. Tabs showing a single record
cannot be configured in the dashlet as they are controlled by the module's Record
View Dashlet layout which can be configured by admin users via Studio.

Note: Only the Record View Dashlet layouts for the Accounts, Cases, and
Opportunities modules can be configured in Studio.
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Product Catalog Dashlet

The Product Catalog dashlet allows users to easily access the Product Catalog and
instantly add products from the catalog as line items on opportunities and quotes.
The dashlet appears to the right of the page when creating a new opportunity or
quote, and also in the Opportunities and Quotes record view intelligence pane. For
more information on utilizing the Product Catalog dashlet in these modules, refer
to the Opportunities and Quotes documentation.

You can also access the Product Catalog from other Sidecar modules (e.g. Home,
Accounts) simply by adding the Product Catalog dashlet to the intelligence pane
dashboard. Please note that unlike the Opportunities and Quotes modules, the
Product Catalog dashlet will be read-only when added to other modules (excluding
Accounts). You can search for products using the Search field on the dashlet as
well as view details of the Product Catalog record by clicking the icon to the left of
a product's name. When viewing the details of the record, you can mark the
product as a favorite by clicking the star icon on the upper left of the product
catalog's record view. Once the product is marked as a favorite, it will appear in
the Product Catalog Quick Picks dashlet on opportunities and quotes. When
accessing the Product Catalog dashlet in the Accounts module, you can select a
product from the dashlet to add as a revenue line item to the account's related
opportunity. Simply click the product name in the dashlet then enter appropriate
values in the Revenue Line Items record view form. Once the necessary
information is entered, click "Save", and the revenue line item will appear in the
Revenue Line Items subpanel in the account's record view.

RSS Feed Dashlet
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The RSS Feed dashlet allows you to view external RSS or Blog feeds via the
dashboard on the intelligence pane. When adding the dashlet, you will need to
enter in the desired feed URL (e.g. "https://news.google.com/news/headlines/sectio
n/topic/TECHNOLOGY?ned=us&hl=en&gl=US") in the Feed URL field. You can
also select a value in the "Number of entries to show" field to display the most
recent 5, 10, 15, or 20 entries from the feed and specify an auto-refresh interval
(e.g. Every Hour) if desired. Once the dashlet is added to the intelligence pane, the
applicable feeds will display and you can click the title of each feed to access the
full story on the parent site. If you wish to access the full site where the RSS feeds
originate from, simply click the title (e.g. Technology - Google News) below the
dashlet header.

The Gear icon on the upper right of the dashlet allows you to edit, refresh, and 
remove the dashlet accordingly. To collapse the dashlet, click the Up arrow to the
left of the Gear icon. To open up the dashlet, you can simply click the arrow again.

Sales Pipeline Chart Dashlet

The Sales Pipeline Chart dashlet illustrates the flow of open sales opportunities
through the various sales stages by displaying the total dollar amounts for open
records grouped by sales stage. The top of the sales funnel is the widest point and
represents sales deals that are still in the earliest stage of "Qualification". The
funnel narrows as unqualified prospects fall away and opportunities with higher
win potential approach final sale. 

Note: The Sales Pipeline Chart dashlet is not available for Sugar Serve users. For
more information on license types and the functionality available for each, refer to
the User Management documentation.
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Note: The Sales Pipeline chart assumes that the sales stages are being used as
defined in the out-of-the-box Sales Stage dropdown list. While the dashlet will
display custom Sales Stage field values, the out-of-the-box Closed Won and Closed
Lost field values must be preserved in order for Sugar's Sales Pipeline Chart to
properly identify open vs. closed business. Any custom stages added to the Sales
Stage dropdown by your organization will be displayed at the top of the funnel,
regardless of how the stages are sorted within the dropdown.

You can customize the Sales Pipeline Chart to monitor the overall health of your
personal funnel or the aggregate funnel for you and all of the users that report to
you. After adding this dashlet to the homepage, toggle between "My Pipeline" and
"My Team's Pipeline" using the individual and group icons on the upper right of
the dashlet. "My Pipeline" displays a summary of opportunities or revenue line
items for the current user and "My Team's Pipeline" displays a summary of
opportunities or revenue line items for the current user plus his direct reports as
configured in the "Reports to" field of their user profile.

The pipeline can also be filtered by time periods that have been configured by the
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administrator in the Forecasts module by clicking on the time period dropdown.
The chart will display only records with an expected close date within the specified
date range. Hover over the time periods to see the dates that the time periods
begin and end.

To further customize the dashlet, users can click on individual sales stage labels to
add and remove those stages from the funnel view. In the example pictured below,
only the Proposal/Price Quote and Negotiation/Review sales stages are enabled
and therefore appear in the legend with solid dots. Sales stages that have been
disabled will appear in the legend as empty circles.

For more detailed information on forecasting, please refer to the Forecasts
documentation.
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Saved Reports Chart Dashlet

The Saved Reports Chart dashlet allows you to view pre-defined report charts as
well as charts of your saved reports. When adding a Saved Reports Chart dashlet,
you can select from the pre-defined report charts as well as any custom report
charts to which you have access. Summation-type, summation with details-type,
and matrix-type reports have the chart option available to view as dashlets.

When adding the reports chart dashlet, you will first select your desired report via
the Select a Report option. You can either type the first few characters of the
report's name and select from the type-ahead results or click "Search and Select..."
below the search box to select your desired report from the Search and Select
Reports drawer. Please note that only reports with charts will be available to add
to the dashlet. The Auto Refresh option allows you to choose a time frame (e.g.
Every 30 Minutes) that you wish to have the dashlet query automatically refreshed.

In addition, the following configuration options allow you to define how the chart
will display:

Note: The configuration options available may vary slightly between the report
chart types.

Chart type : Select the type of chart (e.g. Pie Chart, Funnel Chart) to
display.

The chart type initially defaults to the chart type defined in the
originating report.
The available chart types will vary between reports.
For more information on chart types, please refer to the Reports
documentation.

Show total : Enable the checkbox to display the report's total value on the
dashlet.

The total value in the report chart dashlet dynamically updates to
display the total as reflected in the originating report.

Show legend : Enable the checkbox to display the full chart's legend on
the dashlet.
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Show x-axis label : Mark the checkbox to display the chart's x-axis title on
the dashlet.

A title from the originating report will populate automatically, but
you can specify a different title for display in the dashlet by
entering a new value in the open text box.
This option only applies to bar charts and line charts.

Tick display methods : Enable the appropriate options based on how you
wish to display x-axis labels with long texts on the chart dashlet. When all
three options are enabled, Sugar will apply the display methods in order
("Wrap ticks", "Stagger ticks", "Rotate ticks") and display the x-axis labels
based on the best option.

Wrap ticks : Wraps x-axis labels to the next line.
Stagger ticks : Staggers x-axis labels in alternating positions.
Rotate ticks : Rotates x-axis labels diagonally instead of across.
This option only applies to vertical bar charts and line charts.

Show y-axis label : Enable the checkbox to display the chart's y-axis title
on the dashlet.

A title from the originating report will populate automatically, but
you can specify a different title for display in the dashlet by
entering a new value in the open text box.
This option only applies to bar charts and line charts.

Bar chart value placement : Select where the chart values (e.g. End,
Middle) will be positioned for bar-type charts.

The Top option applies to bar grouped-type charts (e.g. Horizontal
Bar Grouped Chart) with an un-stacked data series.

Bar chart display options : Enable the appropriate options based on how
you wish to view data on the chart.

Allow scrolling : Scroll the chart up-and-down or left-to-right on
the dashlet, if applicable. Disabling this option re-sizes the chart to
fit the full dashlet width.

Scrolling will work for charts where the data exceeds the
size of the dashlet width.
This option only applies to bar charts.

Stack data series : Displays a stacked bar for each grouping in the
report chart broken into sub-sections of data. Disabling this option
displays separate bars for each sub-section in the same grouping.

This option only applies to grouped bar charts (e.g. Vertical
Bar Grouped Chart).

Hide empty groups : Hides any empty data groups from the chart,
if applicable.

This option only applies to bar charts.
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Once the dashlet is added, click the Gear icon on the upper right to edit, refresh,
or remove the dashlet as necessary. In addition, you can select the View Report
option to access the originating report's detail view which will open in a new
browser tab. Please note that you will only be able to view a report according to
your team membership, user access type, and assigned roles. The report may also
be edited to update or add information as necessary as long as your ability to edit
reports in Sugar is not restricted by a role. For more information on teams and
roles, please refer to the Team Management and Role Management documentation
in the Administration Guide. If any changes are made to the report, the reports
chart dashlet on your Home page will reflect the changes after saving the report
and refreshing the dashlet.

To collapse the dashlet, simply click the Up arrow to the left of the Gear icon. You
can click the colored circles in the chart legend to toggle whether or not that
segment appears in the chart. Users can also drill through to view a list of records
associated with a particular chart section by clicking on the section. For more
information about drilling through report charts, please refer to the Reports
documentation.
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Note: Dashlet Gear menus, including the View Report option in the Saved Reports
Chart dashlet, are only available to the containing dashboard's Assigned To user
and system admin users.

Module-Specific Dashlets

Certain modules (e.g. Forecasts) in Sugar contain dashlets that are built
specifically for that module. For the Forecasts module, the intelligence pane
displays dashlets that allow users to view key information regarding the various
forecast stages, likely amounts, best amounts, etc. For more information regarding
these forecast-specific dashlets, please refer to the Forecasts documentation.

The Gear icon also appears on the upper right of these dashlets to allow users to 
edit, refresh, and remove the dashlet's accordingly. To collapse the dashlet, click
the Up arrow to the left of the Gear icon and to open up the dashlet, simply click
the arrow again.
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Service Console

Overview

Users with a Sugar Serve license type have access to Service Console, a Home
page dashboard that provides a powerful work environment for customer service
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agents by incorporating SLAs and region-specific business hours, insightful
dashlets, and a cohesive case research and action experience. Its functionality is
broken into two tabs. The Overview tab comes pre-built with nine dashlets focused
on assisting customer service users track and complete their work. The second tab,
named "Cases", presents a prioritized list of the current user's open cases. Clicking
a case's row opens a Case Detail drawer which displays a wealth of information
and provides the tools needed to work the case to completion. Admin Serve users
and the Serve user assigned to the Service Console dashboard have the ability to
configure the various parts of the console. For more information on how to
configure the console, refer to the Console Management documentation.

Out-of-the-box, Service Console is a shared, default Home page dashboard and can
be accessed by clicking the Cube icon's down arrow and selecting "Service
Console" from the menu.

Prerequisites

Sugar Serve Initialization

Service Console makes heavy use of the Case module's Follow Up Date field which
is set according to your organization's SLAs and business hours by the Sugar Serve
SugarBPM template. Several related records must be set up, and an admin must
configure the SugarBPM template in order for follow-up dates to be calculated
correctly. For detailed instructions, refer to the Getting Started With SugarBPM
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for Sugar Serve and Stock SugarBPM - Case Follow-Up Date Management articles.

Console Access

Although Service Console shares some behaviors with standard shared
dashboards, it is also specialized and, therefore, has some key differences:

Visibility : Service Console follows the visibility and availability rules of
other shared dashboards with the additional requirement that users must
have a Sugar Serve license type. By default, Serve Console is shared with
the Global team and set as a default dashboard, meaning it will appear in
the home dashboards list for all users who are members of the Global team
and have a Sugar Serve license type. An admin user may need to alter its
Team field to push Service Console to additional users.

Overview Tab

Service Console's overview tab contains, by default, nine dashlets that aim to assist
customer service professionals to track and organize their work. Admin Serve
users and the Serve user assigned to the Service Console dashboard are able to
edit the tab just like a standard dashboard to add, remove, or modify its dashlets.
For more information on configuring the Overview tab, refer to the Console
Management documentation. The following dashlets appear by default:

My Open Cases by Followup Date
Planned Activities
Active Tasks
My Open Cases by Status
My Recently Viewed Cases
My Cases in the Last Week by Status
Open Cases by User by Status
My Cases Resolved This Month by Week
Status of Open Tasks Assigned by Me
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Cases Tab

Service Console's Cases tab contains a prioritized list view of the current users'
open cases which can be clicked to reveal a Case Detail drawer where the case can
be worked to completion. Its features and functionality are described in the
following sections.

Prioritized List View

The Cases tab of the Service Console displays a prioritized list of open cases
assigned to the current user. By default, this list is ordered by the cases' follow-up
dates, a value set according to your organization's SLAs and business hours by the 
Sugar Serve SugarBPM template, which requires admin configuration prior to use.
Admin Serve users and the Serve user assigned to the Service Console dashboard
have the ability to change the default sort order as well as apply a filter to the list
view. For more information, refer to the Console Management documentation. The
Cases tab itself includes counts of cases grouped according to how soon their
follow-up dates are due. Actions you can take for each case are available in a
dropdown menu to the left of each row. Each row of the prioritized list contains
detailed case information and can be clicked to open a Case Detail drawer in order
to further investigate and work each case to resolution. The list view automatically
refreshes every five minutes to keep its counts, statuses, and follow-up date
information current.

Note: The case counts and list of cases include any case, assigned to the current
user, which is not in a status of "Closed", "Duplicate", or "Rejected". If you have
added other statuses to the dropdown values of the Case module's Status field, the
counts and list will include cases in those custom statuses.

Case Counts

The Cases tab includes counts of all open cases which are assigned to the current
user. The counts are broken into three groups according to follow-up date and
colored red, yellow, or white based on how much time you have until they are due:
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Red : The number of cases assigned to the user with a follow-up date that
has already passed
Yellow : The number of cases assigned to the user with a follow-up date in
the next 24 calendar hours
White : The number of cases assigned to the user with a follow-up date
more than 24 calendar hours in the future

Note: The Follow Up Date field is set according to your organization's SLAs and
business hours by the Sugar Serve SugarBPM template which requires admin
configuration prior to use.

Note: The yellow and white counts use 24 calendar hours and do not take into
account business hours. This means that cases due within the next work day may
not appear in the yellow box. For example, when a business center is closed over
the weekend, on Friday afternoon, a case due Monday morning will be counted in
the white box rather than the yellow box even though it is due within the next
business day.

Row Actions

To the left of each row is a dropdown menu of actions you can take on the row's
case. Click the down arrow to access the following options:

Edit in New Tab : Opens a new tab with the case's record view in edit
mode
Copy Record URL : Copies the URL of the case to your clipboard
Open in New Tab : Opens a new tab with the case's record view
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Case Information

The Cases tab lists cases which are assigned to the current user are listed in order
of their follow-up dates. Clicking anywhere within a case's row opens the Case
Detail drawer within the Service Console. The following information is displayed in
each case's row:

Number : The case's Number field
Priority : The case's Priority field
Status : The case's Status field, stacked beneath its priority and color-
coded as follows:

Green : New
Blue : Assigned
Purple : Pending InputNote: If an admin has modified the Status field's dropdown list to remove

the stock New, Assigned, and Pending Input options, these colors can be
utilized by creating custom options using those exact words as the Item
Name value. Any custom statuses with other Item Name values will be
colored blue.
Time until follow Up : The amount of calendar time until or since the
follow-up date and color-coded as described below, stacked on top of the
case's Follow Up Date field

Red : A follow-up date that has already passed
Yellow : A follow-up date in the next 24 calendar hours
White : A follow-up date more than 24 calendar hours in the futureNote: The yellow and white colors use 24 calendar hours and do not take

into account business hours. This means that cases due within the next
work day may not be marked yellow. For example, when a business center
is closed over the weekend, on Friday afternoon, a case due Monday
morning will be marked white rather than yellow even though it is due
within the next business day.
Follow Up Date : The case's Follow Up Date field, stacked beneath the
amount of time until or since the follow-up date
Note: The Follow Up Date field is set according to your organization's SLAs
and business hours by the Sugar Serve SugarBPM template which requires
admin configuration prior to use.
Subject : The case's Subject field, stacked on top of its description
Description : The case's Description field, stacked beneath its description
Business Center : The case's Business Center field
Account : The case's related account's name, stacked on top of the
account's service level
Account's Service Level : The case's account's service level, stacked
beneath the account's name
Assigned To : The user assigned to the case
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Note: While the case counts within the Cases tab will include all cases related to
the current user, the cases list can display a maximum of 100 rows.

Case Detail Drawer

Clicking a case's row in the Service Console opens a drawer that serves as a single
location to gather information about the case and its related records, review past
interactions and progress, communicate with the customer, and process the case
to its completion. The drawer contains four dashlets geared towards helping with
these actions which are described in the following sections. You can quickly switch
which case's details are displayed by clicking a different row from the list still
displayed in the background. To close the drawer, click the X icon at the top left of
the drawer or press your Escape key. While the prioritized list view refreshed
automatically every five minutes, the Case Detail drawer does not. Switch between
cases or close and reopen the drawer to see refreshed information.

Note: While the dashlets cannot be removed or added to, admin users with a
Sugar Serve license type or a regular Serve user assigned to the dashboard have
the ability to change their configurations. For more information about editing
dashlets, refer to the Dashlets and Dashboards documentation or the
documentation for each of these specific dashlets linked in the sections below.

Case Record Dashlet

                       272 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Console_Management#Configuring_the_Module_Tab_Drawers
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/Dashboards_Dashlets#Editing_Dashlets


 

On the top left of the Case Detail drawer is a Record View dashlet. Out-of-the-box,
it is configured to display the case you are currently viewing as well as additional
tabs containing its related tasks, contacts, and documents. The dashlet, as a whole,
provides a concise replacement for the case's full record view by displaying not
only the case's fields but also making the case's most important subpanel contents
available via additional tabs. The case record can be edited directly in the dashlet
by clicking an individual field or clicking the Edit button. Once you are done
editing, click the Save button to preserve your changes. The related record tabs
display lists of records with a relationship to the current case record. For more
information, refer to the Record View dashlet documentation.

Comment Log Dashlet

The top right of the Case Detail drawer contains the Comment Log dashlet. This
dashlet displays the case's Comment Log field's entries with the most recent entry
on top. You can also quickly create new entries by typing in the open text box then
clicking the "Add" button. For more information about comment logs including
mentioning records and users, refer to the User Interface documentation.

Related Account Record Dashlet

On the bottom left of the Case Detail drawer is another Record View dashlet,
similar to the top left. Out-of-the-box, this dashlet displays the account related to
the current case, providing additional customer information and the ability to edit
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the related account without having to navigate from the case. For more
information, refer to the Record View dashlet documentation.

Case Interactions Dashlet

The bottom right of the Case Detail drawer contains the Case Interactions dashlet.
This dashlet displays the case's related emails, calls, meetings, and notes with the
most recent interactions on top. Each row in the dashlet can be expanded by
clicking anywhere within an interaction's row or clicking the down arrow to the
right of the row, which will display a preview of the record. To collapse the row,
simply click on the interaction's row again or click the up arrow. When previewing
emails, any email attachments can be downloaded by clicking the attachment's
name. You can also quickly create new interactions by clicking the Plus icon in the
dashlet header and selecting the type of record you wish to create. Doing so will
open a quick-create drawer and automatically select the current case in the new
record's Related To field. For more information, refer to the Interactions dashlet
documentation.

Last Modified: 2020-03-03 21:06:05

Renewals Console

Overview
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Users with a Sugar Sell license type have access to Renewals Console, a Home
page dashboard that provides a powerful work environment for your organization's
Sales agents and Customer Success Managers to automate and streamline renewal
management. The Renewals Console makes it easy to manage accounts, quickly
see the status of your current quarter's renewal pipeline, and manage individual
renewal opportunities. 

The Renewals Console is broken into three tabs. The Overview tab comes pre-built
with four dashlets that provide a quick look at your current sales pipeline, top
revenue line items, and your open activities and tasks. Next, the Accounts tab
presents a list of the accounts assigned to the current user with potential renewal
opportunities. Clicking on an account's row opens an Account Detail drawer that
displays subscriptions, relationships, and recent comments and interactions with
the account. Finally, the Opportunities tab shows a visualization of your currently
open opportunities and their relative worst, likely, and best positions compared
with other opportunities in the list. Clicking on an opportunity's row will open the 
Opportunity Detail drawer with more complete details about the opportunity and
its related records and interactions.

Prerequisites

Sugar Sell Initialization

The Renewals Console only works with Sugar instances configured to use the 
Opportunities and Revenue Line Items model. It relies on the use of renewable
services in the Product Catalog and Revenue Line Items modules. An administrator
must configure the products in your product catalog as renewable services or you
must designate the appropriate revenue line items as renewable services at the
line-item level. For more information, refer to the Services and Renewable
Revenue Line Items section of the Opportunities documentation.
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Note: To be identified as "renewable" by Sugar Sell's pipeline automation engine,
the user who closes an opportunity with renewable line items must be a Sugar Sell
user or the pipeline automation will not initiate.

Access and Permissions

Although the Renewals Console shares some behaviors with standard shared
dashboards, it is also specialized and, therefore, has some key differences:

Visibility : Renewals Console follows the visibility and availability rules of
other shared dashboards with the additional requirement that users must
have a Sugar Sell license type. By default, the Renewals Console dashboard
is shared with the Global team and set as a default dashboard, meaning it
will appear in the home dashboards list for all users who are members of
the Global team and have a Sugar Sell license type. An admin user may
need to alter its Team field to push the Renewals Console to additional
users.
Editability : The dashlets on Renewals Console can only be modified,
configured, or rearranged by an administrator user with a Sell license type.
For more information, refer to the Console Management documentation.
Duplication : Renewals Console cannot be duplicated.
Deletion : Renewals Console cannot be deleted.

By default, the Renewals Console is a shared, default Home page dashboard and
can be accessed by clicking the Cube icon's down arrow and selecting "Renewals
Console" from the menu.
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Overview Tab

By default, the Renewals Console's overview tab contains four dashlets. Admin Sell
users can configure this tab's contents to add, remove, or modify its dashlets as
explained in the Console Management documentation.

The following dashlets appear by default:

Planned Activities
Active Tasks
Pipeline
Top 10 Sales Revenue Line Items

Accounts Tab

By default, the Renewals Console's Accounts tab displays the accounts assigned to
the current user and sorted by the date of the next renewal unless the
administrator has re-configured these options for the view. Each account in the list
can be clicked to reveal an Account Detail drawer with additional information
about its subscriptions and related records and activities. The features and
functionality for the components in the Accounts tab are described in the following
sections.
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Note: Admin Sell users and the Sell user assigned to the Renewals Console
dashboard have the ability to set a default sort order as well as apply a filter to the
list view. For more information, refer to the Console Management documentation.

Account Row Actions

To the left of each account's name is an Actions menu that provides quick access to
view, edit, or share the account record for that row. Click the down arrow to
access the following options:

Edit in New Tab : Opens a new browser tab with the account's record
view in edit mode
Copy Record URL : Copies the URL of the account to your clipboard for
easy sharing
Open in New Tab : Opens a new browser tab with the account's record
view

Account Information

Each account row displays select account details and you can click on an account's
row to view even more information in the Account Detail drawer. The following
information is displayed in the list view for each account in the Renewals Console:
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Account Name/Industry : The name of the account stacked above the
account's industry.
Description : The account's Description field value.
Date of Next Renewal : The expected close date for the next service that
is up for renewal on opportunities related to the account.
Annual Revenue : The account's Annual Revenue field value.
Service Level : The account's Annual Revenue field value.
Account Type : The account's Account Type field value.

For more information on account fields, please refer to the Accounts
documentation.

Note: While the counts within the Accounts tab will tally all accounts related to
the current user, the Renewals Console can display a maximum of 100 rows.

Account Detail Drawer

Clicking an account's row in the Renewals Console opens a drawer that aggregates
information about the account, its related records, past interactions, and active
subscriptions. The drawer contains four dashlets, the Account Record Dashlet,
Comment Log Dashlet, Active Subscriptions Dashlet, and Account Interactions
Dashlet, which are described in the following sections. You can quickly switch
which account's details are displayed by clicking a different row from the list still
displayed in the background. To close the drawer, click the X icon at the top left of
the drawer or press your Escape (esc) key. While the prioritized list view is
refreshed automatically every five minutes, the Account Detail drawer does not.
Switch between accounts or close and reopen the drawer to see the latest
information.

Note: An admin user with a Sugar Sell license type and the user assigned to the
Account Details dashboard may edit the layout and configuration of dashlets in the
Account Detail drawer for all users. For more information, refer to the Console
Management documentation.
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Account Record Dashlet

The primary dashlet in the Accounts tab is a Record View dashlet, which appears
in the first quadrant of the Account Detail drawer by default. It is configured to
display the account you are currently viewing as well as additional tabs containing
related records. The dashlet is a concise alternative to the account's full record
view, as it displays not only the account's fields but also the account's most
important subpanel contents via additional tabs. The account record can be edited
directly in the dashlet by clicking an individual field or clicking the Edit button.
Once you are done editing, click the Save button to preserve your changes. The
related record tabs display lists of records with a relationship to the current
account record. For more information, refer to the Record View dashlet
documentation.

Comment Log Dashlet

The Account Detail drawer also contains a Comment Log dashlet. This dashlet
displays entries from the account's Comment Log field with the most recent entry
on top. You can quickly create new entries by typing in the open text box and then
clicking "Add". For more information about comment logs including mentioning
records and users, refer to the User Interface documentation.

Active Subscriptions Dashlet
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The Active Subscriptions dashlet shows a list of all of the current account's
revenue line items that are in a "Closed Won" status, marked "Service", and have a
start date in the past and an end date in the future. The dashlet shows each
revenue line item's name, quantity of units, and calculated revenue line item
amount next to "Total". A simple bar chart visualizes the time elapsed and time
remaining for the subscription, which you can explicitly view by hovering your
mouse over the bar.

Account Interactions Dashlet

The Account Interactions dashlet displays the account's related emails, calls,
meetings, and notes with the most recent interactions on top. Each row in the
dashlet can be expanded by clicking anywhere within an interaction's row or
clicking the down arrow on the row, which will display a preview of the record. To
collapse the row, simply click on the interaction's row again. When previewing
emails, any email attachments can be downloaded by clicking the attachment's
name. You can also quickly create new interactions by clicking the Plus icon in the
dashlet header and selecting the type of record you wish to create. Doing so will
open a quick-create drawer and automatically select the current account in the
new record's Related To field. For more information, refer to the Interactions
dashlet documentation.
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Opportunities Tab

By default, the Renewals Console's Opportunities tab displays the open
opportunities that are assigned to the current user and sorted by the expected
close date with overdue opportunities shown in the topmost positions, unless the
administrator has re-configured these options for the view. Each opportunity in the
list can be clicked to reveal an Opportunity Detail drawer with additional
information about its related records and activities. The features and functionality
for the components in the Opportunities tab are described in the following
sections.

Note: Admin Sell users and the Sell user assigned to the Renewals Console
dashboard have the ability to set a default sort order as well as apply a filter to the
list view. For more information, refer to the Console Management documentation.

Opportunity Row Actions

To the left of each opportunity's name is an Actions menu that provides quick
access to view, edit, or share the opportunity record for that row. Click the down
arrow to access the following options:

Edit in New Tab : Opens a new browser tab with the opportunity's record
view in edit mode
Copy Record URL : Copies the URL of the opportunity record to your
clipboard for easy sharing
Open in New Tab : Opens a new browser tab with the opportunity's
record view

Opportunity Information
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Each opportunity row displays select opportunity details and you can click on a
row to view even more information in the Opportunity Detail drawer. The following
information is displayed in the list view for each opportunity in the Renewals
Console:

 Stage/Status : "Stage" shows the latest sales stage of all of the open
revenue line items related to the opportunity. The stage is stacked over the
opportunity's status.
Name/Account Name : The name of the opportunity stacked over the
name of the opportunity's account.
Expected Close Date : The latest expected close date for all of the
opportunity's related line items.
Worst | Likely | Best : A visual representation of the worst, likely, and
best values for the opportunity in context with the rest of your pipeline. For
more information, refer to the Worst | Likely | Best Column section of this
page.
Lead Source : The opportunity's Lead Source field value.
Next Step : The opportunity's Next Step field value.

For more information on opportunity fields, please refer to the Opportunities
documentation. For more information on revenue line item fields, please refer to
the Revenue Line Items documentation.

Note: While the counts within the Opportunities tab will tally all filtered
opportunities related to the current user, the Renewals Console can display a
maximum of 100 rows.

Worst | Likely | Best Column

A column within the Opportunities tab labeled "Worst | Likely | Best" presents a
visual representation of your opportunities' values relative to each other. The
leftmost hash mark represents the relative position of the lowest "Worst" value for
all of the opportunities returned in the Renewals Console list view. The rightmost
hash mark is the relative position of the highest "Best" value for all of the
opportunities. The thick, gray horizontal bar between the hash marks represents
the worst-to-best values within the overall range for the current opportunity, with
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a black hash mark to indicate the relative position of the likely value for the
current opportunity. This visualization allows you to evaluate the potential value of
the opportunity relative to the rest of your pipeline. To explicitly view the Best,
Likely, and Worst values for an opportunity, simply hover your mouse over the
gray bar.

Opportunity Detail Drawer

Clicking an opportunity's row in the Renewals Console opens a drawer that
aggregates information about the opportunity, its related records, and past
interactions. The drawer contains four dashlets, the Opportunity Record Dashlet, 
Related Account Record Dashlet, Comment Log Dashlet, and Opportunity
Interactions Dashlet, which are described in the following sections. You can
quickly switch which opportunity's details are displayed by clicking a different row
from the list still displayed in the background. To close the drawer, click the X icon
at the top left of the drawer or press your Escape (esc) key. While the prioritized
list view is refreshed automatically every five minutes, the Opportunity Detail
drawer does not. Switch between opportunities or close and reopen the drawer to
see the latest information.

Note: An admin user with a Sugar Sell license type and the user assigned to the
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Opportunity Details dashboard may edit the layout and configuration of dashlets in
the Opportunity Detail drawer for all users. For more information, refer to the 
Console Management documentation.

Opportunity Record Dashlet

The primary dashlet in the Opportunities tab is a Record View dashlet, which
appears in the first quadrant of the Opportunity Detail drawer by default. It is
configured to display the account you are currently viewing as well as additional
tabs containing related records. The dashlet is a concise alternative to the
opportunity's full record view, as it displays not only the opportunity's fields but
also the opportunity's most important subpanel contents via additional tabs. The
opportunity record can be edited directly in the dashlet by clicking an individual
field or clicking the Edit button. Once you are done editing, click the Save button
to preserve your changes. The related record tabs display lists of records with a
relationship to the current opportunity record. For more information, refer to the 
Record View dashlet documentation.

Related Account Record Dashlet

Another, Record View dashlet, the Related Account Record dashlet, is available in
the Opportunity Detail drawer. This dashlet displays the account related to the
current opportunity, providing valuable service level and business center
information as well as the ability to edit the related account without having to
navigate away from the Renewals Console. For more information, refer to the 
Record View dashlet documentation.
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Comment Log Dashlet

The Opportunity Detail drawer also contains a Comment Log dashlet. This dashlet
displays entries from the opportunity's Comment Log field with the most recent
entry on top. You can quickly create new entries by typing in the open text box and
then clicking "Add". For more information about comment logs including
mentioning records and users, refer to the User Interface documentation.

Opportunity Interactions Dashlet

The Opportunity Interactions dashlet displays the opportunity's related emails,
calls, meetings, and notes with the most recent interactions on top. Each row in
the dashlet can be expanded by clicking anywhere within an interaction's row or
clicking the down arrow on the row, which will display a preview of the record. To
collapse the row, simply click on the interaction's row again. When previewing
emails, any email attachments can be downloaded by clicking the attachment's
name. You can also quickly create new interactions by clicking the Plus icon in the
dashlet header and selecting the type of record you wish to create. Doing so will
open a quick-create drawer and automatically select the current opportunity in the
new record's Related To field. For more information, refer to the Interactions
dashlet documentation.
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Search

Overview

Sugar comes with the ability to search across the entire system to easily locate and
filter records in the system. Users can perform a search via the module's list view,
record view, as well as global search. The module search allows you to locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the module list view or
subpanel view of the record. Global search allows users to search for information
across their entire Sugar database as opposed to restricting search within a
specific module. This documentation will go over the basics of the various search
options and cover how to perform a search, filter a search, view results, etc.

Sweet Spot Search

The Sweet Spot feature allows you to quickly and conveniently search Sugar from
anywhere within the application. Using the Sweet Spot feature, you can find and
navigate to:

The Home page Actions menu
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A module (e.g. Accounts, Bugs)
Common actions in the modules' Actions menus (e.g. Create Account, View
Account Reports)
A specific record
The user menu

You will only be able to see actions and records as allowed by your team
membership, user access type, and assigned roles. If you are an administrator, you
can also find and navigate to many of the sections on Sugar's Admin page.

To open Sweet Spot, use the appropriate shortcut key sequence for your operating
system:

OS Shortcut
Mac OS X shift+cmd+space
Windows shift+ctrl+space
Linux shift+ctrl+space

Once the Sweet Spot opens, begin typing your query and the search results will
update as you type.
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You can configure Sweet Spot by clicking the gear icon in the top right corner or
by typing "Sweet Spot Configuration Panel" into Sweet Spot to open the Sweet
Spot Configuration Panel drawer.

In the Sweet Spot Configuration Panel, you can configure shortcuts in the form of
hotkeys. These hotkeys allow you to access your commonly accessed actions even
more quickly. For example, if you frequently search for the Process Business Rules
module, you can configure a hotkey so that when you type a keyword, such as
"PBR", the Process Business Rules module is found. To configure a hotkey, choose
the desired Sweet Spot Action from the dropdown menu, then provide the keyword
that will act as the shortcut. Note that a keyword can contain multiple words. To
add multiple hotkeys, click the plus button at the end of the row. To remove a
hotkey configuration, click the minus button at the end of the row you wish to
remove.

In the Theme dropdown menu on the right side of the Sweet Spot Configuration
Panel, you can select whether you want to use the Default (i.e. system settings),
Light, or Dark theme.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting searches to a specific module. The Global
Search bar displays on the upper right of every Sugar page and utilizes Full-Text
Search to search throughout nearly all fields and modules for an enhanced search
experience. For more information on performing searches within a single module,
please refer to the List View Search and Record View Search section.

By default, Sugar comes out-of-the-box with a defined list of fields for each module
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that users can search as well as view in the search results on the View All Results
page. Please note that secondary fields (e.g. email address, office phone, start
date) will display in the View All Results page only if they contain a value. In
addition, if there is a match found in a searchable field, it will display on the View
All Results page even though it is not defined as a displayed field for the module.
For example, if you enter a search (e.g. John) and the system finds a match in the
case's Description field, but the Description field is not configured in the record
view layout for cases, the case record will appear on the View All Results page
along with the description as the secondary field because it contains the search
term.

Note: All email addresses (e.g. primary, secondary) in the record are included in
the search. Primary email addresses have a higher relevance compared to the
other email addresses for search results.

Module Searchable Fields Fields Displayed on
View All Results Page

Accounts Name, Email Address,
Billing Street, Shipping
Street, Office Phone, Fax,
Alternate Phone,
Description, DUNS, SIC
Code

Name, Primary Email
Address, Office Phone

Bugs Subject, Bug Number,
Description, Work Log

Subject, Bug Number,
Status

Calls Subject, Description Subject, Start Date, End
Date, Status

Campaigns Name, Objective,
Description

Name, Type

Cases Subject, Description, Case
Number, Resolution, Work
Log

Subject, Case Number

Contacts First Name, Last Name,
Home Phone, Office
Phone, Mobile Phone,
Other Phone, Fax, Primary
Address Street, Alternate
Address Street, Portal
Name, Description, Email
Address

Name, Primary Email
Address

Contracts Contract Name,
Description, Reference
Code

Contract Name, Status
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Custom Basic Type Name, Description Name
Custom Company Type Name, Office Phone,

Alternate Phone, Fax,
Email Address, Billing
Street, Shipping Street,
Description

Name, Primary Email
Address, Office Phone

Custom File Type Document Name,
Description

Document Name

Custom Issue Type Subject, Number,
Description, Work Log

Subject, Status

Custom Person Type First Name, Last Name,
Home Phone, Mobile
Phone, Office Phone,
Other Phone, Fax, Primary
Address Street, Alternate
Address Street,
Description, Email
Address

Name, Office Phone,
Primary Email Address

Custom Sale Type Name, Description, Next
Step

Name, Expected Close
Date

Documents Document Name,
Description

Document Name

Emails Subject, Date, From Subject, Date, From
Employees First Name, Last Name,

Email Address
Knowledge Base Name, Body, Description Name
Leads First Name, Last Name,

Email Address, Home
Phone, Mobile Phone,
Office Phone, Other
Phone, Fax, Primary
Address Street, Alternate
Address Street,
Description

Name, Primary Email
Address, Office Phone

Manufacturers Name Name
Meetings Subject, Description,

Location
Subject, Start Date, End
Date, Status

Notes Subject, Description Subject
Opportunities Opportunity Name,

Description, Next Step
Opportunity Name,
Expected Close Date
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Product Categories Name, Description Name
Projects Name, Description Name, Status, Priority
Project Tasks Name, Description Name, Status
Quoted Line Items Name, Mft Part Number Name, Status
Quotes Quote Subject,

Description, Purchase
Order Number, Quote
Number, Billing Address
Street, Shipping Address
Street

Quote Subject, Quote
Number, Quote Stage

Revenue Line Items Name, Description, Next
Step

Name, Expected Close
Date

Target First Name, Last Name,
Email Address,
Description, Primary
Address Street, Alternate
Address Street

Name, Primary Email
Address

Target Lists Name, Description Name
Tasks Subject, Description Subject, Status, Due Date

Please note that not all fields in Sugar are enabled by default for search, but can
be enabled by an administrator. Administrators can control additional elements of
global search via Admin > Search and Admin > Studio. If the administrator
globally disables a module for search, you will not be able to perform a search on
that module or filter by that module when searching. For more information on how
to enable and disable certain fields and modules in Global Search, please refer to
the Studio documentation as well as the Search section of the System
documentation in the Administration Guide.

To use global search, you need to first enter a keyword into the search box and the
pop-up results will begin appearing once you enter at least one character. Please
note that clicking on the search bar will expand it across Sugar's navigation bar,
which spans across the top of the screen. To minimize the search bar, simply click
anywhere outside of the search bar or hit the Esc key on your keyboard.

Note: Elastic search strips out the non-numeric characters ("-", "()") from phone
numbers so you can just enter the digits (e.g. 4082269800) when searching.

Once expanded, you will be able to access the Module dropdown by clicking the
down arrow on the far left of the search box. This allows you to configure some
aspects of global search such as what module(s) (e.g. Accounts, Contacts) to filter
your search results by in Sugar. If you wish to clear your search term, simply click
the X icon to the far right of the search box. Please note that this will collapse the
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search bar as well.

By default, up to five search results will display below the search box and include
the primary field (e.g. name, subject) for the records matching your search term.
The specific term (e.g. abc) in the record's field is bolded to indicate the match to
the search term. In addition, if any secondary fields (e.g. office phone, description)
match the search term as well, it will display beneath the record's primary field in
the Quick Search Results list, with the matching term bolded. For any email
addresses that include the matching search term, the entire email address (e.g.
support@abc.com) will be bolded instead. Please note that the Quick Search
Results list will display up to three matching fields for the record. To view all
matching results, simply hit the Enter key while focused on the search bar or click
the View all results link at the bottom of the Quick Search results list and you will
be navigated to the View All Results page. Click the appropriate record (e.g. ABC
Family Associates) in the Quick Search Results list to access the record's details.
Please note that users assigned a role restricting view access to a module (e.g.
Cases), will not be able to view search results specific to that module.

You can also perform tag searches using Global Search to easily locate groups of
records that are tagged by common attributes. For more information regarding
tagging records, please refer to the Tags documentation. For example, if you have
a set of leads that were acquired from a specific conference and you wish to locate
all the lead records tagged with this value, you can perform a search using the tag
value. As you search, the list of matching tags will appear in the tag ribbon
beneath the search box and display up to five tags matching the search term.
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Simply select the appropriate tag (e.g. 2018 Western Conference) from the tag
ribbon and the tag pill will get entered into the search box. If you wish to remove
any selected tag pills from the search box, simply click the "x" to the right of the
tag name. All matching records tagged with "2018 Western Conference" will
display beneath the search box.

You can append additional search terms or tags in the search box if you wish to
further narrow your search. Simply enter the keyword (e.g. Jeanette) to the right of
the existing search term and the matching result(s) will display. If you search
using multiple tags, the system will look for records that match any one of the tags
in the search box using the "or" operator.

Please note that clicking the tag pill in the module's record view or the record's
preview in the intelligence pane will navigate you to the View All Results page
which will display the list of records that contain the same tag. When viewing the
module's list view, dashlet list view, or subpanel list view, you can click the tag link
to be navigated to the View All Results page.

Note: You cannot click the tag pill when editing the record to access the View All
Results page.

Operators

When performing a search via global search, you can use operators such as "AND",
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"OR", and "NOT" in your search query to further narrow the search results. Please
note that there must be at least three characters entered for each search term, and
the operators must be entered in all caps (e.g. AND, OR, NOT) otherwise Sugar
will consider it as a keyword to search on.

Note: Quotation marks cannot be used in multiple word searches (e.g. "John
Smith") to return exact matches. So entering John Smith in your search query will
return: John Moore with a street address of "123 Smith Dr.", Smith Company
with a description of "Primary point of contact is John Lee", etc.

Operator  Description Example
"AND" Use this operator to

specify search criteria
where all keywords must
match for records to be
included in the search
result.

John AND Texas : Search
returns records (e.g.
contacts) that include
"John" and "Texas" in the
searchable fields (e.g.
Name, Primary Address
City).

"OR" Use this operator to
specify search criteria
where at least one
keyword must match for
records to be included as
a search result.

95111 OR 95113 :
Search returns records
(e.g. accounts) that
include the digits "95111"
or "95113" in the
searchable fields (e.g.
Billing Postal Code).

"NOT" Use this operator if you
wish to exclude records
containing a specific
keyword in the search
query.

John NOT Texas : Search
excludes records (e.g.
contacts) that include the
term "Texas" in the
searchable fields (e.g.
Billing State) then
evaluates the remaining
query to return records
including "John".

The "AND" operator is implicitly added when there is a space between the search
strings. For example, if you enter "John Smith AND California" into the search box,
Sugar will look for records that include the term "John", "Smith", and "California"
in the searchable fields (e.g. Name, Billing State). If there are records that match
the search terms in the query, the record will display in the Quick Search Results
list. The term(s) (e.g. Smith) in the record's fields will be bolded in the search
result to indicate the match to the search term.
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When entering your search criteria, you can also use a combination of the
operators. Use parentheses if you wish to group a part of your search query. When
using the parentheses to create subqueries, Sugar will first parse the subquery
contained in the parentheses before evaluating the remaining query. For example,
if you enter: "(Johnson OR Jonson) AND Systems", Sugar will return records
including "Systems" with "Johnson" as well as "Systems" with "Jonson" in the
searchable fields (e.g. Name: Johnson Systems, Name: Jonson with Website:
www.jonsonsystems.com).

Note: When using the NOT operator, please keep in mind that it cannot be used in
direct combination with parentheses (e.g. NOT (John Smith)).

The following are example search queries using the available operators in global
search: 

Search Criteria Matching Search Results
Jane AND @example.com Jane Roberts

Email: jroberts@example.com
ABC Company

Primary Address Street: 123 Jane St.

Email: support@example.com
J Thomas

Email: jane@example.com
(NOT John OR NOT Jane) Smith Bob Smith

Email: bob.smith@example.com
Mary Smith

Email: marys@smithcompany.com
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(ABC Technologies) OR (ABC
Corporation) Brooklyn

ABC Inc.

Billing Street: 123 Technologies Dr.

Billing City: Brooklyn
ABC Corporation

Billing City: Brooklyn
Bob AND (Smith OR Jones) AND Idaho
NOT Boise

Bob Smith Company

Billing State: Idaho

Billing City: Nampa
Bobby Lee Jones

Primary Address State: Idaho

Primary Address City: Meridian
 (Jenn OR Jennifer) Martin AND Texas JenniferMartinez 

Email: jmartinez@abc.com

Primary Address State: Texas
JennMoore

Email: jmartin@example.com

Primary Address Street:123 Texas Dr. 

Viewing All Results

If there are more than five matching results, you can click on "View all results" at
the bottom of the Quick Search Results list to view all matching records. The View
All Results page loads an initial number of records meeting the current search
criteria with the option to show additional results at the user's request. The total
number of matching search results will display on the upper left of the page. By
default, Sugar displays 20 records for each search results set on the View All
Results page, but Administrators can change the number of records displayed via
Admin > System Settings. For more information on changing the number of
displayed records, please refer to the System documentation in the Administration
Guide. To load the next set of Global Search results, simply click on "More search
results" at the bottom of the View All Results page.
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If you wish to view the full details of a record, click the record's name to open the
record view (or detail view for Legacy modules). You can also view a record's
details directly from the View All Results page by clicking the Preview icon to the
far right of a record's row. Please note that preview is only available for modules
(e.g. Contacts, Leads) using the Sidecar user interface. The record's details will
display in the intelligence pane to the right of the View All Results page and will
provide users with key information regarding the record as well as any related
activity stream information. For more information on previewing via the
intelligence pane, please refer to the Dashboards & Dashlets documentation.

Filtering the View All Results Page

When not in preview mode, the intelligence pane to the right of the search results
displays various Filter options (e.g. Assigned to Me, Created by Me) that allow you
to further narrow the search results on the View All Results page. Please note that
the filters only apply to the set of search results based on your current search
query.

Each of the filter options displays a number in parentheses to indicate the number
of records from the View All Results page that meet the criteria. Any filter option
(e.g. My Favorites) that displays a zero count will not be clickable as there are no
records that meet the criteria. As you select filter options, the search results on the
page will dynamically change to only display records meeting the currently applied
filter(s). In addition, the counts for all of the filter options will dynamically change
to indicate the total count of records that meet the currently selected filter(s). For
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example, if you select "Leads" under the Modules filter, the counts next to each of
the other filter options (e.g. Created By Me, Modified by Me) will change according
to the number of results which are both a lead and match the particular filter (e.g.
Created By Me).

Selecting multiple filter options within a single filter (e.g. Modules) will use an "or"
operator. So if you select "Leads" and "Contacts" from the Modules filter, the View
All Results page will display both lead and contact records. However, if you select
filter options from different filters, it will use an "and" operator. For example, if
you select "Leads" from the Modules filter and select "Created by Me", Sugar will
only return lead records that you created.

To clear individual filters, click the filter again (e.g. Created by Me) to unselect the
option. If you wish to clear all filters applied on the View All Results page, simply
click the Reset button on the upper right of the intelligence pane.

To collapse a multi-option filter (e.g. Modules), you can click the Up arrow on the
upper right of the filter. If you wish to collapse all multi-option filters (e.g.
Modules) on the intelligence pane, click the Actions menu to the right of the Reset
button and select "Close All". To expand them, simply click the Actions menu again
and select "Open All".

Filtering by Module
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Global Search gives you the option to filter the search results by module by
clicking the down arrow to the far left of the expanded search bar. Please note that
the Search all option is selected by default to include all modules when searching.
The list of available modules to select will appear in the Modules list and you can
simply select the appropriate module(s) you wish to include in your search. For
example, if you select the Contacts module then enter "john" in the search box,
Sugar will only return matching contact records.

When three or fewer modules are selected from the Modules dropdown, the
corresponding Module icons will display in the search bar.

However, if more than three modules are selected, it will display the Multiple
Modules icon in the search bar.

Note: The selected module(s) will remain in the search bar until the user's
browser cache is cleared.

If you wish to unselect all modules at once, simply select the Search all option from
the Modules dropdown. Please note that manually deselecting all modules will
default back to the Search all option as well.

Administrators can configure what modules are available to select in the Modules
list via Admin > Search. For more information on configuring which modules are
available to search via Global Search, please refer to the Search section of the
System documentation in the Administration Guide. Please note that only modules
you have view access for will appear in the Modules list for Global Search.

Keyboard Navigation

Using the Tab key (Alt+Tab for Safari browser) on your keyboard enables you to
easily navigate through Sugar's navigation bar which spans across the top of the
screen. You will be able to use the Tab key to access the Global Search bar and
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perform a search. For more information on navigating around Sugar using your
keyboard, please refer to the Accessibility documentation. Once you have tabbed
into the Global Search field, enter at least one character to expand the global
search bar. Please note that hitting the Enter key while in the search box will
navigate you to the View All Results page where you can also perform a search. If
you hit the Tab key within the search bar without entering in a search term, the
Magnifying Glass icon will be highlighted and you can hit "Enter" to be navigated
to the View All Results page as well.

Note: You can use global shortcut keys to access and exit the Global Search field
as well. For more information regarding global shortcut keys, please refer to the 
Accessibility documentation.

Once you enter a search term, you can use the Up and Down arrow keys on your
keyboard to navigate through the Quick Search Results list and hit "Enter" while
focused on a specific quick search result (e.g. Jane Smith) to open up the module's
record view (for Sidecar modules) or detail view (for Legacy modules). Please note
that hitting the Tab key while navigating through the quick search results will
close the Quick Search Results list and highlight the X icon in the Search bar,
which will allow you to clear your keyword and perform a new search. Please note
that the Global Search bar will collapse as well when clicking the X icon to clear
search. Hitting the "Shift" and "Tab" key will close the Quick Search Results list
and highlight the search term in the search bar, allowing you to perform additional
searches.

In addition, you can easily navigate through the Modules dropdown list using the
Up and Down arrow keys on your keyboard and hitting the Spacebar key to select
or unselect a module. Hitting the Tab key while navigating through the Modules
dropdown list will close the dropdown and take you back to the search bar. If you
wish to clear the text entered in the search box, you can either click the X icon or
hit the Tab key while in the search box to highlight the X icon, then hit "Enter" or
the Spacebar key.

To navigate through the tag ribbon, you can use either the Tab key or Arrow keys
on your keyboard. To add a tag pill to the search bar, simply hit the Enter key
while focused on the tag pill (e.g. 2018 Latin America Conference) in the tag
ribbon. Hitting the Enter key again on the newly added tag pill in the search bar
will open up the View All Results page to display all matching results.

€

In addition, you can tab through the View All Results page to highlight and access
certain elements (e.g. Search box, Intelligence Pane, Preview button) of the page.
For example, if you press "Enter" while focused on the Preview button, the
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record's data will display to the right of the search result providing key
information regarding the record.

Admin Configuration

Sugar administrators have the ability to globally enable and disable modules for
Global Search. Please note that disabled modules will not be included in search
results nor in the list of modules to filter. For more information on how to enable
and disable modules for Global Search, please refer to the Search section of the
System documentation in the Administration Guide.

Administrators also have the ability to enable and disable specific fields for Global
Search, as well as set the priority for searchable fields using boost values. To
configure fields for search, simply navigate to Admin > Studio and update the Full-
Text Searchable option to either "Searchable" or "Disabled" depending on whether
you want it included for search or not. The Full-Text Searchable option is only
available for the following data type fields: Phone, TextArea, TextField, and URL.
Boosting is the process of enhancing the relevancy of a record's fields for global
search. Fields with a higher boost level will be given greater weight when the
search is performed. When a search is performed, matching records containing
fields with a greater weight will appear higher in the search results. The default
boost value is 1.0 which stands for a neutral boost. To apply a positive boost, set
the boost value higher than 1. To apply a negative boost, use values lower than 1.
For example, a value of 1.35 will positively boost a field by 135%. But using a value
of 0.60 will apply a negative boost. Please note that it is not necessary to perform a
full system index when boost values are changed for fields. For more information
on how to enable or disable fields for Global Search or change the boost values,
please refer to the Studio documentation in the Administration Guide.

Global Search functions off of an index created from the data in your system. When
creating and updating records, data is added and modified in the index
accordingly. Occasionally the index can become corrupt or inefficient, which may
require a system index to be performed. You can perform a system index manually
via Admin > Search. For more information on how to run a system index on Full-
Text Search, please refer to the System documentation in the Administration
Guide.

Advanced Options

The Advanced Options panel is available on the view all results screen of Global
Search to allow users to enable and disable modules for the Filter by list specific to
their login. Please note that administrators have the ability to globally enable and
disable modules for global search via Admin > Search. If the administrator globally
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disables a module, you will not be able to perform a search on that module or filter
by that module when searching. The module will also no longer appear within the
Advanced Options panel. For more information on how to globally enable and
disable modules, please refer to the System documentation in the Administration
Guide.

List View Search (Sidecar Modules)

List view search enables users to easily and effectively search by a record name in
a module-specific manner to pull up relevant results they wish to view. The
matching records will populate in the list view below the Search bar. Please note
that the system retrieves all records that start with the keyword entered in the
search. When looking up names, Sugar performs an OR search for each name
entered. Records matching any of the names entered will appear in the list view.
Sugar's list view search also supports wildcard characters (e.g. %) to search for
records without including the entire word in the search query. For example, a
search for "%univ" will pull up any records containing "univ", including "The
University of Miami", "Miami University" or "Universidad de Miami". For more
information on how to use wildcards in list view searches, please refer to the 
Wildcards section.

In addition, the search provides a Filter option which can be used in combination
with the open Search box to narrow your search further using the available options
on the list. For more information on the available filter options, please refer to the 
Filter section.

When you choose a filter and run a search, Sugar will return records with a
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matching name from within the filtered list view results. For example, if you select
"My Accounts" in the Filter list and enter an account name, Sugar will only return
account records with a matching name that are assigned to you. You can also
create new filters if you wish to add more complex filters for your search criteria.
For more information on creating new filters, please refer to the Creating a Filter
section. When you run a search using a saved or created filter, the search will be
preserved when you navigate away from the module. Returning to the list view will
automatically display the results of your last filter. Please note that searches using
the open Search box only are not preserved when navigating away.

To see all records to which you have access, simply select the All "Module Name"
(e.g. All Accounts) option in the filter. Please note that you will only be able to see
records as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. You may use any combination of wildcard characters in the Search
box as you desire. The following wildcard characters can be used in the List View
search box:

Character Wildcard Use
% Matches any number of characters,

including zero
_ Matches only one character

Please note that list view search automatically appends the wildcard character (%)
to the end of your search phrase for each text field. This allows the system to pull
up all records that include the keyword entered in the search.

When performing a multiple-word search, Sugar will behave differently based on
the module (e.g. Accounts, Contacts) in which you perform the search. For
example, performing a search for "Max Hold" in the Accounts module will match
an account named "Max Holding Company" but will not match "Maximum Holding
Company" because the wildcard is appended to the end of the entire query (e.g.
Max Hold%). However, if the same search is performed for "Max Hold" in the
Contacts module, it will return search results matching a contact named "Max
Holder" as well as "Maximillian Holder" because it appends a wildcard to the end
of each word in the query (e.g. Max% Hold%). Please note that the latter behavior
applies to any person-type module (e.g. Leads) to account for search results that
may contain multiple words in the First Name and/or Last Name field (e.g. "Jean
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Paul" as a first name).

The following search examples illustrate List View search behavior:

Search Criteria Matching Search Results
First Name Last Name

rob Rob 
Roberta
John

Smith
Collins
Roberts

%bert Bert
Roberta
John

Andernie
Collins
Roberts

r_b Roberta 
Ruby
John

Collins
Lieu
Roberts

%r_b Rob
John
Mirabel

Smith
Roberts
Glaston

__it Rob
Anita

Smith
Nother

r_b% smit% Robert
Rob

Smith
Smite

rob smith Rob
Robert
Rob Roy

Smith
Smith
Smith

smith Rob
Smith

Smith
Johnson

jean Jeannine
Jean Paul

Pugh
Gaultier

paul Sue
Paul

Paulson
Jones

jean paul Jean
Jean Paul

Paul
Gaultier

When performing a search, Sugar will try to match your search text to the
beginning of a record's field. So, if an account name starts with an article like "A"
or "The", this must be accounted for in the search by adding a wildcard (%) at the
beginning of your text. For example, to properly pull up an account named "The
ABC Company", you will have to enter "%abc" for Sugar to find a match in the
system.
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In addition, you can use the wildcard character when specifying the search criteria
for custom filters with the "starts with" operator. Please note that the wildcard
character will only work with the "starts with" operator. For example, if you wish
to find all records containing the word "systems", then you can use the "starts
with" operator and type "%systems" as the filter value. For more information on
creating filters, please refer to the Creating a Filter section.

AND vs OR

When searching in the List View search, Sugar uses the "and" operator. This
means that if you are searching against multiple fields in your filter option, Sugar
will place an "and" in between each search field returning only records matching
all (as opposed to any) of your search criteria. For example, if you select "My
Accounts" in the Filter options and enter an account name, Sugar will only return
account records with a matching name that are assigned to you.

The only time Sugar will use the "or" operator is when using a multi-select option
in the search criteria. For example, you can create a custom filter for the Accounts
list view search and select "Type", "is any of", then add "Analyst", "Customer", and
"Partner". If you perform a search based on this new filter, the system will return
account records that match any one of the values specified in the filter. For more
information on creating custom filters, please refer to the Creating a Filter section.

Please note that if any additional fields (e.g. industry, status) are added to the
custom filter, the operators between the Type field and the other fields will be an
"and" operator.

                       306 / 1.116



 

Filter

List View search provides a Filter option which allows users to narrow their search
further using the available options on the list.

The following options are available to users when filtering their List View search:

Create : Create a new custom filter which you can use to filter your search
All "Module Name" : Returns all records in the module to which you have
access
My "Module Name" : Returns only records assigned to you
My Favorites : Returns only records you have marked as favorites
Recently Created : Returns only records you created in the module within
the last 7 days
Recently Viewed : Returns only records you have viewed in the module
within the last 7 days

When you choose a filter and run a search, Sugar returns records with a matching
name from within the filtered list view results. You can use one of the default filter
options from the list or create a custom filter if you wish to have more complex
filters options when searching.

Note: Only the fields that you have permission to view and that the administrator
has configured to be available will appear in the Filter list when creating a search
filter. For more information on field-level permissions, please refer to the Role
Management documentation in the Administration Guide. For more information on
adding and removing fields to filters in list view, please refer to the Studio
documentation in the Administration Guide.

When you run a search using a filter, the search will be preserved when you
navigate away from the module. Returning to the list view will automatically
display the results of your last filter. In contrast, searches performed using only
the list view's Search box are not preserved when navigating away.

Creating a Filter

Users can create and save new filters via the Create option in the Filter list of the
search bar. Filters may contain one or more fields and operators (e.g. is any of, is,
starts with) along with their desired value(s). All of a filter's criteria must evaluate
as true for a record to appear in the list view search result. Filters may also be
saved as templates with empty field values to be completed at the time the filter is
run. This is useful for searches that must be performed often against the same
fields but with varying values.
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The following steps cover creating a filter for accounts with a type of "Customer",
"Competitor", or "Partner" and assigned to Sara Smith as an example:

1. Click the Filter option on the Accounts search bar then select "Create". 

Note: You can also click "Create" to the right of the Filter option.

2. Select "Type" as the filter field and select the "is any of" operator then add
"Competitor", "Customer", "Partner" as the search values. As you create
the new filter criteria, it will be applied to the list view concurrently to
display the matching results. To remove specific filter values (e.g.
customer, partner), you can simply click the "x" to the right of the field or
you can select "Reset" to the left of the Save button to clear all filter values.
Note: The "is any of" operator allows the system to pull up records that
match any one of the set values (customer, competitor, partner).

3. To add additional fields (e.g. Assigned to) to the new filter, click the Plus
button to the right of the filter.
Note: Only the fields that you have permission to view and that the
administrator has configured to be available will appear in the Filter list
when creating a search filter. For more information on field-level
permissions, please refer to the Role Management documentation in the
Administration Guide. For more information on adding and removing fields
to filters in list view, please refer to the Studio documentation in the
Administration Guide.

4. Select "Assigned to" as the secondary filter field and select the "is any of"
operator then add "Sarah Smith".

5. Enter a descriptive title for the filter (e.g. Sarah's Accounts) in the field
that contains "Enter new filter name…".

6. Click "Save" to add this filter to the module's Filter options.
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You can also create and save a filter without entering any filter values (e.g.
Customer) if you wish to enter new values each time you utilize the filter. When re-
using the filter simply enter the appropriate filter value(s) and the list view will
display the matching results. Once you are done with the filter, click "Reset" to the
far right of the filter's name to clear the filter value(s). 

The custom filter can always be edited as necessary by selecting the filter and
updating the fields, conditions, values, etc. via the filter details panel. Once the
necessary updates have been made, click "Save" to preserve the changes.

Please note that you can easily delete custom filters by selecting the filter (e.g.
Sarah's Accounts) from the Filter list, clicking the filter's name on the Search bar,
then clicking "Delete" on the filter details panel.

Preview

Once the list view displays the search results, users can easily view the record's
details directly from the module's list view by clicking the Preview icon to the far
right of the record's row. The record's detail will display in the intelligence pane to
the right of the list view and provide users with key information regarding the
record as well as the related activity stream information. For more information on
viewing previews, please refer to the Previews section of the User Interface
documentation.
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Record View Search (Sidecar Modules)

Users also have the ability to search for related records which appear in the
subpanels of the record view. The Search bar appears below the record's fields and
you can filter the view to only display a specific module (e.g. Leads, Contacts). You
can search by a record name by entering the keyword into the Search bar, and the
subpanel(s) with the matching record(s) will appear below. Please note that the
system will retrieve records from the subpanel that start with the keyword entered
in the search box. To clear the search, simply click the "x" to the right of the
search keyword and all records meeting the search criteria will display in the
corresponding subpanel(s). When you run a search using a saved or created filter,
the search will be preserved when you navigate away from the page.

To filter, simply click the Related option to the far left of the Search bar and select
the module whose subpanel you wish to view. For more information on how to
filter records for search, please refer to the Filter section. Please note that filter
and search may be combined to only display matching records within the selected
module's subpanel. To see all subpanels to which you have access, simply select
"All" in the Related dropdown list.

Related Records Search

Users can search for related records simply by entering in the name of the record
in the Record View's search box. Please note that the system will only search for
related records which appear in the subpanels of the record view. The relevant
record(s) meeting the search criteria will display in their respective subpanels.
Users have the option to filter the view to only display a specific module if they
wish by selecting the module (e.g. Contacts, Leads) from the Related list. For more
information on searching within a specific module, please refer to the Related
Module section.
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Related Module

When searching for records which appear in the subpanels of the record view, you
can filter the view to only display a specific module (e.g. Leads, Contacts). Simply
click the Related option to the far left of the Search bar then select the module
whose subpanel you wish to view. Please note that you can narrow your search
further using the Filter option to the right of the Related option. For more
information on searching using the Filter option, please refer to the Filter
section.To see all subpanels to which you have access, simply select "All" in the
Related dropdown list.

Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. You may use any combination of wildcard characters in the search
box as you desire.

The following wildcard characters can be used when searching for related module
records in record view:

Character Wildcard Use
% Matches any number of characters,

including zero
_ Matches only one character

Please note that search automatically appends the wildcard character (%) to the
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end of your search phrase for each text field. This allows the system to pull up all
records that include the keyword entered in the search. If performing a multiple
word search, the wildcard is only appended to the last word and not all words.

The following are example searches using wildcards in record search:

Search Criteria Would Match Would Not Match
rob Rob, Robert, Robin Bob, Jacob
%bert Albert, Bert, Robert Bart
r_b Robert, Ruby Bob, Raab
%s_i Dustin, Christi, Smith Sophie, Josephine
__it Nita, Littrell Schmitt
r_b% smit% Robert Smith, RobSmite Bob Smith, Robert Phillip
rob smit Rob Smith, Rob Smite John Smith

When performing a search, Sugar will try to match your search text to the
beginning of a record's field. So, if an account name starts with an article like "A"
or "The", this must be accounted for in the search by adding a wildcard (%) at the
beginning of your text. For example, to properly pull up an account named "The
ABC Company", you will have to enter "%abc" for Sugar to find a match in the
system.

In addition, you can use the wildcard character when specifying the search criteria
for custom filters with the "starts with" operator. Please note that the wildcard
character will only work with the "starts with" operator. For example, if you wish
to find all related contact records containing the word "smith", then you can use
the "starts with" operator and type "%smith" as the filter value. For more
information on creating filters, please refer to the Creating a Filter section.

Filter

Record view search provides a Filter option which allows users to narrow their
search further using the available options on the list.

The following options are available to users when filtering their Record View
search:
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Create : Create a new custom filter which you can use to filter your search.
All "Module Name" : Returns all records in the module to which you have
access
My "Module Name" : Returns only records assigned to you
My Favorites : Returns only records you have marked as favorites
Recently Created : Returns only records you created in the module within
the last 7 days
Recently Viewed : Returns only records you have viewed in the module
within the last 7 days

While in the record view, users can search for records which appear in subpanels
beneath the record's fields and filter the view to only display a specific subpanel
(e.g. Contacts, Accounts). When you choose a filter and run a search, Sugar
returns records matching the search criteria for the specified related module in
the record view. You can use one of the default filter options from the list or create
a custom filter if you wish to have more complex filter options when searching.

Creating a Related Records Filter

Users can also create new filters via the Create Filter option in the Filter list of the
search bar. This allows users to add custom, complex filter options when searching
in the module's record view. You have the option to add multiple fields to your new
filter and set select operators (e.g. is any of, is, starts with) along with the value(s)
it must contain. Please note that each one of the filter's criteria need to be true for
a record in order for it to appear in the subpanel view's search result. Unlike
creating a filter for the list view search, you must first select a module from the
Related list then select the Create option as it is specific to that module.

The following steps cover creating a filter for the related Contacts module located
in the state of "CA" as an example:

1. Click the Related option on a module record view's (e.g. Accounts) search
bar then select "Contacts".

2. Click the Filter option on the Search bar then select "Create".
You can also click "Create" to the right of the Filter option.
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3. Select "State" as the filter field and select the "exactly matches" operator
then enter "CA" as the search value. As you add in the filter criteria's, it
will be applied to the subpanel view concurrently to display any matching
results.

To clear any filter values (e.g. CA), simply select "Reset" to the left
of the Save button.
You can also remove filter values by clicking the "x" within the
search value (if applicable).

4. To add additional fields (e.g. Assigned to) to the new filter, click the Plus
button to the right of the filter dropdown list.

5. Enter a descriptive title for the new filter (e.g. "Contacts in CA") in the field
that contains "Enter new filter name…".

6. Click "Save" to add this filter to the related module's Filter dropdown list.

The filter will now appear as an option in the Filter list when "Contacts" is selected
as the related module. Please note that you can easily delete custom filters by
selecting the filter from the Filter list of the related module (e.g. Contacts),
clicking the filter's name (e.g. Contacts in CA) on the search bar, then clicking
"Delete" on the filter details panel. You can also edit the custom filter as necessary
via the filter details panel then click "Save" to preserve the changes.

Activity Stream Search

The record view's activity stream displays all posts specific to the current record
you are viewing. Please note that users can view all post's in the record view's
activity stream even if they do not follow the record in Sugar. To access the record
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view's activity stream, navigate to the module's record view (e.g. ABC Company)
then click the Activity Stream button below the module's fields. For more
information on activity streams, please refer to the Activity Streams
documentation. You can filter the posts on the activity stream based on the activity
type by selecting one of the available options on the Filter list. For more
information on filtering the activity stream, please refer to the Activity Type Filter
section.

Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration Guide.

Activity Type Filter

The record view activity stream can be filtered to only display certain messages
(e.g. Messages for Create, Messages for Update) by clicking "Filter" above the post
input box then selecting the desired message type. This enables users to filter the
activity stream to only display specific activity type's they wish to view. To view all
posts in the activity stream, simply select the All Activity Stream option in the
Filter list.

Preview

Once the subpanel view displays the search results, users can easily view the
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related record's details directly from the record view by clicking the Preview icon
to the far right of the record's row. The record's detail will display in the
intelligence pane to the right of the record view and provide users with key
information regarding the record as well as the related activity stream information.
For more information on viewing previews, please refer to the Previews section of
the User Interface documentation.

List View Search (Legacy Modules)

Modules using the Legacy user interface in Sugar has a list view with basic and
advanced search functionality to help you find records easily and effectively in a
module-specific manner. These module-specific searches differ from global search
in that you search by specific fields in a specific module, instead of across your
entire Sugar database.

Much like global search, list view search has the ability to use wildcards and
automatically appends a wildcard character (%) to the end of your search phrase.
For more information regarding using wildcards in list view searches, please refer
to the Wildcards section.

Basic Search
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Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a record name, Sugar will only return records with a
matching name that are assigned to you. Once the search is complete, the relevant
results will populate in the list view below the search panel. To see all records to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration Guide.

Administrators can configure what fields appear on the Basic Search via Admin >
Studio. For more information on editing layouts, please refer to the Studio
documentation in the Administration Guide.

Advanced Search

Advanced search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. The search
fields are context-sensitive and will vary depending on the module you are
searching. From the Advanced search panel, you can click "Basic Search" for
simplified searching. The buttons, checkboxes, and dropdowns available in
Advanced Search have the following functions:

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:
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Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section.

Advanced search allows users to perform ranged searches on certain date or
numeric fields. Ranged search fields include a dropdown to select the type of
predefined search including the following options:

Date Fields : Equals, Last 7 Days, Last Month, Is Between, etc.
Depending on the option selected, there will be zero (e.g. Last 7 Days, Next
7 Days), one (e.g. Equals, Not On), or two (e.g. Is Between) input boxes to
search on.
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Numeric Fields : Equals, Greater Than, Less Than, Is Between, etc.
Depending on the option selected, there will be one (e.g. Equals, Does Not
Equal) or two (e.g. Is Between) input boxes to search on.

Fields can be enabled or disabled to allow range searches via Admin > Studio. For
more information on how to enable or disable range searches on a field, please
refer to the Studio documentation in the Administration Guide.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter a record name to search, Sugar will only return records with
a matching name that you have marked as favorites. When searching by a
multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all records to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration Guide.

Administrators can configure what fields appear on the Advanced Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Layout Options

Sugar gives users the ability to personalize the list view of each module through
the advanced search layout options feature. Users can pick which fields are
displayed in the list view, the order they are displayed in, and which column the
records are ordered by.
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Use the following steps to personalize the list view for a module using the layout
options in advanced search:

1. Click on the Layout Options link to expand the available options below.

2. Select any column name in the Display Columns panel and click the right
aligned arrow to remove the column from the list view.

3. Alternatively, select any column name in the Hide Columns panel and click
the left aligned arrow to add a column to the list view.

4. Select any column name in the Display Columns panel and click the up or
down aligned arrow to move a column left or right respectively in the list
view.

5. In the Order By column dropdown, select a field to order your results by.
Only columns in the Display panel will be available to order by and some
columns (e.g. Email Address) are not available for sorting.

6. Select a direction you wish to order the fields by: Ascending : 1-10, A-Z;
Descending : 10 -1, Z-A 
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Note: Clicking on a column header in the list view will temporarily override
the sort selected here. In order to order by the selection made here again,
simply click the Search button.

€

7. Click Search to execute the search.

Not all columns in each module can be used in the layout options by default. If
there is a column you desire to add to your list view or order by, please contact
your Sugar administrator to enable the desired fields. For more information on
how to add or remove fields as options in the layout options section, please refer to
the Studio documentation in the Administration Guide.

Note: The layout options configured here supersede the default list view settings
configured in Studio for the specified module. 

Sugar remembers the last search run when you return to each module including
whether or not the Layout Options panel was exposed. After changing your layout
options, click "Layout Options" again to hide the expanded panel and click Search.
Running a search locks in place whatever options you currently have on the search
screen. Now the next time you run a search, the new options will be remembered
and the Layout Options will be hidden. Click the Clear and the Search buttons to
revert back to the default layout options.

Saved Search

Sugar gives users the ability to save any layout option changes and search criteria
for easy access to perform the same search at a later time. A common example of
this would be a manager saving a search where only his or her employees are the
Assigned Users on the record. This way, the manager can review all of their team's
records at the click of a button. You can save an unlimited number of search
results and the Saved Searches dropdown displays the last saved search at the top
of the list.

Note: Saved searches are user specific and can not be seen or shared by other
users.
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Use the following steps to save a personalized search from advanced search:

1. Enter any number of search criteria you desire.
2. Enter a descriptive title for the search in the "Save search as" textbox and

click "Save". 

Note: Any layout option changes made will also be saved with the saved
search.

3. The search is saved and executed. You now have the ability to modify any
search criteria or layout options. After any necessary modifications are
made click the Update button next to "Modify current search". 

Note: The name of the search you will be updating shows below the Update
button.

4. There is no way to modify the name of a saved search. Alternatively, you
can execute a saved search, enter a new name into the "Save search as"
textbox and click save. This will create a new saved search with the same
criteria as the original with the new name. You may then proceed to delete
the old saved search.

5. To execute a previously saved search, simply select the desired search from
the "Saved Searches" dropdown.

6. This immediately executes the saved search.
7. If you wish to remove a saved search, simply click the Delete button after

executing a previously saved search. 

Note: The name of the search you will be deleting shows below the Delete
button.
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AND vs OR

When performing searches in the Basic or Advanced search panels, Sugar uses the
"and" operator, not "or". This means that if you are searching against multiple
fields, Sugar will place an "and" in between each search field returning only
records matching all of your search criteria. For example, a search performed for a
record name containing "Sales" and the My Favorites checkbox enabled will only
return records where the record name contains "sales" and is marked as a favorite.

The only time Sugar will use the "or" operator is when using the mutiselect options
in the search criteria. For example, a search performed in the Documents module
for the Category field will allow you to select multiple options to search by.
Performing a search on the Category field with "Marketing" and "Sales" selected
will return any records where the document's category is defined as "Marketing"
or "Sales".

If any other field is added into the search criteria the operators between the
Category field and any other field will remain an "and" operator.

Basic Search:

Advanced Search:

Wildcards

Wildcards can be used to search for criteria without including the entire word in
the search. Use a wildcard character in place of characters you do not require in
your search. You may use any number of wildcard characters in any combination
you desire. Search operators can be combined for queries, but if quotation marks
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and wildcard characters are used together, the quotation marks will supersede the
wildcard, resulting in a search for an exact match. The following wildcard
characters can be used in the related module filters in Sugar:

Character Wildcard Use
% Use this wildcard to match any number

of characters, including zero
_ Use this wildcard to match a single

character

Please note that a wildcard is implied at the end of all search queries. For example,
searching for "Acme" will match account names like Acme Industries or Acme
Funds. Insert a wildcard before your search query with a % sign (%Acme) to match
account names that begin with or contain the query, such as "ABC Acme
Industries". If performing a multiple word search, the wildcard is only appended to
the last word and not all words.

The following are example searches using wildcards in related record search:

Search Criteria Matches Does Not Match
rob Rob, Robert, Robin Bob, Jacob
%bert Albert, Bert, Robert Bart
r_b Robert, Ruby Bob, Raab
%s_i Dustin, Christi, Smith Sophie, Josephine
__it Nita, Littrell Schmitt
r_b% smit% Robert Smith, RobSmite Bob Smith, Robert Phillip
rob smit Rob Smith, Rob Smite John Smith

When performing a search, Sugar will try to match your search text to the
beginning of a record's field. Therefore, if an account name starts with an article
like "A" or "The", this must be accounted for in the search by adding a wildcard (%)
at the beginning of your text. For example, to properly return an account named
"The ABC Company", you should enter "%abc" for Sugar to find a match in the
system.

Search Memory

Sugar by default automatically saves your most recent search criteria when
leaving the module then repopulates the search fields the next time you return. For
example: Perform a search in the Accounts module for "sugar". Navigate away
from the Accounts module and then return back to the Accounts module. The
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search for "sugar" will automatically be shown and the relevant results will be
shown below in the list view.

Note: This can be an unintended result if a user is unaware of this functionality.
For example, a search may have an assigned user selected that is not currently
visible in the scrolling selection box. When running a new search, best practice is
to click the Clear button before entering your search criteria.

Search memory can be set to one of the following options:

Remember last search : This is the default behavior in Sugar
Populate only : This will populate the search criteria, but will not execute
the search.
Note : This is recommended for systems experiencing performance issues.
Do not remember last search : Search will be cleared and executed
every time the search is loaded

Note: These options are global settings and will affect all users. Please be sure to
inform users of any behavior change before making modifications.

Admin Configuration

A Sugar administrator has many options for configuring legacy searches. You have
the ability to add, remove, and order fields on either the basic or advanced search
layouts through Admin > Studio. For more information on how to change the basic
and advanced search layouts, please refer to the Studio documentation in the
Administration Guide.

The search results are controlled through the list view layout in Admin > Studio.
Here you can also control the possible fields a user can add to their personalized
list view. For more information on how to change the list view layout, please refer
to the Studio documentation in the Administration Guide.

Last Modified: 2021-09-30 13:04:07

Home

Overview

Sugar's Home page houses the dashboard and activity stream which allows users
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to view pertinent record information via various dashlets and activity stream posts.
Every user in Sugar can configure their dashlets based on the display options and
filters available from their dashboard. Users can also personalize their activity
stream to only view posts specific to records that are important to them. This
documentation will go over the basics of the Home page as well as the various
options available to customize the Home page to best fit your individual needs.

Home Module Tab

The Home module tab, represented by the Cube icon, is the first tab on the Sugar
navigation bar. Click the Cube icon to navigate to the Home page or click the
triangle next to the cube to perform additional actions. The following options are
available in the Home module tab's actions menu:

Create Dashboard : Create a new dashboard and build out its layout and
dashlet set. Refer to the Dashboards and Dashlets documentation for more
information.
Activity Stream : View your activity stream for all enabled modules. Refer
to the Activity Stream section for more information.
Manage Dashboards : Access the Dashboards module to share
dashboards, pull dashboards to your Home page, etc. Refer to the 
Dashboards and Dashlets documentation for more information.
Dashboards List : Choose one of the available Home page dashboards to
view. Admin-designated default dashboards, shared dashboards you have
pulled to your Home page view, and personal dashboards you have created
will be displayed. For more information, refer to the Dashboards and
Dashlets documentation.
Note: Up to 50 dashboards can be displayed in the Home module tab's
menu.
Recent Records : The three records you most recently viewed, from
across all Sugar modules, are displayed at the bottom of the menu. Click a
record name to navigate to its record view. Clicking "More recents..." will
display a fourth record.
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Dashboards

Sugar's Home page allows you to build full-page dashboards by combining dashlets
and configuring the dashboard layout to suit your business needs. 

Dashboards and dashlets are thoroughly documented in the Dashboards and
Dashlets documentation, which covers dashboards both on the Home page and
dashboards on list view and record view intelligence panes. Home page
dashboards are unique in that they allow the user to split the board into up to
three columns. Refer to the Changing Home Dashboard Layouts section below for
more information.

Instances that are upgraded from Sugar 6.x to Sugar 7.x will have their legacy
dashboards migrated over. Users will be able to view these by selecting "My
Legacy Dashboard" from the Sugar cube icon. For more information regarding the
legacy dashboard, please refer to the My Legacy Dashboard section.

Changing Home Dashboard Layouts

Users can change the number of columns on their Home dashboards depending on
how they wish to view the information. You can organize the dashlets into one,
two, or three columns. 
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The following steps cover changing a dashboard to display two columns as an
example:

1. Click the triangle next to the Create button then select "Edit".

2. Select the two-column layout icon on the upper left of the dashboard.
The second column will open up to the right of the existing column
allowing users to add a new dashlet or move an existing one into it.
For more information on adding dashlets, please refer to the Adding
Dashlets section of the Dashboards and Dashlets documentation.

3. Click "Save" once the appropriate changes have been made to the
dashboard.

4. The dashboard will now display the dashlets across two columns.

Dashlets

Dashlets reside within the dashboard and provide users with valuable information
about their records in Sugar. By default, there are stock dashlets that come out-of-
the-box with Sugar and users can easily add them to various dashboards per their
viewing preference. Please note that each dashlet can be configured to display the
necessary information you wish to view. For more information on configuring the
dashlet, please refer to the Editing Dashlets section of the Dashboards and
Dashlets documentation.
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Commonly Used Dashlets

By default, the "My Dashboard" will display on your Home page and include stock
dashlets such as "My Contacts", "Pipeline", etc. Users have the option to add
various types of dashlets to each dashboard to view information that is of
importance to them. For more information on adding dashlets, please refer to the 
Adding Dashlets section of the Dashboards and Dashlets documentation.

The commonly-used dashlets are available to use on your Home page:

Dashlet Description
List View Dashlet Enables users to view a list of records

for a specific module (e.g. Accounts,
Contacts, Leads) in Sugar

Planned Activities Dashlet Provides users with a list of open or
upcoming calls and meetings that are
assigned to them

Active Tasks Dashlet Allows users to view outstanding tasks
that require attention and need to be
completed on a future or current date

History Dashlet Allows users to view a history of
record's related activities (e.g. calls,
meetings, emails) that have already
taken place

Saved Reports Chart Dashlet Displays charts from your saved or pre-
defined reports and allows users to drill
through to view associated records

My Activity Stream Dashlet Displays the user's main Activity Stream
within a dashboard, eliminating the
need to navigate to the Activity Streams
view to monitor the most recent stream
activities.

Forecast Pipeline Chart Dashlet Illustrates the flow of open sales
opportunities through the various sales
stages by displaying the total dollar
amounts for open records grouped by
sales stage.

Adding Dashlets to Home Dashboards

Additional dashlets can be added by clicking the triangle next to the Create button
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on the upper right of the dashboard then selecting "Edit". The dashboards edit
layout will display open "Add a Row" boxes where you can add new dashlets. For
each row you add, you will have the option to select the column (+1 column) and
add the desired dashlet. You can select and add from the list of available dashlets
(e.g. My Accounts) to the specific column on the dashboard row. For more
information on adding dashlets to dashboards, please refer to the Adding Dashlets
section of the Dashboards and Dashlets documentation.

Please note that you can add the same dashlet multiple times in the dashboard
with different configurations to show different records or information.

My Legacy Dashboard

The user's existing dashboard in 6.x will be migrated over to 7.x upon upgrade and
can be viewed via the My Legacy Dashboard on the Home page. The My Legacy
Dashboard enables users to view information from their existing 6.x dashlets and
allows them to similarly configure dashlets (e.g. My Accounts, My Calls, etc.) that
are supported for 7.x in the new dashboard (e.g. My Dashboard). The overall
layout of the legacy dashboard will be the same as it was in 6.x, but dashlets such
as My Activity Stream, My Project Tasks, and any forecast-specific dashlets will not
appear as they are not compatible with 7.x. Please note that the My Activity
Stream dashlet does not appear upon upgrade as it is replaced with the new
activity stream view on the 7.x Home page. For more information on viewing and
managing the activity stream, please refer to the Activity Streams documentation.
The legacy dashlets will migrate over with the same configurations applied and
will function in a similar fashion. For example, you can close meetings from the My
Meetings dashlet by clicking the Close icon, click the Pencil icon next to records in
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the dashlet to edit via the module's record view/detail view, create new
calls/meetings in the My Calendar dashlet, etc.

Simply click the triangle next to the Sugar cube icon and select "My Legacy
Dashboard" to view and access your 6.x dashboard. Please note that you will not
be able to configure (e.g. change layout, add tabs, add dashlets, etc.) the legacy
dashboard, but will be able to modify the existing dashlets by clicking the Edit icon
at the top of the dashlet menu bar. This will display the pop-up Options box with
various options (e.g. Title, Display Rows, etc.) and filters (e.g. Only My Items,
Assigned to, etc.) to make any necessary changes. Unlike 6.x, administrators will
not be able to configure the Filters options or the dashlet list view display columns
via Admin > Studio as the Sugar Dashlet layout in Studio is not available.

Activity Stream

Sugar's activity stream allows users to view a list of activities performed on
records, create posts, preview posts, comment on posts, etc. Users can easily track
the most recent updates across their entire organization via the record and user
posts on the Home page activity stream. You can also personalize the activity
stream by specifying which records' posts you wish to view in the activity stream.
Please note that the modules currently enabled to generate record posts for the
activity stream are Accounts, Contacts, Leads, Opportunities, Revenue Line Items,
Bugs, and Cases. For more information on viewing posts, creating posts, etc. via
the activity stream, please refer to the Activity Streams documentation.
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Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration Guide.

Last Modified: 2020-03-11 00:11:43

Leads

Overview

Sugar's Leads module consists of individual prospects who may be interested in a
product or service your organization provides. In addition to standard creation
options, leads can provide their own details to you via a web-to-lead form. Once the
lead is qualified according to your organization's practices, it can be converted into
a contact, opportunity, account, or other record. This documentation will cover
information and actions specific to the Leads module. For instructions concerning
views and actions which are common across most Sugar modules, such as
creating, editing, and deleting leads, please refer to the Working With Sugar
Modules section of this page.

Please note that you will only be able to see lead records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
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and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Leads module is not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation. 

Lead Fields

The Leads module contains a number of stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The definitions below are suggested meanings for the
fields, but the fields can be leveraged to best meet your organization's needs.
Administrators or users with developer-level role access have the ability to alter,
add, or remove fields via Admin > Studio. For more information on configuring
fields, please refer to the Studio documentation in the Administration Guide.

Field Description
Account Description A description or other information about

the lead account
Account Name The account to which the lead belongs

Note: Unlike the Contacts module, the
Account Name field is not a Relate field
in the Leads module. When you convert
the lead, you will have the option to
create the account as a related record.

Alternate Address The lead's alternate address (e.g.
billing, shipping)

Assigned to The Sugar user assigned to the lead
Assistant The name of the lead's assistant within

his or her company
Assistant Phone The assistant's phone number
Avatar The lead's profile image
Birthdate The lead's date of birth
Business Center Name The business center this lead belongs to,

which is used during lead routing in
Sugar Sell
Note: This field's value is only visible to
Sugar Sell users; when this field
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appears on layouts, users without a
supported license type will see a
placeholder containing the text "License
Required" instead of the field's value.
See the User Management page for
more details on license types.

Campaign The campaign, if any, from which the
lead originated

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Converted An indication that the lead has been
converted to a contact, opportunity, or
account

D&B Principal ID Unique ID number associated with the
individual in D&B

Date Created The date the lead record was created
Date Modified The date the lead record was last

modified
Department The lead's department within their

company
Description A description or other information about

the lead
Do Not Call An indication that the lead should not be

called
Email Address The lead's email address
Facebook Account The lead's Facebook account

information
Fax The lead's fax number
First Name The lead's first name
Google Plus ID The lead's Google Plus ID
Home Phone The lead's residence number
Last Name The lead's last name
Lead Source The source from which this lead
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originated
Lead Source Description A description or other information about

the lead source
Mobile The lead's mobile number
Name When viewing, the lead's full name
Office Phone The lead's office number
Opportunity Amount The expected opportunity amount for

the potential business with the lead
Opportunity Name The opportunity name associated with

the lead
Other Phone The lead's alternate phone number
Primary Address The lead's primary address
Referred By The name of the individual or

organization that referred the lead
Salutation Standard greeting for the lead (e.g. Mr.,

Ms., Mrs., etc.)
Status The current status of the lead

Note: The converted status cannot be
set directly in the Status field. Rather,
the conversion process must be
completed.

Status Description A description or other information about
the lead's status

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the lead
record

Title The lead's business title
Twitter Account The lead's Twitter account information
Website The website URL associated with the

lead's organization

Working With Sugar Modules
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While the Leads module has some features that only apply to leads, it also uses the
Sidecar user interface that most Sugar modules are based on. In the table below,
the left column contains links to the User Interface page covering topics that are
applicable to all Sidecar modules. The right column has links to sections of the
current page that cover topics specific to leads.

General Instructions for Working
With Sugar Modules

Leads-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Leads-specific help exists for each
topic, use the links below to navigate to
sections of the current page.

Creating Records Lead Creation via Web-to-Lead Form
Converting Leads
Creating Leads via vCard

Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Emailing Records Emails and Leads

Campaigns and Leads
Exporting Records Downloading a Lead's vCard
Recalculating Calculated Values
Finding Duplicate Records
Merging Records
Viewing Record Historical Summaries
Viewing Record Audit Logs
Record PDFs
Favoriting Records
Following Records
Sharing Records

Leads Tile View
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Tile View allows users to visualize and engage with their leads in an intuitive drag-
and-drop interface. Users can drag a tile from one column to another to change its
status. Please note that leads may be converted by dragging the tile into the
Converted column and following the steps to convert a lead. However, leads
cannot be unconverted and therefore attempts to move tiles out of the Converted
column will receive an error stating "Unable to change Lead status. This Lead has
already been converted."

To access Tile View, navigate to the Leads list view and click on the Tile View icon
next to the search bar:

For more information on using the Tile View, refer to the User Interface
documentation. For information on configuring Tile View layouts, refer to the Tile
View Settings documentation in the Administration Guide.
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Lead Menus

The Leads module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and its options with links to more information about each
option in the User Interface documentation or, for Leads-specific functionality,
within this page.

Module Tab Menus

The Leads module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Leads list view. You may also click the
triangle in the Leads tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of leads you most recently
viewed. The Favorites menu displays the list of leads you most recently marked as
favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Lead Opens the record view layout to create a

new lead
Create Lead From vCard Imports a vCard file from your computer

to create a new lead
View Leads Opens the list view layout to search and
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display leads
View Lead Reports Displays existing reports based on the

Leads module
Import Leads Opens the import wizard to create or

update leads using external data

If you do not see the Leads module tab in Sugar, please check the following:

The Leads module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Leads module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Leads module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Leads
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Leads list view displays all lead records and allows for searching and filtering
to locate specific leads. You can view the basic details of each record within the
field columns of the list view or click a lead's name to open the record view. To
access a module's list view, simply click the module's tab in the navigation bar at
the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual lead records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.
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The options in the Mass Actions menu allows you to perform the following
operations:

Menu Item Description
Email Email one or more leads at a time
Mass Update Mass update one or more leads at a time
Merge Merge two or more duplicate leads
Add to Target List Add one or more leads to a target list
Delete Delete one or more leads at a time
Export Export one or more leads to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual lead directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this lead in the intelligence

pane
Edit Edit this lead
Follow Receive updates about changes to this

lead in your activity stream
Delete Delete this lead
Convert Convert a qualified lead into a contact,

account, or opportunity

Record View Actions Menu

The Leads record view displays a single lead in full detail including its fields,
subpanels of related records, and activity stream. To access a lead's record view,
simply click a hyperlinked lead name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this lead
Share Share a link to this lead via email
Download PDF Download lead information as a PDF file
Email PDF Email lead information as a PDF

attachment
Convert Convert a qualified lead into a contact,

account, or opportunity
Manage Subscriptions Manage this lead's campaign

subscriptions
Download vCard Download a vCard from Sugar and

transfer this lead's information to
another application (e.g. Outlook)

Find Duplicates Locate potential duplicates of this lead
Copy Duplicate this lead
Historical Summary View a historical summary of activities

(e.g. calls, meetings, etc.) related to this
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lead
View Audit Log View a record of changes to this lead
View Personal Info Display this record's fields which an

admin has designated as personal
information

Delete Delete this lead

Lead Creation via Web-to-Lead Form

Sugar provides a simple way to allow visitors to your website or other online
location to become leads in your Sugar instance. You can create a web-to-lead form
in Sugar and place the form on an external website. Then when a visitor to your
site completes and submits the form, their information is entered into Sugar as a
new lead record. For more information on creating and managing web-to-lead
forms, please refer to the Web-To-Lead Forms documentation.

Converting Leads

Sugar enables you to convert leads into contacts once they qualify according to
your organization's practices (e.g. after an evaluation/qualification process or upon
entering into business with the individual). When the lead is converted, a new
contact record is created in Sugar with a relationship to the original lead record.
The Convert Lead page also gives you the option to create an account and
opportunity record.

You can convert a lead (see the steps to convert a lead) from the following places
in the Leads module:

Record view : Click the Unconverted badge or select "Convert" from the
record's Actions menu.
List view : Select "Convert" from the record's Actions menu in list view.
Tile View : Drag and drop a lead's tile to the "Converted" column.
Subpanel : From a related module's subpanel (e.g. the Leads subpanel
under Accounts), select "Convert" in the record's Actions menu.

Note: The converted status cannot be set directly in the Status field. Rather, the 
conversion process must be completed.

Administrators may configure the Convert Lead layout via Admin > Studio. Admins
can mark modules as required for conversion, add additional modules (e.g. Notes,
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Tasks) to the Convert layout, remove modules, and more. For more information on
configuring the Convert layout, please refer to the Studio documentation in the
Administration Guide.

Lead Conversion Options

The lead's activities can be moved to the contact record created during conversion
or left attached only to the lead depending on the lead conversion option selected
by your administrator via Admin > System Settings. For more information, please
refer to the System documentation in the Administration Guide. 

The lead conversion options available to be enabled by your administrator are as
follows:

Move : This option allows all of the lead's activities to be moved to the
contact record created during the conversion. When enabled, the "Move
related activities to the contact record" checkbox will be displayed on the
Convert Lead page.
Do Nothing : This option leaves the lead's activities only related to the
converted lead.

If the Move option is enabled by your administrator, then the "Move related
activities to the contact record" option will be displayed at the top of the Convert
Lead page. Please note that the checkbox will be marked by default, but users can
simply uncheck the box before converting the lead if they do not wish to move the
lead's related activities to the contact record.

Please note that even if "Do Nothing" is selected, emails associated with the lead
will still appear under the created contact as long as the lead and contact share
the same email address. This is because emails carry an implicit relationship with
any record containing an email address matching an address in the From, To, or
CC lines of the email record.

Duplicate Record Check

Sugar automatically checks for any duplicate records (e.g. Contacts) in the system
when converting the lead. The Convert Lead page will display any records that are
detected as duplicates in a list view within the panels (e.g. Contact, Account). The
first record in the list view will be automatically selected and you can simply click
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the Select button (e.g. Select Contact) on the upper right of the panel if you wish
to relate the existing record to the lead. You can also preview the duplicate
record(s) by clicking the Preview icon to the far right of the record's row. For more
information on previewing records, please refer to the Preview section of this
page.

In addition, the Search bar is available if you wish to perform a list view search for
other existing records to relate to the lead. For more information on performing
searches, please refer to the Search documentation. Please note that the duplicate
check feature is enabled by default in Sugar and cannot be disabled by
administrators or users.

If none of the suggested duplicates are valid, simply click "Ignore and create new".
If there are no duplicate records found for required modules (e.g. Contacts,
Accounts) in lead conversion, the new record will be automatically related to the
lead and the panel will be collapsed. The record view layout will be pre-populated
with the associating record's (e.g. Leads) values (e.g. address).

Steps to Convert a Lead

Once the lead has been evaluated and qualified, it is ready to be converted to a
contact. The panels (e.g. Account) on the Convert Lead page will indicate if any
duplicate records are found and display the record(s) in the list view within the
panel. If no duplicate records are found, the record (e.g. ABC Company) will be
automatically related to the lead.

As the records are related to the lead, the panel will collapse and display a
checkmark to the left of the header. If you wish to reset the association and
complete the panel again, simply click the Reset link to the far right of the header,
and the checkmark will disappear. Please note that the panel you are currently
viewing (e.g. Contact) will collapse as you open up a different panel (e.g. Account)
on the page.
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Note: The required modules (Contacts, Accounts) must be related to the lead
before you can save and convert the lead successfully. For more information on
enabling and requiring modules for lead conversion, please refer to the Studio
documentation in the Administration Guide.

Use the following steps to convert a lead via the Leads record view:

1. Navigate to a Leads record view.
2. Select "Convert" from the Actions menu or initiate conversion using one of

the methods listed in the Converting Leads section.

3. Sugar will perform a duplicate check for any existing records in the various
modules.

The duplicate records (if any) will be displayed in a list view within
each panel. For more information on duplicate record checks and
selecting the record to associate to the lead, please refer to the 
Duplicate Record Check section above.

4. To create a new Contact record, click "Ignore and create new" on the upper
right of the panel. The displayed record view will be pre-populated with the
lead's values. Update any necessary fields then click the Create button (e.g.
"Create Contact") to relate the new record to the lead.
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5. If there are no duplicate records found for a required module (e.g.
Accounts) in lead conversion, the new record will be automatically related
to the lead and the panel will be collapsed. Note: The record view layout
will be pre-populated with the lead's values (e.g. Address). Simply click the
arrow to the far right of the header if you wish to expand the panel and
view or alter the new record's details.

6. A new or existing opportunity record can be related to the lead accordingly.
If you wish to relate an existing opportunity to the lead, click "Search" to
perform a list view search within the panel. If you wish to create a new
record, simply complete the record view in the panel then click "Create
Opportunity". 

Note: If the Opportunity panel is marked as optional, then no opportunity
is required to convert the lead. For more information on setting modules as
required on the Convert Lead layout, please refer to the Studio
documentation in the Administration Guide.

7. A new or existing revenue line item record can also be related to the lead's
opportunity. You can search for an existing record if there are none
associated with the opportunity, or select from the list of existing records
already associated with an opportunity. If you wish to create a new record,
simply complete the record view in the panel then click "Create Revenue
Line Item". When creating a new revenue line item, the Opportunity Name
and Account fields will inherit the information created above at the end of
the converting process.
Note: The Revenue Line Items module can be added to the layout by an
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administrator. For more information on adding modules on the Convert
Lead layout, please refer to the Studio documentation in the Administration
Guide.

8. Once all of the necessary information is entered and the appropriate panels
are completed, click "Save and Convert".

Once the lead has been converted successfully, the lead's record view will display
the converted contact, account, and opportunity information below the record's
detail. You can click the Preview icon to the far right of each record's row to view
the details of the converted records.

Please note that the lead conversion can only be performed once in Sugar and once
a lead is converted, the lead's status field will display "Converted". The status field
becomes read-only upon conversion and cannot be manually changed for the lead.
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Emails and Leads

Leads include an email address that can be used to email the lead as a recipient.
The methods for doing so are covered in the Emailing Records section of the User
Interface documentation. Leads may also be recipients of campaigns, which allow
you to send email messages to a large group of recipients as well as to track the
results of that message. Please refer to the Campaigns and Leads section of this
page for more information. In addition to being a recipient or sender of an email,
leads may be related to emails by being selected in the email's Related To field.
These relationships allow the lead to display all relevant email correspondence in
the Emails subpanel and History dashlet on a case's record view.

Emails Subpanel

The Emails subpanel in the Leads module displays emails that are associated with
the lead record in a variety of ways:

Explicitly related to the lead : If the lead is selected in the email's
Related To field, the email and lead are explicitly related, and the email will
appear in the lead's Emails subpanel and History dashlet. Instructions for
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using this flex relate field are available in the Emails documentation.
Implicitly related to the lead : If one of the lead's email addresses
appears in the email's From, To, or Cc fields, the email and lead are
implicitly related, and the email will appear in the lead's Emails subpanel
and History dashlet. This implicit relationship is made for emails sent from
Sugar as well as any email imported into Sugar via Inbound email leads or
email archiving.

For more information on working with subpanels, please refer to the User
Interface documentation.

Calls, Meetings, and Leads

Leads can be related to calls and meetings in two ways. First, they can be selected
in the event's Related To field, indicating that the lead was the topic of the call or
meeting. Second, they can be included as invitees to the call or meeting. 

Calls and Meetings Subpanels

Each lead's record view includes a Calls subpanel and a Meetings subpanel. These
subpanels display all calls and meetings which include the lead as an attendee. If
the lead is not an attendee but is selected in the call's or meeting's Related To
field, the call or meeting will not appear in the subpanels.

When relating an existing call or meeting to a lead via the subpanels on a lead's
record view, the lead will automatically be added as an invitee. When creating a
call or meeting from the subpanels, the lead will automatically be added as an
attendee and the lead's account will automatically be set in the event's Related To
field.

For more information on working with subpanels, please refer to the User
Interface documentation.

Campaigns and Leads

Sugar's Campaigns module can be used to send mass emails or a series of
newsletter emails to Sugar accounts, contacts, leads, and targets. The results of
each campaign are recorded to measure its impact. Leads are not related directly
to campaigns. Rather, each campaign is related to several target list records, and
each target list is related to leads and other recipients. To send a campaign email
to a lead, the lead should belong to a default-type target list related to the
campaign. To prevent a lead from receiving emails from a campaign, the lead
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should belong to the campaign's suppression list-type target list. Once a campaign
is sent, the results specific to a particular lead will appear in the Campaign Log
Subpanel on the lead's record view as described in the Campaign Log Subpanel
section of this page.

Leads can be added to target lists via the target list record itself, from the Leads
list view using the Add To Target List option, or from the Leads record view using
the Manage Subscription option. Instructions for using the Add To Target List and 
Manage Subscriptions options in the Leads module are provided in the sections
below. For instructions on other available methods of adding to target lists, please
refer to the Target Lists documentation.

Adding to a Target List via Leads List View

A target list consists of a group of individuals or organizations you wish to be
included in or excluded from a mass marketing campaign. These targets are
typically identified based on a set of predetermined criteria such as being a
prospect or existing customer, age group, industry, etc. There are various ways to
add leads to a target list in Sugar including using the Add To Target List option
from the Lead list view's Mass Actions Menu. For more information on target lists
and other methods of adding leads, please refer to the Target Lists documentation.

You can use the Select All feature in the list view when adding to a target list,
which will allow you to easily select the first 1000 records in the result set. If you
wish to add more than 1000 records or add a specific group of records to the
target list, please use the filter option in list view search to perform the additions
in smaller batches. 

Use the following steps to add leads to a target list via the Leads list view:

1. Navigate to the Leads list view by clicking the Leads module tab.
2. Use the List View Search to find the Lead records you wish to add to a

target list.
3. Select the desired lead records then choose "Add to Target List" from the

Mass Actions menu.
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4. Below the search bar, locate and select the desired target list in the
dropdown list or click "Create new target list" to add the leads to a new
target list. Click "Update" to add the record(s) to the target list.

In order to view the leads that have been added, you can navigate to the Target
Lists module. Click the target list's name to open the record view, and you will see
the lead records within the Leads subpanel.

Managing Lead Subscriptions

Leads who receive newsletter-type campaign emails from your Sugar instance are
considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from the Leads record view using the Manage Subscriptions option
in the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
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or more default-type target lists. Leads are added to these target lists in order to
receive your newsletter. The Manage Subscriptions option allows you to add a lead
to the default-type or suppression-type target lists of your newsletter campaigns
without leaving the Leads module. For more information on newsletter
subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage lead subscriptions via a lead's record view:

1. Navigate to a lead's record view.
2. Select "Manage Subscriptions" from the Actions menu.

3. To add the lead to a newsletter subscription mailing list, select the
newsletter from the Available/Newsletters Unsubscribed To list and drag it
to the Newsletters Subscribed To list. This will add the lead to the
campaign's default target list.

4. To remove the lead from the newsletter subscription mailing list, select the
newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign
which will prevent the lead from receiving the newsletter. Please note that
the lead will not be removed from the campaign's default target list.

5. Click "Save" to preserve your changes.

Campaign Log Subpanel

The Campaign Log subpanel contains historical information regarding a lead's
interaction with all Sugar campaigns. When a mass marketing campaign is sent to
a lead (or manually marked as sent in the case of non-email campaigns), the
related campaign activity information will appear within the Campaign Log
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subpanel on the contact's record view. This information mirrors the "View Status"
page available from within each individual campaign and shows activities such as
when a campaign was sent, when the recipient viewed the campaign message,
when the recipient clicked a tracked link within the campaign, etc. Since this
subpanel contains historical campaign interactions for the lead, it cannot be used
to associate a lead with a campaign or otherwise manage a campaign or target list.
For more information on associating a lead with a campaign, please refer to the 
Adding to a Target List via Leads List View section of this page. For more
information on campaigns, please refer to the Campaigns documentation.

For more information on working with subpanels, please refer to the User
Interface documentation.

vCards and Leads

vCards are electronic business cards that are exchanged between applications
such as email and web browsers. Leads may be created from vCards generated by
another application or saved as vCards for use in other software.

Creating Leads via vCard

Use the following steps to create a lead in Sugar via vCard:

1. Click the triangle in the Leads module tab and select "Create Lead From
vCard".

2. Choose the vCard file from your computer and click "Create".

Downloading a Lead's vCard

The following steps cover downloading a vCard and saving it as a contact in
Microsoft Outlook as an example:

                       354 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Campaigns
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Subpanels


 

1. Navigate to a Leads record view.
2. Select "Download vCard" from the Actions menu to download the vCard

file.

3. Open the downloaded file in your mail or address book application. For this
example, double-clicking opens the vCard in Outlook.

4. Make any necessary changes to the information, then click "Save & Close"
to save this lead in Outlook.

Last Modified: 2020-11-20 17:05:56

Contacts

Overview

Sugar's Contacts module consists of individual people with whom your
organization has an established relationship. Sugar enables you to convert lead
records to contact records according to your organization's qualification process.
Contact records are typically related to an account record, and multiple contacts
may be associated with a single account. Each contact record may then relate to
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other Sugar records such as meetings, cases, opportunities, and many others,
making the contact record a hub for viewing and continuing your interaction with
the individual. This documentation will cover information and actions specific to
the Contacts module. For instructions concerning views and actions which are
common across most Sugar modules, such as creating, editing, and deleting
contacts, please refer to the Working With Sugar Modules section of this page.

Please note that you will only be able to see contact records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Contact Fields

The Contacts module contains a number of stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The below definitions are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Account Name The account to which the contact

belongs
Alternate Address The contact's alternate address (e.g.

billing or shipping)
Assigned To The Sugar user assigned to the contact
Assistant The name of the contact's assistant

within his or her company
Assistant Phone The assistant's phone number
Birthdate The contact's date of birth
Business Center Name The business center this contact belongs

to
Note: This field's value is only visible to
Sugar Serve and Sugar Sell users; when
this field appears on layouts, users
without a supported license type will see
a placeholder containing the text
"License Required" instead of the field's
value. See the User Management page
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for more details on license types.
Campaign 1 The campaign, if any, from which the

contact originated
Comment Log A shared log of messages, comments, or

other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Confirm Portal Password When editing, confirmation of the
contact's password for accessing Sugar
Portal

Contact Source A system-level dropdown field that
represents the origin of newly created
contacts. It is set to External on
contacts created via Portal and set to
Internal on contacts created in Sugar.
This field is not available in Studio or
the user interface and is only available
in SugarBPM.

D&B Principal ID Unique ID number associated with the
contact in D&B

Date Created The date the contact record was created
Date Modified The date the contact record was last

modified
Department The contact's department within his or

her company
Description A description or other information about

the contact
Do Not Call Indication that the contact should not be

called
Email Address The contact's email address
Facebook Account The contact's Facebook account

information
Fax The contact's fax number
First Name The contact's first name
Google Plus ID The contact's Google Plus ID
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Home The contact's residence number
Last Name The contact's last name
Lead Source The source from which the contact

originated
Note: The Lead Source field will be set
to "Support Portal User Registration"
for contacts created via portal
registration.

Mobile The contact's mobile number
Name When viewing, the contact's full name
Office Phone The contact's office number
Other Phone The contact's alternate phone number
Picture An image of the contact (e.g. business

card or profile picture)
Portal Active Indication that the contact is enabled to

access Sugar Portal
Portal Application The portal application name. Only used

when integrating a custom portal
solution with Sugar.

Portal Name The contact's user name for accessing
Sugar Portal

Portal Password The contact's password for accessing
Sugar Portal

Portal User Company Name The name of the company to which the
customer belongs to
Note: This field will display the
company name the customer enters
when signing up for the Sugar Portal.

Preferred Language The contact's preferred language when
accessing Sugar Portal

Primary Address The contact's primary address
Reports To The contact's manager in his or her

company
Salutation Standard greeting for the contact (e.g.

Mr., Ms., Mrs., etc.)
Sync to mail client Indication that the contact should be

synced to mail client when using the
Sugar Plug-in for Outlook, for example.
Note: This field must be set on a per-
user basis.
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Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
contact record

Title The contact's title within his or her
company

Twitter Account The contact's Twitter account
information

1 This field's value is not visible to Sugar Serve users; when this field appears on
layouts, users without a supported license type will see a placeholder containing
the text "License Required" instead of the field's value. See the User Management
page for more details on license types.

Working With Sugar Modules

While the Contacts module has some features that only apply to contacts, it also
uses the Sidecar user interface that most Sugar modules are based on. In the table
below, the left column contains links to the User Interface page covering topics
that are applicable to all Sidecar modules. The right column has links to sections of
the current page that cover topics specific to contacts.

General Instructions for Working
With Sugar Modules

Contacts-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Contacts-specific help exists for
each topic, use the links below to
navigate to sections of the current page.

Creating Records Contact Creation via Sugar Portal
Converting Leads to Contacts
Creating Contacts via vCard

Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
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Intelligence Pane
Editing Records
Deleting Records
Emailing Records Emails and Contacts

Campaigns and Contacts
Exporting Records Downloading a Contact's vCard
Recalculating Calculated Values
Finding Duplicate Records
Merging Records
Viewing Record Historical Summaries
Viewing Record Audit Logs
Record PDFs
Favoriting Records
Following Records
Sharing Records

Contact Menus

The Contacts module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Contacts-specific
functionality, within this page.

Module Tab Menus

The Contacts module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Contacts list view. You may also click the
triangle in the Contacts tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important operations within the
module. The Recently Viewed menu displays the list of contacts you most recently
viewed. The Favorites menu displays the list of contacts you most recently marked
as favorites.
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The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Contact Opens the record view layout to create a

new contact
Create Contact From vCard Imports a vCard file from your computer

to create a new contact
View Contacts Opens the list view layout to search and

display contacts
View Contact Reports Displays existing reports based on the

Contacts module
Import Contacts Opens the import wizard to create or

update contacts using external data

If you do not see the Contacts module tab in Sugar, please check the following:

The Contacts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Contacts module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Contacts module for your entire
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Sugar instance. Reach out to your Sugar administrator to have the
Contacts module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Contacts list view displays all contact records and allows for searching and
filtering to locate specific contacts. You can view the basic details of each record
within the field columns of the list view or click a contact's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual contact records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Email Email one or more contacts at a time
Mass Update Mass update one or more contacts at a

time
Merge Merge two or more duplicate contacts
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Add to Target List Add one or more contacts to a target list
Delete Delete one or more contacts at a time
Export Export one or more contacts to a CSV

file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual contact directly from the list view.

The lst view's Record Actions menu allows you to perform the following operations:

Menu Item Description
Preview (Eye icon) Preview this contact in the intelligence

pane
Edit Edit this contact
Follow Follow this contact
Delete Delete this contact

Record View Actions Menu

The Contacts record view displays a single contact in full detail including its fields,
subpanels of related records, and activity stream. To access a contact's record
view, simply click a hyperlinked contact name from anywhere within Sugar. The
record view's Actions menu appears on the top right of the page and allows you to
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perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this contact
Share Share a link to this contact via email
Download PDF Download contact information as a PDF

file
Email PDF Email contact information as a PDF

attachment
Manage Subscriptions Manage this contact's newsletter

campaign subscriptions
Download vCard Download a vCard from Sugar and

transfer this contact's information to
another application (e.g. Outlook)

Find Duplicates Locate potential duplicates of this
contact

Copy Duplicate this contact to create a new
contact

Historical Summary View a historical summary of activities
(e.g. calls, meetings, etc.) related to this
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contact
View Audit Log View a record of changes to this contact
View Personal Info Display this record's fields which an

admin has designated as personal
information

Delete Delete this contact

Contact Creation via Sugar Portal

The Sugar Portal allows your customers to file bugs, cases, and review knowledge
base articles created in Sugar. Please note that customers have to be registered
users of the portal in order to be able to access the portal. When a potential portal
user visits the portal login page and completes the registration form, their
information is entered into Sugar as a new contact record with the Lead Source
field set to "Support Portal User Registration". Once the contact record is
validated and approved for portal access, you can enable the Portal Active
checkbox to activate their portal account. For more information on managing the
Sugar portal, please refer to the Portal Deployment User Guide.

Emails and Contacts

Contacts include an email address that can be used to email the contact as a
recipient. The methods for doing so are covered in the Emailing Records section of
the User Interface documentation. Contacts may also be recipients of campaigns
that allow you to send email messages to a large group of recipients as well as to
track the results of that message. Please refer to the Campaigns and Contacts
section of this page for more information. In addition to being a recipient or sender
of an email, contacts may be related to emails by being selected in the email's
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Related To field. These relationships allow the contact to display all relevant email
correspondence in the Emails subpanel and History dashlet on a contact's record
view.

Emails Subpanel

The Emails subpanel in the Contacts module displays emails which are associated
with the contact record in a variety of ways:

Explicitly related to the contact : If the contact is selected in the email's
Related To field, the email and contact are explicitly related, and the email
will appear in the contact's Emails subpanel and History dashlet.
Instructions for using this flex relate field are available in the Emails
documentation.
Implicitly related to the contact : If one of the contact's email addresses
appears in the email's From, To, or Cc fields, the email and contact are
implicitly related, and the email will appear in the contact's Emails
subpanel and History dashlet. This implicit relationship is made for emails
sent from Sugar as well as any email imported into Sugar via Inbound
email contacts or email archiving.

The Emails subpanel allows the following functions to be performed:

Email Details : To view the details of an email, click the subject to open it
in detail view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation in the
Administration Guide.

Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
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Compose a New Email : Click the Plus button on the upper right of a
subpanel to create a new email with, by default, both an implicit and
explicit relationship to the contact you are currently viewing. The email will
automatically select the contact in the Related To field as well as add the
contact's primary email address as a recipient in the To field.

Note: To send email from Sugar, users must configure their
outbound email server via Emails > Email Settings or, if using the
system email account to send email, the system's outbound email
server must be configured by an administrator in Admin > System
Email Settings.
Note: Because creating a new related record opens a drawer on top
of the current record view, you should use the Cancel button to
return to record view. Using the browser's back button will return
you to the previous page.

More Records : By default, Sugar displays up to five records in each
subpanel, though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related records exist, click "More {Module Name}..."
(e.g. "More Emails...") at the bottom of the subpanel to load the next set of
records.

Calls, Meetings, and Contacts

Contacts can be related to calls and meetings in two ways. First, they can be
selected in the event's Related To field, indicating that the contact was the topic of
the call or meeting. Second, they can be included as invitees to the call or
meeting. 
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Calls and Meetings Subpanels

Each contact's record view includes a Calls subpanel and a Meetings subpanel.
These subpanels display all calls and meetings which include the contact as an
attendee. If the contact is not an attendee but is selected in the call's or meeting's
Related To field, the call or meeting will not appear in the subpanels.

When relating an existing call or meeting to a contact via the subpanels on a
contact's record view, the contact will automatically be added as an invitee. When
creating a call or meeting from the subpanels, the contact will automatically be
added as an attendee and the contact's account will automatically be set in the
event's Related To field.

Campaigns and Contacts

Sugar's Campaigns module can be used to send mass emails or a series of
newsletter emails to Sugar accounts, contacts, leads, and targets. The results of
each campaign are recorded to measure its impact. Contacts are not related
directly to campaigns. Rather, each campaign is related to several target list
records, and each target list is related to contacts and other recipients. To send a
campaign email to a contact, the contact should belong to a default-type target list
related to the campaign. To prevent a contact from receiving emails from a
campaign, the contact should belong to the campaign's suppression list-type target
list. Once a campaign is sent, the results specific to a particular contact will appear
in the Campaign Log Subpanel on the contact's record view as described in the 
Campaign Log Subpanel section of this page.

Contacts can be added to target lists via the target list record itself, from the
Contacts list view using the Add To Target List option, or from the Contacts record
view using the Manage Subscriptions option. Instructions for using the Add To
Target List and Manage Subscriptions options in the Contacts module are provided
in the sections below. For instructions on other available methods of adding to
target lists, please refer to the Target Lists documentation.

Adding to a Target List via Contacts List View

A target list consists of a group of individuals or organizations you wish to be
included or excluded from a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add contacts
to a target list in Sugar including using the Add To Target List option from the
Contact list view's Mass Actions Menu. For more information on target lists and
other methods of adding contacts, please refer to the Target Lists documentation.
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You can use the Select All feature in the list view when adding to a target list,
which will allow you to easily select the first 1000 records in the result set. If you
wish to add more than 1000 records or add a specific group of records to the
target list, please use the filter option in list view search to perform the additions
in smaller batches. 

Use the following steps to add accounts to a target list via the Contacts list view:

Navigate to the Contacts list view by clicking the Contacts module tab.
Use the List View Search to find the Contact records you wish to add to a
target list.
Select the desired contact records then choose "Add to Target List" from
the Mass Actions menu.

Below the search bar, locate and select the desired target list in the
dropdown list or click "Create new target list" to add the contacts to a new
target list. Click "Update" to add the record(s) to the target list.

In order to view the contacts that have been added, you can navigate to the Target
Lists module. Click the target list's name to open the record view, and you will see
the contact records within the Contacts subpanel.
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Managing Contact Subscriptions

Contacts who receive newsletter-type campaign emails from your Sugar instance
are considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from the Contacts record view using the Manage Subscriptions
option in the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
or more default-type target lists. Contacts are added to these target lists in order
to receive your newsletter. The Manage Subscriptions option allows you to add a
contact to the default-type or suppression-type target lists of your newsletter
campaigns without leaving the Contacts module. For more information on
newsletter subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage contact subscriptions via a contact's record
view:

Navigate to a contact's record view.
Select "Manage Subscriptions" from the Actions menu.

To add the contact to a newsletter subscription mailing list, select the
newsletter from the Available/Newsletters Unsubscribed To list and drag it
to the Newsletters Subscribed To list. This will add the contact to the
campaign's default target list.
To remove the contact from the newsletter subscription mailing list, select
the newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign
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which will prevent the contact from receiving the newsletter. Please note
that the contact will not be removed from the campaign's default target list.

Click "Save" to preserve your changes.

Campaign Log Subpanel

The Campaign Log subpanel contains historical information regarding a contact's
interaction with all Sugar campaigns. When a mass marketing campaign is sent to
a contact (or manually marked as sent in the case of non-email campaigns), the
related campaign activity information will appear within the Campaign Log
subpanel on the contact's record view. This information mirrors the "View Status"
page available from within each individual campaign and shows activities such as
when a campaign was sent, when the recipient viewed the campaign message,
when the recipient clicked a tracked link within the campaign, etc. Since this
subpanel contains historical campaign interactions for the contact, it cannot be
used to associate a contact with a campaign or otherwise manage a campaign or
target list. For more information on associating a contact with a campaign, please
refer to the Adding to a Target List via Contacts List View section of this page. For
more information on campaigns, please refer to the Campaigns documentation.

The Campaign Log subpanel allows the following functions to be performed:

Campaign Details : To view the details of a campaign, click its name to
open it in detail view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
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or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.
Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For more
information, please refer to the System documentation in the
Administration Guide.
Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
More Records : By default, Sugar displays up to five records in each
subpanel though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related records exist, click "More {Module Name}..."
(e.g. "More campaign log...") at the bottom of the subpanel to load the next
set of records.

Converting Leads to Contacts

Sugar enables you to convert lead records to contact records as you determine
that they qualify for your organization's definition of a contact (e.g. after an
evaluation/qualification process or upon entering into business with the
individual). When the lead is converted, a new contact record is created with a
relationship to the original lead record. For more information on converting leads,
please refer to the Leads documentation.

Use the following steps to convert leads into contacts:

Navigate to a lead's record view.
Select "Convert" from the Actions menu or click the Unconverted button to
initiate the lead conversion process.
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Note: Sugar will automatically perform a duplicate check for the modules
(e.g. Contacts) on the Convert Lead page.

If there are no duplicate records found for a module (e.g. Contacts), the
new record will be automatically marked for creation on the Convert Lead
page and associated to the lead. The panel will be collapsed as well, but
you can click the header to open the panel and view the record's details.
If there are duplicate records found for a module (e.g. Contacts), they will
display in a list view within the panel. You can select an existing contact, or
if none of the suggested duplicates are valid, simply click "Ignore and
create new" to create a new contact record.

Some of the fields (e.g. address, phone) on the displayed record view will
be pre-populated with the lead's values. Simply update any necessary fields
then click the Create Contact button.

Complete the other module panels (Accounts, Opportunities) accordingly
on the Convert Lead page.
Once all of the necessary information is entered and the appropriate panels
are completed, click "Save and Convert".
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Once the lead has been converted successfully, the lead's record view will display
the converted contact, account, and opportunity information below the record's
detail. You can click the Preview icon to the far right of each record's row to view
the details of the converted contact and other records.

vCards and Contacts

vCards are electronic business cards that are exchanged between applications
such as email and web browsers. Contacts may be created from vCards generated
by another application or saved as vCards for use in other software.

Creating Contacts via vCard

Use the following steps to create a contact in Sugar via vCard:

1. Click the triangle in the Contacts module tab and select "Create Contact
From vCard".
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2. Choose the vCard file from your computer and click "Create".

Downloading a Contact's vCard

The following steps cover downloading a vCard and saving it as a contact in
Microsoft Outlook as an example:

1. Navigate to a Contacts record view.
2. Select "Download vCard" from the Actions menu to download the vCard

file.

3. Open the downloaded file in your mail or address book application. For this
example, double clicking opens the vCard in Outlook.

4. Make any necessary changes to the information, then click "Save & Close"
to save this lead in Outlook.
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Accounts

Overview

Sugar's Accounts module consists of companies with whom your organization has a
relationship. It is generally seen as the hub for managing and analyzing your
business' interactions with each company. Each account record may then relate to
other Sugar records such as contacts, meetings, cases, opportunities, and many
others as your relationship with the customer matures. This documentation will
cover information and actions specific to the Accounts module. For instructions
concerning views and actions which are common across most Sugar modules, such
as creating, editing, and deleting accounts, please refer to the Working With Sugar
Modules section of this page.

Please note that you will only be able to see account records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Account Fields

The Accounts module contains a number of stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
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User Interface documentation. The definitions below are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Alternate Phone The account's alternate phone
Annual Revenue The company's annual revenue
Assigned To The Sugar user assigned to the account
Billing Address The account's billing address
Business Center Name 1 The business center responsible for

managing this account. This field is only
available to Sugar Serve and Sugar Sell
users.

In Sugar Serve, new cases inherit their
account's business center which is then
used for SugarBPM business hour
calculations. For more information,
refer to the Business Centers and
Accounts section of this page.

In Sugar Sell, leads' business centers
are used for SugarBPM business hour
calculations during lead routing. For
more information, refer to the Stock
SugarBPM Templates documentation.

Campaign 2 The campaign, if any, from which the
account originated

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Copy Address From Left Select the box to copy the account's
billing address to the shipping address
field
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Date Created The date the account record was
created

Date Modified The date the account record was last
modified

Date of Next Renewal For instances using revenue line items,
the Date of Next Renewal will show the
earliest expected close date from all of
the account's related revenue line items
that meet the following criteria:

Type = "Existing Business"
Service = Yes
Renewable = Yes
Sales Stage is NOT "Closed
Won" or "Closed Lost"

For more information on renewable
services, refer to the Opportunities
documentation. Please note that this
field is hidden from views by default and
must be added by an administrator via 
Studio.

Description A description or other information about
the account

DUNS The unique 9-digit number associated
with the company in D&B

Email Address The account's email address
Employees The number of employees at the

company
Facebook Account The account's Facebook account

information
Fax The account's fax number
Google Plus ID The account's Google Plus ID
Industry The industry type to which the company

belongs
Name When viewing, the account's name
Office Phone The account's office number
Ownership Indicate if the company is privately or

publicly owned
Member Of Designate a parent-child relationship
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between the account and another
account in Sugar

Rating The rating for the company compared to
other companies in Sugar

Service Level The contractual level of service (e.g.
Tier 1, Tier 2) for the account which, for
Sugar Serve, is used by the stock
SugarBPM template to calculate case
follow-up dates

Shipping Address The account's shipping address
SIC Code The Standard Industrial Classification

(SIC) code for the account
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
account record

Ticker Symbol The stock trading symbol for the
company

Twitter Account The account's Twitter account
information

Type The account type (e.g. customer,
investor, etc.)

Website The website URL associated with the
account

1 This field's value is only visible to Sugar Serve and Sugar Sell users; when this
field appears on layouts, users without a supported license type will see a
placeholder containing the text "License Required" instead of the field's value. See
the User Management page for more details on license types.
2 This field's value is not visible to Sugar Serve users; when this field appears on
layouts, users without a supported license type will see a placeholder containing
the text "License Required" instead of the field's value. See the User Management
page for more details on license types.

Working With Sugar Modules
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While the Accounts module has some features that only apply to accounts, it also
uses the Sidecar user interface that most Sugar modules are based on. In the table
below, the left column contains links to the User Interface page covering topics
that are applicable to all Sidecar modules. The right column has links to sections of
the current page that cover topics specific to accounts.

General Instructions for Working
With Sugar Modules

Accounts-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Accounts-specific help exists for
each topic, use the links below to
navigate to sections of the current page.

Creating Records Creating via Lead Conversion
Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Emailing Records Emails and Accounts

Campaigns and Accounts
Exporting Records
Recalculating Calculated Values
Finding Duplicate Records
Merging Records
Viewing Record Historical Summaries
Viewing Record Audit Logs
Record PDFs
Favoriting Records
Following Records
Sharing Records

Account Menus

The Accounts module contains various options and functionality which are
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available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Accounts-specific
functionality, within this page.

Module Tab Menus

The Accounts module tab is typically located on the navigation bar at the top of
any Sugar screen. Click the tab to access the Accounts list view. You may also click
the triangle in the Accounts tab to display the Actions, Recently Viewed, and
Favorites menus. The Actions menu allows you to perform important operations
within the module. The Recently Viewed menu displays the list of accounts you
most recently viewed. The Favorites menu displays the list of accounts you most
recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Account Opens the record view layout to create a

new account
View Accounts Opens the list view layout to search and

display accounts
View Account Reports Displays existing reports based on the

Accounts module
Import Accounts Opens the import wizard to create or

update accounts using external data
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If you do not see the Accounts module tab in Sugar, please check the following:

The Accounts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Accounts module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Accounts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Accounts module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Accounts list view displays all account records and allows for searching and
filtering to locate specific accounts. You can view the basic details of each record
within the field columns of the list view or click an account's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual account records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Email Email one or more accounts at a time
Mass Update Mass update one or more accounts at a

time
Add to Target List Add one or more accounts to a target

list
Merge Merge two or more duplicate accounts
Delete Delete one or more accounts at a time
Export Export one or more accounts to a CSV

file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual account directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this account in the intelligence

pane
Edit Edit this account
Follow Follow this account
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Delete Delete this account

Record View Actions Menu

The Accounts record view displays a single account in full detail including its
fields, subpanels of related records, and activity stream. To access an account's
record view, simply click a hyperlinked account name from anywhere within Sugar.
The record view's Actions menu appears on the top right of the page and allows
you to perform various operations on the current record.

The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this account
Share Share a link to this account via email
Download PDF Download account information as a PDF

file
Email PDF Email account information as a PDF

attachment
Find Duplicates Locate potential duplicates of this

account
Copy Duplicate this account to create a new

account
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Historical Summary View a historical summary of activities
(e.g. calls, meetings, etc.) related to this
account

View Audit Log View a record of changes to this account
View Personal Info Display this record's fields which an

admin has designated as personal
information

Delete Delete this account

Business Centers and Accounts

Business centers, available exclusively to Sugar Serve and Sugar Sell users,
represent your company's centers of operation and specify a time zone, operating
hours, and holidays so that a concept called "Business Hours" can be leveraged in
SugarBPM. Each account's selected business center can be used for SugarBPM
business hour calculations.

Sugar Serve's stock SugarBPM template uses each case's business center which is
inherited from the case's account at the point of creation. For more information,
refer to the Cases documentation. If your organization does not wish to specify
various business centers on accounts and cases, the stock templates can be
modified to use a static business center. Refer to the Getting Started With
SugarBPM for Sugar Serve and Stock SugarBPM - Case Follow-Up Date
Management articles for help configuring the stock template and your instance to
work together.

Sugar Sell's stock lead-routing SugarBPM template uses each account's business
center for task due-date calculations using business hours. For more information,
refer to the Stock SugarBPM Templates documentation.

Once business centers have been set up by an admin or Business Center
Administrator, Sugar Serve and Sugar Sell users can simply select the appropriate
business center in the Business Center Name field on the account record. For
more information on creating and configuring business centers, refer to the 
Business Center Management documentation. 

Emails and Accounts

Accounts include an email address which can be used to email the account as a
recipient. The methods for doing so are covered in the Emailing Records section of

                       385 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Record_Historical_Summaries
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Record_Audit_Logs
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Personal_Information
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Cases#Business_Centers_and_Cases
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/SugarBPM/Stock_SugarBPM_Templates#Route_Lead_and_Create_Follow-Up_Task
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Business_Center_Management#Creating_a_Business_Center_Administrator
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Business_Center_Management#Creating_a_Business_Center_Administrator
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Business_Center_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Emailing_Records


 

the User Interface documentation. Accounts may also be recipients of campaigns
that allow you to send email messages to a large group of recipients as well as to
track the results of that message. Please refer to the Campaigns and Accounts
section of this page for more information. In addition to being a recipient or sender
of an email, accounts may be related to emails by being selected in the email's
Related To field. These relationships allow the account to display all relevant email
correspondence in the Emails subpanel and History dashlet on an account's record
view. An account's Emails subpanel and History dashlet may also display emails
belonging to the contacts related to the account.

Emails Subpanel

The Emails subpanel in the Accounts module displays emails which are associated
with the account record in a variety of ways:

Explicitly related to the account : If the account is selected in the
email's Related To field, the email and account are explicitly related, and
the email will appear in the account's Emails subpanel and History dashlet.
Instructions for using this flex relate field are available in the Emails
documentation.
Implicitly related to the account : If one of the account's email
addresses appears in the email's From, To, or Cc fields, the email and
account are implicitly related, and the email will appear in the account's
Emails subpanel and History dashlet. This implicit relationship is made for
emails sent from Sugar as well as any email imported into Sugar via
Inbound email accounts or email archiving.
Related to the account's related contacts : If the email is related, either
explicitly or implicitly, to a contact record that belongs to the account, the
email will appear in the account's Emails subpanel and History dashlet.

Note: Administrators can enable or disable an account from
displaying related contact emails via Admin > Related Contacts
Emails. For more information, please refer to the Emails
documentation in the Administration Guide.

For more information on working with subpanels, please refer to the User
Interface documentation.

Campaigns and Accounts

Sugar's Campaigns module can be used to send mass emails or a series of
newsletter emails to Sugar accounts, contacts, leads, and targets. The results of
each campaign are recorded to measure its impact. Accounts are not related
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directly to campaigns. Rather, each campaign is related to several target list
records, and each target list is related to accounts and other recipients. To send a
campaign email to an account, the account should belong to a default-type target
list associated with the campaign. To prevent an account from receiving emails
from a campaign, the account should belong to the campaign's suppression list-
type target list. Once a campaign is sent, the results specific to a particular
account will appear in the Campaign Log Subpanel on the account's record view as
described in the Campaign Log Subpanel section of this page.

Accounts can be added to target lists via the target list record itself or from the
Accounts list view as described below. For instructions on other available methods
of adding to target lists, please refer to the Target Lists documentation.

Adding to a Target List via Accounts List View

A target list consists of a group of individuals or organizations you wish to be
included in or excluded from a mass marketing campaign. These targets are
typically identified based on a set of predetermined criteria such as being a
prospect or existing customer, age group, industry, etc. There are various ways to
add accounts to a target list in Sugar including using the Add To Target List option
from the Account list view's Mass Actions Menu. For more information on target
lists and other methods of adding accounts, please refer to the Target Lists
documentation.

You can use the Select All feature in the list view when adding to a target list,
which will allow you to easily select the first 1000 records in the result set. If you
wish to add more than 1000 records or add a specific group of records to the
target list, please use the filter option in the list view search to perform the
additions in smaller batches. 

Use the following steps to add accounts to a target list via the Accounts list view:

Navigate to the Accounts list view by clicking the Accounts module tab.
Use the List View Search to find the Account records you wish to add to a
target list.
Select the desired account records then choose "Add to Target List" from
the Mass Actions menu.
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Below the search bar, locate and select the desired target list in the
dropdown list or click "Create new target list" to add the accounts to a new
target list. Click "Update" to add the record(s) to the target list.

In order to view the accounts that have been added, you can navigate to the Target
Lists module. Click the target list's name to open the record view, and you will see
the account records within the Accounts subpanel.

Campaign Log Subpanel

The Campaign Log subpanel contains historical information regarding an account's
interaction with all Sugar campaigns. When a mass marketing campaign is sent to
an account (or manually marked as sent in the case of non-email campaigns), the
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related campaign activity information will appear within the Campaign Log
subpanel on the account's record view. This information mirrors the "View Status"
page available from within each individual campaign and shows activities such as
when a campaign was sent, when the recipient viewed the campaign message,
when the recipient clicked a tracked link within the campaign, etc. Since this
subpanel contains historical campaign interactions for the account, it cannot be
used to associate an account with a campaign or otherwise manage a campaign or
target list. For more information on associating an account with a campaign,
please refer to the Adding to a Target List via Accounts List View section of this
page. For more information on campaigns, please refer to the Campaigns
documentation.

For more information on working with subpanels, please refer to the User
Interface documentation.

Leads and Accounts

Once a lead has been evaluated and qualified, it can be converted into an account
in addition to a contact and opportunity. Please note that Sugar automatically
checks for any duplicate records in the system when converting the lead. The
Convert Lead page will display any records that are detected as duplicates in a list
view within the module panels (e.g. Account). You can either select the existing
record or create a new record as necessary. For more information on lead
conversion and creating new records, please refer to the Leads documentation.

Creating via Lead Conversion

Sugar enables you to create a new account record during the lead conversion
process. For more information about lead conversion, please refer to the Leads
documentation.
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Use the following steps to create an account during lead conversion:

Navigate to a Leads record view.
Select "Convert" from the Actions menu or click the Unconverted button to
initiate the lead conversion process.

If there are no duplicate records found for a module (e.g. Contacts) in lead
conversion, the new record will be automatically marked for creation on
the Convert Lead page and related to the lead. The panel will be collapsed
as well, but you can click the header to open the panel and view the
record's details.
If there are duplicate records found for a module (e.g. Accounts), you can
either select an existing account or create a new account record if none of
the suggested duplicates are valid. Click "Ignore and create new" to create
a new account record.

Some of the fields (e.g. address, phone, etc.) on the displayed record view
will be pre-populated with the lead's values. Simply update any necessary
fields then click the Create Account button.

Note: You can click "Save and Convert" at the top of the page if you wish to
convert the lead at this point. However, if you wish to create or relate an
opportunity record to the lead as well, please complete the Opportunity panel on
the Convert Lead page before saving and converting.
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Once the lead has been converted successfully, the lead's record view will display
the converted contact, account, and opportunity information below the record's
detail. You can click the Preview icon to the far right of each record's row to view
the details of the converted account and other records.

Last Modified: 2020-11-20 16:57:10

Revenue Line Items
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Overview

Sugar's Revenue Line Items module consists of individual line items of potential
business that are included on an opportunity record and tracked through the sales
life cycle. The opportunity record acts as a header for one or more revenue line
item records. This allows for greater granularity when working opportunities and
forecasting since each line item within an opportunity can have its own sales stage
and probability as well as being included or excluded from a user's forecasting
worksheet individually. For more information about how opportunities and revenue
line items interact, please refer to the Opportunities and Revenue Line Items
section of this page.

Each revenue line item may be related to a product from your organization's
Product Catalog. Doing so will cause the product's values to automatically populate
matching fields on the revenue line item. For more information, please refer to the 
Products and Revenue Line Items section of this page.

Before continuing, be aware of the following access and visibility notifications:

You will only be able to see revenue line item records as allowed by your
team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and 
Role Management documentation in the Administration Guide.
The Revenue Line Items module is not available for Sugar Serve and Sugar
Professional users. For more information on license types and the
functionality available for each type, refer to the User Management
documentation.
If your instance is configured to use opportunities alone without revenue
line items, please refer to the Opportunities documentation in the Sugar
Professional Application Guide. For more information about changing your
opportunities model via Admin > Opportunities, please see the 
Opportunities Configuration documentation in the Administration Guide.

This documentation will cover information and actions specific to the Revenue Line
Items module. For instructions concerning views and actions which are common
across most Sugar modules, such as creating, editing, and deleting line items,
please refer to the Working With Revenue Line Items section of this page. 

Revenue Line Item Fields

The Revenue Line Items module contains a number of stock fields that come out-of-
the-box with Sugar. For information on using and editing various field types, refer
to the User Interface documentation. The definitions below are suggested
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meanings for the fields, but the fields can be leveraged differently to best meet
your organization's needs. Administrators or users with developer-level role access
have the ability to alter, add, or remove fields via Admin > Studio. For more
information on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Account Name1 The account to which the related

opportunity belongs
Assigned To The Sugar user assigned to the revenue

line item
Associated Quote The quote that was generated based on

this revenue line item

Each revenue line item may only be
included on a single quote which may
only be generated once.

Best The most optimistic amount that may be
won for the revenue line item 

The amount will display in the system
default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Revenue Line Items
section of this page.

If no value is provided, the Best field
will be automatically filled with the
value of the Likely field or the value of
the Calculated Revenue Line Item
Amount field.

Unless the sales stage is set to "Closed
Lost", the revenue line item's Best value
will roll up into the parent opportunity.

Calculated Revenue Line Item Amount1 The line item's calculated value based
on the Quantity, Unit Price, and Total
Discount Amount fields
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Note: This value is automatically
calculated and cannot be directly
modified. To adjust the Calculated
Revenue Line Item Amount, you must
edit the revenue line item's quantity,
discount, or unit price.

Campaign The campaign, if any, from which the
revenue line item opportunity originated

Category The category to which the revenue line
item's product belongs

Note: The default value is populated
with the Parent value of a selected
product and may be modified manually.
For more information on creating
product categories, please refer to the 
Product Catalog documentation in the
Application Guide.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Cost The actual cost of the revenue line
item's product

The amount will display in the system
default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Revenue Line Items
section of this page.

Note: The value is automatically
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populated based on the selected product
and may not be modified manually

Date Created The date the revenue line item record
was created

Date Modified The date the revenue line item record
was last modified

Description A description or other information about
the revenue line item

Expected Close Date The date when the revenue line item is
expected to close or already has closed

Forecast The revenue line item's commit range
for forecasting (e.g. "Include",
"Exclude", etc.)

Note: The available values are
determined by the Ranges configuration
in Admin > Forecasts. For more
information on configuring forecasting
ranges, please refer to the Forecasts
documentation in the Administration
Guide.

Lead Source The source (e.g. Trade Show) from
which the revenue line item opportunity
originated

Likely The most likely amount that may be won
for the revenue line item

The amount will display in the system
default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Revenue Line Items
section of this page.

If no value is provided, the Likely field
will be automatically filled with the
value of the Calculated Revenue Line
Item Amount field.
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Unless the sales stage is set to "Closed
Lost", the revenue line item's Likely
value will roll up into the parent
opportunity.

List Price1 The list price of the revenue line item's
selected product

Mft Part Number1 The manufacturer's part number for the
revenue line item's product, if any,
selected from the Product Catalog

Modified by Name The Sugar user who last modified the
revenue line item record

Next Step The succeeding stage of the revenue
line item's sales cycle

Opportunity Name The opportunity to which the revenue
line item belongs

Probability (%) The revenue line item's current
likelihood of being won

Note: This value is calculated based on
the selected Sales Stage and cannot be
edited.

Product1 The product's name as selected from the
product catalog list or manually entered
as new

Note: For more information on creating
and managing the product catalog,
please refer to the Product Catalog
documentation in the Application Guide.

Quantity The number of products being
purchased

Renewable2 For line items with "Service" enabled,
select whether or not the service offered
can be renewed for additional time
periods. The Renewable field is used to
trigger pipeline automation, which
automatically generates new
opportunities for the subsequent period
when a renewable service is sold.

Service1,2 Designate this line item as a service.
Enabling the Service field will make the
Service Duration (required), Service
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Start Date (required), and Renewable
fields available.

Service Duration1,2 For line items with "Service" enabled,
the period of time that this service
covers. The Service Duration and
Service Start Date fields are used to
calculate the Service End Date and,
when the Renewable field is set to yes,
the Service Duration will determine the
expected close date for future service
opportunities.

Service Start Date2 For line items with "Service" enabled,
select the date that the service will
begin. The Service Duration and Service
Start Date fields are used to calculate
the Service End Date. This field is
inherited from the product catalog but
can be edited on a line-item basis.

Service End Date2 For line items with "Service" enabled,
the Service End Date is calculated using
the Service Duration and Service Start
Date fields. Because this field is
automatically calculated, it cannot be
edited directly.

Sales Stage The revenue line item's current state in
the sales process (e.g. Prospecting,
Qualification, etc.)

Note: When the revenue line item's
sales stage is set to "Closed Lost", the
values (e.g. Likely, Best, etc.) associated
with the revenue line item no longer roll
up into the parent opportunity. 

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Tax Class1 Tax classification (e.g. taxable, non-
taxable) for the revenue line item's
product, if any, selected from the
Product Catalog
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Teams The Sugar team(s) assigned to the
revenue line item record

Total Discount Amount The amount of the discount provided for
the revenue line item

Type The type of the revenue line item's
business (e.g. New Business or Old
Business)

Unit Price1 The unit price of the revenue line item's
product

The amount will display in the system
default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Revenue Line Items
section of this page.

Weight The weight of the product, if any,
selected from the Product Catalog

Worst The least optimistic amount that may be
won for the revenue line item

The amount will display in the system
default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Revenue Line Items
section of this page.

If no value is provided, the Worst field
will be automatically filled with the
value of the Likely field or the
Calculated Revenue Line Item Amount
field.
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Unless the sales stage is set to "Closed
Lost", the revenue line item's Worst
value will roll up into the parent
opportunity.

1. When a revenue line item is related to a product catalog record, this value
automatically populates from the related product and cannot be modified
on the revenue line item record. For more information on creating and
managing records in the Product Catalog, please refer to the Product
Catalog documentation in the Application Guide.

2. For more information on service-related fields, refer to the Services and
Renewable Revenue Line Items section of the Opportunities
documentation.

Sales Stages

A sales stage identifies the current stage (e.g. Prospecting, Qualification, etc.) that
the revenue line item is in during the sales cycle. When you select a sales stage in
the revenue line item record, the system automatically populates the
corresponding probability value (e.g. 10, 20, etc.) in the Probability (%) field.
These probability values are a useful tool as it helps calculate and predict your
sales forecast for a specified time period. For more information on the Forecasts
module, please refer to the Forecasts documentation. Administrators have the
ability to configure the sales stage and probability values for each sales stage via
Admin > Dropdown Editor. For more information, please refer to the Adding
Custom Sales Stages and Probabilities to Opportunities article.

Please note that the below values are only guidelines for defining your sales stage,
and you can skip one or more stages based on your organization's needs.

Sales Stage Probability Suggested Definition
Prospecting 10 This is the first stage in

the sales process and
indicates that the
opportunity or revenue
line item with this
prospect is new and needs
to be qualified by a sales
representative.

Qualification 20 The sales representative is
currently interacting with
the prospect to determine
if a sales opportunity
exists.
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Needs Analysis 25 After determining that the
prospect has an interest in
the products or services,
the sales representative
now uncovers the
prospect's business
challenges.

Value Proposition 30 After uncovering the
prospect's business
challenges, the sales
representative now maps
the company's products
and/or services to the
prospect's business
challenges and describes
the value of the solution.

Id. Decision Makers 40 After determining that
there is a match between
the prospect's business
challenges and the
company's products
and/or services, the sales
representative now
identifies the decision-
makers necessary to close
this opportunity or
revenue line item.

Perception Analysis 50 The sales representative
analyzes the prospect's
perceived value of the
company's solution at this
stage in order to prepare
the appropriate
combination of products
and services for the sales
quote.

Proposal/Price Quote 65 The sales representative
delivers the proposal,
sometimes called the price
quote, to the prospect.

Negotiation/Review 80 The sales representative
reviews and negotiates the
proposal with the
prospect.
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Closed Won 100 The sales representative
has won this opportunity
or revenue line item and
the company can now bill
the customer.

Closed Lost 0 The sales representative
has lost this opportunity
or revenue line item.

Working With Revenue Line Items

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Revenue Line Items section
describe Revenue Line Items-specific behaviors and functionality. 

Content Link Description
Creating Revenue Line Items
Basic Revenue Line Item Creation
Creating via Quick Create
Creating via Subpanels
Creating via Duplication
Importing Revenue Line Items

The Creating Records section covers the
various methods of creating new
revenue line item records, including via
the Create button in the Revenue Line
Items module, the Quick Create menu
on the upper right of every Sugar page,
via the Revenue Line Items subpanel on
related modules, duplication of an
existing revenue line item record, and
importing a list of revenue line items
into Sugar using a .csv spreadsheet.

Viewing Revenue Line Items
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing revenue
line item records, including via the
Revenue Line Items list view and record
view, the Recently Viewed menu in the
Revenue Line Items module tab, activity
stream entries concerning revenue line
item updates or where a user mentions
a revenue line item, previewing revenue
line items in the right-hand side panel,
and reports displaying revenue line item
data.

Searching for Revenue Line Items
Global Search

The Searching for Records section
provides an introduction to the two
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List View Search
Creating a Filter
Saving a Filter

searching methods for locating revenue
line items: global search, which
searches across all Sugar modules, and
list view search, which searches and
filters within the Revenue Line Items
module.

Revenue Line Items List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Revenue Line Items
Activity Stream
Dashboards

The List View section walks through the
many elements of the Revenue Line
Items List View layout which contains a
filterable list of all revenue line item
records in Sugar. While the generic
menu options are described in the User
Interface sections linked to the left, the
options specifically available in the
Revenue Line Items list view are
described in the List View Mass Actions
Menu and List View Record Actions
Menu sections of this page.

Revenue Line Items Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Record View section walks through
the many elements of the Revenue Line
Items Record View layout which
contains detailed information about a
single revenue line item record. While
the generic menu options are described
in the User Interface sections linked to
the left, the options specifically
available in the Revenue Line Items
record view are described in the Record
View Actions Menu section of this page.

Editing Revenue Line Items
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
revenue line item records, including
inline via the Revenue Line Items record
view, in full edit mode on the record
view, inline via the Revenue Line Items
subpanel on related module records,
inline via the Revenue Line Items list
view, and via the Mass Update option on
the list view.
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Deleting Revenue Line Items
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted revenue line items, including
via the Revenue Line Items record view,
an individual record's Actions menu on
the Revenue Line Items list view, and
the Mass Actions menu on the list view.

Note: A revenue line item may be
deleted only if its Status field is not set
to "Closed Won" or "Closed Lost". For
data integrity purposes, closed revenue
line items may not be deleted.

Exporting Revenue Line Items The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of revenue line items
and all their data as a .csv file for use
outside of Sugar (e.g. in Microsoft
Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Revenue Line Items The Finding Duplicate Records section
provides instructions for locating
duplicate revenue line item records. If
searching on matching fields (e.g.
Name) identifies one or more duplicates,
they can be merged into a single record.

Merging Revenue Line Items
Merging via List View

The Merging Records section provides
instructions for merging duplicate
revenue line items which will combine
field values and related records into a
single revenue line item.

Viewing Revenue Line Item Historical
Summaries

The Viewing Record Historical
Summaries section describes the
Historical Summary record view option
which displays quick details of the
revenue line item record's related calls,
meetings, emails, notes, and tasks.

Viewing Revenue Line Item Audit Logs The Viewing Record Audit Logs section
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describes the View Audit Log record
view option which displays a history of
changes to the revenue line item's
audited fields.

Revenue Line Item PDFs
Downloading Revenue Line Item PDFs
Emailing Revenue Line Item PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
email .pdf files of revenue line item
information as configured by an
administrator via Admin > PDF
Manager.

Favoriting Revenue Line Items
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking revenue line items as favorites,
including via the Revenue Line Items list
view, Revenue Line Items record view,
or any Revenue Line Items subpanel
appearing on the record view of a
related module. Favoriting a revenue
line item allows you to easily access it
from list views, dashlets, or the Revenue
Line Items module tab.

Following Revenue Line Items
Following via List View
Following via Record View

The Following Records section describes
the various methods of marking revenue
line items as "Following", including via
the Revenue Line Items list view and
record view. Following a revenue line
item causes its activity stream updates
to be included on your Home page and
Revenue Line Items list view activity
streams so that you can easily keep up
with changes and user posts on the
record.

Sharing Revenue Line Items The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the revenue line item record. If
the recipient is logged into Sugar,
clicking the link will bring them directly
to the revenue line item's record view.

Revenue Line Item Menus
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The Revenue Line Items module contains various options and functionality which
are available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with a link to more information about
each option in the User Interface documentation or, for Revenue Line Items-
specific functionality, within this page. 

Module Tab Menus

The Revenue Line Items module tab is typically located under the More tab of the
navigation bar at the top of any Sugar screen. Sugar normally displays the top six
modules shown in the Display Modules list of your user preferences with the
remaining displayed modules grouped under the More tab. For more information
on displayed modules for the navigation bar, please refer to the Layout Options
section of the Getting Started documentation.

Click the tab to access the Revenue Line Items list view. You may also click the
triangle in the Revenue Line Items tab to display the Actions, Recently Viewed, and
Favorites menu. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of revenue line items you
most recently viewed. The Favorites menu displays the list of revenue line items
you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Revenue Line Item Opens the record view layout to create a

new revenue line item
View Revenue Line Items Opens the list view layout to search and

display revenue line items
Import Revenue Line Items Opens the import wizard to create or
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update revenue line items using
external data

If you do not see the Revenue Line Items module tab in Sugar, please check the
following:

The Revenue Line Items module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed.
Navigate to your user profile (upper right of Sugar), click the Advanced
tab, and check the Layout Options section. If you see the Revenue Line
Items module in the Hide Modules list, simply move it to the Display
Modules list. For more information on hiding and displaying modules,
please refer to the Layout Options section of the Getting Started
documentation.
The administrator may have disabled the Revenue Line Items module for
your entire Sugar instance. Reach out to your Sugar administrator to have
the Revenue Line Items module displayed. For more information on
displaying and hiding modules throughout Sugar, please refer to the 
Developer Tools documentation in the Administration Guide.

List View Menus

The Revenue Line Items list view displays all revenue line item records and allows
for searching and filtering to locate specific revenue line items. You can view the
basic details of each record within the field columns of the list view or click a
revenue line item's name to open the record view. To access a module's list view,
simply click the module's tab in the navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual revenue line item records or
click the checkbox in the list header to select all records displayed on the current
set of list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more revenue line

items at a time
Merge Merge two or more duplicate revenue

line items
Delete Delete one or more revenue line items

at a time
Export Export one or more revenue line items

to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual revenue line item directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this revenue line item in the

intelligence pane
Edit Edit this revenue line item
Follow Follow this revenue line item
Delete Delete this revenue line item

Record View Actions Menu

The Revenue Line Items record view displays a single revenue line item in full
detail including its fields, subpanels of related records, and activity stream. To
access a revenue line item's record view, simply click a hyperlinked revenue line
item name from anywhere within Sugar. The record view's Actions menu appears
on the top right of the page and allows you to perform various operations on the
current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this revenue line item.
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Share Share a link to this revenue line item via
email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Revenue
Line Items module via Admin > 
PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the Revenue
Line Items module via Admin > 
PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Generate Quote Generate a quote based on this revenue
line item.

Find Duplicates Locate potential duplicates of this
revenue line item.

Copy Duplicate this revenue line item to
create a new revenue line item.

Historical Summary View a historical summary of activities
(e.g. calls, meetings, etc.) related to this
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revenue line item.
View Audit Log View a record of changes to this

revenue line item.
Delete Delete this revenue line item.

Opportunities and Revenue Line Items

In Sugar, the opportunity serves as a header for a set of revenue line items, and
the opportunity's amount and probability fields are roll-ups of this revenue line
item data. Each revenue line item represents the prospective sale of an individual
product. This means that each opportunity must relate to one or more revenue line
items, and each revenue line item must relate to an opportunity. When creating an
opportunity, you will be required to also create at least one revenue line item in a
subpanel beneath the opportunity fields as described in the Creating
Simultaneously With Opportunities section of this page. Special consideration also
needs to be given to the importing of opportunities and revenue line items as
discussed in the Importing Revenue Line Items section below. Revenue line items
and their relationship with opportunities are unique in that they can be deleted
from Sugar via the Revenue Line Items subpanel while viewing an opportunity.
Instructions for doing so are covered in the Deleting via Opportunities Module
section below.

Creating Simultaneously With Opportunities

When creating an opportunity, a subpanel appears beneath the opportunity fields
where you must create one or more revenue line items.

The Revenue Line Items subpanel allows the following operations during
opportunity creation:

Scroll horizontally within the subpanel to view all available revenue line
item fields.
Click the Plus button on the far right of the subpanel row to add additional
revenue line items to the opportunity. The current Revenue Line Item row
will be validated when adding a new row to ensure that all required fields
and data are entered properly.
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To remove any revenue line items from the opportunity, simply click the
Minus button to the left of the Plus button. Please note that you cannot
remove the first revenue line item as at least one related revenue line item
is required for the opportunity to save.

After saving the opportunity, the revenue line item(s) will appear in the Revenue
Line Items subpanel beneath the opportunity record's fields in the record view.

Deleting via Opportunities Module

If a revenue line item is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted as long as its Status field is not set to "Closed
Won" or "Closed Lost". For data integrity purposes, closed revenue line items may
not be deleted. Deletion may be performed from either the Revenue Line Items
detail view or list view, as described in the User Interface documentation. Revenue
line items are unique in that they can also be deleted via the Revenue Line Items
subpanel on the related opportunity's record view. Please note that deleting
revenue line item records will not delete the related records and will only remove
the relationship, so you may wish to also delete any related records to avoid
orphaned records.

Use the following steps to delete one or more revenue line item records via the
Revenue Line Items subpanel on an opportunity record:

1. Navigate to an opportunity in record view.
2. Scroll to the Revenue Line Items subpanel in Data View below the

opportunity's fields.
3. Select the desired records then choose "Delete" from the Actions menu.

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

Importing Revenue Line Items

The import function allows you to push multiple revenue line items records into
Sugar using a .csv file instead of creating them one-by-one. When an opportunity is

                       411 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_Records


 

imported into Sugar, at least one revenue line item must also be imported and
related to the opportunity in order to populate the amounts (e.g. best, likely, etc.)
and Expected Close Date field on the opportunity record. When you are importing
opportunity and revenue line items, please be sure to import your opportunities
first, followed by your revenue line items. Each revenue line item row must include
its parent opportunity's ID as well as values for its amount fields (i.e. Best, Likely,
Worst). For more information on importing, please refer to the Import
documentation.

Products and Revenue Line Items

Sugar's Product Catalog module contains a list of all products or services that your
organization sells. This module provides the Revenue Line Items and Quoted Line
Items modules with the template used when creating products to be used for 
Opportunities and Quotes, including pricing and cost information as well as
information about the manufacturer. For more information, please refer to the 
Product Catalog documentation in the Application Guide.

Each revenue line item has the option to relate to an existing product from the
product catalog via the Product field. Please note that you can add revenue line
items based on a product catalog item using your preferred currency instead of the
product catalog item's currency by enabling the Create Revenue Line Items in
Preferred Currency option in your user profile. If you choose to select a product
from the product catalog, several fields will populate automatically to match the
chosen product. Only line items that relate to a product from the catalog will be
eligible to be used to generate a quote. For more information on generating quotes
from revenue line items, please refer to the Quotes and Revenue Line Items
section of this page.

Currencies and Revenue Line Items

Sugar allows your organization to perform business around the world by
supporting multiple currencies. Administrators must first add desired currencies
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and exchange rates to Sugar via Admin > Currencies. They also have the ability to
set the instance's default currency via Admin > Locale. This is typically the
currency of the country where the majority of business is conducted. For more
information, please refer to the System documentation in the Administration
Guide.

Users can specify their own preferred currency in their user profiles; records that
the user creates will default to this currency. If they choose to also enable the
Show Preferred Currency option in their profiles, currency fields throughout Sugar
will display in their chosen currency. When a user enables the Create Revenue
Line Items in Preferred Currency option, the user's preferred currency will be used
when creating revenue line items based on a product catalog item, rather than the
default behavior of using the product catalog item's currency. For more
information, please refer to the Getting Started documentation. Finally, each
revenue line item record has a Currency field where you will specify the currency
being used for this particular business transaction

Filtering on Currency Fields

Currency fields are filtered according to the record's set currency rather than
being standardized to the user's preferred or system default currency. In the list
view, filtering revenue line items by a currency field allows you to specify the
filter's currency. Only records matching both the chosen currency and amount
range will be returned. For example, if you filter based on a Likely value that
equals 500 in US Dollars, then the search result will return all line items with a
Likely value of $500 but will exclude values of €500 or other currency values which
are equivalent to $500.

Note: By contrast, when filtering values in the Reports module, any record
matching the specified amount or range will be returned regardless of the record's
currency. For example, if one revenue line item's Likely value is $500 in US Dollars
and another's is €500 in Euros, filtering a report for a Likely value of exactly 500
will return both records in the report.
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Updating Currency Rates

When saving a revenue line item in a currency that differs from the system-defined
default currency, Sugar will store the conversion rate for that currency at the
record level. This conversion rate is used to calculate the converted amounts when
the field is set to use the system default currency (as opposed to the user's
preferred currency which is explained below). To keep amounts historically
accurate, the conversion rate will only update on a revenue line item provided the
sales stage is not set to "Closed Won" or "Closed Lost". If the line item is in any
other sales stage, the conversion rate will update under the following scenarios:

The revenue line item undergoes a save event (e.g. mass update, manual
save, etc.) and the record's currency has a different conversion rate defined
in Admin > Currencies than is currently saved in the opportunity.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all revenue line
items saved with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option selected,
the converted amounts display in the user's preferred currency. In this case, the
conversion rate used to calculate the converted amounts is drawn directly from the
conversion rate at the system level rather than any conversion rate stored on the
record. This means that the value will always use the current conversion rate
regardless of the line item's sales stage. For this reason, the converted amount
fields should not be considered historically accurate for closed revenue line items
when it is using the user's preferred currency. For information about setting a
user's Preferred Currency and Show Preferred Currency options, please refer to
the Getting Started documentation.

Emails and Revenue Line Items

Revenue line items may be related to emails by being selected in the email's
Related To field. These relationships allow the revenue line item to display all
relevant email correspondence in the Emails subpanel, as described below, and in
the History dashlet on a revenue line item's record view.

Emails Subpanel

The Emails subpanel in the Revenue Line Items module displays emails that are
related to the revenue line item record via the email's Related To field. These
emails will also appear in the History dashlet on a revenue line item's record view. 

The Emails subpanel allows the following functions to be performed:
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Email Details : To view the details of an email, click the subject to open it
in detail view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation in the
Administration Guide.

Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Compose a New Email : Click the Plus button on the upper right of a
subpanel to create a new email with, by default, a relationship to the
revenue line item you are currently viewing. The email will automatically
select the revenue line item in the Related To field.

Note: Because creating a new related record opens a drawer on top
of the current record view, you should use the Cancel button to
return to record view. Using the browser's back button will return
you to the previous page.

More Records : By default, Sugar displays up to five records in each
subpanel, though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related records exist, click "More {Module Name}..."
(e.g. "More emails...") at the bottom of the subpanel to load the next set of
records.
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Quotes and Revenue Line Items

Quotes and opportunities both track sales throughout their lifecycle, but the two
modules serve different purposes. Quotes allow you to communicate the details of
a sale with customers while opportunities, with their revenue line item, allow you
to forecast potential sales and the possible ranges of their dollar amounts. To aid
in using both modules, Sugar allows you to generate a quote from a set of revenue
line items as well as to use a quote to generate an opportunity and its set of
revenue line items.

Generating Quotes From Revenue Line Items

Users may use one or more revenue line items to generate a new quote. Doing so
copies all relevant information from the revenue line item(s) to the new quote's
fields. Only revenue line items that include a product from the Product Catalog in
their Product field may be used to generate a quote. The generated quote will be
automatically linked to the revenue line item and displayed in its Associated Quote
field.

After being used in a quote generation, the revenue line item will show a "Quoted"
badge at the top of its record view.

Revenue line items that have not been included on a quote display a "Not Quoted"
badge instead.
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Please note that each revenue line item may be used to generate a quote only
once. The option will no longer be available from a revenue line item's record view
once it has been included on a quote. The effect is that each revenue line item may
be a part of only one quote.

Generating a Quote via Subpanel

Users may also generate a quote from one or more revenue line items on an
opportunity record.

Use the following steps to generate a quote via the Revenue Line Items subpanel
on an opportunity record:

1. Navigate to an opportunity in record view.
2. Scroll to the Revenue Line Items subpanel in Data View below the

opportunity's fields.
3. Select the checkboxes of the revenue line items you would like to include in

the quote.
Note: Only revenue line items that have not been included in
previous quotes may be used to generate a new quote.

4. Choose "Generate Quote" from the Actions menu.

5. The quote record that opens in edit view will have all relevant fields and
line items automatically populated from the revenue line item records.
Make any necessary modifications, then click "Save" to preserve your
changes.

Generating a Quote via Record View

Users may also generate a quote from a single revenue line item record from the
Revenue Line Item record view.

Use the following steps to generate a quote via the Revenue Line Item's record
view:
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1. Navigate to an unquoted revenue line item's record view.
2. Select "Generate Quote" from the Actions menu or click the "Not Quoted"

badge to initiate the same quote-creation process.

3. The quote record that opens in edit view will have all relevant fields and
line items automatically populated from the revenue line item record. Make
any necessary modifications, then click "Save" to preserve your changes.

Generating Revenue Line Items From Quotes

To generate an opportunity including its set of revenue line items from a quote,
choose "Create Opportunity from Quote" from the quote record's Actions menu.

Note: Quotes that are already "Converted" (as indicated by the badge adjacent to
the quote's name in the example pictured here) cannot be re-converted into an
opportunity. The "Create Opportunity from Quote" menu option will be grayed out
when the quote's badge is Converted.
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After selecting the Create Opportunity... option, you will be navigated to the newly
created and saved opportunity, which will be pre-populated with the original
quote's values in the Name, Account Name, Expected Close Date, Best, Likely, and
Worst fields. In addition, the opportunity's Type will default to "New Business" and
the Status to "In Progress".

The quoted line items related to the original quote will be copied to new revenue
line items related to the new opportunity. By default, the Sales Stage values for
these revenue line items are set to "Proposal/Price Quote", the Probability to
"65%", and the Type to "New Business".
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Because the probability defaults to 65%, the revenue line item will, by default,
have a Forecast field value of "Exclude," meaning it will not be included in
forecasts. You can edit the revenue line items and the opportunity record to modify
any of these values as needed. The originating quote will be related to the new
opportunity and can be found in the Quotes subpanel on the opportunity's record
view. For more information on creating an opportunity from a quote, please refer
to the Creating Opportunities from Quotes section of the Quotes documentation.

Tile View and Revenue Line Items

Instances that leverage the Revenue Line Items module will enjoy added benefits
when using Tile View for opportunities. Dragging an opportunity from one column
to another will update all of the opportunity's revenue line items in one quick
action. For more information, refer to the Tile View section in the Opportunities
documentation.

Last Modified: 2020-08-25 14:25:16

Opportunities

Overview

Sugar's Opportunities module allows you to track individual sales and their line
items from start to finish. Each opportunity record serves as a header for a group
of revenue line items as well as relating to other important records such as quotes,
contacts, etc. Each revenue line item is the prospective sale of a particular product
and includes relevant sale data. Each revenue line item will typically progress
through several Sales Stages until it is marked either "Closed Won" or "Closed
Lost". The Opportunity record reflects the amount and expected close date of its
revenue line items. Opportunities and revenue line items can be leveraged even
further by using Sugar's Forecasts module to understand and predict sales trends
as well as focus work to achieve sales quotas. For more information on the
Forecasts module, please refer to the Forecasts documentation.

Note: If your instance is configured to use opportunities alone without revenue
line items, please refer to the Opportunities documentation in the Sugar
Professional Application Guide. For more information about changing your
opportunities model via Admin > Opportunities, please see the Opportunities
Configuration documentation in the Administration Guide.
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You can view opportunity information in opportunity-based dashlets such as "My
Closed Opportunities". Clicking an opportunity's name or bubble from any dashlet
will open the Opportunities record view while hovering on the bubble will display
key details in a tooltip. For more information on using dashlets and viewing
opportunity records via dashlets, please refer to the Dashboards and Dashlets
documentation.

This documentation will cover information and actions specific to the Opportunities
module. For instructions concerning views and actions which are common across
most Sugar modules, such as creating, editing, and deleting calls, please refer to
the Working With Opportunities section of this page. 

Please note that you will only be able to see opportunity records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Opportunities module is not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation.

Opportunity Fields

The Opportunities module contains a number of stock fields that come out-of-the-
box with Sugar. For information on using and editing various field types, refer to
the User Interface documentation. The definitions below are suggested meanings
for the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Account Name The account to which the opportunity

belongs
Assigned to The Sugar user assigned to the

opportunity
Best Calculated as the total of Best values of

all related revenue line items, the
opportunity's most optimistic total
amount. The amount will display in the
system default currency or, if your Show
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Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Opportunities section of
this page.

Note: The Best value for related
revenue line items in a sales stage of
"Closed Lost" will not be included in the
calculation.

Campaign The campaign, if any, from which the
opportunity originated

Note: This is an optional field as not all
opportunities will have a campaign.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Date Created The date the opportunity record was
created

Date Modified The date the opportunity record was last
modified

Description A description or other information about
the opportunity

Expected Close Date Calculated as the last expected close
date of a related revenue line item, the
opportunity's expected or actual close
date

Lead Source The source (e.g. Trade Show) from
which the opportunity originated

Likely Calculated as the total of Likely values
of all related revenue line items, the
opportunity's most probable total
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amount. The amount will display in the
system default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
record's selected currency. For more
information, please refer to the 
Currencies and Opportunities section of
this page.

Note: The Likely value for related
revenue line items in a sales stage of
"Closed Lost" will not be included in the
calculation.

Next Step The succeeding stage of the
opportunity's sales cycle

Opportunity Name The name of the opportunity
Renewal Badge (unlabeled) For opportunities with open and 

renewable revenue line items, a badge
will appear next to the opportunity's
name with the date that the next
renewal term begins.

Status Calculated based on the sales stages of
the related revenue line items, the
current status of the opportunity

Teams The Sugar team(s) assigned to the
opportunity record

Type The type (e.g. new business, existing
business) of opportunity

Worst Calculated as the total of Worst values
of all related revenue line items, the
opportunity's least optimistic total
amount. The amount will display in the
system default currency or, if your Show
Preferred Currency option is enabled on
your user profile, in your preferred
currency. If the record's selected
currency differs, you will also see a grey
box with the value displayed using the
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record's selected currency. For more
information, please refer to the 
Currencies and Opportunities section of
this page.

Note: The Worst value for related
revenue line items in a sales stage of
"Closed Lost" will not be included in the
calculation.

Working With Opportunities

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Opportunities section describe
Opportunities-specific behaviors and functionality. 

Content Link Description
Creating Opportunities
Basic Opportunity Creation
Creating via Quick Create
Creating via Subpanels
Creating via Duplication
Importing Opportunities

The Creating Records section covers the
various methods of creating new
opportunity records, including via the
Create button in the Opportunities
module, the Quick Create menu on the
upper right of every Sugar page, via the
Opportunities subpanel on related
module records, duplication of an
existing opportunity record, and
importing a list of opportunities into
Sugar using a .csv spreadsheet.

Note: For more information on
importing opportunities with revenue
line items, please refer to the Importing
Opportunities section of this page.

Viewing Opportunities
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing
opportunity records, including via the
Opportunities list view and record view,
the Recently Viewed menu in the
Opportunities module tab, list view
dashlets showing opportunity
information, activity stream entries

                       424 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Basic_Record_Creation
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_via_Quick_Create
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_via_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_via_Duplication
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Importing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Dashlets
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Activity_Streams
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Preview
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Reports


 

concerning opportunity updates or
where a user mentions an opportunity,
previewing opportunities in the right-
hand side panel, and reports displaying
opportunity data.

Searching for Opportunities
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating
opportunities: global search, which
searches across all Sugar modules, and
list view search, which searches and
filters within the Opportunities module.

Opportunities List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Opportunities
Activity Stream
Dashboards

The List View section walks through the
many elements of the Opportunities List
View layout which contains a filterable
list of all opportunity records in Sugar.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Opportunities list view
are described in the List View Mass
Actions Menu and List View Record
Actions Menu sections of this page.

Opportunities Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Record View section walks through
the many elements of the Opportunities
Record View layout which contains
detailed information about a single
opportunity record. While the generic
menu options are described in the User
Interface sections linked to the left, the
options specifically available in the
Opportunities record view are described
in the Record View Actions Menu
section of this page.

Editing Opportunities
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels

The Editing Records section describes
the various methods of editing existing
opportunity records, including inline via
the Opportunities record view, in full
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Editing Inline via List View
Mass Editing via List View

edit mode on the record view, inline via
the Opportunities subpanel on related
module records, inline via the
Opportunities list view, and via the Mass
Update option on the list view.

Deleting Opportunities
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted opportunities, including via
the opportunities record view, an
individual record's Actions menu on the
Opportunities list view, and the Mass
Actions menu on the list view.

Note: For data integrity purposes, an
opportunity related to a revenue line
item with a "Closed Won" or "Closed
Lost" status may not be deleted. In
addition, revenue line items in these
statuses may not be deleted. If revenue
line items are not enabled for your
instance, an opportunity may be deleted
only if its Status field is not set to
"Closed Won" or "Closed Lost". For data
integrity purposes, closed opportunities
may not be deleted.

Exporting Opportunities The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of opportunities and all
their data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Opportunities The Finding Duplicate Records section
provides instructions for locating
duplicate opportunity records. If
searching on matching fields (e.g.
Opportunity Name) identifies one or
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more duplicates, they can be merged
into a single record.

Merging Opportunities
Merging via List View

The Merging Records section provides
instructions for merging duplicate
opportunities which will combine field
values and related records into a single
opportunity.

Viewing Opportunity Historical
Summaries

The Viewing Record Historical
Summaries section describes the
Historical Summary record view option
which displays quick details of the
opportunity record's related calls,
meetings, emails, notes, and tasks.

Viewing Opportunity Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the opportunity's audited
fields.

Opportunity PDFs
Downloading Opportunity PDFs
Emailing Opportunity PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
email .pdf files of opportunity
information as configured by an
administrator via Admin > PDF
Manager.

Favoriting Opportunities
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking opportunities as favorites,
including via the Opportunities list view,
Opportunities record view, or any
Opportunities subpanel appearing on
the record view of a related module.
Favoriting an opportunity allows you to
easily access it from list views, dashlets,
or the Opportunities module tab.

Following Opportunities
Following via List View
Following via Record View

The Following Records section describes
the various methods of marking
opportunities as "Following", including
via the Opportunities list view and
record view. Following an opportunity
causes its activity stream updates to be
included on your Home page and
Opportunities list view activity streams
so that you can easily keep up with
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changes and user posts on the record.
Sharing Opportunities The Sharing Records section provides

instructions for the Share record view
option which composes an email with a
link to the opportunity record. If the
recipient is logged into Sugar, clicking
the link will bring them directly to the
opportunity's record view.

Opportunities Tile View

Tile View allows users to visualize and engage with their opportunities in an
intuitive drag-and-drop interface. Users can drag a tile from one column to another
to change its status or change the expected close date from one month to the next.

To access Tile View, navigate to the Opportunities list view and click on the Tile
View icon next to the search bar:

When using Tile View for the Opportunities module, you can toggle between two
group-by options: Opportunities by Time and the group-by option configured by
your administrator. By default, the second grouping is Opportunities by Sales
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Stage, but your admin may have configured a different grouping such as
Opportunities by Lead Source:

For more information on using the Tile View, refer to the User Interface
documentation. For information on configuring Tile View layouts and groupings,
refer to the Tile View Settings documentation in the Administration Guide.

Tile View With Revenue Line Items

Instances that leverage the Revenue Line Items module will enjoy added benefits
when using Tile View. Instead of updating the sales stage and expected close dates
in each revenue line item in an opportunity one-by-one, users can update all of an
opportunity's revenue line items at once; Dragging an opportunity from one
column to another will update all of the opportunity's revenue line items in one
quick action.

When interacting with Opportunities Tile View in an instance using revenue line
items, keep in mind the following rules:

When an opportunity has more than one revenue line item and those line
items have different sales stages, the opportunity will show up in the
column associated with the latest (right-most) sequential sales stage that is
not Closed Won or Closed Lost.
Opportunities with all line items in the Closed Lost stage will appear in the
Closed Lost column.
Opportunities with all line items in either closed stage and at least one of
them are Closed Won will appear in the Closed Won column.
Moving an opportunity from one sales stage to another in Tile View will
update all revenue line items in the opportunity to the new sales stage.
Moving an opportunity from one month to another in Tile View will update
the expected close dates for all of its revenue line items to the last day of
the month that it is moved to.
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Opportunity Menus

The Opportunities module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Opportunities-specific
functionality, within this page.

Module Tab Menus

The Opportunities module tab is typically located on the navigation bar at the top
of any Sugar screen. Click the tab to access the Opportunities list view. You may
also click the triangle in the Opportunities tab to display the Actions, Recently
Viewed, and Favorites menus. The Actions menu allows you to perform important
operations within the module. The Recently Viewed menu displays the list of
opportunities you most recently viewed. The Favorites menu displays the list of
opportunities you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Opportunity Opens the record view layout to create a

new opportunity
View Opportunities Opens the list view layout to search and

display opportunities
View Opportunity Reports Displays existing reports based on the

Opportunities module
Import Opportunities Opens the import wizard to create or
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update opportunities using external data

If you do not see the Opportunities module tab in Sugar, please check the
following:

The Opportunities module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed.
Navigate to your user profile (upper right of Sugar), click the Advanced
tab, and check the Layout Options section. If you see the Opportunities
module in the Hide Modules list, simply move it to the Display Modules list.
For more information on hiding and displaying modules, please refer to the 
Layout Options section of the Getting Started documentation.
The administrator may have disabled the Opportunities module for your
entire Sugar instance. Reach out to your Sugar administrator to have the
Opportunities module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Opportunities list view displays all opportunity records and allows for
searching and filtering to locate specific opportunities. You can view the basic
details of each record within the field columns of the list view or click an
opportunity's name to open the record view. To access a module's list view, simply
click the module's tab in the navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual opportunity records or click
the checkbox in the list header to select all records displayed in the current set of
list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update two or more opportunities

at a time
Merge Merge two or more duplicate

opportunities
Delete Delete one or more opportunities at a

time
Export Export one or more opportunities to a

CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual opportunity directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this opportunity in the

intelligence pane
Edit Edit this opportunity
Follow Follow this opportunity
Delete Delete this opportunity
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Record View Actions Menu

The Opportunities record view displays a single opportunity in full detail including
its fields, subpanels of related records, and activity stream. To access an
opportunity's record view, simply click a hyperlinked opportunity name from
anywhere within Sugar. The record view's Actions menu appears on the top right
of the page and allows you to perform various operations on the current record

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this opportunity.
Share Share a link to this opportunity via

email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the opportunity information
as a PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the
Opportunities module via Admin
> PDF Manager.
Clicking on this menu item will
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expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the opportunity information as a
PDF attachment.

This menu option is only visible
if the administrator has created
a PDF template for the
Opportunities module via Admin
> PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Find Duplicates Locate potential duplicates of this
opportunity

Copy Duplicate this opportunity
Historical Summary View a historical summary of activities

(e.g. calls, meetings, etc.) related to this
opportunity

View Audit Log View a record of changes to this
opportunity

Delete Delete this opportunity

Revenue Line Items and Opportunities

When creating a new opportunity, you will be required to also create at least one
revenue line item. This is because the opportunity serves as a header for a set of
revenue line items, and the opportunity's amount and probability fields are roll-ups
of this revenue line item data. For more information about revenue line items,
please refer to the Revenue Line Items documentation.

Please note that the related revenue line item(s) in the subpanel determine the
value for certain Opportunity fields (e.g. Status, Expected Close Date, Likely, etc.).
The opportunity's Status field will be "New" until a revenue line item is added. It
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will then remain "In Progress" until all of the related revenue line items are closed.
If all related revenue line items are "Closed Won", then the parent opportunity will
also be marked "Closed Won". If all related revenue line items are "Closed Lost",
then the opportunity will also be marked "Closed Lost". The opportunity's Expected
Close Date field will automatically reflect the latest close date of all of its related
revenue line items. Throughout the opportunity's life cycle, the opportunity's
amount fields (Likely, Best, Worst) will be automatically populated as the total of
the corresponding fields on its related revenue line items.

Services and Renewable Revenue Line Items

Opportunities can have line items that represent services or subscriptions that may
be sold with a defined start and end date and that may be renewed on a regular
basis. When these fields are used in Sugar Sell, the renewable services will get
automatically added to the future pipeline as they are sold and can be tracked via
the Renewals Console.

Note: You must use Sugar Sell with revenue line items enabled to take advantage
of pipeline renewal automation functionality.

To designate a revenue line item as a service, simply place a checkmark in the
Service field. This can be configured for product records in the Product Catalog
module or one-off on the revenue line item, as shown here:

If no product catalog record is selected, and the revenue line item is marked as a
service, the Service Duration, Service Start Date, and Renewable fields will
become editable. If a product is selected from the Product Catalog, the Service and
Service Duration field values will automatically populate from the related product
and cannot be modified on the revenue line item record. The Service End Date will
automatically calculate based on the values in the Service Duration and Service
Start Date fields. For more information on creating and managing records in the
Product Catalog, please refer to the Product Catalog documentation in the
Application Guide.

As mentioned above, once a product or line item is set as a "Service", the
"Renewable" field becomes an additional option. For Sugar Sell, placing a
checkmark in the Renewable field will tell Sugar to enable pipeline automation for
the parent opportunity. With pipeline automation, Sugar Sell will automatically
create a new opportunity for you when the parent opportunity changes to the
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Closed Won status. Keep in mind that a new opportunity will only be created when
the opportunity contains a revenue line item that meets the following criteria:

Service = Yes
Renewable = Yes
Sales Stage = Closed Won

Note: To be identified as "renewable" by Sugar Sell's pipeline automation engine,
the user who closes an opportunity with renewable line items must be a Sugar Sell
user or else the pipeline automation will not initiate.

On the new opportunity, the Expected Close Date, Service Start Date, Duration,
and Service End Date will roll over to succeed the dates from the originating
revenue line item. For example, when an opportunity is won for one year of
renewable service that starts on January 1, 2020, a new opportunity will be
created by Sugar Sell to track the renewable service that will start on January 1,
2021. This automation ensures that the renewal pipeline is constantly updated as
you close business, saving you the time it takes to manually create opportunities
for renewals. Your closed and upcoming renewals can then be tracked via Sugar
Sell's Renewals Console.

Revenue Line Items Subpanel

The Revenue Line Items subpanel contains all line items which make up this
opportunity. Every opportunity must have one or more related revenue line items,
and each revenue line item must belong to an opportunity. Because of this, there is
no "Unlink" option in the Record Actions Menu to the right of each row. A quote
can be generated from one or more of an opportunity's revenue line items from
this subpanel. For more information, please refer to the Generating Quotes From
Revenue Line Items section of this page.

While the Revenue Line Items subpanel appears to be a typical subpanel on
existing opportunities, it behaves uniquely when creating new opportunities, as
explained in the following section, Creating Opportunities With Revenue Line
Items.

Creating Opportunities With Revenue Line Items

When creating an opportunity, you can create one or more revenue line items in
the subpanel that appears beneath the opportunity:
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The Revenue Line Items subpanel allows the following operations when creating a
new opportunity:

Scroll horizontally within the subpanel to view all available revenue line
item fields.
To add additional line items to the opportunity, click the Plus button to the
right of the row. The current Revenue Line Item row will be validated when
adding a new row to ensure that all required fields and data are entered
properly.
To remove any revenue line items from the opportunity, simply click the
Minus button to the right of the row. Please note that you cannot remove
the topmost revenue line item as at least one related revenue line item is
required for the opportunity to save. Instead, simply edit the row to contain
the correct details.

Note: Users can add revenue line items based on a product catalog item using
their preferred currency (e.g. Euro) instead of the product catalog item's currency
by enabling the Create Revenue Line Items in Preferred Currency option in their
user profile. 

After the opportunity is saved, the revenue line item(s) will appear in the Revenue
Line Items subpanel in the opportunity's record view.

Product Catalog Dashlet

The Product Catalog dashlet provides users with a simple way to access the
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Product Catalog directly from the opportunity record and instantly add products
from the catalog as revenue line items. The Product Catalog dashlet is located next
to the opportunity when creating a new opportunity and also on the Opportunities
Record Dashboard on an opportunity's record view.

The following sections explain the various features and components of the Product
Catalog dashlet. For detailed steps on creating revenue line items via the Product
Catalog dashlet, please refer to the Creating Revenue Line Items via Product
Catalog Dashlet section of this page.

Note: The Product Catalog records must be created before users can select
products when adding line items. As of Sugar 10.0, the Product Catalog, Product
Categories, Product Types, and Manufacturers modules are accessible by all users.
For more information on adding and modifying products in the product catalog,
please refer to the Product Catalog documentation. When you select an item from
the Product Catalog dashlet, the line item's tax class, cost, and manufacturer
information will be pre-filled by values set by your administrator and therefore
cannot be edited.

Viewing Products and Categories via Dashlet

In the Product Catalog dashlet, product categories are represented as folders and
are organized to reflect the structure of the customer's category hierarchy. Users
can search for products and categories and click on individual folders to reveal the
products contained in each category. To close an expanded category folder, click
on the open-folder icon.

Simply click on a product name to instantly add the product to the opportunity.
The new line item will be pre-populated with values specific to the product and can
be edited for quantity, discount, or unit price prior to saving. For more
information, please refer to the Creating Revenue Line Items via Product Catalog
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Dashlet section of this page. 

Searching for Products and Categories via Dashlet

Users can also search for products using the Search field on the Product Catalog
dashlet.

Upon entering a search term, a list of matching product categories and matching
products will be shown in the dashlet. If the user clicks on a category (e.g. a
folder) in the list of search results, all products in the category are loaded, not only
the products that match the search terms.

Previewing Products via Dashlet

Click on the icon next to a product name to view the complete details of its Product
Catalog record:
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After clicking the icon, the record's detail view opens. Click the "Add" button to
add it to the opportunity as a revenue line item. To close the Product Catalog
record's details without adding the product as a line item, click the "Cancel"
button.

Favoriting Products via Dashlet

For products in the product catalog that you use often and would like easier access
to, you can mark the product as a favorite when viewing the details of the record.
Simply click the star icon to the right of the product's name in the upper left of the
record view to designate it as a favorite. If you wish to remove the product as a
favorite, click the star again to revert it to white. To close the product catalog
record's details, simply click the Cancel button. After a product is marked as a
favorite, it will appear under the Favorites tab of the Product Catalog Quick Picks
dashlet.

Creating Revenue Line Items via Product Catalog Dashlet

If you need to add a line item for a product that is in the Product Catalog, you can
easily find and select the product directly from the Product Catalog dashlet, which
is located next to the opportunity record when creating a new opportunity and also
on the Opportunities Record Dashboard from an opportunity's record view. For
more information on searching for products and interacting with the dashlet,
please refer to the appropriate Product Catalog Dashlet subsections on this page.

Note: The Product Catalog records must be created before users can select
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products when adding line items. As of Sugar 10.0, the Product Catalog, Product
Categories, Product Types, and Manufacturers modules are accessible by all users.
For more information on adding and modifying products in the product catalog,
please refer to the Product Catalog documentation. When you select an item from
the Product Catalog dashlet, the line item's tax class, cost, and manufacturer
information will be pre-filled by values set by your administrator and therefore
cannot be edited.

Use the following steps to add a revenue line item to a new or existing opportunity
using the Product Catalog dashlet:
Note: You can follow the same steps below to add a line item using the Product
Catalog Quick Picks dashlet.

1. Create a new opportunity record via any of the various creation methods
explained in the User Interface documentation or navigate to a previously
saved opportunity. For this example, we will select "Create Opportunity"
from the Opportunity module's tab menu.

To view and use the Product Catalog dashlet with existing
opportunity records, simply expand the opportunity's record-view
dashboard (if needed) by clicking on the double-arrow icon next to
the record's Edit button and then select the Opportunities Record
Dashboard or any other dashboard that has been configured to
display the Product Catalog dashlet.

2. On the Create screen, enter the general opportunity information in the
form's fields.

3. The Product Catalog dashlet will be displayed to the right of the
opportunity. When you are ready to add a new revenue line item, click on
any product name in the dashlet to add it as an editable revenue line item.
Note: Users can add revenue line items based on a product catalog item
using their preferred currency (e.g. Euro) instead of the product catalog
item's currency by enabling the Create Revenue Line Items in Preferred
Currency option in their user profile.

For more information on searching for and adding products as line items,
please refer to the appropriate Product Catalog Dashlet subsections of this
page.
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For previously saved opportunities, clicking a product name will
reveal a quick-create revenue line item record populated with the
product's part number and unit price, which are copied from the
Product Catalog.

4. Use the scroll bar to view all of the line item's available fields. Modify the
Quantity field if the default value of "1" is not correct. Please note that
users may enter line items with a quantity of zero to denote optional
products, previously-paid items, or to handle other situations. Rows with
zero quantity will not affect the value of the opportunity.

5. Click "Save" to save the opportunity and revenue line items together or, for
existing opportunities, to add the line item to the Revenue Line Items
subpanel.

Product Catalog Quick Picks Dashlet

The Product Catalog Quick Picks dashlet provides easy access to products in the
product catalog that you recently used or marked as favorites. The dashlet consists
of two tabs (Recently Used, Favorites) and is located to the right of the page when
creating a new opportunity, as well as in the Opportunities record view
intelligence pane. If the dashlet is not displayed in the intelligence pane, you can
add the dashlet by editing the dashboard. For more information on adding
dashlets, refer to the Dashboards and Dashlets documentation. The Recently Used
tab allows you to see a list of products from the product catalog that you most
recently added to an opportunity as a revenue line item. While the Favorites tab
displays a list of products that you have marked as favorites. For more information
on marking products as favorites, refer to the Favoriting Products via Dashlet
section of this page.
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You can select products directly from the Product Catalog dashlet or the Product
Catalog Quick Picks dashlet to instantly add it as a revenue line item to an
opportunity. For more information on adding revenue line items to new or existing
opportunities using the Product Catalog dashlet, refer to the Creating Revenue
Line Items via Product Catalog Dashlet section of this page. Please note that you
can follow the same steps to add revenue line items using the Product Catalog
Quick Picks dashlet. Once the product is added as a revenue line item, you can
refresh the page and it will appear under the Recently Used tab of the Product
Catalog Quick Picks dashlet. The dashlet will display up to 10 products that you
most recently used across opportunity records.

Favoriting Products via Dashlet

In addition to favoriting a product when viewing the details of the record via the
Product Catalog dashlet, you can also mark a product listed in the Product Catalog
Quick Picks dashlet as a favorite. Simply click the icon to the left of the product's
name under the Recently Used tab to access the product catalog record.

Click the star icon to the right of the product's name in the upper left of the record
view to designate it as a favorite. If you wish to remove the product as a favorite,
click the star again to revert it to white. To close the product catalog record's
details, simply click the Cancel button.

After a product is marked as a favorite, it will appear under the Favorites tab in
alphabetical order. By default, the dashlet displays 8 products per page, and you
can use the arrows and numbers to view additional favorited products. You can
easily select a product under the tab to add as a revenue line item to new or
existing opportunities. Simply follow the steps covered in the Creating Revenue
Line Items via Product Catalog Dashlet section of this page using the Product
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Catalog Quick Picks dashlet.

Importing Opportunities

The import function allows you to push multiple revenue line items records into
Sugar using a .csv file instead of creating them one-by-one. When an opportunity is
imported into Sugar, at least one revenue line item must also be imported and
related to the opportunity in order to populate the amounts (e.g. best, likely, etc.)
and Expected Close Date field on the opportunity record. When you are importing
opportunity and revenue line items, please be sure to import your opportunities
first, followed by your revenue line items. Each revenue line item row must include
its parent opportunity's ID as well as values for its amount fields (i.e. Best, Likely,
Worst). For more information on importing, please refer to the Import
documentation.

Quotes and Opportunities

Quotes and opportunities both track sales throughout their lifecycle, but the two
modules serve different purposes. Quotes allow you to communicate the details of
a sale with customers while opportunities allow you to forecast potential sales and
the possible ranges of their dollar amounts. To aid in using both modules, Sugar
allows you to generate an opportunity from a quote as well as to generate a quote
from a set of revenue line items.

Generating Opportunities From Quotes
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To generate an opportunity including its set of revenue line items from a quote,
choose "Create Opportunity from Quote" from the quote record's Actions menu.

Note: Quotes that are already "Converted" (as indicated by the badge adjacent to
the quote's name in the example pictured here) cannot be re-converted into an
opportunity. The "Create Opportunity from Quote" menu option will be grayed out
when the quote's badge is Converted.

After selecting the Create Opportunity... option, you will be navigated to the newly
created and saved opportunity, which will be pre-populated with the original
quote's values in the Name, Account Name, Expected Close Date, Best, Likely, and
Worst fields. In addition, the opportunity's Type will default to "New Business" and
the Status to "In Progress".
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The quoted line items related to the original quote will be copied to the new
opportunity as revenue line items. By default, the Sales Stage values for the
revenue line items are set to "Proposal/Price Quote", the Probability to "65%", and
the Type to "New Business".

Because the probability defaults to 65%, the revenue line items will, by default,
have a Forecast field value of "Exclude," meaning they will not be included in
forecasts. You can edit the revenue line items and the opportunity record to modify
any of these values as needed. The originating quote will be related to the new
opportunity and can be found in the Quotes subpanel on the opportunity's record
view.

For more information on creating an opportunity from a quote, please refer to the 
Creating Opportunities from Quotes section of the Quotes documentation.
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Generating Quotes From Revenue Line Items

A quote may be generated from one or more of an opportunity's revenue line items
via the Opportunities record view's Revenue Line Items subpanel. Each individual
revenue line item may be used to generate a quote only once. The option will no
longer be available from a revenue line item's record view once it has been
included on a quote.

Use the following steps to generate a quote from an opportunity's Revenue Line
Items subpanel:

1. Navigate to the Revenue Line Item subpanel on an opportunity's record
view.

2. Select the revenue line items you wish to include on a quote.
3. Choose "Generate Quote" from the subpanel's Actions menu.

4. The new quote is opened in record view to allow additional changes. Make
any necessary changes to the quote's fields then click "Save" to finalize the
new quote record.

The quote record is automatically generated with a quoted line item record for
each revenue line item record. For more information, please refer to the Quotes
and Quoted Line Items documentation.

Emails and Opportunities

Opportunities may be related to emails by being selected in the email's Related To
field. These relationships allow the opportunity to display all relevant email
correspondence in the Emails subpanel and History dashlet on an opportunity's
record view. An opportunity's Emails subpanel and History dashlet may also
display emails belonging to the contacts related to the opportunity. 

Emails Subpanel
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The Emails subpanel in the Opportunities module displays emails which are
associated with the opportunity record in a variety of ways:

Related to the opportunity : If the opportunity is selected in the email's
Related To field, the email and opportunity are explicitly related, and the
email will appear in the opportunity's Emails subpanel and History dashlet.
Instructions for using this flex relate field are available in the Emails
documentation.
Related to the opportunity's related contacts : If the email is related,
either explicitly or implicitly, to a contact record which is related to the
opportunity, the email will appear in the opportunity's Emails subpanel and
History dashlet.

Note: Administrators can enable or disable an opportunity from
displaying related contact's emails via Admin > Related Contacts
Emails. For more information, please refer to the Email
documentation in the Administration Guide.

The Emails subpanel allows the following functions to be performed:

Email Details : To view the details of an email, click the subject to open it
in detail view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation in the
Administration Guide.

Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Compose a New Email : Click the Plus button on the upper right of a
subpanel to create a new email with, by default, a relationship to the
opportunity you are currently viewing. The email will automatically select
the opportunity in the Related To field.

Note: To send email from Sugar, users must configure their
outbound email server via Emails > Email Settings or, if using the
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system email account to send email, the system's outbound email
server must be configured by an administrator in Admin > System
Email Settings.
Note: Because creating a new related record opens a drawer on top
of the current record view, you should use the Cancel button to
return to record view. Using the browser's back button will return
you to the previous page.

More Records : By default, Sugar displays up to five records in each
subpanel, though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related records exist, click "More {Module Name}..."
(e.g. "More emails...") at the bottom of the subpanel to load the next set of
records.

Leads and Opportunities

Once a lead has been evaluated and qualified, it can be converted into an
opportunity in addition to a contact and account. Depending on how your
administrator has configured the Lead Conversion layout, it may be possible or
even required to create an opportunity or relate to an existing opportunity during
lead conversion. For more information on opportunities and lead conversion,
please refer to the Leads documentation.

Creating via Lead Conversion
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Sugar enables you to create a new opportunity record during the lead conversion
process. For more information about lead conversion, please refer to the Leads
documentation.

Use the following steps to create an opportunity during lead conversion:

1. Navigate to a Leads record view.
2. Select "Convert" from the Actions menu or click the Unconverted button to

initiate the lead conversion process.
Note: Sugar will automatically perform a duplicate check for the
modules (e.g. Contacts) on the Convert Lead page.

3. If there are no duplicate records found for the required modules (Contacts,
Accounts) in lead conversion, the new records will be automatically marked
for creation on the Convert Lead page and associated to the lead. The panel
will be collapsed as well, but you can click the header to open the panel
and view the record's details.

Note: If there are duplicate records detected for a module, you can
either select an existing record or create a new record. For more
information, please refer to the Leads documentation.

4. Once the Contact and Account panels are completed, you can proceed to
the Opportunity panel to create an opportunity record.

5. Enter the relevant information on the displayed record view then click
"Create Opportunity". Please note that some opportunity fields will not be
editable as they are based on the revenue line item you entered.

Note: Some opportunity fields (e.g. Expected Close Date, etc.) will
not be editable as they are based on the related revenue line
item(s).

6. Once all the appropriate panels are complete, click "Save and Convert" to
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convert the lead.

Once the lead has been converted successfully, the lead's record view will display
the Converted badge in the header and show the converted contact, account, and
opportunity below the record's detail. You can click the Preview icon to the far
right of each record's row to view the details of the converted opportunity and
other records.

Forecasts and Opportunities

Sugar's Forecasts module incorporates opportunity records to build forecasting
worksheets and predict sales. Forecasts are based on the monetary value of the
revenue line items in Sugar. Users can work towards sales quotas at the individual,
team, and sales organization level. Before users can access the Forecasts module
to begin building forecasting worksheets, a user with administrator access must
configure the Forecasts module with the organization's desired Time Periods,
Ranges, and Scenarios. For more information on setting up the Forecasts module,
please refer to the Forecast Configuration documentation in the Administration
Guide.

Based on the chosen filters (include, exclude, etc.), you will see all or some of your
assigned revenue line items for the currently selected time period. The Forecast
column displays an automatic category indicating whether or not the revenue line
item's amounts are included in the totals for the specified time period. You can
work directly with your revenue line item records by inline editing their
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probabilities and amounts from the Forecasts module or by clicking the Name field
to open a record in record view where you can make additional edits. You can also
view a revenue line item's details directly from the forecast worksheet by clicking
the Preview icon to the far right of each row. For more information on editing and
managing forecasts, please refer to the Forecasts documentation.

Contacts and Opportunities

Each opportunity can relate to one or more contacts that are displayed in a
subpanel on the Opportunities record view. The Contacts subpanel allows users to
select an opportunity-specific role (e.g. Primary Decision Maker, Business
Evaluator, etc.) for each related contact to help you classify how each individual
will ultimately factor into the buying decision for the current opportunity.

To select a role, simply choose "Edit" from the Actions menu on the far right of the
record's row in the Contacts subpanel. The record's row will open up within the
subpanel allowing you to edit the individual fields. Select the appropriate role for
the contact then click "Save".

The selected role will be displayed adjacent to the contact for only the current
opportunity.
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Currencies and Opportunities

Sugar allows your organization to perform business around the world by
supporting multiple currencies. Administrators must first add desired currencies
and exchange rates to Sugar via Admin > Currencies. They also have the ability to
set the instance's default currency via Admin > Locale. This is typically the
currency of the country where the majority of business is conducted. For more
information, please refer to the System documentation in the Administration
Guide.

Users can specify their own preferred currency in their user profiles. If they
choose to also enable the Show Preferred Currency option in their profiles,
currency fields throughout Sugar will display in their chosen currency. For more
information, please refer to the Getting Started documentation. Finally, each
opportunity record has a Currency field where you will specify the currency being
used for this particular business transaction. 

Filtering on Currency Fields

Currency fields are filtered according to the record's set currency rather than
being standardized to the user's preferred or system default currency. In the list
view, filtering opportunities by a currency field allows you to specify the filter's
currency. Only records matching both the chosen currency and amount range will
be returned. For example, if you filter based on a Likely value that equals 500 in
US Dollars, then the search result will return all opportunities with a Likely value
of $500 but will exclude values of €500 or other currency values which are
equivalent to $500. 

Note: By contrast, when filtering values in the Reports module, any record
matching the specified amount or range will be returned regardless of the record's
currency. For example, if one revenue line item's Likely value is $500 in US Dollars
and another's is €500 in Euros, filtering a report for a Likely value of exactly 500
will return both records in the report.
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Updating Currency Rates

When saving an opportunity in a currency that differs from the system-defined
default currency, Sugar will store the conversion rate for that currency at the
record level. This conversion rate is used to calculate the converted Likely, Best,
and Worst amounts when the field is set to use the system default currency (as
opposed to the user's preferred currency which is explained below). To keep
amounts historically accurate, the conversion rate will only update on an
opportunity provided the sales stage is not set to "Closed Won" or "Closed Lost". If
the opportunity is in any other sales stage, the conversion rate will update under
the following scenarios:

The opportunity undergoes a save event (e.g. mass update, manual save,
etc.) and the record's currency has a different conversion rate defined in
Admin > Currencies than is currently saved in the opportunity.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all
opportunities saved with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option selected,
the converted Likely, Best, and Worst amounts display in the user's preferred
currency. In this case, the conversion rate used to calculate the converted amounts
is drawn directly from the conversion rate at the system level rather than any
conversion rate stored on the record. This means that the value will always use the
current conversion rate regardless of the opportunity's sales stage. For this
reason, the converted amount fields should not be considered historically accurate
for closed opportunities when it is using the user's preferred currency. For
information about setting a user's Preferred Currency and Show Preferred
Currency options, please refer to the Getting Started documentation.

For more information about currency exchange rates, please refer to the System
documentation in the Administration Guide.

Last Modified: 2021-11-23 16:17:22

Forecasts

Overview

Sugar's Forecasts module incorporates revenue line item records to build
forecasting worksheets and predict sales. Users can work towards sales quotas at
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the individual, team, and sales organization level.

Before users can access the Forecasts module to begin building forecasting
worksheets, a user with administrator access must configure the Forecasts module
with the organization's desired Time Periods, Ranges, and Scenarios. For more
information on setting up the Forecasts module, please refer to the Forecast
Configuration documentation in the Administration Guide.

Sales representatives use the Forecasts module to work with their assigned
revenue line items as the current time period progresses. These users will commit
total predictions for their personal sales based on the revenue line items they
expect to close. For instructions specific to a sales representative's use of the
module, please refer to the Sales Representatives section of this documentation.

Sales managers work with their own revenue line item records similarly to other
sales representatives. In addition, they aggregate their reportees' committed
forecast amounts to predict their total team's sales and work towards the team's
quota for each time period. In order for a user to have a designated manager that
aggregates their forecast amounts, they must have the manager selected in the
Reports To field on their user record. For instructions specific to a sales manager's
use of the module, please refer to the Sales Managers section of this
documentation.

Additional insights are offered by the elements of the expandable Intelligence Pane
including analysis for an individual's worksheet and analysis for a manager's team
worksheets. For more information, please refer to the sales representative
Intelligence Pane and the sales manager Intelligence Pane sections of this
documentation.

The Forecasts module is not available for Sugar Serve users. For more information
on license types and the functionality available for each type, refer to the User
Management documentation. 

Note: If your instance is configured to use opportunities alone without revenue
line items, please refer to the Forecasts documentation in the Professional
Application Guide. For more information about changing your opportunities model
via Admin > Opportunities, please see the Opportunities Configuration
documentation in the Administration Guide.

Forecast Fields

The Forecasts module contains the following fields which enable users to work
with revenue line item records to forecast sales for a given time period. Users with
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administrator or developer access have the ability to enable fields for use in the
Forecasts module via Admin > Forecasts. Many revenue line item fields are
available to be added to the forecasting worksheet. For more information please
refer to the Forecast Configuration documentation in the Administration Guide.

Field Description
Account Name The account to which the revenue line

item belongs; cannot be in-line edited
from the Forecasts module

Best The revenue line item's Best field
representing the most optimistic total
amount; automatically set to match
Likely when Sales Stage is "Closed -
Lost" or "Closed - Won"

Best (Adjusted) For managers, the Best value with an
optional, manual adjustment above or
below your reportee's committed Best
total and your own worksheet's Best
total; reported to your manager as the
Best value when committing your
forecast

Expected Close Date The revenue line item's expected date of
completion

Forecast The revenue line item's commit range
(e.g. "Include", "Exclude", etc.) based on
the revenue line item's initial probability
and the user's edits; controls whether
the revenue line item is counted in the
forecast's totals and allows for filtering;
automatically set to "Included" when
Sales Stage is "Closed - Won" and
"Excluded" when Sales Stage is "Closed
- Lost"

Likely The revenue line item's Likely field
representing the most likely total
amount

Likely (Adjusted) For managers, the Likely value with an
optional, manual adjustment above or
below your reportee's committed Likely
total and your own worksheet's Likely
total; reported to your manager as the
Likely value when committing your
forecast
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Opportunity Name The revenue line item's related
opportunity; cannot be in-line edited
from the Forecasts module

Probability The revenue line item's current
probability of being won

Note: This value is calculated based on
the selected Sales Stage and cannot be
edited.

Quota For sales representatives, your
individual quota for this sales time
period as assigned by your manager

For managers, your quota for this sales
time period as assigned by your
manager

Quota (Adjusted) For mid-level managers, your team's
quota with an optional, manual increase
above your team's assigned quota; when
assigning quota to your reportees, this
is the quota value they will receive

Revenue Line Item Name The revenue line item's name; cannot be
in-line edited from the Forecasts module

Stage The revenue line item's current sales
stage

Tags User-created keywords or phrases used
to find, group, and classify data by
common attributes

Worst The revenue line item's Worst field
representing the least optimistic total
amount; automatically set to match
Likely when Sales Stage is "Closed -
Lost" or "Closed - Won"

Worst (Adjusted) For managers, the Worst value with an
optional, manual adjustment above or
below your reportee's committed Worst
total and your own worksheet's Worst
total; reported to your manager as the
Worst value when committing your
forecast
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Forecasts Module Tab

The Forecasts module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen to the right of the home cube icon. Depending
on your settings, you may have to click "Show More" in order to see the Forecasts
module tab. Click the tab to access the Forecasts module. A user with
administrator access must first configure the Forecasts module before it can be
accessed and used. For more information on setting up the Forecasts module,
please refer to the Forecast Configuration documentation in the Administration
guide.

If you do not see the Forecasts module tab in Sugar, please check the following:

The Forecasts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Forecasts module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Forecasts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Forecasts module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.

Forecast Actions

Forecast actions are available at the top of the Forecasts module page and allow
users to perform the following operations:

Menu Item Description
Save Draft Saves changes to the user's worksheet

but does not make these changes
available to the user's manager

Commit Saves changes to the current worksheet
and pushes these changes to the user's
manager's team worksheet or, in the
case of a manager committing a
personal worksheet, to his or her own
team worksheet. For managers viewing
a team worksheet, the Commit button
will be enabled after any committed
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change to his or her own worksheet or a
reportee's worksheet.

Assign Quota For managers, pushes quota changes to
reportees' forecasting worksheets.

Export CSV Exports the rows of the current
forecasts worksheet

Settings For users with administrator access,
opens the Forecast Configurations
wizard

Sales Representatives

Sales representatives use the Forecasts module to work with their assigned
revenue line items as the current time period progresses. These users will commit
total predictions for their personal sales based on the revenue line items they
expect to close.

When you access the Forecasts module as a sales representative, you will see your
name at the top left of the screen. Sales representatives who do not have any
reportees will only be able to see and work with his or her own revenue line items.
Below your name, you will see a time period selection, summary and commit
history, filter, and worksheet. On the right side of each page is an expandable 
Intelligence Pane which offers additional insight into your forecasting worksheet.

Time Periods

Below your name, you will see the current time period for which you are
forecasting revenue line items to meet a quota. The length and the start date of
this time period depend on the Time Periods configuration set up by your
administrator. Clicking the arrow to the right of the current time period allows you
to choose a future or past time period, the availability of which is also determined
by the administrator's Time Periods configuration. Select a past or future time
period to work with revenue line items and forecast for those periods.
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Summary and Commit History

To the right below the Time Period selection, you will see a summary of your
current forecasting numbers for the time period currently in view. The large
numbers are your current worksheet's Quota, Likely, Best, and Worst predictions.
The smaller numbers show your most recent commit's Likely, Best, and Worst
predictions. Any red or green arrows next to the large numbers show whether you
worksheet's current (uncommitted) numbers are higher or lower than your most
recent commit.

Note: You may or may not see the Best and Worst options depending on how your
administrator has configured the Forecasts module. By default, the Worst field is
disabled and must be enabled by the administrator via Admin > Forecasts > 
Scenarios.

To the left of these summary numbers, you will see the date of your most recent
commit. There will be no date shown if you have not yet committed for this time
period. By clicking the arrow to the right of the latest commit date, a dark grey
panel will appear showing the timestamp of the last commit with a history of your
commits for this time period along with the changes for each forecasting number
from the previous commit.

Filters

Below the summary and commit history, you will see a filter bar which controls
what kinds of revenue line items are displayed. By default, the "Include" filter will
be active, meaning that only the revenue line items with a probability falling within
the Include range specified during the administrator's Ranges configuration will be
displayed. To add additional filters, click on the Filters bar and choose additional
ranges. The filter(s) (e.g. Include, Exclude) added to the Filters bar will be
preserved when you navigate away from the module. Returning to the Forecasts
module will automatically display the revenue line items based on the filter(s) you
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last applied.

Please note the Upside and custom ranges may or may not be available depending
on the administrator's Ranges configuration. To remove ranges from the filter,
click the "x" for each filter name. Removing all filters will display all of your
assigned revenue line items.

Column Resizing

You can easily adjust the size of columns in the forecasting worksheet based on
your viewing preference. Simply place your cursor on the column divider, and
when the left-and-right arrow appears, click and drag the column to the desired
size. The set column width will be preserved when you navigate away from the
page. Sugar will render the preferred column size across sessions until the user
removes or resets the relevant browser cookies.

Note: Sugar enforces a minimum width for currency fields (e.g. Best, Likely, etc.)
in list view columns which prevents the columns from being collapsed beyond this
limit.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. Please note that the list view may only be sorted by one
column at a time.
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Column Selection

Sugar gives users the ability to personalize the list view by specifying which fields
they want to be displayed in the list view. You can click the Column Selection icon
to the far right of the list view column headers to see the list of available fields.
Click a field name to toggle whether or not it is included as a column in your list
view. Please note that administrators have the ability to configure what fields are
available to display on the forecasting worksheet. For more information, please
refer to the Forecast Configuration documentation in the Administration Guide.

Line Items and Totals

Based on the chosen filters, you will see all or some of your assigned revenue line
items for the currently selected time period listed below the Filters bar. On the far
left of each row, a blue bar will appear to indicate whether or not the row's
amounts are included in the totals for this time period. The presence of the blue
bar indicates the row is being counted. In addition to the range called "Include",
multiple forecast ranges may be counted towards your totals depending on how
your administrator has configured forecast ranges for the instance. For more
information about making more than one range included in totals, please refer to
the Forecast Configuration documentation in the Administration Guide. The range
and thus the inclusion of each row can be changed manually via this view. You can
work directly with your revenue line item records by in-line editing their
probabilities and amounts from the Forecasts module or by clicking the Name field
to open a record in the Revenue Line Items module where you can make additional
edits. To the right of each row is a preview button which will allow you to view
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details about the revenue line item record in your intelligence pane.

At the bottom of the list, the "Displayed Total" and "Overall Total" rows display
sums of the Worst, Likely, and Best amount columns. The Displayed Total row
shows the sum of the Worst, Likely, and Best amounts (both included and
excluded) displayed on the worksheet based on the filters currently applied. The
Overall Total row displays the totals (both included and excluded) of all revenue
line items' amounts in this time period regardless of any filters currently applied.

Editing Forecast Inclusion

The first time a revenue line item is loaded to a worksheet, Sugar will assign it a
category of either "Include", "Exclude", "Upside" (optional), or a custom range
based on the Ranges configured by your administrator. The revenue line items
with a higher probability of being won are typically assigned to the Include range
while those with a lower probability of being won are designated for the Exclude
range. Your administrator may have chosen to use the Upside range or to create a
number of other, custom ranges - each with their own non-overlapping range of
probabilities. Custom ranges may also exist which have no association with
probabilities.

Since one or more ranges may be considered as included depending on your
administrators' configuration, the blue bars to the left of each row will update to
reflect which items are included and which are excluded based on your updates to
each's forecast range.

You may wish to alter the category automatically assigned to your revenue line
items by these administrator-configured ranges especially as each revenue line
item moves forward in the sales process and becomes more likely to be won. To do
this, simply click on the revenue line item's current category in the Forecast
column and choose the desired category from the dropdown menu.
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Changing a revenue line item's Forecast column to an included range such as
"Include" will cause its Likely, Best, and Worst fields to be added to your totals
while choosing an excluded range such as "Exclude" will remove the revenue line
item's numbers from your totals. Changing which revenue line items are included
on your worksheet requires you to save a draft or commit in order to preserved.

Note: All revenue line items in a Closed Won stage will be included in the
worksheet and cannot have their Forecast column altered. All revenue line items in
a Closed Lost stage will be excluded from the worksheet and cannot have their
Forecast column altered.

Editing Revenue Line Item Fields

In addition to editing the inclusion, you can make in-line changes to each revenue
line item's fields including Sales Stage, Likely, Best, and Worst. To do so, simply
click any field which shows a pencil icon when being hovered over, and enter the
new amount. Keep in mind that your worksheet may or may not include "Best" and
"Worst" depending on your administrator's Scenarios configuration.

Clicking outside the text box or pressing Enter/Return will save your change to the
line and update the worksheet's totals, summary, and Intelligence Pane. Clicking
the Save Draft or Commit button will also update the revenue line item records
themselves and make your changes visible when viewing the revenue line item in
other places in Sugar. Saving a draft or committing is also required to preserve
these changes to your worksheet and, in the case of committing, make the changes
visible in your manager's Forecasts module.

Currency Support

If you use a currency different from your Sugar instance's default currency, your
Likely, Best, and Worst amounts will be displayed in the system's default currency
in the Forecasts module. Clicking to edit these amount values will, however,
display and allow for editing in your chosen currency.
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Intelligence Pane

To the right of the forecasting worksheet, you will find an expandable intelligence
pane which provides additional insights for planning and forecasting. If the pane is
hidden, click the double-arrow button to expand it. Clicking the button again will
hide it when you wish to see your worksheet at full width. The out-of-the-box
default dashboard, "Forecasts Dashboard", contains two default dashlets which
help provide additional insight into your forecasting worksheet, the In Forecast
and Forecast Bar Chart dashlets. For more information about using dashboards,
refer to the Dashboards and Dashlets documentation.

In Forecast Dashlet

The In Forecast dashlet appears at the top of the Intelligence Pane and gives a
breakdown of how your revenue line items match up to your quota. Keep in mind
that your In Forecast dashlet may or may not include "Best" and "Worst"
depending on your administrator's Scenarios configuration.

Note: The In Forecast dashlet is not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation.
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The In Forecast dashlet's values are calculated based on the most recent updates
to your worksheet even if the changes have not yet been saved as a draft or
committed. The values take all of your revenue line items into account regardless
of any filters currently being used in your worksheet. Their meanings are as
follows:

Field Description
Quota Your personal quota for this sales time

period as assigned by your manager
Closed Won The total amount of your Closed Won

revenue line items
Deficit The difference between your quota and

the total amount of your Closed Won
revenue line items; the additional
revenue needed to be won in order to
meet your quota

Likely The total of the Likely amounts for the
included revenue line items which are
not yet Closed Won

(Likely Colored Box) When summing your Closed Won
amounts and your Likely amounts for
included revenue line items, in red, the
remaining quota shortage and
percentage of quota still outstanding or,
in green, the quota overage and
percentage exceeded above quota

Best (Optional) The total of the Best amounts
for the included revenue line items
which are not yet Closed Won
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(Best Colored Box) (Optional) When summing your Closed
Won amounts and your Best amounts for
included revenue line items, in red, the
remaining quota shortage and
percentage of quota still outstanding or,
in green, the quota overage and
percentage exceeded above quota

Worst (Optional) The total of the Worst
amounts for the included revenue line
items which are not yet Closed Won

(Worst Colored Box) (Optional) When summing your Closed
Won amounts and your Worst amounts
for included revenue line items, in red,
the remaining quota shortage and
percentage of quota still outstanding or,
in green, the quota overage and
percentage exceeded above quota

Forecast Bar Chart Dashlet

The Forecast Bar Chart appears on the bottom of the Intelligence Pane and
provides a configurable chart showing different cuts of your forecasting data over
the course of the selected time period. Each revenue line item's Expected Close
Date field determines in which sub-period it appears. Only the revenue line items
currently appearing on your worksheet will appear in your chart meaning that the
chart respects your current filters. The Forecast Bar Chart dashlet's values are
calculated based on the most recent updates to your worksheet even if the changes
have not yet been saved as a draft or committed. Throughout all chart
configurations, the dotted black line represents your quota for the given time
period and can be hovered over to view the quota amount.

Note: The Forecast Bar Chart dashlet is not available for Sugar Serve users. For
more information on license types and the functionality available for each, refer to
the User Management documentation.

Use the two dropdown menus to control what is displayed in the chart.
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When "Likely" is chosen, each green point represents the total Likely amounts for
all revenue line items currently appearing in your filtered worksheet for that sub-
period and any previous sub-periods falling within the selected time period.
Choosing "Best" or "Worst" shows the same points using the revenue line items'
Best or Worst amounts instead. A green line connects these points showing the
change in your possible cumulative amounts.

Each sub-period also displays bars which represent the Likely, Best, or Worst
amounts (depending on the chosen dropdown option) for the revenue line items
currently appearing in your filtered worksheet. Choosing "In Forecast" will color
code segments of these bars according to each revenue line item's Forecast field
(i.e. "Include", "Exclude", etc). Choosing "Sales Stage" will color code the bars
according to the Stage field of each revenue line item. Choosing "Probability" will
color code the bars according to the Probability field of each revenue line item.

Note: You may or may not see "Best" and "Worst" as options in the second
dropdown depending on your administrator's Scenarios configuration.

Sales Managers

Sales managers work with their own revenue line item records similarly to other
sales representatives. In addition, they aggregate their reportees' committed
forecast amounts to predict their total team's sales and work towards the team's
quota for each time period. The Reports To field on the user record specifies a
user's manager; this relationship is what determines who a sales representative
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reports to and, conversely, who a sales manager's reportees are.

When you access the Forecasts module as a sales manager, you will see your name
at the top left of the page along with an arrow which allows you to drill down into
your personal worksheet, your team worksheet, and your reportees' worksheets
hierarchically. While working with your personal worksheet works similarly to how
a regular sales representative works with their revenue line item, you will also
have options such as time period selection, summary and commit history, and 
filters when working with your team worksheet and your reportees' forecasting
data. On the right side of each page is an expandable intelligence pane which
offers additional insight into your forecasting worksheet.

Note: Only administrators can edit the Reports To field. For more information on
the field and how it is used in Sugar, refer to the User Management
documentation.

Forecast Drilldown

Because sales managers are able to see and work with their reportees' revenue
line items in addition to their own, these users will see an arrow next to their name
at the top left of the Forecasts module. This allows them to drill into team
forecasting data and individual sales representatives' revenue line items. By
default, Aaron will enter the Forecasts module viewing his team worksheet which
includes the total committed amounts and quotas for each immediate reportee and
himself.

Own Line Items

As a manager, Aaron can see and work with his own revenue line items by
selecting "Aaron Johnson (me)" from the menu next to his name or from the Name
column in his team worksheet below.

While working with his own revenue line items, he will have the same options on
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his worksheet as a regular sales representative has. For more information on
working with a manager's forecasting worksheet, please refer to the Line Items
and Totals section of this documentation. Aaron will need to commit his new
revenue line items or changes to his revenue line items on his worksheet before
the amounts will be reflected on his team worksheet.

Reportee's Line Items

Since Aaron is Ellen's manager, Aaron also has the ability to work with Ellen's
committed forecast and revenue line items. He can navigate to her committed
worksheet by selecting "Ellen Smith" from the menu next to his name or from the
Name column in his team worksheet below.

While viewing his reportee's worksheet, Aaron will not be able to edit any of the
revenue line items' amounts or probabilities. He is able to filter for various ranges,
change the time period, and view Ellen's summary and commit history for each
time period.

Team Worksheet

Aaron can return to his team worksheet by choosing his own name from the
Drilldown menu.

While viewing his team worksheet, he has the ability to set each team member's
quota as well as to set adjusted Likely, Best, and Worst amounts. Please note that
your worksheets may or may not include "Best" and "Worst" depending on your
administrator's Scenarios configuration. To edit an adjusted amount or quota, click
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on the number, enter a new value, and click outside the text box or press
Return/Enter. Clicking "Save Draft" will preserve these changes in the worksheet
but will not push the changes to other Sugar users. Upon clicking "Commit", these
adjusted amounts will be pushed to Aaron's manager thus appearing in Joy's
worksheet as his committed amounts. Any changes to quotas will also be pushed to
his reportees' worksheets.

From the team worksheet, managers will see an "i" icon on the far right of each
row where there are newly committed changes. Clicking the "i" opens the most
recent commit history for that team member.

Note: Although it is possible for Aaron to set or alter his own personal quota, it is
recommended that intermediate managers not make changes to their personal
quota. Rather, Aaron's manager, Joy, should set the quota for his entire team from
her team worksheet.

Management Hierarchy

The ability to drill into a reportee's team worksheet and revenue line items
continues up the management chain. Joy is Aaron's manager and views her own
team worksheet by default when first opening the Forecasts module. She is also
able to drill into her own revenue line items by clicking her own name, Aaron's
team worksheet by clicking his name, or her other reportee's team worksheet.

When Joy navigates to her reportee Aaron's team worksheet, Aaron's name now
appears and his team worksheet is displayed in read-only mode. Joy can further
drill down to see the worksheets of Aaron's team's members in read-only mode.
This drilling can continue recursively down through the management chain as
needed. Clicking "Parent" will move up one level of the hierarchy, bringing Joy
back to her own team worksheet.
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Time Periods

Below the currently selected drilldown name, you will see the time period for
which you are forecasting to meet the time period's quota for your team. The
length and the start date of this time period depend on the Time Periods
configuration set up by your administrator. At every level of drilldown, sales
managers can click the arrow to the right of the current time period and choose a
future or past time period, the availability of which is also determined by the
administrator's Time Periods configuration. Select a past or future time period to
work with revenue line items and forecast for those periods.

Summary and Commit History

To the right below the Time Period selection, you will see a summary of the
current forecasting numbers for the time period and drilldown level currently in
view. The large numbers are your current worksheet's Quota, Likely, Best, and
Worst predictions. The smaller numbers show your most recent commit's Likely,
Best, and Worst predictions. Any red or green arrows next to the large numbers on
a manager's personal worksheet or own team worksheet show whether your
worksheet's current (uncommitted) numbers are higher or lower than the most
recent commit. Please note that you may or may not see a Best and Worst
depending on your administrator's Scenarios configuration.
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To the left of these summary numbers, you will see the date of the most recent
commit. On a manager's personal worksheet and own team's worksheet, there will
be no date shown if you have not yet committed for this time period. By clicking
the arrow to the right of the latest commit date, a dark grey panel will appear
showing the timestamp of the last commit with a history of the commits for the
worksheet currently in view for this time period along with the changes for each
forecasting number from the previous commit.

Column Resizing

You can easily adjust the size of columns in the forecasting worksheet based on
your viewing preference. Simply place your cursor on the column divider, and
when the left-and-right arrow appears, click and drag the column to the desired
size. The set column width will be preserved when you navigate away from the
page. Sugar will render the preferred column size across sessions until the user
removes or resets the relevant browser cookies.

Note: Sugar enforces a minimum width for currency fields (e.g. Best, Likely, etc.)
in list view columns which prevents the columns from being collapsed beyond this
limit.

Column Sorting
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List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. Please note that the list view may only be sorted by one
column at a time.

Column Selection

Sugar gives users the ability to personalize the list view by specifying which fields
they want to be displayed in the list view. You can click the Column Selection icon
to the far right of the list view column headers to see the list of available fields.
Click a field name to toggle whether or not it is included as a column in your list
view. Please note that administrators have the ability to configure what fields are
available to display in the list view via Admin > Studio. For more information on
configuring fields to display in the list view, please refer to the Studio
documentation in the Administration guide.

Filters

Below the summary and commit history of each worksheet, managers will see a
filter bar which controls what kinds of revenue line items are displayed. By default,
the "Include" filter will be active, meaning that only the revenue line items with a
probability falling within the Include range specified during the administrator's 
Ranges configuration will be displayed. To add additional filters, click on the
Filters bar and choose additional ranges. The filter(s) (e.g. Include, Exclude) added
to the Filter bar will be preserved when you navigate away from the module.
Returning to the Forecasts module will automatically display the revenue line
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items based on the filter(s) you last applied.

Please note the Upside or custom ranges may or may not be available depending
on the administrator's Ranges configuration. To remove ranges from the filter,
click the "x" for each filter name. Removing all filters will display all of your
assigned revenue line items. Please note that when viewing your reportee's
worksheets, only the revenue line items they have committed as included will be
visible.

Intelligence Pane

To the right of the forecasting worksheet, you will find an expandable Intelligence
Pane which provides additional insights for planning and forecasting. If the pane is
hidden, click the double-arrow button to expand it. Clicking the button again will
hide it when you wish to see your worksheets at full width. The out-of-the-box
default dashboard, Forecasts Dashboard, contains two default dashlets which help
provide additional insight into your forecasting worksheet, the In Forecast and 
Forecast Bar Chart dashlets. For more information about using dashboards, refer
to the Dashboards and Dashlets documentation.

In Forecast Dashlet
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The In Forecast dashlet appears at the top of the Intelligence Pane and gives a
breakdown of how your team's revenue line items match up to your quota. Please
keep in mind that the In Forecast dashlet may or may not include "Best" and
"Worst" depending on your administrator's Scenarios configuration.

Note: The In Forecast dashlet is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
User Management documentation.

The In Forecast dashlet's values are calculated based on the most recent updates
to the worksheet even if the changes have not yet been saved as a draft or
committed. The values take all of your and your team's revenue line items into
account regardless of any filters currently being used in your worksheet. Their
meanings are as follows:

Field Description
Quota Your team's quota for this sales time

period as assigned by your manager
Quota (Adjusted) For mid-level managers, your team's

quota with an optional, manual increase
above your team's assigned quota; when
assigning quota to your reportees, this
is the quota value they will receive

Closed Won The total amount of your team's Closed
Won revenue line items
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Deficit The difference between your team's
adjusted quota and the total amount of
your team's Closed Won revenue line
items; the additional revenue needed to
be won in order to meet your adjusted
quota

Likely The total of the Likely amounts for the
included revenue line items which are
not yet Closed Won

(Likely Colored Box) When summing your team's Closed Won
amounts and Likely amounts for
included revenue line items, in red, the
remaining quota shortage and
percentage of quota still outstanding or,
in green, the quota overage and
percentage exceeded above quota

Best (Optional) The total of the Best amounts
for the included revenue line items
which are not yet Closed Won

(Best Colored Box) (Optional) When summing your team's
Closed Won amounts and Best amounts
for included revenue line items, in red,
the remaining quota shortage and
percentage of quota still outstanding or,
in green, the quota overage and
percentage exceeded above quota

Worst (Optional) The total of the Worst
amounts for the included revenue line
items which are not yet Closed Won

(Worst Colored Box) (Optional) When summing your team's
Closed Won amounts and Worst
amounts for included revenue line
items, in red, the remaining quota
shortage and percentage of quota still
outstanding or, in green, the quota
overage and percentage exceeded above
quota

When drilled into your own or a reportee's forecasting worksheet, the Quota
(Adjusted) row will not be displayed and the dashlet will function as it does for
sales representatives without reportees. For more information on the meanings
and configuration of the table while viewing you or a reportee's worksheet, please
refer to the In Forecast dashlet section within the Sales Representatives section of
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this documentation.

Forecast Bar Chart Dashlet

The Forecast Bar Chart appears on the bottom of the Intelligence Pane and
provides a configurable chart showing different cuts of your team members'
forecasting data. Throughout all chart configurations, the dotted black line
represents your adjusted quota for the given time period and can be hovered over
to view the quota amount.

Note: The Forecast Bar Chart dashlet is not available for Sugar Serve users. For
more information on license types and the functionality available for each type,
refer to the User Management documentation.

While viewing your or a reportee's worksheet, the charts will display the relevant
revenue line items over the course of the selected time period. In these views, the
charts function in the same way as they do for support representatives without
reportees. For more information on the meanings and configuration of the chart
while viewing your or a reportee's worksheet, please refer to the Forecast Bar
Chart section within the Sales Representative section of this documentation.

While viewing your or a reportee's team worksheet, the charts will display the
current worksheet's totals in bars grouped by user. Throughout all chart
configurations, the dotted black line represents the worksheet's adjusted quota for
the given time period and can be hovered over to view the quota amount.

Use the dropdown menu to configure what is displayed in the chart.

When "Likely" is chosen, each dark blue bar represents the total committed Likely
amount for each user within the current team worksheet. Each light blue bar
represents the total adjusted Likely amounts for each user. The dark green dots
show the cumulative Likely total of the team built user-by-user from left to right
with the rightmost point representing the total Likely amount for the entire team.
The light green dots and line do the same using the adjusted Likely team total.
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Choosing "Best" shows similar chart elements except that the Best and adjusted
Best amounts are used. Choosing "Worst" does the same with Worst and adjusted
Worst amounts.

Note: You may or may not see "Best" and "Worst" as options in the second
dropdown depending on your administrator's Scenarios configuration.

Saving Forecast Drafts

Whenever new information is added or changes are made to your current
forecasting worksheet, the Save Draft button will become activated. Click this
button to save your changes to the current worksheet without submitting these
changes to your manager. This provides an opportunity to work with your forecast
data before pushing more finalized amounts up the management chain. Clicking
"Save Draft" will also cause any changes to your personal revenue line items'
amounts and/or probability to alter the revenue line item record itself, making
these new numbers visible on the revenue line item in other areas of Sugar.
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Committing Forecasts

Whenever new information is added or changes are made to your current
forecasting worksheet, the Commit button will become activated. Click this button
to save your changes to the current worksheet and to submit these changes to your
manager or to the team worksheet if you are a manager working on your personal
worksheet. Clicking "Commit" will also cause any changes to your personal
revenue line item' amounts and/or probability to alter the revenue line item record
itself, making these new numbers visible on the revenue line item in other areas of
Sugar.

For sales managers, changes to your reportees' quotas will appear in their
Forecasts module when you perform a commit or when using the Assign Quota
option. Either action will also update your quota and your reportees' quotas in the 
In Forecasts dashlet.

Assigning Quotas

After a manager makes changes to the quotas for his or her reportees, the new
quota will become visible in the reportee's Forecasts module when the manager
clicks Assign Quota from the Actions menu in addition to when they commit their
forecast. Either action will also cause changes to your quota and your reportees'
quotas to be reflected inthe In Forecasts dashlet.

Exporting Forecasts

The Export option is available on every forecasting page and exports every line of
the current worksheet. The resulting CSV file can be used in other programs such
as Microsoft Excel to view and manipulate your forecasting data. To export your
current worksheet, click "Export CSV" in the Actions menu.
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Configuring Forecasts

Users with administrator access will have a Settings option available within the
Forecasts module. Choosing "Settings" will open the Forecast Configuration
wizard which is also available by navigating to Admin > Forecasts. For more
information on configuring the Forecasts module, please refer to the Forecast
Configuration documentation in the Administration Guide.

Last Modified: 2021-07-07 14:33:14

Quotes

Overview

Sugar's Quotes module consists of quotes which specify the quantity and the price
per unit for products or services that your organization is selling to clients. You
can select a product directly from the product catalog or manually enter a product
that is not in the catalog during quote creation. There are various ways you can
create quotes in Sugar such as via the Quotes module and duplication. Once
created, you can generate the quote as a document in PDF format and send it to
your clients. This documentation will go over the basics of the Quotes module as
well as the various options available in performing the actions related to the
module.
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For instructions concerning views and actions which are common across most
Sugar modules, such as creating, editing, and deleting quote records, please refer
to the Working With Sugar Modules section of this page.

Please note that you will only be able to see quote records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Quotes module is not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation. 

Quote Fields

The Quotes module contains a number of stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The following definitions are suggested meanings for the
fields, but some fields can be leveraged differently to meet your organization's
needs. Users with administrator or developer access have the ability to alter, add,
or remove some fields via Admin > Studio. For more information on configuring
fields, please refer to the Studio documentation in the Administration Guide.

Field Name Description
Actual Close Date The date on which the quote is accepted

or rejected
Assigned User The Sugar user assigned to the quote
Billing Account Name The Sugar account to which the quote

should be billed
Billing Address The billing address of the account to be

billed for the product or service

Note: This group of fields will
automatically populate from the related
billing account record but can be edited
on the quote without affecting the
address on the related account record.

Billing Contact Name The primary contact at the billing
account for this order

Converted Amount The quote's grand total amount
converted to the system default
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currency as configured in Admin >
Currencies and the viewing user's
preferred currency (if the Show
Preferred Currency option is enabled).

Note: If the applied exchange rate is
modified via Admin > Currencies, the
Converted Amount value will be
automatically updated by a scheduled
process. For more information on how
currency changes affect the Converted
Amount value, refer to the Updating
Currency Rates section. For more
information on the Converted Amount
field, refer to the Grand Total vs
Converted Amount section.

Date Created The date a user created the quote
record in Sugar

Date Modified The date the quote record was last
modified in Sugar

Date Shipped The date the order shipped to the buyer
Description A description or other information about

the quote
Discount The discounted amount (if applicable)

for the quote
Discounted Subtotal The sum of quoted line items after any

discounts have been applied
Display Line Numbers A checkbox that controls whether the

quote record's line items should be
sequentially numbered

Grand Total The sum of groups and line items after
any tax, discounts, or shipping charges
are applied

Opportunity Name The name of the opportunity related to
the quote

Order Stage The current order stage (Pending,
Confirmed, etc.) of the quote

Original P.O. Date The date on which a purchase order was
issued

Payment Terms The time period within which the buyer
must pay for the product or service
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Purchase Order Num The purchase order (P.O.) number given
by the buyer as proof of payment
authorization

Quote Number The unique, system-generated number
used to reference the quote

Quote Stage The current stage of the quote's life
cycle (Draft, Closed Won, etc.)

Quote Subject A brief summary of the product or
service to be quoted

Shipping The shipping charge for the order

Note: Value must be manually added in
the Shipping field at the bottom of the
quote's worksheet and saved via the
quote record's Save button at the top of
the page.

Shipping Account Name The Sugar account where the product or
service will be delivered

Shipping Address The shipping address of the account
that will receive the product or service

Note: This group of fields will
automatically populate from the related
shipping account record but can be
edited on the quote without affecting
the address on the related account
record.

Shipping Contact Name The primary contact at the shipping
account for this order

Shipping Provider The shipping method for the order 

Note: Shipping providers are
configured by the administrator via
Admin > Shipping Providers. Only
shipping providers marked "Active" are
displayed as options on the quote
record.

Subtotal The sum of quoted line items before any
tax, discounts, or shipping charges are
applied

Tax The tax rate to apply to the quote's
taxable subtotal

                       484 / 1.116



 

Note: Tax rates are configured by the
administrator via Admin > Tax Rates.
Only tax rates marked "Active" are
displayed as options on the quote
record.

Teams The Sugar team(s) assigned to the quote
record

Total Discount The order's total discount as a currency
amount

Total Discount Percentage The order's total discount as a
percentage of the total amount

Note: This value is shown under the
"Total Discount" label to the left of the
Total Discount amount

Grand Total The total sum of all the groups and line
items in the quote using the quote's
currency.

Note: For more information, please
refer to the Grand Total vs Converted
Amount section.

Valid Until The date that the quote expires

Quote Stages

The Quote Stage field represents the quote's position in its life cycle. There are
eight quote stages that come out-of-the-box with Sugar, and users with
administrator or developer access have the ability to modify the quote stages via
the quote_stage_dom list in Admin > Dropdown Editor. For more information on
modifying dropdown lists, please refer to the Developer Tools documentation in
the Administration Guide. The following definitions are suggested meanings for
each quote stage, but the stages can be leveraged differently to meet your
organization's needs.

Quote Stage Description
Draft The quote is not yet final
Negotiation The quote has been presented to the

client and the client has requested
modifications
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Delivered The quote has been presented to the
client for consideration

On Hold Activity related to the quote has been
temporarily suspended

Confirmed The quote has been approved for sale
Closed Accepted The client has accepted the terms of the

quote and agreed to proceed with the
sale

Closed Lost The client has not accepted the terms of
the quote and the sale has been lost

Closed Dead The client has neither accepted nor
rejected the terms of the quote, but the
sale has been presumed lost

Order Stages

The Order Stage field is typically used to track the status of an order resulting
from a Closed Accepted quote. There are five order stages which come out-of-the-
box with Sugar, but users with administrator or developer access have the ability
to modify the order stages via the order_stage_dom list in Admin > Dropdown
Editor. For more information on modifying dropdown lists, please refer to the 
Developer Tools documentation in the Administration Guide. The following
definitions are suggested meanings for each order stage, but the stages can be
leveraged differently to meet your organization's needs.

Order Stage Description
Pending The order has been sent to your internal

production team or supplier
Confirmed The order has been accepted by your

internal production team or supplier
On Hold Processing on this order has been

paused
Shipped The order has been released to the

customer
Canceled The customer has canceled this order

Calculated Fields
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A quote's worksheet area is located just above the subpanels on a quote's record
view. Users can add line items to the worksheet and then Sugar applies Sugar
Logic to calculate the sum of the line items relative to applicable tax rates and any
shipping charges or discount amounts that the user has specified. Several
calculated fields contribute to the bottom line of a quote. These fields are shown at
the top of the worksheet in the Totals bar and will instantly adjust for user-
inputted data. The calculated fields are Total Discount, Discounted Subtotal, Total
Tax, and Grand Total.

In addition to the quote's calculated fields, each line item displays a calculated
value labeled "Line Item Total". The value of each "Line Item Total" field's value is
stored in the database in the Quoted Line Items module as total_amount and
labeled "Calculated Quoted Line Item Amount" by default.

Note: If the line item's currency is different from the quote's selected currency,
the "Line Item Total" will display the transactional value (grey box) in the line
item's currency and the converted amount value next to it in the quote's currency.

Note: The value for a quote's Shipping charge is not a calculated value. It must be
manually entered in the lower portion of the quote worksheet and saved via the
quote record's Save button. You can click on the field to edit it or you can click the
"Edit" button at the top of the record view. To save the value, click the "Save"
button at the top of the record view.

Working With Sugar Modules
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While the Quotes module has some features that only apply to quotes, it also uses
the Sidecar user interface that most Sugar modules are based on. In the table
below, the left column contains links to the User Interface page covering topics
that are applicable to all Sidecar modules. The right column has links to sections of
the current page that cover topics specific to quotes.

General Instructions for Working
With Sugar Modules

Quotes-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Quotes-specific help exists for
each topic, use the links below to
navigate to sections of the current page.

Creating Records Building Quotes
Viewing Records
Searching for Records Filtering on Currency Fields
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu

Quote Worksheet Options and Menus
Intelligence Pane Product Catalog Dashlet

Product Catalog Quick Picks Dashlet
Editing Records
Deleting Records
Emailing Records
Exporting Records
Recalculating Calculated Values
Finding Duplicate Records
Viewing Record Historical Summaries
Viewing Record Audit Logs
Record PDFs Downloading Quotes as PDFs
Favoriting Records
Sharing Records

Quote Menus

The Quotes module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
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present each menu and its options with links to more information about each
option in the User Interface documentation or, for Quotes-specific functionality, on
this page.

Module Tab Menus

The Quotes module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Quotes list view. You may also click the
triangle in the Quotes tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu displays options for creating and viewing quotes. The 
Recently Viewed menu displays the list of quotes you last visited. The Favorites
menu displays the list of quotes you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Quote Opens the record view layout to create a

new quote
View Quotes Opens the list view layout to search and

display quotes
View Quote Reports Directs you to the Reports list view

filtered to display only reports based on
the Quotes module

If you do not see the Quotes module tab in Sugar, please check the following:

The Quotes module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Quotes module in the Hide Modules

                       489 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Favoriting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Favoriting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Basic_Record_Creation
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Reports


 

list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Quotes module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Quotes
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Quotes list view displays all quote records and allows for searching and
filtering to locate specific quotes. You can view the basic details of each record
within the field columns of the list view or click on a quote's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual quote records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more quotes at a

time
Delete Delete one or more quotes at a time
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Export Export one or more quotes to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on a quote directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this quote in the intelligence

pane
Edit Edit this quote
Delete Delete this quote

Record View Actions Menu

The Quotes record view displays a single quote in full detail including its fields,
quote worksheet, and subpanels of related records. To access a quote's record
view, simply click a hyperlinked quote name from anywhere within Sugar. The
record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this quote
Share Share a link to this quote via email
Download PDF Download the quote to your computer as

a PDF file
Note: Clicking on this menu item will
expand and contract the menu to reveal
or hide the available PDF templates.

Email PDF Send an email with a PDF copy of the
quote as an attachment.
Note: Clicking on this menu item will
expand and contract the menu to reveal
or hide the available PDF templates. To
send emails through Sugar, users must
first configure a default user email
account via Emails > Email Settings.

Create Opportunity from Quote Copy the details of this quote to a new
opportunity record
Note: Quotes that are already
"Converted" (as indicated by the badge
adjacent to the quote's name in the
example pictured here) cannot be re-
converted into an opportunity. The
"Create Opportunity from Quote" menu
option will be grayed out when the
quote's badge is Converted.
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Copy Duplicate this quote to create a new
quote record.
Note: The original quote's line items,
groups, comments, and related account
and opportunity data will carry over to
the new quote.

Historical Summary View a historical summary of activities
(e.g. calls, meetings, etc.) related to this
quote

View Audit Log View a record of changes to this quote
Delete Delete this quote

Quote Worksheet Options and Menus

Below the quote record, the quote's worksheet contains several options and menus
specific to the worksheet, its groups, and rows. In the following image, the blue
section is the Totals bar, which displays the calculated totals for the worksheet;
the yellow section contains the column headers for all of the line items that you
may add; and the pink section is an example of a group, which can contain any
number of quoted line items and comments. The totals for all groups on the
worksheet are added to the shipping charge and calculated tax to reach a grand
total.

Note: If you are using Sugar Mobile, your administrator may need to take action
for the quote worksheet configuration to be in sync. More information can be
found in the Quotes Configuration documentation in the Administration Guide.

The following table describes the options and menus available on the example
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quote worksheet pictured above:

Option Description
Create on Worksheet Add a new group or create

ungrouped line items and
comments

Select All Select or deselect all rows
on the worksheet

Mass Actions Group or delete all
selected rows

Create in Group Add a new comment or
line item to the group

Group Actions Edit the group name or
delete the group (does not
delete the group's rows)

Select Row Select the line item or
comment

Row Actions Edit or delete the line item
or comment

Row Save/Cancel Save (✓) a new or edited
row or cancel (x) creating
or editing the row

Building Quotes

When creating quotes in Sugar, the full edit view layout opens which includes all of
the quote fields in expandable panels labeled "Business Card", "Billing and
Shipping", "Quote Settings", and "Show More". Beneath the panels, there is a
quote worksheet where product groups and line items can be configured,
rearranged, and tallied along with any discounts, taxes, or shipping fees. For more
information on the worksheet's layout, please refer to the Quote Worksheet
Options and Menus section of this page.

Note: The quotes worksheet fields and field order can be modified by
administrators via Admin > Quotes Configuration. The layouts for the panels above
the worksheet can be configured by administrators via Admin > Studio. For more
information on configuring these two layouts, please refer to the Studio and 
Quotes Configuration documentation in the Administration Guide.

The following sections cover using the quote's worksheet to calculate the quote's

                       494 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Layouts
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Products_and_Quotes#Quotes_Configuration


 

grand total.

Quoted Line Item Groups

The quote's worksheet allows users to add products from the product catalog and
arrange them in groups. Groups may also contain comments. Groups are optional
for quote records so you can omit them altogether in favor of independent line
items or create one or more groups to organize similar products or services
together. For example, a quote for software might have a group labeled "Services"
to contain the quoted line items for implementation and extended support.

Creating Groups

Empty groups can be created via the worksheet's Create menu. Alternatively,
users can create a group from existing comments and quoted line items. The next
two sections explain each method.

Creating Empty Groups

Use the following steps to add a new group to the quote's worksheet:

1. After filling in and saving the quote's fields, scroll down to the quote's
worksheet and click on the Create (+) button to access the worksheet's
available actions and select "+ Group".

2. Enter an optional name for the new group and then click the Save icon. To
create an unnamed group, just click the Save icon without entering any
text.
Note: To cancel without creating a new group, click on the Cancel (x) icon.
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You now have a new group and can start adding line items to the group.

Creating Groups from Quoted Line Items

If a quote already has line items and you want to move some or all of those line
items into a new group together, follow these steps to create a new group from the
quoted line items:

1. From the quote's worksheet area, identify the quoted line items that you
would like to group together and place a checkmark in the empty checkbox
next to each item's row.

2. Next, click on the worksheet's Actions button (three vertical dots in the
Totals bar) and select "Group Selected".

3. Enter an optional name for the new group and then click the Save icon. To
create an unnamed group, just click the Save icon without entering any
text.
Note: To cancel without creating a new group, click on the Cancel (x) icon.

4. The selected items now exist within the new group:
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Editing Groups

To edit a group's name, click on the group's Actions button (three vertical dots to
the left of the group name) and then select "Edit".

To edit the position of quoted line items and comments in a group, you can simply
drag and drop the rows to the desired location. Line items and comments can be
rearranged within the group, moved to a new group, or moved out of groups to
independent lines on the quote worksheet. For more information, please refer to
the Moving Quoted Line Items and Moving Comments sections.

Deleting Groups

When you delete a group from a quote's worksheet, any quoted line items that
were in the deleted group will simply become ungrouped on the quote. To delete a
group, click on the group's Actions button (three vertical dots to the left of the
group name) and then select "Delete Group".

Quoted Line Items

Quoted line items represent the specific products or services on the quote. You can
create line items as independent rows on the quote or they may be included in a
group, which typically contains additional, related line items. For more information
on creating quote groups, please refer to the Adding Groups section of this page.

Note: You can only relate quoted line items with a quote by creating them directly
from a quote record's worksheet as described in the following sections. Quoted line
items created directly in the Quoted Line Items module via the Actions menu or
Create button cannot be linked to a quote record.
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Creating Quoted Line Items

When adding products as quoted line items, you may select a product from your
database's Product Catalog directly in the line item or via Product Catalog or 
Product Catalog Quick Picks dashlets or you may manually enter a new product on
the fly. Either way, each line item added to a quote will create a new record in the
Quoted Line Items module.

To create a line item as an independent row on the quote worksheet, click on the
Create (+) button to access the worksheet's available actions and select "+ Quoted
Line Item":

To create a line item inside a group on the quote worksheet, click on the group's
Create (+) button to access the group's available actions and select "+ Quoted
Line Item":

Please note that line numbers are only visible next to quoted line items when the
"Display Line Numbers" field is enabled in the quote record's Quote Settings panel.
This option is enabled by default.
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Please refer to the following sections for more information on creating a new
custom line item and creating line items via product catalog.

Creating Custom Quoted Line Items

If you need to add a line item for a product that is not in the Product Catalog, you
can instantly create a custom line item directly from the quote worksheet. Custom
line items are stored in Sugar as quoted line item records but are not added to the
Product Catalog.

Follow these steps to create a custom line item for a quote:

1. Choose "+ Quoted Line Item" from the worksheet's Create (+) menu or
from the group's Create (+) menu as desired. For more information, please
refer to the Quoted Line Items section of this page.

2. Click on the Line Item dropdown field in the new row and begin typing the
product that you would like to use as a line item. When you enter the first
letter of a product, Sugar will begin to display recommendations from the
Product Catalog that begin with the same letter. To ignore the
recommendations and create an entirely new product, completely type out
the name of the product as you would like it to appear on the quote and
then click on the New Quoted Line Item menu option or press the Enter
key.

3. Enter the quantity, unit price, and remaining line item fields as needed. For
more information, please refer to the Quoted Line Items documentation.
Note: By default, custom line items will use the quote's selected currency
but you can change the line item's currency from these defaults as desired.
When the line item's currency is different from the quote's selected
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currency, the Unit Price and Line Item Total fields will display the
transactional amount in a grey box using the line item's currency and the
converted amount next to it in the quote's currency.

4. Click the blue checkmark next to the row to save the line item.

This will save the row to Sugar's database as a quoted line item record but will not
affect the Product Catalog. After adding a quoted line item to a quote, you can
navigate to the quoted line item's record view by clicking its hyperlinked name on
the quote worksheet. For more information on quoted line item records, please
refer to the Quoted Line Items documentation.

Creating Quoted Line Items via Product Catalog

If you need to add a line item for a product that is in the Product Catalog, you can
easily find and select the product directly from the Product Catalog dashlet or the
Product Catalog Quick Picks dashlet, which is located next to the quote form when
creating a new quote and also on a Quotes record view intelligence pane. For more
information on interacting with these dashlets, refer to the Product Catalog
Dashlet and the Product Catalog Quick Picks Dashlet sections of this
documentation. In addition to the dashlets, you can also select the product directly
from the line item on the quote worksheet.

Note: The Product Catalog records must be created before users can select
products when adding line items. As of Sugar 10.0, the Product Catalog, Product
Categories, Product Types, and Manufacturers modules are accessible by all users.
For more information on adding and modifying products in the product catalog,
please refer to the Product Catalog documentation. When you select an item from
the Product Catalog dashlet, the line item's tax class, cost, and manufacturer
information will be pre-filled by values set by your administrator and therefore
cannot be edited.

The following steps cover adding a line item to the quote worksheet using the
Product Catalog dashlet as an example:

Note: You can follow the same steps below to add a line item using the Product
Catalog Quick Picks dashlet.

1. Create a new quote record via any of the various creation methods
explained in the User Interface documentation. For this example, we will
select "Create Quote" from the Quote module's tab menu.
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Note: To view and use the Product Catalog dashlet with existing quote
records, simply expand the quote's record-view dashboard (if needed) by
clicking on the double-arrow icon next to the record's Edit button and then
select the Quotes Record Dashboard or any other dashboard that has been
configured to display the Product Catalog dashlet.

2. On the create screen, enter the general quote information in the form's 
fields.

3. When completing the form fields, the Product Catalog dashlet will be
displayed to the right of the quote form. When you are ready to create a
new quoted line item, click on any product name in the dashlet to instantly
add it as an editable line item to the quote's worksheet. The line item's
fields will populate with the part number and unit price, which are copied
from the Product Catalog. The Part Number field cannot be edited for line
items created via Product Catalog. By default, line items created using the
product catalog will use the product catalog item's currency but you can
change the line item's currency from these defaults as desired. If the line
item's currency is different from the quote's selected currency, the Unit
Price and Line Item Total fields will display the transactional amount in a
grey box using the line item's currency and the converted amount next to it
in the quote's currency
Note: If you wish to select the product directly from the line item on the
quote worksheet instead of via the dashlet, you will need to first create a
line item on the quote worksheet then click on the Line Item dropdown
field to enter and select the desired product.

4. Modify the quantity field if the default value of "1" is not correct. Please
note that users may enter line items with a quantity of zero to denote
optional products, previously-paid items, or to handle other situations.
Rows with zero quantity will not affect the value of the quote.

5. Optionally, apply a discount to the line item. By default, the discount field
accepts a percentage value, but users can enter an absolute discount
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amount by toggling the Unit button from "%" to the currency symbol.

6. After completing the line item, click the blue checkmark next to the row to
save the line item.

This will save the row to Sugar's database as a new quoted line item record.

Editing Quoted Line Items

To change the editable values of a quoted line item, click on the row's Actions
button (three vertical dots to the left of the line item) and then select "Edit".

Custom line items are fully editable. The quantity and discount are editable for line
items from the product catalog, or you may change the selected product, which
will reset the row's values appropriately. After updating the quoted line item, click
the blue checkmark to apply the changes or click the Cancel (x) icon to cancel any
changes and revert the row's values. If the line item's value has changed, the
quote's totals will automatically recalculate. If the edited line item is in a group,
then the group's totals will recalculate, as well.

Moving Quoted Line Items

Users can move quoted line items to a new position on a worksheet. Simply save
the row and then click and hold anywhere on the line item until the mouse tip
changes to a four-directional arrow. Drag the row to the preferred position on the
worksheet and then release the mouse button.

Note: Quoted line items cannot be moved when they are in edit mode. 

Line items can be moved within a group, from one group to another group, or out
of a group to an independent row. When you change the position of a line item, its
line number will adjust accordingly and so will the line numbers for any other rows

                       502 / 1.116



 

affected by the change. Upon moving line items into or out of a group, the group's
totals will automatically recalculate.

Please note that line numbers are only visible when the "Display Line Numbers"
field is enabled on the quote record.

Moving a quoted line item into or out of a group is audited by the quoted line item
record's activity stream, but changing the position of a line item within a single
group is not tracked.

Deleting Quoted Line Items

If you delete a line item from a quote's worksheet, you cannot get it back. You will
delete the record from the Quoted Line Items module. The quote worksheet allows
you to delete a single quoted line item or to use a mass action for deleting several
line items at once. Upon deleting line items, the quote's totals will recalculate
automatically. If the deleted line items were in a group, the group totals will
recalculate, too.

To delete a single quoted line item, click on the line item row's Actions button
(three vertical dots to the left of the line item's name) and then select "Delete".
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To delete multiple line items at once, identify the quoted line items that you would
like to delete and place a checkmark in the empty checkbox next to each item's
row. Click on the worksheet's Actions button (three vertical dots in the Totals bar)
and select "Delete Selected".

Comments

Comments are user-created notes on the quote worksheet. Comments are included
on the default quote PDF templates. You can create comments as independent
rows on the quote or they may be included in a group. For more information on
creating quote groups, please refer to the Adding Groups section of this page.
Because comments, like quoted line items, occupy rows on the worksheet, they can
be added, edited, moved, and deleted from the sheet in the same way as quoted
line items.

Creating Comments

To create a comment as an independent row on the quote worksheet, click on the
Create (+) button to access the worksheet's available actions and select "+
Comment":

To create a comment inside a group on the quote worksheet, click on the group's
Create (+) button to access the group's available actions and select "+ Comment":
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Type the comment into the text box and then click the blue checkmark to save the
comment as a new row or click the Cancel (x) icon to remove the comment's row:

Editing Comments

To edit a comment's text, click on the comment row's Actions button (three vertical
dots to the left of the comment) and then select "Edit".

After updating the comment, click the blue checkmark to preserve the changes or
click the Cancel (x) icon to cancel any changes and revert the text.

Moving Comments
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Users can move comments to a new position on a worksheet. Simply save the
comment and then click and hold anywhere on the comment row until the mouse
tip changes to a four-directional arrow. Drag the comment to the preferred
position on the worksheet and then release the mouse button. Comments can be
moved within a group, from one group to another group, or out of a group to an
independent row.

Note: Comments cannot be moved when they are in edit mode.

Deleting Comments

To delete a comment from the quote worksheet, click on the comment row's
Actions button (three vertical dots to the left of the comment) and then select
"Delete".

Product Catalog Dashlet

The Product Catalog dashlet provides users with a simple way to access the
Product Catalog directly from the quote record and instantly add products from
the catalog as line items on the quote worksheet. The Product Catalog dashlet is
located next to the quote form when creating a new quote and also on the Quotes
Record Dashboard on a quote's record view.
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The following sections explain the various features and components of the Product
Catalog dashlet. For detailed steps on creating quoted line items via the Product
Catalog dashlet, please refer to the Creating Quoted Line Items via Product
Catalog section of this page.

Note: The Product Catalog records must be created before users can select
products when adding line items. As of Sugar 10.0, the Product Catalog, Product
Categories, Product Types, and Manufacturers modules are accessible by all users.
For more information on adding and modifying products in the product catalog,
please refer to the Product Catalog documentation. When you select an item from
the Product Catalog dashlet, the line item's tax class, cost, and manufacturer
information will be pre-filled by values set by your administrator and therefore
cannot be edited. 

Viewing Products and Categories via Dashlet

In the Product Catalog dashlet, product categories are represented as folders and
are organized to reflect the structure of the customer's category hierarchy. Users
can search for products and categories and click on individual folders to reveal the
products contained in each category. To close an expanded category folder, click
on the open-folder icon.

Simply click on a product name to instantly add the product to the quote
worksheet. The new line item will be pre-populated with values specific to the
product and can be edited for quantity, discount, or unit price prior to saving. For
more information, please refer to the Creating Quoted Line Items via Product
Catalog section of this page. 

Searching for Products and Categories via Dashlet
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Users can also search for products using the Search field on the Product Catalog
dashlet.

Upon entering a search term, a list of matching product categories and matching
products will be shown in the dashlet. If the user clicks on a category (e.g. a
folder) in the list of search results, all products in the category are loaded, not only
the products that match the search terms.

Previewing Products via Dashlet

Click on the icon next to a product name to view the complete details of its Product
Catalog record:

After clicking the icon, the record's detail view opens. Click the "Add" button to
add it to the quote as a quoted line item. To close the Product Catalog record's
details without adding the product as a line item, click the "Cancel" button.
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Favoriting Products via Dashlet

For products in the product catalog that you use often and would like easier access
to, you can mark the product as a favorite when viewing the details of the record.
Simply click the star icon to the right of the product's name in the upper left of the
record view to designate it as a favorite. To close the product catalog record's
details, simply click the Cancel button. If you wish to remove the product as a
favorite, click the star again to revert it to white. After a product is marked as a
favorite, it will appear under the Favorites tab of the Product Catalog Quick Picks
dashlet.

Product Catalog Quick Picks Dashlet

The Product Catalog Quick Picks dashlet provides easy access to products in the
product catalog that you recently used or marked as favorites. The dashlet consists
of two tabs (Recently Used, Favorites) and is located next to the quote form when
creating a new quote and also in the Quotes record view intelligence pane. If the
dashlet is not displayed in the intelligence pane, you can add the dashlet by editing
the dashboard. For more information on adding dashlets, refer to the Dashboards
and Dashlets documentation. The Recently Used tab allows you to see a list of
products from the product catalog that you most recently added as line items on a
quote worksheet. While the Favorites tab displays a list of products that you have
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marked as favorites. For more information on marking products as favorites, refer
to the Favoriting Products via Dashlet section of this page.

You can select products directly from the Product Catalog dashlet or the Product
Catalog Quick Picks dashlet to instantly add it as a line item on the quote
worksheet. For more information, refer to the Creating Quoted Line Items via
Product Catalog section of this page. Once the product is added as a quoted line
item, you can refresh the page and it will appear under the Recently Used tab of
the Product Catalog Quick Picks dashlet. Please note that the dashlet will display
up to 10 products that you most recently used across quote records.

Favoriting Products via Dashlet

In addition to favoriting a product when viewing the details of the record via the
Product Catalog dashlet, you can also mark a product listed in the Product Catalog
Quick Picks dashlet as a favorite. Simply click the icon to the left of the product's
name under the Recently Used tab to access the product catalog record.

Click the star icon to the right of the product's name in the upper left of the record
view to designate it as a favorite. If you wish to remove the product as a favorite,
click the star again to revert it to white. To close the product catalog record's
details, simply click the Cancel button.

                       510 / 1.116



 

After a product is marked as a favorite, it will appear under the Favorites tab in
alphabetical order. By default, the dashlet displays 8 products per page, and you
can use the arrows and numbers to view additional favorited products. You can
easily select a product under the tab to add as a line item to new or existing
quotes. For more information on adding line items using dashlets, refer to the 
Creating Quoted Line Items via Product Catalog section of this page.

Creating Opportunities from Quotes

Opportunity records in Sugar represent prospective sales. As you interact with
your client and present the quote for your products and services, you can create an
opportunity from the quote's detail view to track the quote's progression through
your organization's sales stages. The new opportunity is populated with the
original quote's values to reflect the opportunity name, account name, expected
close date, best, likely, and worst amounts. Any other populated fields will be
based on the default values as they are defined in Studio for the Opportunities
module. On save, the new opportunity record will automatically be related to the
quote record in Sugar, and the quote record will show that it has been converted.

Note: For instances using revenue line items, each quoted line item on the quote
will become a revenue line item related to the newly created opportunity record.
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To create an opportunity from a quote, navigate to a quote's record view. Select
"Create Opportunity from Quote" from the Actions menu. If the option is grayed
out in the menu, confirm that the quote's Opportunity Name field is empty and that
the quote record is labeled "Not Converted". Quotes that already relate to an
opportunity are considered converted and cannot be converted into another
related opportunity.

Sugar will instantly create and save a new, related opportunity and redirect you to
the opportunity's record view. You may update the opportunity if needed by
clicking "Edit" and then saving the changes. The opportunity's Quotes subpanel
will display the originating quote record. Click on the quote's name and the quote
will now display the related opportunity's name in the Opportunity Name field and
the quote's label will display "Converted".

Downloading Quotes as PDFs

Users can download Sugar quote records in PDF format via the quote's Actions
menu or from any Quotes subpanel on a related record. There are several default
PDF templates that are included with the Quotes module, but administrators may
create new quote PDF templates or modify the default templates via Admin > PDF
Manager. For more information on editing and adding PDF templates, please refer
to the PDF Manager documentation in the Administration Guide. The default quote
PDFs included with Sugar are: Quote, Quote (with services), Invoice, and Invoice
(with services). Templates "with services" will include service-related fields such as
Service Start Date, Service End Date, and Service Duration.

                       512 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System/PDF_Manager


 

The Download PDF option enables you to easily download the quote to your
machine and email or print and mail it to your client outside of the Sugar
application. The default PDF formats list the details (e.g. quantity, product name,
etc.) of the items or services for purchase as well as any comments and pricing
information. Once the client approves the quote's terms and agrees to purchase
your product or service, you can generate an invoice for payment.

To download a PDF from the quote's record view, find the Download PDF option in
the quote record's Actions menu and the available PDF formats will be listed in the
subsequent rows. If the PDF options are hidden, simply click on "Download PDF"
to expand the PDF options. Click on the PDF format that you prefer (e.g. Invoice or
Quote).

To download a PDF from a related record's Quotes subpanel, expand the Actions
menu for the quote record in the subpanel and find the Download PDF option. The
available PDF formats will be listed in the subsequent rows. If the PDF options are
hidden, simply click on "Download PDF" to expand the PDF options. Click on the
PDF format that you prefer (e.g. Invoice or Quote).

After downloading the file, locate the PDF in your browser's footer or in your
computer's Downloads folder. It will be named Quote_Name.pdf where
Quote_Name is the name of the quote record with underscores in place of space
characters (e.g. a quote named "300 Software Licenses" will export with the file
name 300_Software_Licenses.pdf).

                       513 / 1.116



 

The .pdf document will contain all of the information from the quote's worksheet as
well as the quote number, assigned user's name, and billing and shipping
information.

Currencies and Quotes

Sugar allows your organization to perform business around the world by
supporting multiple currencies. Administrators must first add desired currencies
and exchange rates to Sugar via Admin > Currencies. They also have the ability to
set the instance's default currency via Admin > Locale. This is typically the
currency of the country where the majority of business is conducted. For more
information, refer to the System documentation in the Administration Guide.

Each quote record has a Currency field in the Quote Settings panel where you can
specify the currency being used for the particular business transaction. By default,
the field displays the system default currency unless the user's preferred currency
is defined in their user profile. When line items are added to the quote's
worksheet, the default currency for each line item will vary depending on how it is
entered (manually or via Product Catalog). Line items built from product catalog
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items will use the product catalog item's selected currency by default while custom
line items will use the quote's selected currency. For more information on creating
and managing the Product Catalog, refer to the Product Catalog documentation in
the Application Guide. Please note that you can change each line item's currency
from these defaults as desired. 

For each line item in the quote's worksheet, the unit price and line item total
values will display in the quote's selected currency. However, if the line item's
currency differs from the quote's currency then the Unit Price and Line Item Total
fields will display the transactional amount, in the line item's currency, in a grey
box next to the converted amount in the quote's currency. Please note that the 
Show Preferred Currency option in the user's profile will not affect the line items
in the quote's worksheet. 

In the following example below, the quote's selected currency is Euros (€). The
first line item is a custom quoted line item that was manually entered, so it uses
the quote's selected currency (Euros) by default. The second line item (TK 1000
Desktop) was created from a product catalog item, so its transactional value (grey
box) uses the catalog item's currency, US Dollars. Now, since this line item's
currency differs from the quote's currency, the converted amount will display next
to the grey box using the quote's currency (Euros). Please note that if the second
line item's base currency was changed to the quote's currency (Euros), then the
unit price and line item total values would just display in the quote's currency.

In the Quotes list view, there are two currency-type fields where the values are
displayed using different currencies:

Grand Total : Displays the total sum of all the groups and line items in the
quote using the quote's currency.
Converted Amount : Displays the grand total amount converted to the
system default currency (grey box) and the viewing user's preferred
currency (if the Show Preferred Currency option is enabled).
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For more information about converted currency amounts, refer to the Updating
Currency Rates section of this page.

Note: Quote currencies work differently in Sugar Mobile. See the Totals and
Shipping section of the Android and iOS User guides for more information on how
the mobile application uses quote currencies.

Grand Total vs Converted Amount

The stock Quotes list view contains two fields, Grand Total and Converted Amount,
that differ in functionality. The Grand Total field displays the total sum of all the
groups and line items in the quote using the quote's selected currency while the
Converted Amount field displays the grand total amount converted to the system
default currency. If the viewing user's Show Preferred Currency option is enabled
in their user profile, the Converted Amount field will also display the converted
amount in the viewing user's preferred currency. For more information on setting
a user's Preferred Currency and Show Preferred Currency options, refer to the 
Getting Started documentation.

The primary differences between these fields and options are as follows:

Field Name Value Displayed Method to Update Value
Grand Total The total sum of all groups

and line items in the quote
using the quote's selected
currency

Updated by editing the
quote record

Converted Amount
(system default currency)

Grand Total amount
converted to the system
default currency based on
the system-defined
conversion rate

Updated by a scheduled
process when the relevant
exchange rate is modified
via Admin > Currencies.
For more information on
how currency changes
affect the Converted
Amount value please see 
Updating Currency Rates

Converted Amount (user's
preferred currency)

Grand Total amount
converted to the viewing

Updated by modifying the
relevant exchange rate via
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user's preferred currency
as specified in their user
profile based on the
system-defined conversion
rate

Admin > Currencies. For
more information on how
currency changes affect
the Converted Amount
value please see Updating
Currency Rates

Updating Currency Rates

When saving a quote in a currency that differs from the system-defined default
currency, Sugar will store the conversion rate for that currency at the record level.
This conversion rate is used to calculate the converted amounts when the quote's
currency differs from the system default currency. To keep amounts historically
accurate, the conversion rate will only update on a quote provided the quote stage
is not set to "Closed Accepted", "Closed Lost", or "Closed Dead". If the quote is in
any other stage, the conversion rate will update under the following scenarios:

The quote undergoes a save event (e.g. mass update, manual save, etc.)
and the record's currency has a different conversion rate defined in Admin
> Currencies than is currently saved in the quote.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all quotes
saved with that currency to the new rate.

When the viewing user's profile has the Show Preferred Currency option enabled,
the Converted Amount field displays the Grand Total amount in the user's
preferred currency. In this case, the conversion rate used to calculate the
Converted Amount's value is drawn directly from the conversion rate at the system
level rather than any conversion rate stored on the record. This means that the
value will always use the current conversion rate regardless of the opportunity's
sales stage. For this reason, the Converted Amount field should not be considered
historically accurate for closed quotes when it is using the user's preferred
currency. For information about setting a user's Preferred Currency and Show
Preferred Currency options, please refer to the Getting Started documentation.

For more information about currency exchange rates, please refer to the System
documentation in the Administration Guide.

Filtering on Currency Fields

Amount fields are filtered according to the record's set currency rather than being
standardized to the user's preferred or system default currency. In the list view,
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filtering quotes by a currency field allows you to specify the filter's currency. Only
records matching both the chosen currency and amount range will be returned.
For example, if you filter based on a Grand Total value of 1,082.50 in US Dollars,
then the search result will return a quote with a Grand Total value of $1,082.50
but will exclude values of €1,082.50 or other currency values which are equivalent
to $1,082.50.

When filtering by currency fields in reports, you will specify a number or range of
numbers for the filter and any record with a field value falling within that range,
regardless of the record's currency, will be returned. For example, if one quote's
Total value is $500 in US Dollars and another's is €500 in Euros, a report filtering
for a Total value of exactly 500 will return both records.

Last Modified: 2022-03-23 14:00:06

Quoted Line Items

Overview

Sugar's Quoted Line Items module consists of the individual line items which make
up your organization's sales quotes. These line items are all of the products that
have already been sold or are in the process of being sold to clients along with a
quantity, price, and potential discounts. Since a quote is made up of one or more
quoted line items, you will most often create quoted line items while creating the
quote itself. You can view the quoted line item's details in record view by clicking
the line item in a quote or by navigating to it directly via the Quoted Line Items
module if your administrator has enabled the module to appear in Sugar's
navigation bar. For more information about how quotes and quoted line items
interact, please refer to the Quotes and Quoted Line Items section of this page.

Each quoted line item will include a product that is being sold. The product can be
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selected from the product catalog or can be typed in manually. For more
information, please refer to the Products and Quoted Line Items section of this
page.

This documentation will cover information and actions specific to the Quoted Line
Items module. For instructions concerning views and actions which are common
across most Sugar modules, such as creating, editing, and deleting line items,
please refer to the Working With Sugar Modules section of this page.

Please note that you will only be able to see quoted line item records as allowed by
your team membership, user access type, and assigned roles. For more information
on teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Quoted Line Items module is not available for Sugar Serve users. For
more information on license types and the functionality available for each, refer to
the User Management documentation. 

Quoted Line Item Fields

The Quoted Line Items module contains a number of stock fields that come out-of-
the-box with Sugar. For information on using and editing various field types, refer
to the User Interface documentation. The definitions below are suggested
meanings for the fields, but the fields can be leveraged differently to best meet
your organization's needs. Users with administrator or developer access have the
ability to alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description
Account Name The account related to the quoted line

item's quote
Assigned To The Sugar user assigned to the quoted

line item record
Line Item Total Displayed on the quoted line item's

related quote worksheet, the line item's
value based on the Quantity, Unit Price,
and Discount Amount fields.

This value is shown on the quote's
worksheet, is automatically calculated,
and cannot be directly modified. To
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adjust the Line Item Total, you must edit
the quoted line item's quantity, unit
price, or discount amount on the record
view.

Note: Service Duration is only factored
into the calculation for line items related
to a product catalog record marked as a
service.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Contact Name The contact related to the quoted line
item's quote

Cost1, 2 The actual cost of the quoted line item's
product

Date Created The date the quoted line item record
was first saved

Date Modified The date the quoted line item record
was last modified

Description A description or other information about
the quoted line item

Discount Amount The quoted line item's discount amount
Discount Type The unit (i.e. percentage or the system's

default currency) applied to the value in
the Discount Amount field

List Price1, 2 The quoted list price of the product
Name The product's name as selected from the

product catalog list or manually entered
as new

Part Number1 The manufacturer's part number for the
quoted line item's product

Product Template The product catalog record, if any,
related to the quoted line item

Quantity The number of products being
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purchased
Quote Name The quote to which the quoted line item

relates
Note: Quoted line items will only be
related to quotes when they are created
from the quote's worksheet.

Renewable3 For line items with "Service" enabled,
select whether or not the service offered
can be renewed for additional time
periods. The Renewable field is used to
trigger renewal pipeline automation.

Service1,3 Designate this line item as a service.
Enabling the Service field will make the
Service Duration (required), Service
Start Date (required), and Renewable
fields available.

Service Duration1,3 For line items with "Service" enabled,
the period of time that this service
covers. The Service Duration and
Service Start Date fields are used to
calculate the Service End Date and,
when the Renewable field is set to yes,
the Service Duration will determine the
expected close date for future service
opportunities.

Service Start Date3 For line items with "Service" enabled,
select the date that the service will
begin. The Service Duration and Service
Start Date fields are used to calculate
the Service End Date. This field is
inherited from the product catalog but
can be edited on a line-item basis.

Service End Date3 For line items with "Service" enabled,
the Service End Date is calculated using
the Service Duration and Service Start
Date fields. Because this field is
automatically calculated, it cannot be
edited directly.

Status The current status of the quoted line
item

Subtotal The list price multiplied by the line
item's quantity before any discount is
applied
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Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
quoted line item record

Unit Price2 The unit price of the product

1. When a quoted line item is related to a product catalog record, this value
automatically populates from the related product and cannot be modified
on the quoted line item record. For more information on creating and
managing records in the Product Catalog, please refer to the Product
Catalog documentation in the Application Guide.

2. The displayed currency is based on the system's default currency as
configured by administrators in Admin > Locale unless the user's preferred
currency is defined in their user profile. You can change the quoted line
item's currency from these defaults as desired. If the user has enabled
"Show Preferred Currency" in their preferences, then Sugar will display the
value in their preferred currency. If the user has disabled "Show Preferred
Currency" in their preferences, then Sugar will display the value in the
system's default currency as configured by the Administrator.

3. For more information on service-related fields in Sugar Sell, refer to the
Services and Renewable Revenue Line Items section of the Opportunities
documentation.

In addition to the fields listed above, quoted line items that are related to a
product catalog record inherit the following field values from the product:

Asset Number
Book Value
Book Value Date
Pricing Formula
Product URL
Serial Number
Support Contact
Support Description
Support Expires
Support Starts
Support Term
Support Title
Tax Class
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Vendor Part Number
Weight

For more information on Product Catalog fields, please refer to the Product
Catalog documentation.

Working With Sugar Modules

While the Quoted Line Items module has some features that only apply to quoted
line items, it also uses the Sidecar user interface that most Sugar modules are
based on. In the table below, the left column contains links to the User Interface
page covering topics that are applicable to all Sidecar modules. The right column
has links to sections of the current page that cover topics specific to quoted line
items.

General Instructions for Working
With Sugar Modules

Quoted-Line-Items-Specific
Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Quoted-Line-Items-specific help
exists for each topic, use the links below
to navigate to sections of the current
page.

Creating Records Creating Quoted Line Items via Quotes
Viewing Records
Searching for Records Filtering on Currency Fields
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Exporting Records
Recalculating Calculated Values
Finding Duplicate Records
Merging Records
Viewing Record Audit Logs
Favoriting Records
Following Records
Sharing Records
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Quoted Line Item Menus

The Quoted Line Items module contains various options and functionality which
are available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Quoted Line Items-specific
functionality, within this page.

Module Tab Menus

The Quoted Line Items module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list and you can click "Quoted Line
Items" to access the list view. Once the Quoted Line Items tab displays on the
navigation bar, you can click the triangle within the tab to display the Actions,
Recently Viewed, and Favorites menu. The Actions menu allows you to perform
important actions within the module. The Recently Viewed menu displays the list
of quoted line items you most recently viewed. The Favorites Menu displays the list
of quoted line items you most recently marked as favorites.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Quoted Line Item Opens the record view layout to create a

new quoted line item

Note: You can only relate quoted line
items with a quote by creating them
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directly from a quote worksheet. For
more information, please refer to the 
Quotes documentation.

View Quoted Line Items Opens the list view layout to search and
display quoted line items

Import Quoted Line Items Opens the import wizard to create or
update quoted line items using external
data

If you do not see the Quoted Line Items module tab in Sugar, please check the
following:

The Quoted Line Items module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed.
Navigate to your user profile (upper right of Sugar), click the Advanced
tab, and check the Layout Options section. If you see the Quoted Line Items
module in the Hide Modules list, simply move it to the Display Modules list.
For more information on hiding and displaying modules, please refer to the 
Layout Options section of the Getting Started documentation.
The administrator may have disabled the Quoted Line Items module for
your entire Sugar instance. Reach out to your Sugar administrator to have
the Quoted Line Items module displayed. For more information on
displaying and hiding modules throughout Sugar, please refer to the 
Developer Tools documentation in the Administration Guide.

List View Menus

The Quoted Line Item list view displays all quoted line item records and allows for
searching and filtering to locate specific quoted line items. You can view the basic
details of each record within the field columns of the list view or click a quoted line
item's name to open the record view. To access a module's list view, simply click
the module's tab in the navigation bar at the top of any Sugar page..

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual quoted line item records or
click the checkbox in the list header to select all records displayed on the current
set of list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more quoted line

items at a time
Recalculate Values Mass update the calculated quote values

to reflect changes made in Studio
Merge Merge two or more duplicate quoted

line items
Delete Delete one or more quoted line items at

a time
Export Export one or more quoted line items to

a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual quoted line item directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this quoted line item in the

intelligence pane
Edit Edit this quoted line item
Follow Follow this quoted line item
Delete Delete this quoted line item

Record View Actions Menu

The Quoted Line Items record view displays a single quoted line item in full detail
including its fields, subpanels of related records, and activity stream. To access a
quoted line item's record view, simply click a hyperlinked quoted line item name
from anywhere within Sugar. The record view's Actions menu appears on the top
right of the page and allows you to perform various operations on the current
record.

The options in the Actions menu allow you to perform the following operations:
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Menu Item Description
Edit Edit this quoted line item.
Share Share a link to this quoted line item via

email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Quoted
Line Items module via Admin > 
PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the Quoted
Line Items module via Admin > 
PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Find Duplicates Locate potential duplicates of this
quoted line item.

Copy Create a duplicate record of this quoted
line item.

View Audit Log View a record of changes to this quoted
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line item.
Delete Delete this quoted line item.

Quotes and Quoted Line Items

Quotes are often an integral part of an organization's negotiation and completion
of sales. In Sugar, the Quotes module serves as a header for the sale and includes
information about the entire transaction such as the billing address, total amounts,
and stage. Each quote contains one or more quoted line items that represent each
kind of item or service that is being sold. Quoted line items include the quantity,
prices, and discounts specific to a single product.

Creating Quoted Line Items via Quotes

Since a quote is made up of one or more quoted line items, you will most often
create quoted line items while creating or editing the quote itself. The Quotes
detail view layout allows you to add line items and select products. For more
information about products, please refer to the Products and Quoted Line Items
section of this page. Each line added to a quote becomes a new quoted line item
record upon save. For more information on adding quoted line items to quotes,
please refer to the Quotes documentation.

After adding a quoted line item to a quote, you can navigate to the quoted line
item's record view by clicking its hyperlinked name on the quote worksheet.

Note: Quoted line items only appear on a quote record when it is created directly
from the Quotes module. For more information, please refer to the Quotes
documentation.
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Products and Quoted Line Items

Sugar's Product Catalog module contains a list of all products or services that your
organization sells. This module provides the Quoted Line Items and Revenue Line
Items modules with the template used when creating products to be used for 
Quotes and Opportunities, including pricing and cost information as well as
information about the manufacturer. As of Sugar 10.0, the Product Catalog,
Product Categories, Product Types, and Manufacturers modules are accessible by
all users. For information and actions specific to those modules, please refer to the
Product Catalog documentation in the Application Guide.

When adding products as quoted line items, you may select a product from your
database's Product Catalog module or you may manually enter a new product on
the fly. Either way, each line item added to a quote will create a new record in the
Quoted Line Items module. After adding a quoted line item to a quote, you can
navigate to the quoted line item's record view by clicking its hyperlinked name on
the quote worksheet.

If you selected a product from the product catalog, the Line Item field will be
populated with the product's name on the quoted line item's record view. However,
if you manually entered a product to your quoted line item, then the Line Item field
will not be populated since the product does not exist in the product catalog.

Currencies and Quoted Line Items

Sugar allows your organization to perform business around the world by
supporting multiple currencies. Administrators must first add desired currencies
and exchange rates to Sugar via Admin > Currencies. They also have the ability to
set the instance's default currency via Admin > Locale. This is typically the
currency of the country where the majority of business is conducted. For more
information, please refer to the System documentation in the Administration
Guide.

By default, the Unit Price, Cost, and List Price fields will display using the system's
default currency unless the user's preferred currency is defined in their user
profile. For more information on configuring your preferred currency, refer to the 
Getting Started documentation. Please note that the quoted line item's currency
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can be changed from these defaults to the specific currency being used for the
particular business transaction.

Note: The Show Preferred Currency option in the user's profile will not affect the
Quoted Line Items record view to convert the saved amounts using the user's
preferred currency. This is different from how quoted line item currencies work in
Sugar Mobile. See the Working With Quoted Line Items section of the Android and 
iOS User guides for more information.

Filtering on Currency Fields

Currency fields are filtered according to the record's set currency rather than
being standardized to the user's preferred or system default currency. In the list
view, filtering quoted line items by a currency field allows you to specify the filter's
currency. Only records matching both the chosen currency and amount range will
be returned. For example, if you filter based on a Unit Price value that equals 100
in US Dollars, the search result will return all quoted line item records with a unit
price of $100 and will exclude other currency (e.g. $, ) values which are equivalent
to $100.

Note: By contrast, when filtering values in the Reports module, any record
matching the specified amount or range will be returned regardless of the record's
currency. For example, if one quoted line item's Unit Price value is $500 in US
Dollars and another's is €500 in Euros, filtering a report for a Likely value of
exactly 500 will return both records in the report.

Updating Currency Rates

When saving a quoted line item in a currency that differs from the system-defined
default currency, Sugar will store the conversion rate for that currency at the
record level. This conversion rate is used to calculate the converted amounts when
they are set to use the system default currency (as opposed to the user's preferred
currency which is explained below). To keep amounts historically accurate, the
conversion rate will only update on a quoted line item provided the status is not set
to "Shipped". If the line item is in any other sales stage, the conversion rate will
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update under the following scenarios:

The quoted line item undergoes a save event (e.g. mass update, manual
save, etc.) and the record's currency has a different conversion rate defined
in Admin > Currencies than is currently saved in the line item.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all quoted line
items saved with that currency to the new rate.

For more information about currency exchange rates, refer to the System
documentation in the Administration Guide.

Last Modified: 2020-09-29 16:34:37

Product Catalog

Overview

Sugar's Product Catalog and its supporting modules allow you to define,
categorize, and organize a list of all products or services that your organization
sells or supports. Products within the Product Catalog can be broadly classified
into product types, such as Software and Hardware. Each product type can be
further organized into several product categories. For example, the software
product type can contain product categories such as Spreadsheets and Word
Processors. You can also create sub-categories within a category. Users can define
the details of their products within the following products-related modules:

Module Description
Product Catalog

List of products sold by your
organization; used as a template for the
Quoted Line Items and Revenue Line
Items modules

Product Categories The categories by which products are
organized in the Product Catalog

Product Types The Type dropdown list in the Product
Catalog
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Manufacturers The Manufacturer Name dropdown list
in the Product Catalog

This documentation will cover information and actions specific to the above
modules. For instructions concerning views and actions which are common across
most Sugar modules, such as creating, editing, and deleting records, please refer
to the Working With Records section of this page.

Please note that you will only be able to see products-related records as allowed by
your license type, team membership, assigned roles, and user access type. For
more information, please refer to the referenced documentation in the
Administration Guide.

Product Catalog

Sugar's Product Catalog module contains a list of all products or services that your
organization sells or supports. This module provides the Quoted Line Items and
Revenue Line Items modules with the template used when creating products to be
used for Opportunities and Quotes, including pricing and cost information and
information about the manufacturer. The Product Catalog may also provide a list of
products available for selection in the Cases, Bugs, and Knowledge Base modules if
your administrator has enabled the functionality in Studio. For Sugar Serve users
to leverage the Product Catalog, an administrator would need to add a custom
relate field to a supported Sugar Serve module (i.e., Bugs, Cases, or Knowledge
Base). For more information on setting up a Product Catalog field for bugs, cases,
or knowledge base articles, please refer to the Creating a Relate Field article.

Note: Depending on your license type, you may not have access to all modules
(e.g. Sugar Sell users will not have access to Bugs). For more information on
license types and the functionality available for each, refer to the User
Management documentation. 

Product Catalog Fields

The Product Catalog contains a number of stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Fields can be altered, added, or removed via Admin > Studio.
For more information on configuring fields, please refer to the Studio
documentation in the Administration Guide.
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Field Description
Availability Select if the item is in stock or not from

the dropdown list
Category Name The product category to which the new

item belongs
Cost The actual cost of the item. This will not

appear on printed quotes
Currency The currency of the given prices (Cost,

List, Unit)
Date Available Select the date of availability if the item

is out of stock
Date Created The date the product catalog record was

created
Date Modified The date the product catalog record was

last modified
Date-Cost-Price The starting date that the cost is valid
Default Pricing Formula Select a formula from the dropdown list

to arrive at the discount price for the
Unit Price field. The formulas are as
follows:

Fixed Price: Allows you to enter
a Unit Price without any
calculation.
Profit Margin: Enter the points
in the adjoining field to vary the
percentage against the cost.
Markup over Cost: Choose a
percentage to raise the price
over the cost.
Discount from List: Enter the
discount percentage from the
List Price in the adjoining field.
Same as List: The Unit Price
will be the same as the List
Price.

Description A description or other information about
the product

List Price The quotable list price of the product
Manufacturer Name The manufacturer of the product
Part Number The manufacturer's part number for the
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product
Product Name The name of the product
Product URL The web address of product if it is

available online
Quantity in Stock Enter the number of units that are in

stock of the product

Note: Negative values are supported in
this field.

Renewable1 Activated when the Service field is set to
yes, select whether or not the service
offered can be renewed for additional
time periods. When "Renewable" equals
yes, it will trigger the renewal pipeline
automation feature for Sugar Sell users.

Service1 Designate this product catalog record as
a service. Enabling the Service field will
make the Service Duration (required)
and Renewable fields available.

Service Duration1 Required when the Service field is set to
yes, set the period of time that this
service covers. When the Renewable
field is also set to yes, the Service
Duration will determine the expected
close date for future service
opportunities.

Support Contact The support person's contact
information, such as the phone number
or email address

Support Desc. Brief description or other information
regarding the support provided

Support Name The name of the Customer Support
person

Support Term The term (e.g. six months, one year,
etc.) in which support will be provided
for the product

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.
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Tax Class Tax classification (e.g. taxable, non-
taxable) for the product

Teams The Sugar team(s) assigned to the
product catalog record

Type The specified product type
Unit Price The unit price of the product
Vendor Part Number The vendor's part number for the

product
Weight The weight of the product

Note: Negative values are supported in
this field.

1 For more information on service-related fields in Sugar Sell, refer to the Services
and Renewable Revenue Line Items section of the Opportunities documentation in
the Application Guide.

Product Categories

The Product Categories module allows you to create categories to group records
under a Product Type. This is one of the levels of organization you can use for the
products and services that your organization offers, and will contain multiple
entries from the product catalog.

Product Category Fields

The Product Category module contains four stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields.

Field Description
Product Category The category's name as it will appear on

the Product Category dropdown list
Parent Category Select a parent product category if this

product category is a sub-set of another
category

Note: A record should not be selected
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as its own parent category.
Description A description or other information about

the product category
Order Enter a number to specify the order in

which this category will appear in the
Product Category dropdown list

Product Types

The Product Types module controls the Type dropdown list in the Product Catalog
fields. In addition to product categories, the product type allows you to define the
classification of a product or service that is being offered on a product catalog
record.

Product Type Fields

The Product Types module contains three stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields.

Field Description
Product Type The product type's name as it will

appear on the Type dropdown list in the
product catalog

Description A description or other information about
the product type

Order Enter a number to specify the order in
which this product type will appear in
the Type dropdown list

Ordering Product Types

The Order field in Product Types defines the order of the different type options
when viewing the Type dropdown list of a Product Catalog record. The Order field
allows you to organize what order the dropdown list will display, with 1 being the
highest on the list and moving down as the order number rises. When creating new
product type record options, the Order field will automatically increment to the
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next number in the list, thereby adding the new option to the bottom of the list.
The Order field can be overwritten with another number if you would like to
manually re-order the options.

Manufacturers

The Manufacturers module controls and maintains the Manufacturer Name field in
the Product Catalog module. The Manufacturer Name field allows you to select
from a list of the manufacturers you use to classify your products and specify from
which manufacturer they are produced.

Manufacturer Fields

The Manufacturers module contains three stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The below definitions are suggested meanings for
the fields.

Field Description
Manufacturer The manufacturer's name as it will

appear in the Manufacturer Name field
in the product catalog

Status Select "Active" or "Inactive" to indicate
which manufacturers are displayed as
options in the Manufacturer Name field

Order Enter a number to specify the order in
which this category will appear in the
Manufacturer Name field list

Ordering Manufacturers

The Order field in the module defines the order in which the manufacturer options
are displayed in the corresponding Manufacturer Name field of the Product
Catalog module. Enter the numeric value (e.g. 1, 2, 3) in the manufacturer record's
Order field to determine the order it will display in the corresponding field list
(Manufacturer Name). For example, a manufacturer record with an order value of
"1" will display at the top of the list followed by the next value (e.g. 2), and so
forth. When creating new manufacturer records, the Order field will automatically
increment to the next number in the list, thereby adding the new option to the
bottom of the list. The Order field can be overwritten with another number if you
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would like to manually re-order the options.

Working With Products-Related Modules

The Product Catalog and supporting modules use Sugar's Sidecar user interface.
The following sections detail menus, views, and actions common to sidecar
modules and contain links to additional information within the page or links to the
User Interface documentation.

Menus

Sugar modules contain various options that are available via menus in the module
tab, list view, and record view. The following sections present each menu type and
its options with links to more information about each option in the User Interface
documentation or, for module-specific functionality, within this page.

Module Tab Menus

The module tab is either displayed in the navigation bar or found by clicking the
"More" icon represented by three vertical dots to the right of the module tabs on
the navigation bar. Click the module name to access the module's list view or
expand the module tab to display the Actions, Recently Viewed, and Favorites
menus. 

From the Product Catalog's module tab menu, you can also access the supporting
modules of Manufacturers, Product Categories, and Product Types. By navigating
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to any of these modules, you can access their respective module tabs, which in
turn will offer the option to return to any of the other supporting modules. 

The Actions menus in the module tab for the Product Catalog and its supporting
modules will allow you to perform the following operations:

Menu Item Description
Create [Record] Opens the record view layout to create a

new record in the module
View Product Catalog Opens the list view layout to search and

display the product catalog
View Manufacturers Opens the Manufacturers list view
View Product Categories Opens the Product Categories list view
View Product Types Opens the Product Types list view
Import [Records] Opens the import wizard to create or

update records in modules that support
importing

List View Menus

The list view displays all records meeting the current search criteria. You can view
the basic details of each record within the field columns. Users with administrator
or developer access have the ability to change what fields are visible in the list
view via Admin > Studio. For more information on editing layouts, please refer to
the Studio documentation.

Mass Actions Menu

The Mass Actions menu to the right of the checkbox option allows you to perform
various actions on the currently selected records.
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The options in the Mass Actions menu allow you to perform the following
operations:

Menu Item Description
Mass Update Mass update one or more records at a

time
Recalculate Values Updates calculated values to reflect

changes to calculated fields made in
Studio (Available in certain
circumstances)

Merge Merge two or more duplicate records
Delete Delete one or more records at a time
Export Export one or more records to a CSV file

Record Actions Menu

The Record Actions menu to the right of each record's Preview button allows users
to edit, follow, or delete specific records directly from the list view.

The options in the Record Actions menu allow you to perform the following
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operations:

Menu Item Description
Preview (Eye icon) Preview this record in the intelligence

pane
Edit Edit this record
Delete Delete this record

Record View Actions Menu

The record view displays thorough record information including all record fields.
The record view can be reached by clicking a record's link in the list view. You
have the ability to change the record view by configuring the layout via Admin >
Studio. For more information on editing layouts, please refer to the Studio
documentation.

The Actions menu on the top right of each record view allows you to perform
various actions on the current record.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this record
Share Share a link to this record via email
Download PDF Download record information as a PDF

file
Email PDF Email record information as a PDF
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attachment
Find Duplicates Locate potential duplicates of this

record
Copy Duplicate this record
View Audit Log View a record of changes to this record
Delete Delete this record

Common Views and Actions

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules.

Content Link Description
Creating Records
Basic Record Creation
Creating Via Subpanels
Creating Via Duplication
Importing Records

The Creating Records section covers the
various methods of creating new
records, including via the Create button
in the module, via the subpanel on
related module records, duplication of
an existing record, and importing a list
of records into Sugar using a .csv
spreadsheet.

Viewing Records
Viewing Via List View
Viewing Via Record View
Viewing Via Recently Viewed
Viewing Via Preview
Viewing Via Reports

The Viewing Records section describes
the various methods of viewing records,
including via the list view and record
view, the Recently Viewed menu in the
module tab, previewing records in the
right-hand side panel, and reports
displaying the record's data.

Searching for Records
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating Sugar
records: global search, which searches
across all Sugar modules, and list view
search, which searches and filters
within the module.

List View
Total Record Count
Create Button
List View Search

The List View section walks through the
many elements of the List View layout,
which contains a filterable list of all
records in the current module. While the
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Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Records
Dashboards

generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the list view are described in the List
View Mass Actions Menu and List View
Record Actions Menu sections of the
module overviews below. 

Record View
Favorite Designation
Next or Previous Record
Actions Menu
Show More
Dashboards

The Record View section walks through
the many elements of the Record View
layout, which contains detailed
information about a single record. While
the generic menu options are described
in the User Interface sections linked to
the left, the options specifically
available in the record view are
described in the Record View Actions
Menu sections of the module overview
sections below.

Editing Records
Editing Inline Via Record View
Editing Via Record View
Editing Inline Via Subpanels
Editing Inline Via List View
Mass Editing Via List View

The Editing Records section describes
the various methods of editing existing
records, including inline via the record
view, in full edit mode on the record
view, inline via the subpanel on related
module records, inline via the list view,
and via the Mass Update option on the
list view.

Deleting Records
Deleting Via Record View
Deleting Via List View
Mass Deleting Via List View

The Deleting Records section describes
the various methods of deleting
unwanted records, including via the
record view, an individual record's
Actions menu on the list view, and the
Mass Actions menu on the list view.

Exporting Records The Exporting Records section provides
an introduction to the export
functionality, which allows you to
download a list of records and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
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the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Records The Finding Duplicate Records section
provides instructions for locating
duplicate records. If searching on
matching fields (e.g. Name) identifies
one or more duplicates, they can be
merged into a single record.

Merging Records
Merging Via List View

The Merging Records section provides
instructions for merging duplicates,
which combines field values and related
records into a single record.

Favoriting Records
Favoriting via List View
Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking records as favorites, including
via the list view and record view.

Note: You can only mark records as
favorites via the Product Catalog
module. Favoriting a product catalog
record allows you to easily access the
product from the list view, Product
Catalog Quick Picks dashlet, the Product
Catalog module tab, or from within the
search and select drawer. For more
information on the Product Catalog
Quick Picks dashlet, please refer to the
Opportunities or Quotes
documentation. 

Sharing Records The Sharing Records section provides
instructions for the Share record view
option, which composes an email with a
link to the record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the record view.

Last Modified: 2021-03-03 14:56:51
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Contracts

Overview

Sugar's Contracts module consists of individual business arrangements your
organization has with vendors, customers, or association. There are various ways
you can create contracts in Sugar such as via the Contracts module, importing
contracts, duplication, etc. Once the contract record is created, you can view and
edit information pertaining to the contract via the Contracts module. Each contract
record may then relate to other Sugar records such as opportunities, documents,
quotes, and many others. This documentation will cover the basics of the Contracts
module as well as the various options available in performing the actions related to
the module. For instructions concerning views and actions which are common
across most Sugar modules, such as creating, editing, and deleting contract
records, please refer to the Working With Sugar Modules section of this page.

The Contracts module is not available for Sugar Serve users. For more information
on license types and the functionality available for each, refer to the User
Management documentation. 

Please note that you will only be able to see contract records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: By default, the Contracts module is hidden in Sugar and the system
administrator must enable the module via Admin > Display Modules and
Subpanels. For more information on displaying modules in Sugar, please refer to
the Developer Tools documentation in the Administration Guide.

Contract Fields

The Contracts module contains a number of stock fields which come out-of-the-box
with Sugar. For information on using and and editing various field types, refer to
the User Interface documentation. The below definitions are suggested meanings
for the fields, but the fields can be leveraged differently to best meet your
organization's needs. Users with administrator or developer access have the ability
to alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description
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Account Name The account to which the contract
belongs

Assigned To The Sugar user assigned to the contract
Comment Log A shared log of messages, comments, or

other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Company Signed Date Date on which your organization signed
the contract

Contract Name The name or designation of the contract
Contract Term Calculation of days between the start

and end date of the contract
Contract Value The value of the contract for the

specified currency
Customer Signed Date Date on which the account signed this

contract
Date Created The date the contract record was

created
Date Modified The date the contract record was last

modified
Description A description or other information about

the contract
End Date Date on which this contract expires
Expiration Notice Date and time to send a reminder to the

assigned user indicating that this
contract will expire shortly
Note: Assignment notifications must be
turned on and the "Process Workflow
Tasks" scheduler must be running.

Opportunity Name The opportunity if any, from which the
contract originated or is related to

Reference Code The internal designation used to refer to
this contract

Start Date Date on which this contract takes effect
Status The current status of the contract (e.g.
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Not Started, In Progress, Signed)
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
contract record

Type Name The contract type assigned to the record
Note: Contract types can be created
and managed via Admin > Contract
Types.

Working With Sugar Modules

While the Contracts module has some features that only apply to contracts, it also
uses the Sidecar user interface that most Sugar modules are based on. In the table
below, the left column contains links to the User Interface page covering topics
that are applicable to all Sidecar modules. The right column has links to sections of
the current page that cover topics specific to contracts.

General Instructions for Working
With Sugar Modules

Contracts-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Contracts-specific help exists for
each topic, use the links below to
navigate to sections of the current page.

Creating Records
Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Exporting Records
Recalculating Calculated Values

                       548 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Tags
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Searching_for_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Intelligence_Pane
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Exporting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Recalculating_Calculated_Values


 

Finding Duplicate Records
Merging Records
Viewing Record Audit Logs
Record PDFs
Favoriting Records
Following Records
Sharing Records

Contract Menus

The Contracts module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Contracts-specific
functionality, within this page.

Module Tab Menus

The Contracts module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences with the remaining
displayed modules grouped under the More tab. For more information on displayed
modules for the navigation bar, please refer to the Layout Options section of the
Getting Started documentation.

Note: By default, the Contracts module is hidden in Sugar and the system
administrator must enable the module via Admin > Display Modules and
Subpanels. For more information on displaying modules in Sugar, please refer to
the Developer Tools documentation in the Administration Guide.

Click the tab to access the Contracts list view. You may also click the triangle in
the Contracts module tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important operations within the
module. The Recently Viewed menu displays the list of contracts you most recently
viewed. The Favorites menu displays the list of contracts you most recently marked
as favorites.
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The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Contract Opens the record view layout to create a

new contract
View Contracts Opens the list view layout to search and

display contracts
Import Contracts Opens the import wizard to create or

update contracts using external data

If you do not see the Contracts module tab in Sugar, please check the following:

By default, the Contracts module is hidden in Sugar and the system
administrator must enable the module via Admin > Display Modules and
Subpanels. For more information on displaying modules in Sugar, please
refer to the Developer Tools documentation in the Administration Guide.
The Contracts module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Contracts module in the Hide
Modules list, simply move it to the Display Modules list and save. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Contracts module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Contracts module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.

List View Menus

The Contracts list view displays all contract records and allows for searching and
filtering to locate specific contracts. You can view the basic details of each record

                       550 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Basic_Record_Creation
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Importing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools#Display_Modules_and_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Getting_Started#Layout_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Getting_Started#Layout_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools#Display_Modules_and_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View


 

within the field columns of the list view or click on a contract's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual contract records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more contracts at a

time
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

Merge Merge two or more duplicate contracts
Delete Delete one or more contracts at a time
Export Export one or more contracts to a CSV

file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
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perform actions on the individual contract directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this contract in the intelligence

pane
Edit Edit this contract
Follow Follow this contract
Delete Delete this contract

Record View Actions Menu

The Contracts record view displays a single contract in full detail including its
fields, subpanels of related records, and activity stream. To access a contract's
record view, simply click a hyperlinked contract name from anywhere within
Sugar. The record view's Actions menu appears on the top right of the page and
allows you to perform various operations on the current record.

The Actions menu allows you to perform the following operations: 
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Menu Item Description
Edit Edit this contract record.
Share Share a link to this contract via email. 

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Contracts
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the Contracts
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Find Duplicates Locate potential duplicates of this
contract record.

Copy Duplicate this record to create a new
contract.

View Audit Log View a record of changes to this
contract record.
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Delete Delete this contract.

Last Modified: 2020-02-20 21:22:26

Documents

Overview

Sugar's Documents module gives your users a way to access and update company-
specific files. These files can range from internal policies to customer-distributed
content. There are various ways you can create documents in Sugar such as via the
Documents module and via the quick-create menu. Once the document record is
created, you can view and edit information pertaining to the document via the
Documents detail view. Each document record may then relate to other Sugar
records such as accounts, cases, opportunities, and many others. This
documentation will cover how to use the Documents module as well as the various
actions and options available from within the module.

Document Fields

The Documents module contains a number of stock fields that come out-of-the-box
with Sugar. The below definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs. Users
with administrator or developer access have the ability to alter, add, or remove
fields via Admin > Studio. For more information on configuring fields, please refer
to the Studio documentation in the Administration Guide.

Field Description
Assigned To The Sugar user assigned to the

document
Category Primary category for locating

documents
Description A description or other information about

the document
Document Name The name or designation of the

Document (Defaults to the filename of
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the Document)
Document Type The type of the Document (e.g. NDA,

Mail Merge, License Agreement, etc.)
Expiration Date The date the Document expires
File Name Click "Choose File" to navigate to the

location to upload a Document
Publish Date The date the Document is published

(Defaults to today)
Related Document A Document record that is related to

this Document
Related Document Revision The Related Document's current

revision
Revision The most recent revision number for the

Document
Note: The Revision field becomes read-
only after the initial save.

Source Where the Document is stored (i.e
Sugar, Google, IBM SmartCloud, etc.)

Status The current status of the document (e.g.
Active, Draft, Expired, etc.)

Sub Category Secondary category for locating
documents

Teams The Sugar team(s) assigned to the
document record

Template Classifies a Document as a template or
not

Documents Module Tab

The Documents module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list and you can click "Documents"
to access the list view. Once the Documents tab displays on the navigation bar, you
can click the triangle within the tab to display the Actions, Recently Viewed, and
Favorites menu. The Actions menu allows you to perform important actions within
the module. The Recently Viewed Menu displays the list of documents you last
viewed in the module. The Favorites Menu displays the list of documents you most
recently marked as favorites in the module.

                       555 / 1.116



 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Document Opens the edit view layout to create a

new document
View Documents Opens the list view layout to search and

display documents

If you do not see the Documents module tab in Sugar, please check the following:

The Documents module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Documents module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.

The administrator may have disabled the Documents module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Documents module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

Creating Documents

There are various methods for creating documents in Sugar including via the
Documents module, quick create, and via duplication. The full edit view layout
opens when creating the document directly from the Documents menu and
includes all of the relevant fields for your organization's documents. The Edit View
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layout can be configured by administrators via Admin > Studio. For more
information on configuring layouts, please refer to the Studio documentation in the
Administration Guide.

Creating Via Documents Module

You can create a library of documents and graphics that you can share with other
users and contacts, ranging from marketing collateral to contracts. You can also
create templates for frequently used documents. One of the most common methods
of document creation is via the Create Document option in the Documents module
tab. This opens up the edit view layout which allows you to enter in all the relevant
information for the document.

Use the following steps to create a document via the Documents module:

1. Click the triangle in the Documents module tab to open the actions menu
and select "Create Document".

2. Enter appropriate values for the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save".

Creating Via Google Docs

Sugar has the ability to create documents in the system that are linked to external
sources, the most popular of these is Google Docs or Google Drive.

Use the following steps to create a document linked to Google Docs via the
Documents module:

1. Click the triangle in the Documents module tab to open the actions menu
and select "Create Document".

2. Select "Google Docs" from the Source dropdown to reveal the External
Source selector.
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Note: If Google Docs is not an option in the Source dropdown, then you
most likely need to connect your Sugar account to your Google Id through
your user profile. For more information on how to connect to your Google
Id in Sugar, please refer to the Google Docs Integration section in this
documentation.

3. Click "Choose File" to navigate to a file on your local computer. The
selected file will be uploaded to Google Docs. Not all file extensions are
currently supported for uploading to Google Docs.
The following file extensions are currently allowed:

File Description
CSV Comma Separated Values
DOC Microsoft Word 97-2004
DOCX Microsoft Word
HTML Web Text File
HTM Web Text File
JPG Image File
ODS OpenDocument Spreadsheet
ODT OpenDocument Text
PDF Portable Document Format
PNG Image File
PPT Microsoft PowerPoint Presentation
PPS Microsoft PowerPoint Slideshow
RTF Rich Text Format
SXW OpenOffice.org XML
TAB Tab Separated Values
TXT Plain Text
TEXT Plain Text
TSV Tab Separated Values
XLS Microsoft Excel 97-2004 Workbook
XLSX Microsoft Excel Workbook
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4. Alternatively, click "File on External Source" to reveal the external source
selector.

5. Click the arrow button to launch the selector. This window will show the 20
most recently modified documents in your Google Drive.
Note: This will only show documents owned by you in your Google Drive,
and will show documents from all folders in your drive.

6. Use the Search box to find a specific document. Select a document by
clicking on the document's file name.

7. Enter appropriate values for the remaining fields in the edit view layout. All
required fields are marked with a red asterisk and must be completed prior
to saving.

8. Once the necessary information is entered, click "Save".

Note: Documents that link to an external account (e.g. Google Docs, IBM Smart
Cloud) cannot be used as attachments in emails composed through the Sugar
Email Client.

Creating Via Quick Create
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The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also quick-create a document from any Documents
subpanel on related module records.

Use the following steps to create a document via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and
select "Create Document". You can also click the Plus button on any
Documents subpanel on a related module's record view (for Sidecar
modules) or select "Create" on any Documents subpanel on a related
module's detail view (for Legacy modules).
From Quick Create menu:

From Documents subpanel (for Sidecar modules):

From Documents subpanel (for Legacy modules):

2. Enter appropriate values in the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

3. If creating the document via the Documents subpanel in a Legacy module
and additional fields are desired, click the Full Form button to use edit view
instead.

4. Once the necessary information is entered, click "Save".
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Creating Via Duplication

You can also create a new document by duplicating an existing document record.
The Copy option is useful if the document you are creating has similar information
to an existing document. Related records on the original document will not be
related to the newly created document, but the last revision of the original
document will copy over to the new document with the change log contents:
"Document Created".

Use the following steps to create a document by duplicating an existing record:

1. Navigate to a document record's detail view.
2. Click the Actions menu and select "Copy".

3. The displayed edit view is pre-populated with the original document's
values. Update the necessary fields, then click "Save".

Note: The Source and File Name fields can not be modified when
duplicating a document.
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Viewing Documents

There are various options available for viewing document records in Sugar
including via Documents list view, Documents detail view, Documents Recently
Viewed menu, dashlets, and reports. Please note that you will only be able to see
document records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

Viewing Via List View

The Documents list view displays all document records meeting the current search
criteria. To access the list view, simply click the documents module tab. While list
view shows key document fields, you can click the document's name to open the
record in detail view. For more information on viewing documents via list view,
please refer to the Documents List View section of this documentation.

Viewing Via Detail View

The Documents detail view displays thorough document information including all
document fields followed by subpanels of the document's related records
belonging to various modules. The detail view can be reached by clicking a
document record's link from anywhere in the application including from the
Documents list view. For more information on viewing documents via detail view,
please refer to the Documents Detail View section of this documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which documents you have recently viewed.
Click the Actions menu in the Documents module tab to see a list of your most
recently viewed documents, and click each name to open the document in detail
view.
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Viewing Via Dashlets

Sugar Dashlets allow users to get a quick view of various records, activities,
reports, etc. Dashlets may be added to a user's Home page or to the intelligence
pane for Sidecar modules (e.g. Accounts, Contacts, etc.).You can view document
information in document-based dashlets such as "My Documents". Clicking a
document's name from any dashlet will open the document in detail view. For more
information on using dashlets and viewing document records via dashlets, please
refer to the Dashboards and Dashlets documentation.

Viewing Via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding documents and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the document record's detail view by clicking the document's
name in the report results. Please note that you can only directly access document
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detail views with Rows and Columns-type and Summation with Details-type reports
as Summation-type and Matrix-type reports do not include hyperlinks in their
display columns. For more information on using reports, please refer to the 
Reports documentation.

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration Guide. Check with your system administrator if you cannot
access the Reports module.

Searching Documents

The Documents list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Documents list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %agreement). This will
pull up any record that has the word "agreement" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.
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The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Favorites : Select this box to return only records you have marked as
favorites.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Favorites" and enter a document name, Sugar will only return
document records with a matching name that you have marked as favorites. Once
the search is complete, the relevant results will populate in the list view below the
search panel. To see all document records to which you have access, simply click
"Clear" and then "Search" to perform a blank search with no filters. Please note
that you will only be able to see document records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Administrators can configure what fields appear on the Documents Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Favorites : Select this box to return only records you have marked as
favorites.
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Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches that you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter a document name to search, Sugar will only return document
records with a matching name that you have marked as favorites. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all document
records to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
document records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

Administrators can configure what fields appear on the Documents Advanced
Search via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation in the Administration Guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full-Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right-hand side of Sugar. You can click the
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magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.

To use global search, you need to first enter the keyword into the search box and
the pop-up results will begin appearing once you enter in at least one character.
Clicking the magnifying glass icon or hitting your Return/Enter key will cause
Sugar to return exact matches for your keyword rather than matches with words
beginning with your keyword. For more information on using and configuring
Global Search, please refer to the Global Search section of the Search
documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results by clicking the down arrow within the
Search box then selecting the module(s) to include in the search. For more
information on configuring your Global Search, please refer to the Search
documentation. Administrators can control additional elements of global search via
Admin > Search and Admin > Studio. For more information on administrator
configuration of Global Search, please refer to the Field Options section of the
Studio documentation as well as the Search section of the System documentation
in the Administration Guide.

Documents List View

The Documents list view displays all document records meeting the current search
criteria and to which your user has access. You can view the basic details of each
document within the field columns. Please note that you will only be able to see
document records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Documents Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration Guide.

Pagination

                       567 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Global_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Advanced_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Field_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Layout_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Layouts


 

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection

You can perform several actions on document records directly from the list view by
first selecting the desired records. To select individual document records on the
Documents list view, mark the checkbox on the left of each row. To select or
deselect multiple document records on the list view, use the options in the
checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of
document results.
Select All : Selects all records in the current search results across all
pages of document results.
Deselect All : Deselects all records that are currently selected.

Mass Actions Menu
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The Mass Actions menu to the right of the checkbox dropdown allows you to
perform various actions on the currently selected records.

The options in the Mass Actions menu allow you to perform the following
operations:

Menu Item Description
Delete Delete one or more documents at a time
Mass Update Mass update one or more documents at

a time
Export Export one or more documents to a CSV

file

Favorite Designation

Users have the option to mark document records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Documents module tab. In the Documents list view, the star on the left of each
document's row is yellow once marked to indicate a favorite document. For more
information on how to mark records as favorites, please refer to the Favoriting
Documents section of this documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
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will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Documents Detail View

The Documents detail view displays thorough document information including all
document fields which are grouped by default into the Overview and Revision
Details panels. You can also view a document's related records (Document
Revisions, Related Contracts, Accounts, etc.) which appear in subpanels beneath
the document fields. The detail view can be reached by clicking a document
record's link from anywhere in the application including from the Documents list
view.

Please note that you will only be able to view a document record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Actions Menu

The Actions menu on the top left of each document's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration Guide.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this document
Copy Duplicate this document
Delete Delete this document

Favorite Designation

Users have the option to mark document records as a favorite via the detail view
as well as the list view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Documents module tab. In the Documents detail view, the star on the right of the
document's name is yellow once marked to indicate a favorite document. For more
information on how to mark records as favorites, please refer to the Favoriting
Documents section of this documentation.

Next or Previous Record

On the upper right of the Documents detail view, there are two buttons that allow
you to page through each document in the Documents list view's current search
results. Clicking the Previous button displays the previous document of the current
search results while clicking the Next button displays the next document of the
current search results. The text in between shows which document result you are
currently viewing within the total number of current results.
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Subpanels

Beneath a document record's fields are subpanels containing related records from
various modules as well as the document revision history.

Related Records Subpanels

The most common type of subpanels displayed on a document's detail view
contains the document's related records belonging to various modules. The
relationship type determines whether a related record will be displayed in the field
listing or in a subpanel. For example, a document may be related to only one other
document but related to multiple accounts. This means that the related document
will be displayed amongst the document's fields while accounts will be displayed in
a subpanel beneath the fields.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information modifying subpanels, please refer to the Studio documentation in
the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration Guide.

To view the details of a related record, click the record's name in the
subpanel or choose "View" from the Actions menu on the far right of the
record's row to open it in record view.
To relate an existing record to the document, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the document, choose "Create" from the
subpanel's Action menu, then complete the record view layout and click
"Save".
To delete the document's relationship to a record, choose "unlink" from the
Actions menu on the far right of a record's row. This removes the
relationship but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Please note that administrators can prevent users from moving subpanels to
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different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration Guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Document Revisions Subpanel

The Document Revisions subpanel lists the document revisions for this document
record. The revisions are sorted in descending order on the revision number by
default. Each revision retains the copy of the document loaded on that revision.
This provides you with the ability to look back at the history of the document to
compare revisions.

Note: This does not work as expected with External Documents (e.g. Google Docs,
IBM Smart Cloud) as the document is not stored in Sugar for these document
sources, but only a link to the document. To retain change history, either utilize
Google Doc's change features or select a different document for every revision.

You can click the Create button on this subpanel to create a new revision of the
document you are currently viewing. The revision number is automatically
populated with the current highest revision number plus one, but can be modified.
However, once the new Document is saved, this field becomes read-only for all
users.

Note: If you skip numbers, it will not go back and fill in the missing numbers.
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You may also populate the Change Log field with a short description of the change
being made for this revision. Click "Save" to complete the revision record.

Editing Documents

Documents may be edited at any time to update or add information to the record.
You can make changes to existing document records via the Documents edit view.
Edit view is available within the Documents module and includes all of the
Document fields you should need.

Please note that your ability to edit documents in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure the Documents edit view via Admin >
Studio. For more information on configuring layouts, please refer to the Studio
documentation in the Administration Guide.

Editing Via Detail View

You can edit documents via the Detail View by clicking the Edit button on the
upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve the changes made.
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Editing Via List View

You can edit documents via the List View by clicking the Pencil icon to the left of
each document's name. The edit view layout will open and you can update the
necessary fields, then click "Save" to preserve the changes.

Deleting Documents

If a document record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Documents detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once. Deleting document records
will not delete the related records and will only remove the relationship, so you
may wish to also delete any related records to avoid orphaned records. Document
revision records will be deleted when deleting the parent document record.
Please note that your ability to delete documents in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a document record via the detail view:

1. Navigate to a document record's detail view.
2. Select "Delete" from the Actions menu.
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3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Deleting Via List View

Use the following steps to delete one or more document records via the list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the Basic or Advanced Search to find the Document records you wish

to delete.
3. Select the desired document records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of document records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Documents

Sugar's Export option allows users to download all fields for the selected
documents to their computers as a .CSV (comma-separated values) file. This may
be useful when needing to use document data with other software such as
Microsoft Excel. Due to PHP memory limitations on the server, there may be
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occasions when the application times out while exporting a large number of
document records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Documents may be exported from the Documents list view by selecting "Export"
from the Actions menu. Users with access to the Reports module also have the
option of creating or accessing reports containing specifically chosen fields for
documents and their related record(s). Please note that only Rows and Columns-
type reports have the ability to be exported. For more information on exporting
records in Sugar, please refer to the Export documentation.

Please note that your ability to export documents from Sugar may be restricted by
a role. For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Export option.

Downloading Documents

Exporting a document from Sugar will only export the document record with the
metadata about the document, but the document itself will not be included in the
export. In order to download a document from the documents module, simply click
on the File Name link in the list view or the detail view and the document will be
downloaded to your computer. If the document is linked to an external source (e.g.
Google Docs, IBM Smart Cloud), then the file name link will open directly to the
doc inside a new window or tab.

From Documents list view:
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From Documents detail view:

Mass Updating Documents

Mass Updating allows users to make the same change to multiple document
records at once from the Documents list view. Users with administrator- or
developer-level access can control which fields are available to change during
mass update via Admin > Studio. Currently, only fields with the data type of date,
datetime, dropdown, multiselect, and radio may be altered during a mass update.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration Guide.

Due to the PHP memory limitations on the server, there may be occasions when
the application times out while mass updating a large number of document
records. If you encounter an error when performing this action, we recommend
selecting the records in smaller batches.

Please note that your ability to mass update documents may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Mass Update option. 

Use the following steps to mass update document records from the list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the list view's Basic or Advanced Search to identify documents you

wish to modify.
3. Select the desired documents individually or using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.
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5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.
Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add the
teams specified here to any existing team assignments.

6. Click "Update" to save the changes to all of the currently selected
document records.

Favoriting Documents

Each Sugar user has the option to designate their own favorite documents which
are important or will be viewed often so that they can easily be accessed via search
or from the documents module tab. Once records are marked as favorites, use the
My Favorites checkbox in the Documents Basic or Advanced Search to retrieve
your favorites or select from your most recent favorites directly from the 
Documents Module Tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Documents list view:

1. Navigate to the Documents list view by clicking the Documents module tab.
2. Use the Basic or Advanced Search to find the Document records you wish

to mark as favorites.
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3. Mark the star icon on the left of each desired document's row.
4. To remove the document as a favorite, click the star again to revert it to

white.

Favoriting Via Detail View

Use the following steps to mark records as favorites via the Documents detail view:

1. Navigate to a document record's detail view.
2. Click the star icon to the right of the document's name in the upper left of

the detail view to designate it as a favorite.
3. To remove the document as a favorite, click the star again to revert it to

white.

Favoriting Via Subpanel

Use the following steps to mark document records as favorites via the subpanel in
related modules:

1. Navigate to a related module's record view.
2. Click the star icon to the left of the desired record's row in the Documents

subpanel.
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3. To remove the document as a favorite, click the star again to revert it to
gray.

Google Docs Integration

Sugar comes with Google Docs (Google Drive) integration by default. In order to
be able to create a document in Sugar from a Google Doc in your Google Drive you
will first need to link your Google Account with your profile in sugar. For more
information regarding setting up external accounts in your user profile, please
refer to the External Accounts Tab section in the Getting Started documentation.

Last Modified: 2020-03-11 00:15:53

Calendar

Overview

Sugar's Calendar module allows users to easily schedule, view, and manage their
activities (e.g. calls, meetings, tasks) in one place. The calendar will show your
calls, meetings, and tasks provided you are an invitee on the call or meeting, or the
task is assigned to you. You can also view other user's scheduled activities via the
shared calendar option. This documentation will cover how to use the Calendar
module as well as the various actions and options available from within the
module.

Calendar Module Tab

The Calendar module tab is typically found by clicking the "More" icon represented
by three vertical dots to the right of the module tabs on the navigation bar. The
additional modules will appear on the list and you can click "Calendar" to access
your calendar. Once the Calendar Lists tab displays on the navigation bar, you can
click the triangle within the tab to display the Actions menu, which allows you to
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perform important actions within the module.

The Actions menu allows you to perform the following options:

Menu Item Description
Schedule Meeting Schedule a new meeting via the

Meetings record view
Schedule Call Schedule a new call via the Calls record

view
Create Task Create a new task via the Tasks record

view
Today View the current day on the calendar

Calendar Actions

When viewing your calendar, there are several options across the top of the
calendar to help you navigate the calendar and increase the functionality available.
These buttons are accessible from any calendar screen, with some notable
exceptions. Most of the buttons are used to change the view of the calendar to
show a specific time period or jump to a specific period.

The buttons are defined as follows:

Options Description
Day View the current day on the calendar
Week View the current week on the calendar
Month View the current month on the calendar
Year View the current year on the calendar
Shared View the shared calendar for other

users in Sugar
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User List Select which users will show on the
shared calendar
Note: This option is only available when
viewing the Shared calendar

Calendar Icon Click the calendar icon to quickly jump
to a specific date
Note: This option is not available when
using the year view

Settings Change the settings on the calendar as
described in Viewing via Calendar

Creating Activities

There are various methods for creating the different activities available in Sugar,
including via the calendar itself, the Calendar module's actions menu, the
individual activity's module, or via quick create. The record view opens in edit
mode when creating the call directly from the Calls menu, Quick Create menu, and
Calendar module and includes all of the relevant fields for your organization. When
using quick create to make a call while viewing an existing record of another
module, Sugar automatically creates a relationship between both records. For
example, if you are viewing a contact record (e.g. John Smith) and create a new
call via its record view, the Related To field in the call record will automatically
populate with "John Smith", thus creating the relationship and adding him as an
invitee. The record view layout can be configured by administrators via Admin >
Studio. For more information on configuring layouts, please refer to the Studio
documentation in the Administration Guide.

Creating via Calendar Grid

The calendar allows you to create meetings and calls easily by clicking on the cell
corresponding to the specific date and time you wish to schedule the activity. The
record view will appear in edit mode, and the start date and time will automatically
be populated based on the date and time cell you selected in the calendar.

Use the following steps to create an activity (e.g. meeting) via the calendar grid:

1. Click the Calendar module tab.
2. On the calendar view, click the cell corresponding to the date and time you

wish to schedule the meeting. You can choose to view the calendar by Day,
Week, Month, Year, or Shared. For more information on viewing the shared
calendar, please refer to the Viewing Shared Calendar section of this
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documentation.

When a cell is selected on the calendar, a Meeting record view will appear
in edit mode. A popup will also appear giving users to option to create a
new call or a new task instead.

3. Refer to step 2 and beyond in Creating via Meetings Module section of the
Meetings documentation for additional instructions about creating meeting
records.

Creating via Actions Menu

Activities can also be created via the create options (e.g. Schedule Meeting,
Schedule Call, etc.) in the Calendar module tab. This opens up the record view in
edit mode for the corresponding module (e.g. Calls, Meetings, etc.) which allows
you to enter all the relevant information for the activity.

The following steps cover creating a new meeting via the Calendar module tab as
an example:

1. Click the triangle in the Calendar module tab to open the actions menu and
select "Schedule Meeting".

2. Refer to step 2 and beyond in Creating via Meetings Module section of the
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Meetings documentation for additional instructions about creating meeting
records.

Creating via Activities Modules

Calls, meetings, and tasks can also be created directly from their individual
modules. The activity will then show on your calendar if you are listed as an invitee
on the call or meeting or if you are the assigned user on the task. For instructions
for creating activities directly from their modules, please refer to the Calls,
Meetings, or Tasks documentation.

Creating via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick-create button on the upper right of all Sugar pages
to access the menu. You can also quick-create an activity from any Activities
subpanel (Legacy modules), Planned Activities dashlet (Sidecar modules), as well
as Calls, Meetings, or Tasks subpanels (Sidecar modules) on related module
records.

Note: As a best practice, if you are going to be relating the activity to any other
record in Sugar, create the activity from the related record's record view, which
will automatically relate the two records.

Use the following steps to create a call via the quick-create menu as an example:

1. Open the Quick Create menu on the upper right of any Sugar page and
select "Log Call". You can also quick-create calls using the following
methods:
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From Activities subpanel (legacy modules only):

From Calls subpanel:

From Planned Activities dashlet:

2. Refer to step 2 and beyond in Creating via Meetings Module section of the
Meetings documentation for additional instructions about creating meeting
records.

Adding Reminders

Sugar includes the ability to remind invitees when they have a call or meeting that
is scheduled to begin in a given amount of time. Reminders can be sent via email
to all of the invitees prior to the call or meeting's scheduled start date and time. By
default, reminders have to be manually added to calls and meetings upon creating
or editing the activity. Users can configure their default reminders via their User
Preferences, which will automatically select the default reminder time in the
Reminders field.

For more information on adding reminders, please refer to the Calls and Meetings
documentation.

Adding Invitees
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Users have the option of adding additional invitees (e.g. Contacts, Leads, Users) to
calls and meetings via the Add Invitees or Create an Invitee option in the Calls or
Meetings module's edit or quick-create view. Please note that the user creating the
call or meeting as well as the contact or lead selected in the Related To field will
automatically be added as invitees to the call or meeting. You can simply remove
yourself or an attendee from the call by choosing the remove button on the
Scheduling panel or "Unlink" from the Invitees panel.

Adding via Add Invitees

Users have the option to add invitees to the Guests panel directly from the meeting
or call record view.

Please refer to the steps in the Adding via the Guests Panel section of the Meetings
documentation for instructions on how to add invitees to meeting records.

Adding via Create an Invitee

Users have the option to create invitees and add them to the Guests panel directly
from the meeting or call record view. Please refer to the steps in the Adding via
Create a Guest section of the Meetings documentation for instructions on how to
add invitees to meeting records.

Setting Meetings and Calls to Recur

Meetings and calls can be set as recurring events so that users do not have to
create individual meeting or call records for regularly occurring events.
Recurrences can be set up to occur daily, weekly, monthly, or yearly.
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When a recurring meeting or call is configured, individual meeting records are
created in Sugar, so when viewing the Meetings or Calls list view, all recurrences
will show. For more information on viewing records via the list view, please refer
to the List View section of the User Interface documentation.

For more information on setting up, editing, and deleting recurring records, please
refer to the Calls and Meetings documentation.

Viewing via Calendar

The Calendar module allows users to schedule, view, and manage various activities
(Calls, Meetings, Tasks) in Sugar. The Calendar module can be accessed by
clicking the Calendar module tab.

The three activity types are color-coded on the calendar as follows:

Module Color
Calls Red
Meetings Blue
Task Green
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You can click the cell of an existing call or meeting to view the details via the
Quick Create form. You can also click the "i" icon to the far right of the call record
cell for a quick view of additional details (e.g. Subject, Start Date & Time,
Duration, Related to, etc.) of any activity without opening up the record.

Please note that you will only be able to see activity records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration guide.

The Calendar module defaults to the week view and can be viewed as a day, week,
month, or year view using the buttons at the top of the page. The week view can
also be changed to have a different day of the week using the Calendar Options in
your user profile. Simply navigate to the Advanced tab of your user profile then
scroll to the Calendar Options panel and select the appropriate "First Day of Week"
(e.g. Sunday, Monday, etc.). For more information regarding configuring the first
day of the week, please refer to the Getting Started documentation.
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When viewing the day, week, or month view of the calendar, you can jump to a
specific date using the calendar pop-up in the top right of the screen. Select any
date within the same month or use the left or right arrows to navigate to previous
or upcoming months. You can also jump to today's date with the Today button in
the pop-up calendar, or jump to a specific month or year by clicking on the
displayed month in the pop-up calendar. Alternately, you can jump to the next day,
week, month, or year, depending on your current view, using the Next and
Previous buttons at the top and bottom of the calendar view. For more information
on using the next and previous buttons, please review the Next or Previous
Calendar View section of this documentation.

The look and feel of the calendar can also be changed via the Settings option to the
right of the calendar pop-up.

The Calendar settings allow you to perform the following actions:

Display time slots in Day and Week views : When this option is enabled,
activities are displayed in their specified time cells when viewing a day or
week via the calendar. If this option is disabled, all activities will appear as
a list. This option is enabled by default.
Start Time : The value set in this field represents the first time cell
displayed on your day or week calendar view (e.g. 09:00 am).

Note: This option is disabled and hidden if "Display time slots in
Day and Week views" is disabled.

End Time : The value set in this field represents the last time cell
displayed on your day or week calendar view (e.g. 05:00 pm).

Note: This option is disabled and hidden if "Display time slots in
Day and Week views" is disabled.

Show Calls : When this option is set to "Yes", scheduled calls are also
displayed in the calendar view. If you do not wish to see calls in the
calendar view, set this option to "No". This option is set to "Yes" by default.
Show Tasks : When this option is set to "Yes", scheduled tasks are also
displayed in the calendar view. If you do not wish to see tasks in the
calendar view, set this option to "No". This option is set to "Yes" by default.
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Once all settings have been set, click "Apply" to update the calendar with your
changes.

Viewing Shared Calendar

The Calendar module allows you to view not just your own activities, but you can
also view the calendar of other Sugar users using the Shared Calendar. The
calendar will show the selected user in a weekly view on one page. Using the
shared calendar, users will also have the option to create activities for other users
directly from the calendar. For more information on using the shared calendar,
please refer to the Shared Calendar section of this documentation.

Please note that you will only be able to see activity records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration Guide.
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Moving Scheduled Activities

The Sugar calendar allows for the start time and duration of meetings and calls to
be edited from the calendar, instead of having to directly edit the activity record
via the module. The records that appear on the calendar can also be dragged and
dropped to new locations to change the start date and time.

Note: All occurrences of recurring meetings and calls cannot be modified by
dragging one record of the series.

In addition, the activities can be dragged from the bottom of the box to be able to
change the duration of the activity. To do this, simply hover over the activity's box
to make the two lines appear at the bottom. Click the two lines and drag to the
new end time of the call or meeting.

Note: Changing the meeting details with drag-and-drop does not send a system-
generated update to the meeting invitees.

More Information
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Additional details for each activity can be viewed by clicking the "i" icon on the far
right of each activity block on the calendar. This provides users a quick view of
additional information in addition to what appears on the block. The pop-up
window can also be used to access the record. Click the Pencil button to edit the
record in the record view, the Preview button to view the record, or the "X" button
to close the pop-up window.

The resulting pop-up window will show the following fields by default:

Module Fields
Calls Subject

Start Date & Time
Duration
Related to
Status
Description (abbreviated)

Meetings Subject
Start Date & Time
Duration
Related To
Status
Description (abbreviated)

Tasks Start Date & Time
Due Date & Time
Priority
Status
Description (abbreviated)

Note: The list of fields appearing here may only be configured through a code-
level customization.

Next or Previous Calendar View
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On the four corners of the Calendar, there are buttons that allow you to page
through the given time frame in groups at a time, either the next or previous day,
week, month, or year. The timeframe will change depending on which calendar you
are viewing. When viewing the shared calendar, these buttons will always paginate
by the week.

Editing Activities

Activities on the calendar can be edited directly from the calendar instead of
having to access the record via the individual modules (e.g. Calls). Dragging and
dropping activity cells within the calendar can make changes to the start and end
dates. For more information on moving activities from within the calendar, please
refer to the Moving Scheduled Activities section of this documentation.

Use the following steps to edit an activity via the calendar:

1. Navigate to the calendar by clicking the Calendar module tab.
2. Locate the activity (e.g. Call) you would like to edit and click on the cell to

open it in record view.
3. Make the necessary changes to the activity, including setting reminders,

adding invitees, or set any recurrences of the activity.
4. Once the necessary information is entered, click "Save" or, if you would like

an invitation email to go out to the invitees where they can accept or deny
the call or meeting, click "Save and Send Invites".

The record view can also be reached by clicking the Pencil button on the More
Information pop-up for the activity. Please review the More Information section of
this documentation for more information about using this popup.
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Please note that your ability to edit activities in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure the record view layouts via Admin >
Studio. For more information on configuring layouts, please refer to the Studio
documentation in the Administration Guide.

Editing Recurring Meetings and Calls

When a meeting or call is set to be recurring, additional copies or duplicates of the
call or meeting record are created for the specific time and date of each
recurrence. Therefore, editing one record's cell on the calendar will not affect the
other recurrences of the same call or meeting and will only affect the one
recurrence you are editing. Users must select Edit All Recurrences from the
meeting record's Action Menu.

Please refer to the steps in the Editing All Recurrences via Record View section of
the Meetings documentation for instructions on how to edit all recurrences.

Deleting Calls and Meetings via Calendar
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If a call or meeting record is invalid or should no longer appear on your calendar
or in Sugar, it can be deleted through the record view via the calendar.

Use the following steps to delete a record via the calendar:

1. Navigate to the calendar by clicking the Calendar module tab.
2. Locate the call or meeting you would like to delete.
3. Click "i" icon located to the right of the subject and select the pencil icon

from the popup.

4. This will take you to the meeting or call record view. Please refer to the
steps in the Deleting via Record View section of the User Interface
documentation for instructions on how to delete meetings.

Recurring calls and meetings can be deleted by this method if you would like to
delete the individual call or meeting. Deleting one record through this process will
not remove the entire series. Please refer to the steps in the Deleting All
Recurrences via Record View section of the Meetings documentation for
instructions on how to delete all recurrences.

Note: Your ability to delete calls and meetings in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Delete options.

Shared Calendar

The Shared Calendar option in the Calendar module allows you to view other
user's calendars which is helpful when scheduling calls or meetings as well as
keeping track of the other user's activities. The shared calendar also gives you the
ability to schedule meetings and calls on behalf of the user so that they are
automatically an invitee to the activity and the assigned user. Please note that the
shared calendar is always viewed as a weekly view.
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Use the following steps to enable the shared calendar:

1. Navigate to the calendar by clicking the Calendar module tab.
2. Click the Shared button on the upper left of the page.

3. Click the User List button on the upper right of the page then select the
user(s) you wish to view calendars for in Sugar.

Note: You can filter the Users list by using the Filter user list by team
dropdown above the Users list.

4. Click "Select" after choosing the user(s) to display all of the user's weekly
calendars on the Calendar page.

Please note that you will only be able to see and edit activity records on the shared
calendar as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration Guide.

Publishing Calendars

Sugar allows users to share calendars between applications to ensure that
activities do not overlap between calendars. The Sugar calendar can be viewed in
other applications such as the Outlook calendar to display the user's free/busy time
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from Sugar.

Publishing Your Sugar Calendar

Sugar calendars can be shared and viewed with various iCal-compatible calendar
applications (e.g. Apple Calendar or Google Calendar). The calendars are viewable
as read-only in the external calendar applications and any edits to existing
activities can only be done in Sugar. For more information on sharing your
calendar on another application, please review the Calendar Options section in the
Getting Started documentation.

Publishing to Your Outlook Calendar

You can specify settings in another application, such as Outlook, to enable the
ability to view a user's free/busy information from the Sugar calendar. Please note
that the settings must be configured on each user's computer. Once configured,
the invitee shows as busy for any time currently scheduled in Sugar if the user's
email address in Sugar matches the invitee email address in Outlook.

Use the following steps to configure this functionality:

1. In Sugar, navigate to your user preferences and select the Advanced tab.
2. Copy the Search location URL located at the bottom in the Calendar

Options panel.
3. In Outlook, go to File > Options > Calendar > Free/Busy Options.
4. In the Internet Free/Busy section, paste the Search location URL into the

corresponding box.

Integrating With MS Outlook

Sugar allows you to sync meetings and calls in Sugar with your local installation of
Microsoft Outlook using the Outlook Plug-in. The plug-in also allows you to archive
emails and sync contacts. All meetings and calls, including recurring ones, can be
synced using the plug-in. When a meeting or call is synced from Outlook to Sugar,
the meeting or call will appear on the Sugar calendar, but will not be editable via
Sugar and only viewable.

For more information on using the Outlook Plug-in, please review the Sugar Plug-
in for MS Outlook User Guide.
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Calls

Overview

Sugar's Calls module is used to log phone calls which can be related to other
Sugar records that may represent the attendees or topic for discussion. You can
use call records to schedule and remind guests of future calls and to preserve a
record of any other calls that you hold. Call records may have multiple guests and
can even be scheduled to recur.

Calls logged in Sugar also show on your Sugar calendar, from which you can
create calls directly. You can also view and create calls via the Planned Activities
dashlet on a contact or other related module record. For example, a contact
record's Planned Activities dashlet displays Sugar call records that are related to
the contact. Creating a call from the dashlet creates a relationship between the
records automatically. 

This documentation covers using the Calls module. For general usage instructions
concerning views and actions that are common across most Sugar modules such as
creating, editing, and deleting records, please refer to the Working With Calls
section of this page.

Please note that you can only see call records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Call Fields

The Calls module contains a number of stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to meet your organization's
needs. Administrators or users with developer-level role access have the ability to
alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description

                       599 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Field_Types
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Field_Types
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Fields


 

Assigned To The Sugar user assigned to the call
Note: The user in the "Assigned to" field
cannot be removed from a call's guest
list.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Created By The Sugar user who created the call
Date Created The date the call record was created
Date Modified The date the call record was last

modified
Description A description or other information about

the call
Direction Indication of whether the call is inbound

or outbound
Email Reminder Time Send a reminder email to all call guests

a specified duration before the call's
start time

End Date The date and time the call is expected to
end

Modified By Name The name of user who last modified the
call record

Popup Reminder Time Trigger a reminder popup alert to all
Sugar user guests at a specified
duration before the call's start time.
Note: Users must be logged into Sugar
in an open browser window in order to
receive the popup reminder.

Related To The related module record associated
with the call

Repeat Type For a recurring series of calls, the
timespan unit (e.g. Every x days =
"Daily", Every x weeks = "Weekly") to
use for the interval of time between
recurrences
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Repeat Interval Shown when Repeat Type does not
equal "None", the number of units in the
"Repeat Type" field that should pass
between recurrences, for example:

Every three days : Repeat Type
= "Daily"; Repeat Interval = "3"
Every other week : Repeat Type
= "Weekly"; Repeat Interval =
"2"
Each year : Repeat Type =
Yearly; Repeat Interval = "1"

Repeat Shown when Repeat Type does not
equal "None"; Select "Until" to set a
hard end date to recurrences or
"Occurrences" to specify the number of
times to repeat the call

Repeat Until Shown when "Repeat" equals "Until",
the date of the last occurrence in the
series

Repeat Occurrences Shown when "Repeat" equals
"Occurrences", the number of calls in
the series

Repeat on Days of Week Shown when "Repeat Type" equals
"Weekly", the day(s) of the week that
the calls will occur in the recurring
series

Custom Date (monthly) Shown when "Repeat Type" equals
"Monthly", select "Each" to specify a
certain day(s) of the month or "On the"
to set a variable such as the first
Monday of each month

Custom Date (yearly) Shown when "Repeat Type" equals
"Yearly", select "None" to repeat the call
on the same day every year or "On the"
to set a variable such as the last Friday
of each year

Start Date The date and time that the call or first
call in the series of recurring calls is
scheduled to begin

Status The current status (e.g. Scheduled,
Held, Canceled) of the call record
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Subject The name or topic used to identify the
call

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the call
record

Calls Color Codes

When viewing the Calls list view and the Calls dashlet, the start date may be
highlighted in blue or red. This allows users to quickly view scheduled calls that
are either overdue or start within the next 24 hours. Please note that the start date
will not be highlighted for calls with a status of "Held" or with a start date in the
future (beyond 24 hours from the current date and time).

The start dates in the Calls list view are highlighted as follows:

Blue : The call has not been held and the start date occurs within the next
24 hours.
Red : The call has not been held and the start date occurred in the past.

Please note that you can only see call records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration guide

Working With Calls
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The following links open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following the Working With Calls section describe call-
specific behaviors and functionality.

Content Link Description
Creating Calls
Basic Call Creation
Creating via Quick Create
Creating via Subpanels
Creating via Duplication
Importing Calls

The Creating Records section covers the
various methods of creating new call
records, including via the Create button
in the Calls module, the Quick Create
menu on the upper right of every Sugar
page, via the Calls subpanel on related
module records, duplication of an
existing call record, and importing a list
of calls into Sugar using a .csv
spreadsheet.

Viewing Calls
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing call
records, including via the Calls list view
and record view, the Recently Viewed
menu in the Calls module tab, list view
dashlets showing call information,
activity stream entries concerning call
updates or where a user mentions a call,
previewing calls in the right-hand side
panel, and reports displaying call data.

Searching for Calls
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating calls:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Calls module.

Calls List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection

The List View section walks through the
many elements of the Calls List View
layout which contains a filterable list of
all call records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Calls list view are described in the 
List View Mass Actions Menu and List
View Record Actions Menu sections of
this page.
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Preview
Record Actions Menu
More Calls
Activity Stream
Dashboards
Calls Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Record View section walks through
the many elements of the Calls Record
View layout which contains detailed
information about a single call record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Calls record view are
described in the Record View Actions
Menu section of this page.

Editing Calls
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
call records, including inline via the
Calls record view, in full edit mode on
the record view, inline via the Calls
subpanel on related module records,
inline via the Calls list view, and via the
Mass Update option on the list view.

Deleting Calls
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted calls, including via the Calls
record view, an individual record's
Actions menu on the Calls list view, and
the Mass Actions menu on the list view.

Exporting Calls The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of calls and all their data
as a .csv file for use outside of Sugar
(e.g. in Microsoft Excel).

Favoriting Calls
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking calls as favorites, including via
the Calls list view, Calls record view, or
any Calls subpanel appearing on the
record view of a related module.
Favoriting a call allows you to easily
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access it from list views, dashlets, or the
Calls module tab.

Following Calls
Following via List View
Following via Record View

The Following Records section describes
the various methods of marking calls as
"Following" including via the Calls list
view and record view. Following a call
causes its activity stream updates to be
included on your Home page and Calls
list view activity streams so that you can
easily keep up with changes and user
posts on the record.

Sharing Calls The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the call record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the call's record
view.

Call Menus

The Calls module contains various options and functionality which are available via
menus in the module tab, list view, and record view. The following sections present
each menu and its options with links to more information about each option in the
User Interface documentation or, for Calls-specific functionality, within this page.

Module Tab Menus

The Calls module tab is typically found by clicking the "More" icon represented by
three vertical dots to the right of the module tabs on the navigation bar. The
additional modules will appear on the list and you can click "Calls" to access the
list view. Once the Calls tab is visible in the navigation bar, you can click the
triangle on the tab to display the Actions, Recently Viewed, and Favorites menus.
The Actions menu allows you to perform important actions within the module. The 
Recently Viewed menu displays the list of calls you most recently viewed. The 
Favorites menu displays the list of calls you most recently marked as favorites.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Log Call Opens the record view layout to create a

new call
View Calls Opens the list view layout to search and

display calls
Import Calls Opens the import wizard to create or

update calls using external data
Activities Report Displays existing reports based on the

Calls module

If you do not see the Calls module tab in Sugar, please check the following:

The Calls module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Calls module in the Hide Modules list,
simply move it to the Display Modules list. For more information on hiding
and displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Calls module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Calls
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration guide.

List View Menus
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The Calls list view displays all call records and allows for searching and filtering to
locate specific calls. You can view the basic details of each record within the field
columns of the list view or click a call's name to open the record view. To access a
module's list view, simply click the module's tab in the navigation bar at the top of
any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual call records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more calls at a time
Delete Delete one or more calls at a time
Export Export one or more calls to a CSV file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual call directly from the list view.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this call in the intelligence pane
Edit Edit this call
Close Close this call

Note: Shown only for calls that do not
have a status of "Held"

Delete Delete this call
Delete All Recurrences Delete this call and all other call records

in this call's series
Note: Shown only for calls that are one
in a recurring series

Record View Actions Menu

The Calls record view displays a single call in full detail including its fields,
subpanels of related records, and activity stream. To access a call's record view,
simply click a hyperlinked call name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this call
Edit All Recurrences Edit this call and all other call records in

this call's series
Note: Shown only for calls that are one
in a recurring series

Share Share a link to this call via email
Copy Duplicate this call to create a new call
Delete Delete this call
Delete All Recurrences Delete this call and all other call records

in this call's series
Note: Shown only for calls that are one
of a recurring series

Close and Create New Close this call as "Held" and create a
new copy of the call
Note: Shown only for calls that do not
have a status of "Held"

Close Close this call as "Held"
Note: Shown only for calls that do not
have a status of "Held"
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Call Guests

The following guests are automatically added to a call's guest list:

Automatic Guest To Remove the Guest
The lead or contact in the "Related to"
field, if any

This guest can be removed from the
guest list at any time. If a lead or
contact record is related to a call but is
not on the guest list, then you will not
see the call in the person's Calls
subpanel.

The user who created the call This guest can be removed from the
guest list after initially saving the call.
Create and save the call, click "Edit",
and then click the Remove (-) button
next to the created-by user's row in the
Guests panel.

The user in the "Assigned to" field for
the call record

The assigned user cannot be removed
from the guest list. If you need to
remove the assigned user from the
guest list, you must first re-assign the
call to a different user. Once the call
record is assigned to a new user, the
original user will remain a guest until
removed via the Remove (-) button.

Users may add additional guests (e.g. contacts, leads, users) to calls via the Guests
panel in the call's record view.

Adding via the Guests Panel

Use the following steps to add attendees via the Guests panel:

1. Navigate to the Calls module and create a new record or edit an existing
record.

2. Scroll to the Guests panel and click on the Add (+) button located on the
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far right.

3. To add a guest, type in the name of the lead, contact, or user via the search
bar that appears or select "Search for more..." to search the Contacts list
view. To remove a guest, click the Remove (-) button to the right of the
guest's row.
Note: The user in the "Assigned to" field on the call record cannot be
removed from a call. To remove the assigned user from the guest list, re-
assign the call to a different user first.

4. Click "Save" or "Save and Send Invites" if you would like Sugar to send
email invitations to the guests.
Note: Confirm that the guests' Sugar records have valid email addresses
prior to clicking "Save and Send Invites". If a guest has no email address or
their email address is marked as invalid, Sugar cannot email them an
invitation to the call. A message and icon will alert you when adding the
guest and when viewing the call's record view.

Once the guest has responded to the email invitation, their acceptance status will
appear as a color-coded badge next to their name.

Adding via Create a Guest

Use the following steps to create a new contact and add them as a call guest:

1. Navigate to the Calls module and create a new record or edit an existing
record.

2. Scroll to the Guests panel, click on the Add (+) button, and then click on
"Search for more..." to expand the Contacts list view.
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3. At the top of the list view, click the Create button and fill out the
appropriate fields to create a new contact. Once completed, save the new
contact record and Sugar will automatically add the contact to the guest
list for the call.

4. Confirm the remaining fields and guests are configured appropriately and
then save the call.

Recurring Calls

Calls can be saved as recurring events so that users do not have to create
individual call records for regularly occurring events. Recurrences may occur
daily, weekly, monthly, or yearly. When a recurring call is saved, Sugar creates a
series of individual call records so that all recurrences appear in the Calls List
View.

Creating Recurring Calls

To schedule a series of recurring calls, follow the instructions below. As an
example, we will schedule a 30-minute call that recurs every other Thursday until
the end of the 2017 calendar year.

1. Navigate to the Calls module and create a new record.
2. In the Start Date field, enter the date and time that the first Thursday call

will occur and set the End Date for the same day but 30 minutes later.

Note: If a recurring call's start date does not match the call's recurrence
day(s) of the week, the start date will reset to the first matching day-of-
week after the call's Date Created.

3. To create a series of calls, expand the field labeled "Repeat Type" and
select an interval from the dropdown list. Our use case requires an interval
of weeks (e.g. every two weeks), so we will select "Weekly" and specify our
interval number in the next step.
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4. Upon choosing a Repeat Type value, a new row of fields will appear on the
form to gather the series information.

The fields displayed are dependent upon the values you select as you go.
Please refer to the Call Fields section for complete details on the available
options. To schedule a call that recurs every other Thursday until the end
of the 2017 calendar year, set the following values:

Repeat Interval : 2
Repeat on Days of Week : Thu
Repeat : Until
Repeat Until : 2017-12-31

5. Confirm that the remaining fields and guests are configured appropriately.
6. Save the record and confirm that all recurrences appear as separate

records in the Calls module's list view.

Editing All Recurrences via Record View

Recurring activities will display the option to edit all occurrences of the activity in
the record's actions menu. This option will affect all of the call records in a series,
even if some of the calls have been closed and set to "Held". Use the following
steps to edit all recurrences in a series of calls via the record view:

1. Navigate to the record view of any call in the series of recurring calls.
2. Select "Edit All Recurrences" from the Actions menu.
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3. Edit the call record as needed.

4. Then click on "Save" or "Save and Send Invites" to apply the changes to all
held and unheld calls in the series.

Deleting All Recurrences via Record View

Recurring activities will display the option to delete all occurrences of the activity
in the record's actions menu. This option will affect all of the call records in a
series, even if some of the calls have been closed and set to "Held". Use the
following steps to delete all recurrences in a series of calls via the record view:

1. Navigate to the record view of any call in the series of recurring calls.
2. Select "Delete All Recurrences" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Confirm" to
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delete all held and unheld calls in the series.

Deleting All Recurrences via List View

Recurring activities will display the option to delete all occurrences of the activity
in the record's actions menu in the list view. This option will affect all of the call
records in a series, even if some of the calls have been closed and set to "Held".
Use the following steps to delete all recurrences in a series of calls via the list
view:

1. Navigate to the Calls list view by clicking the Calls module tab.
2. Use the Module Search to find the call in the series of recurring calls that

you wish to delete.
3. Click the Record Actions Menu to the far right of the record's row and

select "Delete All Recurrences".

4. A pop-up message will display asking for confirmation. Click "Confirm" to
delete all held and unheld calls in the series.

Call Reminders

Sugar can remind guests when a call is scheduled to begin soon. Reminders can be
sent via email to all of the guests or via pop-up to all user guests prior to the call's
scheduled start date and time. By default, a user must set reminders when
creating or editing the activity, but users can configure default reminders via their 
User Preferences, which will automatically set a default reminder time for calls
they create in Sugar.
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Note: The instance's outbound mail server must be configured via Admin > Email
Settings in order for email reminders to be sent out. For more information on
setting up the system email settings, please refer to the Email documentation in
the Administration Guide.

Email Reminders

Email reminders can be set for any call record relative to its start date and time.
The reminders are emailed to all guests with valid email addresses including non-
Sugar users.

To schedule email reminders, select a time interval from the call's Email Reminder
Time field:

Popup Reminders

Popup reminders can be set for any call record relative to its start date and time.
Popup reminders appear for Sugar users on the call's guest list who are logged
into Sugar in an open browser window at the time the reminder pops up.

To schedule popup reminders for logged-in Sugar users, select a time interval from
the call's Popup Reminder Time field:
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Closing Calls

Once a call has taken place, a user can close the call record, which changes the
call's status to "Held". The "Close" option only appears for meetings that are
considered open, or not "Held". Open calls are shown in the Planned Activities
dashlet on the record view of related records and guests (e.g. Contacts, Leads,
etc.). After closing a call, Sugar will move it from the Planned Activities dashlet to
the History dashlet and the call record's status will display "Held" wherever it is
viewed.

Closing via Record View

An open call's record view allows you to simply close the current call record or use
"Close and Create New" to close the call and create a new call with the same
details simultaneously. "Close and Create New" is often used when a user wants to
log a completed call and easily schedule a follow-up call with the same people
about the same topic.

To close a call record via its record view, click on the call to open its record view.
Expand the record's Actions menu and select "Close" or "Close and Create New".
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Depending on your selection, you will experience different results:

Close : Instantly changes the call's status to "Held" and displays a Success
message.
Close and Create New : Instantly changes the call's status to "Held",
displays a Success message, and opens a quick-create drawer for a new call
record with the same values, guests, relationships. and other field values as
the held call. The only field that is not copied from the original record is the
status field, which will revert to "Scheduled" for the new call. Simply adjust
the dates, times, and other information as needed, and save the new call as
usual.

Once a call is closed, the closing options will no longer appear in the Actions menu.

Closing via List View

Use the following steps to close a call record via the list view:

1. Click the Calls tab to navigate to the Calls module's list view.
2. Use the Module Search to find the Call record(s) you wish to close.
3. Click the Record Actions Menu to the far right of the record's row and

select "Close".

Sugar instantly changes the call's status to "Held" and displays a Success message.

Closing via Dashlet
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The Planned Activities dashlet is available for home page dashboards and on the
record view's intelligence pane for Sidecar modules. From the home page
dashboard, the Planned Activities dashlet displays all upcoming calls and meetings
assigned to you or your team depending on your chosen filters. When viewing the
Planned Activities dashlet from a record's intelligence pane, the calls and meetings
shown are only those that are related to the record you are viewing. For example,
when viewing the contact record for Joe Smith, the Planned Activities dashlet in
the intelligence pane will show only the upcoming calls and meetings with Joe
Smith on the guest list. For more information about the Planned Activities dashlet,
please refer to the Intelligence Pane documentation.

Use the following steps to close a call record via the Planned Activities dashlet:

1. Navigate to your home page's dashboard or the record view that contains
the Planned Activities dashlet showing the call you would like to close.

2. If necessary, click the Calls tab on the Planned Activities dashlet to find the
call.

3. Click the Held (x) button to the right of the call's row in the dashlet.

4. A pop-up message will display asking for confirmation. Click "Confirm" to
move the meeting to the record's History dashlet with the status "Held".

Calendar Module and Calls

The Calendar module displays a user's calendar including their Sugar activity
records. You can view, schedule, and manage their calls, meetings, and tasks
directly within the calendar, allowing you to plan your time with full access to your
other scheduling commitments.

Viewing via Calendar

The Calendar module allows users to schedule, view, and manage activities (calls,
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meetings, tasks) in Sugar. Meeting records are displayed in blue on the calendar
and you can click the corresponding cell to view the meeting's details. You can also
click the Info (i) icon in the meeting's cell for a quick view of additional details (e.g.
Subject, Start Date & Time, etc.) of the meeting without navigating away from the
calendar.

For more information on viewing and managing calls on the calendar, please refer
to the Calendar documentation. Users also have the ability to view other user's
scheduled activities via the shared calendar option. For more information on
viewing the shared calendar, please refer to the Calendar documentation.

Please note that you can only see call records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation.

Creating via Calendar

There are two ways to create calls in the Calendar module. The first method is to
create a call via the Schedule Call option in the Calendar module tab. This will
open up the call's record view in edit mode to create a new call record. For more
information on creating calls via the Calls module, please refer to the User
Interface documentation and the various call-specific sections above.

The second method is to create the call directly within the Sugar calendar. For
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more information on navigating and viewing the calendar, please refer to the 
Calendar documentation. Use the following basic steps to create a call via the
Calendar module:

1. Navigate to the calendar in Sugar by clicking on the Calendar module tab.
2. On the calendar grid, click directly on the cell corresponding to the date

and time you wish to schedule the call.

3. Sugar assumes you want to schedule a meeting, but an alert will ask if you
would prefer to create a task or call. Click on the hyperlinked text
"Schedule a call" inside the alert.

4. You will now see the call's record view in edit mode so that you can create
a new call record. Complete the call's fields as described in the User
Interface documentation and the various call-specific sections above.

Editing via Calendar

Once calls are scheduled in Sugar, they appear in the assigned user's calendar
based on the specified due date and time. You can click the Info (i) icon on the
call's calendar cell to view additional information about the call.
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The Additional Details popup window displays a Pencil icon on the upper right,
which opens up the call's full record view for users to make any changes as
necessary.

Click "Save" to preserve any changes made to the call record.

Last Modified: 2020-03-31 23:12:28

Meetings

Overview

Sugar's Meetings module is used to track meetings which can be related to other
Sugar records that represent the attendees or topic of discussion. You can
schedule upcoming meetings that remind you when the scheduled time approaches
or log meetings you have already held to keep a record of the discussion. Meeting
records can have multiple attendees, both inside and outside Sugar, and include
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the ability to send invitations as well as reminder emails. When a meeting is
repeated on a regular schedule, you can configure it to recur. 

Sugar's Calendar module displays your meetings and allows you to create
meetings directly from your calendar. Meetings can also be viewed and created via
the Planned Activities dashlet on a contact or other related module record. For
example, a contact record's Planned Activities dashlet displays Sugar meeting
records that are related to the contact. Creating a meeting from the dashlet
creates a relationship between the records automatically. 

This documentation will cover using the Meetings module. For general usage
instructions concerning views and actions that are common across most Sugar
modules such as creating, editing, and deleting records, please refer to the 
Working With Sugar Modules section of this page.

Please note that you will only be able to see meeting records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

Meeting Fields

The Meetings module contains a number of stock fields which come out-of-the-box
with Sugar. For information on using and and editing various field types, refer to
the User Interface documentation. The following definitions are suggested
meanings for the fields, but the fields can be leveraged differently to meet your
organization's needs. Users with administrator or developer access can alter, add,
or remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Studio documentation in the Administration Guide.

Field Description
Assigned To The Sugar user assigned to the meeting 

Note: The user in the "Assigned to" field
cannot be removed from a meeting's
guest list.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
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details.
Created By The Sugar user who created the

meeting
Date Created The date the meeting record was

created
Date Modified The date the meeting record was last

modified
Description A description or other information about

the meeting
Display URL The URL to access the meeting if hosted

by an external application (e.g. WebEx,
GoToMeeting, etc.)
Note: This is a dependent field that
appears when a value other than
"Sugar" is selected as the meeting type.

Email Reminder Time Send a reminder email to all meeting
guests at a specified duration prior to
the meeting's start time

End Date The end date and time of the meeting
Location The meeting location
Meeting Password The password to access the meeting via

WebEx, GoToMeeting, etc.

Note: This is a dependent field that
appears when a value other than
"Sugar" is selected as the meeting type.

Meeting Type The application (e.g. Sugar, WebEx,
GoToMeeting, etc.) hosting the meeting

Note: External meeting accounts (e.g.
WebEx, GoToMeeting) are added to the
Meeting Type field when users connect
to their account via the External
Accounts tab in their user preferences.
For more information on connecting to
external applications, please refer to the
External Accounts Tab section in the
Getting Started documentation.

Modified By Name The name of the Sugar user who last
modified the meeting record

Popup Reminder Time Trigger a reminder popup alert to all
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Sugar user guests at a duration prior to
the meeting's start time.

Note: Users must be logged into Sugar
in an open browser window in order to
receive the popup reminder.

Related To The related module record associated
with the meeting

Repeat Type For a recurring series of meetings, the
timespan unit (e.g. Every x days =
"Daily", Every x weeks = "Weekly") to
use for the interval of time between
recurrences

Repeat Interval Shown when Repeat Type does not
equal "None", the number of units in the
"Repeat Type" field that should pass
between recurrences, for example:

Every three days : Repeat Type
= "Daily"; Repeat Interval = "3"
Every other week : Repeat Type
= "Weekly"; Repeat Interval =
"2"
Each year : Repeat Type =
Yearly; Repeat Interval = "1"

Repeat Shown when Repeat Type does not
equal "None"; Select "Until" to set a
hard end date to recurrences or
"Occurrences" to specify the number of
times to repeat the meeting

Repeat Until Shown when "Repeat" equals "Until",
the date of the last occurrence in the
series

Repeat Occurrences Shown when "Repeat" equals
"Occurrences", the number of meetings
in the series

Repeat on Days of Week Shown when "Repeat Type" equals
"Weekly", the day(s) of the week that
the meetings will occur in the recurring
series

Custom Date (monthly) Shown when "Repeat Type" equals
"Monthly", select "Each" to specify a
certain day(s) of the month or "On the"
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to set a variable such as the first
Monday of each month

Custom Date (yearly) Shown when "Repeat Type" equals
"Yearly", select "None" to repeat the
meeting on the same day every year or
"On the" to set a variable such as the
last Friday of each year

Start Date The date and time that the meeting or
first meeting in the series of recurring
meetings is scheduled to begin

Status The current status (e.g. Scheduled,
Held, Canceled) of the meeting record

Subject The subject of the scheduled meeting
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
meeting record

Meetings Color Codes

When viewing the Meetings list view and the Meetings dashlet, the start date may
be highlighted in blue or red. This allows users to quickly view scheduled meetings
that are either overdue or start within the next 24 hours. Please note that the start
date will not be highlighted for meetings with a status of "Held" or with a start
date in the future (beyond 24 hours from current date and time).

The start dates in the Meetings list view are highlighted as follows:

Blue : The meeting has not been held, and the start date occurs within the
next 24 hours.
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Red : The meeting has not been held, and the start date has passed.

Please note that you can only see meeting records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Working With Sugar Modules

While the Meetings module has some features that only apply to meetings, it also
uses the Sidecar user interface that most Sugar modules are based on. In the table
below, the left column contains links to the User Interface page covering topics
that are applicable to all Sidecar modules. The right column has links to sections of
the current page that cover topics specific to meetings.

General Instructions for Working
With Sugar Modules

Meetings-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Meetings-specific help exists for
each topic, use the links below to
navigate to sections of the current page.

Creating Records Creating Recurring Meetings
Creating Meetings via Calendar
Meeting Guests
Meeting Reminders

Viewing Records Viewing Meetings via Calendar
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records Editing All Recurrences of a Meeting via

Record View
Editing Meetings via Calendar

Deleting Records Deleting All Recurrences of a Meeting
via Record View
Deleting All Recurrences of a Meeting
via List View
Closing Meetings

Exporting Records
Favoriting Records
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Following Records
Sharing Records

Meeting Menus

The Meetings module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Meetings-specific
functionality, within this page.

Module Tab Menus

The Meetings module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list, and you can click "Meetings" to
access the list view. Once the Meetings tab displays on the navigation bar, you can
click the triangle on the tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform certain actions within the module.
The Recently Viewed menu displays the list of meetings you most recently viewed.
The Favorites menu displays the list of meetings that you most recently marked as
favorites.

The Actions menu allows you to perform the following operations:

Menu Item Description
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Schedule Meeting Opens the record view layout to create a
new meeting

View Meetings Opens the list view layout to search and
display meetings

Import Meetings Opens the import wizard to create or
update meetings using external data

If you do not see the Meetings module tab in Sugar, please check the following:

The Meetings module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Meetings module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Meetings module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Meetings module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration guide.

List View Menus

The Meetings list view displays all meeting records and allows for searching and
filtering to locate specific meetings. You can see the basic details of each record
within the field columns of the list view or click a meeting's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual meeting records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more meetings at a

time
Delete Delete one or more meetings at a time
Export Export one or more meetings to a CSV

file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual meeting directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this meeting in the intelligence

pane
Edit Edit this meeting
Close Close this meeting
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Note: Shown only for meetings that do
not have a status of "Held"

Delete Delete this meeting
Delete All Recurrences Delete this meeting and all other

meeting records in this meeting's series
Note: Shown only for meetings that are
one in a recurring series

Record View Actions Menu

The Meetings record view displays a single meeting in full detail including its
fields, subpanels of related records, and activity stream. To access a meeting's
record view, simply click a hyperlinked meeting name from anywhere within
Sugar. The record view's Actions menu appears above the record's details and
allows you to perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this meeting
Edit All Recurrences Edit this meeting and all other meeting

records in this meeting's series
Note: Shown only for meetings that are
one in a recurring series

Share Share a link to this meeting via email
Copy Duplicate this meeting to create a new

meeting
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Delete Delete this meeting
Delete All Recurrences Delete this meeting and all other

meeting records in this meeting's series
Note: Shown only for meetings that are
one of a recurring series

Close and Create New Close this meeting as "Held" and create
a new copy of the meeting
Note: Shown only for meetings that do
not have a status of "Held"

Close Close this meeting as "Held"
Note: Shown only for meetings that do
not have a status of "Held"

Meeting Guests

The following guests are automatically added to a meeting's guest list:

Automatic Guest To Remove the Guest
The lead or contact in the "Related to"
field, if any

This guest can be removed from the
guest list at any time. If a lead or
contact record is related to a meeting
but is not on the guest list, then you will
not see the meeting in the person's
Meetings subpanel.

The user who created the meeting This guest can be removed from the
guest list after initially saving the
meeting. Create and save the meeting,
click "Edit", and then click the Remove
(-) button next to the created-by user's
row in the Guests panel.

The user in the "Assigned to" field for
the meeting record

The assigned user cannot be removed
from the guest list. If you need to
remove the assigned user from the
guest list, you must first re-assign the
meeting to a different user. Once the
meeting record is assigned to a new
user, the original user will remain a
guest until removed via the Remove (-)
button.

Users may add additional guests (e.g. contacts, leads, users) to meetings via the

                       632 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_Records


 

Guests panel in the meeting's record view.

Adding via the Guests Panel

Use the following steps to add attendees via the Guests panel:

1. Navigate to the Meetings module and create a new record or edit an
existing record.

2. Scroll to the Guests panel and click on the Add (+) button located on the
far right.

3. To add a guest, type in the name of the lead, contact, or user via the search
bar that appears or select "Search for more..." to search the Contacts list
view. To remove a guest, click the Remove (-) button to the right of the
guest's row.
Note: The user in the "Assigned to" field on the meeting record cannot be
removed from a meeting. To remove the assigned user from the guest list,
re-assign the meeting to a different user first.

4. Click "Save" or "Save and Send Invites" if you would like Sugar to send
email invitations to the guests.
Note: Confirm that the guests' Sugar records have valid email addresses
prior to clicking "Save and Send Invites". If a guest has no email address or
their email address is marked as invalid, Sugar cannot email them an
invitation to the meeting. A message and icon will alert you when adding
the guest and when viewing the meeting's record view.

Once the guest has responded to the email invitation, their acceptance status will
appear as a color-coded badge next to their name.
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Adding via Create a Guest

Use the following steps to create a new contact and add them as a meeting guest:

1. Navigate to the Meetings module and create a new record or edit an
existing record.

2. Scroll to the Guests panel, click on the Add (+) button, and then click on
"Search for more..." to expand the Contacts list view.

3. At the top of the list view, click the Create button and fill out the
appropriate fields to create a new contact. Once completed, save the new
contact record and Sugar will automatically add the contact to the guest
list for the meeting.

4. Confirm the remaining fields and guests are configured appropriately and
then save the meeting.

Recurring Meetings

Meetings can be saved as recurring events so that users do not have to create
individual meeting records for regularly occurring events. Recurrences may occur
daily, weekly, monthly, or yearly. When a recurring meeting is saved, Sugar
creates a series of individual meeting records so that all recurrences appear in the 
Meetings list view.

Note: If a user creates a recurring meeting but the start date does not match the
specified recurrence day(s) of the week, the start date will reset to the first
matching day after the meeting's Date Created.

Creating Recurring Meetings
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To schedule a series of recurring meetings, follow the instructions below. As an
example, we will schedule a 30-minute meeting that recurs every other Thursday
until the end of the 2017 calendar year.

1. Navigate to the Meetings module and create a new record.
2. In the Start Date field, enter the date and time that the first Thursday

meeting will occur and set the End Date for the same day but 30 minutes
later.

Note: If a recurring meeting's start date does not match the meeting's
recurrence day(s) of the week, the start date will reset to the first matching
day-of-week after the meeting's Date Created.

3. To create a series of meetings, expand the field labeled "Repeat Type" and
select an interval from the dropdown list. Our use case requires an interval
of weeks (e.g. every two weeks), so we will select "Weekly" and specify our
interval number in the next step.

4. Upon choosing a Repeat Type value, a new row of fields will appear on the
form to gather the series information.

The fields displayed are dependent upon the values you select as you go.
Please refer to the Meeting Fields section for complete details on the
available options. To schedule a meeting that recurs every other Monday
until the end of the 2020 calendar year, set the following values:

Repeat Interval : 2
Repeat on Days of Week : Mon
Repeat : Until
Repeat Until : 2020-12-31

5. Confirm that the remaining fields and guests are configured appropriately.
6. Save the record and confirm that all recurrences appear as separate

records in the Meetings module's list view.
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Editing All Recurrences via Record View

Recurring activities will display the option to edit all occurrences of the activity in
the record's actions menu. This option will affect all of the meeting records in a
series, even if some of the meetings have been closed and set to "Held". Use the
following steps to edit all recurrences in a series of meetings via the record view:

1. Navigate to the record view of any meeting in the series of recurring
meetings.

2. Select "Edit All Recurrences" from the Actions menu.

3. Edit the meeting record as needed.
4. Then click on "Save" or "Save and Send Invites" to apply the changes to all

held and unheld meetings in the series.

Deleting All Recurrences via Record View

Recurring activities will display the option to delete all occurrences of the activity
in the record's actions menu. This option will affect all of the meeting records in a
series, even if some of the meetings have been closed and set to "Held". Use the
following steps to delete all recurrences in a series of meetings via the record
view:

1. Navigate to the record view of any meeting in the series of recurring
meetings.

2. Select "Delete All Recurrences" from the Actions menu.
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3. A pop-up message will display asking for confirmation. Click "Confirm" to
delete all held and unheld meetings in the series.

Deleting All Recurrences via List View

Recurring activities will display the option to delete all occurrences of the activity
in the record's actions menu in the list view. This option will affect all of the
meeting records in a series, even if some of the meetings have been closed and set
to "Held". Use the following steps to delete all recurrences in a series of meetings
via the list view:

1. Navigate to the Meetings list view by clicking the Meetings module tab.
2. Use the Module Search to find the meeting in the series of recurring

meetings that you wish to delete.
3. Click the Record Actions Menu to the far right of the record's row and

select "Delete All Recurrences".

4. A pop-up message will display asking for confirmation. Click "Confirm" to
delete all held and unheld meetings in the series.

Meeting Reminders

Sugar can remind guests when a meeting is scheduled to begin soon. Reminders
can be sent via email to all of the guests or via pop-up to all user guests prior to
the meeting's scheduled start date and time. By default, a user must set reminders
when creating or editing the activity, but users can configure default reminders via
their User Preferences, which will automatically set a default reminder time for
meetings they create in Sugar.

Note: The instance's outbound mail server must be configured via Admin >
System Email Settings in order for email reminders to be sent out. For more

                       637 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Getting_Started#User_Preferences


 

information on setting up the system email settings, please refer to the Email
documentation in the Administration Guide.

Email Reminders

Email reminders can be set for any meeting record relative to its start date and
time. The reminders are emailed to all guests with valid email addresses including
non-Sugar users.

To schedule email reminders, select a time interval from the meeting's Email
Reminder Time field:

Popup Reminders

Popup reminders can be set for any meeting record relative to its start date and
time. Popup reminders appear for Sugar users on the meeting's guest list who are
logged into Sugar in an open browser window at the time the reminder pops up.

To schedule popup reminders, select a time interval from the meeting's Popup
Reminder Time field:
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Closing Meetings

Once a meeting has taken place, a user can close the meeting record, which
changes the meeting's status to "Held". The "Close" option only appears for
meetings that are considered open, or not "Held". Open meetings are shown in the
Planned Activities dashlet on the record view of related records and guests (e.g.
Contacts, Leads, etc.). After closing a meeting, Sugar will move it from the Planned
Activities dashlet to the History dashlet and the meeting record's status will
display "Held" wherever it is viewed.

Closing via Record View

An open meeting's record view allows you to simply close the current meeting
record or use "Close and Create New" to close the meeting and create a new
meeting with the same details simultaneously. "Close and Create New" is often
used when a user wants to log a completed meeting and easily schedule a follow-
up meeting with the same people about the same topic.

To close a meeting record via its record view, click on the meeting to open its
record view. Expand the record's Actions menu and select "Close" or "Close and
Create New".
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Depending on your selection, you will experience different results:

Close : Instantly changes the meeting's status to "Held" and displays a
Success message.
Close and Create New : Instantly changes the meeting's status to "Held",
displays a Success message, and opens a quick-create drawer for a new
meeting record with the same values, guests, relationships. and other field
values as the held meeting. The only field that is not copied from the
original record is the status field, which will revert to "Scheduled" for the
new meeting. Simply adjust the dates, times, and other information as
needed, and save the new meeting as usual.

Once a meeting is closed, the closing options will no longer appear in the Actions
menu.

Closing via List View

Use the following steps to close a meeting record via the list view:

1. Click the Meetings tab to navigate to the Meetings module's list view.
2. Use the Module Search to find the Meeting record(s) you wish to close.
3. Click the Record Actions Menu to the far right of the record's row and

select "Close".

Sugar instantly changes the meeting's status to "Held" and displays a Success
message.
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Closing via Dashlet

The Planned Activities dashlet is available for home page dashboards and on the
record view's intelligence pane for Sidecar modules. From the home page
dashboard, the Planned Activities dashlet displays all upcoming calls and meetings
assigned to you or your team depending on your chosen filters. When viewing the
Planned Activities dashlet from a record's intelligence pane, the calls and meetings
shown are only those that are related to the record you are viewing. For example,
when viewing the contact record for Joe Smith, the Planned Activities dashlet in
the intelligence pane will show only the upcoming calls and meetings with Joe
Smith on the guest list. For more information about the Planned Activities dashlet,
please refer to the Intelligence Pane documentation.

Use the following steps to close a meeting record via the Planned Activities
dashlet:

1. Navigate to your home page's dashboard or the record view that contains
the Planned Activities dashlet showing the meeting you would like to close.

2. If necessary, click the Meetings tab on the Planned Activities dashlet to
find the meeting.

3. Click the Held (x) button to the right of the meeting's row in the dashlet.

4. A pop-up message will display asking for confirmation. Click "Confirm" to
move the meeting to the record's History dashlet with the status "Held".

Calendar Module and Meetings

The Calendar module displays a user's calendar including their Sugar activity
records. You can view, schedule, and manage calls, meetings, and tasks directly
within the calendar, allowing you to plan your time with full access to other
scheduling commitments.

Viewing via Calendar

The Calendar module allows users to schedule, view, and manage activities (calls,
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meetings, tasks) in Sugar. Meeting records are displayed in blue on the calendar
and you can click the corresponding cell to view the meeting's details. You can also
click the Info (i) icon in the meeting's cell for a quick view of additional details (e.g.
Subject, Start Date & Time, etc.) of the meeting without navigating away from the
calendar.

For more information on viewing and managing meetings on the calendar, please
refer to the Calendar documentation. Users also have the ability to view other
user's scheduled activities via the shared calendar option. For more information on
viewing the shared calendar, please refer to the Calendar documentation.

Please note that you can only see meeting records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation.

Creating via Calendar

There are two ways to create meetings from the Calendar module. The first
method is via the Schedule Meeting option in the Calendar's module tab. This will
open the meeting's record view in edit mode so that you can create a new meeting
record. For more information on creating meeting records, please refer to the User
Interface documentation and the various meeting-specific sections above.

The second method is to create the meeting directly within the Sugar calendar. For
more information on navigating and viewing the calendar, please refer to the 
Calendar documentation. Use the following basic steps to create a meeting via the
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Calendar module:

1. Navigate to the calendar in Sugar by clicking on the Calendar module tab.
2. On the calendar grid, click directly on the cell corresponding to the date

and time you wish to schedule the meeting.

3. An alert will appear asking if you would prefer to create a task or call
record. To continue creating a meeting, click on the Close (x) icon on the
alert.

4. You will now see the meeting's record view in edit mode so that you can
create a new meeting record. Complete the meeting's fields as described in
the User Interface documentation and the various meeting-specific sections
above.

Editing via Calendar

Once meetings are scheduled in Sugar, they appear in the assigned user's calendar
based on the specified due date and time. You can click the Info (i) icon on the
meeting's calendar cell to view additional information about the meeting.

                       643 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_Records


 

The Additional Details popup window displays a Pencil icon on the upper right,
which opens up the meeting's full record view for users to make any changes as
necessary.

Click "Save" to preserve any changes made to the meeting record.

Last Modified: 2020-03-31 23:22:10

Emails

Overview

Sugar's Emails module stores copies of email messages that have been sent from
or archived to Sugar. While Sugar is not primarily an email application, it does
allow users to send email using their personal email address, a shared email
account, or a system account and to archive copies of messages and attachments
sent or received through a third-party email application.
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This documentation will cover how to send and archive email messages and how to
use the following modules:

Emails
Email Signatures
Email Templates
Outgoing Email Accounts

In the Email Signatures, Email Templates, and Outgoing Email Accounts modules,
you can view only the records that you have created with the exception of the
system email account, which may be visible in the Outgoing Email Accounts list
view. In the Emails module, you can search for and view emails that you have
archived to Sugar or that have been archived by other users as allowed by your
team membership, user access type, and assigned roles. Emails that are in a Draft
status can only be seen by the created-by user and administrators. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration Guide.

Note: There are three types of outgoing email accounts in Sugar: system, user,
and default user. This document focuses primarily on the user email account and
the default user email account. For more information about the system email
account and additional details on administering user email accounts, please refer
to the Email documentation in the Administration Guide.

Sending and Receiving Email in Sugar

Sending Email

Emails sent from Sugar are automatically archived in Sugar and related to records
that match the email addresses in the message. To send emails through Sugar,
users must configure their default user email account via Email Settings. Users
may add additional outgoing email accounts (e.g. work email, home email, school
email) unless the administrator has enabled the "Allow users to use this account
for outgoing email" option in Admin > System Email Settings.

If Administrator chooses to allow users to send email using the system email
account by enabling the "Allow users to use this account for outgoing email" option
in Admin > System Email Settings (this is not common), users will not be able to
configure their default email account and must instead utilize the system email
account or create a new user email account. Users will see the system email
account in the Outgoing Email Accounts list view with an asterisk to indicate that
it is a system account. 

Receiving Email
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Because Sugar is not an email application, users cannot receive email directly to
Sugar via their user email accounts. Instead, users must archive emails they
receive using one or more of the techniques listed in the Archiving Emails section
of this page.

Emails

The Emails module contains email records, which are copies of the emails that
have been sent from or archived to Sugar. Users can view, sort, filter, and favorite
email records according to their team and role memberships even if the emails
have been sent or archived by a different user.

For basic use and navigation of the emails module, please refer to the Working
With Emails section, which contains links to the User Interface documentation for
behaviors that are common among most Sidecar modules. More information is
available on email-specific functionality such as sending, replying, archiving, and
composing emails in the sections under the Composing Emails header below.

Email Fields

The Emails module contains the following fields. For information on using and and
editing various field types, refer to the User Interface documentation.

Field Description Notes
Assigned To The Sugar user assigned

to the email record
By default, the Assigned
To user is the user who
creates and sends the
message. For messages
saved as drafts, the
Assigned To user is the
only users who will be
able to edit and send the
draft later.

Attachments Any attachments included
with the email

For more information,
please refer to the Adding
Attachments section of
this page.

Body The content of the email
message

There is no label for this
field in the application.
The body of your message
is composed in the
TinyMCE text editor
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window. For more
information on how to use
the text editor, please
refer to the User Interface
documentation in the
Application Guide.

Date The date the message was
sent, received, or
modified, depending on
the email's status and
direction

Archived
(incoming) : The
date the email was
received
Archived
(outgoing) : The
date the email was
sent
Draft : The last
modified date

Direction The direction (e.g.
Outbound, Inbound,
Internal, Unknown) of the
email based on the sender
and recipient(s) in the
email message.

Not visible on record
views or as a list view
column, the Direction field
is available only as an
available filter field in the
Emails list view. For more
information on filtering
the Emails list view using
the Direction field, refer to
the Email's Direction
Field.

Note: Draft emails will
have a direction of
"Unknown".

From The email address that the
email was or will be sent
from

This field shows your
available outgoing email
accounts and determines
the From name and From
address that the
recipient(s) will see. 

Note: The Emails list view
can be filtered using the
From field to locate emails
from a particular sender.

Inbound Account The incoming email
account that received the

Not visible on record
views, the Inbound
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email Account field is available
only for filtering the
Emails list view.

Number of Attachments An integer representing
the quantity of individual
files that are related to the
email record as
attachments

Not visible on record
views or as a list view
column, the Number of
Attachments field is
available only as an
available filter field in the
Emails list view.

Recipient Fields The fields that contain
email addresses of the
email recipients

To : The email
address(es) that
the email was or
will be sent to
Cc : The email
address(es) that
the email was or
will be copied to
Bcc : The email
address(es) that
the email was or
will be blind
copied to

For more information,
please refer to the 
Working With Recipient
Fields section of this page.

Note: The Emails list view
can be filtered using the
To, CC, or Bcc fields to
locate emails from certain
recipients.

Related To The module and record
that is related to this
email

The email will be listed in
a subpanel under its
"Related To" record.

Status The state of the message:

Archived : The
message has been
sent or received.
The message may
have been sent

Sugar does not
differentiate between sent
and received emails via
the Status field, but users
can find messages by
direction by filtering the
Emails list view using the
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through the Sugar
application or
synchronized to
Sugar from an
external email
client such as
Microsoft Outlook.
Draft : The
message has not
yet been sent from
Sugar. Email
records in a draft
state are only
visible to the
email's assigned
user and the
administrator.

Direction field.

Subject The subject line for the
email message

Tags User-created keywords
that can be used to
identify records in filters,
dashlets, and reports

For more information on
creating and using tags,
please refer to the Tags
documentation.

Teams The Sugar team(s) whose
users have access to the
email record according to
their role permissions

Working With Emails

The following links open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following the Working With Emails section describe email-
specific behaviors and functionality.

Content Link Description
Emailing Sugar Records
Emailing via Emails Module
Emailing via Quick Create

Once an outgoing email account has
been properly configured, Sugar allows
users to compose email messages in the
application and send them to recipients.
Emails composed in Sugar utilize rich-
text formatting utilizing the TinyMCE
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text editor.

The links to the left will take you to the
corresponding section of the User
Interface documentation where you can
learn about the various ways to send
emails to records in Sugar.

Viewing Emails
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing archived
email records, including via the Emails
list view and record view, the Recently
Viewed menu in the Emails module tab,
list view dashlets showing email
information, Activity Stream entries
concerning email updates or where a
user mentions an email, previewing
emails in the right-hand side panel, and
reports displaying email data.

Searching for Emails
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating emails:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Emails module.

Note: The "My Sent" filter on Emails list
view shows all emails where the sender
is the current user, regardless of which
email account was used to send the
message. To restrict search results by
the Group Inbound account that
received them, create a filter using the
"Inbound Account" field.

Emails List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection

The List View section walks through the
many elements of the Emails List View
layout which contains a filterable list of
all email records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Emails list view are described in the 
List View Mass Actions Menu and List
View Record Actions Menu sections of
this page.

                       650 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Using_the_TinyMCE_Text_Editor
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Recently_Viewed
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Dashlets
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Activity_Streams
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Preview
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_via_Reports
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Searching_for_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Global_Search_2
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Creating_a_Filter
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Saving_a_Filter
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Email#Creating_Group_Mail_Accounts
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Total_Record_Count
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Create_Button
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View_Search_2
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Checkbox_Selection
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Mass_Actions_Menu
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Favorite_Designation
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Column_Reordering
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Column_Resizing
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Column_Sorting
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Column_Selection


 

Preview
Record Actions Menu
More Emails
Activity Stream
Intelligence Pane
Emails Record View
Favorite Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Intelligence Pane

The Record View section walks through
the many elements of the Emails Record
View layout which contains detailed
information about a single email record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Emails record view are
described in the Record View Actions
Menu section of this page.

Editing Emails
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
email records, including inline via the
Emails record view, in full edit mode on
the record view, inline via the Emails
subpanel on related module records,
inline via the Emails list view, and via
the Mass Update option on the list view.

Note: Users cannot edit an email's
content, dates, or recipients once it has
been archived. Users with appropriate
role permissions can, however, edit the
Assigned To, Teams, Related To, and
Tags fields for archived emails.

Deleting Emails
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted emails, including via the
Emails record view, an individual
record's Actions menu on the Emails list
view, and the Mass Actions menu on the
list view.

Note: Deleting an email will also delete
any attachments for the email from the
Notes module. To preserve attachments,
download and save email attachments
either locally or into the Sugar
Documents module before deleting an
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email.
Exporting Emails The Exporting Records section provides

an introduction to the export
functionality which allows you to
download a list of emails and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Favoriting Emails
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking emails as favorites, including
via the Emails list view, Emails record
view, or any Emails subpanel appearing
on the record view of a related module.
Favoriting an email allows you to easily
access it from list views, dashlets, or the
Emails module tab.

Email Menus

The Emails module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and their options with links to more information about each
option in the User Interface documentation or, for emails-specific functionality,
within this page.

Emails Module Tab Menu

The Emails module tab is typically located under the More tab on the navigation
bar at the top of any Sugar screen. Depending on your settings, you may have to
click "Show More" in order to see the Emails module tab. Click the tab to access
the Emails list view. You can also click the triangle on the Emails module tab to
display the Actions and Recently Viewed menus. The Actions menu allows you to
perform important actions within the module. The Recently Viewed menu displays
the list of emails you last viewed in the module.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Compose Email Opens the composition layout to

compose and send a new email message
or, optionally, save the message as a
draft

Create Archived Email Opens the composition layout to create
a historical record of an email message
that was sent or received outside of the
Sugar application

View Emails Opens the Emails list view to search and
display email messages

Create Email Template Opens the Email Templates edit view
layout to create a new email template

View Email Templates Opens the Email Templates list view to
search and display email templates

Create Email Signature Opens the composition layout to create
a new email signature

View Email Signatures Opens the Email Signatures list view to
search and display email signatures

Email Settings Opens the Outgoing Email Accounts list
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view to display, edit, and create email
accounts

If you do not see the Emails module tab in Sugar, please check the following:

The Emails module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile, click the Advanced tab, and check the Layout Options section.
If you see the Emails module in the Hide Modules list, simply move it to the
Display Modules list and save. For more information on hiding and
displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Emails module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Emails
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration guide.

List View Menus

The Emails list view displays all email records and allows for searching and
filtering to locate specific emails. You can view the basic details of each record
within the columns of the list view or click an email's name to open the record
view. To access a module's list view, simply click the module's tab in the navigation
bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu allows you to perform mass actions on all currently
selected records. You can use the checkbox on each record's row to select
individual email records or click the checkbox in the list header to select all
records displayed on the current set of list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more email records

at a time
Delete Delete one or more emails at a time
Export Export one or more email records to a

CSV file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual email directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this email in the intelligence

pane
Edit Edit this email
Delete Delete this email

Record View Actions Menu

The Emails record view displays a single email in full detail including its fields,
subpanels of related records, and activity stream. To access an email's record
view, simply click a hyperlinked email subject from anywhere within Sugar. The
record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Reply Respond to the sender of this email
Reply All Respond to the sender and all other

recipients of this email
Edit Edit this email
Delete Delete this email

Archiving Emails

When a copy of a sent or received email message is stored in Sugar, it is
considered an archived email. Users cannot edit an email's content, dates, or
recipients once it has been archived. Users with appropriate role permissions can,
however, edit the Assigned To, Teams, Related To, and Tags fields for archived
emails. 

Note: Assignment notifications, password-reset emails, scheduled reports, and
SugarBPM emails sent from Sugar will not be stored in Sugar as archived emails.

There are several ways that emails may be archived in Sugar, including:

Manually creating an archived email via "Create Archived Email"
Composing and sending an email from Sugar via the Emails module
Sending an email campaign via the Campaigns module
Receiving a message to a Group Inbound Email account in Sugar
Archiving emails via the Sugar Email Archiving service (a.k.a. "SNIP")
Archiving emails via a connector, third-party application, or API (e.g. MS

                       656 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Campaigns
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Email#Creating_Group_Mail_Accounts


 

Outlook Plug-in, Collabspot)

Note: When an email record is archived to Sugar, the service that imports the
email may set the Teams field for the email record. If the team is not set at the
time of archive, the email's team will default to "Global". Users with the
appropriate permissions may update the Teams field after the email has been
archived in Sugar.

Manually Creating Archived Emails

Users who do not have an email account configured in Sugar or who would like to
log an email that was not automatically archived can manually create copies of
email messages for archival purposes. To create an archived email in Sugar,
navigate to the Emails module and select "Create Archived Email" from the Emails
module tab menu. Alternatively, navigate to the record that you would like to
relate to the archived email and select "Create Archived Email" from the record's
History dashlet.

The email composer window will open where you can manually copy the contents
of an email you have already sent or received outside of Sugar. When creating an
archived email, the Send button is hidden. Instead, there is an Archive button,
which allows the user to log the message without actually transmitting it.

In addition to completing the standard email fields, indicate the date and time that
the email was sent or received in the fields labeled "Date Sent". After copying the
contents of the message you want to archive, click the "Archive" button to save the
record in Sugar.
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Please note that, like other archived emails in Sugar, you cannot edit the
message's content, dates, or recipients once it has been archived. Users with
appropriate role permissions can, however, edit the Assigned To, Teams, Related
To, and Tags fields for archived emails.

Composing Emails

There are several places in Sugar where you may create an email message, but
this section focuses on the composition elements of the email message such as
recipients, attachments, templates, and signatures. For more information on places
you can create emails in Sugar, please refer to the User Interface documentation. 

Working With Recipient Fields

Sugar allows multiple recipients for an email message using the To, Cc, and Bcc
fields. To send a message, at least one of the three recipient fields must contain at
least one valid recipient. For example, a user may send a message with recipients
in only the Bcc field if they want to hide the recipients' email addresses from each
other.

To include Cc or Bcc recipients, click the "Cc" or "Bcc" button to expand the
recipient field. You can click the buttons again to hide them or simply click another
area of the record such as the Body or Subject field.

Note: When composing email messages via Quick Create, Sugar will automatically
hide the recipient form fields and populate the message's "To" and "Related To"
fields with the name and email address of the record you are viewing. To edit or
override the default recipient, click directly on the hard-coded name above the
Subject field and the area will transform into the standard From/To/Cc/Bcc form
seen in the image above. For more information, please refer to the User Interface
documentation.

You can type email addresses directly in the recipient fields or look up recipients in
the Address Book. For more information, please refer to the Freehand Address
Entry and Using the Address Book sections of this page. When adding recipients,
keep in mind the following tips for working with recipient fields:
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To select a recipient, click the recipient's pill in the recipient field and it
will turn blue to indicate that it is in a selected state.

To select multiple recipients within the same field, hold down the Shift or
Command key then click the desired recipient pills.
To move one or more recipients between the To, Cc, and Bcc fields, select
the recipient(s) and drag your selection from one field to the other.

To remove recipients from the message altogether, click the x inside the
recipient's pill or select the recipient(s) and press the Delete key on your
keyboard.
To deselect recipient(s), click the blank space inside the field.

Using the Address Book

You can search across modules using the Address Book in the Emails module,
which aggregates the users, contacts, leads, targets, and accounts in Sugar that
have at least one valid email address. 

To access the address book, click on the address book icon next to the recipient
field you are working with.

You can search for and select multiple recipients from the Address Book and filter
the Address Book's list view to restrict results to a specific module such as
contacts or users.
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You can also tap into the Address Book by typing a first name, last name, email
address, or account name directly in any of the recipient fields on the email
message. Sugar will find potential matches as you type and you can select the
correct recipient from the suggestions. Each matching recipient option will display
a badge that indicates which module contains the record (e.g. "Le" for Leads).

Freehand Address Entry

In addition to using the address book, you may choose to click inside any of the
recipient fields and type one or more email addresses freehand. Email addresses
do not need to be stored in Sugar to be used as email recipients. If an email
address already exists in the database, then Sugar will find it as you type and you
can select it from the suggestions. If the email address is not yet stored in the
database, then simply hit the Enter key to commit the new address to the recipient
field.

Note: Sugar validates email addresses on-the-fly and warns the user when an
invalid email address has been entered.
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Adding Attachments

Sugar allows you to send attachments along with your email. Attachments can be
files from your local computer or documents from within Sugar. Any user who has
permission to view the email record can also access attachments for the message.
To include an email attachment, simply click on the Attachment icon in the toolbar:

The Attachment menu provides two options:

Upload From Local : Opens your system's file navigator so you can find
and attach a file that is saved on your computer
Sugar Document : Opens the Search and Select screen so you can search
for a file in Sugar's Documents module

Note: File attachments from your computer are stored in the Notes module, so you
must have permission to create notes in order to upload attachments. If you do not
have permission to create notes, the Attachment option will be hidden. Similarly,
users who do not have role permission to view records in the Documents module
will not see the "Sugar Document" attachment option. For more information on
configuring roles in Sugar, please refer to the Role Management documentation in
the Administration Guide.

After selecting the documents you want to attach to the message, they will appear
under the body field of the email message.

Each attachment will display an approximate file size in parentheses next to the
file name. If the file you are attaching exceeds or causes the total size of
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attachments on the message to exceed the system's maximum upload size, the
attachment will fail to upload. For more information on configuring the system's
maximum upload size, please refer to the System documentation in the
Administration Guide.

To remove an attachment before sending a message, simply click on the x next to
the attachment's name.

When viewing draft and archived emails in list view, a paper clip icon next to a
record's subject will indicate that the email contains one or more attachments. You
can download an archived email's attachments from the email record's preview or
from record view by clicking on the file name.

Using a Template

Email templates can save time and reduce errors when composing common email
messages. For more information on how to create an email template, please refer
to the Email Templates section of this documentation.

As a best practice, send templates that contain variables to a single recipient only.
If the template has any variable fields defined in it (i.e. $contact_name), Sugar will
replace the variables with corresponding values from a related record. If multiple
records share the same email address or multiple recipients are on the email,
Sugar will pick only one of the record's values to place in the email template to
send to all of the email addresses. If no related record is found, Sugar will warn
you that the variable fields will be blank before you send the message. For more
information on how to send a dynamic variable to many recipients, please refer to
the Campaigns documentation in the Application Guide.

To use an email template, compose a new email message and click on the Template
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icon in the toolbar before completing any other fields on the email.

After clicking the Template icon, the Search and Select window will appear where
you can find the appropriate template for your message. Select the radio button
next to the template to pull all of its content and any attachments into your current
message.

Note: If the body or subject of the email contains any data before a template is
selected, the body and subject will be removed and replaced with the template
data. Similarly, if the message contains an attachment, the attachment will be
removed and replaced with any attachments that the template may contain.

Once an email template has been inserted in the email editor, users are free to edit
the subject and email body, add or remove attachments, and insert a signature on
the message.

Using an Email Signature

Email signatures are an easy way to standardize the messages you send with your
contact details or other messaging. For more information on how to create an
email signature, please refer to the Email Signatures section of this
documentation.

Follow these steps to choose an email signature for a message:

1. First, create a new email or edit a saved draft.
If you have created a default signature, it will automatically appear
in the body of the message and you can simply type your message
above the signature.
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If you have not designated a signature as default or if you would
like to select a different signature, continue to step 2.

2. Place your cursor inside the body of the message where you want the
signature to appear.

3. Click on the Email Signature icon in the toolbar and select your preferred
signature from the dropdown list.

To remove a chosen signature, simply select another signature to replace it. If you
decide to use no signature at all after a signature has been added to the composer,
you must delete it manually in the composition window.

Note: The Email Signature button is disabled when the cursor is not in the body of
the email composer field and when there are no signatures defined for the user.

Saving and Editing Draft Emails

To save a draft of an email that you do not want to send right away, simply start 
composing a new email message and click "Save Draft" instead of using the Send
button. Any content, recipients, templates, and signatures used in the email are
saved with the draft. Only the administrator and the Assigned To user can view
and edit emails in a Draft status.

Note: Draft emails cannot be re-assigned to another user, so mass updating the
Assigned To field for emails will not re-assign drafts if they are selected.

Users can only access the draft emails that they have created. A user's drafts
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appear alongside archived emails in the Emails list view and can be isolated in list
view using the "My Drafts" filter.

Click on the subject of a draft email to launch the Compose Email screen where
the email's assigned user can continue editing the email and save the email as a
draft again or send the email, which will change the email's status to "Archived".

Sending Emails

To send an email to the recipients in an email's To, Cc, and Bcc fields, simply click
the Send button.

Sent emails will use the settings configured for the From account to send the
email. A copy of the sent email will be saved to Sugar as "Archived" in the Emails
module and can be isolated in list view using the "My Sent" filter.

Replying to Emails

Users can access the "Reply" and "Reply All" functions from the record view of
emails that have an Archived status. Select "Reply" to reply to only the sender of
the selected email or select "Reply All" to reply to the sender and all other
recipients of the original email.
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When replying to an email, Sugar creates a new email while populating the body,
subject, and recipients of the email and carrying over the Related To, Assigned To,
and Teams fields from the original email. The subject line of the email you are
replying to carries over to the new email preceded by the letters "Re: ". The body
of the email you are replying to is also carried over to the reply message with a
line above the contents to separate the original email from the content you are
adding to the reply.

Enter your reply above the divider line in the compose email screen. For more
information on how to compose an email, please refer to the Composing Emails
section.

Note: If the original email contained any attachments, they will not copy to the
reply email.

Forwarding Emails
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Users can access the Forward function from the record view of emails that have an
Archived status. Select "Forward" to open a compose window where you can
specify one or more recipients.

When forwarding an email, Sugar creates a new email while populating the body
and subject of the email and carrying over the Related To, Assigned To, and Teams
fields from the original email. The subject line of the email you are forwarding
carries over to the new email preceded by the letters "FW: ". The body of the email
you are forwarding is also carried over to the message with a line above the
contents to separate the original email from the content you may optionally add to
the message. The recipient fields must be completed by the user before the email
can be forwarded. For more information on adding recipients, please refer to the 
Working With Recipient Fields section of this page.

Optionally, enter a message above the divider line in the compose email screen.
For more information on how to compose an email, please refer to the Composing
Emails section.
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Note: If the original email contained any attachments, they will not copy to the
forwarded email.

Relating Emails to Records

Emails in Sugar are implicitly related to records in Sugar that match an email
address in the From, To, or Cc fields in the email. This implicit relationship is made
for emails sent from Sugar as well as emails archived in Sugar via incoming email
accounts or the Sugar Email Archiving service. Implicitly related emails will show
in the Emails subpanel and History dashlet of the related record.

While composing an email, users can set an explicit relationship via the Relates To
field. This allows the user to relate the email to a Sugar record regardless of
whether the record contains an email address related to the email.

In addition to using the Relates To field, you can link additional module records to
emails via the related record subpanels on the email's record view.

Understanding Email Address Opt-Outs

Email addresses can be marked as opted out in Sugar to indicate that the owner
has not consented to receive marketing campaigns. To mark an email address as
opted opt, simply click the button with a slashed circle to the right of the email
address when editing the record (e.g. contact).

Administrators can configure whether new email addresses added to Sugar
records default to opted-in or opted-out by using the "Opt-out new email addresses
by default" option via Admin > System Email Settings. For more information
regarding this option, refer to the Email documentation in the Administration
guide.

When a recipient clicks the opt-out link in an email-type campaign, Sugar will
automatically mark the recipient's email address as "Opted Out" in the
corresponding record (e.g. contacts). For more information regarding opt-outs and
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campaigns, please refer to the Campaigns documentation as well as the 
Understanding Campaign Opt Outs article.

Opted-out email addresses are indicated by a blue circle with a line through it.
Opted-out email addresses also display a Link button in record view. Clicking this
button will copy a link to your computer's clipboard which you can send to the
email address owner in order to request that they confirm their desire to receive
marketing emails from your organization. When the copied link is visited in a web
browser, Sugar will automatically set the email address to opted-in.

Please keep in mind that although email addresses marked as opted out cannot
receive campaign emails, users can continue to send them transactional emails in
Sugar. The recipient pill will display an opt-out status to indicate that it is an opted-
out email address.

Unlinking Emails

When an email is explicitly related to a record, users have the option of unliking
the email record via the Emails subpanel. Please note that the unlink option is not
available for email records that are implicitly related via a matching email address
or automated email importing. As a result, the unlink option is not available when
viewing the Emails subpanel in the following modules: Accounts, Contacts, Leads,
Targets, Cases, Opportunities, and Revenue Line Items. For more information on
the different ways emails can be related to records in Sugar, please refer to the 
Relating Emails to Records section. 

To delete the relationship between the record and the related email, simply
navigate to the module record (e.g. Quotes) containing the related email and
choose "Unlink" from the Actions menu on the far right of the desired record's row
in the Emails subpanel. Please keep in mind that performing this action removes
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the relationship but does not delete the email record itself.

Email Templates

Email templates are used in Sugar to send simple form letters, automated email
responses, or just commonly used emails to save time and prevent typos. They are
also useful for ensuring a consistent style and voice for communications
transmitted throughout your organization. Email templates can contain text, HTML
content, images, and attachments. The content of templates may contain variables
for field values like the recipient's name so that you can personalize the email for
the recipient.

For information on using an existing template in an email message, please please
refer to the Using a Template section of this page.

Note: Sugar's core product includes several places where email templates can be
created for different purposes. For more information on alternative types of email
templates in Sugar, please refer to the Understanding Email Templates for
Campaigns, Workflows, and SugarBPM article.

Viewing Email Templates

To view the list of available templates, navigate to the Emails module and select
"View Email Templates" from the Emails module tab menu. Please note that you
will only be able to see email templates as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation in the
Administration guide.

Note: If you are logged in as an administrator, you can view and edit the "Forgot
Password email" and "System-generated password email" system templates via the
Email Templates list view.

Creating Email Templates
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To create a new email template in Sugar, click the triangle on the Emails module
tab and select "Create Email Template" from the module tab menu.

Refer to the Email Template Fields and Inserting Template Variables sections to
complete the email template. For instructions on using templates in email
messages, please refer to the Using a Template section of this page.

Email Template Fields

The Email Templates module contains the following fields:

Field Description
Assigned To The Sugar user assigned to the process

email template
Body The content of the message including

any text, HTML content, images, or
variables

Note: Use the TinyMCE functions to
add formatting to the content. For more
information on using TinyMCE, please
refer to the User Interface
documentation. To insert content
variables, please refer to the Inserting
Template Variables section of this page.
If images or advanced CSS are required
in your email template, it is highly
recommended to host the images or CSS
file on a publicly available hosting
service and link to it in the email
template. For more information, please
refer to the Using CSS in Email
Templates article.
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Date Created The date the email template record was
created

Date Modified The date the email template record or
its content was last modified

Description A description or other information about
the email template

Name A unique and descriptive name to help
users find the template

Subject The subject that recipients will see in
their email inbox

Teams The Sugar team(s) that should have
access to the email template

Type The type of email template

Note: The Type field defaults to "Email"
when creating email templates via the
Emails module. For more information on
how to create an email template for
campaigns, please refer to the 
Campaigns documentation.

Inserting Template Variables

When constructing the subject and body of an email template, Sugar allows you to
insert variables that correspond with Sugar fields on related records. The variables
will be replaced with the related record's field values when the email is sent from
Sugar. For example, you can insert a variable for the recipient's first name on a
template that you plan to send to leads or contacts.

Use the following steps to insert a variable for the recipient's first name into an
email template:

1. Click to place your cursor on the location in the subject or body where the
recipient's first name should appear.

2. In the Insert Variable row, select the module you would like to insert a
variable from.
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3. Set the second dropdown to the desired field from the modules selected in
the first dropdown. For our example, select "First Name".

4. Click "Insert" to insert the generated variable name to your subject or body
at your cursor's location.

If there are no images, links, or formatting in your email, then sending it as text
only may be a good option. Click the Send Text Only checkbox to remove the
HTML formatting options. Alternatively, you can click "Edit Plain Text" at the
bottom of the page to have the plain text option send differently than the HTML
text.

Editing Email Templates

To edit a template, navigate to the Emails module and select "View Email
Templates" from the Emails module tab menu. Click on the name of the template
you want to edit and adjust the content, fields, and variables as needed. Please
note that you will only be able to see and edit email templates as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration guide.

Email Signatures

An email signature is a snippet of text positioned below the body of an email
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message that typically contains the contact information of the sender. Sugar allows
users to create multiple signature variations that they can insert during email
composition. Optionally, users can mark one email signature as their default
signature. Sugar will automatically insert the default signature when a user
composes a new email, but the user has the option to delete it or replace it with a
non-default signature.

For steps to insert signatures in email messages, please refer to the Using an
Email Signature section of this page.

Note: You must have role access to the Emails module to view and create email
signatures. For more information on roles, please refer to the Role Management
documentation in the Administration Guide.

Viewing Email Signatures

To view your saved signatures, navigate to the Emails module and select "View
Email Signatures" from the Emails module tab menu. Please note that you will only
be able to see email signatures that you have created.

Creating Email Signatures

To create a new email signature, click the triangle on the Emails module tab and
select "Create Email Signature" from the module tab menu.

Give your new signature a descriptive name (e.g. "Sugarcon Promo Signature")
and compose your signature in the Signature composition area just as you want it
formatted for outgoing messages. Optionally, enable the "Default" checkbox to
make this your automatic signature on all new emails. Each user can have one
default signature. Marking a signature as your default will uncheck the Default
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field on any signature you may have previously designated.

When you are satisfied with the signature you have created, click "Save" to add the
signature to the Signatures dropdown on email compose views for your user. Other
users cannot access the signatures that you have created.

For more information about the fields available on the email signature record,
please refer to the Email Signature Fields section. For instructions on using
signatures in email messages, please refer to the Using a Signature section of this
page.

Email Signature Fields

The Email Signatures module contains the following fields:

Field Description
Name A unique and descriptive name to help

users find the template
Default Designates the user's default email

signature

Note: Each user can have one default
signature. Marking a signature as your
default will uncheck the Default field on
any signature you may have previously
designated.

Signature The content of the email signature
including any text, HTML content, and
images
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Note: Use the TinyMCE functions to
add formatting to the signature. For
more information on using TinyMCE,
please refer to the User Interface
documentation. If images or advanced
CSS are required in your email
signature, it is highly recommended to
host the images or CSS file on a publicly
available hosting service and link to it in
the email signature. For more
information, please refer to the Using
CSS in Email Templates article.

Date Created The date the email template record was
created

Date Modified The date the email template record or
its content was last modified

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports

Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Editing Email Signatures

To edit a signature, navigate to the Emails module and select "View Email
Signatures" from the Emails module tab menu. Click on the name of the signature
you want to edit and adjust the content as needed. Please note that you can only
view and edit the email signatures that you have created. Click "Save" to preserve
your changes to the signature. 

The edited signature will be available the next time you insert the signature into a
new message. Any drafts that were saved with the signature before it was edited
will retain the old signature. You can re-select the same signature from the draft's
Signatures menu, which will replace the old version with the new one. 

Sugar Email Archiving Service

Sometimes referred to as SNIP, the Sugar Email Archiving service allows users to
easily archive email to Sugar records simply by sending the email to a special
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email address. The email archiving service monitors the email address, imports the
email into your Sugar instance, and links related records without the use of a plug-
in or other syncing process. 

Note: Before you can use Sugar Email Archiving, an administrator must enable the
service for your instance. For activation instructions, please refer to the Email
documentation in the Administration Guide.

Features and Limitations

Anyone can send emails to the Sugar Email Archiving address, so the capability is
not limited to users. Sugar Email Archiving will not import messages that are
larger than 10 MB including attachments.

When an email record is archived via the Sugar Email Archiving service, the
email's team will default to "Global". Users with the appropriate permissions may
update the Teams field after the email has been archived in Sugar.

If the sender's email client is configured to use non-English From, To, and Cc
fields, forwarding emails to Email Archiving may not work. Instead, send the email
to Email Archiving directly using the Cc and Bcc fields or forward the email as an
attachment. For a large volume of non-English emails that need to be archived
using Email Archiving, set a rule in your email application to copy the emails to the
Sugar Email Archiving address. 

Relating Archived Emails to Sugar Records

Sugar will scan incoming emails that are sent to the Email Archiving Service for
the following relatable items:

From, To, and Cc fields : The Sugar Email Archiving service scans the
From, To, and Cc fields of the message and relates the email to any records
it finds with a matching email address in Sugar. The archived email will
appear in the Emails subpanel and History dashlet for any matching
records in Sugar. Please note that Email Archiving cannot relate records
based on email addresses in the Bcc field due to the field's hidden nature.
Message body : The Sugar Email Archiving service scans the content in
the body of the message and relates the email to any records it finds with a
matching email address in Sugar. For an email address to be recognized in
the body of an email, it must be preceded by "To:" and surrounded by
opening and closing carets, for example, "To: <john@example.com>" or
"To: John Smith <john@example.com>". The archived email will appear in
the Emails subpanel and History dashlet for any matching records in Sugar.
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Case Macro : If an archived email's subject line contains a specially-
formatted key known as the Case Macro, the message will automatically be
associated with the corresponding case in Sugar's Cases module. For more
information on using the case macro, please refer to the Automatically
Associating Emails With Cases article.
Calendar invites (.ics) : If the email contains a calendar event, Sugar will
archive the email as well as create a Meeting record. Any users, contacts,
or leads that share an email address with the meeting's attendees will be
added as meeting invitees in Sugar.

The Sugar Email Archiving Service will relate emails to records in the following
modules:

Accounts, Contacts, Leads : relates emails with a matching email address
Cases : relates emails containing a matching case number via Case Macro
Meetings : creates meetings from emails with calendar invites; relates
matching invitees
Opportunities : relates emails from related contacts if the admin has
enabled Related Contacts Emails for opportunities

Note: Any relationships between archived emails and custom modules must be
made manually.

Sugar Email Archiving creates an implicit relationship between the email and
matching records via the email addresses on the email. This implicit relationship
behaves differently than an explicit relationship. For example, an email implicitly
related (i.e. via Sugar Email Archiving by matching email address) to Beth Roberts'
contact record would appear in her Emails subpanel just like one that is explicitly
related (i.e. manually created relationship via subpanels). However, if Beth's email
address is updated in Sugar, the emails created via Sugar Email Archiving will no
longer appear in her subpanel since the email addresses no longer match. You can
explicitly relate a contact to an email by navigating to the email's record view and
selecting Beth Roberts in the email's Contacts subpanel.

Email Assignment

Like other records in Sugar, an email can only be assigned to one user. The Sugar
Email Archiving service assigns emails to a user based on a match between the
email address stored in the user's profile settings and an email address listed in
the From, To, or CC fields. Sugar looks for users' email addresses in the From field
first, then the To field, and then the CC field, and assigns the email record to the
first user it finds with a matching email address. For example, if three Sugar users
appear on an email, two in the To field and one in the CC field, the first user listed
in the To field will be assigned the email record in Sugar.
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Outgoing Email Accounts

Sugar users have the ability to create outgoing email accounts or edit configured
email accounts by navigating to the Emails module and selecting "Email Settings"
in the Emails module tab menu. The Outgoing Email Accounts list view will display
all the outgoing email accounts which the user has access to in Sugar. Outgoing
email accounts can include the default user email account, personal email
accounts, as well as shared email accounts. When the user first logs in to Sugar,
the primary email address on their profile is created as a placeholder outbound
account. Please note that you will need to configure this email account before
using it to send emails. If the admin has enabled the "Allow users to use this
account for outgoing email" option in Admin > System Email Settings, you will not
be able to configure the default email account and must instead utilize the system
email account which will appear in the Outgoing Email Accounts list view with an
asterisk to indicate that it is a system account. Each of the outgoing email account
types is described in the list below.

Note: The Outgoing Email Accounts list view does not support filtering, preview,
or mass actions.

There are three types of outgoing email accounts in Sugar: 

User Email Accounts : User email accounts can be created by all users
and can consist of the user's personal email accounts (e.g.
jane@example.com) as well as any shared email accounts
(e.g.support@example.com, sales@example.com). Please note that user
email accounts can only be edited by the record owner. In addition, the
"Allow users to configure email accounts" option must be enabled in Admin
> System Email Settings in order for users to create new outgoing email
accounts. Reach out to your Sugar administrator if you do not see the
Create button in the Outgoing Email Accounts list view.
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Personal Email Accounts : Sugar users can configure one or more
personal email accounts (e.g. jane@example.com,
jane.smith@mycompany.com) to send email messages through
Sugar. Personal email accounts will only be available for the current
user since it is assigned to their private team.
Shared Email Accounts : Shared email accounts can be created
by any user and allows groups of users to send outbound email
messages using the same email account (e.g.
support@example.com). In order to share outgoing email accounts,
the user must assign the email account to the specific team(s) who
can use this account to send emails. Once created, the shared email
account will appear in the Outgoing Email Accounts list view for all
users belonging to at least one of the assigned teams.

Default User Email Account : A default email account is automatically
created by Sugar for each user and uses the primary email address stored
in the user's profile. To use this account, users need to make sure that the
Username and Password fields are configured properly.
Note: The users' default email accounts may be affected by the "Allow
users to use this account for outgoing email" option in Admin > System
Email Settings. If the administrator has enabled the option, users will not
be able to configure their default email account and must instead utilize the
system email account or create a new user email account. The system email
account will display in the Outgoing Email Accounts list view with an
asterisk to indicate that it is a system account.
System Email Account : The system's outbound email setting is
configured by the administrator via Admin > System Email Settings. By
default, administrators will see the system email account in the Outgoing
Email Accounts list view. Though uncommon, the administrator may choose
to allow users to send email using the system email account by enabling the
"Allow users to use this account for outgoing email" option in Admin >
System Email Settings. Once enabled, users will not be able to configure
their default email account and must instead utilize the system email
account or create a new user email account. In addition, users will see the
system email account in the Outgoing Email Accounts list view with an
asterisk to indicate that it is a system account.

Once the necessary outgoing email accounts have been configured, users will be
able to send email messages through Sugar using one of the available accounts
(e.g. jane@example.com, support@example.com). Please note that in order to send
messages through the Sugar application, you must select "Sugar Email Client"
from the Email Settings section of your user profile. For more information, please
refer to the Getting Started documentation.

Note: Email messages sent from Sugar will be automatically archived and linked
to existing records throughout the application.
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Creating Outgoing Email Accounts

This page applies to email accounts for individual users. For help setting up the
System Email Settings, please refer to the Email documentation in the
Administration Guide.

Sugar users have the ability to configure personal and shared email accounts by
clicking the Create button in the Outgoing Email Accounts list view. You can also
click the Copy option to duplicate an existing outgoing email account record if you
are creating a another email account with similar settings.

Use the following steps to add a new outgoing user email account:

1. Navigate to the Emails module and select "Email Settings" from the module
tab.

2. Click "Create". If you do not see the Create button, talk to your
administrator about enabling the system email setting "Allow users to
configure email accounts".

3. Click on the appropriate Email Provider logo (e.g. Google, Exchange
Online) to expose provider-specific fields pre-populated with their most
common default settings. For accounts with any other email provider,
select "Other".

Note: For Google basic authentication accounts, you may be required to
enable less-secure app access within your Google account. For more
information, please refer to Google's help documentation.
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4. Complete the applicable fields specific to your email provider. All required
fields are marked as such and must be completed prior to saving. If you are
not familiar with these terms or their values, please check with your IT
department or email provider.

Name : The name of the outgoing email account that will be used to
identify it in list view and will appear as the "From" name on
messages sent from Sugar via this account. Defaults to the first and
last name in the user's profile.
Email Provider : Choose your mail provider to populate provider-
specific values.
Authorize : Click this button to authorize the Google/Exchange
Online mail account to be the outgoing email account. The Google
or Microsoft connector must be configured via Admin > Connectors
before you can authorize and set up the mail account.
Note: For Google mail, a "This app isn't verified" warning may
appear after selecting your Gmail account to authorize. You can
click the Advanced link then click the "Go to..." link at the bottom of
the window to proceed and grant permission for the connection to
occur. For more information on this warning, refer to the Unverified
apps article on the Google Cloud Platform Console Help page.
Status : The status will display "Authorized" once the mail account
is authorized.
Note: Only available for Google and Exchange Online tabs.
Authorized Email Address : The email address of the authorized
mail account.
Note: Only available for Google and Exchange Online tabs.
Server : The web address of the external email server from which
emails will be viewed in Sugar.
Port : The communication port number used for connecting to the
email server.
Use SMTP Authentication : Select this box to require server
authentication for the account. For "Google" and "Exchange
Online", this option is automatically enabled. Most email servers
require authentication for security purposes. By default,
authentication is required for Google, Exchange, and Outlook
providers. If left unchecked, the SMTP server will accept
anonymous connections, which is not recommended. The following
fields are displayed when "Use SMTP Authentication" is enabled for
Outlook, Google Less Secure Apps, Exchange, and Other providers:

Username : Enter the username for the external account.
The username is often the email address.
Password : The Password field group contains a grayed-out
field that cannot be edited and the following two required
fields:

New Password : Enter the account's existing
password.
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Confirm Password : Re-type the account's existing
password. This value must exactly match the "New
Password" value in order to properly authenticate.

Transport Encryption : Select the appropriate option from the
dropdown to use Secure Socket Layer (SSL), Transport Layer
Security (TLS), or no encryption (None) when connecting to the
email server.
From Email Address : The email address used to send messages
for this account. Defaults to the primary email address stored in the
user's profile.

If specifying a different address than the email address
associated with the account you are authenticating, the
email server being utilized may need to be configured to
allow the email account to send email as the entered From
Address.
For more information on configuring "Send As" permissions
with Gmail, refer to Gmail's Help documentation. 
For Exchange Online, enter only the authorized email
address, as it cannot send emails using a different email
address unless the organization's Exchange admin has
configured the account to allow this.

Reply-To Name : To have replies to your email sent to a name and
email address other than the From name and address, populate
both the Reply-To Name and Reply-To Email Address.
Reply-To Email Address : To have replies to your email sent to a
name and email address other than the From name and address,
populate both the Reply-To Name and Reply-To Email Address.
Teams : The Sugar team(s) assigned to the outgoing email account.
User email accounts are assigned to the user's private team by
default. Adding teams to an email account allows the users
belonging to the teams to also send from the account. The shared
email account will appear in the Outgoing Email Accounts list view
for all users belonging to at least one of the assigned teams.

5. Once the necessary information is entered, click "Save" to preserve the
changes. Sugar will automatically validate the settings and alert you if
there is an error.

Though uncommon, users may be able to use the system's outgoing email server if
the administrator allows it. For more information on configuring the system
outgoing email server settings and allowing users to use the system account,
please refer to the Email documentation in the Administration Guide.

Editing Outgoing Email Accounts
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To edit outgoing user email accounts that you created, navigate to the Emails
module and select "Email Settings" from the module tab menu. Then in the
Outgoing Email Accounts list view, click the pencil icon to the far right of the
record's row you wish to edit. Alternatively, you can also click on the email
account's name and then click the Edit button on its record view. Please note that
outgoing user email accounts can only be edited by the record owner.

Note: If the administrator has exposed the system email account to users, it will be
listed in the Outgoing Email Accounts list view with an asterisk and cannot be
edited by regular users.

Deleting Outgoing Email Accounts

To delete an outgoing user email account that you created, navigate to the Emails
module and select "Email Settings" from the module tab menu. Then in the
Outgoing Email Accounts list view, click the Record Actions menu to the far right
of the record's row and select "Delete". Alternatively, you can also click on the
account's name and then select "Delete" from the Actions menu on its record view.
Please note that outgoing user email accounts can only be deleted by the record
owner.

Note: If the administrator has exposed the system email account to users, it will be
listed in the Outgoing Email Accounts list view with an asterisk and cannot be
deleted. In addition, the default user email account that was created when the
user's record was created cannot be deleted.

Email's Direction Field
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The Direction field in the Emails module specifies the direction (e.g. Outbound,
Inbound, Internal, Unknown) of the email based on the sender (e.g. user,
customer) and the recipient(s) in the email message. Please note that this field is
not visible on record views or as a list view column, and is available only as an
available filter field in the Emails list view. Sugar automatically sets the direction
for archived emails and determines the direction using the following criteria:

Direction Sender Recipient Notes
Inbound The sender is not a

user/employee
Outbound The sender is a

user/employee
At least one
recipient is not a
user/employee

Internal The sender is a
user/employee

All recipients are a
user/employee

Unknown The sender is blank Draft emails have a
direction of
"Unknown".

To filter the emails by direction, simply create a filter using the Direction field then
choose the value (e.g. Inbound) you wish to filter the list view by. In the example
below, Sugar will return all inbound emails for Calm Sailing Inc. received in the
last 30 days.

Last Modified: 2021-11-23 19:17:51
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Tasks

Overview

Sugar's Tasks module is used to track to-do or action items which can be related to
various Sugar records to which the task is relevant. Tasks with due dates will
display a color coding on list views and dashlets to help alert users when a task is
overdue or will be due soon. You can view tasks in specialized dashlets on related
records as well as in your calendar to help you plan your workday and complete
important action items on time. As tasks are completed, they can be closed via
various convenient methods throughout Sugar. This documentation will cover
information and actions specific to the Tasks module. For instructions concerning
views and actions which are common across most Sugar modules, such as
creating, editing, and deleting calls, please refer to the Working With Tasks
section of this page.

Please note that you will only be able to see task records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Task Fields

The Tasks module contains a number of stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The below definitions are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs. Administrators or users with developer-level role access have the ability to
alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description
Assigned To The Sugar user assigned to the task
Comment Log A shared log of messages, comments, or

other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
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details.
Contact Name The contact record the task is related to

Note: The task will appear in either the
contact's Active Tasks dashlet or 
Inactive Tasks dashlet in the
intelligence pane.

Date Created The date the task record was created
Date Modified The date the task record was last

modified
Description A description or other information about

the task
Due Date The date and time the task is due to be

completed

Note: The task will appear on the
assigned user's Calendar per the date
and time of the task.

Priority The priority or importance of the task
(e.g. High, Medium, Low)

Related to The module and record that is related to
this task

Note: The task will appear in either the 
Active Tasks dashlet or Inactive Tasks
dashlet of the selected module record's
intelligence pane or the Activities
subpanel or History subpanel (BWC
modules only).

Start Date The date and time the task is started
Status The current status of the task (e.g. Not

Started, In Progress, Completed, etc.)

Note: Closing a task will automatically
set the status to "Completed".

Subject The subject or a brief summary of the
task

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports

Note: For more information on creating
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and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the task
record

Task Due Date Colors

When viewing the Tasks list view or Tasks dashlet, the due date will be highlighted
in one of two colors: blue or red. This allows users to quickly recognize scheduled
tasks that are either overdue or due within the next 24 hours.

Task due dates are highlighted in list view and dashlets as follows:

Blue : Tasks with any status other than "Completed" with a due date in the
next 24 hours.
Red : Tasks with any status other than "Completed" with a due date that
has passed.
No color : Tasks with a status of "Completed" or with a due date 24 hours
or more in the future.

Working With Tasks

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Tasks section describe Tasks-
specific behaviors and functionality.

Content Link Description
Creating Tasks
Basic Task Creation
Creating via Quick CreateCreating via

The Creating Records section covers the
various methods of creating new task
records, including via the Create button
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Subpanels
Creating via Duplication
Importing Tasks

in the Tasks module, the Quick Create
menu on the upper right of every Sugar
page, via the Tasks subpanel on related
modules, duplication of an existing task
record, and importing a list of tasks into
Sugar using a .csv spreadsheet.

Viewing Tasks
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity StreamsViewing via
Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing task
records, including via the Tasks list view
and record view, the Recently Viewed
menu in the Tasks module tab, list view
dashlets showing task information,
activity stream entries concerning task
updates or where a user mentions a
task, previewing tasks in the right-hand
side panel, and reports displaying task
data.

Note: There are also specialized
dashlets for tasks, which are explained
in detail in the Task Dashlets section of
this page.

Searching for Tasks
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating tasks:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Tasks module.

Tasks List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Tasks
Activity Stream
Dashboards

The List View section walks through the
many elements of the Tasks List View
layout which contains a filterable list of
all task records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Tasks list view's menus are available
in the List View Mass Actions Menu and 
List View Record Actions Menu sections
of this page.
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Tasks Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Record View section walks through
the many elements of the Tasks Record
View layout which contains detailed
information about a single task record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Tasks record view's
menu is available in the Record View
Actions Menu section of this page.

Editing Tasks
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
task records, including inline via the
tasks record view, in full edit mode on
the record view, inline via the Tasks
subpanel on related module records,
inline via the Tasks list view, and via the
Mass Update option on the list view.

Deleting Tasks
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted tasks, including via the Tasks
record view, an individual record's
Actions menu on the Tasks list view, and
the Mass Actions menu on the list view.

Exporting Tasks The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of tasks and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Merging Tasks
Merging via List View

The Merging Records section provides
instructions for merging duplicate tasks
which will combine field values and
related records into a single task.

Viewing Task Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record

                       690 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Favorite_Designation_2
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Following_Designation
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Next_or_Previous_Record
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Actions_Menu
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Show_More
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Related_Record_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Filtering_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Reordering_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Activity_Stream_2
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Dashboards_2
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_Inline_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_Inline_via_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Editing_Inline_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Mass_Editing_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_via_Record_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Deleting_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Mass_Deleting_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Exporting_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Recalculating_Calculated_Values
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Merging_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Merging_via_List_View
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#Viewing_Record_Audit_Logs


 

view option which displays a history of
changes to the task's audited fields.

Task PDFs
Downloading Task PDFs
Emailing Task PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
email .pdf files of task information as
configured by an administrator via
Admin > PDF Manager.

Favoriting Tasks
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking tasks as favorites, including via
the Tasks list view, Tasks record view,
or any Tasks subpanel appearing on the
record view of a related module.
Favoriting a task allows you to easily
access it from list views, dashlets, or the
Tasks module tab.

Following Tasks
Following via List View
Following via Record View

The Following Records section describes
the various methods of marking tasks as
"Following", including via the Tasks list
view and record view. Following a task
causes its activity stream updates to be
included on your Home page and Tasks
list view activity streams so that you can
easily keep up with changes and user
posts on the record.

Sharing Tasks The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the task record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the task's record
view.

Tasks Tile View

Tile View allows users to visualize and engage with their tasks in an intuitive drag-
and-drop interface. Users can drag a tile from one column to another to change its
status.
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To access Tile View, navigate to the Tasks list view and click on the Tile View icon
next to the search bar:

For more information on using the Tile View, refer to the User Interface
documentation. For information on configuring Tile View layouts, refer to the Tile
View Settings documentation in the Administration Guide.

Task Menus

The Tasks module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and its options with a link to more information about the menu
option either in the User Interface documentation or, for Tasks-specific
functionality, within this page.
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Module Tab Menus

The Tasks module tab is typically found by clicking the "More" icon represented by
three vertical dots to the right of the module tabs on the navigation bar. The
additional modules will appear on the list and you can click "Tasks" to access the
list view. Once the Tasks tab displays on the navigation bar, you can click the
triangle within the tab to display the Actions, Recently Viewed, and Favorites
menu. The Actions menu allows you to perform important actions within the
module. The Recently Viewed menu displays the list of tasks you last viewed in the
module. The Favorites menu displays the list of tasks you most recently marked as
favorites.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Tasks Opens the record view layout to create a

new task
View Tasks Opens the list view layout to search and

display tasks
Import Tasks Opens the import wizard to create or

update tasks using external data

If you do not see the Tasks module tab in Sugar, please check the following:

The Tasks module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Tasks module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
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hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Tasks module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Tasks
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Tasks list view displays all task records and allows for searching and filtering
to locate specific tasks. You can view the basic details of each record within the
field columns of the list view or click a task's name to open the record view. To
access a module's list view, simply click the module's tab in the navigation bar at
the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual task records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more tasks at a time
Merge Merge one or more duplicate tasks
Delete Delete one or more tasks at a time
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Export Export one or more tasks to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual task directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this task in the intelligence

pane
Edit Edit this task
Follow Follow this task
Close Close this task
Delete Delete this task

Record View Actions Menu

The Tasks record view displays a single task in full detail including its fields,
subpanels of related records, and activity stream. To access a task's record view,
simply click a hyperlinked task name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this task.
Share Share a link to this task via email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Tasks
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the Tasks
module via Admin > PDF
Manager.
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Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Close and Create New Close this task as "Completed" and
duplicate it to a new task.

Note: This option only appears as long
as the status does not equal
"Completed".

Close Close this task as "Completed".

Note: This option only appears as long
as the status does not equal
"Completed".

Copy Duplicate this task to create a new task.
View Audit Log View a record of changes to this task.
Delete Delete this task.

Task Dashlets

Dashlets showing task records can be added to your Home page, list view
intelligence panes, and record view intelligence panes. The List View dashlet is a
basic dashlet that allows you to select the Tasks module and create a filter so that
the dashlet displays tasks that meet your filter criteria. For more information on
list view dashlets, please refer to the Dashboards and Dashlets documentation.

Sugar also offers two dashlets with specific task-related functionality: the Active
Tasks dashlet and the Inactive Tasks dashlet, which are briefly explained in the
following sections.

Active Tasks Dashlet

The Active Tasks dashlet displays all tasks in a status of "Not Started", "In
Progress", and "Pending Input" with the tasks broken into three tabs based on
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their due dates and adjacent buttons for performing actions on the tasks. When
used on a related module's record view, the dashlet becomes contextual, and only
shows tasks that are relevant to the current record.

For complete information regarding the Active Tasks dashlet, please refer to the 
Dashboards and Dashlets documentation.

Inactive Tasks Dashlet

The Inactive Tasks dashlet displays all tasks in a status of "Completed" or
"Deferred" with the tasks broken into two tabs based on their statuses and
adjacent buttons for performing actions on the tasks. When used on a related
module's record view, the dashlet becomes contextual, and only shows tasks that
are relevant to the current record.

For complete information regarding the Inactive Tasks dashlet, please refer to the 
Dashboards and Dashlets documentation.

Closing Tasks

Once a task has been completed, users can edit the Status field to "Completed"
while on the record or list view. As a more convenient option, Sugar also allows
users to close tasks, which automatically sets the status to "Completed".
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Please note that the Close option will only appear if the task is not already in a
status of "Completed". The following sections explain several ways to close tasks in
Sugar.

Closing via List View

Use the following steps to close a task via the list view:

1. Navigate to the Tasks list view by clicking the Tasks module tab.
2. Use the Module Search to find the task records you wish to close.

3. Click the Record Actions menu to the far right of the record's row and
select "Close".

Closing via Record View

Use the following steps to close a task via the record view:

1. Navigate to a task's record view.
2. Select "Close" from the Actions menu.

Closing and Creating New via Record View
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Use the following steps to close and duplicate a task via the record view:

1. Navigate to a task's record view.
2. Select "Close and Create New" from the Actions menu.

3. The displayed record view is pre-populated with the original task's values.
By default, the new task's status is set to "Not Started". Update the
necessary fields then click "Save".

Closing via Subpanels

Use the following steps to close a task from the Tasks subpanel on the record view
of a related record:

1. Scroll to the Tasks subpanel on the record view of a related record.
2. Select "Close" from the Actions menu of the task record you wish to close.

Closing via Dashlet
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Tasks with statuses of "Not Started", "In Progress", or "Pending Input" appear in
the Active Tasks dashlet on the record views of related records. Closing a task will
cause it to move to the Inactive Tasks dashlet along with deferred tasks. 

Use the following steps to close a task via the Active Tasks dashlet:

1. Navigate to the Active Tasks dashlet on your Home page or a module
record view's (e.g. Accounts) intelligence pane.

2. Click the appropriate tab (Due Now, Upcoming, To Do) on the dashlet, then
locate the task record you wish to close.

3. Click the X button to the right of the task's row in the dashlet.

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

Once the task is closed, the task record will be moved to the Inactive Tasks dashlet
and the task's status will change to "Completed".

Calendar Module and Tasks

The Calendar module displays a user's calendar including their Sugar activity
records. You can view, schedule, and manage their calls, meetings, and tasks
directly within the calendar, allowing you to plan your time with full access to your
other scheduling commitments.

Viewing via Calendar

When tasks are created in Sugar, they appear in the assigned user's calendar
based on the set due date of the task. For example, if you create a task due on
December 22nd at 11:30 am and assign it to user John Smith, then the task will
appear in that user's calendar per the specified due date and time. You can view
the quick details of the task by clicking the "i" icon on the task record cell and
view/edit the actual task record by clicking the Eye or Pencil icon in the popup
window. For more information on viewing via calendar, please refer to the 
Calendar documentation.
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Please note that you will only be able to see task records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Creating via Calendar

There are two methods of creating tasks in the Calendar module. The first method
is to create a task via the Create Task option in the Calendar module tab. This will
open up the Tasks record view in edit mode to create a new task record. For more
information on creating tasks, please refer to the Creating Records section of the
User Interface documentation.

The second method is to create the task directly via the user's Sugar calendar
using the following steps:

1. Click the Calendar module tab.
2. On the calendar view, click the cell corresponding to the date and time you

wish to schedule the task. You can choose to view the calendar by Day,
Week, Month, Year, or Shared. For more information on viewing the shared
calendar, please refer to the Calendar documentation.
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3. When a cell is selected, a popup will appear at the top of the drawer. Select
"Create a task".

4. Refer to step 2 and beyond in the Basic Record Creation section of the User
Interface documentation for additional instructions about creating task
records.

Editing via Calendar

Once tasks are created in Sugar, they appear in the assigned user's calendar based
on the specified due date and time. You can click the "i" icon on the task record
cell to view additional information regarding the task.

The Additional Details popup window displays the Pencil icon on the upper right,
which opens up the Tasks record view for users to make any changes as necessary.
Click "Save" to preserve the changes made to the task record.
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Last Modified: 2020-03-26 22:22:46

Notes

Overview

Sugar's Notes module consists of individual notes which contain text or an
attached field pertinent to the related record. The Related To flex-relate field is
typically set to the module and record to which the note's contents are relevant. A
contact record can also be related using the Contact field which will cause the note
to be displayed when viewing the contact record. Notes are also used to
communicate with customers about bugs and cases via the Sugar Portal. For more
information, please refer to the Bugs and Cases documentation. This
documentation will cover information and actions specific to the Notes module. For
instructions concerning views and actions which are common across most Sugar
modules, such as creating, editing, and deleting notes, please refer to the Working
With Sugar Modules section of this page.

Please note that you will only be able to see note records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note Fields

The Notes module contains a number of stock fields which come out-of-the-box
with Sugar. For information on using and and editing various field types, refer to
the User Interface documentation. The definitions below are suggested meanings
for the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
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the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Assigned To The Sugar user assigned to the note
Attachment An optional file to attach to the note

Note: The Sugar administrator can
specify the maximum file size allowed to
be uploaded.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Contact The contact record the note is related
to.
Note: If populated, this note will show
in the contact's History subpanel

Display in Portal? Notes attached to cases, bugs, and/or
knowledge base articles will display in
the portal by default
Note: Administrators can have this field
disabled by default via Admin > Studio.

Note The details and content of the note
Note Source A system-level dropdown field that

represents the origin of newly created
notes. It is set to External on notes
created via Portal and set to Internal on
notes created in Sugar. This field is not
available in Studio or the user interface
and is only available in SugarBPM.

Related to The module and record that is related to
this note
Note: This will decide which module
this note will show in the History
subpanel

Subject The subject or designation of the note
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Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the note
record

Working With Sugar Modules

While the Notes module has some features that only apply to notes, it also uses the
Sidecar user interface that most Sugar modules are based on. In the table below,
the left column contains links to the User Interface page covering topics that are
applicable to all Sidecar modules. The right column has links to sections of the
current page that cover topics specific to notes.

General Instructions for Working
With Sugar Modules

Notes-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Notes-specific help exists for each
topic, use the links below to navigate to
sections of the current page.

Creating Records
Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Exporting Records
Recalculating Calculated Values
Merging Records
Record PDFs
Favoriting Records
Following Records
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Sharing Records

Note Menus

The Notes module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and its options with links to more information about each
option in the User Interface documentation.

Module Tab Menus

The Notes module tab is typically located under the More tab on the navigation bar
at the top of any Sugar screen to the right of the home cube icon. Depending on
your settings, you may have to click "Show More" in order to see the Notes module
tab. Click the tab to access the Notes list view. You may also click the triangle in
the Notes tab to display the Actions, Recently Viewed, and Favorites menu. The
Actions menu allows you to perform important actions within the module. The 
Recently Viewed menu displays the list of notes you most recently viewed. The 
Favorites menu displays the list of notes you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Note or Attachment Opens the record view layout to create a

new note
View Notes Opens the list view layout to search and

display notes
Import Notes Opens the import wizard to create or

update notes using external data

If you do not see the Notes module tab in Sugar, please check the following:
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The Notes module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Notes module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Notes module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Notes
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Notes list view displays all note records and allows for searching and filtering
to locate specific notes. You can view the basic details of each record within the
field columns of the list view or click a note's subject to open the record view. To
access a module's list view, simply click the module's tab in the navigation bar at
the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual note records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more notes at a

time
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Merge Merge two or more duplicate notes
Delete Delete one or more notes at a time
Export Export one or more notes to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual note directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this note in the intelligence

pane
Edit Edit this note
Delete Delete this note

Record View Actions Menu

The Notes record view displays a single note in full detail including its fields,
subpanels of related records (if applicable), and activity stream. To access a note's
record view, simply click a hyperlinked note name from anywhere within Sugar.
The record view's Actions menu appears on the top right of the page and allows
you to perform various operations on the current record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this note
Share Share a link to this note via email
Download PDF Download note information as a PDF file
Email PDF Email note information as a PDF

attachment
Copy Duplicate this note
Delete Delete this note

Last Modified: 2020-04-01 18:57:56

Targets

Overview

Sugar's Targets module consists of individual people who are unqualified prospects
that you have some information on but who are not yet qualified leads. Information
(e.g. name, email address) regarding these targets are normally acquired from
business cards you receive while attending various trades shows, conferences, etc.
Targets in Sugar are stand-alone records as they are not related to contacts, leads,
accounts, or opportunities. Once the target is qualified according to your
organization's practices, it can be converted into a lead record.
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This documentation will cover information and actions specific to the Targets
module. For instructions concerning views and actions which are common across
most Sugar modules, such as creating, editing, and deleting targets, please refer
to the Working With Targets section of this page.

Please note that you will only be able to see target records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide. 

Note: The Targets module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
User Management documentation. 

Target Fields

The Targets module contains a number of stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Account Name The account to which the target belongs
Alternate Address The target's alternate address (e.g.

billing or shipping)
Assigned To The Sugar user assigned to the target
Assistant The name of the target's assistant within

his or her company
Assistant Phone The assistant's phone number
Birthdate The target's date of birth
Comment Log A shared log of messages, comments, or

other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
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Interface documentation for more
details.

D&B Principal ID Unique ID number associated to the
individual in D&B

Date Created The date the target record was created
Date Modified The date the target record was last

modified
Department The target's department within their

company
Description A description or other information about

the target
Do Not Call Indication that the target should not be

called
Email Address The target's email address
Email Opt Out Indication that the target has opted out

of receiving emails
Facebook Account The target's Facebook account

information
Fax The target's fax number
First Name The target's first name
Google Plus ID The target's Google Plus ID
Home The target's residence number
Last Name The target's last name
Mobile The target's mobile number
Name When viewing, the target's full name
Office Phone The target's office number
Other Phone The target's alternate phone number
Primary Address The target's primary address
Salutation Standard greeting for the target (e.g.

Mr., Ms., Mrs., etc.)
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports

Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
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target record
Title The target's business title
Twitter Account The target's Twitter account information

Working With Targets

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Targets section describe Target-
specific behaviors and functionality. 

Content Link Description
Creating Targets
Basic Target Creation
Creating via Quick Create
Creating via Subpanels
Creating via Duplication
Importing Targets

The Creating Records section covers the
various methods of creating new target
records, including via the Create button
in the Targets module, the Quick Create
menu on the upper right of every Sugar
page, via the Targets subpanel on
related module records, via duplication
of an existing target record, and
importing a list of targets into Sugar
using a .csv spreadsheet.

Viewing Targets
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing target
records, including via the Targets list
view and record view, the Recently
Viewed menu in the Targets module tab,
previewing targets in the right hand
side panel, and reports displaying target
data.

Searching for Targets
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating targets:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Targets module.

Targets List View
Total Record Count
Create Button
List View Search

The List View section walks through the
many elements of the Targets List View
layout which contains a filterable list of
all target records in Sugar. While the
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Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Targets
Dashboards

generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Targets list view are described in
the List View Mass Actions Menu and 
List View Record Actions Menu sections
of this page.

Targets Record View
Favorite Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Dashboards

The Record View section walks through
the many elements of the Targets
Record View layout which contain
detailed information about a single
target record. While the generic menu
options are described in the User
Interface sections linked to the left, the
options specifically available in the
Targets record view are described in the
Record View Actions Menu section of
this page.

Editing Targets
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
target records, including inline via the
Targets record view, in full edit mode on
the record view, inline via the Targets
subpanel on related module records,
inline via the Targets list view, and via
the Mass Update option on the list view.

Deleting Targets
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted targets, including via the
Targets record view, an individual
record's Actions menu on the Targets
list view, and the Mass Actions menu on
the list view.

Emailing Targets
Emailing via Email Address Fields
Emailing via List View
Emailing via Quick Create
Emailing via Emails Module
Emailing via Workflows

The Emailing Records section describes
the various methods of emailing target
records as recipients, including clicking
any email address within Sugar, via the
Mass Actions menu on the Targets list
view, via the Quick Create menu, via the
Emails module using the Related To
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field, and via workflows which can
automatically send emails according to
conditions configured by administrator
users.

Exporting Targets The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of targets and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Targets The Finding Duplicate Records section
provides instructions for locating
duplicate target records. If searching on
matching fields (e.g. Last Name)
identifies one or more duplicates, they
can be merged into a single record.

Merging Targets
Merging via List View

The Merging Records section provides
instructions for merging duplicate
targets which will combine field values
and related records into a single target.

Viewing Target Historical Summaries The Viewing Record Historical
Summaries section describes the
Historical Summary record view option
which displays quick details of the
target record's related calls, meetings,
emails, notes, and tasks.

Viewing Target Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the target's audited fields.

Target PDFs
Downloading Target PDFs
Emailing Target PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
email .pdf files of target information as
configured by an administrator via
Admin > PDF Manager.

Favoriting Targets The Favoriting Records section
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Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

describes the various methods of
marking targets as favorites, including
via the Targets list view, Targets record
view, or any Targets subpanel appearing
on the record view of a related module.
Favoriting a target allows you to easily
access it from list views, dashlets, or the
Targets module tab.

Sharing Targets The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the target record. If the recipient
is logged into Sugar, clicking the link
will bring them directly to the target's
record view.

Target Menus

The Targets module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and its options with a link to more information about the menu
option either in the User Interface documentation or, for Targets-specific
functionality, within this page.

Module Tab Menus

The Targets module tab is typically located under the More tab of the navigation
bar at the top of any Sugar screen. Sugar normally displays the top six modules
shown in the Display Modules list of your user preferences, so the remaining
displayed modules are grouped under the More tab. For more information on
displayed modules for the navigation bar, please refer to the User Preferences
section of the Getting Started documentation. Click the tab to access the Targets
list view. You may also click the triangle in the Targets tab to display the Actions,
Recently Viewed, and Favorites menu. The Actions menu allows you to perform
important operations within the module. The Recently Viewed menu displays the
list of targets you most recently viewed. The Favorites Menu displays the list of
targets you most recently marked as favorites.
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The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Target Opens the record view layout to create a

new target
Create Target From vCard Opens the record view layout and

populates fields from a vCard
View Targets Opens the list view layout to search and

display targets
Import Targets Opens the import wizard to create or

update targets using external data

If you do not see the Targets module tab in Sugar, please check the following:

The Targets module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Targets module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Targets module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Targets
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus
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The Targets list view displays all target records and allows for searching and
filtering to locate specific targets. You can view the basic details of each record
within the field columns of the list view or click a target's name to open the record
view. To access a module's list view, simply click the module's tab in the navigation
bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual target records or click the
checkbox in the list header to select all records displayed in the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Email Email one or more targets at a time
Mass Update Mass update one or more targets at a

time
Merge Merge two or more duplicate targets
Add to Target List Add one or more targets to a target list
Delete Delete one or more targets at a time
Export Export one or more targets to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio
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List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual target directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this target in the intelligence

pane
Edit Edit this target
Delete Delete this target

Record View Actions Menu

The Targets record view displays a single target's fields and subpanels of related
records. To access a target's record view, simply click a hyperlinked target name
from anywhere within Sugar. The record view's Actions menu appears on the top
right of the page and allows you to perform various operations on the current
record.
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The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this target record.
Share Share a link to this target record via

email.
Download PDF Download the target information as a

PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Targets
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the target information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the Targets
module via Admin > PDF
Manager.
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Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Convert Target Convert this target to a lead.
Manage Subscriptions Manage this target's newsletter

campaign subscriptions.
Download vCard Download a vCard from Sugar and

transfer this target's information to
another application (e.g. Outlook).

Find Duplicates Locate potential duplicates of this target
record.

Copy Duplicate this target's information to
create a new target record.

Historical Summary View a historical summary of activities
(e.g. calls, meetings, etc.) related to this
target.

View Audit Log View a record of changes to this target
View Personal Info Display this record's fields which an

admin has designated as personal
information

Delete Delete this target record.

Converting Targets to Leads

Sugar enables you to convert targets to leads as you determine they qualify for
your organization's definition of a lead (e.g. after an evaluation/qualification
process) and becomes a valid sales prospect. Please note that targets are only
converted into leads in Sugar, and the new lead record will have a relationship to
the original target record. Once the lead is qualified as a sales opportunity, they
can be converted into contacts, opportunities, and accounts. For more information
on lead conversions, please refer to the Leads documentation.

Use the following steps to convert a qualified target to a lead:
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1. Navigate to a target's record view.
2. Select "Convert Target" from the Actions menu.

3. Enter appropriate values for the fields in the Leads record view layout then
click "Save".

Since targets only convert to a lead, the Leads record view displays
all lead fields which are grouped by default into the Overview, More
Information, and Other panels. Administrators have the ability to
determine what fields are displayed on the Leads record view via
Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation in the Administration
Guide.

4. Once the conversion is complete, the target record will display the
converted lead name at the top of the record view page. You can click the
record's name to view the detail of the converted lead.

Emails and Targets

Targets include an email address that can be used to email the target as a
recipient. The methods for doing so are covered in the Emailing Records section of
the User Interface documentation. Targets may also be recipients of campaigns
that allow you to send email messages to a large group of recipients as well as to
track the results of that message. Please refer to the Campaigns and Targets
section of this page for more information. In addition to being a recipient or sender
of an email, targets may be related to emails by being selected in the email's
Related To field. These relationships allow the target to display all relevant email
correspondence in the Emails subpanel and History dashlet on a target's record
view.
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Emails Subpanel

The Emails subpanel under the Targets record displays emails that are related to
the target record in a variety of ways:

Explicitly related to the target : If the target is selected in the email's
Related To field, the email and target are explicitly related, and the email
will appear in the target's Emails subpanel and History dashlet.
Instructions for using this flex relate field are available in the Emails
documentation.
Implicitly related to the target : If one of the target's email addresses
appears in the email's From, To, or Cc fields, the email and target are
implicitly related, and the email will appear in the target's Emails subpanel
and History dashlet. This implicit relationship is made for emails sent from
Sugar as well as any email imported into Sugar via Inbound email targets
or email archiving.

For more information on working with records in subpanels, refer to the User
Interface documentation.

Campaigns and Targets

Sugar's Campaigns module can be used to send mass emails or a series of
newsletter emails to Sugar accounts, contacts, leads, and targets. The results of
each campaign are recorded to measure its impact. Targets are not related directly
to campaigns. Rather, each campaign is related to several target list records, and
each target list is related to targets and other recipients. To send a campaign
email to a target, the target should belong to a default-type target list related to
the campaign. To prevent a target from receiving emails from a campaign, the
target should belong to the campaign's suppression list-type target list. Once a
campaign is sent, the results specific to a particular target will appear in the
Campaign Log Subpanel on the target's record view as described in the Campaign
Log Subpanel section of this page.

Targets can be added to target lists via the target list record itself, from the
Targets list view using the Add To Target List option, or from the Targets record
view using the Manage Subscriptions option. Instructions for using the Add To
Target List and Manage Subscriptions options in the Targets module are provided
in the sections below. For instructions on other available methods of adding to
target lists, please refer to the Target Lists documentation.

Adding to a Target List via Targets List View
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A target list consists of a group of individuals or organizations you wish to be
included or excluded from a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. There are various ways to add targets
to a target list in Sugar including using the Add To Target List option from the
Target list view's Mass Actions Menu. For more information on target lists and
other methods of adding target, please refer to the Target Lists documentation.

You can use the Select All feature in the list view when adding to a target list,
which will allow you to easily select the first 1000 records in the result set. If you
wish to add more than 1000 records or add a specific group of records to the
target list, please use the filter option in list view search to perform the additions
in smaller batches. 

Use the following steps to add targets to a target list via the Targets list view:

1. Navigate to the Targets list view by clicking the Targets module tab.
2. Use the List View Search to find the Target records you wish to add to a

target list.
3. Select the desired target records then choose "Add to Target List" from the

Mass Actions menu.

4. Below the search bar, locate and select the desired target list in the
dropdown list or click "Create new target list" to add the targets to a new
target list. Click "Update" to add the record(s) to the target list.
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In order to view the targets that have been added, you can navigate to the Target
Lists module. Click the target list's name to open the record view, and you will see
the target records within the Targets subpanel.

For more information on working with records in subpanels, refer to the User
Interface documentation.

Managing Target Subscriptions

Targets who receive newsletter-type campaign emails from your Sugar instance
are considered subscribers to that newsletter. Users can manage these newsletter
subscriptions from a target's record view using the Manage Subscriptions option in
the Actions menu. Please note that you can only manage subscriptions for
newsletter-type campaigns. A newsletter campaign you have created will have one
or more default-type target lists. Targets are added to these target lists in order to
receive your newsletter. The Manage Subscriptions option allows you to add a
target to the default-type or suppression-type target lists of your newsletter
campaigns without leaving the Targets module. For more information on
newsletter subscriptions, please refer to the Campaigns documentation.

Use the following steps to manage target subscriptions via a target's record view:

1. Navigate to a target record's record view.
2. Select "Manage Subscriptions" from the Actions menu.
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3. To add the target to a newsletter subscription mailing list, select the
newsletter from the Available/Newsletters Unsubscribed To list and drag it
to the Newsletters Subscribed To list. This will add the target to the
campaign's default target list.

4. To remove the target from the newsletter subscription mailing list, select
the newsletter from the Newsletters Subscribed To list and drag it to the
Available/Newsletters Unsubscribed To list. This will add them to the
suppression-type unsubscription target list for the newsletter campaign
which will prevent the target from receiving the newsletter. Please note
that the target will not be removed from the campaign's default target list.

5. Click "Save" to preserve your changes.

Campaign Log Subpanel

The Campaign Log subpanel contains historical information regarding a target's
interaction with all Sugar campaigns. When a mass marketing campaign is sent to
a target (or manually marked as sent in the case of non-email campaigns), the
related campaign activity information will appear within the Campaign Log
subpanel on the target's record view. This information mirrors the "View Status"
page available from within each individual campaign and shows activities such as
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when a campaign was sent, when the recipient viewed the campaign message,
when the recipient clicked a tracked link within the campaign, etc. Since this
subpanel contains historical campaign interactions for the target, it cannot be used
to associate a target with a campaign or otherwise manage a campaign or target
list. For more information on associating a target with a campaign, please refer to
the Adding to a Target List via Targets List View section of this page. For more
information on campaigns, please refer to the Campaigns documentation.

For more information on working with records in subpanels, refer to the User
Interface documentation.

vCards and Targets

vCards are electronic business cards that are exchanged between applications
such as email and web browsers. Targets may be created from vCards generated
by another application or saved as vCards for use in other software.

Creating Targets via vCard

Use the following steps to create a target in Sugar via vCard:

1. Click the triangle in the Targets module and select "Create Target From
vCard".

2. Choose the vCard file from your computer and click "Create".

Downloading a Target's vCard

The following steps cover downloading a vCard and saving it as a target in
Microsoft Outlook as an example:

1. Navigate to a Targets record view.
2. Select "Download vCard" from the Actions menu to download the vCard
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file.

3. Open the downloaded file in your mail or address book application. For this
example, double clicking opens the vCard in Outlook.

4. Make any necessary changes to the information, then click "Save & Close"
to save this lead in Outlook.

Last Modified: 2020-03-27 14:47:03

Target Lists

Overview

Target lists are used by Sugar's Campaigns module as collections of individuals or
organizations you want to include or exclude in a campaign. Each campaign may
relate to several target lists, and each target list can relate to any number and
combination of targets, contacts, leads, users, and accounts. In turn, each of these
records can be a part of multiple target lists, each of which may represent a
grouping of recipients based on relevant criteria such as age group, geographical
location, or industry.
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This documentation will cover information and actions specific to the Target Lists
module.

For instructions concerning views and actions which are common across
most Sugar modules, such as creating, editing, and deleting target lists,
please refer to the Working With Target Lists section of this page.
For instructions on how to send an email campaign to a target list, please
refer to the Campaigns documentation as well as the Creating a Campaign
and other campaign-related articles in our Knowledge Base.

Please note that you will only be able to see target list records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Target Lists module is not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation. 

Target Lists Fields

The Target Lists module contains a number of stock fields, which come out-of-the-
box with Sugar. The definitions below are suggested meanings for the fields, but
the fields can be leveraged differently to best meet your organization's needs. For
information on using and editing various field types, refer to the User Interface
documentation. 

Field Description
Assigned To The Sugar user assigned to the target

list
Date Created The date the target list record was

created
Date Modified The date the target list record was last

modified
Description A description or other information about

the target list
Name The name or designation of the target

list
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
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Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
target list

Total Entries The total count of records (contacts,
leads, targets, users, and accounts)
belonging to a target list. This number
will update automatically and cannot be
edited manually.
Note: You must refresh the record view
page to update the Total Entries field
after adding records to the target list.

Type The type of the target list (e.g. default,
test, etc.)

Domain Name The name of the domain to exclude from
the campaign recipient list (e.g.
"example.com"). All email addresses
containing the domain name will not
receive the campaign email.
Note: This field only displays when
"Suppression List - By Domain" is
selected for the Type field.

Target List Types

A target list can specify individuals or organization who need to be included in a
campaign or excluded from a campaign depending on the following target list
types:

Target List Type Description
Default A list of people who are the primary

recipients of the campaign email
Seed A list of people who need to receive the

campaign email but not be tracked in
the campaign statistics
Note: This list is typically used for
internal purposes where the individuals
in this group need to approve the
campaign before it is launched. The
seed list is ignored in the campaign's
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View Status page.
Suppression List - By Domain A list of people who should be excluded

from the campaign email recipient list
and whose email addresses share a
common domain name, such as
"website.com"
Note: Suppression by domain can be
used to prevent marketing to entire
organizations such as competitors.

Suppression List - By Email Address A list of people who should be excluded
from the campaign email recipient list
Note: This list typically consists of
people who chose to opt out from
receiving your campaign message.

Suppression List - By Id A list of people who should be excluded
from a Newsletter-type campaign email
recipient list
Note: The "Suppression List - By Id"
must be related to the Newsletter
campaign in order for the message's opt-
out link to function properly.

Test A list of people who receive test email
campaigns to make sure that the
message's layout is displayed properly
before the campaign is finalized and
sent to the default list
Note: A campaign may be sent to the
test list multiple times by using the
Delete Test Entries button on the View
Status page between re-sends.

For more information on sending campaigns, please refer to the Campaigns
documentation.

Working With Target Lists

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Target Lists section describe
Target Lists-specific behaviors and functionality. For more information on sending
campaigns, please refer to the Campaigns documentation.

Content Link Description
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Creating Target Lists
Basic Target List Creation
Creating via Subpanels
Creating via Duplication

The Creating Records section covers the
various methods of creating new target
list records, including via the Create
button in the Target Lists module, via
the Target Lists subpanel on campaigns,
and via duplication of an existing target
list record.

Viewing Target Lists
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Preview

The Viewing Records section describes
the various methods of viewing target
list records, including via the Target
Lists list view and record view, the
Recently Viewed menu in the Target
Lists module tab, and previewing target
lists in the right-hand side panel.

Searching for Target Lists
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating target
lists: global search, which searches
across all Sugar modules, and list view
search, which searches and filters
within the Target Lists module.

Target Lists List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Target Lists
Dashboards

The List View section walks through the
many elements of the Target Lists List
View layout which contains a filterable
list of all target list records in Sugar.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Target Lists list view are
described in the List View Mass Actions
Menu and List View Record Actions
Menu sections of this page.

Target Lists Record View
Favorite Designation
Next or Previous Record
Actions Menu
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels

The Record View section walks through
the many elements of the Target Lists
Record View layout which contain
detailed information about a single
target list record. While the generic
menu options are described in the User
Interface sections linked to the left, the
options specifically available in the
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Dashboards Target Lists record view are described
in the Record View Actions Menu
section of this page.
Note: In the Users subpanel on a target
list record view, regular users can link
or unlink any active user record but can
only inline edit their own user record.
Administrators can inline edit, link, and
unlink any active user record via the
Users subpanel.

Editing Target Lists
Editing Inline via Record View
Editing via Record View
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
target list records, including inline via
the Target Lists record view, in full edit
mode on the record view, inline via the
Target Lists list view, and via the Mass
Update option on the list view.

Deleting Target Lists
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted target lists, including via the
Target Lists record view, an individual
record's Actions menu on the Target
Lists list view, and the Mass Actions
menu on the list view.

Exporting Target Lists The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of target lists and all
their data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Merging Target Lists
Merging via List View

The Merging Records section provides
instructions for merging duplicate
target lists which will combine field
values and related records into a single
target list.

Favoriting Target Lists
Favoriting via List View
Favoriting via Record View

The Favoriting Records section
describes the various methods of
marking target lists as favorites,
including via the Target Lists list view
or Target Lists record view. Favoriting a
target list allows you to easily access it
from list views, dashlets, or the Target
Lists module tab.

Sharing Target Lists The Sharing Records section provides
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instructions for the Share record view
option which composes an email with a
link to the target list record. If the
recipient is logged into Sugar, clicking
the link will bring them directly to the
target list's record view.

Target Lists Menus

The Target Lists module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Target Lists-specific
functionality, within this page.

Module Tab Menus

The Target Lists module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list and you can click "Target Lists"
to access the list view. Once the Target Lists tab is visible in the navigation bar,
you can click the triangle within the tab to display the Actions, Recently Viewed,
and Favorites menus. The Actions menu allows you to perform important actions
within the module. The Recently Viewed menu displays the list of target lists you
most recently viewed. The Favorites menu displays the list of target lists you most
recently marked as favorites.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Target List Opens the record view layout to create a
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new target list
View Target Lists Opens the list view layout to search and

display target lists

If you do not see the Target Lists module tab in Sugar, please check the following:

The Target Lists module may be marked as hidden in your user
preferences, which will prevent it from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Target Lists module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Target Lists module for your
entire Sugar instance. Reach out to your Sugar administrator to have the
Target Lists module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Target Lists list view displays all call records and allows for searching and
filtering to locate specific target lists. You can view the basic details of each record
within the field columns of the list view or click a target list's name to open the
record view. To access a module's list view, simply click the module's tab in the
navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual target list records or click
the checkbox in the list header to select all records displayed in the current set of
list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more target lists at

a time
Merge Merge two or more duplicate target lists
Delete Delete one or more target lists at a time
Export Export one or more target lists to a CSV

file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual target list directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this target list in the

intelligence pane
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Edit Edit this target list
Delete Delete this target list

Record View Actions Menu

The Target Lists record view displays a single target list in full detail including its
fields and subpanels of related records. To access a target list's record view,
simply click a hyperlinked target list name from anywhere within Sugar. The
record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this target list
Share Share a link to this target list via email
Export Export the members (i.e. contacts,

leads, targets, users, and accounts) of
this target list to a .csv file

Copy Duplicate this target list to create a new
target list

Delete Delete this target list

Populating Target Lists

A target list consists of a group of individuals or organizations (e.g. targets,
contacts, accounts, etc.) you wish to be included or excluded from a mass
marketing campaign. These targets are typically identified based on a set of
predetermined criteria such as being a prospect or existing customer, age group,
industry, etc. There are various ways to populate a target list in Sugar including
using the Add to Target List option from a module's list view, selecting records
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from the subpanel in the Target Lists record view, etc. You can use the Select All
feature in the module's list view when adding to a target list, which will allow you
to easily select the first 1000 records in the result set. If you wish to add more than
1000 records or add a specific group of records to the target list, please use the 
filter option in the list view search to perform the additions in smaller batches.

Please note that if you have multiple targets with the same email address, Sugar
will send the campaign email to only one of the targets, chosen at random. The
other email addresses which are considered duplicates will be suppressed even
though they are not on the opt-out list.

For more information on sending campaigns, please refer to the Campaigns
documentation.

Populating via Individual Selection

The record view of each target list will display the Targets, Contacts, Leads, Users,
and Accounts subpanels. Users have the option to select and add the desired
targets directly via these subpanels.

The following steps cover populating a target list with contacts via the Target Lists
record view as an example:

1. Navigate to a target list's record view.
2. Scroll to the Contacts subpanel and choose "Link Existing Record" from the

subpanel's Action menu.
3. Locate and select the desired record from the Search and Select Contacts

page.

Once the contacts have been selected, you will see the records within the Contacts
subpanel of your target list's record view.

Populating via Reports

The record view of each target list will display the Targets, Contacts, Leads, Users,
and Accounts subpanels. You can select and add the desired targets from an
existing report directly to the target list via these subpanels.

The following steps cover populating a target list by selecting a report based on
the Leads module as an example:

1. Navigate to a target list's record view.
2. Scroll to the Leads subpanel and choose "Select from Reports" from the
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subpanel's Action menu.

3. Reports based on the Leads module will display on the Search and Select
Reports page. Select the report you wish to add to the target list by
clicking the radio button to the left of the report's name.

Once the report has been selected, the lead records from the report results will
display in the Leads subpanel. To add more records to the target list, simply use
the Select from Reports option again and choose a different report.

Populating via Module List View

You can select records directly from the Accounts, Contacts, Leads, and Targets
list views to add them to a target list.
The following steps cover populating a target list by selecting records from the
Accounts list view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account record(s) you wish to add.
3. Select the desired account record(s) then choose "Add to Target List" from

the Actions menu.
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4. The Add To Target List panel will appear below the search bar. Search and
select the desired target list from the dropdown list or create a new target
list by clicking "Create new target list".

If creating a new target list, enter appropriate values for the fields
in the record view layout. All required fields will indicate "Required"
in the field and must be completed prior to saving.

5. Once the appropriate target list is selected or created, click "Update" to
add the account records to the target list.

The selected account records will appear in the Accounts subpanel of the target
list record.

Populating via Importing Targets

The Target Lists module does not have an import option, but you can import
targets via the Targets module. While performing the import, users have the option
to add the targets to a target list. For more information on how to import records
into Sugar, please refer to the Import documentation.
Use the following steps to populate a new or existing target list with newly
imported targets:

1. Click the triangle in the Targets module tab and select "Import Targets".
2. In Step 1, select the source of the data you are importing. Click "Next".
3. In Step 2, select the import file and choose "Create new records only".
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Click "Next".
4. In Step 3, confirm the import file properties. Click "Next".
5. In Step 4, confirm the field mappings for the import. Click "Next".
6. On Step 6 of the import process, click the Add to Target List button.

7. A popup window will open with the option to select an existing target list or
create a new target list.

If adding to an existing target list, search and select the desired
target list from the window.
If creating a new target list, enter appropriate values for the fields
in the record view layout. All required fields will indicate "Required"
in the field and must be completed prior to saving.

Once the appropriate target list is selected or created, the newly imported targets
will appear in the Targets subpanel of the target list record.
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Exporting Target List Members

In addition to exporting target list records from the Target Lists list view, Sugar
allows you to export the members of a target list from the Target Lists record view.
This allows users to download all fields for the members of the selected target list
to their computers in a CSV format.
Use the following steps to export the members of a target list via the target lists
record view:

1. Navigate to a target list's record view.
2. Click the Actions menu and select "Export".

Please note that your ability to export target list members from Sugar may be
restricted by a role. For more information on roles, please refer to the Role
Management documentation in the Administration Guide. Check with your system
administrator if you do not see the Export option. 

Last Modified: 2020-03-27 21:23:04

Campaigns

Overview

Sugar's Campaigns module can be used to create and manage email and non-email
marketing and advertisement campaigns for your organization. Email-based
campaigns can be used to send mass emails or a series of newsletter emails to
individuals with whom you have an active or growing relationship. The results of
each campaign are recorded to measure the success of your campaigns. 

The Campaigns module is not available for Sugar Serve users. For more
information on license types and the functionality available for each, refer to the 
User Management documentation. 
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Note: Email addresses that are marked as opted-out cannot receive campaign
emails. For more information, refer to the Emails documentation.

Campaign Fields

The Campaigns module contains a number of stock fields, which come out-of-the-
box with Sugar. The below definitions are suggested meanings for the fields, but
the fields can be leveraged to best meet your organization's needs. Users with
administrator or developer access have the ability to alter, add, or remove fields
via Admin > Studio. For more information on configuring fields, please refer to the
Studio documentation in the Administration guide.

Field Description
Actual Cost The total cost of the campaign
Assigned To The Sugar user assigned to the

campaign record
Budget The budgeted amount for the

campaign's cost
Currency The currency of the campaign costs
Description A description or other information about

the campaign
Date Created The date the campaign record was

created
Date Modified The date the campaign record was last

modified
End Date The date the campaign is expected to

end
Expected Cost The expected cost of the campaign
Expected Revenue The expected revenue stemming from

the campaign
Frequency For newsletter-type campaigns, the

frequency the campaign is expected to
be sent

Impressions The expected number of recipient views
Name The name of the campaign record
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Objective The objective or purpose of the
campaign

Start Date The date the campaign is expected to
start

Status The current status of the campaign 

Note: This field is manually set, not
automatic.

Teams The Sugar team(s) assigned to the
campaign

Type The campaign's format or type (e.g.
email, web)

Campaigns Module Tab

The Campaigns module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list and you can click "Campaigns"
to access the list view. Once the Campaigns tab displays on the navigation bar, you
can click the triangle within the tab to display the Actions, Recently Viewed, and
Favorites menu. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the campaigns, target lists, and
targets you last viewed in the module. The Favorites menu displays the list of
campaigns you most recently marked as favorites in the module.
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The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Create Campaign (Wizard) Opens the campaign wizard to create a

new campaign
Create Campaign (Classic) Opens the edit view layout to create a

new campaign
View Campaigns Opens the list view layout to search and

display campaigns
View Newsletters Opens the list view layout to search and

display newsletter-type campaigns
Create Email Template Opens the Email Templates edit view

layout to create a new email template
View Email Template Opens the Email Templates list view

layout to search and display email
templates

Set Up Email For users with administrator access,
opens the email setup for campaigns
wizard
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View Diagnostics Displays your system's configuration
status for sending email-based
campaigns

Create Lead Form Opens the Lead Form wizard to
generate a web-to-lead form

If you do not see the Campaigns tab in Sugar, please check the following:

The Campaigns module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Campaigns module in the Hide
Modules list, simply move it to the Display Modules list and save. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Campaigns module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Campaigns module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

Prerequisites

There are several key components involved when executing an email or newsletter
campaign in Sugar. Before sending out an email-based campaign, an administrator
must make sure the following items are set up properly:

Outbound Emails : Configure Sugar to send outbound emails via Admin >
System Email Settings. For more information on configuring outbound
email, please refer to Set Up Email below or to the Email documentation in
the Administration Guide.
Campaign Batch Size : Specify the number of emails sent per batch via
Admin > Campaign Email Settings. Due to some email providers throttling
the number of emails allowed to be sent at one time, we recommend setting
this to 200 and adjusting as necessary. For more information on
configuring the campaign batch size, please refer to Set Up Email below or
to the Email documentation in the Administration Guide.
Bounce Handling Account : Create the bounce-handling inbox for
bounced campaign emails via Admin > Inbound Email. For more
information on configuring the bounce handling account, please refer to
the Email documentation in the Administration Guide.
Campaigns Scheduler : Configure the scheduler job that automatically
sends campaign emails via Admin > Schedulers > Run Nightly Mass Email
Campaigns Scheduler. The frequency of this scheduler should be
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determined in conjunction with the campaign batch size to ensure you do
not exceed sending limitations imposed by your email provider. For more
information on configuring schedulers, please refer to the Schedulers
documentation in the Administration Guide.
Bounced Emails Scheduler : Configure the scheduler job to process the
bounced campaign emails via Admin > Schedulers > Run Nightly Process
Bounced Campaign Emails Scheduler. For more information on configuring
schedulers, please refer to the Schedulers documentation in the
Administration Guide.
Note: The Run Nightly Mass Email Campaigns and Run Nightly Processed
Bounced Campaign Emails schedulers are configured by default to run
every night on the hour from 2:00 AM to 6:00 AM for the time zone of the
admin user (User Id = 1). For quicker processing of campaign information,
we recommend changing both schedulers to run every 10 minutes
throughout the day. Please note that if your email provider throttles the
number of emails allowed to be sent in a given time period, you may need
to reduce the frequency of sending.

Set Up Email

In addition to navigating directly to the email settings on the Administration page,
you can also configure Sugar's email settings for campaigns via the Set Up Email
option in the Campaigns module tab. This launches a wizard that walks through
entering all of the relevant information for email set up. Please note that the Set
Up Email option is only available to administrators and only needs to be configured
once for your Sugar instance.

Use the following steps to configure email settings via the Campaigns module:

1. Click the triangle in the Campaigns module tab to open the Actions menu
and select "Set Up Email".
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2. Enter the appropriate values specific to your email server in the fields on
the Setup Email page. Please note that any values entered on this page will
affect the system-wide email settings in Admin > System Email Settings.
Click "Next".

Note: All required fields (e.g. From Name, From Address, SMTP
Server, etc.) are marked with a red asterisk and must be completed.

3. Enter the appropriate information to set up your bounce-handling email
account on the New Mail Account page. Click "Next".

Note: A message will display if you already have an existing bounce-
handling account, but you can mark the Create New Mail Account
checkbox if you wish to create another one.

4. The Summary page will display a summary of the information you entered
on the previous steps. Click "Save" to preserve your changes.
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Campaign Diagnostic Tool

The campaign diagnostic tool enables you to check if all pending administrative
tasks have been completed before you attempt to launch the campaign. It is
recommended that the Campaign Diagnostic tool be run prior to sending out
campaigns to ensure any issues get resolved before the campaign emails need to
be sent.

Use the following steps to run the campaign diagnostic tool:

1. Click the Actions menu in the Campaigns module tab and select "View
Diagnostics".

2. Sugar will check your instance's email and scheduler configuration and
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display warnings if any additional configuration is necessary. Administrator
users will also see links (e.g. Launch Email Setup) to appropriate sections
of the Administration page to correct the issues.

Note: If you are not an administrator user, please reach out to your
system administrator to have the issues looked into and resolved
accordingly. For more information on the required elements for
campaigns, please refer to the Prerequisites section above.

3. Once all necessary configurations have been completed, click the Re-Check
button to re-run the campaign diagnostic tool.

Campaign Types

Sugar supports many different types of campaigns. The main types and their
differences are as follows:

Newsletter : A series of mass emails sent to a consistent or growing target
list periodically or on a regular basis. Each newsletter is intended to be
managed on a subscription basis and is normally targeted towards
individuals with whom you have an existing relationship. The Frequency
field is only available for campaigns with the type set to "Newsletter".
Recipients opting out of newsletter-type campaigns are added to that
campaign's unsubscription list but will still be able to receive other
campaigns' emails.
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Email Campaign : A one-time or series of mass emails sent to a target list.
Email campaigns are typically targeted towards a wide audience with the
intention of lead generation. Recipients opting out of email-type campaigns
have their email address marked as "opt-out" and are prevented from
receiving any future campaign emails.
Non-email based Campaign : A non-email mass marketing effort
delivered via mail, web, radio, television, print, or telesales. These
campaigns are not executed through Sugar, but you can create a campaign
record and manually update send dates and results for record-keeping and
to assess return on investment.

Note: Non-email based campaigns will not display Tracker URLs
and Email Marketing subpanels in the detail view.

Creating Campaigns

There are two primary methods for creating a campaign in Sugar: the Create
Campaign (Classic) option and the Create Campaign (Wizard) option. When using
the classic option, you will create the campaign record then add the target list and
create tracker URLs as well as an email marketing record via the related
subpanels below the campaign's detail. The classic option is recommended for
simplicity and empowering users to make modifications to the campaign later. The
campaign wizard option will walk you through getting the campaign created step-
by-step. Each step of the campaign set-up process will guide users on the items
(Tracker URLs, Target List, Marketing, etc.) that need to be completed.

Creating Via Classic Option

Creating a campaign using the classic method opens the Campaigns edit view
where you may enter the basic campaign information. Use the following steps to
create a campaign via the classic option:

1. Click the Actions menu in the Campaigns module tab and select "Create
Campaign (Classic)".

2. Enter appropriate values for the fields in the edit view layout which will
help identify the campaign. All required fields are marked with a red
asterisk and must be completed prior to saving.
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Note: The status, start date, and end date entered on this screen
are for your records only and will not control when the actual email
campaign will be executed.

3. Once the necessary information is entered, click "Save".

Once the campaign record is created, scroll to the related subpanels below the
campaign's detail to add the target list and create the tracker URLs as well as an 
email marketing record.

Creating Via Duplication

You can also create a new campaign by duplicating an existing campaign record.
The Copy option is useful if the campaign you are creating has similar information
to an existing campaign. When duplicating a campaign, the campaign data, and the
related target lists will copy over, but the original campaign's tracker URLs and
Email Marketing records will not be related to the new campaign.
Use the following steps to create a campaign by duplicating an existing campaign
record:

1. Navigate to a campaign record's detail view.
2. Click the Actions menu and select "Copy".

3. The displayed edit view is pre-populated with the original campaign's
values. Update the necessary fields, then click "Save".
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Once the campaign record has been created, scroll to the related subpanels below
the campaign's detail to add the target list and create the tracker URLs as well as
an email marketing record.

Creating Target Lists

A target list consists of a collection of individuals or organizations you want to
include or exclude in a mass marketing campaign. Target lists can contain any
number and combination of contacts, leads, targets, users, and accounts. You have
the option to associate existing target lists with your new campaign or to create
new target lists during the campaign creation process.

The target list type determines some specific functionality within the campaign.
The available target list types are "Default", "Seed", "Suppression List", and "Test".
Default and Seed-type target lists will receive emails when campaigns are sent.
Test-type target lists will receive emails when campaigns are tested.

Sugar will also create some target lists for you by default. For example, when
selecting a campaign type of "Newsletter", Sugar automatically generates three
target lists for the campaign: default-type "Subscription List", suppression by ID-
type "Unsubscription List", and test-type "Test List". Please note that these three
target list types are required for the Newsletter campaign. You may add additional
target list types to the campaign as necessary. If you wish to remove the system
generated target list types (e.g. suppression by ID-type "Unsubscription List"),
please keep in mind that you must replace it with the same target list type (e.g.
Suppression List - By Id).

For more information about target lists, please refer to the Target Lists
documentation.

Use the following steps to add an existing target list to your campaign via the
Target List subpanel on the Campaigns detail view:

1. Navigate to the Target List subpanel.
2. Choose "Select" from the Actions menu.

Note: Click the Create button if you wish to create a new target list
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for the campaign.

3. Locate and select the name of the desired target list in the pop-up window.
To add several target lists at once, mark the specific record's
corresponding checkbox then click "Select".

Creating Tracker URLs

Tracker URLs are special links for your email template that you can insert in place
of standard links to help you understand how your recipients are engaging with the
campaign message. If you choose to create your links as tracker links, then Sugar
will log your recipients' clicks by assigning each tracker link a unique key and
routing the link through Sugar before loading the final URL in their browser. The
click-through results are reportable and visible via the Campaign Status page for
your email campaign.

Tracker URLs can redirect recipients to public URLs such as a page on your
website, to a Sugar web-to-lead form, or to an opt-out page that suppresses the
recipient's email address from future mailings from the current list in Sugar. Once
you send a campaign that contains tracker URLs, you can see how many recipients
clicked each link and who those recipients are via the Campaign Response
Subpanel on the View Status page for the campaign.
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The following sections explain how to create different types of tracker URLs (i.e., 
redirect and opt-out) and insert them into your email template.

Creating Redirect Tracker URLs

Tracker URLs pass clicks from the email message through your Sugar instance
before arriving at their final destination. This allows the clicks to be tracked by
your campaign, which provides visibility into how your recipients are responding to
the campaign.

Redirect tracker URLs can appear as text or images in your campaign email and,
when clicked, will steer your recipient to the URL of your choice: a page on your
website, a targeted advertisement, or even a web-to-lead form where they can
provide details that will be saved as a Sugar lead record. For more information on
web-to-lead forms, please refer to the Web To Lead Forms documentation.

Use the following steps to create a redirect URL via your campaign's detail view:

1. Navigate to the Tracker URLs subpanel.
2. Click the Create button to create a new tracker URL.

3. Enter appropriate values in the fields on the page. All required fields are
marked with a red asterisk and must be completed.
Tracker Name : Enter an internal name for the tracker URL.
Opt-out Link : Leave this box unchecked.
Tracker URL : Enter the destination URL where recipients will be directed
to after clicking the link in the email.

4. Click "Save" to create the tracker URL record.

You can now insert this tracker URL into the email template of your choice. For
more information on adding redirect URL links to your template, please refer to
the Inserting Tracker URLs section of this documentation.
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Creating Opt-Out Tracker URLs

You can create an opt-out tracker URL to embed an Unsubscribe link in the
campaign email which will allow the targets to opt out of your campaign mailing
list. Please note that you will need to manually add the opt-out link by inserting the
tracker URL in the email template. If an opt-out link is not included in the email
template, Sugar will add a default opt-out link to the bottom of your campaign
email. 

Please note that both the newsletter-type and email-type campaigns include opt-
out links, but the behavior of each is different. For more information on how the
opt-outs work for each campaign type, please refer to the Understanding
Campaign Opt Outs article.

When a recipient clicks the opt-out link in the email, a new browser tab will open
to confirm that the recipient has elected to opt out of receiving campaign emails.
Please note that administrators can modify the confirmation message that appears
by changing the LBL_ELECTED_TO_OPTOUT label via Admin > Studio >
Campaigns > Labels. For more information on modifying labels, please refer to the
Studio documentation in the Administration Guide. Any recipients who have
elected to opt out of receiving campaign emails will be listed in the Opted Out
subpanel of the Campaign Status page. 

Use the following steps to create an opt-out link via your campaign's detail view:

1. Navigate to the Tracker URLs subpanel.
2. Click the Create button to create a new tracker URL.

3. Enter appropriate values in the fields on the page. All required fields are
marked with a red asterisk and must be completed.

Tracker Name : Enter an internal name for the tracker URL.
Opt-out Link : Mark the checkbox so that this link will be used to
allow recipients to opt out.
Tracker URL : This is defaulted and disabled for opt-out links.
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4. Click "Save" to create the opt-out tracker URL record.

You can now insert this tracker URL into the email template of your choice. For
more information on adding an opt-out link to your template, please refer to the 
Inserting Tracker URLs section of this documentation.

Creating Email Marketing Records

When you create an email campaign, you must also create an Email Marketing
record that specifies the body of the message in the form of an email template,
which bounce-handling account will catch automated replies from invalid email
addresses, and which target lists will receive this particular mass email of your
campaign.

When you are sending more than once from a single campaign, both newsletter-
type and email-type campaigns will need a new Email Marketing for each
subsequent send. For example, a monthly newsletter campaign will have 12 Email
Marketing records created in a year, each one with a different email template with
the same target lists. Or, if you wish to send an introductory email to all of your
newest prospects every 3 months, this email-type campaign will have 4 Email
Marketing records created in a year, each one using the same email template but
different target lists. Sugar will not allow the same Email Marketing record to be
sent to a recipient more than once.

Use the following steps to create an Email Marketing record via your campaign's
detail view:

1. Click the Create button to create a new email marketing record.

2. Complete the fields as follows. All required fields are marked with a red
asterisk and must be completed.

Name : Enter an internal name for the email marketing record.
Status : Select "Active" from the dropdown. Only active Email
Marketing records may be sent.
Start Date & Time : Enter a date and time when the emails need
to begin sending. This start date and time must have passed before
the campaign may be queued for delivery.
Email Template : Select or create an email template. For more
information on creating an email template, please refer to the 
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Creating Email Templates section of this documentation.
Send This Message To : Check this box to send this email to all
target lists that are associated with this campaign or select
individual target lists via the multiselect box below.

Use Mailbox : Select the bounce handling account that will catch
automated replies from invalid email addresses.
From Name : This will automatically populate based on the
selected bounce handling account. You can enter a different name
that will appear as the email's From name.
From Email Address : This will automatically populate based on
the selected bounce handling account. You can override the field to
enter a different email address that the campaign will be sent from.
Please note that your system outbound email account may need to
grant specific 'Send As' permissions if you wish to use a From email
address that differs from the address set up in Admin > System
Email Settings. If these permissions are not granted, emails may fail
to send or the authenticated email account will be imposed in place
of the address depending on your mail server settings. Also, if the
From address entered is not configured as a bounce handling email
address in Sugar, you will not see the results of the bounced emails
in your campaign's Status page.
"Reply-to" Name : This field will automatically populate if a Reply-
to name is provided on the bounce handling account. You can
override the Reply-to name to a different one so that any replies on
the email campaign can be addressed to this name on the email.
"Reply-to" Address : This field will automatically populate if a
Reply-to address is provided on the bounce handling account.
Please note that if any recipients reply back to the email campaign,
it will be sent to this email address on the bounce handling account
by default. You can override the Reply-to address for the campaign
to a different one so that any replies can be sent to a specific email
address where it can be better monitored.

3. Click the Save button to complete the creation of the Email Marketing
record.
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Creating Email Templates

Email templates contain the design and content of the emails your campaign will
send. Placeholder variables can be added to the template for field values like the
target name so you can personalize the email to your recipients. Creating an email
template through the Campaigns module rather than via the Emails module sets
the template's type to "Campaign" and allows you to add redirect and opt-out
tracker URLs.

Use the following steps to create an email template from the Email Marketing
record:

1. While creating or editing your campaign's Email Marketing record, click
"Create" to the right of the Email Template dropdown.

2. Enter the appropriate values for the fields in the pop-up window. The
required field is marked with a red asterisk and must be completed.

Name : Enter an internal name for the email template.
Teams : Select the Sugar team(s) assigned to the email template.
Type : This will automatically populate as "Campaign".
Description : Enter a description or other information about the
template.
Insert Variable : Insert variables or placeholders into the
template. For more information regarding inserting variables,
please refer to the Inserting Variables section.
Insert Tracker URL : Insert a tracker URL or opt-out link into the
template. For more information regarding inserting tracker URLs,
please refer to the Inserting Tracker URLs section.
Subject : Enter the subject of the emails that will be sent.
Body : Enter the body of the emails that will be sent.

3. Using the TinyMCE functions, add simple formatting to your email's
content. For more advanced customization you can click the HTML button
in the top left to access and edit the generated HTML code.
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Note: Only inline CSS may be used in email templates. Inline CSS is a
method of using CSS within your HTML content instead of storing it in an
external CSS file. So, every HTML element must be styled using inline CSS
by virtue of the "style=" declaration.

4. Click "Save" to preserve your changes to the email template.

Inserting Variables

When constructing the subject and body of your email, Sugar allows you to insert
variables, or placeholders, into the template that will be populated with the
record's information for that variable.

Use the following steps to insert a variable for the recipient's first name into the
template:

1. Click to place your cursor on the location in the subject or body where the
recipient's first name should appear.

2. In the Insert Variable row, the first dropdown defaults to
"Contact/Lead/Target" which will allow you to insert fields from the
associated person-type recipient's record.

3. Set the second dropdown to the desired field (e.g. First Name) from the
modules selected in the first dropdown.
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4. Click the Insert button to insert the generated variable name to your
subject or body at your cursor's location.

Inserting Tracker URLs

When constructing the body of your email, Sugar also allows you to insert redirect
or opt-out tracker URLs.

Use the following steps to insert a tracker URL or opt-out link into the template.

1. Click to place your cursor on the location in the body where the link should
appear.

2. Select the link you wish to add from the Insert Tracker URL dropdown.
Note: For more information on creating tracker URLs, please refer
to the Creating Tracker URLs section.
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3. Type the text you wish to appear as a link between the curly brackets in the
text box to the right of the dropdown.

4. Click the Insert URL Reference button to place the link in the body of the
email where your cursor is located.

After sending the email campaign, you can see how many people and who exactly
clicked on which links in your email message via the campaign's View Status page.

Testing Campaigns

Before you launch an email or newsletter campaign, it is recommended that you
perform tests to check how different email clients display the campaign message.
A test-type target list must be selected under the Target Lists subpanel as well as
in the Email Marketing record in order to test the campaign.

Note that in test mode, the system disables your suppression lists allowing the
campaign message to be sent to targets on your suppression-type target lists. The
system also disables checks for duplicate email addresses thereby allowing users
to send a message multiple times to the same recipients.

Use the following steps to test an email-based campaign:
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1. Navigate to a campaign record's detail view.
2. Select "Send Test" from the Actions menu.

3. Select the Email Marketing record and test target list combination that you
would like to test and click "Send".

Note: If an Email Marketing record does not have a test-type target
list associated to it, then the Targeted Lists section will remain
empty and no test emails will be sent.

You can send the campaign to the test target list multiple times by clicking the
Delete Test Entries button on the View Status page. You will need to do this after
each test in order to delete the log entries on the campaign status and allow Sugar
to send to the test list recipients again. Please note that sending to these recipients
again will be prevented until the previous test's entries have been deleted. Also,
please be sure that the test entries are all deleted once the campaign is ready to
be sent so that the statistics from the test will not be included in the actual
campaign's results.

Sending Campaigns

Once the Sugar email settings are configured and your campaign has been tested
successfully, you are now ready to send the campaign. Upon sending a campaign,
the emails are queued to be sent out at intervals. The administrator can configure
how many emails are sent and when to send them. For more information on the
relevant configurations, please refer to the Prerequisites section.

Use the following steps to send an email-based campaign:

1. Navigate to a campaign record's detail view.
2. Select "Send Emails" from the Actions menu.

                       763 / 1.116



 

3. Select the Email Marketing record and default target list that you would
like to receive the email campaign then click "Send".

Note: If the email marketing record does not have a default-type
target list associated to it, then the Targeted Lists section will
remain empty and no emails will be sent.

The specified start date and time on the email marketing record must have passed
before the campaign will be queued for delivery. Once the emails enter the queue
in Admin > Email Queue, the relevant scheduler will send the emails in set batches
on an interval configured by an administrator. For more information on the email
queue, please refer to the Email documentation in the Administration Guide. For
more information on the schedulers used by the Campaigns module, please refer to
the Prerequisites section.

Note: When a campaign is sent to a target list, deleting that target list or
unlinking it from the campaign will not remove the recipients from the email
queue, and the emails will be sent when the scheduler runs. Administrators can
delete emails via the email queue before they are sent.

Viewing Campaign Status

After you launch a campaign, you can view its results on the Campaign Status page
to gauge its impact and progress. The Campaign Status page includes several
subpanels, which display information such as the recipients who viewed the
message, the recipients who clicked a tracker URL in the email, how many leads
and contacts were created from the campaign, etc. This enables you to evaluate
the effectiveness of the campaign.
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Use the following steps to view the Campaign Status page:

1. Navigate to a campaign record's detail view.
2. Click the View Status button on the upper right of the page.

Campaign Status Chart

This is a visual representation of the counts of your recipient's activities which are
also detailed in the below subpanels. Use the dropdown to view a particular Email
Marketing record's data or choose "--None--" to view the cumulative results of all
of this campaign's sends.

Message Queue Subpanel

The Message Queue subpanel shows the campaign emails waiting to be sent in the
email queue. The emails will remain in the queue until the start time of the Email
Marketing record has passed and the scheduler picks up and sends them in
batches as specified in Admin > Campaign Email Settings. For more information
on batch size, please refer to the Prerequisites section. For more information on
monitoring this queue, please refer to the Email documentation of the
Administration Guide.

Campaign Response Subpanels
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The success of a campaign can be determined by analyzing the response statistics.
Knowing how many of your targets saw your email, clicked its links, and became
leads or contacts, for example, can provide insight into your campaign strategy.

The following subpanels measure different aspects of your recipient's responses to
the campaign or a specific send of the campaign based on your selection in the
Filter Chart By dropdown at the top of the page:

Message Sent/Attempted : The list of campaign emails that were sent out
to targets.
Viewed Message : The list of targets who viewed the emails that were
delivered. Sugar includes a very small, invisible image in each email. Each
time the recipient downloads this image, Sugar records that they viewed
the email.
Click-thru Link : The list of targets who clicked on a redirect tracker URL
in the email. This does not include opt-outs. For more information on
redirect tracker URLs, please refer to the Creating Tracker URLs section.
Leads Created : The list of leads who have been generated from a web-to-
lead form assigned to this campaign record.
Contacts Created : The list of contacts who have been converted from a
lead generated from a web-to-lead form assigned to this campaign record.
Bounced Messages, Invalid Email : The list of campaign emails that
bounced back due to invalid email addresses.
Bounced Messages, Other : The list of campaign emails that failed to
send despite having valid email addresses. After six failed attempts, these
messages will be removed from the queue.
Opted Out : The list of targets who chose to opt out of receiving campaign
emails by clicking the opt-out link.
Note: Opt-out links for newsletter-type and email-type campaigns behave
differently. When a target clicks an opt-out for a newsletter-type campaign,
they are prevented from receiving future emails from that specific
campaign by being added to the campaign's suppression-type list. When
clicking an opt-out for an email-type campaign, they are prevented from
receiving future emails from any campaign by having their email address
marked as "Opted Out" on their Sugar record. For more information, refer
to the Understanding Campaign Opt Outs article.
Suppressed by Email Address or domain : The list of email addresses
that were not sent the campaign email because the email address was
marked as opted out, belonged to a suppression list, or was an invalid
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address.

Note: If you do not see the campaign response subpanels, the administrator may
have disabled the Campaign Log subpanels for your entire Sugar instance. Reach
out to your Sugar administrator to have the Campaign Log subpanels displayed.
For more information on displaying and hiding subpanels throughout Sugar, please
refer to the Developer Tools documentation in the Administration guide.

Campaign Results Subpanels

The last three subpanels on the Campaign Status page can be used to demonstrate
the broader effects of the campaign by showing what new accounts, leads, and
opportunities were generated as a result of the effort.

Accounts : The list of accounts that are related to this campaign record
either through lead generation and then conversion or manually related
through the Campaign field on the account's record view.
Leads : The list of leads that are related to this campaign record either
through lead generation or manually related through the Campaign field on
the lead's record view.
Opportunities : The list of opportunities that are related to this campaign
record either through lead generation and then conversion or manually
related through the Campaign field on the opportunity's record view.

Viewing Campaign ROI

For campaigns (Email and Newsletter) that are executed through Sugar, you can
view the campaign's return on investment by clicking the View ROI button in the
Campaigns detail view. The return on investment chart displays the actual revenue
you earned through the campaign versus the estimated expected revenue. It also
reflects the actual cost you incurred by executing the campaign versus the budget
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that you set for the campaign. The budget, actual cost, and expected revenue
amounts entered in the campaign overview screen are displayed as bars in the
campaign return on investment chart. The actual revenue is calculated from the
campaign's related opportunities that have a sales stage of "Closed Won". 

Use the following steps to view a campaign's ROI:

1. Navigate to a campaign record's detail view.
2. Click the View ROI button on the upper right of the page.

Viewing Campaigns

There are various options available for viewing campaign records in Sugar
including via Campaigns list view, Campaigns detail view, Campaigns Recently
Viewed menu, dashlets, and reports. Please note that you will only be able to see
campaign records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

Viewing Via List View

The Campaigns list view displays all campaign records meeting the current search
criteria. To access the list view, simply click the Campaigns tab. While list view
shows key campaign fields, you can click the campaign's name to open the record
in detail view. For more information on viewing campaigns via list view, please
refer to the Campaigns List View section.

Viewing Via Detail View

The Campaigns detail view displays thorough campaign information including all
campaign fields followed by subpanels of the campaign's related records. The
detail view can be reached by clicking a contact record's link from anywhere in the
application including from the Campaigns list view. For more information on
viewing campaigns via detail view, please refer to the Campaigns Detail View
section.

Viewing Via Recently Viewed
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As you work, Sugar will keep track of which campaigns you have recently viewed.
Click the Actions menu in the Campaigns Module Tab to see a list of your most
recently viewed campaigns and click each name to open the Campaigns detail
view.

Viewing Via Dashlets

Sugar dashlets allow users to get a quick view of various records, reports, etc.
Dashlets may be added to a user's Home page or to the intelligence pane for
modules (e.g. Accounts) using the Sidecar user interface. You can view campaign
information in List View dashlets specific to the Campaigns modules (e.g. My
Campaigns dashlet), as well as List View dashlets based on other modules such as
"My Contacts". Clicking a campaign's name from any dashlet will open the
Campaigns detail view. For more information on using dashlets and viewing
campaign records via dashlets, please refer to the Dashboards and Dashlets
documentation.

Viewing Via Reports

Users with access to the Reports module have the option to build, generate, and
manage various reports in Sugar. You can generate reports to gather key data
regarding your campaigns plus information for related records. You also have the
option to filter the report based on the campaign and related module(s) to only
include records that is of importance. The display columns will only show data for
fields (e.g. campaign name, type, related leads etc.) that you choose specifically
when creating the report. Once the report is run, you will be able to view the
campaign record's detail view by clicking the campaign's name in the report
results. Please note that you can only click into campaign records for Rows and
Columns Report and Summation Report with Details Report type. The other two
report types (Summation Report, Matrix Report) are summation reports and do not
include display columns with hyperlinks (e.g. Campaign Name) to allow for
navigating to campaign record detail views. For more information on viewing
campaign records via the Reports module, please refer to the Reports
documentation.
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Searching Campaigns

The Campaigns list view includes a Basic and Advanced Search to help you find
your records easily and effectively in a module-specific manner. Once the search is
performed, the relevant search results will be displayed in the Campaigns list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module. Please
note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %offer). This will
pull up any record that has the word "offer" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in the Basic Search panel have the following
functions:

Search : Click the Search button or hit Return/Enter key to perform the
search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only records you have marked as
favorites.

When you perform a search, Sugar will return records matching all (as opposed to
any) of the fields and checkboxes for which you have given a value. For example, if
you select "My Items" and enter a campaign's name, Sugar will only return
campaign records with a matching name that are assigned to you. Once the search
is complete, the relevant results will populate in the list view below the search
panel. To see all campaign records to which you have access, simply click "Clear"
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and then "Search" to perform a blank search with no filters. 

Please note that you will only be able to see campaign records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Administrators can configure what fields appear on the Campaigns Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration Guide.

Advanced Search

Advanced search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Favorites : Select this box to return only records you have marked as
favorites.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
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of the fields for which you have given a value. For example, if you select "My
Favorites" and enter a campaign's name to search, Sugar will only return
campaign records with a matching name that you have marked as favorites. When
searching by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar
will return records matching any of these selections. Once the search completes,
the relevant results will populate in the list view below the search panel. To see all
campaign records to which you have access, simply click "Clear" and then "Search"
to perform a blank search with no filters.

Please note that you will only be able to see campaign records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide. Administrators can configure what
fields appear on the Campaigns Advanced Search via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration Guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Full-Text
Search may be used with Global Search to search throughout nearly all fields and
modules for an enhanced search experience. The Global Search bar is located on
the top right-hand side of Sugar. You can click the magnifying glass icon or hit
Return/Enter to perform your search once the text string is entered in the search
box.

To use global search, you need to first enter the keyword into the search box and
the pop-up results will begin appearing once you enter in at least one character.
Clicking the magnifying glass icon or hitting your Return/Enter key will cause
Sugar to return exact matches for your keyword rather than matches with words
beginning with your keyword.

For more information on using and configuring Global Search, please refer to the 
Global Search section of the Search documentation.
Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results by clicking the down arrow within the
Search box then selecting the module(s) to include in the search. For more
information on configuring your Global Search, please refer to the Search
documentation.

Administrators can control additional elements of global search via Admin >
Search and Admin > Studio. For more information on administrator configuration
of Global Search, please refer to the Field Options section of the Studio
documentation as well as the Search section of the System documentation in the

                       772 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Layouts
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Global_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Advanced_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Field_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#Search


 

Administration Guide.

Campaigns List View

The Campaigns list view displays all campaign records meeting the current search
criteria to which your user has access. You can view the basic details of each
campaign within the field columns. Please note that you will only be able to see
campaign records as allowed by your team membership, user access type, and
assigned roles.

For more information on teams and roles, please refer to the Team Management
and Role Management documentation in the Administration Guide. You have the
option to change what fields are displayed in list view by configuring your layout
options in the Campaigns Advanced Search.

For more information on configuring your list view, please refer to the Layout
Options section of the Search documentation. Users with administrator or
developer access also have the ability to change what fields are visible in the list
view via Admin > Studio. For more information on editing list view layouts, please
refer to the Studio documentation in the Administration Guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration Guide.

Checkbox Selection
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You can perform several actions on campaign records directly from the list view by
first selecting the desired records. To select individual campaign records on the
Campaigns list view, mark the checkbox on the left of each row. To select or
deselect multiple campaign records on the list view, use the options in the
checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of
campaign results.
Select All : Selects all records in the current search results across all
pages of campaign results.
Deselect All : Deselects all records that are currently selected.

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more campaigns at a time
Mass Update Mass update one or more campaigns at

a time
Export Export one or more campaigns to a CSV

file
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Favorite Designation

Users have the option to mark campaign records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often as they can easily be accessed via search or from the
Campaigns module tab. In the Campaigns list view, the star on the left of each
campaign's row is yellow once marked to indicate a favorite campaign. For more
information on marking records as favorites, please refer to the Favoriting
Campaigns section of this documentation.

Campaign Status

Each campaign's status page may be accessed directly from the list view by
clicking the Chart icon on the right of each list view row. For more information on
the campaign status page, please refer to the Campaign Status section of this
documentation.

Campaign Wizard

The Campaign Wizard may be directly accessed from the list view by clicking the
Wand icon on the right far right of each list view row. For more information
regarding the Campaign Wizard, please refer to the Using the Campaign Wizard
section of this documentation.

More Information
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Additional details for each campaign can be viewed by clicking the "i" to the far
right of each list view row. This provides users a quick view of additional campaign
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Start Date, Description, and Objective fields by
default. The list of fields appearing here may only be configured through a code-
level customization.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Campaigns Detail View

The Campaigns detail view displays thorough campaign information including all
campaign fields which are grouped by default into the Overview and Other panels.
You can also view a campaign's related records which appear in subpanels beneath
the campaign fields. The detail view can be reached by clicking a campaign
record's link from anywhere in the application including from the Campaigns list
view.

Please note that you will only be able to view a campaign record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide. Users with administrator or developer
access have the ability to change the detail view by configuring the layout via
Admin > Studio. For more information on editing layouts, please refer to the 
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Studio documentation in the Administration Guide.

Actions Menu

The actions menu on the top left of each campaign's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration Guide.

The options in the actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this campaign
Share Share a link to this campaign via email
Copy Duplicate this campaign
Delete Delete this campaign
Send Test Send test emails for this campaign
Send Emails Send all emails for this campaign
Mark As Sent Mark a non-email campaign as being

sent
View Change Log View a record of changes to this

campaign

Favorite Designation

Users have the option to mark campaign records as a favorite via the detail view as
well as the list view. This allows users to group records that are important or will
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be viewed often as they can easily be accessed via search or from the Campaigns
module tab. In the Campaigns detail view, the star on the right of the campaign's
name is yellow once marked to indicate a favorite campaign. For more information
on marking records as favorites, please refer to the Favoriting Via Detail View
section of this documentation.

Next or Previous Record

On the upper right of the Campaigns detail view, there are two buttons that allow
you to page through each campaign in the Campaigns list view's current search
results. Clicking the Previous button displays the previous campaign of the current
search results while clicking the Next button displays the next campaign of the
current search results. The text in between shows which campaign result you are
currently viewing within the total number of current results.

Related Record Subpanels

Every campaign record's detail view will display subpanels which list related
records from other modules. Users with administrator or developer access have
the ability to change the fields (e.g. Name, Assigned User, etc.) and labels of each
subpanel by configuring the layout via Admin > Studio to provide visibility to the
most important fields. For more information on modifying subpanels, please refer
to the Studio documentation in the Administration Guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration Guide.
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To view the details of a related record, click the record's
name in the subpanel to open it in detail view.
To relate an existing record to the campaign, choose
"Select" from the subpanel's Action menu, then locate and
select the desired record.
To relate a new record to the campaign, click "Create" on
the upper left of the subpanel, then complete the Record
View layout and click "Save".
To edit the campaign's related record, click either the
record's name or the View button to the far right of the
record's row to open the record view and edit as necessary.
To delete the campaign's relationship to a record, choose
"Unlink" from the Actions menu on the far right of the
record's row. This removes the relationship but does not
delete the record itself.
To collapse or expand the subpanel, click the double arrow
to the left of the subpanel's name.
To move the subpanel to a new location on the detail view,
drag and drop the subpanel's header.

Please note that administrators can prevent users from
moving subpanels to different locations in the detail view.
For more information on preventing rearranging of
subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator
if you are not able to rearrange your subpanels.

Editing Campaigns

Campaigns may be edited at any time to update or add information to the record.
You can make changes to existing campaign records via the Campaigns edit view.
Edit view is available within the Campaigns module and includes all of the
Campaign fields you should need.
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Please note that your ability to edit campaigns in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.

Administrators in Sugar may configure the Campaigns edit view via Admin >
Studio. For more information on configuring these layouts, please refer to the 
Studio documentation in the Administration Guide.

Editing Via Detail View

You can edit campaigns via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary field, then
click "Save" to preserve your changes.

Editing Via List View

You can edit campaigns via the list view by clicking the pencil icon to the left of
each campaign's name. The edit view layout will open and you can update the
necessary fields then click "Save" to preserve your changes.
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Deleting Campaigns

If a campaign record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Campaigns detail view or list
view. Deleting via the detail view allows you to delete a single record while the list
view allows for mass deleting multiple records at once. Deleting campaign records
will not delete the related records and will only remove the relationship, so you
may wish to also delete any related records to avoid orphaned records.

Please note that your ability to delete campaigns may be restricted by a role.

For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Delete options.

Deleting Via Detail View

Use the following steps to delete a campaign record via the detail view:

1. Navigate to a campaign record's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Mass Deleting Via List View

Use the following steps to delete one or more campaign records via the list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the Basic or Advanced Search to find the campaign records you wish to

delete.
3. Select the desired campaign records individually or using the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.
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5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Exporting Campaigns

Sugar's Export option allows users to download all fields for the selected
campaigns to their computers as a .CSV (comma-separated values) file. This may
be useful when needing to use campaign data with other software such as
Microsoft Excel. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a large number of
campaign records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Campaigns may be exported from the Campaigns list view by selecting "Export"
from the Actions menu. Users with access to the Reports module also have the
option of creating or accessing reports containing specifically chosen fields for
campaigns and their related record(s). Please note that only Rows and Columns-
type reports have the ability to be exported. For more information on exporting
records in Sugar, please refer to the Export documentation.

Please note that your ability to export campaigns from Sugar may be restricted by
a role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Campaigns
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Mass Updating allows users to make the same change to multiple campaign
records at once from the Campaigns list view. Users with administrator or
developer access can control which fields are available to change during mass
update via Admin > Studio. Currently, only fields with the data type of date,
datetime, dropdown, multiselect, and radio may be altered during a mass update.
For more information on configuring mass update, please refer to the Studio
documentation in the Administration Guide. Due to the PHP memory limitations on
the server, there may be occasions when the application times out while mass
updating a large number of campaign records. If you encounter an error when
performing this action, we recommend selecting the records in smaller batches.

Please note that your ability to mass update campaigns may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update campaign records from the list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the list view's Basic or Advanced Search to find campaigns you wish to

modify.
3. Select the desired campaigns individually or using the checkbox

dropdown's options.
4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.

Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add
the teams specified here to any existing team assignments.
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6. Click "Update" to save the changes to all of the currently selected
campaign records.

Favoriting Campaigns

Each Sugar user has the option to designate their own favorite campaigns which
are important or will be viewed often. Favorite records can then be easily be
accessed via search or from the Campaigns module tab. Once records are marked
as favorites, use the My Favorites checkbox in the Campaigns Basic or Advanced
Search to retrieve your favorites or select from your most recent favorites directly
from the Campaigns module tab.

Favoriting Via List View

Use the following steps to mark records as favorites via the Campaigns list view:

1. Navigate to the Campaigns list view by clicking the Campaigns module tab.
2. Use the Basic or Advanced Search to find the campaign records you wish to

mark as favorites.
3. Click the star icon on the left of each desired campaign's row.
4. To remove the campaign as a favorite, click the star again to revert it to

white.

Favoriting Via Detail View
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Use the following steps to mark records as favorites via the Campaigns detail view:

1. Navigate to a campaign record's detail view.
2. Click the star icon to the right of the campaign's name in the upper left of

the detail view to designate it as a favorite.
3. To remove the campaign as a favorite, click the star again to revert it to

white.

Sharing Campaigns

Individual Campaign records can be shared with other users in your organization
by sending an email with the record's link directly from the detail view. In the
campaign's detail view, select "Share" from the Actions menu which will open a
Compose Email window including the URL of the campaign record. Enter the
recipient(s) email address in the To field then click "Send".

Users can simply click the link in the email to access the campaign record in
Sugar. Please note that the user must be logged in to Sugar in order to access the
record. Users will only be able to view the shared record as allowed by their team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Marking Campaigns As Sent

When launching a non-email campaign such as a telesales or mail campaign, Sugar
will need to be told that the campaign has been sent since the sending is
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performed outside of the application. Once you mark the campaign as "sent," the
Campaigns subpanel on the detail view of each member of the campaign's target
populates with a row indicating an activity of "Message Sent" to indicate that the
campaign material was sent to that individual. The Campaign's status page will
then display these recipients in the Message Sent/Attempted subpanel. For more
information on the Campaigns status page, please refer to the Viewing Campaign
Status section of this documentation.

Use the following steps to mark a campaign as sent via the Campaigns detail view :

1. Navigate to a campaign record's detail view.
2. Select "Mark As Sent" from the Actions menu.

Viewing Campaign Change Logs

Changes made to each campaign record are tracked over time, and users are able
to view the history of changes via the change log in each campaign's detail view.
To view the change log, navigate to a campaign in detail view and select "View
Change Log" from the Actions menu. Please note that only fields marked as "Audit"
in Admin > Studio will be displayed in the change log. For more information on
designating for audit, please refer to the Studio documentation in the
Administration Guide.
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Using the Campaign Wizard

You can use the Campaign Wizard to guide you through the process of creating a
campaign, however, it is recommended to create and modify campaigns using the
classic interface instead. For instructions on creating and editing campaign
records using the classic interface, please refer to the Creating Campaigns and 
Editing Campaigns sections of this documentation.

Last Modified: 2021-11-23 17:53:56

Web-To-Lead Forms

Overview

Sugar provides a simple way to allow visitors to your website or other online
locations to become leads in your Sugar instance. You can generate a web-to-lead
form in Sugar and place the form on an external website. When a visitor to your
site completes and submits the form, their information is entered into Sugar as a
new lead record. You can use this lead information to generate more opportunities
for your organization.

Note: Web-to-Lead forms are not available for Sugar Serve users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation. 

Creating Web-To-Lead Forms

The Sugar Campaigns module contains a lead form wizard to assist in generating a
custom web-to-lead form. Use the following steps to create a web-to-lead form via
the Campaigns module:

1. Click the triangle in the Campaigns module tab and select "Create Lead
Form".
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2. Click and drag the desired fields from the Available Fields list to the Lead
Form (First Column) or Lead Form (Second Column) lists.
Note: You can also choose to add all fields to either column by clicking the
Add All Fields button.

3. All required fields marked with an asterisk must be added to a column on
the lead form prior to continuing.

4. Once the desired fields have been moved to the appropriate columns, click
the Next button to continue.

5. Enter appropriate values for the fields on the next page of the wizard:
Form Header : This will be the title at the top of your form. A generic title
has been populated; modify or remove this to suit your needs.
Form Description : This will be a brief description of the form and will
show below the form header, but before the form begins. A generic
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description has been populated; modify or remove this to suit your needs.
Submit Button Label : Enter in the label for the button that will be used
to complete the form. "Submit" is the default label but you can change this
label (e.g. "Sign Up", "Save", "Complete") to best suit your needs.
Post URL : This is the location the form will send the data entered and is
defaulted to your instance of Sugar. Enable the "Edit Post URL?" checkbox
to edit this field.
Note: If you change this location to be anything other than your Sugar
instance then a lead will not be generated when the form is completed.
Redirect URL : This is the location your visitors will be directed to after
completing the form. You may enter the location of your corporate website,
a custom "Thanks for signing up" page, or any URL to suit your needs.
Note : Leaving this field empty will display a message that says: "Thank
You For Your Submission".
Related Campaign : Use the Select button to choose an existing campaign
that is related to this lead form. Leads generated from this form will
automatically be associated to this campaign.
Assigned to : Use the Select button to choose the Sugar user that should
be assigned to the new lead record when the form is submitted. By default,
this field is populated with the current user who is generating the form.
Team : Enter the name of the team that is allowed access to the leads
generated from this form. To change the primary team, either enter the
team name here or select the team. By default the primary team selected
will be Global. More than one team can be assigned simultaneously. For
more information on teams, please refer to the Team Management
documentation.
Form Footer : The form footer displays the text entered here below the
form inputs, but before the submit button.

6. All required fields are marked with a red asterisk and must be completed
prior to continuing.

7. Once the necessary information is entered, click "Generate Form".
8. Sugar will generate the HTML needed for your form and show you a

preview in a TinyMCE editor. If you desire, you can add additional text and
images as well as change the layout of the form per your preference. You
can click the HTML button to make advanced customizations and edit the
generated HTML code.
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9. Once any additional changes have been completed, click "Save Web To
Lead Form".

Including Email Addresses on Forms

If the lead form contains any email address fields, an opt-in checkbox field (i.e. By
checking this box, you agree to receive future marketing emails) will appear on the
form which allows visitors to explicitly indicate that they wish to receive marketing
emails. Please keep in mind that when the opt-in checkbox is enabled, this setting
will apply to all email addresses entered on the form. In addition, if the global opt-
out setting has been enabled via Admin > System Email Settings and the visitor
enables the opt-in checkbox on the lead form, the opt-in setting will take
precedence over the global opt-out setting when the lead record is created in
Sugar. For more information about email address opt-outs, refer to the Emails
documentation.

Saving Web-To-Lead Forms

Since your web-to-lead form will be hosted outside of Sugar, you will need to save
the generated HTML to a different hosting location. Your generated form will not
be saved or accessible through Sugar after leaving this screen. If you need to add
or remove fields to your form after generation, you will have to go through the
steps to generate a new form.

Use the following steps to save your generated web-to-lead form:

1. You may download the generated HTML file by clicking on the Web to Lead
Form link.
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2. This will download the HTML file to your local computer. Simply transfer
this file to the final hosting destination.

3. Alternatively, you may copy the HTML directly out of the text box on this
screen and add it to a preexisting HTML file of your choosing.

4. Once the web-to-lead form is accessible to your potential customers,
include a link to the form on your corporate website, social media websites,
or add as a tracker URL in a campaign. For more information regarding
adding tracker URLs to a campaign, please refer to the Campaigns
documentation.

Lead Generation

Once a web-to-lead form is submitted, the data entered on the form becomes a lead
record in your Sugar instance. Leads can be converted to contacts, accounts, and
opportunities. For more information on the Leads module, please refer to the 
Leads documentation.

The campaign selected during form generation is linked to the created lead via the
Campaign field under the More Information panel as well as the Campaigns
subpanel.
More Information panel:

Campaigns subpanel:
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Leads created from the web-to-lead form can also be tracked on the Campaigns
status page via the status chart and the Leads Created subpanel.
Status chart:

Leads Created subpanel:

If a lead that was generated from a web-to-lead form is converted to a contact, this
will be shown in the Campaigns status page as well:

For more information regarding the Campaigns status page, please refer to the 
Viewing Campaign Status section in the Campaigns documentation.

Last Modified: 2020-03-11 00:46:05

Cases
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Overview

Sugar's Cases module is used to track and manage customer requests for
assistance with products or services. As a case is opened, worked on, and resolved,
its progress will be denoted by the Status field. Each case record may relate to
other Sugar records such as calls, contacts, and bugs, making it easy to get the full
picture of a customer's issues and history. If enabled, contacts can view and open
cases via the Sugar Portal along with bugs and knowledge base articles. Cases can
also be automatically created from incoming emails, and a case macro can be
employed to automatically relate emails to existing cases. This documentation will
cover information and actions specific to the Cases module. For instructions
concerning views and actions which are common across most Sugar modules, such
as creating, editing, and deleting cases, please refer to the Working With Cases
section of this page.

Users with a Sugar Serve license type can use the Service Console as their primary
case workspace. Service Console is a Home page dashboard that provides a
powerful work environment for customer service agents by incorporating SLAs and
region-specific business hours, insightful dashlets, and a cohesive case research
and action experience. For more information, refer to the Service Console
documentation.

In addition, Sugar Serve provides a stock SugarBPM™ template that sets case
follow-up dates on new and in-progress cases according to your organization's
Service Level Agreements (SLAs). It incorporates case and related account fields
when calculating follow-up dates as well as sending email notifications and
updating the case Status field in certain circumstances. It also updates Case fields
that are used to perform first response and resolution calculations. Refer to the 
Getting Started With SugarBPM for Sugar Serve and Stock SugarBPM - Case
Follow-Up Date Management articles for help configuring this process definition
and your instance to work together.

Please note that you will only be able to see case records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Note: The Cases module is not available for Sugar Sell users. For more
information on license types and the functionality available for each type, refer to
the User Management documentation. 

Case Fields
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The Cases module contains a number of stock fields that come out-of-the-box with
Sugar. For information on using and editing various field types, refer to the User
Interface documentation. The definitions below are suggested meanings for the
fields, but the fields can be leveraged differently to best meet your organization's
needs. Administrators or users with developer-level role access have the ability to
alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description
Account Name The account that submitted the case

Note: In Sugar Serve, information from
a case's related account is used by the 
stock SugarBPM template to calculate
the Follow Up Date

Assigned To The Sugar user assigned to the case
Note: Case owners receive an email
whenever a case is assigned to them if
the administrator has enabled email
notifications.

Business Center Name 1 The business center responsible for
managing this case
Note: This field is only available to
Sugar Serve users and is hidden from
the view if you do not have the
appropriate license type. See the User
Management page for details on license
types. During case creation, selecting a
related account will cause the Business
Center Name field to be populated
automatically, on save, with the
account's business center. The value can
also be manually set. The selected
business center is used for business
hour calculations. For more information,
refer to the Business Centers and Cases
section of this page.

Business Hours to First Response 1, 2 The calculated duration in business
hours from the moment the case is
created until its First Response Sent
field is set to "true". Setting the First
Response Sent field to "false" does not
clear this field's value, but it is updated
each time the First Response Sent field
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is set to "true".
Business Hours to Resolution 1, 2 The calculated duration in business

hours from the moment the case is
created until its Status field is set to
"Closed", "Rejected", or "Duplicate".
Reopening the case does not clear this
field's value, but it is updated each time
the case is closed.

Case Number An automatically incremented number
to identify every case, which cannot be
edited through Sugar

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Date Created The date the case was created
Date Modified The date the case was last modified
Description Explanation of the cause and details of

the case when submitted
First Response Actual Time 1, 2 The date and time the First Response

Sent field is set to "true". Setting the
First Response Sent field to "false" does
not clear this field's value, but it is
updated each time the First Response
Sent field is set to "true".

First Response Sent 1, 2 A checkbox that indicates whether or
not the first response has been sent to
the customer. This field is updated by a 
stock SugarBPM template when the
case's status changes from "New" to
anything else. However, the SugarBPM
template can be configured to set the
field using other criteria if desired (e.g.
when a note with a Note Source of
"Internal" is related to the case).

When this field is set to "true", Sugar
updates the following fields:
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Business Hours to First
Response
First Response Actual Time
First Response SLA Met (only if
the case's Follow Up Date field
has been set)
First Response Target Time (only
if the case's Follow Up Date field
has been set)
First Response Variance from
Target (only if the case's Follow
Up Date field has been set)
First Response User
Hours to First Response

Setting this field to "false" does not
clear the above fields' values, but they
are updated each time this field is set to
"true".

First Response SLA Met 1, 2 A dropdown field with possible values of
"Yes" and "No"; its value is updated
when the First Response Sent field is set
to "true". If the first response was sent
to the customer before the follow-up
date, this field is set to "Yes"; if the first
response was sent after the follow-up
date, this field is set to "No". The stock
SugarBPM template sets this field to
"No" if the follow-up date passes before
the case's status is updated.

Setting the First Response Sent field to
"false" does not clear this field's value,
but it is updated each time the First
Response Sent field is set to "true".

First Response Target Time 1, 2 The calculated date and time by which
the first response must be sent to meet
the SLA. This field is set based on the
value of the Follow Up Date field at the
time the First Response Sent field is set
to "true". Setting the First Response
Sent field to "false" does not clear this
field's value, but it is updated each time
the First Response Sent field is set to
"true".
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First Response Variance from Target 1, 2 The calculated difference in business
hours between the First Response
Actual Time and First Response Target
Time fields. A negative number indicates
that the first response was sent before
the target and a positive number
indicates that it was sent after. Setting
the First Response Sent field to "false"
does not clear this field's value, but it is
updated each time the First Response
Sent field is set to "true".

First Response User 1, 2 The user the case is assigned to when
the First Response Sent field is set to
"true". Setting the First Response Sent
field to "false" does not clear this field's
value, but it is updated each time the
First Response Sent field is set to "true".

Follow Up Date The date and time to follow up with the
customer
Note: While this value can be manually
set, it is automatically set by the stock
SugarBPM template included with
Sugar Serve. For more information,
refer to the Stock SugarBPM Templates
documentation.

Hours to First Response 1, 2 The calculated duration in calendar
hours from the moment the case is
created until its First Response Sent
field is set to "true". Setting the First
Response Sent field to "false" does not
clear this field's value, but it is updated
each time the First Response Sent field
is set to "true".

Hours to Resolution 1, 2 The calculated duration in calendar
hours from the moment the case is
created until its Status field is set to
"Closed", "Rejected", or "Duplicate".
Reopening the case does not clear this
field's value, but it is updated each time
the case is closed.

Pending Processing A system-level checkbox field that is set
to true when creating a case via inbound
email or relating a case to an inbound
email. It is not available in Studio or the
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user interface and is only available in 
SugarBPM.

Primary Contact The primary contact for the case. If the
case is created via the portal, the
Primary Contact field is set to the portal
user that created the case.
Note: The contact listed as the primary
contact is not automatically added to the
Contacts subpanel on the case.

Priority The urgency of the problem which, for
Sugar Serve, is used by the stock
SugarBPM template to calculate the
Follow Up Date

Resolution Results of the investigation into the
problem

Resolved Date The system-generated date and time
that the Status field was set to "Closed",
"Rejected", or "Duplicate". If the case is
reopened, the Resolved Date field is
automatically cleared.

Show In Portal Cases created in Sugar will be visible in
the portal by default
Note: Administrators can have this field
disabled by default via Admin > Studio.

Source The method in which the case was
submitted (e.g. internal, customer email,
portal, etc.)
Note: For cases created via the portal,
the Source field will automatically be set
to "Portal".

Status The current status of the case which, for
Sugar Serve, is set by the stock
SugarBPM template in some situations

Subject A brief statement of the problem
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the case
Type Type of categorization that this case
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falls into
Work Log Freeform field to add activities and

notable events while working on the
case

1 This field's value is only visible to Sugar Serve users; when this field appears on
layouts, users without a supported license type will see a placeholder containing
the text "License Required" instead of the field's value. See the User Management
page for more details on license types.
2 To better understand how all of the case SLA and resolution fields work together,
refer to the Understanding SLA and Case Resolution Calculations article.

Working With Cases

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Cases section describe Cases-
specific behaviors and functionality.

Content Link Description
Creating Cases
Basic Case Creation
Creating via Quick Create
Creating via Subpanels
Creating via Duplication
Importing Cases

The Creating Records section covers the
various methods of creating new case
records, including via the Create button
in the Cases module, via the Quick
Create menu on the upper right of every
Sugar page, via the Cases subpanel on
related module records, via duplication
of an existing case record, and via
importing a list of cases into Sugar
using a .csv spreadsheet.

Viewing Cases
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing case
records, including via the Cases list
view and record view, the Recently
Viewed menu in the Cases module tab,
list view dashlets showing case
information, activity stream entries
concerning case updates or where a
user mentions a case, previewing cases
in the right-hand side panel, and reports
displaying case data.

Searching for Cases The Searching for Records section
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Global Search
List View Search
Creating a Filter
Saving a Filter

provides an introduction to the two
searching methods for locating cases:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Cases module.

Cases List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Cases
Activity Stream
Dashboards

The List View section walks through the
many elements of the Cases List View
layout which contains a filterable list of
all case records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Cases list view are described in the 
List View Mass Actions Menu and List
View Record Actions Menu sections of
this page.

Cases Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Record View section walks through
the many elements of the Cases Record
View layout which contains detailed
information about a single case record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Cases record view are
described in the Record View Actions
Menu section of this page. 

Note: When linking a record via the
Contacts subpanel, the Search and Add
Contacts drawer will automatically be
filtered to only display contact records
associated with the case's parent
account.

Editing Cases
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
case records, including inline via the
Cases record view, in full edit mode on
the record view, inline via the Cases
subpanel on related module records,
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inline via the Cases list view, and via the
Mass Update option on the list view.

Deleting Cases
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted cases, including via the Cases
record view, an individual record's
Actions menu on the Cases list view, and
the Mass Actions menu on the list view.

Exporting Cases The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of cases and all their
data as a .csv file for use outside of
Sugar (e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Cases The Finding Duplicate Records section
provides instructions for locating
duplicate case records. If searching on
matching fields (e.g. Subject) identifies
one or more duplicates, they can be
merged into a single record.

Merging Cases
Merging via List View

The Merging Records section provides
instructions for merging duplicate cases
which will combine field values and
related records into a single case.

Viewing Cases Historical Summaries The Viewing Record Historical
Summaries section describes the
Historical Summary record view option
which displays quick details of the case
record's related calls, meetings, emails,
notes, and tasks.

Viewing Cases Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the case's audited fields.

Cases PDFs
Downloading Cases PDFs
Emailing Cases PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
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email .pdf files of case information as
configured by an administrator via
Admin > PDF Manager.

Favoriting Cases
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking cases as favorites, including via
the Cases list view, Cases record view,
or any Cases subpanel appearing on the
record view of a related module.
Favoriting a case allows you to easily
access it from list views, dashlets, or the
Cases module tab.

Following Cases
Following via List View
Following via Record View

The Following Records section describes
the various methods of marking cases as
"Following", including via the Cases list
view and record view. Following a case
causes its activity stream updates to be
included on your Home page and Cases
list view activity streams so that you can
easily keep up with changes and user
posts on the record.

Sharing Cases The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the case record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the case's record
view.

Cases Tile View

Tile View allows users to visualize and engage with their cases in an intuitive drag-
and-drop interface. Users can drag a tile from one column to another to change its
status.
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To access Tile View, navigate to the Cases list view and click on the Tile View icon
next to the search bar:

For more information on using the Tile View, refer to the User Interface
documentation. For information on configuring Tile View layouts, refer to the Tile
View Settings documentation in the Administration Guide.

Case Menus

The Cases module contains various options and functionality which are available
via menus in the module tab, list view, and record view. The following sections
present each menu and its options with links to more information about each
option in the User Interface documentation or, for Cases-specific functionality,
within this page. 
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Module Tab Menus

The Cases module tab is typically found by clicking the "More" icon represented by
three vertical dots to the right of the module tabs on the navigation bar. The
additional modules will appear on the list and you can click "Cases" to access the
list view. Once the Cases tab displays on the navigation bar, you can click the
triangle within the tab to display the Actions, Recently Viewed, and Favorites
menu. The Actions menu allows you to perform important operations within the
module. The Recently Viewed menu displays the list of cases you most recently
viewed. The Favorites menu displays the list of cases you most recently marked as
favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Case Opens the record view layout to create a

new case
View Cases Opens the list view layout to search and

display cases
View Case Reports Displays existing reports based on the

Cases module
Import Cases Opens the import wizard to create or

update cases using external data

If you do not see the Cases module tab in Sugar, please check the following:

The Cases module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
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user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Cases module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Cases module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Cases
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Cases list view displays all case records and allows for searching and filtering
to locate specific cases. You can view the basic details of each record within the
field columns of the list view or click a case's name to open the record view. To
access a module's list view, simply click the module's tab in the navigation bar at
the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual case records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
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Mass Update Mass update one or more cases at a
time

Merge Merge two or more duplicate cases
Delete Delete one or more cases at a time
Export Export one or more cases to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual case directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this cases in the intelligence

pane
Edit Edit this case
Follow Follow this case
Delete Delete this case

Record View Actions Menu

The Cases record view displays a single case in full detail including its fields,
subpanels of related records, and activity stream. To access a case's record view,
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simply click a hyperlinked case name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this case.
Share Share a link to this case via email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Cases
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.
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This menu option is only visible
if the administrator has created
a PDF template for the Cases
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Create Article Converts information from the case to
the record view of a Knowledge Base
article. Please refer to the Knowledge
Base documentation for more
information.

Find Duplicates Locate potential duplicates of this case.
Copy Duplicate this case to create a new case

record.
Historical Summary View a historical summary of activities

(e.g. calls, meetings, etc.) related to this
case.

View Audit Log View a record of changes to this case.
Delete Delete this case.

Emails and Cases

Emails offer important functionality for working with cases in Sugar. Inbound
emails can automatically generate new cases. Once the case exists, Sugar can
automatically relate emails to a relevant case when the case macro is used. Emails
can also be manually related to cases using the email's Related To field. These
relationships allow the case's record view to display all relevant email
correspondence in the Emails subpanel and History dashlet.

Creating Cases via Inbound Email

Creating cases via emails provides users with added convenience in the case
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creation process and helps expedite the amount of time before the support team
can begin working on the issue. Cases can be automatically created when emails
are sent to a group mailbox account which is monitored by Sugar.

Administrators can create group mail accounts via Admin > Inbound Email. Group
mail accounts periodically poll an email account for new emails and import the
emails into Sugar. The group mail account can be configured to automatically
create a new case for each incoming email as well as to send an automatic reply
email including the generated case's number. For more information, please refer
to the Email documentation in the Administration Guide. 

Email Case Macro

Sugar has the ability to automatically relate emails to their relevant cases using a
case macro. The case macro is placed in the subject line of the email and contains
the case number. Administrators have the ability to alter the macro's format via
Admin > Inbound Email, but the default format is "[CASE:{number}]". The
formatting of the macro in email subjects is imperative for Sugar to properly
create the relationship. For example, a valid email subject line using the default
macro would be "Re: [CASE:123] System not responding". For more information on
configuring the case macro, please refer to the Email documentation in the
Administration Guide.

When Sugar automatically relates an email to a case because of a case macro
match, the case will be set in the email's Related To field. When viewing the case
in record view, the email will appear in both the History dashlet and Emails
subpanel.

Sugar will recognize the case macro and automatically relate the email to the
relevant case for any email entering Sugar in the following ways:

Group mail account : A group mail accounts is a monitored inbound
mailbox that is created via Admin > Inbound Email. This is a mailbox on
your company's mail server that Sugar is granted the ability to read. For
example, creating "support@mycompany.com" as a group mail account
means that any email with "support@mycompany.com" in the To or CC list
will be checked for a case macro and automatically related to the case in
Sugar. Support representatives can CC the address when corresponding
with customers to have the emails automatically archived and related to
the case in Sugar. Please note that if the account is configured to not
automatically import emails, the relationship to the case will not be formed
until a user imports it from the group inbox in the Emails module. //mention
on Admin Emails documentation. For more information on configuring a
group mail account, please refer to the Email documentation in the
Administration Guide.
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Sugar Email Archiving : Sugar Email Archiving must be configured and
enabled by administrators in Sugar via Admin > System Email Settings.
Once configured, an email address will be generated that is specific to your
instance of Sugar. When this email address receives an email, it scans the
email for any email addresses. The email is then imported into Sugar,
where the email is associated with any contact, lead, etc. containing an
email address on the email. When a case macro is included in the email's
subject, Sugar will also relate the email to the referenced case. For more
information on setting up Email Archiving, please refer to the Email
documentation in the Administration Guide.
Sent from within Sugar : Composing and sending an email from
anywhere within Sugar, including via the Emails module, clicking an email
address on any record, from the History dashlet, etc., will cause Sugar to
automatically search the subject for a case macro and relate the email to
the relevant case. For more information on composing emails within Sugar,
please refer to the Emails documentation.

Emails Subpanel

The Emails subpanel in the Cases module displays emails which are associated
with the case record in a variety of ways:

Related to the case : If the case is selected in the email's Related To field,
the email and case are related, and the email will appear in the case's
Emails subpanel and History dashlet. Instructions for using this flex relate
field are available in the Emails documentation.
Related to the case's related contacts : If the email is related, either
explicitly or implicitly, to a contact record which is related to the case, the
email will appear in the case's Emails subpanel and History dashlet.

Note: Administrators can enable or disable a case from displaying related contact
emails via Admin > Related Contacts Emails. For more information, please refer to
the Email documentation in the Administration Guide.

Sugar Portal and Cases

The Sugar Portal allows customers to view their organization's cases as well as
submit cases directly to Sugar. Please note that customers have to be registered
users of the portal in order to be able to submit cases to Sugar. For more
information on enabling and configuring the portal, please refer to the Sugar
Portal documentation. For information on using the portal, please refer to the 
Portal Deployment User Guide and Portal User Guide documentation.
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Note: When cases are created via the portal, the Source field in the case's record
view will automatically be set to "Portal" to indicate that the case originated from
the portal.

In addition to being used by your customers to view and submit cases, the Sugar
Portal can also be used as a method of communicating about cases between
customers and your organization. Utilizing the portal this way ensures that all case-
related communications between your users and contacts are stored in Sugar. This
communication is conducted via related note records which can be created by both
Sugar users and portal-enabled contacts. Sugar users can create and add notes to
the case via the Notes subpanel on the case's record view in Sugar. Please note
that cases created in Sugar will automatically appear in the portal as the Show in
Portal checkbox is enabled by default in the case's record view. But administrators
can have this field disabled by default via Admin > Studio. Customers can easily
add notes to the case as well by clicking the Add a Note button on the case's
record view in the portal. When a customer adds a note via the portal, the note
record will appear in the Notes subpanel of the case's record view in Sugar.
Likewise, when a Sugar user adds a note to a case in Sugar, the note record will
appear in the Notes panel of the case's record view in the portal. Please keep in
mind that notes attached to cases will automatically appear in the portal as the
Display in Portal checkbox is enabled by default in the note's record view. But
administrators can have this field disabled by default via Admin > Studio. These
notes will only be visible to other portal users within the customer's organization.

Contacts and Cases

On a case's record view, the Contacts subpanel is uniquely configured with an
intelligent filter. Sugar presumes that any contacts related to a case will belong to
the account already related to the case. Therefore, a filter for the case's account is
automatically applied to search results in the Contacts subpanel.
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The available contacts are automatically filtered to show those related to the case's
account:

In the event that a case should be linked to a contact from a different account, you
may override the default account filter by clicking on the X next to the account
name filter in the search bar or by removing the filter line item:

Knowledge Base Articles and Cases
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You can create Knowledge Base articles based on a bug or case. This is
particularly useful when the bug fix or situation will not be resolved until a later
date, but a workaround currently exits. Simply click "Create Article" in the Case
record view's Actions menu. The Knowledge Base record view layout will open and
include all of the relevant fields for your organization's articles. For more
information on creating knowledge base articles, please refer to the Knowledge
Base documentation.

In order for an article to be visible in the Sugar Portal, the article must meet both
of the following requirements:

External Article = Checked
Status = Published

Note: If either of these conditions is not met, the article will not be visible in the
Sugar Portal.

Last Modified: 2020-11-20 16:59:14

Knowledge Base

Overview

Sugar's Knowledge Base module provides the ability to create, maintain, and
publish information in the form of articles. Knowledge base articles can cover a
variety of topics such as troubleshooting or frequently asked questions. When used
for internal purposes, articles can be accessed via the Sugar instance by Sugar
users within your organization. When needed for external purposes, articles can
also be published to the Sugar Portal, providing visibility for customers or other
portal users.
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Articles can be rated based on their usefulness by both internal and external
readers to help you determine which articles should be improved or updated and
which should be promoted as valuable information. As you work to improve
articles, you can create revisions to keep a history of versions as well as to make
changes without immediately affecting published content. Articles can also be
localized to reach new audiences using a variety of languages. This documentation
will cover information and actions specific to the Knowledge Base module. For
instructions concerning views and actions which are common across most Sugar
modules, such as creating, editing, and deleting accounts, please refer to the 
Working With Sugar Modules section of this page.

Please note that you will only be able to see account records as allowed by your
team membership, user access type, and assigned roles. For more information on
teams and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide.

Article Fields

The Knowledge Base module contains a number of stock data fields that come out-
of-the-box with Sugar. For information on using and editing various field types,
refer to the User Interface documentation. The definitions below are suggested
meanings for the fields, but the fields can be leveraged differently to best meet
your organization's needs. Users with administrator or developer access have the
ability to alter, add, or remove fields via Admin > Studio. For more information on
configuring fields, please refer to the Studio documentation in the Administration
Guide.

Field Description
Active Revision Denotes the most up-to-date,

unpublished revision of an article. This
box is automatically set when a new
revision is created for an unpublished
article so that only the newest revision
will have it checked. Only revisions with
"Active Revision" checked will appear in
the Knowledge Base list view.
Note: If a revision is published, it will
retain the Active Revision designation
until a subsequent revision is published
in its place.

Approved By The Sugar user who is appointed to
approve the article
Note: When setting an article's status to
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"Approved", the Approved By field will
automatically be populated with your
name.

Attachments External files uploaded to the article
which can be downloaded from the
article via Sugar Portal

Author The Sugar user who owns the article
Note: The author defaults to the current
user.

Body The HTML content of the article
Category The category, or topic, the article

belongs to
Created By The Sugar user who created the article
Date Created The date that a user created the article
Date Modified The last date that a user modified the

article
Description A brief description of the article's

content
Expiration Date The date on which the article

information expired or will expire in the
future
Note: The status for published articles
will automatically change to "Expired"
on the specified expiration date.

External Article Indicates whether an article should be
visible through the Sugar Portal
Note: This field must be in a checked
state for an article to be visible through
the Sugar Portal.

View Count How many times the published article
has been viewed either via the Sugar
instance or Sugar Portal

Language The language used in the article
Modified By The Sugar user who last modified the

article
Publish Date The date the article was published or

will be published in the future
Note: The Publish Date field will
automatically default to today's date
when an article's status is set to
"Published".
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Related Case 1 The case record that inspired and is
associated with the article
Note: Creating an article from a case
causes the case to automatically
populate this field.

Status The current status of the article (e.g.
Draft, Expired, In Review, Published)
Note: The Status field must be set to
"Published" for an article to be visible
through the Sugar Portal.

Tags User-created keywords that can be used
to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the
article

Title The name of the article
Note: This field will be visible to
readers when the article is published.

1 This field's value is only visible to Sugar Serve, Enterprise, and Ultimate users;
when this field appears on layouts, users without a supported license type will see
a placeholder containing the text "License Required" instead of the field's value.
See the User Management page for more details on license types.

Article Statuses

When viewing an article's record view or the Knowledge Base list view, the Status
field will show a different color for each status. Administrators have the ability to
configure the status values via Admin > Dropdown Editor. For more information on
configuring the status values, please refer to the Developer Tools documentation in
the Administration Guide.

Please note that the below values are only guidelines for defining your status and
that you can skip one or more statuses based on your organization's needs.

Color Status Label Description
White Draft The article is

currently
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undergoing
changes

Yellow In Review The article is being
reviewed by the
designated
approver
Note: When the
status changes to
"In Review", a
notification email is
automatically sent
to the user who is
designated in the
Approver field.

Blue Approved The article has
been approved for
publish

Green Published The article is live in
the knowledge base

Gray Expired The article's
expiration date is in
the past
Note: The status of
published articles
will automatically
change to
"Expired" on the
specified expiration
date, but they will
remain visible in
the knowledge
base.

Working With Sugar Modules

While the Knowledge Base module has some features that only apply to knowledge
base records, it also uses the Sidecar user interface that most Sugar modules are
based on. In the table below, the left column contains links to the User Interface
page covering topics that are applicable to all Sidecar modules. The right column
has links to sections of the current page that cover topics specific to knowledge
base articles.
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General Instructions for Working
With Sugar Modules

Knowledge-Base-Specific
Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Knowledge-Base-specific help
exists for each topic, use the links below
to navigate to sections of the current
page.

Creating Records Creating Articles via Cases
Article Templates
Creating Categories

Viewing Records Viewing Published Articles by Category
Searching for Records Article Categories
List View List View Mass Actions Menu

List View Record Actions Menu
Categories List View

Record View Record View Actions Menu
Intelligence Pane Viewing Article Ratings

Viewing Useful Published Articles
Published Articles in Other Languages
Dashlet

Editing Records Publishing Articles
Article Attachments
Article Localizations
Article Revisions
Renaming Categories
Moving Categories

Deleting Records Deleting Revision Articles
Deleting Categories

Viewing Record Audit Logs
Record PDFs
Favoriting Records
Following Records
Sharing Records
Using the TinyMCE Text Editor

Article Menus

The Knowledge Base module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
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sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Knowledge Base-specific
functionality, within this page.

Module Tab Menus

The Knowledge Base module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs on the navigation
bar. The additional modules will appear on the list and you can click "Knowledge
Base" to access the list view. Once the Knowledge Base tab is visible in the
navigation bar, you may click the triangle in the tab to display the Actions,
Recently Viewed, and Favorites menus. The Actions menu allows you to perform
important actions within the module. The Recently Viewed menu displays the list
of articles you most recently viewed. The Favorites menu displays the list of
Knowledge Base records you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Article Opens the record view layout to create a

new article
Create Template Opens the record view layout to create a

new template
Note: This option is only available to
administrators.

View Articles Opens the list view layout to search and
display articles

View Categories Opens the list view layout to search and
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display categories
View Templates Opens the list view layout to search and

display templates
Note: This option is only available to
administrators.

Settings Opens the Knowledge Base language-
configuration settings
Note: This option is only available to
administrators.

If you do not see the Knowledge Base module tab in Sugar, please check the
following:

The Knowledge Base module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed.
Navigate to your user profile (upper right of Sugar), click the Advanced
tab, and check the Layout Options section. If you see the Knowledge Base
module in the Hide Modules list, simply move it to the Display Modules list.
For more information on hiding and displaying modules, please refer to the 
Layout Options section of the Getting Started documentation.
The administrator may have disabled the Knowledge Base module for your
entire Sugar instance. Reach out to your Sugar administrator to have the
Knowledge Base module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Knowledge Base list view displays all knowledge base records and allows for
searching and filtering to locate specific articles. You can view the basic details of
each record within the field columns of the list view or click an article's name to
open the record view. To access a module's list view, simply click the module's tab
in the navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual article records or click the
checkbox in the list header to select all records displayed on the current set of list
view results.

                       820 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Knowledge_Base_Administration
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Knowledge_Base_Administration#Settings
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Getting_Started#Layout_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools#Display_Modules_and_Subpanels
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface#List_View


 

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more articles at a

time
Delete Delete this article

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual article directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Edit Edit this article
Create Localization Copy this article in order to adapt it for

a different audience via another
language
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Create Revision Create a new or corrected version of the
original article

Delete Delete this article

Record View Actions Menu

The Knowledge Base record view displays a single article in full detail including its
fields, subpanels of related records, and activity stream. To access an article's
record view, simply click a hyperlinked article name from anywhere within Sugar.
The record view's Actions menu appears on the top right of the page and allows
you to perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this article.
Create Localization Copy this article in order to adapt it for

a different audience via another
language.

Create Revision Create a new or corrected version of the
original article

Share Share a link to this article via email. 

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.
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This menu option is only visible
if the administrator has created
a PDF template for the
Knowledge Base module via
Admin > PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.

This menu option is only visible
if the administrator has created
a PDF template for the
Knowledge Base module via
Admin > PDF Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Copy Duplicate this article.
View Audit Log View a record of changes to this article's

fields.
Delete Delete this article.

Sugar Portal and Articles

The Sugar Portal allows your customers and partners to read and vote on the 
usefulness of knowledge base articles. 

Note: Only registered users of your Sugar instance's portal can log in to view and
rate articles. For more information on enabling and configuring the portal and
portal users, please refer to the Sugar Portal documentation. For information on
using the portal, please refer to the Portal Deployment User Guide and Portal User
Guide documentation.
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To make an article visible in portal, enable the article's "External Article"
checkbox, specify an Expiration Date for a future date, and ensure that the article's
status is "Published".

Publishing Articles

Publishing a completed article allows you to make it visible on the Sugar Portal for
your customers and others outside of your Sugar users to view. For knowledge
base consumers within your organization who are Sugar users, publishing also
changes the article's status and designates that version as the active revision,
making it available in the knowledge base list view until a subsequent revision is
published. This enables your internal users to access knowledge base content
within Sugar by browsing the Knowledge Base Categories & Published Articles
dashlet or the Knowledge Base list view.

Articles can be published manually or scheduled to be published automatically on a
future date. Publishing will check the article's Active Revision checkbox, making it
available in the Knowledge Base list view even if a related revision was previously
considered the active revision. Once an article has been published, the published
version will retain the Active Revision designation when new revisions are created.
Only when another revision is published in its place will the Active Revision
designation be transferred. If an article is already published, publishing a related
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revision will also cause the original article's status to be changed to "Expired". For
more information about revisions, please refer to the Article Revisions section of
this page.

Publishing Articles Immediately

To publish an article, simply edit the Status field to "Published" and save the
record. If you want the article to be visible in the Sugar Portal, make sure the
External Article box is checked. The Publish Date field will automatically set to
today's date.

Scheduling a Future Publish

To schedule an article to publish in the future, set the Publish Date field to a date
in the future, change the Status field to "Published", and save the record. If you
want the article to be visible in the Sugar Portal, make sure the External Article
box is checked. On the specified publish date, the article's status will change to
"Published" and the article will automatically become visible.
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Viewing Published Articles by Category

While the Knowledge Base list view allows you to locate articles using traditional
search, filter, and sorting, Sugar also allows you to navigate the hierarchical
structure of categories to locate published articles. The Knowledge Base
Categories & Published Articles dashlet can be added to the Knowledge Base list
view and record view intelligence panes. When it is included on the Knowledge
Base record view and you are viewing a published article, it will automatically
open to display the current article. This is a convenient way to confirm the
placement of a published article in your category hierarchy.

Folder icons represent categories while document icons represent articles. Blue
folders indicate that a category contains child categories or published articles;
clicking the blue folder will expand it to display the category's contents. White
folders, on the other hand, may not be expanded since they indicate that the
category has no child categories or published articles. To collapse an expanded
category, simply click the open folder icon. Clicking an article's name will open the
article in record view.

Creating Articles via Cases

Sugar allows you to create an article based on the details of a case record. This is
useful when a resolution to a problem is documented in a case. Creating an article
from such records enables you to make this information available without manually
copying from the case. The new article's Title field is based on the case's Subject
field, and the article's body is automatically populated with the case's number,
subject, description, and resolution. The case will automatically be set in the new
article's Related Case field. For more information on working with cases, please
refer to the Cases documentation.

Use the following steps to create an article from a case record:

1. Navigate to a case's record view.
2. Select "Create Article" from the Actions menu.
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3. Update the necessary fields and then click "Save".

Article Templates

Administrators have the ability to create templates to improve consistency or ease
access to common or brand elements across your organization's knowledge base.
Knowledge Base templates can contain text, HTML content, and images including
embedded .jpg or .png image files. Existing templates can then be used by regular
users when creating articles to improve article consistency and quality while
reducing the amount of time they must spend. For more information on how
administrators can work with article templates, please refer to the Knowledge
Base Administration documentation in the Administration Guide. 

Applying Templates to Articles

You can apply an existing template when creating or editing a Knowledge Base
article. From the article's record view, click on the Templates button located above
the toolbar in the Body field. A Search and Select drawer will appear where you
can choose the desired template record. The selected template's content will then
appear in the Body field of the knowledge base article.

Note: If the Body field already contains content prior to selecting a template, you
will receive a message requesting confirmation before the selected template can
be applied. Select "Cancel" to disregard the template or "Confirm" to overwrite any
existing content with the template's content.
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Article Ratings

Reader feedback is important to gather and consider when working on knowledge
base articles. In Sugar, both internal and external users have the ability to vote
whether an article is useful or not. Internal users will find the Useful and Not
Useful buttons on the article's record view. Sugar Portal users will find the same
icons when viewing the article in the portal. Each time a new revision is created, it
starts with zero votes, effectively wiping the slate for your improved or updated
content.

Viewing Article Ratings

As users vote an article as useful or not useful, the clicks are tallied within Sugar
and can be viewed via a dashlet on the article's record view. The Usefulness for
Articles dashlet may be added to the Knowledge Base record view's intelligence
pane to display the aggregated usefulness of the current article. It totals the
Useful and Not Useful votes that the article has received and shows the
percentage of Useful votes on top of a visual depiction of the ratio. The red portion
represents Not Useful votes while the Useful votes are shown in green. Hovering
on the green or red portions displays the exact percentage and number of
corresponding votes.
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Viewing Useful Published Articles

The Most Useful Published Knowledge Base Articles dashlet displays a list of top-
rated published articles based on usefulness ratings and view count. Article
usefulness is tallied via clicks on the Useful and Not Useful icons. The view count
is the total number of views an article has received as shown in the View Count
field. This dashlet displays the top three articles in descending order according to
their rating. Click "More most useful published knowledge base articles" at the
bottom of the dashlet to see additional articles. To view the details of an article
listed in this dashlet, click on the article's name to navigate to its record view.

Article Attachments
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Articles can include attached files which will then be available for download by the
article's viewers. In an article's record view, one or more files can be uploaded to
the Attachments field. Then, when users view the published article, they will have
the option to download a single attachment by either clicking the pill that contains
the name of the attached file or by clicking "Download".

When multiple attachments exist on a single article, users viewing the article will
have the option to download a single attachment or all attachments at once. They
may click the pill that contains the name of the single file for download or click
"Download All" to download a .zip file containing all of the attachments to their
computer.

Article Localizations

A localization is a copy of an article that has been adapted for a different audience,
usually via translation to another language. Administrators must first add desired
languages to the Knowledge Base module as described in the Knowledge Base
Administration documentation. Once languages are configured in your instance,
users may create localizations which will copy all populated fields from the original
article except for the Status and Language fields. This allows users to re-write the
article's contents in various languages to accommodate different target audiences.

Note: If an administrator deletes a language from the Knowledge Base module's
Settings page, all localization articles associated with the deleted language will
also be deleted.

Creating Localization Articles

A localization article can be created from the Knowledge Base list view, the
article's record view, or the Localizations subpanel. There are many ways users
can create a new localization:

To create a localization article from a Knowledge Base article's record
view, click the Actions menu and select "Create Localization".

To create a localization article from the Knowledge Base article list view,
click the article row's Actions menu and select "Create Localization".
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To create a localization article from the Localizations subpanel on a
Knowledge Base article's record view, click the Plus icon.

A drawer will appear with a copy of the original article details except for the
Language and Status fields. The Status field will automatically be set to "Draft".
Users should choose the appropriate language and, optionally, edit the status and
any other desired field. Clicking "Save" will finalize the new localization article,
and it will appear within the Knowledge Base list view and on the parent article's
record view within the Localizations subpanel.
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Localizations Subpanel

A localization article is a copy of an article that has been adapted for a different
audience via translation to another language. The Localizations subpanel displays
all localizations related to the article and allows the following operations to be
performed:

Localization Details : To view the details of a related localization article,
click the article's name in the subpanel to open it in record view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of localizations currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more localizations than currently
displayed. Click the hyperlinked number to see the total count of related
records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable the sticky feature and
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the User Interface section of the 
System documentation in the Administration Guide.

Column Widths : Place your cursor on the column divider and, when the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Create a New Localization : Click the Plus button on the upper right of a
subpanel to create a new localization for the article you are currently
viewing.

Note: Because creating a new related record opens a draw on top
of the current record view, you should use the Cancel button to
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return to record view. Using the browser's back button will return
you to the previous page.

Favorites Designation : Click the star on the left of a record's row to
toggle it as a favorite. A dark grey star indicates that the record is a
favorite while a white star indicates it is not. For more information, please
refer to the User Interface page.
Hyperlink Fields : Blue field values, such as record names, may be clicked
to open the record in record view. Record view provides a complete picture
of the record and is described in detail in the User Interface page. Email
addresses also appear in blue and can be clicked to compose an email to
that recipient.
Record Actions Menu : Click the triangle on the right of a record's row to
access the Record Actions Menu which includes the following options:

Preview : To preview a record by displaying its fields and activity
stream in the right-hand side drawer, click the Eye icon to the far
right of the record's row. For more information, please refer to the 
User Interface page.
Create Revision : To create a new revision of the localized article,
choose "Create Revision" from the actions menu on the far right of
the record's row, then complete the record view layout and click
"Save".
Edit : To inline edit the record directly within the subpanel, choose
"Edit" from the Actions menu on the right of the record's row and
click "Save" to preserve the changes.

More Records : By default, Sugar displays up to five records in each
subpanel though administrators can alter the number via Admin > System
Settings as described in the System documentation in the Administration. If
additional related records exist, click "More <Module Name>..." (e.g.
"More Accounts...") at the bottom of the subpanel to load the next set.

Published Articles in Other Languages Dashlet

The Published Articles in Other Languages dashlet displays all published
localization articles related to the current article you are viewing. From this
dashlet, you can view who created each localization and when they created it, as
well as which language is related to each localization via the language code icon
located to the right of the article's name. This two-letter icon corresponds with the
language code you administrator has specified in the Settings. To access an
article's record view, click on the article's name directly from the dashlet.
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Article Revisions

As you improve or update your knowledge base content, Sugar allows you to create
revisions. Revisions are a set of articles that are versions of the same content. They
allow you to keep a history of past versions as well as to make content changes
without affecting the published version. One revision of each set of related
revisions will be designated as the active revision using the Active Revision
checkbox. Only article revisions with the Active Revision field checked are
displayed in the Knowledge Base list view while the others will only be visible in
the Revisions subpanel. If an article is not yet published, creating a new revision
will cause the Active Revision designation to transfer to the newest revision. Once
an article has been published, the published version will retain the Active Revision
designation when new revisions are created. Only when another revision is
published in its place will the Active Revision designation be transferred. For more
information about how publishing affects revisions, please refer to the Publishing
Articles section of this documentation.

Creating Revision Articles

When a revision is created, it duplicates all fields from the original article except
for the Status field, which will default to "Draft". Please note that the Date Created
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field of all revisions will match the date the original article was created. The Date
Modified fields will, however, reflect the most recent edit of the particular revision.
A revision can be created from the Knowledge Base list view, the article's record
view, the Revisions subpanel, or the Localizations subpanel.

To create a revision from an article's record view, click the Actions menu and
select "Create Revision".

To create a revision from the list view, click the record Actions menu and select
"Create Revision".

To create a revision from the Revisions subpanel, click the Plus icon.

To create a revision from the Localizations subpanel, click the record Actions menu
and select "Create Revision".
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Deleting Revision Articles

Deleting an article from the Knowledge Base list view only deletes the active
revision. Another revision, if available, is then promoted to be the active revision.
In order to delete an article revision which is not marked as the active revision,
you must click on its name in the revisions subpanel, then select "Delete" in the
record view's actions menu.

Revisions Subpanel

The Revisions subpanel is available on each article's record view and displays all
revisions related to the article. The subpanel allows the following operations to be
performed:
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Revision Article Details : To view the details of a related revision, click
the article's name in the subpanel to open it in record view.
Record Count : Subpanel headers display the total count of related
revisions (e.g. "5 of 6+") next to the module name. The count captures the
number of revisions currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more revisions than currently
displayed. Click the hyperlinked number to see the total count of related
revisions.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation in the
Administration Guide.

Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Create a New Revision : Click the Plus button on the upper right of the
subpanel to create a new revision for the article you are currently viewing.

Note: Because creating a new revision opens a draw on top of the
current record view, you should use the Cancel button to return to
record view. Using the browser's back button will return you to the
previous page.

Favorites Designation : Click the star on the left of a revision's row to 
toggle it as a favorite. A dark grey star indicates that the revision is a
favorite while a white star indicates it is not.
Record Actions Menu : Click the triangle on the right of a revision's row
to access the Record Actions Menu which includes the following options:

Preview : To preview a revision by displaying its fields and activity
stream in the right hand side drawer, click the Eye icon to the far
right of the revision's row.
Edit : To inline edit the revision directly within the subpanel,
choose "Edit" from the Actions menu on the right of the revision's
row and click "Save" to preserve the changes.

Note: The new subpanel order will reset when the user's browser cache is
cleared.
More Records : By default, Sugar displays up to five revisions in each
subpanel, though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related revisions exist, click "More {Module Name}..."
(e.g. "More Emails...") at the bottom of the subpanel to load the next set of
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records.

For more information on revisions, please refer to the Revisions section of this
documentation.

Article Categories

Categories provide a way to group knowledge base articles so that writers, as well
as viewers, can easily locate desired articles and related topics. Each article can
belong to one category, and a category can have many articles. Categories can also
have child or parent categories, allowing for a hierarchical structure of categories
and sub-categories. Categories can be viewed in the Categories list view and in the
Knowledge Base Categories & Published Articles dashlet. Clicking on a category's
hyperlink in the Knowledge Base list view or an article's record view will open a
drawer containing all articles belonging to that category, providing a convenient
way to view and open articles. Alternatively, you can directly filter the Knowledge
Base list view for a particular category. For more information about filtering list
views, please refer to the Search documentation.

Categories List View

Click the triangle in the Knowledge Base module tab then select "View Categories"
from the menu to open the Categories list view.

In the Categories list view, you can view all knowledge base categories and their
subcategories by expanding the Categories tree view or search for categories by
title in the search bar. Grey folder icons indicate that a category contains
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subcategories while white folder icons represent categories with no children.
Clicking the grey folders, as opposed to the category name, will reveal its
subcategories. You can perform actions on an individual category by clicking the
triangle to the right of a category's row in the list view.

Each category's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Add Subcategory (Plus icon) Create a new category as a child of this

category
Edit Edit the name of the category
Delete Delete the category
Move Down Move the category down in the tree
Move To Move the category to a parent folder
Move Up Move the category up in the tree

Creating Categories

Categories and subcategories can be created from the Categories list view, and top-
level categories can be created from the Category field within an article's record
view.

Creating via Categories List View

Use the following steps to create a category from the Categories list view:
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1. Select "View Categories" from the Knowledge Base module tab's Actions
menu.

2. Click "Create" and enter the category name in the new row which appears.
Press the Enter key to save.

3. To create a subcategory, select the "+" to the far right of the category's
row and enter the name of the new child row which appears. Press the
Enter key to save.

Creating via Category Field

Use the following steps to create a top-level category from the Category field while
creating or editing a knowledge base article. Please note that this method does not
allow for creating subcategories:

1. Create a new article or edit an existing article in the Knowledge Base
module.

2. Click the Categories field and select "Create a category" in the bottom left
corner of the dropdown.
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Alternatively, select the expand icon located in the bottom right corner to
open the Search and Select Categories drawer and click "Create" in the top-
right corner of the drawer that opens.

3. Type the desired category's name into the open text box which appears and
press the Enter key to save the new category.

4. Select the new category's name in the dropdown to select it for the current
knowledge base article. If you do not wish to change the category of the
current article, click outside of the Category field's dropdown.

Renaming Categories

Categories may be renamed via the Categories list view and the Categories field in
an article's record view. To rename a category from the Categories list view,
simply click the triangle to the far right of the category row and select "Edit". Type
the new category name followed by the Enter key to save your change.
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You can also rename categories while editing or creating an article. Click the
category field to open the dropdown and select the Expand icon located in the
bottom right corner. The drawer that opens allows categories to be renamed
similarly to the list view. After renaming desired categories, you can click "Cancel"
or select a category to relate to the current article.

Moving Categories

Users can change the order and hierarchy of categories via the Categories list
view. Categories and subcategories can be moved up, down, or into a different
folder. This can be accomplished through the drag and drop method or through the
move options in the Record Actions menu.

Moving via Drag and Drop

To drag and drop a category to a new position in the Categories tree view, click
and hold the category and drag it to the desired location. A category can be moved
into a new position in the main tree view or into a different folder. A checkmark
will appear beside the category name when the category is in a successful drop
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position.

Moving via Record Actions Menu

To move a category using the Record Actions menu, click the triangle located on
the right of the category's row. The menu presents the following three options for
moving categories:

Move Up : Moves the category up one position within its current folder
Move Down : Moves the category down one position within its current
folder
Move To : Moves the category to be the child of another category

Deleting Categories

Categories can be deleted via the Categories list view and the Category field in an
article's record view. Use caution when deleting a category because it will not only
delete the current category, it will also delete all of its subcategories. When a
category is deleted, any articles belonging to the category will have empty
Category fields. While the Category field is not required, it is useful for organizing

                       843 / 1.116



 

articles. It is recommended to associated articles be assigned a new category using
mass update prior to the deletion.

Note: When a parent category is deleted, all subcategories are automatically
deleted as well.

To delete a category and its child subcategories from the Categories list view,
simply click the triangle to the far right of the category row and select "Delete".

You can also delete categories while editing or creating an article. Click the
category field to open the dropdown and select the Expand icon located in the
bottom right corner. The drawer that opens allows categories to be deleted
similarly to the list view. After deleting unwanted categories, you can click
"Cancel" or select a category to relate to the current article.
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Overview

Sugar's Bugs module is used to track and manage product-related problems,
commonly referred to as bugs, defects, or feature requests, either found internally
or reported by customers. As a bug is reported, worked on, and resolved, its
progress will be denoted by the Status field. Each bug record may relate to other
Sugar records such as calls, contacts, and cases, making it easy to get the full
picture of a customer's issues and history. If enabled, contacts can view and
submit bugs via the Sugar Portal along with cases and knowledge base articles.
This documentation will cover information and actions specific to the Bugs module.
For instructions concerning views and actions which are common across most
Sugar modules, such as creating, editing, and deleting bugs, please refer to the 
Working With Bugs section of this page. 

Please note that you will only be able to see bug records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation in the Administration Guide. 

Note: The Bugs module is not available for Sugar Sell users. For more information
on license types and the functionality available for each type, refer to the User
Management documentation. 

Bug Fields

The Bugs module contains a number of stock fields which come out-of-the-box with
Sugar. For information on using and and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Assigned To The Sugar user assigned to the bug
Business Hours to Resolution 1 The calculated duration in business

hours from the moment the bug is
created until its Status field is set to
"Closed" or "Rejected". Reopening the
bug does not clear this field's value, but
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it is updated each time the bug is
closed.

Category The general area of the product or
service where the bug was discovered

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Date Created The date the bug was created
Date Modified The date the bug was last modified
Description Explanation of the details and

reproduction steps of the bug when
submitted

Fixed in Release The version of product where the bug
was fixed

Follow Up Date The internal follow-up date regarding
the status of the bug

Found in Release The version of product where the bug
was found

Hours to Resolution 1 The calculated duration in calendar
hours from the moment the bug is
created until its Status field is set to
"Closed" or "Rejected". Reopening the
bug does not clear this field's value, but
it is updated each time the bug is
closed.

Number An automatically incremented number
to identify every bug, which cannot be
edited through Sugar

Pending Processing A system-level checkbox field. It is not
available in Studio or the user interface
and is only available in SugarBPM.

Priority Specify the urgency of the bug from this
dropdown list

Resolution Results of the investigation of the bug
and how it can be fixed
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Show in Portal Bugs created in Sugar will be visible in
the portal by default
Note: Administrators can have this field
disabled by default via Admin > Studio.

Source The method in which this bug was
submitted, (e.g. internal, customer
email, portal, etc.)

Status Specify the status of the bug as it moves
along the process from submission to
resolution

Subject Brief statement of the problem
Tags User-created keywords that can be used

to identify records in filters, dashlets,
and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the bug
Type Type of categorization that this bug falls

in to (e.g. Defect, Feature, etc.)
Work Log Free form field to add activities and

actions while working on the bug

1 This field's value is only visible to Sugar Serve users; when this field appears on
layouts, users without a supported license type will see a placeholder containing
the text "License Required" instead of the field's value. See the User Management
page for more details on license types.

Working With Bugs

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Bugs section describe Bugs-
specific behaviors and functionality.

Content Link Description
Creating Bugs
Basic Bug Creation
Creating via Quick Create
Creating via Subpanels

The Creating Records section covers the
various methods of creating new bug
records, including via the Create button
in the Bugs module, via the Quick
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Creating via Duplication
Importing Bugs

Create menu on the upper right of every
Sugar page, via the Bugs subpanel on
related module records, via duplication
of an existing bug record, and via
importing a list of bugs into Sugar using
a .csv spreadsheet.

Viewing Bugs
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Activity Streams
Viewing via Preview
Viewing via Reports

The Viewing Records section describes
the various methods of viewing bug
records, including via the Bugs list view
and record view, the Recently Viewed
menu in the Bugs module tab, list view
dashlets showing bug information,
activity stream entries concerning bug
updates or where a user mentions a
bug, previewing bugs in the right-hand
side panel, and reports displaying bug
data.

Searching for Bugs
Global Search
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to the two
searching methods for locating bugs:
global search, which searches across all
Sugar modules, and list view search,
which searches and filters within the
Bugs module.

Bugs List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Bugs
Activity Stream
Dashboards

The List View section walks through the
many elements of the Bugs List View
layout which contains a filterable list of
all bug records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Bugs list view are described in the 
List View Mass Actions Menu and List
View Record Actions Menu sections of
this page.

Bugs Record View
Favorite Designation
Next or Previous Record
Actions Menu

The Record View section walks through
the many elements of the Bugs Record
View layout which contains detailed
information about a single bug record.
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Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Bugs record view are
described in the Record View Actions
Menu section of this page.

Editing Bugs
Editing Inline via Record View
Editing via Record View
Editing Inline via Subpanels
Editing Inline via List View
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
bug records, including inline via the
Bugs record view, in full edit mode on
the record view, inline via the Bugs
subpanel on related module records,
inline via the Bugs list view, and via the
Mass Update option on the list view.

Deleting Bugs
Deleting via Record View
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted bugs, including via the Bugs
record view, an individual record's
Actions menu on the Bugs list view, and
the Mass Actions menu on the list view.

Exporting Bugs The Exporting Records section provides
an introduction to the export
functionality which allows you to
download a list of bugs and all their data
as a .csv file for use outside of Sugar
(e.g. in Microsoft Excel).

Recalculating Calculated Values The Recalculating Calculated Values
section provides instructions on utilizing
the Recalculate Values list view option
to update calculated field values in the
module if the administrator has changed
the field's formula via Admin > Studio.

Finding Duplicate Bugs The Finding Duplicate Records section
provides instructions for locating
duplicate bug records. If searching on
matching fields (e.g. Subject) identifies
one or more duplicates, they can be
merged into a single record.

Merging Bugs
Merging via List View

The Merging Records section provides
instructions for merging duplicate bugs
which will combine field values and
related records into a single bug.
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Viewing Bug Historical Summaries The Viewing Record Historical
Summaries section describes the
Historical Summary record view option
which displays quick details of the bug
record's related calls, meetings, emails,
notes, and tasks.

Viewing Bug Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the bug's audited fields.

Bug PDFs
Downloading Bug PDFs
Emailing Bug PDFs

The Record PDFs section provides
instructions for these record view
options which allow you to download or
email .pdf files of bug information as
configured by an administrator via
Admin > PDF Manager.

Favoriting Bugs
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking bugs as favorites, including via
the Bugs list view, Bugs record view, or
any Bugs subpanel appearing on the
record view of a related module.
Favoriting a bug allows you to easily
access it from list views, dashlets, or the
Bugs module tab.

Sharing Bugs The Sharing Records section provides
instructions for the Share record view
option which composes an email with a
link to the bug record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the bug's record
view.

Bug Menus

The Bugs module contains various options and functionality which are available via
menus in the module tab, list view, and record view. The following sections present
each menu and its options with links to more information about each option in the
User Interface documentation or, for Bugs-specific functionality, within this page.

Module Tab Menus
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The Bugs module tab is typically found by clicking the arrow to the right of the
module tabs on the navigation bar. The additional modules will appear on the list
and you can click "Bugs" to access the list view. Once the Bugs tab displays on the
navigation bar, you can click the triangle within the tab to display the Actions,
Recently Viewed, and Favorites menu. The Actions menu allows you to perform
important operations within the module. The Recently Viewed menu displays the
list of bugs you most recently viewed. The Favorites menu displays the list of bugs
you most recently marked as favorites.

The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Report Bug Opens the record view layout to create a

new bug
View Bugs Opens the list view layout to search and

display bugs
View Bug Reports Displays existing reports based on the

Bugs module
Import Bugs Opens the import wizard to create or

update bugs using external data

If you do not see the Bugs module tab in Sugar, please check the following:

The Bugs module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Bugs module in the Hide Modules list,
simply move it to the Display Modules list. For more information on hiding
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and displaying modules, please refer to the Layout Options section of the
Getting Started documentation.
The administrator may have disabled the Bugs module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Bugs
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Bugs list view displays all bug records and allows for searching and filtering to
locate specific bugs. You can view the basic details of each record within the field
columns of the list view or click a bug's name to open the record view. To access a
module's list view, simply click the module's tab in the navigation bar at the top of
any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual bug records or click the
checkbox in the list header to select all records displayed on the current set of list
view results

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
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Mass Update Mass update one or more bug at a time
Delete Delete one or more bug at a time
Merge Merge two or more duplicate bug
Export Export one or more bugs to a CSV file
Recalculate Values (Available in certain circumstances)

Updates calculated values to reflect
changes to calculated fields made in
Studio

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual bug directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this bug in the intelligence

pane
Edit Edit this bug
Delete Delete this bug

Record View Actions Menu

The Bugs record view displays a single bug in full detail including its fields,
subpanels of related records, and activity stream. To access a bug's record view,
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simply click a hyperlinked bug name from anywhere within Sugar. The record
view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allows you to perform the following operations:

Menu Item Description
Edit Edit this bug.
Share Share a link to this bug via email.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Download PDF Download the record's information as a
PDF file.

This menu option is only visible
if the administrator has created
a PDF template for the Bugs
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Email PDF Email the record's information as a PDF
attachment.
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This menu option is only visible
if the administrator has created
a PDF template for the Bugs
module via Admin > PDF
Manager.
Clicking on this menu item will
expand and contract the menu to
reveal or hide the available PDF
templates.

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings. 

Create Article Converts information from the case to
the record view of a Knowledge Base
article. Please refer to the Knowledge
Base documentation in the Application
Guide.

Find Duplicates Locate potential duplicates of this bug.
Copy Duplicate this bug.
Historical Summary View a historical summary of activities

(e.g. calls, meetings, etc.) related to this
bug.

View Audit Log View a record of changes to this bug.
Delete Delete this bug.

Sugar Portal and Bugs

The Sugar Portal allows customers to view bugs as well as submit bugs directly to
Sugar. Please note that customers have to be registered users of the portal in
order to access it. For more information on enabling and configuring the portal,
please refer to the Sugar Portal documentation. For information on using the
portal, please refer to the Portal Deployment User Guide and Portal User Guide
documentation.

In addition to being used by your customers to view and report bugs, the Sugar
Portal can also be used as a method of communicating about bugs between
customers and your organization. Utilizing the portal this way ensures that all bug-
related communications between your users and contacts are stored in Sugar. This
communication is conducted via related note records which can be created by both
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Sugar users and portal-enabled contacts. Sugar users can create and add notes to
the bug via the Notes subpanel on the bug's record view in Sugar. Please note that
bugs created in Sugar will automatically appear in the portal as the Show in Portal
checkbox is enabled by default in the bug's record view. But administrators can
have this field disabled by default via Admin > Studio. Customers can easily add
notes to the bug as well by clicking the Add a Note button on the bug's record view
in the portal. When a customer adds a note via the portal, the note record will
appear in the Notes subpanel of the bug's record view in Sugar. Likewise, when a
Sugar user adds a note to a bug in Sugar, the note record will appear in the Notes
panel of the bug's record view in the portal. Please keep in mind that notes
attached to bugs will automatically appear in the portal as the Display in Portal
checkbox is enabled by default in the note's record view. But administrators can
have this field disabled by default via Admin > Studio. These notes will be visible
to anyone with access to the portal.

Emails and Bugs

Bugs may be related to emails by being selected in the email's Related To field.
These relationships allow the bug to display all relevant email correspondence in
the Emails subpanel and in the History dashlet on a bug's record view. 
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Emails Subpanel

The Emails subpanel in the Bugs module displays emails which are related to the
bug record via the email's Related To field. These emails will also appear in the 
History dashlet on a bug's record view.

The Emails subpanel allows the following functions to be performed:

Email Details : To view the details of an email, click the subject to open it
in detail view.
Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.
Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

Note: Administrators can choose to disable collapse stickiness or to
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation in the
Administration Guide.

Column Widths : Place your cursor on the column divider. When the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.
Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).
Compose a New Email : Click the Plus button on the upper right of a
subpanel to create a new email with, by default, a relationship to the bug
you are currently viewing. The email will automatically select the bug in
the Related To field.

To send email from Sugar, users must configure their outbound
email server via Emails > Email Settings or, if using the system
email account to send email, the system's outbound email server
must be configured by an administrator in Admin > System Email
Settings.
Because creating a new related record opens a drawer on top of the
current record view, you should use the Cancel button to return to
record view. Using the browser's back button will return you to the
previous page.

More Records : By default, Sugar displays up to five records in each
subpanel, though administrators can alter the number via Admin > System
Settings as described in the System documentation of the Administration
Guide. If additional related records exist, click "More {Module Name}..."
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(e.g. "More emails...") at the bottom of the subpanel to load the next set of
records.

Creating a Knowledge Base Article

You can create knowledge base articles based on a bug or case. This is particularly
useful when the bug fix or situation will not be resolved until a later date, but a
workaround currently exists. Simply click "Create Article" in the Bug record view's
Actions menu. The Knowledge Base record view layout opens and includes all of
the relevant fields for your organization's articles. For more information on
creating knowledge base articles, please refer to the Knowledge Base
documentation.

In order for an article to be visible in the Sugar Portal, the article must meet both
of the following requirements:

External Article = Checked
Status = Published

Note: If either of these conditions is not met, the article will not be visible through
the Sugar Portal.
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Projects

Overview

Sugar's Projects module is used to track a variety of tasks in order for a project
manager to properly organize and complete a given project. Projects are tracked
using both a project grid and a Gantt chart. Resources (e.g. contacts and users)
can be allocated to the tasks of each project to help ensure your deadlines are met.
Projects are also able to be associated to different accounts, contacts,
opportunities, or other modules so that if a project is a direct result of one of these
modules, such as the project being performed that was purchased through an
opportunity, the relationship will show and alternate details be made available.

The Projects module is not available for Sugar Serve and Sugar Sell users. For
more information on license types and the functionality available for each type,
refer to the User Management documentation. 

Note: This module is hidden by default. The administrator must enable it for your
use. 

Project Fields

The Projects module contains the following fields which enable users to create and
properly organize projects.

Field Description
Assigned to Enter the name of the user who has

ownership of the project, which is
assigned to you by default

Date Created The date the project record was created
Date Modified The date the project record was last

modified
Description Enter a brief description of the project
End Date The date when the project will be

completed
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Name Enter a name for the project
Priority Select the importance of the project

from the dropdown list, such as Low,
Medium, or High

Start Date Click the Calendar icon and select the
project start date

Status Select a value from the dropdown list
such as Draft, In Review, or Published to
show the approval status of the project

Team The Sugar team(s) assigned to the
project

Projects Module Tab

The Projects module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Projects list view. You may also click the
triangle on the tab to display the Actions and Recently Viewed menus. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of projects you last viewed in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Project Opens the edit view layout to create a

new project
Create Project Template Opens the edit view layout to create a

new project template
View Project List Opens the list view layout to search and

display projects
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View Project Templates Opens the list view layout to display
project templates

View Project Tasks Opens the list view layout to search and
display project tasks

View My Projects Dashboard Opens the Projects Dashboard

If you do not see the Projects module tab in Sugar, please check the following:

The Projects module may be marked as hidden in your user preferences,
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Projects module in the Hide Modules
list, simply move it to the Display Modules list and save. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Projects module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Projects
module displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation in
the Administration guide.

Creating Projects

There are three methods for creating projects in Sugar including via the Projects
module, quick create, and Project Templates. The full edit view layout opens when
creating the project directly from the Projects menu as well as via the Quick
Create menu and includes all of the relevant fields for your organization. You can
quick create a project while viewing an existing record (e.g. Accounts) of another
module and Sugar will automatically create a relationship between both records.
For example, if you are viewing an account record (e.g. ABC Company) and create
a new project via the Projects subpanel, the project record's Accounts subpanel
will automatically populate with "ABC Company", thus creating the relationship.
Please note that administrators can configure both the Edit View and Quick Create
layouts via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Creating via Projects Module

One of the most common methods of project creation is via the Create Project
option in the Projects module tab. This opens up the edit view layout, which allows
you to enter all the relevant information for the project.
Use the following steps to create a project via the Projects module:
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1. Click the triangle on the Projects module and select "Create Project".
2. Enter appropriate values for the fields in the edit view layout. All required

fields are marked with a red asterisk and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save". 

Creating via Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the quick create button on the upper right of all Sugar pages
to access the menu. You can also easily create new records from any Projects
subpanel on related module records.

Use the following steps to create a project via Quick Create:

1. Open the Quick Create menu on the upper right of any Sugar page and
select "Create Project". You can also quick-create projects using the
following methods:

From Projects Subpanel (Sidecar modules): 

From Projects Subpanel (Legacy modules):
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2. Enter appropriate values in the fields in the edit view layout. All required
fields are marked with a red asterisk and must be completed prior to
saving.

3. If creating the project via the Projects subpanel in a Legacy module and
additional fields are desired, click the Full Form button to use edit view
instead.

4. Once the necessary information is entered, click "Save". 

Creating via Project Template

Project Templates are used when a similar project is going to be configured time
and time again. See Project Templates for more information. After you have a
template already created, you can use the template to create additional projects,
following these steps:

1. Click the triangle on the Projects module tab and select "View Project
Templates".

2. While on the Project Template list view, click the name of your template to
open the template's detail view.

3. Select "Save as Project" from the Actions menu.

4. Change the name of your new project as need be and click "Save as New
Project", where you will be brought to the detail view of your new project.
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Viewing Projects

There are various options available for viewing projects in Sugar including via
Projects list view, Projects detail view, Projects Recently Viewed menu, the Project
Dashboard, dashlets, and reports. Please note that you will only be able to see
projects records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Teams
and Roles documentation in the Administration guide.

Viewing via List View

The Projects list view displays all project records meeting the current search
criteria. To access the list view, simply click the Projects module tab. While list
view shows key project fields, you can click the project's name to open the record
in detail view. For more information on viewing project via list view, please refer to
the Projects List View section.

Viewing via Detail View

The Projects detail view displays thorough projects information including all
project fields followed by subpanels of the project's related records belonging to
various modules. The detail view can be reached by clicking a project record's link
from anywhere in the application including from the Projects list view. For more
information on viewing projects via detail view, please refer to the Projects Detail
View section.

Viewing via Recently Viewed

As you work, Sugar will keep track of which projects and project templates you
have recently viewed. Click the triangle on the Projects module tab to see a list of
your most recently viewed projects and click each name to open the project in
detail view.

Viewing via Project Dashboard

The Project Dashboard allows users to view upcoming and overdue project tasks,
as well as any support cases related to projects the user is assigned to. It also
allows an option for users to view any upcoming or overdue project tasks that are
assigned to the user. The Project Dashboard can be reached by clicking the
appropriate link in the Projects module tab.
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The "My Projects Dashboard" panel shows four columns, showing projects that are
assigned to you, any overdue project tasks where the Finish Date is in the past,
any upcoming project tasks where the Start Date is within the next week, and any
cases that are open related to the project.

The "My Project Tasks" panel shows two columns, showing any overdue project
tasks assigned to you where the Start Date is in the past, any upcoming project
tasks assigned to you where the Finish Date is within the next week.

All record references, for projects, project tasks, or cases, on either panel, are
clickable and will bring you to either the detail view for the specific record or the
Gantt chart of the parent project.

Viewing via Dashlets

Sugar Dashlets allow users to get a quick view of various records, activities,
reports, etc. Dashlets may be added to a user's Home page or to the intelligence
pane of any module. You can view account information in List View dashlets
specific to the Projects module (e.g. My Projects dashlet). Clicking a project's
name from any dashlet will open the Project record view. For more information on
using dashlets and viewing account records via dashlets, please refer to the 
Intelligence Pane documentation.

Viewing via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding projects and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
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will be able to view the project record's detail view by clicking the project's name
in the report results. Please note that you can only directly access project detail
views with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Roles documentation in the
Administration guide. Check with your system administrator if you cannot access
the Reports module.

Searching Projects

The Projects list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Projects list view below.
Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Please note
that Sugar automatically appends the wildcard character (%) to the end of your
search phrase. This allows the system to retrieve all records that start with the
keyword entered in the search. If you would like to broaden the search, you can
use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.
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Note: Projects is hidden from Global Search by default. The administrator must 
enable it for your use.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Items : Select this box to return only records assigned to you.
My Favorites : Select this box to return only your favorite records.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a project name, Sugar will only return projects with a
matching name that are assigned to you. Once the search is complete, the relevant
results will populate in the list view below the search panel. To see all projects to
which you have access, simply click "Clear" and then "Search" to perform a blank
search with no filters. Please note that you will only be able to see projects as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

Administrators can configure what fields appear on the Projects Basic Search via
Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.
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The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Items" and enter in a project name to search, Sugar will only return projects with a
matching name that are assigned to you. When searching by a multiselect or
dropdown field (e.g. "Status"), however, Sugar will return records matching any of
these selections. Once the search completes, the relevant results will populate in
the list view below the search panel. To see all projects to which you have access,
simply click "Clear" and then "Search" to perform a blank search with no filters.
Please note that you will only be able to see projects as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Teams and Roles documentation in the
Administration guide.

Administrators can configure what fields appear on the Projects Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. Beginning with
version 6.5.0, Full Text Search may be used with Global Search to search
throughout nearly all fields and modules for an enhanced search experience. The
Global Search bar is located on the top right hand side of Sugar. You can click the
magnifying glass icon or hit Return/Enter to perform your search once the text
string is entered in the search box.
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To use global search, you need to first enter the keyword into the search box. With
Full Text Search enabled, pop-up results will begin appearing once you input three
or more characters. Clicking the magnifying glass icon or hitting your
Return/Enter key will cause Sugar to return exact matches for your keyword rather
than matches with words beginning with your keyword. When Full Text Search is
not enabled, results starting with your keyword will appear after clicking the
magnifying glass icon or hitting your Return/Enter key. For more information on
using and configuring Global Search, please refer to the Global Search section of
the Search documentation.

Regular Sugar users can configure some aspects of global search such as what
modules are displayed in the search results. For more information on configuring
your Global Search, please refer to the Search documentation. Administrators can
control additional elements of global search via Admin > Search and Admin >
Studio. For more information on administrator configuration of Global Search,
please refer to the Studio documentation as well as the Search section of the
System documentation in the Administration guide.

Projects List View

The Projects list view displays all projects meeting the current search criteria and
to which your user has access. You can view the basic details of each project
within the field columns. Please note that you will only be able to see projects as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Projects Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current

                       869 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Global_Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Advanced_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Field_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#Search
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Team_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/Search#Layout_Options
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Developer_Tools/Studio#Editing_Layouts


 

results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

Checkbox Selection

You can perform several actions on projects directly from the list view by first
selecting the desired records. To select individual projects on the Projects list
view, mark the checkbox on the left of each row. To select or deselect multiple
projects on the list view, use the options in the checkbox dropdown menu:

Select This Page : Selects all records shown on the current page of
project results.
Select All : Selects all records in the current search results across all
pages of project results.
Deselect All : Deselects all records that are currently selected.

Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

                       870 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#User_Interface


 

Menu Item Description
Delete Delete one or more projects at a time
Mass Update Mass update one or more projects at a

time
Export Export one or more projects to a CSV

file

Favorite Designation

Users have the option to mark project records as favorites via the list view as well
as the detail view. This allows users to designate records that are important or will
be viewed often so that they can easily be accessed via search or from the Projects
module tab. In the Projects list view, the star on the left of each record's row is
yellow once marked to indicate a favorite project. For more information on how to
mark records as favorites, please refer to the Favoriting Projects section of this
documentation.

More Information

Additional details for each project can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional project
information in addition to what appears in the display column fields. The resulting
pop-up window will show the Description field by default. The list of fields
appearing here may only be configured through a code-level customization.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.
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Projects Detail View

The Projects detail view displays thorough project information including all project
fields, which are grouped by default into the Overview and Other panels. You can
also view a project's related records (Activities, Opportunities, Cases, etc.), which
appear in subpanels beneath the project fields. The detail view can be reached by
clicking a project's link from anywhere in the application including from the
Projects list view.

Please note that you will only be able to view a project record according to your
team membership, user type, and role restrictions. For more information on teams
and roles, please refer to the Teams and Roles documentation in the
Administration guide. Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.

Actions Menu

The Actions menu on the top left of each project's detail view allows you to
perform various actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
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Edit Edit this project
Delete Delete this project
View Gantt View the project's Gantt chart
Save As Template Save this project as a template for

future use
Export To MS Project Export this project to an MPX file for

use with Microsoft Project

Favorite Designation

Users have the option to mark project records as a favorite via the detail view as
well as the list view. This allows users to designate records that are important or
will be viewed often as they can easily be accessed via search or from the Projects
module tab. In the Projects detail view, the star on the right of the record's name is
yellow once marked to indicate a favorite project. For more information on how to
mark records as favorites, please refer to the Favoriting Projects section of this
documentation.

Next or Previous Record

On the upper right of the Projects detail view, there are two buttons that allow you
to page through each project in the Project list view's current search results.
Clicking the Previous button displays the previous project of the current search
results while clicking the Next button displays the next project of the current
search results. The text in between shows which project result you are currently
viewing within the total number of current results.

Subpanels

Beneath a project's fields are subpanels containing all of the users and contacts
that are working on the project, the project's tasks that need to be done, any
holidays or days off of the project so they will not be included in the date and time
calculations, and related records from various modules.
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Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Resources Subpanel

The Resources subpanel is used to add specific Sugar users and contacts to the
project. When these users and contacts are added to the project, they will be
available to be added as resources on project tasks via the Gantt chart, meaning
they are the responsible party for the task. For more information on project
resources, please review the Project Resources section of this documentation.

The Resources subpanel allows the following operations to be performed:

To view the details of a related user or contact, click the Users or Contacts
icon in the subpanel to open it in detail view.
To relate an existing user or contact to the project, choose the appropriate
"Select" option from the subpanel's Action menu, then locate and select the
desired record.
To remove the resource from the project, click "Unlink" from the dropdown
on the far right of the record's row. This removes the relationship, but does
not delete any actual records.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Note: If you are not able to view this subpanel, the administrator may have
disabled the Projects subpanel for your entire Sugar instance. Reach out to your
Sugar administrator to have the subpanel displayed. For more information on
displaying and hiding subpanels throughout Sugar, please refer to the Developer
Tools documentation in the Administration guide.
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Project Tasks Subpanel

The Project Tasks supbanel lists all of the project's Project Tasks and basic details
of each task. When a task is added to the project via the Gantt chart, the project
task will appear on this subpanel. The Project Tasks subpanel allows the following
operations to be performed:

To view the details of a project task, click the record's name in the
subpanel to open it in detail view.
To add additional tasks to the project, click the "View Gantt" button from
the subpanel's header and follow the information provided in Creating
Project Tasks section of this documentation.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Project Holidays Subpanel

The Project Holidays subpanel lists all of the resources' days that they will not be
working. The subpanel includes columns showing the resource's name, the date of
the holiday, and a description of the holiday. For more information on Project
Holidays, please refer to the Project Holidays section of this documentation. The
Project Holiday's subpanel allows the following operations to be performed:

To add additional holidays to the project, click the "Create" button from the
subpanel's header and fill in the necessary fields.
To remove the holiday from the project, click "Unlink" from the dropdown
on the far right of the record's row.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the project. Once the activities have taken place or are completed, they
will instead appear within the History subpanel. The History subpanel also
includes notes and emails associated with the project. For more information on the
history and activities subpanel, please refer to the User Interface documentation.
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Related Record Subpanels

The most common type of subpanels displayed on a project's detail view contain
the project's related records belonging to various modules. The relationship type
determines whether a related record will be displayed in the field listing or in a
subpanel. Out-of-the-box, the Projects module does not include any relationships to
other modules that would cause a related record to be displayed in the field listing.
However, for example, a project may be related to multiple cases. This means that
the cases will be displayed in a subpanel beneath the fields listing.

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
Administration guide.

To view the details of a related record, click the record's name in the
subpanel to open it in record view (for Sidecar modules) or detail view (for
Legacy modules).
To relate an existing record to the project, choose "Select" from the
subpanel's Action menu, then locate and select the desired record.
To relate a new record to the project, choose the Create option (e.g. Create
Task) from the subpanel's Action menu, then complete the record view
layout and click "Save".
To edit the project's related record, choose "Edit" on the far right of the
record's row.
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To delete the project's relationship to a record, choose "Unlink" from the
dropdown on the far right of the record's row. This removes the
relationship, but does not delete the record itself.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Editing Projects

Projects may be edited at any time to update or add information to the record. You
can make changes to existing project records via the Projects edit view and quick
create forms (for Legacy modules). Edit view is available within the Projects
module and includes all of the Project fields you should need. To edit the Project
Tasks related to this project, please refer to the Editing Project Tasks section of
this documentation.

Quick create is available for editing projects from outside the Projects module and
opens as a pop-up without navigating away from your current page. It generally
contains fewer fields, but the Full Form button may be used to access the full edit
view should you need to edit additional fields. Please note that the quick create
form is only available when viewing Legacy module records (e.g. Quotes).
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Please note that your ability to edit projects in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure both the Projects edit view and quick
create via Admin > Studio. For more information on configuring layouts, please
refer to the Studio documentation in the Administration guide.

Editing via Detail View

You can edit projects via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve your changes.
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Editing via List View

You can edit projects via the list view by clicking the Pencil icon to the left of each
project's name. Once the edit view layout is open, update the necessary fields, then
click "Save" to preserve your changes.

Deleting Projects

If a project record is invalid or should no longer appear in your organization's
Sugar instance, it may be deleted from either the Projects detail view or list view.
Deleting via the detail view allows you to delete a single record while the list view
allows for mass deleting multiple records at once. Deleting projects will not delete
related records and will only remove the relationship, so you may wish to also
delete any related records to avoid orphaned records if necessary.

Please note that your ability to delete projects may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting via Detail View

Use the following steps to delete a project via the detail view:

1. Navigate to a project's detail view.
2. Select "Delete" from the Actions menu. 

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.
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Mass Deleting via List View

Use the following steps to delete one or more projects via the list view:

1. Navigate to the Projects list view by clicking the Projects module tab.
2. Use the Basic or Advanced Search to find the project records you wish to

delete.
3. Select the desired project records individually or using the Checkbox

Dropdown's options.
4. Choose "Delete" from the Actions menu. 

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of project records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Exporting Projects

Sugar's Export option allows users to download all fields for the selected projects
to their computers as a .CSV (comma-separated values) file. This may be useful
when needing to use Project data with other software such as Microsoft Excel. Due
to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of project records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Projects may be exported from the Projects list view by selecting "Export" from the
Actions menu. Users with access to the Reports module also have the option of
creating or accessing reports containing specifically chosen fields for projects and
their related record(s). Please note that only Rows and Columns-type reports have
the ability to be exported. For more information on exporting records in Sugar,
please refer to the Export documentation.
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Please note that your ability to export projects from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Exporting to Microsoft Project

Sugar includes the functionality to export projects not just in CSV format, but also
in .MPX format. MPX is the standard format used by Microsoft Project. Upon
exporting this file, you will be able to open the file in Microsoft Project, which
allows people who are not Sugar users to be able to view this project information.

Note: MPX file format is not supported by MS Project 2013.

The following steps cover exporting a project to Microsoft Project:

1. Navigate to a project's detail view.
2. Select "Export to MS Project" from the Actions menu.

3. Open the downloaded file in Microsoft Project.

Mass Updating Projects

Mass Updating allows users to make the same change to multiple projects at once
from the Projects list view. Users with administrator or developer access can
control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
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on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of project records. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update projects may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update projects from the list view:

1. Navigate to the Projects list view by clicking the Projects module tab.
2. Use the list view's Basic or Advanced Search to find projects you wish to

modify.
3. Select the desired project individually or using the Checkbox

Dropdown's options.
4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.
Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add the
teams specified here to any existing team assignments.

6. Click "Update" to save the changes to all of the currently selected project.
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Favoriting Projects

Each Sugar user has the option to designate their own favorite projects which are
important or will be viewed often so that they can easily be accessed via search or
from the Projects module tab. Once records are marked as favorites, use the My
Favorites checkbox in the Projects Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the Projects
module tab.

Favoriting via List View

Use the following steps to mark records as favorites via the Projects list view:

1. Navigate to the Projects list view by clicking the Projects module tab.
2. Use the Basic or Advanced Search to find the Project records you wish to

mark as favorites.
3. Mark the star icon on the left of each desired project's row.
4. To remove the project as a favorite, click the star again to revert it to gray.

Favoriting via Detail View

Use the following steps to mark records as favorites via the Projects detail view:

1. Navigate to a project's detail view.
2. Click the star icon to the right of the project's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the project as a favorite, click the star again to revert it to gray.

Favoriting via Subpanel

Use the following steps to mark project records as favorites via the subpanel in
related modules:

1. Navigate to a related module's record view (e.g. Contacts).
2. Click the star icon to the left of the desired record's row in the Projects

subpanel.
3. To remove the project as a favorite, click the star again to revert it to gray.

Project Templates

Project Templates are used when a similar project is used multiple times. Project
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Templates will save you from recreating the project each time. Instead, the
template can be used to create a new project which will have the same information
from the detail view and the same Project Tasks. Templates can be reused as often
as need be. They can be created using two different ways:

The module tab's Action Menu

Replicating an existing project using the Detail View's Action Menu

Choosing this option will bring you to a screen to define a new name for the
template so that it can be made unique before saving the template and
being mixed with others.

When creating a project from a Project Template, the Project Tasks carry over
from the template to the new project. In addition, all of the fields within the
module carry over.

To see a list of all project templates, navigate to the Project Templates list view. To
access the list view, simply click the triangle over the Projects module tab and
select "View Project Templates".

While list view shows key project template fields, you can click the project
template's name to open the record in detail view. For more information on the
Project Template's list view, please review the Projects List View section of this
documentation.

To create a project from a template, please review the Creating via Project
Template section of this documentation.

Project Resources

Project Resources are a list of users and contacts that can be assigned Project
Tasks. On a project where you are the assigned user, you will see a subpanel on
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the Projects detail view called "Resources". The subpanel will provide options to
Select User, Select Contact, or unlink an existing relationship. In addition any
related user or contact resource will have a corresponding icon allowing you to
view the user's detail view or contact's record view. For more information on
viewing a contact's record view, please refer to the Viewing via Record View
section of the User Interface documentation.

When a resource has been added to the project, the resource will show on the
Gantt chart as an available option for Project Tasks to be assigned. For more
information on the Gantt chart, please review the Project Tasks Gantt Chart
section of this documentation.
Note: If you are not able to view project resources, the administrator may have
disabled the Projects subpanel for your entire Sugar instance. Reach out to your
Sugar administrator to have the subpanel displayed. For more information on
displaying and hiding subpanels throughout Sugar, please refer to the Developer
Tools documentation in the Administration guide.

Project Resource Reports

From the Gantt chart, a resource report can be created showing a specific user's
or contact's assigned tasks across all projects and the user or contact's workload
for a given timeframe.

The report is filtered by each resource and filters for tasks starting or finishing
after a date, and before another given date. This allows an overall view of the
resource's time relative to all projects, not just one specific project.
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This report shows the following information:

Daily Report : This section shows a daily breakdown of all weekday dates
for the report for the resource. The section also shows a "% Busy" section
showing what percentage of an 8 hour day is being taken up for this
resource by project tasks. If the resource has a Project Holiday scheduled,
the % Busy will show as "Holiday". 

Project Tasks : This section shows a list of all project tasks associated
with the resource in the given timeframe. This includes tasks across all
projects, not just the project from which the report was generated. This
shows details for each task so that you can see each task assigned to the
user, as well as the project that the task is for. 

Holidays : This section shows a list of all of the resource's project holidays
for the given timeframe. This will show all holidays, regardless of which
project they are associated. 
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Project Holidays

The Project Holidays subpanel allows you to list any days that a user or contact
resource will not be working on a given project. This links with the project tasks to
ensure that timing of tasks is not affected by a resource taking a holiday. The
holidays are marked for specific days for specific project resources. Project
Holidays contain three fields:

Field Description
Description A brief description or reason for the

holiday.
Holiday Date The holiday or vacation date for this

resource on the project.
Resource Name The user or contact taking the holiday,

selected from a dependent dropdown
list.

Holidays created from this subpanel are specific to the project. Holiday records
can be deleted and removed from the project by clicking "Unlink" on the
corresponding line on the subpanel.

Project Tasks

Project Tasks are a list of each task that needs to be performed to complete the
project. Project Tasks is a separate module than the Projects module, but it can
only be accessed via Projects. Each task can be tracked and monitored via the
Gantt chart. Each task can also be assigned a specific resource and is given a
planned start and finish date allowing the timing to be tracked and planned.

Project Task Fields

The Project Tasks module contains the following fields, which enable users to
properly organize and track each task.
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Field Description
% Complete A numerical value to indicate what

percentage of the task has been
completed.

Actual Duration After the task is completed, enter a
numerical value for the actual duration
of the task.

Description Found only in the edit and detail views,
enter a brief description of the task and
any necessary details.

Duration Only editable from the Gantt chart,
enter a numerical value to indicate how
long it would take to complete the task
which can be specified in days or in
hours.

Note: Changes to this field will affect
the Finish Date as well.

Estimated Effort (hrs) Found only in the edit and detail views,
enter a numerical value for the
estimated amount of work needed for
this task.

Finish Date Only editable from the Gantt chart, this
field will populate based on the Start
Date and Duration. Clicking on this field
on the Gantt chart will produce a
calendar popup to easily select a date.

Note: Changes to this field will affect
the Duration as well, and will be
affected by changes to the Start Date
and/or Duration fields.

Milestone Mark tasks as milestones if they are an
important and measureable landmark on
the way to completing the project. Tasks
can be marked with a checkbox on the
edit view or by clicking the task ID to
highlight the entire row and then right
clicking in the Gantt chart. Milestone
tasks will include an asterisk next to the
task ID on the Gantt chart.

Order The project task's detail view and edit
view display an Order field. This field,
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which was used in the application prior
to version 5.0, has been replaced by the
Task ID field. If you are not using an
order number, you can safely remove
this field from the Project Task layouts
in Studio.

Predecessors If the completion of this task depends on
the completion of other tasks, enter the
Task ID in this column. This field must
be edited and viewed from the Gantt
chart.

Note: Multiple tasks can be
predecessors and the IDs can be
separated by commas.

Priority Choose a value of Low, Medium, or High
for the task which can be edited and
viewed from the edit and detail views.

Project The name of the parent project that can
be viewed from both the edit and detail
views. This value cannot be edited.

Resource Select the individual who is assigned to
the task from the Resources dropdown
list.

Start Date Only editable from the Gantt chart, this
field will automatically populate with
today's date. Clicking on this field on the
Gantt chart will produce a calendar
popup to easily select a date.

Status Found only in the edit and detail view,
choose a value representing the current
stage of the task. This field also shows
on the Project Tasks subpanel.

Task ID When viewing the Gantt chart, the tasks
are ordered by Task ID. Task IDs cannot
be directly edited from the Gantt chart
or the edit and detail views. To move a
task to a different section of the list, and
therefore change its Task ID, click on
the existing ID to highlight the row,
then right click to "Cut" and then
"Paste" it in the new location.

Task Name Enter the name for the project task
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here.
Task Number The project task's detail view and edit

view display a Task Number field. This
field, which was used in the application
prior to 5.0, has been replaced by the
Task ID field. If you are not using task
number, you can safely remove this field
from the Project Task layouts in Studio.

Teams The Sugar team(s) assigned to the task.
This is only viewable from the edit and
detail view.

Utilization (%) From the dropdown list, select the
percentage of a day that the resource
should dedicate their work hours
towards the assigned task. This field is
only found in the edit and detail views of
the project task.

Note: The value of this field is not
reflected in the Resource Report.

Project Tasks Module Tab

The Project Tasks module tab is located on the navigation bar at the top of the
Project Task detail view, Project Task edit view, or Project Task list view. Click the
tab to access the Project Task list view. You may also click the triangle on the tab
to display the Actions and Recently Viewed menus. The Actions menu allows you to
perform important actions within the module. The Recently Viewed menu displays
the list of project tasks you last viewed in the module.

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Project Opens the edit view layout to create a

new project
Project List Opens the list view layout to search and

display projects
Project Tasks Opens the list view layout to search and

display project tasks
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Creating Project Tasks

Project Tasks can only be created from the Gantt chart's project grid. The tasks are
specific to each project, so they must be created directly from the project. When
creating a Project Task from the grid, you will be able to put in basic information
about the task. To add additional information later, please review the Editing
Project Tasks section of this documentation.

Use the following steps to create a project task via the Projects module:

1. Navigate to the detail view of the project where you would like to add
tasks.

2. From the detail view, select "View Gantt" from either the Project Tasks
subpanel or the Action Menu. 

3. Add a row to the grid next to the Gantt chart. This can be done using the
icon in the toolbar or by right clicking on the grid. 

4. Fill in the grid columns on the new row that you created. When complete,
click the save icon the toolbar. 
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Viewing Project Tasks

There are various options available for viewing project tasks in Sugar including via
the grid and Gantt chart, the My Projects Dashboard, Project Tasks list view,
Project Tasks detail view, Project Tasks Recently Viewed menu, dashlets, and
reports.

Viewing Project Tasks via Gantt Chart

The Projects module includes a grid and Gantt chart, which allows you to view all
project tasks related to a specific project in one place. The grid, on the left of the
screen, outlines each task with pertinent information regarding each project task.
The Gantt chart, on the right, shows a timeline of each task and how they overlap.
For more information on the Gantt chart, please review the Project Tasks Gantt
Chart  section of this documentation.

Viewing Project Tasks via My Projects Dashboard

The Project Dashboard allows for users to view any upcoming or overdue project
tasks that are assigned to the user, or are related to any projects for which the
user is the assigned user. The Project Dashboard can be reached by clicking the
appropriate link in the Projects module tab.

The "My Projects Dashboard" panel shows four columns, showing projects that are
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assigned to you, any overdue project tasks where the Finish Date is in the past,
any upcoming project tasks where the Start Date is within the next week, and any
cases that are open related to the project.

The "My Project Tasks" panel shows two columns, showing any overdue project
tasks assigned to you where the Start Date is in the past, any upcoming project
tasks assigned to you where the Finish Date is within the next week.

Any project task link is clickable and will take you to the grid and Gantt chart for
the given project. Next to the task name, Sugar also displays the Finish Date for
the task.

Viewing Project Tasks via List View

The Project Tasks list view displays all project records meeting the current search
criteria. To access the list view, click the "View Project Tasks" option from the
Projects module tab. While list view shows key project fields, you can click the
project task's name to open the record in detail view. For more information on
viewing project via list view, please refer to the Project Tasks List View section.

Viewing Project Tasks via Detail View

The Project Tasks detail view displays thorough project task information including
all project task fields followed by subpanels of the project task's related records
belonging to various modules. The detail view can be reached by clicking a project
task record's link from anywhere in the application including from the Projects
detail view. For more information on viewing project tasks via detail view, please
refer to the Project Tasks Detail View section.

Viewing Project Tasks via Recently Viewed

As you work, Sugar will keep track of which project tasks you have recently
viewed. Click the triangle on the Project Tasks module tab to see a list of your
most recently viewed project tasks and click each name to open the project task in
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detail view.

Viewing Project Tasks via Dashlets

Sugar Dashlets allow users to get a quick view of various records, activities,
reports, etc. Dashlets may be added to a user's Home page or to the intelligence
pane of any module. You can view project task information in List View dashlets
specific to the Project Tasks module (e.g. My Project Tasks dashlet), as well as List
View dashlets based on other modules such as "My Calls". Clicking a project task's
name from any dashlet will open the Project Tasks detail view. For more
information on using dashlets and viewing project task records via dashlets, please
refer to the Intelligence Pane documentation.

Viewing Project Tasks via Reports

Users with access to the Reports module can build, run, and manage reports to
gather key data regarding projects and their related records. In addition to only
displaying desired fields and relationships, reports can also incorporate complex
filters to only display specific subsets of your records. Once the report is run, you
will be able to view the project task record's detail view by clicking the project's
name in the report results. Please note that you can only directly access project
task detail views with Rows and Columns-type and Summation with Details-type
reports as Summation-type and Matrix-type reports do not include hyperlinks in
their display columns. For more information on using reports, please refer to the 
Reports documentation.
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Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you cannot
access the Reports module.

Searching Project Tasks

The Project Tasks list view includes a Basic and Advanced Search to help you
locate records easily and effectively in a module-specific manner. Once the search
is performed, the relevant results will be displayed in the Project Tasks list view
below. Global Search allows users to search for information across their entire
Sugar database as opposed to restricting search within a specific module. Please
note that Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "create" in the name, regardless of how it
starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.
Note: Project Tasks is hidden from Global Search by default. The administrator
must enable it for your use.
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Project Tasks Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
My Items : Select this box to return only records assigned to you.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a project task name, Sugar will only return project
tasks with a matching name that are assigned to you. Once the search is complete,
the relevant results will populate in the list view below the search panel. To see all
project tasks to which you have access, simply click "Clear" and then "Search" to
perform a blank search with no filters. Please note that you will only be able to see
projects as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

Administrators can configure what fields appear on the Project Tasks Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Project Tasks Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
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Clear : Click the Clear button to clear all criteria from the searchable
fields.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select a Project
Name and enter in a project task name to search, Sugar will only return project
tasks with a matching name that related to that specific project. When searching
by a multiselect or dropdown field (e.g. "Assigned to"), however, Sugar will return
records matching any of these selections. Once the search completes, the relevant
results will populate in the list view below the search panel. To see all project
tasks to which you have access, simply click "Clear" and then "Search" to perform
a blank search with no filters. Please note that you will only be able to see project
tasks as allowed by your team membership, user access type, and assigned roles.
For more information on teams and roles, please refer to the Teams and Roles
documentation in the Administration guide.

Administrators can configure what fields appear on the Projects Advanced Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Project Tasks List View

The Project Tasks list view displays all project tasks meeting the current search
criteria and to which your user has access. You can view the basic details of each
project task within the field columns. Please note that you will only be able to see
project tasks as allowed by your team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Teams and 
Roles documentation in the Administration guide.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Project Tasks Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
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documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Project Tasks Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

Project Tasks Checkbox Selection

You can perform several actions on project task records directly from the list view
by first selecting the desired records. To select individual project tasks on the
Project Tasks list view, mark the checkbox on the left of each row. To select or
deselect multiple project tasks on the list view, use the options in the checkbox
dropdown menu:

Select This Page : Selects all records shown on the current page of
project results.
Select All : Selects all records in the current search results across all
pages of project results.
Deselect All : Deselects all records that are currently selected.
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Project Tasks Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Delete Delete one or more project tasks at a

time
Mass Update Mass update one or more project tasks

at a time
Export Export one or more project tasks to a

CSV file

Favorite Designation

Users have the option to mark project tasks records as favorites via the list view as
well as the detail view. This allows users to designate records that are important
or will be viewed often so that they can easily be accessed via search or from the
Project Tasks module tab. In the Project Tasks list view, the star on the left of each
record's row is yellow once marked to indicate a favorite record. For more
information on how to mark records as favorites, please refer to the Favoriting
Projects Tasks section of this documentation.
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Project Tasks More Information

Additional details for each project task can be viewed by clicking the "i" icon to the
far right of each list view row. This provides users a quick view of additional
project task information in addition to what appears in the display column fields.
The resulting pop-up window will show the Description field by default. The list of
fields appearing here may only be configured through a code-level customization.

Project Tasks Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Project Tasks Detail View

The Project Tasks detail view displays thorough project task information including
all project task fields which are grouped by default into one panel. You can also
view a project task's related records (Activities, History, etc.), which appear in 
subpanels beneath the project task fields. The detail view can be reached by
clicking a project task's link from within Sugar including from the Project Tasks
list view.

Please note that you will only be able to view a project task record according to
your team membership, user type, and role restrictions. For more information on
teams and roles, please refer to the Teams and Roles documentation in the
Administration guide. Users with administrator or developer access have the
ability to change the detail view by configuring the layout via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation in
the Administration guide.
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Project Tasks Actions Menu

The Actions menu on the top left of each project's detail view allows you to
perform two actions on the current record. Administrator users can change the
action items to be displayed as separate buttons instead of a dropdown menu via
Admin > System Settings. For more information on configuring the actions menu,
please refer to the System documentation in the Administration guide.

The options in the Actions menu allow you to perform the following operations:

Menu Item Description
Edit Edit this project task
Edit Task In Grid View the project task's parent project's

Grid and Gantt chart

Favorite Designation

Users have the option to mark project tasks records as a favorite via the detail
view as well as the list view. This allows users to designate records that are
important or will be viewed often as they can easily be accessed via search or from
the Project Tasks module tab. In the Project Tasks detail view, the star on the right
of the record's name is yellow once marked to indicate a favorite record. For more
information on how to mark records as favorites, please refer to the Favoriting
Projects Tasks section of this documentation.

Next or Previous Project Task Record

On the upper right of the Project task's detail view, there are two buttons that
allow you to page through each project in the Project Task list view's current
search results. Clicking the Previous button displays the previous project task of
the current search results while clicking the Next button displays the next project
task of the current search results. The text in between shows which project task
result you are currently viewing within the total number of current results.
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Project Tasks Subpanels

Beneath a project task's fields are subpanels containing containing related records
from various modules, including different activities such as calls and meetings, as
well as a history of notes and emails.
Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Project Tasks Related Record Subpanels

The most common type of subpanels displayed on a project task's detail view
contain the project task's related records belonging to various modules. The
relationship type determines whether a related record will be displayed in the field
listing or in a subpanel. Out-of-the-box, the Project tasks module does not include
any relationships to other modules that would cause a related record to be
displayed in the field listing. However, a project task may be related to multiple
notes which means that the related notes will be displayed in a subpanel beneath
the fields. Please note that the Project Tasks module displays the Activities and
History subpanels by default. Administrators can create new relationships between
various modules in Sugar to create additional subpanels. For more information on
creating relationships, please refer to the Studio documentation in the
Administration guide.

Users with administrator or developer access have the ability to change the fields
(e.g. Subject, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation in the Administration guide.

Related record subpanels allow the following operations to be performed. Please
note that administrators in Sugar can change the subpanel's Action menu to be
displayed as separate buttons instead of a dropdown via Admin > System Settings.
For more information, please refer to the System documentation in the
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Administration guide.

To view the details of a related record, click the record's name in the
subpanel or choose "View" from the Actions menu on the far right of the
record's row to open it in record view.
To relate a new record to the project task, choose the Create option (e.g.
Create Task) from the subpanel's Action menu, then complete the record
view layout and click "Save".
To delete the project task's relationship to a record, choose "unlink" from
the Actions menu on the far right of the record's row. This removes the
relationship, but does not delete the record itself.
To close an activity (e.g. Tasks) from the Activities subpanel, choose "close"
from the Actions menu on the far right of the record's row. This moves the
record to the History subpanel within the Project Tasks record.
To collapse or expand the subpanel, click the double arrow to the left of the
subpanel's name.
To move the subpanel to a new location on the detail view, drag and drop
the subpanel's header.

Please note that administrators can prevent users from moving subpanels to
different locations in the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation in the
Administration guide. Check with your system administrator if you are not able to
rearrange your subpanels.

Project Tasks Activities and History Subpanels

The Activities subpanel lists open or upcoming tasks, calls, and meetings that are
related to the project task record. Once the activities have taken place or are
completed, they will instead appear within the History subpanel. The History
subpanel also includes notes and emails associated with the project task record.
For more information on the history and activities subpanel, please refer to the 
User Interface documentation.

                       903 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/System#User_Interface
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/User_Interface_Legacy#Activities_and_History


 

Project Tasks Gantt Chart

The Projects module includes a grid and Gantt chart to allow you to visualize,
track, and easily make changes to your project tasks all in one place. This menu is
accessible from each project's detail view through the Actions Menu or the Project
Tasks subpanel. The page consists of a grid which shows each project task, as well
as information on the timing, % complete, preceding tasks, and who is responsible
for completing the task. Project tasks on the grid can be edited by clicking on the
specific cell and making in-line changes. Whole rows can be selected by clicking
the Task ID number in the ID column on the far left column. The Gantt chart shows
a timeline of each task represents which tasks are being worked on at a given
time.

Gantt Chart Toolbar

The Gantt Chart Toolbar allows you to make changes to both what tasks are
showing on the grid, but also how they are displayed. The icons and menus
perform the following actions, from left to right:

Toolbar Option Description

                       904 / 1.116



 

Add New Row Adds a new row to the end of the task
list, unless a row is selected, when the
button will add the row above the
selection

Indent Row When a row is selcted, this button will
make it a subordinate function of the
above row, causing any subordinate
tasks to be grouped under the parent
task

Outdent Row When a row is selcted and already
indented, this button will move it out
from being a subordinate function of the
above row and making it its own task

Copy Row When a row is selected, the Copy button
will allow the data in the row to be
placed in another row while keeping the
origional in tact

Cut Row When a row is selected, the Cut button
will delete the entire row, but allow it to
be pasted into another as an ensuing
action

Paste Row Adds currently copied or cut row to the
end of the task list, unless a row is
selected, when the button will place the
row above the selection

Delete Row When a row is selected, the Delete
button will remove the entire row and
delete the project task

Expand All This button will affect the entire grid by
expanding all hidden rows created by
indenting to show all rows on the grid

Collapse All This button will affect the entire grid by
collapsing all visible indented rows on
the grid

Save Saves all changes to the grid and
updates the related project task records

Week View Changes the Gantt chart to show one
week of events at a time

2 Week View Changes the Gantt chart to show two
weeks of events at a time

Month View Changes the Gantt chart to show one
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month of events at a time
View... Dropdown list to provide filters to

change which project tasks are showing
on the grid

Export to PDF Exports a PDF from Sugar containing
the information shown in the task grid

Resource Report Opens the Resource Report popup
Grid Changes the view of the page to only

show the task grid and releted toolbar
buttons

Gantt Changes the view of the page to only
show the Gantt chart and releted
toolbar buttons

Grid/Gantt Changes the view of the page to show
both the task grid and Gantt chart

Editing Project Tasks

Project Tasks may be edited at any time to update or add information to the
record. You can make changes to existing project task records via the Gantt chart
and Project Tasks edit view. Edit view is available within the Project Tasks module
and includes all of the Project Task fields you should need.

Please note that your ability to edit project tasks in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Edit options.

Administrators in Sugar may configure the Project Tasks edit view via Admin >
Studio. For more information on configuring layouts, please refer to the Studio
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documentation in the Administration guide.

Editing Project Tasks via Detail View

You can edit project tasks via the Detail View by clicking the Edit button on the
upper left of the page. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve your changes.

Editing Project Tasks via Gantt Chart

Project Tasks can be edited one at a time via the task grid and Gantt Chart. The
Gantt chart can be accessed via the Projects detail view and Project Tasks detail
view. Project Task fields can be edited by clicking on the field, either if it is empty
or if it contains existing data, and edits can be made directly inline on the grid.
Selecting the entire row can be done by clicking the ID number for the row of each
project task. Multiple tasks can be selected by holding the Shift key on your
keyboard while clicking.

The following fields can be edited from the task grid and Gantt chart:

% Complete
Task Name
Duration
Start
Finish
Predecessors
Resource
Actual Duration

Editing Project Tasks via List View

You can edit project tasks via the list view by clicking the Pencil icon to the left of
each project task's name. Once the edit view layout is open, update the necessary
fields, then click "Save" to preserve your changes.
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Deleting Project Tasks

If a project task is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the project's Gantt chart or the Project
Tasks list view. Deleting via the Gantt chart allows you to delete a single record
while the list view allows for mass deleting multiple records at once. Deleting
projects will not delete related records and will only remove the relationship, so
you may wish to also delete any related records to avoid orphaned records if
necessary.

Please note that your ability to delete project tasks may be restricted by a role. For
more information on roles, please refer to the Role Management documentation in
the Administration guide. Check with your system administrator if you do not see
the Delete options.

Deleting Project Tasks via Gantt Chart

Use the following steps to delete a project task via the Gantt chart:

1. Navigate to the project's Gantt chart
2. Select the project task's row by clicking on the ID number for the task

3. Right click on the selected row and select the "Delete" option from the
action menu, or click the "Delete" button from the Gantt toolbar

                       908 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Administration_Guide/Role_Management


 

4. Save the Gantt chart to confirm the change to the project.

Mass Deleting Project Tasks via List View

Use the following steps to delete one or more project tasks via the list view:

1. Navigate to the Project Tasks list view by clicking the triangle on the
Projects module tab and selecting "View Project Tasks".

2. Use the Basic or Advanced Search to find the project task records you wish
to delete.

3. Select the desired project tasks individually or using the checkbox
dropdown's options.

4. Choose "Delete" from the Actions menu.

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of project task records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.
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Exporting Project Tasks

Sugar's Export option allows users to download all fields for the selected project
tasks to their computers as a .CSV (comma-separated values) file. This may be
useful when needing to use Project data with other software such as Microsoft
Excel. Due to PHP memory limitations on the server, there may be occasions when
the application times out while exporting a large number of project tasks. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Project tasks may be exported from the Project Tasks list view by selecting
"Export" from the Actions menu. Users with access to the Reports module also
have the option of creating or accessing reports containing specifically chosen
fields for project tasks and their related record(s). Please note that only Rows and
Columns-type reports have the ability to be exported. For more information on
exporting records in Sugar, please refer to the Export documentation.

Please note that your ability to export projects from Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Export option.

Mass Updating Project Tasks

Mass Updating allows users to make the same change to multiple project tasks at
once from the Project Tasks list view. Users with administrator or developer access
can control which fields are available to change during mass update via Admin >
Studio. Currently, only fields with the data type of date, datetime, dropdown,
multiselect, and radio may be altered during a mass update. For more information
on configuring mass update, please refer to the Studio documentation in the
Administration guide. Due to the PHP memory limitations on the server, there may
be occasions when the application times out while mass updating a large number
of project tasks. If you encounter an error when performing this action, we
recommend selecting the records in smaller batches.

Please note that your ability to mass update project tasks may be restricted by a
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role. For more information on roles, please refer to the Role Management
documentation in the Administration guide. Check with your system administrator
if you do not see the Mass Update option.

Use the following steps to mass update projects from the list view:

1. Navigate to the Project Tasks list view by clicking the triangle on the
Projects module tab and selecting "View Project Tasks".

2. Use the list view's Basic or Advanced Search to find project tasks you wish
to modify.

3. Select the desired project tasks individually or using the checkbox
dropdown's options.

4. Choose "Mass Update" from the Actions menu.

5. Scroll to the Mass Update panel and set values for the fields you wish to
alter.
Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add the
teams specified here to any existing team assignments.

6. Click "Update" to save the changes to all of the currently selected project
tasks.

Favoriting Project Tasks

Each Sugar user has the option to designate their own favorite project tasks which
are important or will be viewed often so that they can easily be accessed via search
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or from the Project Tasks module tab. Once records are marked as favorites, use
the My Favorites checkbox in the Project Tasks Basic or Advanced Search to
retrieve your favorites or select from your most recent favorites directly from the 
Project Tasks module tab.

Favoriting via List View

Use the following steps to mark records as favorites via the Project Tasks list view:

1. Navigate to the Project Tasks list view by clicking "View Project Tasks"
from the Projects module tab.

2. Use the Basic or Advanced Search to find the Project Tasks records you
wish to mark as favorites.

3. Mark the star icon on the left of each desired record's row.
4. To remove the record as a favorite, click the star again to revert it to gray.

Favoriting via Detail View

Use the following steps to mark records as favorites via the Project Tasks detail
view:

1. Navigate to a Project Task's detail view.
2. Click the star icon to the right of the record's name in the upper left of the

detail view to designate it as a favorite.
3. To remove the record as a favorite, click the star again to revert it to gray.

Last Modified: 2020-02-04 00:12:57

Reports

Overview

Sugar's Reports module allows users to build, generate, and manage reports for
modules such as Accounts, Contacts, Calls, etc. Reporting is a valuable tool in
Sugar as users can gather data from various modules to generate vital information
for their organization.

There are four types of reports (Rows and Columns Report, Summation Report
with Details, Summation Report, Matrix Report) available in Sugar. Some reports
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can be rendered as charts that allow you to drill through to see the corresponding
records. This page covers functionality specific to the Reports module. For
instructions concerning views and actions which are common across most Sugar
modules, such as viewing, editing, etc., please refer to the Working With Reports
section of this page.

Note: Some of the examples in this documentation contain steps to create
Opportunity reports. Users with Revenue Line Items enabled should adjust the
steps to target the Revenue Line Items module. Users with Sugar Serve license
types will not have access to opportunities or revenue line items but can adapt the
steps to other modules in their Sugar instance. For more information on license
types and the module functionality available for each type, refer to the User
Management documentation.

Report Fields

The Reports module contains a number of stock fields that come out-of-the-box
with Sugar. For information on using and editing various field types, refer to the 
User Interface documentation. The definitions below are suggested meanings for
the fields, but the fields can be leveraged differently to best meet your
organization's needs. The following fields are available when viewing the Reports
list view.

Field Description
Accessed On The date the report record was last

opened
Chart Type The chart type (if applicable) defined for

the report
Date Created The date the report record was created
Date Modified The date the report record was last

modified
Description A description or other key information

about the report

Note: The Description field is only
viewable and editable via the list view
preview. 

Module The target module (e.g. Accounts)
associated with the report

Name The name of the report
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Report Type The report type (Rows and Columns
Report, Summation Report, Summation
Report with Details, Matrix Report)
specific to the report

Tags User-created keywords that can be used
to identify, organize, and group report
records by common attributes

Note: The reports module contains over
100 stock reports that are pre-tagged
using a combination of the following out-
of-the-box tags:

Stock Report
Sales and Marketing
Customer Service
Data Privacy
Administrative

For more information on tags in Sugar,
please refer to the Tags documentation.
For more information on stock reports,
please refer to the Stock Reports
documentation.

Team The Sugar team(s) assigned to the
report record

User The Sugar user assigned to the report
record

Working With Reports

The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Reports section describe
Reports-specific behaviors and functionality. 

Content Link Description
Viewing Reports
Viewing via List View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Preview

The Viewing Records section describes
the various methods of viewing report
records, including via the Reports list
view, the Recently Viewed menu in the
Reports module tab, list view dashlets
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showing report information, and
previewing reports in the right-hand
side panel.

Searching for Reports
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Reports module.

Note: The Report module's Filter option
also includes the following filters out-of-
the-box:

Stock Reports : Filter the list
view to show only the reports
that were included with Sugar.
Non-Stock Reports : Filter the
list view to show only user-
created reports.
With Charts : Filter the list
view to show only reports that
are designed with charts.

For more information on stock reports,
please refer to the Stock Reports
documentation.

Reports List View
Total Record Count
Create Button
List View Search
Checkbox Selection
Mass Actions Menu
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
Record Actions Menu
More Reports
Intelligence Pane

The List View section walks through the
many elements of the Reports List View
layout which contains a filterable list of
all report records in Sugar. While the
generic menu options are described in
the User Interface sections linked to the
left, the options specifically available in
the Reports list view are described in
the List View Mass Actions Menu and 
List View Record Actions Menu sections
of this page.

Editing Reports
Editing Inline via List View
Editing via Preview
Mass Editing via List View

The Editing Records section describes
the various methods of editing existing
report records, including inline via the
Reports list view, via the List View
preview, and via the Mass Update
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option on the list view.
Deleting Reports
Deleting via List View
Mass Deleting via List View

The Deleting Records section describes
the various methods of deleting
unwanted reports, including via an
individual record's Actions menu on the
Reports list view and the Mass Actions
menu on the list view.

Favoriting Reports
Favoriting via List View

The Favoriting Records section
describes marking reports as favorites
via the Reports list view. Favoriting a
report allows you to easily access it from
list views, dashlets, or the Reports
module tab.

Report Menus

The Reports module contains various options and functionality which are available
via menus in the module tab, list view, and detail view. The following sections
present each menu and its options with links to more information about each
option in the User Interface documentation or, for Reports-specific functionality,
within this page.

Module Tab Menus

The Reports module tab is typically located on the navigation bar at the top of any
Sugar screen. Click the tab to access the Reports list view. You may also click the
triangle in the Reports tab to display the Actions, Recently Viewed, and Favorites
menu. The Actions menu allows you to perform important operations within the
module. The Recently Viewed menu displays the list of reports you last viewed. The
Favorites menu displays the list of reports you most recently marked as favorites in
the module.
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The module tab's Actions menu allows you to perform the following operations: 

Menu Item Description
Create Report Opens the Report Wizard for creating a

new report
View Reports Opens the list view layout for searching

and displaying reports
Manage Advanced Reports Opens the Advanced Reports tab for

creating and viewing advanced reports
Report Schedules Opens the Report Schedules module for

scheduling automated reports via email

If you do not see the Reports module tab in Sugar, please check the following:

The Reports module may be marked as hidden in your user preferences
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Reports module in the Hide Modules
list, simply move it to the Display Modules list. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Reports module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Reports
module displayed. For more information on displaying and hiding modules
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throughout Sugar, please refer to the Developer Tools documentation in
the Administration Guide.

List View Menus

The Reports list view displays all report records and allows for searching and
filtering to locate specific reports. You can view the basic details of each record
within the field columns of the list view or click a report's name to open the detail
view. To access a module's list view, simply click the module's tab in the navigation
bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual report records or click the
checkbox in the list header to select all records displayed in the current set of list
view results.

The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more reports at a

time
Delete Delete one or more reports at a time

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
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perform actions on the individual report directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this report in the intelligence

pane
Edit Inline edit this report
Edit Report Edit the report via the Report Wizard
Create Schedule Send a copy of this report to your email

inbox on a recurring basis
View Schedules View any scheduled reports for this

report in the Report Schedules list view
Delete Delete this report

Detail View Actions Menu

The Reports detail view displays a single report in full detail including display
column fields (if applicable), charts (if applicable), etc. To access a report's detail
view, simply click a hyperlinked report name from anywhere within Sugar. The
Actions menu appears on the top left of each report's detail view and allows you to
perform various operations on the current report. Administrator users can change
the action items to be displayed as separate buttons instead of a dropdown menu
via Admin > System Settings. For more information on configuring the actions
menu, please refer to the System documentation in the Administration Guide.
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The Actions menu allows you to perform the following operations: 

Menu Item Description
Run Report Run this report to generate the result
Share Share a link to this report via email

Note: To send emails through Sugar,
users must first configure a default user
email account via Emails > Email
Settings.

Edit Edit this report
Copy Duplicate this report to create a new

report
Create Schedule Send a copy of this report to your email

inbox on a recurring basis.
View Schedules View any scheduled reports for this

report in the Report Schedules list view
Print as PDF Download this report as a PDF file
Export Export this report's result to a CSV file
Delete Delete this report

Report Types

There are four types of reports (Rows and Columns Report, Summation Report,
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Summation Report with Details, Matrix Report) available for users to create in
Sugar. Please note that each report type provides users with information for
records that meet the specified criteria, but each type displays the report results in
different layouts.

Rows and Columns

The Rows and Columns report is the most basic report to create out of the four
report types. The report results display the data in a simple rows-and-columns
format displaying values for the selected display column fields for all records
meeting the specified criteria. For more information on creating a Rows and
Columns report, please refer to the Rows and Columns Report section.

Summation

The Summation Report provides computed data based on the selected fields for
records meeting the specified criteria. You can group the report based on one or
more fields from the target or related module. The report result displays the data
in groups, summarized using computed derivatives (e.g. SUM, AVG, MAX, MIN)
from numeric-type field values (e.g. Likely) as well as weighted amounts.
Summation Reports can be viewed in a chart format and displayed as a Sugar
Dashlet on your Home page as well. For more information on creating a
Summation Report, please refer to the Summation Report section.

Summation Report with Details

The Summation Report with Details is a combination of the Summation-type and
Rows and Columns-type report as you can group the data, get the total count of
records, and choose display columns (e.g. Contact Name, Account Name, Email
Address) as well. You can group the report based on one or more fields from the
target or related module. Summation Report with Details can be viewed in a chart
format and displayed as a Sugar Dashlet on your Home page. For more information
on creating a Summation Report with Details, please refer to the Summation
Report with Details section.

Matrix

The Matrix Report is also similar to the Summation-type report as it provides an
overview of the computed data and displays the total summary count. The report
results display in a grid table with row and column headers. The numeric field
values for all display summaries appear on the table along with the total amounts
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for each row and column. Matrix Reports can be viewed in a chart format and
displayed as a Sugar Dashlet on your Home page. For more information on
creating a Matrix Report, please refer to the Matrix Report section.

Creating Reports

There are various types of reports (e.g. Rows and Columns Report, Summation
Report with Details, Summation Report, Matrix Report) you can create via the
Reports module. The first step of creating a report via the Report Wizard is to
choose the report type, and the steps to create the report vary slightly depending
on the report type chosen. Please note that you can create reports in Sugar via the
Reports module itself using the Create options as well as by duplicating an existing
report via the Copy option. 

Creating via Reports Module

The most common method of report creation is via the Reports module using the
Create button in the list view or the Create Report option in the module tab. This
opens the Report Wizard which allows you to build the necessary report and
generate the results accordingly. The following sections cover creating the four
different report types via the Reports module.

Creating a Rows and Columns Report

Of the four report types, the Rows and Columns report is the most basic one to
create in Sugar. Users can simply define filters to determine which records the
report will include or exclude then choose the fields (e.g. Name, Email Address)
they would like displayed in the report result. The Rows and Columns report
creates a tabular report containing the values of selected display column fields for
all records meeting the specified criteria.

The following steps cover creating a Rows and Columns report for calls with a
status of "Held" as an example:

1. Click the triangle in the Reports module tab and select "Create Report".
2. Choose "Rows and Columns Report" as the report type and "Calls" as the

target module in the following step.
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3. To filter on a field related to the target module, select it from the Available
Fields list on the bottom left to add it to the list of filters. In this example,
select "Status" to filter the report based on call records already held. Click
"Next".

For more information on report filters, please refer to the Report
Filters section.

4. On the Choose Display Columns step, select the fields you would like
included in the report results from the Available Fields list then click
"Next". We are adding the following fields as an example: Subject, Status,
Description, Date Created, User Name, Contacts Name, and Account
Name.

For more information on selecting display column fields, please
refer to the Report Display Columns section.

5. Select "Subject", "Date Created", "Status", and "Description" in the
"Available Fields : Calls" list, as these are fields contained in the Calls
module. By default, the target module's fields display in the Available
Fields list.

Note: You can designate the generated report to be sorted by a
specific display column field in either ascending or descending
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order. Simply mark the radio button next to the field label then
select "Ascending" or "Descending" in the corresponding dropdown
list.

6. For the User Name field, click "Assigned to User" from the Related
Modules list at the top left then select "User Name" from the "Available
Fields : Assigned to User" list.

Note: User names are stored in their own table in the database and
are related to the modules in Sugar. So even though the Assigned
User field appears in various module layouts, they are not direct
fields in those modules.

7. For the Contact Name field, click "Contacts" from the Related Modules list
then select "Name" from the "Available Fields : Contacts" list.

By default, the label for the Name field displays "Name", but you
can change the label to "Contact Name" to differentiate the field
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between accounts and contacts. For more information on changing
display column labels, please refer to the Changing Display Column
Labels section.

8. For the Account Name field, click "Account" from the Related Modules list
then select "Name" from the "Available Fields : Account" list.

Change the label for the Name field to display "Account Name". For
more information on changing display column labels, please refer to
the Changing Display Column Labels section.

9. To place the fields in a different order on the report, drag and drop the
field rows within the display column list.

The first field (Subject) on the display columns list represents the
first column of the report, the second field (Date Created) is the
second column, and so forth. For more information on changing the
display column order, please refer to the Changing Display Column
Order section.

10. Click "Next" after adding all of the appropriate fields.
11. On the Report Details step, enter the report name and assign it to the

desired user and team.
Please note that if you want your report to include all held calls
whether or not they have an assigned user, related contact, or
account, you must mark the Optional Related Modules boxes. For
more information on marking related modules as optional, please
refer to the Optional Related Modules section.

12. After entering the report details, click "Save and Run" to save and generate
the report immediately.

Clicking the Preview button allows you to preview the report before
saving.
Clicking the Save button saves the report without running it
immediately.
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Creating a Summation Report

The Summation Report groups and provides computed data for records that meet
the specified criteria. You can choose a number of group-by columns to group the
data in the report and can define group-by data for related modules as well. You
can also drag and drop the group-by fields to a different order in the Define Group
By step to change the layout in the report results. Please note that the Summation
Report does not provide detailed information like Summation Report with Details
and will not include any display columns in the report.

The following steps cover creating a report to capture closed won opportunities for
Q2 2017 grouped by assigned user and the month it was closed as an example:

1. Click the triangle in the Reports module tab and select "Create Report".
2. Choose "Summation Report" as the report type and "Opportunities" as the

target module.

3. Next, define the report filters as follows then click "Next":
Select "Expected Close Date" from the Available Fields panel, then
choose "Is Between" and select "04/01/2017 and 06/30/2017" from
the options appearing to the right of the Expected Close Date filter.
Select "Sales Stage" from the Available Fields panel, then choose
"Is" and "Closed Won" in the dropdowns appearing to the right of
the Sales Stage filter.
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4. On the Define Group By step, select "User Name" and "Month: Expected
Close Date", which will group the closed won opportunity records by the
assigned user and month it was closed. Click "Next".
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5. On the Choose Display Summaries step, select "SUM: Likely" to summarize
the report based on the opportunity's likely total amounts. Click "Next".
Please note that the field(s) selected in the Define Group By step are
automatically included in the Choose Display Summaries step.

Note: You can sort results by a specific field column in either
ascending or descending order. Simply select the radio button next
to the field label (e.g. Month: Expected Close Date) then select
"Ascending" or "Descending" in the corresponding dropdown list.

6. On the Chart Options step, select the type of chart, if any, that you wish to
display in the report as well as how the data should be summarized on the
chart, then click "Next". For more information on setting up the chart
options, please refer to the Report Chart Options section.

7. On the Report Details step, enter a name for the report and assign it to the
appropriate user and team.

Note: Enable the "Optional Related Modules" box to include all
closed won opportunities whether or not they are assigned to a
user. For more information regarding this option, please refer to the
Optional Related Modules section.

8. After entering the report details, click "Save and Run" to save and generate
the report immediately.

Click the Preview button to preview the report before saving.
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Click the Save button to save the report without running it
immediately.
To view the values corresponding to a section of the chart, hover
your mouse over the section.
To view the list records corresponding to a section of the chart,
simply click the bar in the chart. For more information, refer to the 
Drilling Through Charts section.

Creating a Summation Report with Details

The Summation Report with Details groups and summarizes data with detailed
information related to records in the report. You can group the report based on
one or more fields from the target or related module. Grouping the report by
particular fields allows the report results to display data in categories by the
specified field values. You can also drag and drop the group-by fields to a different
order in the Define Group By step to change the layout in the report results.

The following steps cover creating a Summation Report with Details to capture
closed won opportunities in 2016 grouped by month as an example:

1. Follow Steps 1-5 of the Summation Report section and complete the report
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criteria as follows:

Report Type : Select "Summation Report with Details"
Target Module : Choose "Opportunities"
Define Filters : Define the report filters as follows then click
"Next":

Select "Expected Close Date" from the Available Fields
panel, then choose "Is Between" and select "01/01/2016"
and "12/31/2016" from the options appearing to the right of
the Expected Close Date filter.
Select "Sales Stage" from the Available Fields panel, then
choose "Is" and "Closed Won" in the dropdowns appearing
to the right of the Sales Stage filter.

Define Group By : Select "Month: Expected Close Date" from the
Available Fields panel then click "Next".
Choose Display Summaries : Select "SUM: Likely" from the
Available Fields panel then click "Next".

Note: The field(s) selected in the Define Group By step are
automatically included in the Choose Display Summaries
step.

2. On the Choose Display Columns step, select the fields (e.g. "Opportunity
Name", "Expected Close Date", "Likely", "Sales Stage", and "User Name")
you would like included on the report from the Available Fields panel then
click "Next".

Refer to Steps 5-10 of the Rows and Columns Report section for
instructions on adding fields as display columns.
For more information on selecting display column fields, please
refer to the Report Display Columns section.
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3. On the Chart Options step, select the type of chart, if any, that you wish to
display in the report as well as how the data should be summarized on the
chart and then click "Next".

4. On the Report Details step, enter a name for the report and assign it to the
appropriate user and team.

Note: Select the "Optional Related Modules" box to include all
closed won opportunities whether or not they are assigned to a
user. For more information regarding this option, please refer to the
Optional Related Modules section.

5. After entering the report details, click "Save and Run" to save and generate
the report immediately.

Click the Preview button to preview the report before saving.
Click the Save button to save the report without running it
immediately.
To view the corresponding chart values, simply hover your mouse
over the bar in the report chart.
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Creating a Matrix Report

The Matrix Report provides an overview of the data and displays the total for
display summaries in a grid format. The numeric field values for all display
summaries appear on the table along with the total amounts for each row and
column. You can choose a maximum of three group-by columns to group the data
in the report.

You can also choose specific layout options (e.g. 1x2 and 2x1) on the Report
Details step of the Report Wizard if you selected three group-by columns on the
Define Group By step. The 1x2 layout option displays the data for the first group-by
field in a row and displays the data for the other two group-by fields in columns.
The 2x1 layout option displays the data for the first two group-by fields in rows and
displays the data for the third group-by field in a column. If you only have two
group-by columns, you can manually change the report layout by dragging and
dropping the group-by fields to a different order on the Define Group By step.
Please note that the Matrix Report does not provide detailed information like
Summation Report with Details and will not include display columns in the report.

The following steps cover creating a Matrix Report to capture closed won
opportunities in 2016 grouped by assigned user and the month it was closed as an
example:
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1. Follow Steps 1-5 of the Summation Report section and complete the report
criteria as follows:

Report Type : Select "Matrix Report"
Target Module : Choose "Opportunities"
Define Filters : Define the report filters as follows then click
"Next":

Select "Expected Close Date" from the Available Fields
panel, then choose "Is Between" and select "01/01/2016"
and "12/31/2016" from the options appearing to the right of
the Expected Close Date filter.
Select "Sales Stage" from the Available Fields panel, then
choose "Is" and "Closed Won" in the dropdowns appearing
to the right of the Sales Stage filter.

Define Group By : Select "Month: Expected Close Date" and "User
Name" from the Available Fields panel then click "Next"
Note: You must click the related Assigned to User module to select
the User Name field as user names are not direct fields of the
Opportunities module.
Choose Display Summaries : Select "SUM: Likely" from the
Available Fields panel then click "Next"
Note: The field(s) selected in the Define Group By step are
automatically included in the Choose Display Summaries step.

2. On the Chart Options step, select the chart type that you wish to display in
the report as well as how the data should be summarized on the chart, then
click "Next". For more information on setting up the chart options, please
refer to the Report Chart Options section.

3. On the Report Details step, enter a name for the report and assign it to the
appropriate user and team.

4. Mark the "Optional Related Modules" box to include all closed won
opportunities whether or not they are assigned to a user. For more
information regarding this option, please refer to the Optional Related
Modules section.

Note: The Layout Options dropdown list (1x2 and 2x1) will appear if
you selected three group-by columns on the Define Group By step.
Select the appropriate layout depending on how you want the data
to be displayed on the report grid.

5. After entering the report details, click "Save and Run" to save and generate
the report immediately.

Click the Preview button to preview the report before saving.
Click the Save button to save the report without running it
immediately.

When viewing the report's chart, hover your mouse over the bar in the report chart
to se the corresponding chart values.
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Creating Reports via Duplication

You can also create a new report by duplicating an existing report in Sugar. The
Copy option is useful if the report you are creating has similar information to an
existing report. You can also copy a report if you would like to view the same or
similar data as a different report type. This option is presented when the user
clicks "Copy" from the report's Actions menu.

Note: If any report schedule records have been created and related to the original
report, they will not copy over to the new report. For more information on creating
report schedule records, please refer to the Scheduling Reports section.

The following steps cover creating a report by duplicating an existing Rows and
Columns-type report as an example:

1. Navigate to a report's detail view.
2. Click the Actions menu and select "Copy".
3. Choose the report type you would like to create from the Copy-As submenu.

To keep the new report's type the same, choose "As Original Type".
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4. Go through the Report Wizard to select and enter new data as described in
the sections under Report Options. If you selected a report type other than
the original type, there may be additional or fewer steps in the Report
Wizard to complete and you may need to edit the report to meet the new
report type's requirements.

5. In the final step, enter a new name for the report and click "Save and Run".

Report Options

There are various steps involved when creating reports in Sugar and the steps can
vary slightly depending on the report type (e.g. Summation report versus Rows and
Columns). The following sections provide details concerning the steps involved
when creating reports.

Report Filters

The Define Filters step of the Report Wizard determines which records the report
includes or filters out. Filter groups and operators allow for additional levels of
complexity as you combine filters to get the precise result set you desire.

Target Module Filters

By default, the fields for the Target Module you are creating the report on will be
displayed in the Available Fields list. To filter on the field related to the target
module, select it from the Available Fields list on the bottom left, and it will be
added to the list of filters. Please note that only fields marked as "Reportable" in
Studio will display in the Available Fields list. For more information on marking
fields as reportable, please refer to the Studio documentation in the Administration
Guide.
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You can also use the search feature above the Available Fields list to easily locate a
field. Enter the appropriate keyword (e.g. billing, date) in the search field and the
matching results will display in the Available Fields list. Sugar automatically
appends the wildcard character (%) to the beginning and end of your search
phrase, so the system will return all fields that contain the keyword.

Related Module Filters

The Related Modules list shows all modules that have a relationship with the
target module. To filter on a field in a related module, choose the name of the
module (e.g. Documents) in the Related Modules list, and the Available Fields list
below will display fields belonging to the related module. You can select the
desired field(s) from the related module to add as a filter for your report. Please
note that only fields marked as "Reportable" in Studio will display in the Available
Fields list. For more information on marking fields as reportable, please refer to
the Studio documentation in the Administration Guide.
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You can also use the search feature above the Available Fields list to easily locate a
field. Enter the appropriate keyword (e.g. billing, date) in the search field and the
matching results will display in the Available Fields list. Sugar automatically
appends the wildcard character (%) to the beginning and end of your search
phrase, so the system will return all fields that contain the keyword.

Filter Values

Once the filter has been created, you can specify what field values constitute a
match for the report in the Define Filters section. Select the appropriate value
from the corresponding dropdown list and enter the relevant value in the open text
box (if applicable).
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Please note that if the assigned user or a member of your team changes or adds a
new filter, the system alerts you that the report filters have been modified since
the last run when you save and run the report.

Run-Time Filters

The run-time option in the Define Filters step allows you to make the filter(s)
available on the saved report, which enables you to quickly change your filter
values without having to edit the report. Simply mark the Run-time box for any
filter(s) you wish to view on the saved report.

Once the report is created and saved, the run-time filter (e.g. "Accounts > Date
Created") will appear on the generated report view. You can change the filter
values directly from the report view by selecting the new filter values from the
dropdown list and clicking "Apply" or "Run Report" at the top of the report's detail
view. Clicking the Reset button will reset the run-time filter back to the original
filter value you set.

Please note that the Report Wizard retains the original filter value(s) you set when
building the report regardless of the changes you or other users make on the run-
time filters on the report's detail view. If the report is shared by a team, then each
user can run the report with different run-time filter values to meet their individual
needs. The run-time filter values set by each user will be preserved for future
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viewing until they change or reset the value.

Operators

When building the report, you have the option to choose between two operators,
"AND" and "OR", using dropdowns within the Define Filters section. By default,
operators are set to "AND" which will cause the filters to work cumulatively. All
filters or groups of filters under an AND operator will need to be true for a record
in order for that record to appear in the report result. Changing an operator to
"OR" will mean that if any single filter under that "OR" is true for a record, the
record will be included in the report results. The OR operator accepts records
matching any of the filters while the AND operator accepts records matching all
filters.

Filter Groups

By default, all filters will be added to a single group. To split filters into multiple
groups, use the Add Filter Group button.

When you have more than one filter group and click a new filter field, Sugar will
prompt for which filter group the new field should belong.

Filter groups and operators can be combined to achieve complex filtering
situations. For example, if we need a report for documents belonging to accounts
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created prior to the first quarter where the document is either new this week or
new this month is connected to a lead, we would use the following filter groups
with an OR operator joining the two together:

Filters on Tag Fields

If a report's target module contains the Tags field, the report can be filtered by
tags via the Related Modules filters. To filter by tags, click on the Tags module
name in the Related Modules list. The Available Fields list below will display fields
belonging to the Tags module. Select the Name field to create a tag filter. Please
note that you can select any field(s) from the Tags module as a filter for your
report, but this example will only demonstrate filtering by the tag's name.

After clicking on the Name field, a line item will appear in the Filters view that
allows you to select an operator and specify a tag name in its adjacent text field.
This text field is not a type-ahead style like the Tags field is in the Sidecar modules
and can only contain a single tag phrase (e.g. tradeshow, hot lead). While the field
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is case-insensitive, you must know the precise spelling of the tag name that you
wish to use as a filter.

To filter a report by more than one tag, click on the Name field again for each
additional tag. This will produce additional filter rows where you can specify the
appropriate operator and its corresponding tag. In the following example, the
report will display a list of account records that are tagged with any one or more of
the three specified tags (manufacturing, laser, or hot prospect).

When the Tags field is used as a related-module display column in a Rows and
Columns report or Summation Report with Details, the Tags column will display a
separate line item for each tag that a record contains. For example, an account
tagged as both "manufacturing" and "laser" will be displayed twice in an Accounts
report if the report displays the Tags column. Also, note that the Tag column will
only display a single tag even if the record contains multiple tags. This will be the
tag that matches the filter criteria.

Please note that clicking on a hyperlinked tag name from report results will take
you to the tag's record view. For more information on tags in Sugar, please refer to
the Tags documentation.

Filters on Date and Datetime Fields

When creating reports in Sugar, specifying a range of time is a useful way to
isolate your desired results. Sugar provides a set of pre-defined options to help you
easily target the most common date ranges:

Date Range Filter Definition
On A specific day
Before Any value before the specified date
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After Any value after the specified date
Is Between Any values after a specified start date

but before a specified end date
Not On Any values except the specified date
Is Empty No date set for the field
Is Not Empty Any date set for the field
Yesterday A value set to the prior day
Today A value set to the current day
Tomorrow A value set to the following day
Last # Days Any values within the last X days

including the current day
Next # Days Any values within the next X days

including the current day
Last 7 Days Any values within the last 7 days

including the current day (e.g. Running
on Monday includes the previous
Tuesday morning through the end of the
current Monday)

Next 7 Days Any values within the next 7 days
including current day (e.g. Running on
Monday includes the current Monday
morning through the end the following
Sunday)

Last Month Any values that fall within the prior
calendar month

This Month Any values that fall within the current
calendar month

Next Month Any values that fall within the next
calendar month

Last 30 Days Any values within the last 30 calendar
days including the current day

Next 30 Days Any values within the next 30 calendar
days including the current day

Last Quarter Any values within the prior quarter
defined by the calendar year (e.g.
January - March, April - June)

This Quarter Any values within the current quarter
defined by the calendar year (e.g.
January - March, April - June)
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Next Quarter Any values within the upcoming quarter
defined by the calendar year (e.g.
January - March, April - June)

Last Year Any values within the prior calendar
year

This Year Any values within the current calendar
year

Next Year Any values within the upcoming
calendar year

Additionally, if your administrator has configured the Forecasts module via Admin
> Forecasts, additional options based on your organization's fiscal year will be
available. If your fiscal year follows a traditional calendar year, these options will
function in the same way as the corresponding options above:

Date Range Filter Definition
Previous Fiscal Year Any values within the prior fiscal year
Previous Fiscal Quarter Any values within the prior quarter

defined by the fiscal year
Current Fiscal Year Any values within the current fiscal year
Current Fiscal Quarter Any values within the current quarter

defined by the fiscal year
Next Fiscal Year Any values within the upcoming fiscal

year
Next Fiscal Quarter Any values within the upcoming quarter

defined by the fiscal year

For more information about configuring the Forecasts module, please refer to the 
Forecast Configuration documentation in the Administration Guide.

Note: When generating reports with datetime filters, Sugar will always adjust the
results to ensure they are accurate according to the time zone settings of the user
accessing the report. For instance, a user on Eastern Standard Time (-5 GMT) may
see a different set of results for a report than would a user on Pacific Standard
Time (-8 GMT) because the date ranges are adjusted for the user's time zone.

Group By Fields

Summation Reports and Summation Reports with Details allow you to group
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records by one or multiple fields within a module. Select a module in the Related
Modules pane to display the fields by which you can group. Note that some module
fields may not be displayed since only field types that contain set values can be
used for grouping (e.g. text fields cannot be used).

Click field names individually to add them to the Define Group By list, or use the
Search field to locate specific fields. There is no limit to the number of fields you
can include; however, including too many fields may make the report difficult to
read. When there are multiple Group By fields, drag and drop field names to
reorder this list. The first field in the list determines the Y-axis of a chart and the
remaining fields appear as different colors in the chart legend.

Report Display Columns

The display columns step allows users to select which field(s) they would like
included when generating the report. The system will pull data specific to these
fields based on the report criteria for the associated module record. When you
select a field from the Available Fields list, they will be added to the right of the
list with the displayed path of the field (e.g. Contacts > Assigned to User > User
Name). The displayed field paths show users where the field is originating from to
retrieve the value for the report. For example, although "Email Address" appears
as a field in several modules (e.g. Accounts, Contacts, Leads), email addresses are
actually stored in their own table and are related to the modules where they
appear as opposed to being direct fields of those modules. So, the corresponding
displayed path will show the primary module record, then the related module
followed by the field name (e.g. Contacts > Email Address > Email Address) since
the email address field is a field of the related Email Address module.

To remove any unnecessary fields from the display column list, simply click the "-"
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sign to the far right of the displayed field path row.

Changing Display Column Labels

By default, the selected display column fields will display stock labels that can be
changed if you desire. To change the label, simply enter the new label name in the
open text field then click outside of the text box to preserve the change.

Changing Display Column Order

You can change the left-to-right order of the display columns by dragging and
dropping the displayed field paths in the Choose Display Columns section.

Defining Column Sort

You can also designate the generated report to be sorted by a specific field column
in either ascending or descending order. Simply mark the radio button next to the
field label then select "Ascending" or "Descending" in the corresponding dropdown
list. Please note that only one display column can be designated to sort by default
in the report.
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Optional Related Modules

The Optional Related Modules option will appear on the Report Details step if you
add fields from related modules to the display column. Please note that if you want
your report to include records whether or not they have data in the fields, you will
need to mark the displayed module relationship(s) in the Optional Related Modules
section. For example, if you add the email address field as a display column for the
New Leads report, the Optional Related Modules section will display "Leads >
Email Address". Check the box for the Email Address relationship in order to
include all applicable results even if the lead record does not contain an email
address. By default, Sugar treats all related modules in a report as mandatory
meaning that an email address will be required for a lead record to be included.

Leaving this box unchecked will exclude all lead records from your report that do
not have an email address associated with them.

This holds true for all related modules. You will need to check the box for any
relationship you do not wish to be treated as mandatory when Sugar is generating
your report. In order to report on records with no related records of a particular
module (e.g. Contacts without a related Account) using a filter such as Contacts >
Accounts > Name > Is Empty, the Optional Related Modules will also need to be
checked.

Show Query

The Show Query option is only visible to system administrators and displays as a
checkbox on the Report Details step. If the Show Query box is checked and the
Preview button is clicked, the generated report will display all the SQL queries at
the bottom of the page for administrators to use and analyze how the specific data
was retrieved in the system.
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Reports Detail View

The Reports detail view displays thorough report information including display
column fields (if applicable), charts (if applicable), etc. The detail view can be
reached by clicking a report record's link from anywhere in the application
including from the Reports list view. The detail view's Actions menu appears on the
top left of the page and allows you to perform various actions on the current
report. 

Please note that your access to reports and the displayed results in a report will
vary according to your team membership, user type, and role restrictions. For
more information on teams and roles, please refer to the Team Management and 
Role Management documentation in the Administration Guide.

Favorite Designation

Users have the option to mark reports as a favorite via the detail view as well as
the list view. This allows users to designate reports that are important or will be
viewed often so that they can easily be accessed via Advanced search or from the
Reports module tab. In the Reports detail view, the star on the right of the report's
name is yellow once marked to indicate a favorite report. For more information on
how to mark reports as favorites, please refer to the Favoriting Reports section.

Run-time Filters

Run-time filters allow you to quickly change the filter values on the report without
having to edit the report. Please note that run-time filters only appear if filters are
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set in the Define Filters step when building the report. The report will be filtered
based on the original filter value, but you can change the value via the Run-time
filter and click "Apply" or "Run Report" to re-generate the report result. For more
information on run-time filters, please refer to the Run-Time Filters section.

Report Details

By default, the report details box will appear displaying the report's name, display
columns, report type, team(s) assigned to report, etc. To hide the report details,
simply click the Hide Details button on the upper left of the report's detail view.
Once the report details are hidden, the Show Details button will appear in place of
the Hide Details button. Click the Show Details button to display the report details
again.

Report Chart

Users have the option to display the data as a chart which then allows users to drill
into each segment to display the associated records. The chart option is available
for Summation with Details-type, Summation-type, and Matrix-type reports. You
can choose a type of chart for display via the Chart Options step of the Report
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Wizard. Please note that at least one group-by and one calculated display summary
(e.g. Count, AVG: Likely, SUM: Likely) must be selected in order to be able to
display a chart.

The chart is displayed with the report by default and its visibility can be toggled
using the Hide/Show Chart button. After running the report, you can hover on a
segment of the chart to view the corresponding chart values. Clicking on a
segment will open a drawer containing a list of the records making up that
segment. For more information, refer to the Drilling Through Report Charts
section below.

Note: When you make a chart in the Reports module, there is a limit to the
number of groups allowed. The limit is 50 groups for all charts except funnel, for
which the limit is 16. The limit only applies to charts. If the number of elements is
more than 50 (or 16 for funnel), then an error message is displayed at runtime.

Report charts can also be added and displayed as a Sugar dashlet on your Home
page. These Saved Report Chart dashlets also allow for drilling through to access
the associated records. For more information on adding report charts as dashlets,
refer to the Home documentation. Please note that at least one group-by and one
Display Summary column is required to generate a chart.
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Drilling Through Report Charts

In order for drill-through to work for a given report chart, the following conditions
must be met:

When viewing from the Reports module, the report has been run by
navigating to the report's detail view, clicking the Run button, or clicking
"Save and Run" after editing. Drill-through is not supported when
previewing a report during editing.
When viewing from a dashboard, you are viewing a Saved Reports Chart
dashlet. Drill-through is not supported for other dashlets containing charts
(e.g. Pipeline dashlet).
The base module of the report is a Sidecar module. For more information,
refer to the User Interface documentation.
The report is not grouped by a DateTime-type field such as Date Created or
a Multiselect-type field. Reports grouped by aggregate DateTime-fields
(e.g. Month: Date Created) do support drill-through. For more information
on field types, refer to the Studio documentation.

Clicking a segment of a report chart will open a drawer containing a filtered list
view showing the records belonging to that segment. To the right of the list view is
the chart with the currently selected segment highlighted. The segment's applied
filter will also be noted above the list view (e.g. "User Name: max").

The following operations are available when drilling through a report chart:

Select a new segment : Click a different chart segment to update the list
view filters and show the new segment's associated records.
Cancel : Click the Cancel link to close the drawer and return to the
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previous view.
Refresh list and chart : Click the Refresh button to update and reload the
filtered list view results and chart.
Display columns : Click the Gear icon to choose which fields to display.
Open records : Click the name of a record in the list to open it in record
view.
Preview records : Click the Eye icon to the right of any row to preview that
record. Please note that editing records via the preview panel is not
supported while drilling through a chart.
Favorite designation : Click the star on the left of a record's row to toggle it
as a favorite. A dark gray star indicates that the record is a favorite while a
white star indicates it is not.
Record Actions menu : Click the triangle to the right of any row to access
the Record Actions menu to edit, follow, or delete specific records from the
list view.
Checkbox selection : Mark the checkbox on the left of each record row to
select individual records from the list view. Click the checkbox to the left of
the Mass Actions menu to select all records displayed on the current set of
list view results.
Mass Actions menu : Click the triangle to the right of the checkbox option
to access the Mass Actions menu to perform various actions (e.g. Mass
Updates, Delete) on the currently selected records.

Report Chart Options

The Chart Options step of the Report Wizard allows users to choose the chart type
that they want to be displayed on the generated report as well as how to
summarize the data within the chart. Please note that at least one of the calculated
fields (e.g. Count, AVG: Amount, SUM: Amount) in the Choose Display Summaries
step must be selected in order to be able to select a chart type in the Chart
Options step.

The following options are available in the Chart Options step of the Report Wizard:

Chart Type : Select the type of chart that you want to display on your
report. The available chart types are:
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No Chart : The report will not have a chart.
Horizontal/Vertical Bar (Stacked) : Categorical data will be
displayed as rectangular bars with heights or lengths proportional
to the values that they represent. When a secondary grouping
exists, the values will be proportionally stacked within the bars as
color blocks.

Note: For the Saved Reports Chart Dashlet, this chart type
can be used by selecting the chart type
"[Horizontal/Vertical] Bar Grouped Chart" and leaving
"Stack Data Series" disabled in the bar chart display
options.

Horizontal/Vertical Bar (Grouped) : Categorical data will be
displayed as rectangular bars with heights or lengths proportional
to the values that they represent. When a secondary grouping
exists, clusters of bars will be proportionally organized within each
primary grouping.

Note: For the Saved Reports Chart Dashlet, this chart type
can be used by selecting the chart type
"[Horizontal/Vertical] Bar Grouped Chart" and enabling
"Stack Data Series" in the bar chart display options.

Pie : Most useful or visualizing numerical proportions, a pie chart
will depict data as proportional sections where the sum of all data is
100%.
Funnel : Most useful for visualizing values across multiple stages in
a linear process, funnel charts should be used to show values in
decreasing order as data points are filtered out at each stage.
Line : Line charts are only available when a report has two or more
group-by columns. Line charts will comprise a series of data points
connected by line segments and are useful for displaying data
trends over time.

Data Series : Select the data that you want to be summarized by the chart.
The field(s) you selected in the Choose Display Summaries step will be
available to choose in this dropdown list.

Description : Enter a brief description to label the chart.
Round Numbers Over 100000 : Enable this option if you want numbers
over 100,000 to be rounded to the nearest thousand in the report charts.
For example, 150,000 will be displayed as 150K.
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Report Results

The report's detail view will display the report results with relevant data and
report chart (if applicable) for all records that meet the specified criteria. Please
note that each report type will display the report results differently and users
should consider how they would like to view the data prior to creating the report.

Rows and Columns Report Result

The report results for this report type displays the data in simple rows and
columns format. The display column field values for all records that meet the
specified criteria will appear on the report result. You can view a record's details
by clicking on the record's name. You can also sort the report results by a display
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header noting that the fields which allow sorting
will have a pair of arrows. Please note that the report may be sorted by only one
column at a time. To view an example Rows and Columns report result, please
refer to the creating Rows and Columns Report section.

Summation Report Result

The Summation Report provides an overview of the selected field data(s) grouped
by specific criteria(s). The report result displays the data in groups summarized
using computed derivatives (e.g. SUM, AVG, MAX, MIN) from numeric-type field
values (e.g. Likely) as well as weighted amounts. Each field you select in the
Define Group By and Choose Display Summaries steps will be displayed as a
column in the report result. The field(s) in the Define Group By list determines how
the data will be grouped on the report results table and the chart. For example, if
you group the opportunity report by "User Name" then "Month: Expected Close
Date" on the Define Group By list, the opportunity records will be grouped by the
user assigned to the opportunity and each user will be broken up by the month of
the expected close date in the report results. The grand total of the summarized
field values will display at the bottom of the report results page.

You can sort the report results by a field column in either ascending or descending
order. To sort by a field or switch the sort direction, click the column header
noting that the fields which allow sorting will have a pair of arrows. Please note
that the report may be sorted by only one column at a time. To view an example
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Summation report result, please refer to the Creating Summation Report section.

Summation Report with Details Result

The Summation Report with Details groups the data and displays the total
summary count for records in the report result. Unlike the Summation Report, this
report type includes display columns for fields related to the target and related
module. The report result will group the data in different categories based on the
specified field values. If you choose to display the data as a chart, it will appear at
the top of the report results page. The field values for all records that meet the
specified criteria will be displayed in a rows and columns type table broken up into
grouped panels. You can sort the report results by a field column in either
ascending or descending order. To sort by a field or switch the sort direction, click
the column header (e.g. Expected Close Date) noting that the fields which allow
sorting will have a pair of arrows. Please note that the report may be sorted by
only one column at a time. You can also view the record's details by clicking the
record name.

Each panel header will display the grouped by field value(s) along with the total
summary count for the group. You can collapse the grouped panels individually by
clicking the double up arrow to the far left of the header or click "Collapse All" to
collapse all panels. Collapsed panels will display the header with the display
summaries for each group and you can click the double down arrow to open the
panels again. The grand total for the summarized field values will appear at the
bottom of the report results page. To view an example Summation with Details
report result, please refer to the Creating Summation Report with Details section.

Matrix Report Result
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The Matrix report groups the fields based on the group-by fields and displays the
summary for specific numeric-type field values that you select. The report result
displays the data in a grid table with row and column headers. If you selected
three group-by columns, then you will have the option to choose specific report
layouts (e.g. 1x2 and 2x1) on the Report Details step. The 1x2 layout option will
display the data for the first group-by field in a row and display the data for the
other two group-by fields in columns. The 2x1 layout option will display the data
for the first two group-by fields in rows and display the data for the third group-by
field in a column. The report results will show the grand total for each field row on
the table as well as for each column. To view an example Matrix report result,
please refer to the Creating Matrix Report section.

Viewing Currency Fields

When the viewing user's profile has the Show Preferred Currency option selected,
all currency values will be displayed in reports using the user's preferred currency.
The values will use the current conversion rate set in Admin > Currencies at the
time the report is run. This means that the displayed value may not be historically
correct for closed business since the conversion rate of the user's preferred
currency may have changed since the purchase was completed.

When the user does not have this option selected, reports will display all currency
values in the system's default currency. To keep amounts historically accurate, the
conversion rate will only update on on currency fields when the business is still
open and under the following scenarios:

The record undergoes a save event (e.g. mass update, manual save) and the
record's currency has a different conversion rate defined in Admin >
Currencies than is currently saved.
An administrator updates the currency exchange rate under Admin >
Currencies. This will trigger a scheduled job which updates all records
saved with that currency to the new rate.

For more information about currency exchange rates, please refer to the System
documentation in the Administration Guide.

Running Reports
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Once the reports are generated and saved in Sugar, you can view the report
results at any time. While viewing the report's detail view, there may be times
when you need to re-run the report to generate new report results. The Run Report
button on the upper left of the report's detail view allows you to refresh and run
the report to re-generate report results. For example, if you make a change to the
run-time filter on the report, you can click "Run Report" to generate the report
based on the new filter values. For more information on run-time filters, please
refer to the Run-Time Filters section. You can also click "Run Report" each time
you want to re-generate the report to capture new records not included in the
current report results.

Editing Reports

Reports may be edited at any time to refine or adjust the report's details or
criteria. There are various methods of editing the report from the Reports detail
view and Reports list view. Regardless of where you initiate the edit, you will
always go through the Report Wizard to make the necessary changes to your
report.

You can edit the report by going through the Report Wizard step-by-step using the
Back and Next button or by clicking the step's link (e.g. Define Filters, Choose
Display Columns, Choose Display Summaries) in the breadcrumbs at the top of the
Report Wizard. When ready, click "Save and Run" to preserve the changes made
and generate the report. If any users have created a scheduled report based on the
edited report, the changes will automatically be reflected the next time they
receive a copy of the report.
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Please note that your ability to edit reports in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Edit options.

Editing via Detail View

You can edit reports via the detail view by clicking "Edit" in the Actions menu on
the upper left of the page. This will open the Report Wizard where you can make
the necessary updates to the various steps (e.g. Define Filters, Define Group By,
Choose Display Columns, Choose Display Summaries). Once the changes are
complete, click "Save and Run" to preserve the changes made and generate the
report again.

Deleting Reports

If a report is invalid or should no longer appear in your organization's Sugar
instance, it may be deleted from either the Reports detail view or list view.
Deleting via the detail view allows you to delete a single report while the list view
allows for deleting one or more records at a time. Deleting a report from Sugar will
also delete any report schedule records related to the report.
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Please note that your ability to delete reports in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation in the Administration Guide. Check with your system administrator
if you do not see the Delete options.

Deleting via Detail View

Use the following steps to delete a report via the detail view:

1. Navigate to a report's detail view.
2. Select "Delete" from the Actions menu.

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Exporting Reports

The Export option allows users to export a report's results as a CSV file. For more
information on exporting records in Sugar, please refer to the Export
documentation. Please note that your ability to export reports from Sugar may be
restricted by a role. For more information on roles, please refer to the Role
Management documentation in the Administration Guide. Check with your system
administrator if you do not see the Export option.

Exporting reports is useful when you need to use Sugar data with other software
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such as Microsoft Excel. You can also use exported report results to update
existing Sugar records by creating a report (including Record IDs), exporting,
making changes, then importing the altered data back into Sugar. For more
information on updating existing records via import, please refer to the Import
documentation.

Note: Due to PHP memory limitations on the server, there may be occasions when
the application times out while exporting a report with a large amount of data. If
you encounter an error when performing this action, we recommend breaking up
the report into smaller batches.

Printing Reports as PDFs

Sugar's Print as PDF option in the Reports module allows users to download the
reports to PDF files onto their local machine. This may be useful when needing to
email the file to other members of the team to share the report data or to keep
track of key historical data from the system. You can also view charts on the
downloaded PDF files for Report types (e.g. Summation Report with Details,
Summation Report, Matrix Report) with chart options.

Please note that your ability to print PDF reports from Sugar may be restricted by
a role preventing the export of data. For more information on roles, please refer to
the Role Management documentation in the Administration Guide. Check with your
system administrator if you do not see the Print as PDF option.

Use the following steps to download a copy of a report as a PDF file via the
Reports detail view:

1. Navigate to a report's detail view.
2. Select "Print as PDF" from the Actions menu.

3. Open the downloaded PDF file to view the report and save it to your local
machine if you wish.

Scheduling Reports
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Users can schedule regular email deliveries of Sugar reports to themselves and
other Sugar users via the Reports Schedule module. Scheduled reports will be
delivered as PDF file attachments to the users' primary email addresses in Sugar.
When scheduling a report, you can choose the date and time to start sending
reports and at what interval you wish to continue receiving them. If you choose to
receive the report at a specified time of day, Sugar will output the report and email
it to you at that time according to the time zone set in your user profile. If you are
configuring the scheduled report for multiple users, then Sugar will convert the
time of day to UTC so that each user receives the report simultaneously regardless
of their time zones.

Note: Scheduled reports may arrive after the set time based on the cycle
increment set by your administrator for the Run Report Generation Scheduled
Tasks scheduler. For more information, please refer to the Report Schedule
Requirements section.

Please note that your ability to schedule reports from Sugar may be restricted by
your role settings. Check with your system administrator if you do not see the
option to schedule a report. Furthermore, delivery to users added to a scheduled
report may be prevented by teams or roles. For example, if a user schedules a
report for a user who does not have access to the report, then the restricted user
will not receive the report. For more information on roles, please refer to the Role
Management documentation in the Administration Guide.

Note: Reports that contain charts in Sugar will not have a chart in the PDF version
of the scheduled report.

Report Schedule Requirements

The Report Schedules module requires the following configurations:

User email settings : A personal outgoing email account must be
configured by the user scheduling a report. For more information on
setting up individual email accounts, please refer to the Emails
documentation in the Application Guide.
System mail server : The outgoing mail server for the Sugar system must
be configured by an administrator. For more information on setting up the
system email settings, please refer to the Email documentation in the
Administration Guide.
Scheduler activation : The Run Report Generation Scheduled Tasks
scheduler must be activated by an administrator (default is inactive) and
configured to run at proper intervals. For example, if the scheduler is set to
trigger once per day and a user schedules a report to be delivered every
hour, the report will only be delivered once each day due to the interval set
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in the scheduler. The administrator must change the interval for the
scheduler to run at least every hour for the user's report to be delivered
hourly. For more information on configuring schedulers, please refer to the
Schedulers section of the System documentation.

Report Schedule Fields

The Report Schedules module contains the following fields:

Field Description
Active The enabled (Active = true) or disabled

(Active = false) state of the scheduled
report event
Note: Disabled report schedule records
will not send emails.

Assigned to The Sugar user assigned to the report
schedule record
Note: The Assigned To user is not
always the same user as the recipient of
the scheduled report.

Created by The Sugar user who created the report
schedule record

Date Created The date and time that the report
schedule record was created

Date Modified The date and time that the report
schedule record was last modified

Description A description or other information about
the scheduled report event

Name A unique and descriptive name for the
scheduled report event

Next Email Scheduled For The date and time that the next report
will be emailed to the recipient(s)

Repeat Type The interval of time between
recurrences

Report The related Report that will be emailed
as a PDF file attachment to the
recipient(s)

Start Date The date and time that the first report
will be emailed as a PDF file attachment
to the recipient(s)
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Teams The Sugar team(s) with access the
scheduled report record (subject to role
permissions)

In addition to the Report Schedule fields, the Users subpanel under a report
schedule record contains the following User module fields:

Field Description
Department The department where the user works

as saved in their user profile
Full Name The user's first and last name
Status The status of the user's record (e.g.

Active or Inactive)
Title The user's title as saved in their user

profile
User Name The user's Sugar username

Please note that the Report Schedule fields and the fields in the Users subpanel
cannot be edited via Studio.

Creating Report Schedules

Use the following steps to schedule an automated report for delivery to your email
inbox:

1. Navigate to the Reports module and create a new report schedule via one
of the following methods:

The actions menu on a report's detail view:

The report's actions menu in the Reports list view:
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Via the Report Schedules module directly:
Use the Report Schedules link in the Reports module tab
and then click the Create button at the top of the list view:

2. If necessary, use the Search and Select functionality to choose a report in
the Report field. This will only be necessary when scheduling a report via
the Create button in the Report Schedules module.

3. Give the scheduled event a descriptive name that you can find later. For
example, "Will's daily call list - 9am".

4. Complete the Repeat Type and Start Date fields with the frequency of
delivery and desired date and time to receive your first emailed report.
Optionally, add a description. For more information on the available fields,
please refer to the Report Schedule Fields section.

5. Click "Save".

After saving, you can view the report schedule record to edit, disable (i.e. set
"Active" to false), or delete the scheduled email as your role permits. If you would
like to add more users to the distribution list for the scheduled report, please refer
to the Adding Users to Report Schedules section.
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Adding Users to Report Schedules

Use the following steps to schedule an automated report for delivery to the email
inboxes of other Sugar users:

1. Follow the steps in the Creating Report Schedules section to create a
scheduled report for yourself. If you do not want to receive this scheduled
report, you still need to create the record for yourself but can unlink your
user record in the following steps.

2. Next, navigate back to the report schedule record by clicking the link in the
confirmation message or using the View Schedules option on the related
report record.

3. On the report schedule's record view, scroll down to the Users subpanel.
4. Click on the subpanel's Actions menu and select "Link Existing Record".

5. Find and select the user or users you would like to add to the scheduled
report's distribution list and then click "Add".

6. To remove users from the distribution list, click the Unlink button next to
the user's name in the Users subpanel for the report.

Copying Report Schedules

Users with the appropriate role permissions can schedule new reports via
duplication, which will copy the entire user recipient list over to a new report
schedule record. Simply select "Copy" from a report schedule record's actions
menu. Give the copy a unique name, update the related report field and scheduled
times as needed, and save. The related user recipients will copy over to the new
report schedule record.
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If needed, you can add more users to the distribution list or remove users by
clicking the Unlink button next to a user's name in the Users subpanel.

Viewing Report Schedules

You can navigate directly to the Report Schedules module to access the Report
Schedules list view. There is a link to the Report Schedules module in the Reports
module tab menu:

In addition, you can view only the scheduled reports related to a given report using
the "View Schedules" option on the report's actions menu in list view or detail
view. When using "View Schedules" from a report's actions menu, Sugar will
automatically filter the Report Schedules list view to show only records related to
that report.
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Click on the name of a record to view its details and edit or add users to the report
schedule. To disable a report schedule, deselect its Active checkbox and save. For
more information on working with list views and editing records in Sugar, please
refer to the User Interface documentation.

Favoriting Reports

Users have the option to mark records as favorites via the report's detail view. This
allows users to designate records that are important or will be viewed often so that
they can easily be accessed via the search filter or from the Reports module tab. 

Favoriting via Detail View

Use the following steps to mark records as favorites via the Reports detail view:

1. Navigate to a report's detail view.
2. Click the star icon to the right of the report's name on the upper left of the

detail view to designate it as a favorite.
3. To remove the report as a favorite, click the star again to revert it to white.

Sharing Reports

Individual reports can be shared with other users in your organization by sending
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an email containing the record's link directly from the detail view. In the report's
detail view, select "Share" from the Actions menu. This will open a Compose Email
window that includes the URL of the report in Sugar. Enter the recipient(s) email
address in the To field then click "Send".

Users can simply click the link in the email to access the report in Sugar. Please
note that the user must be logged in to Sugar in order to access the record, and its
visibility will depend upon their team membership, user access type, and assigned
roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation in the Administration Guide.

Note: To send emails through Sugar, users must first configure a default user
email account via Emails > Email Settings. 

Adding Report Results to Target Lists

A target list consists of a group of individuals or organizations you wish to be
included or excluded from a mass marketing campaign. These targets are typically
identified based on a set of predetermined criteria such as being a prospect or
existing customer, age group, industry, etc. The Reports module gives users the
ability to add a large number of records (e.g. Contacts, Leads, Accounts) to a
target list at once instead of selecting them one-by-one.

For example, if you need to add all leads in the state of California to a target list,
you can create a report based on the Leads module filtered by the Primary Address
State field (e.g. CA). After saving the report, navigate to the Target Lists module
and select the desired target list record you wish to add the report results to.
Scroll down to the Leads subpanel, click the Actions menu, and choose "Select
from Reports". Select the saved lead report from the Search and Select Reports
drawer and all lead records from the report will be added to the target list.
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For more information on adding records to target lists, please refer to the Target
Lists documentation. Please note that Sugar allows up to 1000 records to be added
at a time when adding to a target list. If you desire to add more than 1000 records
to a target list, you will need to create the reports in several batches.

Last Modified: 2020-03-11 16:39:50

Advanced Reports

Overview

Advanced reports allow users to create custom reports using a single or a
combination of SQL statements to directly query your Sugar database. Although
the Reports module may be used to create many kinds of reports, users with SQL
knowledge may use advanced reports to craft direct database queries for more
flexible and extensible reporting. 

Advanced reports are a combination of three related modules:

Custom Queries : Custom query records contain the SQL statement used
to pull information from the database.
Data Formats : Data format records describe how to format and display
the results of the related custom query. Data formats may also be
interrelated to create child/parent combinations of queries.
Advanced Reports : Advanced report records serve as headers for the
report and may display one or more data format. The advanced report
record may also be scheduled to be automatically run and emailed to a
user.

Note: You must be an administrator in order to create, edit, and delete custom
queries, which are required for the full advanced report. Non-admin users can
view advanced reports, custom queries, and data formats according to their team
access. Admin users wishing to build advanced reports must first be familiar with
SQL and Sugar's database structure in order to write the necessary custom
queries.

Advanced Reports Module Tab

Advanced Reports may be accessed by navigating to the Reports module which is
typically located on the navigation bar at the top of any Sugar screen. Click the tab
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to access triangle to the right of the Reports tab, then click "Manage Advanced
Reports" from the actions menu.

From within the Advanced Reports module, clicking the Advanced Reports tab in
the navigation bar will display the list view. Click the triangle to the right of
"Advanced Reports" to access the Actions menu. Below the Actions menu is the
Recently Viewed menu displays the three advanced reports you have most recently
opened. 

The Actions menu allows you to perform the following operations:

Menu Item Description
Create Advanced Report Opens the edit view layout to create a

new advanced report
View Advanced Reports Opens Advanced Reports list view to

search and display advanced reports
Create Custom Query Opens the edit view layout to create a

new custom query
View Custom Queries Opens Custom Queries list view to

search and display custom queries
Create Data Format Opens the edit view layout to create a

new data format
View Data Formats Opens Data Formats list view to search

and display custom queries
View Reports Opens the Reports tab to create and

view standard reports

Creating Advanced Reports

Since a single advanced report consists of records from three different modules,
the following instructions will step through creating a record within each module
and relating those records to generate a report. First, a custom query record will
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be created, then a data format, and finally an advanced report record. The fields
specific to each module are described prior to each set of creation instructions.

Custom Query Fields

The Custom Query module contains a number of stock fields that come out-of-the-
box with Sugar. The below definitions are suggested meanings for the fields, but
the fields can be leveraged differently to best meet your organization's needs.

Field Description
Custom Query The SQL select statement that will

retrieve information from the database
Description A description or other information about

the custom query
Lock Query Option to toggle editability of the

Custom Query field
Query Name The name of the custom query
Teams The Sugar team(s) assigned to the

custom query record

Creating Custom Query Records

Advanced reports enable you to create reports using complex SQL queries that
cannot be expressed in standard reports. The SQL query is contained in a custom
query record. Each custom query record can be related to multiple data format
records which allows it to be reused in multiple reports.

1. Click the triangle in the Advanced Reports module tab to open the actions
menu and select "Create Custom Query".
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2. Enter appropriate values for the fields in the edit view layout. All required
fields will display a red asterisk and must be completed prior to saving. The
SQL select statement you wish to run against the database should be input
to the Custom Query field

3. Click "Save".

After you click "Save", Sugar will determine whether the SQL statement provided
in the Custom Query field is valid. If it is not, Sugar will display an error message
and provide an opportunity for you to correct the SQL. The custom query record
may not be saved unless the SQL statement is deemed valid by Sugar.

Data Format Fields

Field Description
Body Background Color The color of the background of the data
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cells in the report display
Body Text Color The color of the text of the data in the

report display
Combine with Previous Data Format Specifies whether space should appear

between this table and the previous data
format's table when a report includes
multiple data formats

Data Format Name The name of the data format
Description A description or other information about

the data format
Exportable (CSV File Only) Specifies whether this table is available

to be exported as a CSV file
Font Size The size of the font in the report output
Group with Previous Header Specifies whether the column widths

should match those of the previous data
format's table when a report includes
multiple data formats

Header Background Color The color of the header background in
the report display

Header Text Color The color of the header text in the
report display

Parent Data Format When setting up interlocked queries, the
parent data format containing the
parent query of your current, child
query and data format

Query Name The custom query record which will be
formatted by this data format

Report Name The related advanced report record; this
value automatically populates once
linked to an advanced report

Sub/Child Query When this data format is set as the
parent format of a child record, the
name of the child query will be
automatically populated

Show Header Specifies whether a row including
column names should appear above data
rows in the report display

Table Width % The width of the table in the report
display as a percentage or pixels

Teams The Sugar team(s) assigned to the data
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format record

Creating Data Format Records

A data format specifies report formatting details such as the text font, text color,
and the background color for a particular SQL query contained in a custom query
record. You can reference other data formats within a data format. The query
contained in the referenced data format is considered to be the sub-query or the
child-query. When a data format references another data format, the data formats
are interlocked. Interlocked reports are used to produce information from separate
queries in a parent-child pattern. For more information, please refer to the 
Interlocked Reports section of this page.

1. Click the triangle in the Advanced Reports module tab to open the actions
menu and select "Create Data Format".

2. Enter appropriate values for the fields in the edit view layout. All required
fields will display a red asterisk and must be completed prior to saving. For
the Query Name field, type or select the custom query record created in
the steps above.

3. Click "Save".
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Advanced Report Fields

The Advanced Reports module contains a number of stock fields that come out-of-
the-box with Sugar. The below definitions are suggested meanings for the fields,
but the fields can be leveraged differently to best meet your organization's needs.

Field Description
Description A description or other information about

the advanced report
Report Alignment The alignment of the advanced report

text
Report Name The name of the advanced report
Report Title The title of the advanced report
Teams The Sugar team(s) assigned to the

advanced report record

Creating Advanced Report Records

1. Click the triangle in the Advanced Reports module tab to open the actions
menu and select "Create Advanced Report".
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2. Enter appropriate values for the fields in the edit view layout. All required
fields will display a red asterisk and must be completed prior to saving.

3. Click "Save".

Relating the Advanced Report and Data Format Records

After creating all three types of records as described above, use the following
steps to relate the advanced report record to one or more data format records:

1. Click the Advanced Reports module tab to access the Advanced Reports list
view.

2. Search for the advanced report record created in the steps above and click
the record's name to open it in detail view.

3. Below the advanced report information, click the Select button.
4. Find the data format record created in the steps above and click the

record's name to link it to the advanced report.

Running Advanced Reports

Finally, click on "Run Report" and it will return a custom report populated with
results from your custom query and displayed with your designated data format.

Aggregating Queries on a Single Report
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 A single advanced report record may relate to one or more data format records,
each of which includes its own query. The bottom of an advanced report detail
view displays a list of data formats included in the report. When multiple data
formats are included on a single report, their individual tables will be stacked. Two
data format fields, "Combine with previous Data Format" and "Group with Previous
Header" will affect how multiple data formats are displayed on a single report.

The following actions are available on an advanced report detail view for
manipulating its related data formats:

Create New : Create a new data format record which will be automatically
related to this advanced report
Select : Select an existing data format record to relate to this advanced
report; only data formats which are not already related to a report and do
not have a parent data format will be available for selection.
Up : Move a data format's table to a higher position in a report containing
several data formats.
Down : Move a data format's table to a lower position in a report
containing several data formats.
Edit : Open the data format in edit view in order to make changes
Delete : Remove the data format from this report; the data format record
will not be deleted

Note: A data format record can only belong to one advanced report. If you wish to
use one custom query with several reports, you must create a separate data format
record for each report - each of which may relate to the single custom query
record. Also, data formats that have a parent data format (as displayed in the
Parent Format field) are considered child data formats and may not be directly
added to a report. Parent data formats which have child data formats are eligible
to be included on a report.

Adding Multiple Data Formats to a Report

For our example, we will add two different data formats to a single report to show
the 6-month sales pipeline. First, we want to show the total revenue for
opportunities with expected close dates in the next 6 months. We divide the
opportunity revenue between new business and existing business and also provide
a sub-total of revenue for each month and revenue source (new/existing business).
This first query is named "Query Opp Revenue by Business Type" and the first data
format is named "Data Set Opp Revenue by Business Type". Data Set Opp Revenue
by Business Type has the Query Name field set to "Query Opp Revenue by
Business Type".

Second, we want to show the revenue expected for the next 6 months from each
account, providing a greater level of detail of our revenue sources. This query lists

                       976 / 1.116



 

each account and the revenue expected for opportunities related to those accounts
with expected close dates in the coming 6 months and a summation column at the
end. This second query is named "Query Opp Revenue by Account" and the second
data format is named "Data Set Opp Revenue by Account". Data Set Opp Revenue
by Account has the Query Name field set to "Query Opp Revenue by Account".

These two data formats on a single advanced report record produce the following
result:

Interlocking Parent/Child Queries

Sugar allows you to interlock two queries in a parent/child relationship by relating
two data format records. This allows for more complex report results that are
displayed in a parent/child format mirroring the queries' relationship. Sugar will
first run the parent query, then, for each row of the parent query, it will run the
child query.

Use the following steps to interlock a pair of simple queries as an example:

1. Create a custom query record called "All Users Query" with the following
SQL statement:
Select id, user_name from users

2. Create a second custom query record called "Accounts By Users Query"
with the following SQL statement:
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Select name, assigned_user_id from accounts where assigned_user_id =
'{sub}id{sub}'

3. Create a data format record called "All Users Format" with the Query
Name field set to "All Users Query".

4. Create a data format record called "Accounts By Users Format" with the
Query Name field set to "Accounts By Users Query" and the Parent Data
Format field set to "All Users Format".

5. Create an advanced report record.
6. From the advanced report's detail view, use the Select button to choose

"All Users Format".
7. Click the Run Report button.

The '{sub}id{sub}' is inserted to the child query to refer to the parent query's
current result row. In this example, Sugar will generate a list of user names and
id's. Below each user row, a list of accounts assigned to that particular user will
appear. The child query is returning assigned_user_id to help make the
functionality clear.

Please note that a child data format cannot be run from its own record nor added
to an advanced report record. Only by running its parent data format or adding its
parent data format to a report will the child query's results be displayed.

Note: Only two data formats may be interlocked at a time. Chains of three or more
data format records will cause Sugar not to recognize the queries three or more
levels deep.

Column-Level Formatting

Each data format includes formatting options such as color, size, etc which affect
the entirety of the custom query's table and header. These options are available
while editing the data format record and include these fields. In addition, each
column of a query's table may be formatted individually using the options available
on the detail view of a data format record. Please note, in order for these options
to be available, the related custom query must be returning at least one row.
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Formatting a Column's Header

Once you have created a data format record including choosing a custom query
record that will return at least one row of data, a table will be displayed at the
bottom of the data format record's detail view. The following options are available
for formatting a particular column's header:

Field Description
Display Name Replaces the text of the column's header

which defaults to the column name
specified in the custom query's SQL
statement

Display Type The display type of this column's header
text

Font Size The size of this column's header text
Font Style Specifies if the column's header text

should be bolded or italicized
Format Type The displayed format (Month, Quarter,

Year, etc.) of this column's header text
Header Background Color The background color of this column's

header
Header Text Color The text color of this column's header
Wrap Text Specifies if long text in this column's

header should wrap to multiple lines

The following steps will walk through modifying the header to display a desired
column name rather than the field name shown by default:

1. Navigate to the detail view of a data format record whose custom query is
returning at least one row of data.

2. Click the pencil icon above the table column you wish to format.

3. Check the "Modify Header Attributes" checkbox in the pop-up window.
4. Type "Sally Bronsen's Activities" in the Display Name field and make any

other desired modifications.
5. Click "Save" then "Close".
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After closing the pop-up window, the table will refresh to show the changes you
made to the column. For our example, the column name "activity_type" has been
replaced with the text "Sally Bronsen's Activities".

Formatting a Column's Body

Once you have created a data format record including choosing a custom query
record that will return at least one row of data, a table will be displayed at the
bottom of the data format record's detail view. The following options are available
for formatting a particular column's data cells:

Field Description
Body Background Color The background color of this column's

data cells
Body Text Color The text color of this column's data cells
Font Size The size of this column's data cell text
Font Style Specifies if this column's data cell text

should be bolded or italicized
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Format Type Specifies if this column's data cell text
should be formatted as plain text,
currency, date, or datetime values

Table Width The width of this column's data cells and
header as a percentage of the table
width or as an absolute number of pixels

Wrap Text Specifies if long text in this column's
data cells should wrap to multiple lines

The following steps will walk through modifying a column to display a column of
datetime data as a simple date value as an example:

1. Navigate to the detail view of a data format record whose custom query is
returning at least one row of data.

2. Click the pencil icon above the table column you wish to format.

3. Check the "Modify Body Attributes" checkbox in the pop-up window.
4. Choose "Date" for the Format Type field and make any other desired

modifications.
5. Click "Save" then "Close".

After closing the pop-up window, the table will refresh to show the changes you
made to the column. For our example, the column of database datetime values will
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now be displayed as simple date values.

Hiding Columns

If an individual column should not be displayed in a report's output, the column
may be marked as hidden on the data format record. This will prevent it from
being displayed when running an advanced report which includes the data format.

Use the following steps to hide a column from a report's output:

1. Navigate to the detail view of a data format record whose custom query is
returning at least one row of data.

2. Click the pencil icon above the table column you wish to format.

3. Select the Hide Column in Report checkbox.
4. Click "Save" then "Done".

Reordering Columns

 The default column order of a table is determined by the SQL statement used in
the custom query record. The column order can be changed at the data format
record level when a different order is desired on the data format or in the final
advanced report record.
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Use the following steps to change the column order for a data format record:

1. Navigate to the detail view of a data format record whose custom query is
returning at least one row of data.

2. At the top of a column, click the right arrow to move the column one
position right. Click the left arrow to move it one position left.

Scheduling Advanced Reports

Advanced reports can be scheduled to be emailed to users periodically based on
specified date and time intervals. Please note that each individual user has to
schedule the report in their Sugar account in order for the reports to be delivered
to them. Sugar will run the advanced report at the specified interval based on the
set time zone in user preferences and send the data output as a CSV file to the
email address associated with your profile.

The outbound mail server for the system as well as the user's email settings must
be configured properly in order for the reports to be delivered successfully. For
more information on setting up the system email settings, please refer to the Email
documentation in the Administration Guide. For more information on setting up
your user preferences' email settings, please refer to the Getting Started
documentation.

The Run Report Generation Scheduled Tasks scheduler in Sugar processes all
scheduled advanced reports to be delivered to the user at the scheduled interval.
By default, this report scheduler is set as "Inactive" for new Sugar installations.
Administrators must check to make sure that the Run Report Generation
Scheduled Tasks scheduler is active and the settings (e.g. interval) are configured
properly. For example, if the scheduler is set to trigger once per day and a user
schedules a report to be delivered every hour, the report will only be delivered
once each day due to the set interval in the scheduler. The administrator must
change the interval for the scheduler to run every 1 hour in order for the user's
report to be processed and delivered per their scheduled interval. For more
information on configuring schedulers, please refer to the Schedulers section of
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the System documentation.

Scheduling Via List View

Use the following steps to schedule an advanced report via the list view:

1. Navigate to the Advanced Reports list view.
2. Click "-- None --" in the Schedule Report column of the report you wish to

schedule. If you wish to update an existing schedule, click the date shown
in the Schedule Report column.

3. In the pop-up window, enter the start date/time and select the time interval
for report delivery. Check the Active checkbox then click "Update
Schedule" to schedule your report.

Please note that you must mark the Active box in order to activate
the report schedule.

Once the report is scheduled successfully, the date and time for the scheduled
report will appear in the list view row for the specific advanced report.

Exporting Data Formats

Sugar's Export option allows users to download the data in individual data format
tables as a .csv (comma-separated values) file. This may be useful when needing to
use the report data with other software such as Microsoft Excel. In order for the
tables belonging to an advanced report or data format record to be available for
export, the data format record's "Exportable (CSV File Only)" field must be
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checked. Due to PHP memory limitations on the server, there may be occasions
when the application times out while exporting a table with a large amount of data.
If you encounter an error when performing this action, we recommend breaking up
the queries in smaller batches. For more information on exporting records in
Sugar, please refer to the Export documentation. Please note that your ability to
export reports from Sugar may be restricted by a role. For more information on
roles, please refer to the Role Management documentation in the Administration
Guide. Check with your system administrator if you do not see the Export option.

Exporting Via Advanced Reports

Use the following steps to export a data format table from an advanced report:

1. Open an advanced report record in detail view by selecting it from the
Advanced Reports list view or the list of recently viewed reports in the
actions menu.

2. Click "Run Report" at the top of the detail view.
3. Click "Export" above the desired table in order to start the download.

Note: If the "Export" link is not displayed, you must edit the data format
record and check "Exportable (CSV File Only)".

Exporting Via Data Formats

Use the following steps to export a data format table from a data format record:

1. Navigate to the detail view of a data format record whose custom query is
returning at least one row of data.

2. Click "Export" above the desired table in order to start the download.
Note: If the "Export" link is not displayed, you must edit the data format
record and check "Exportable (CSV File Only)".

Last Modified: 2022-02-11 16:32:21

Stock Reports

Overview

Sugar's Reports module comes with a number of pre-built, stock reports. These
reports display information from Sugar modules (e.g. Accounts, Contacts,
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Opportunities, etc.) that will help provide insights into your CRM data. This page
lists each of the stock reports that come out-of-the-box with the current version of
Sugar and helps explain the type of information provided in each report.

Please note that Sugar ships with over 100 stock reports, which may vary by
version. For descriptions of stock reports that shipped with previous versions of
Sugar, please refer to the Understanding Legacy Stock Reports article. In addition
to stock reports, users can create their own reports. For more information on
creating reports, please refer to the Reports documentation.

Viewing Stock Reports

All of Sugar's stock reports can be accessed via the Reports module. From the
Reports list view, stock reports can be identified using stock report tags and stock
report filters. You may also preview a stock report from list view to read its
description and other information from the report's fields. For more information on
previewing reports, please refer to the User Interface documentation.

If you do not see the Reports module tab in the navigation bar, please check your
user profile to see if the module may be marked as hidden. For more information
on hiding and displaying modules, please refer to the Getting Started
documentation. If the Reports module is not marked as hidden in your user profile,
then check with your administrator to confirm that the module is enabled for your
instance. Please note that team and role restrictions also apply to report results
and affect what records users can see when they run the reports. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation.

Stock Report Tags

Stock reports are automatically tagged in Sugar with the "Stock Report" tag. Each
report also has a category tag such as "Administration" or "Sales and Marketing".
The reports listed on this page under Stock Reports by Category are organized by
the reports' category tags in Sugar. Users can filter the Reports list view by tag as
explained in the User Interface documentation.

Stock Report Filters

The Reports list view search provides a filter option that allows users to narrow
the list of visible reports. In addition to the default module filters, the following
filters are available for the Reports module:
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Stock Reports : Filter the list view to show only stock reports.
Non-Stock Reports : Filter the list view to hide all stock reports.
With Charts : Filter the list view to show only reports designed with
charts.

Users can further refine the results by typing a search query in the search bar and
can create and save their own custom filters. For more information on searching
and filtering the list view, please refer to the Search documentation.

Editing Stock Reports

Any user with the proper team and role permissions may edit a stock report as
they would edit any other report, but it is not recommended. Instead, we
recommend duplicating the report and saving the edited copy with a new name
and description. This will preserve the stock report's state as it was made by
Sugar. To copy a stock report, simply follow the steps in the Reports
documentation to create a report via duplication. For more information on
restoring deleted stock reports, please refer to the Restoring Deleted Stock
Reports section of this page.

Stock Reports by Category

The reports on this page have been shipped with the current version. For more
information on reports that shipped with previous versions but are no longer being
shipped in current versions of Sugar, please refer to the Understanding Legacy
Stock Reports article.

Administration Reports

The following reports were designed for administrators to gain insight into teams
and users, usage patterns, and the performance of their Sugar instance. The
reports in this section are tagged "Stock Report" and "Administration" in the
Reports module. 

Note: The tracker settings must be enabled via Admin > Trackers before tracker
data becomes reportable in Sugar. Please refer to the Understanding Tracker
Reports article for in-depth descriptions of each stock tracker report.

Name Module Type Chart Type Description
Active User
Sessions (Last

Tracker
Sessions

Rows and
Columns

Lists the
duration of all
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7 Days) user sessions
over the last 7
days

Licensed User
List

Users Rows and
Columns

Administrators
can refer to
this report in
order to
periodically
check the
number of
active users
counting
against their
license and
ensure that
they are not
close to
exceeding their
limit.

List of Teams
and Licensed
Users

Teams Summation
with details

Provides the
list of teams
and the
number of
users in the
team. Group
and portal
users are
excluded from
this list.

Modules Used
By My Direct
Reports (Last
30 Days)

Trackers Summation Horizontal Bar Displays a
summary of
module usage
in the past 30
days for all
users who
report to the
user who is
running the
report

My Module
Usage (Last 30
Days)

Trackers Summation Horizontal Bar Displays a
summary of
module usage
in the last 30
days for the
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current user
My Module
Usage (Last 7
Days)

Trackers Summation Horizontal Bar Displays a
summary of
module usage
in the last 7
days for the
current user

My Module
Usage (Today)

Trackers Summation Horizontal Bar Displays a
summary of
module usage
so far today for
the current
user

My Recently
Modified
Records (Last
30 Days)

Trackers Rows and
Columns

Lists records
assigned to the
current user
that were
saved in the
last 30 days

My Records
Modified (Last
7 Days)

Trackers Rows and
Columns

Lists records
assigned to the
current user
that were
saved in the
last 7 days

My Usage
Metrics (Last
30 Days)

Tracker
Performance

Summation Shows the total
server
response time
in seconds,
total number of
database round
trips, and total
number of files
accessed for
the user who is
running the
report in the
last 30 days

My Usage
Metrics (Last 7
Days)

Tracker
Performance

Summation Shows the total
server
response time
in seconds,
total number of
database round
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trips, and total
number of files
accessed for
the user who is
running the
report in the
last 7 days

My Usage
Metrics
(Today)

Tracker
Performance

Summation Shows the total
server
response time
in seconds,
total number of
database round
trips, and total
number of files
accessed for
the user who is
running the
report so far
today

Records
Modified By My
Direct Reports
(Last 30 Days)

Trackers Rows and
Columns

Lists records
saved in the
last 30 days by
users who
report to the
user who is
running the
report

Slow Queries Tracker
Queries

Rows and
Columns

Lists the
details for
queries that
took longer
than the query
threshold limit
defined in
Admin >
Trackers

User Sessions
Summary (Last
7 Days)

Tracker
Sessions

Summation Summarizes
the number of
session
roundtrips and
total active
time for each
user over the
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last 7 days
Users Usage
Metrics (Last
30 Days)

Tracker
Performance

Summation Shows the total
server
response time
in seconds,
total number of
database round
trips, and total
number of files
accessed for
each user in
the last 30 days

Users Usage
Metrics (Last 7
Days)

Tracker
Performance

Summation Shows the total
server
response time
in seconds,
total number of
database round
trips, and total
number of files
accessed for
each user in
the last 7 days

Customer Service Reports

The following reports will help customer service users and managers gather
important information about cases and bugs in Sugar. The reports in this section
are tagged "Stock Report" and "Customer Service" in the Reports module.

Name Module Type Chart Type Description
Bugs by
Product
Category by
Status

Bugs Matrix Horizontal Bar Number of
bugs created
by category
and their
current status.
This report
gives a sense of
which area of
the product
generates
bugs. The time
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period can be
adjusted in the
report using
run-time filters.

Bugs Created
by Month By
Category

Bugs Matrix Vertical Bar Number of
bugs created
each month
summarized by
the category.
This report
provides a
trend on the
number of bugs
being
generated
across the
category.

Bugs Created
by Month By
Priority

Bugs Matrix Vertical Bar Number of
bugs created
each month
summarized by
their priority.
This report
provides a
trend on the
number of
bugs.

Cases with No
Calls,
Meetings,
Tasks, or
Emails

Cases Matrix Summary count
of cases where
no activity has
taken place or
is scheduled.
Those cases
are counted
that have no
calls, meetings
or tasks
scheduled or
completed.

My Open Bugs
by Priority

Bugs Summation Pie List of open
bugs assigned
to the user who
is running the
report
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summarized by
priority.

My Open Cases
by Priority

Cases Summation Horizontal Bar List of open
cases assigned
to the user who
is running the
report
summarized by
priority.

New Cases By
Month

Cases Summation Vertical Bar List of new
cases opened
by month

Open Bugs by
User by
Priority

Bugs Matrix Number of
bugs assigned
to each user
grouped by
priority of the
bug. This
report gives a
sense of which
bugs need
attention the
most.

Open Bugs by
User by Status

Bugs Matrix Number of
bugs assigned
to each user
and the priority
of the bug. This
report gives a
sense of the
workload of
users working
on the bugs.

Open Cases By
Month By User

Cases Summation Vertical Bar List of open
cases by
created month
and grouped by
user.

Open Cases by
User by
Priority

Cases Matrix Horizontal Bar Number of
cases assigned
to each user
and the priority
of the bug. This
report gives a
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sense of the
workload of
users working
on the cases.

Open Cases by
User by Status

Cases Matrix Horizontal Bar Number of
cases assigned
to each user
and the current
status of the
bug. This
report gives a
sense of which
cases need
attention the
most.

Summary of
Bugs by
Priority by
Week Created

Bugs Matrix Vertical Bar Number of
bugs created
each week by
priority. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Bugs by Source
by Week
Created

Bugs Matrix Vertical Bar Number of
bugs created
each week by
source. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Bugs by Status
by Week
Created

Bugs Matrix Vertical Bar Number of
bugs created
each week by
status. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Cases by

Cases Matrix Vertical Bar Number of
cases created
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Priority by
Week Created

each week by
priority. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Cases by
Source by
Week Created

Cases Matrix Vertical Bar Number of
cases created
each week by
source. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Cases by
Status by Week
Created

Cases Matrix Vertical Bar Number of
cases created
each week by
status. The
time period can
be adjusted in
the report
using the run-
time filters.

Summary of
Open Cases by
Priority

Cases Summation Horizontal Bar Number of
cases that are
still open
summarized by
priority of bug.

All Cases Due
Today and
Overdue*

Cases Summation Horizontal Bar All cases with a
follow-up date
that has passed
or is today.
Defaults to all
cases with a
follow-up date
in the past 30
days.

All Open Cases
by Followup
Date*

Cases Summation
with details

Vertical Bar Number of
open cases
grouped by the
follow-up date.

Average Cases Matrix Vertical Bar The average

                       995 / 1.116



 

Difference
From Follow-
Up Date by
Week by
Agent*

difference from
the targeted
follow-up date
in business
hours by week
for each agent.
Includes cases
created in the
last 30 days,
but this range
can be changed
using the run-
time filter. A
run-time filter
can also be
used to filter by
cases that
either met or
missed their
first response
SLA.

Average Time
on Cases by
Status by
Type*

Change Timers Matrix Horizontal Bar The average
time in
business hours
spent on cases
in each open
status by case
type. Includes
cases created
in the last 30
days, but this
range can be
changed using
the run-time
filter.
Note: The
average is
calculated
using the
number of
Change Timer
records, not
the number of
Case records.
Therefore, this
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report captures
the average
time spent per
occurrence of
each status,
not per status.

Average Time
Spent on Cases
by Week by
Case Type*

Change Timers Summation Vertical Bar The average
time in
business hours
spent on cases
for each week
by case type.
Includes cases
created in the
last 30 days,
but this range
can be changed
using the run-
time filter.
Note: The
average is
calculated
using the
number of
Change Timer
records, not
the number of
Case records.
Therefore, this
report captures
the average
time spent per
occurrence of
each status,
not per status.

Average Time
to First
Response by
Agent*

Cases Summation Horizontal Bar The average
time in
business hours
until the first
response on a
case, per
agent. Includes
cases created
in the last 30
days, but this
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range can be
changed using
the run-time
filter.

Average Time
to Resolution
by Week by
Agent*

Cases Summation Horizontal Bar The average
time in
business hours
it takes to
resolve cases
by week for
each agent.
Includes cases
resolved in the
last 30 days,
but this range
can be changed
using the run-
time filter.

Average Time
to Resolution
by Week by
Type*

Cases Summation Horizontal Bar The average
time in
business hours
it takes to
resolve cases
by week for
each case type.
Includes cases
resolved in the
last 30 days,
but this range
can be changed
using the run-
time filter.

Cases That
Missed the
First Response
SLA*

Cases Matrix Vertical Bar The number of
cases that
missed their
first response
SLA in the last
7 days. The
time period can
be changed
using the run-
time filter.

Daily Average
Time to First

Cases Summation Horizontal Bar The daily
average time in
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Response* business hours
until the first
response on a
case. Includes
cases created
in the last 7
days, but this
range can be
changed using
the run-time
filter.

First Response
SLA Success
Rate*

Cases Summation Pie All cases
created in the
last 30 days,
separated by
whether or not
their first
response SLA
was met. The
run-time filters
can be used to
change the
time period or
narrow the
results to only
cases assigned
to a specific
agent.

List of Changes
to Case Status*

Change Timers Rows and
Columns

List of all
changes to
case status.
Includes cases
created in the
last 30 days,
but this range
can be changed
using the run-
time filter.

List of Recently
Resolved
Cases*

Cases Rows and
Columns

A list of
recently closed
cases across all
business
centers. The
time period can
be adjusted in
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the report.
My Average
Difference
From Follow-
Up Date by
Week*

Cases Summation Vertical Bar The average
difference from
the targeted
follow-up date
in business
hours by week
for the current
user. Includes
cases created
in the last 30
days, but this
range can be
changed using
the run-time
filter. A run-
time filter can
also be used to
filter by cases
that either met
or missed their
first response
SLA.

My Cases Due
Today and
Overdue*

Cases Summation Horizontal Bar All cases
assigned to the
user who is
running the
report with a
followup date
that has passed
or is today.
Defaults to all
cases with
follow-up date
in the past 30
days.

My Cases in
the Last Week
by Status*

Cases Summation Horizontal Bar Cases modified
by the user
who is running
the report in
the last 7 days,
grouped by the
status of the
case. The time
period can be
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adjusted in the
report. This
report makes it
easy to identify
recently
worked on
cases.

My Cases
Resolved this
Month by
Week*

Cases Summation Vertical Bar This report
displays a chart
for all cases
that were
closed in the
selected time
period and
groups them by
week

My Open Cases
by Followup
Date*

Cases Summation
with details

Vertical Bar Number of
open cases
assigned to the
user who is
running the
report grouped
by the follow-
up date.

My Open Cases
by Status*

Cases Summation Pie This pie chart
shows the
percent of
cases that are
open by status
for the user
who is running
the report.

My SLA
Success Rate*

Cases Summation Vertical Bar The history of
cases the
current user
responded to
that either met
or missed their
first response
SLA. Includes
cases in the
last 30 days,
but this range
can be changed
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using the run-
time filter.

New Cases by
Business
Center by
Week*

Cases Summation Vertical Bar Number of
cases created
for each
business center
by week. The
time period can
be adjusted in
the report.

New Cases by
Customer Tier
by Week*

Cases Summation Vertical Bar Number of
cases created
by the service
level of the
customer
(customer tier)
by week. The
time period can
be adjusted in
the report.

New Portal
Users Awaiting
Activation*

Contacts Rows and
Columns

A list of portal
users created
but not yet
activated.
Includes
contacts
created in the
last 7 days, but
this range can
be changed
using the run-
time filter.

Open Cases
Awaiting First
Response That
Missed SLA*

Cases Rows and
Columns

All open cases
that missed the
first response
SLA and are
still awaiting
first response.

Open Cases
Awaiting First
Response
Within SLA*

Cases Rows and
Columns

All open cases
that are within
their SLA and
awaiting first
response.

Open Cases by Cases Matrix Horizontal Bar A summary of
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Customer Tier
and Priority*

open cases
grouped by the
service level of
the customer
(customer tier)
and priority.

Recently
Created Cases*

Cases Rows and
Columns

A list of all
recently
created cases
across all
business
centers. The
time period can
be adjusted in
the report.

Status of Open
Tasks Assigned
by Me*

Tasks Summation
with details

Vertical Bar Open tasks that
the user who is
running the
report has
assigned to
others. This
report helps
users know
who to follow
up with.

Total Cases
Resolved this
Month by
Agent*

Cases Summation Horizontal Bar Number of
cases that were
resolved during
the month
grouped by
agent and
priority. The
time period can
be adjusted in
the report.

Total Cases
Resolved this
Month by
Business
Center*

Cases Matrix Horizontal Bar Number of
cases that were
resolved during
the month
grouped by
business center
and priority.
The time
period can be
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adjusted in the
report.

Total Time
Spent on Cases
by Week by
Case Type*

Change Timers Summation Vertical Bar The total time
in business
hours spent on
cases for each
week by case
type. Includes
cases created
in the last 30
days, but this
range can be
changed using
the run-time
filter.

*This report is only available for Sugar Serve users.

Data Privacy Reports

The following reports will help data privacy managers and marketing users make
privacy-related insights and identify leads, contacts, and targets who have opted in
to or out of marketing communications. The reports in this section are tagged
"Stock Report" and "Data Privacy" in the Reports module.

Name Module Type Chart Type Description
Count of
Contacts by
Country

Contacts Summation Total count of
existing
contacts
grouped by
country.

Count of Leads
(unconverted)
by Country

Leads Summation Total count of
existing leads
(unconverted)
grouped by
country.

Count of
Targets by
Country

Targets Summation Total count of
existing targets
grouped by
country.

Data privacy Data Privacy Matrix Vertical Bar Number of data
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activity
completed and
rejected each
month

privacy
activities
completed or
rejected each
month. The
month is based
on date closed.

Data Privacy
Activity Due
Now

Data Privacy Summation
with details

Horizontal Bar List of all Data
Privacy Activity
that is due
shortly. Use
the run-time
filter to adjust
the time
period.

Data Privacy
Activity
Overdue

Data Privacy Summation
with details

Horizontal Bar List of all Data
Privacy Activity
that are still
open and the
due date is in
the past.

List of Contacts
with No
Consent

Contacts Rows and
Columns

List of all
contacts who
have not
provided any
consent for any
business
purpose.

List of Emails
Opted In

Email Address Rows and
Columns

List of all
emails
currently opted
in.

List of Emails
Opted Out

Email Address Rows and
Columns

List of all
emails
currently opted
out.

List of Leads
with no
Consent

Leads Rows and
Columns

List of all leads
who have not
provided any
consent for any
business
purpose.

List of Open Data Privacy Rows and A list of all data
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Data Privacy
Activities

Columns privacy
activities that
have a status of
open.

List of Open
Data Privacy
Activities
assigned to me

Data Privacy Rows and
Columns

List of open
data privacy
activity
assigned to me

Number of
Data Privacy
Activity created
each month by
type

Data Privacy Matrix Vertical Bar Number of data
privacy activity
created each
month by
activity type

Open Data
Privacy
Activities by
Type

Data Privacy Summation
with details

Horizontal Bar List of all open
data privacy
activity
grouped by
activity type

Recently
Created Data
Privacy Activity

Data Privacy Rows and
Columns

A list of all
recently
created data
privacy
activity. The
time period can
be adjusted in
the report
using the run-
time filters.

Sales and Marketing Reports

The following reports will help sales and marketing professionals manage sales
activities and identify key performance indicators (KPIs). The reports in this
section are tagged "Stock Report" and "Sales and Marketing" in the Reports
module.

Name Module Type Chart Type Description
Accounts by
Assigned to
User

Accounts Summation Number of
accounts for
each assigned
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user. This
report helps in
making sure
that account
workload is
optimized
across the
sales team. Use
run-time filters
to narrow down
by type or
industry.

Accounts By
Type By
Industry

Accounts Summation Horizontal Bar Number of
accounts
summarized by
account type
and industry

Accounts
Created by
User by Month

Accounts Matrix Vertical Bar Number of
accounts
created by
month by
assigned user
during the
current year.
The time
period can be
adjusted in the
report using
the run-time
filters.

All Closed
Opportunities

Opportunities Rows and
Columns

List of all
closed
opportunities

All Open
Opportunities

Opportunities Rows and
Columns

List of open
opportunities

Contacts
Created by
User by Month

Contacts Matrix Vertical Bar Count of all
contacts
created this
year by each
assigned user
by month. The
time period can
be adjusted in
the report
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using the run-
time filters.

Leads By Lead
Source

Leads Summation Vertical Bar Number of
leads created
by lead source

Leads
Converted -
Lost by Month

Leads Matrix Vertical Bar Number of
leads
converted and
lost each
month. The
time period can
be adjusted in
the report
using the run-
time filters.

Leads
Converted by
User

Leads Summation This report
provides the
number of
leads
converted by
each user in
the current
quarter. The
time period can
be adjusted in
the run-time
filter.

Leads Created
by Source per
Month

Leads Matrix Vertical Bar Leads created
each month by
source. The
time period can
be adjusted in
the report
using the run-
time filters.

Leads Created
by User per
Month

Leads Matrix Vertical Bar Leads created
each month by
user. The time
period can be
adjusted in the
report using
the run-time
filters.

Leads with No Leads Summation Summary count
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Calls,
Meetings,
Tasks, or
Emails

of leads where
no activity has
taken place or
is scheduled.
Those leads are
counted that
have no calls,
meetings or
tasks
scheduled or
completed.

My Customers
by Area

Accounts Rows and
Columns

A list of
customers in a
given area
(City or Zip
Code). This
report only lists
accounts that
are assigned to
the person
viewing the
report. You can
use this report
to create a trip
plan.

My New
Customer
Accounts

Accounts Rows and
Columns

List of new
customers
recently
opened and
assigned to me.

My Open Leads Leads Rows and
Columns

List of all leads
assigned to me.

My Open
Opportunities

Opportunities Rows and
Columns

List of
Opportunities
assigned to me
that are still
open and are
expected to
close this
month. The
time period can
be adjusted in
the report
using the run-
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time filters.
My Open Tasks
by Priority and
Status

Tasks Matrix Horizontal Bar My open tasks
grouped by
priority and
status. This
report allows
one to focus on
higher priority
tasks that are
near
completion.

My Pipeline
Funnel
(Revenue Line
Items)

Revenue Line
Items

Summation Funnel This report
shows a funnel
chart of the
revenue line
item pipeline
that is assigned
to me. Use the
run-time filters
to include only
forecasted
revenue line
items.

Number of
Leads Created
by Week

Leads Summation Vertical Bar Number of
leads created
for each week
this year. The
time period can
be adjusted in
the report
using the run-
time filters.

Number of
Open Tasks by
Users by Week

Tasks Matrix Number of
open tasks by
each user by
week due.

Number of
Opportunities
Created by
Team by Month

Opportunities Matrix Vertical Bar Summary of
the number of
all
opportunities
created this
year grouped
by the primary
team assigned.
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This gives a
sense of which
teams are
generating
opportunities.
The time
period can also
be adjusted in
the run-time
filters.

Number of
Opportunities
created by
User by Month

Opportunities Matrix Vertical Bar Summary of
the number of
all
opportunities
created this
year by each
user. This gives
a sense of
which
salespeople are
generating
opportunities.
The time
period can also
be adjusted in
the run-time
filters.

Number of
Quotes created
by Users by
Month

Quotes Matrix Vertical Bar Number of
quotes created
by each user by
month. The
time period can
be adjusted in
the report
using the run-
time filter.

Open Call List Calls Rows and
Columns

Open Leads by
User

Leads Summation Horizontal Bar List of open
leads grouped
by assigned
user.

Open Meetings Meetings Rows and
Columns

List of Open
Meetings
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Open
Opportunities
and Number of
Calls

Opportunities Summation A list of all
open
opportunities
and the
number of calls
currently
scheduled for
each. Use the
run-time filters
to select only
scheduled or
held meetings.
Select the
opportunity
status to filter
on
opportunities
that are closed
won or lost.

Open
Opportunities
and Number of
Meetings

Opportunities Summation A list of all
open
opportunities
and the
number of
meetings
currently
scheduled for
each. Use the
run-time filters
to select only
scheduled or
held meetings.
Select the
opportunity
status to filter
on
opportunities
that are closed
won or lost.

Open
Opportunities
by Expected
Close Month

Opportunities Summation Vertical Bar Summary of all
open
opportunities
by expected
close month.
Details of the
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opportunities
are also listed
in this report.

Open
Opportunities
by Type by
Expected
Closed Month

Opportunities Matrix Vertical Bar Summary of
opportunities
by expected
close month
grouped by
type.

Open
Opportunities
by User by
Expected Close
Month

Opportunities Matrix Vertical Bar Summary of
opportunities
for each user
by expected
close month.

Open Quotes
by Stage

Quotes Summation Pie A list of all
open quotes
summarized by
stage.

Open Quotes
by Stage by
Close Month

Quotes Matrix Vertical Bar Summary of
quoted
amounts that
are open by
their expected
close month
and grouped by
stage. This
report
indicates which
quotes to
prioritize and
close.

Open Quotes
by Stage by
User

Quotes Matrix Summary of
quoted
amounts that
are open for
each assigned
user grouped
by stage. This
report gives a
sense of where
the quotes are
in terms of
stages for each
salesperson.
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Open Quotes
Expiring This
Month

Quotes Rows and
Columns

A list of quotes
that are
expiring this
month. The
time period can
be adjusted in
the report
using the run-
time filter.

Open Tasks Tasks Rows and
Columns

List of Open
Tasks

Opportunities
Created by
Lead Source by
Month

Opportunities Matrix Vertical Bar Monthly
summary of all
opportunities
created this
year grouped
by lead source.
This report
gives a sense of
which sources
are generating
most
opportunities.
You can also
toggle between
open or closed
won
opportunities.
Use the run-
time filter to
change the
time period.

Opportunities
with No Calls,
Meetings,
Tasks, or
Emails

Opportunities Summation Horizontal Bar Summary count
of
opportunities
where no
activity has
taken place or
is scheduled.
Those
opportunities
are counted
that have no
calls, meetings
or tasks
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scheduled or
completed.

Pipeline By
Team By User

Opportunities Summation Horizontal Bar Summary count
of
opportunities
where no
activity has
taken place or
is scheduled.
Those
opportunities
are counted
that have no
calls, meetings
or tasks
scheduled or
completed.

Pipeline By
Type By Team

Opportunities Summation Horizontal Bar Summarizes
the open
pipeline by
team.

Pipeline by
User (Revenue
Line Items)

Revenue Line
Items

Matrix Horizontal Bar Summary of
RLI's for each
user broken
down by their
current stage.
Use the run-
time filters to
include only
forecasted
revenue line
items.

Pipeline Funnel
(Revenue Line
Items)

Revenue Line
Items

Summation Funnel This report
shows a funnel
chart of the
revenue line
item pipeline.
Use the run-
time filters to
include only
forecasted
revenue line
items.

Quotes Created Quotes Matrix Vertical Bar Total quote
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by Users by
Month

amount created
by each user by
month. The
time period can
be adjusted in
the report
using the run-
time filter.

Quotes Won
Lost by Month

Quotes Matrix Vertical Bar Quoted
amounts won
and lost each
month this
year. The time
period can be
adjusted in the
report using
the run-time
filter.

Quotes Won
Lost by User

Quotes Matrix Quoted
amounts won
and lost this
quarter by
each assigned
user. The time
period can be
adjusted in the
report using
the run-time
filter.

Recently
Closed Quotes

Quotes Rows and
Columns

A list of all
recently closed
quotes.

Revenue Line
Items by
Product

Revenue Line
Items

Summation Summary of all
RLIs by
product. Use
the run-time
filters to
include only
forecasted
revenue line
items. You can
also change the
time period
and the sales
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stage of the
revenue line
item.

Revenue Line
Items Sold by
Type this
Quarter

Revenue Line
Items

Matrix Vertical Bar This report
provides a
summary of all
closed won
sales for each
quarter this
year grouped
by the lead
source. This
provides an
indication of
which sources
of leads are
generating
sales. The time
period can be
adjusted on the
report using
the run-time
filter.

Sales per
Quarter by
Lead Source

Opportunities Matrix Vertical Bar This report
provides a
summary of all
closed won
sales for each
quarter this
year grouped
by the lead
source. This
provides an
indication of
which sources
of leads are
generating
sales. The time
period can be
adjusted on the
report using
the run-time
filter.

Tasks
Completed by

Tasks Matrix Number of
tasks
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Users by Week
this Quarter

completed by
each user by
week in this
quarter. The
time period can
be adjusted in
the report
using the run-
time filter.

Tasks Due This
week

Tasks Rows and
Columns

List of tasks
due this week.
The time
period can be
adjusted in the
report using
the run-time
filter.

Top Grossing
Products This
Year

Revenue Line
Items

Summation Horizontal Bar Monthly sales
of products this
year. The time
period can be
adjusted in the
report using
the run-time
filters.

Top Sales Reps
This Quarter

Opportunities Summation This report
summarizes
total sales by
each assigned
user for the
current
quarter. The
time period can
be adjusted in
the report
using the run-
time filters.

Total Sales by
Quarter

Opportunities Matrix Vertical Bar This report
provides a
chart of total
sales broken
down by type
for each
quarter of this
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year. The time
period can be
adjusted in the
report using
the run-time
filters.

Total Sales by
Quarter by
User

Opportunities Matrix Vertical Bar This report
summarizes
total sales by
each assigned
user for each
quarter of this
year. This
report can be
used to
compare sales
person
performance.
The time
period can be
adjusted in the
report using
the run-time
filters.

Upcoming Calls
Scheduled by
Account

Calls Summation
with details

Number of
calls scheduled
by account in
the coming
weeks.

Upcoming
Meetings
Scheduled by
Account

Meetings Summation
with details

Number of
meetings
scheduled by
account in the
coming weeks.

Weekly Calls
Held This
Quarter by
User

Calls Matrix Vertical Bar Number of
calls held by
each user by
week in this
quarter. The
time period can
be adjusted in
the report
using the run-
time filter.
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Weekly Calls
Scheduled This
Quarter by
User

Calls Matrix Vertical Bar Number of
calls scheduled
by each user by
week in this
quarter. The
time period can
be adjusted in
the report
using the run-
time filter.

Weekly
Meetings Held
This Quarter by
User

Meetings Matrix Vertical Bar Number of
meetings held
by each user by
week in this
quarter. The
time period can
be adjusted in
the report
using the run-
time filter.

Weekly
Meetings
Scheduled This
Quarter by
User

Meetings Matrix Number of
meetings
scheduled by
each user by
week.

Wins and
Losses by
Users this
Quarter

Opportunities Matrix The total
amount of
opportunities
won vs lost by
each assigned
user in the
current
quarter. The
time period can
be adjusted in
the run-time
filters.

Restoring Deleted Stock Reports

If a user deletes a stock report, it is marked with a deleted flag in the instance's
database. Should you need to recover the deleted report, a person with access to
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your instance's file system can locate the report in the saved_reports table and
change the Deleted field from "1" to "0" for this specific report record. Upon doing
so, the report will be restored in your Sugar instance. If the stock report has been
deleted from the database and cannot be recovered, you must manually recreate
the report from scratch in the Reports module.

To hide one or more stock reports from your users, consider mass updating the
team to the Administrator's private team because deleted reports cannot be
restored via the user interface.

Note: Customers with instances hosted on Sugar's cloud service do not have direct
access to the database and, therefore, cannot restore stock reports once they have
been deleted. A support-authorized contact for your organization can file a case
with the Sugar Support team for assistance in trying to restore the report that has
been deleted from your Sugar instance.

Last Modified: 2020-03-11 01:06:38

Processes

Overview

Sugar's Processes module is the user-facing portal to SugarBPM™, Sugar's
business process management tool that allows administrators to streamline
everyday business processes by managing approvals, sales processes, call triaging,
and more. A business process is a set of logically related tasks that are performed
in order to achieve an organizational goal. It presents all of the tasks that must be
completed in a simplified and streamlined format.

SugarBPM empowers Sugar administrators to automate vital business processes
for their organization. Some examples of business processes that can be automated
using SugarBPM include invoice approvals, lead routing, customer service case
routing, and automated reminders and escalations. This documentation will cover
how to use the Processes module, as well as the various actions and options
available from within the module. For more information on how administrators can
create and configure processes, please refer to the SugarBPM documentation in
the Administration Guide.

Note: SugarBPM™ is not available in Sugar Professional.
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Process Fields

The Processes module contains the following fields. Please note that
administrators and users with developer-level role access cannot alter, add, or
remove fields via Studio as they typically can with other Sugar modules.

Field Description
Assigned To The user assigned to the record that

requires approval or routing
Date Modified The date and time that the process

definition's Activity element was
initiated

Date Created The date and time that the process
definition's Activity element was
initiated

Process Number A unique, auto-increment number that is
used to identify this process

Note: Process numbers are generated
in sequential order as new processes are
triggered.

Process Definition Name The name of the process definition
record that generated this process; For
more information about Process
Definitions, please refer to the Process
Definitions documentation in the
Administration Guide.

Process Name The name given to the process
definition's Activity element by the
process owner

Process User The user responsible for executing this
process' Activity element

Process Owner The user assigned to the process
definition record that generated this
process

Record Name The name or title of the record that
requires approval or routing

Working With Processes
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The following links will open specific sections of the User Interface documentation
where you can read about views and actions that are common across most Sidecar
modules. The sections following this Working With Processes section describe
Process-specific behaviors and functionality. 

Content Link Description
Searching for Processes
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to list view
search, which searches and filters
within the Processes module.

Processes List View
Total Record Count
List View Search
Column Reordering
Column Resizing
Column Sorting
Column Selection
More Processes
Dashboards

The List View section walks through the
many elements of the Processes List
View layout, which contains a list of all
running processes that require action
(e.g. approve, reject, etc.) from the
logged-in user. Unlike other Sidecar
modules, you will only see processes in
the list view if there is anything
requiring your approval or review.

While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Processes list view are
described in the List View Record
Actions Menu section of this page.

Processes Record View
Favorite Designation
Following Designation
Next or Previous Record
Actions Menu
Show More
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Activity Stream
Dashboards

The Process record view displays the
Sugar record that is awaiting action in
full detail including its module name,
fields, activity stream, and subpanels of
related records. For information about
navigating these elements of a record,
please refer to the User Interface links
on the left or the relevant module page
in the Application Guide.

To access the Process record view, click
on a process name on the Processes
dashlet or select "Show Process" from
the process record's list view Actions
menu. There are several process-
specific elements added to the standard
record view, which are explained in the 
Approval Process Actions Menu, Routed
Process Actions Menu, and Self-Service
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Actions Menu sections of this page.

Note: Processes may affect Sidecar
module records as well as legacy user-
interface modules. For information on
navigating the legacy user interface,
please refer to the User Interface
(Legacy) documentation.

Process Menus

The Processes module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Process-specific
functionality, within this page.

Module Tab Menu

The Processes module tab is typically found by clicking the "More" icon
represented by three vertical dots to the right of the module tabs at the top of any
Sugar screen. The additional modules will appear on the list and you can click
"Processes" to access the list view.

                    1.024 / 1.116

http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/User_Interface_Legacy
http://support.sugarcrm.com/Documentation/Sugar_Versions/10.0/Ult/Application_Guide/User_Interface/User_Interface_Legacy


 

From the Processes list view, click the triangle in the Processes tab to display the
Actions menu. The module tab's Actions menu has one option, View Processes,
which is another way to navigate to the Processes list view.

Administrators and users with developer-level role access may see additional
options such as a link to the Process Management screen. For more information
about options available to administrators and developers, please refer to the 
SugarBPM documentation in the Administration Guide.

If you do not see the Processes module tab in Sugar, please check the following:

The Processes module may be marked as hidden in your user preferences,
which will prevent the module tab from being displayed. Navigate to your
user profile (upper right of Sugar), click the Advanced tab, and check the
Layout Options section. If you see the Processes module in the Hide
Modules list, simply move it to the Display Modules list. For more
information on hiding and displaying modules, please refer to the Layout
Options section of the Getting Started documentation.
The administrator may have disabled the Processes module for your entire
Sugar instance. Reach out to your Sugar administrator to have the
Processes module displayed. For more information on displaying and hiding
modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Record Actions Menu

The Record Actions menu to the right of each record's Preview button allows users
to execute a running process directly from the list view by clicking "Show
Process". This will direct the user to a landing page where they will be instructed
to approve, reject, or resume (route) the current process. For more information
about executing processes, please see the Executing Processes section of this
page.
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The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview the progression of this process

in the intelligence pane
Show Process Navigate to the process' landing page to

approve, reject, or resume (route) this
process

Record View Actions Menu

The Process record view displays the Sugar record that is awaiting action in full
detail including its module name, fields, process buttons, and subpanels of related
records. To access a process' record view, click on the process name in the 
Processes dashlet or select "Show Process" from the process record's list view
Actions menu.

The process' Actions menu appears on the top right of the page and allows you to
perform operations on the current record specific to its process type. To learn
more about the three available Actions menus (approval, routed, and self-service),
please refer to the corresponding Actions menu section under the Executing
Processes section below. 

In addition to a Processes-specific Actions menu, there are several process-specific
elements added to the record view above the record's name and module icon.

From left to right across the top of the record view, the process record view
displays the following information:

Menu Item Description
Process Definition Name The name of the process definition

record that generated this process; For
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more information about Process
Definitions, please refer to the Process
Definitions documentation in the
Administration Guide.

Process Name The name that was given to the process
definition's Activity element by the
process owner

Process Due Date The date and time by which you should
execute this process step

Note: If the administrator has not
specified a due date, then no date will
appear. If the due date occurs in the
past, then the date will be preceded by
the word "Overdue" in red text.

Viewing Processes

The Processes module is the only SugarBPM module that is visible to regular
users. From the Processes module list view, you can view running processes if
there is anything for you to approve or review. You can view those same processes
via the Processes dashlet in addition to any self-service processes waiting to be
claimed in the Self Service Processes tab. 

Viewing Via Dashlet

All users who may be engaged in a process should place the Processes dashlet on
their home screens. Process users will not receive an email notification when an
activity is ready for them (unless the administrator has explicitly configured this
within the process definition). The dashlet makes it easy for users to know when it
is their turn to participate in a process and to take the appropriate action.

Note: Users (including administrators) will see only the processes that
immediately require their attention in the Processes dashlet.

To add the Processes dashlet, please refer to the Adding Dashlets section of the
Intelligence Pane documentation, choosing "Processes" from the Add a Dashlet
page.
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After saving the dashlet and its containing dashboard, the dashlet will offer several
Processes-specific filtering tools:

Current : Click on this button to view processes that are running within
the expected timeframe.
Overdue : Click on this button to view processes that have a due date in
the past. The label "Overdue" and the due date will be displayed adjacent
to the Process description.
My Processes : Enable this tab to view only the running processes upon
which the logged-in user must act. To execute the Process, click on the
name of the process. Please note that admin users can not see processes
running for other users via the dashlet. To access the system's exhaustive
list of running and completed processes, please refer to the Process
Management section of the Administration Guide.
Self Service Processes : Enable this tab to view only the running
processes in the queue to be claimed by a user. Self-Service processes are
configured inside the User Activity element settings of the related process
definition.
Process Description : Running processes are displayed in list view format
with descriptive fields including the unique process number, the name of
the affected Sugar record, the process title, the responsible user's name,
and the label of the relevant process step.
Due Date : When a due date exists it will appear adjacent to the process
description.

To execute a process from the Processes dashlet, please refer to the Executing
Processes section of this page.

Viewing Via List View

The Processes list view displays all running processes that require the logged-in
user to take action (e.g. approve, reject, etc.) and that meet the current search
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criteria. Users will not see processes for any other user – even if the other user is a
direct report or a member of the same team. To access the list view, simply click
the Processes module tab. To view or execute one of the process activities from the
list view, select "Show Process" from the record's list view Actions menu.

Executing Processes

When a running process requires action from a user, that user will see the process
in their Processes dashlet and Processes module list view. At these moments
within a flow, a user needs to decide if a circumstance is approved or rejected or
review and/or edit a Sugar record. This decision is formally indicated by executing
the process. The following sections explain how to execute the different process
activities in Sugar.

Approval Processes

An approval process is a moment within a flow where a user must decide if a
circumstance is approved or rejected. When an approval process requires action
from a user, that user will see the process in their Processes dashlet and Processes
module list view. The user will formally indicate their approval by executing the
process. 

As an example, an organization may require a different manager's approval
depending on the discount total. The following image portrays how a Sugar
process could automate this approval:
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All of the steps in the above process are automated except for two approval steps:
"Needs Jim Approval" and "Needs Chris Approval". When the automated process
reaches either of these steps, Jim or Chris will see a line item in his Processes
dashlet and list view. The following two sections explain what a running approval
process looks like and how to execute the approval.

Approval Process Actions Menu

When a process requires an approve or reject response, the process' record view
will display the record that is pending approval.

Below the process details are the process' approval buttons and process Actions
menu, which allow you to perform the following operations: 

Menu Item Description
Approve Allow the process to continue to the

next step along the approval path
Reject Allow the process to continue to the

next step along the rejection path
Edit Edit the fields on the record to be

approved
History Display the entire time-stamped history

of all transitions, user engagements, and
automated occurrences for this process

Status Display an image of this process' overall
flow including the approval and
rejection paths for this approval step

Add Notes Add notes for people who will engage
with the process later and/or read notes
left by other users before you

Change Assigned To User Choose a new Assigned To user for the
Sugar record
Note: This option must be enabled by
the administrator.

Select New Process User Choose a new user to execute this
process
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Note: This option must be enabled by
the administrator.

Executing an Approval Process

Follow the steps below to execute an approval process:

1. Click on the hyperlinked process name in your Processes dashlet. Please
note that the dashlet will not differentiate between Approval processes and
Routed processes. The process type will become apparent on the next
screen.

Alternatively, navigate to Processes list view and choose "Show Process"
from the Actions menu of the record:

2. The process landing page is the record view of the affected Sugar record.
Expand the record's Actions menu to browse the available process options.
For an overview of Processes-specific features and options that are
available here, please refer to the Approval Process Actions Menu section
of this page. You can review the user notes and history or, if enabled,
choose to delegate this process step to another user.

3. If desired or required by the process, edit any fields on the Sugar record by
clicking the Edit button.

4. Finally, click on either "Approve" or "Reject" to execute the process and
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return to your dashboard, where the executed process will no longer
appear in the Processes dashlet.

Routed Processes

The other user activity that a process may require is to simply review and/or edit a
Sugar record. For example, a high-value quote record may not require approval,
but the executive team should be able to review the quote for capacity-planning
purposes. In this situation, the process definition can be configured to route the
process flow through the members of the executive team without requiring a
conditional response. The following image portrays how a Sugar process will
automate this procedure:

Routed Process Actions Menu

When a process routes a record to a user to review and/or edit, the process' record
view will display the record that is pending review.

Below the process details are the process' Route button and Actions menu, which
allow you to perform the following operations: 

Menu Item Description
Route Allow the process to continue to the

next step
Edit Edit the fields on the record to be

approved
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History Opens a popup window that displays the
entire time-stamped history of all
transitions, user engagements, and
automated occurrences for this process

Status Opens a popup window that displays an
image of this process' overall flow
including the approval and rejection
paths for this approval step

Add Notes Opens a popup window where you can
add notes for people who will engage
with the process later or read notes left
by other users before you

Change Assigned To User Choose a new Assigned To user for the
Sugar record
Note: This option must be enabled by
the administrator.

Select New Process User Choose a new user to execute this
process
Note: This option must be enabled by
the administrator.

Executing a Routed Process

Follow these steps to execute a process that has been routed to you:

1. Click on the hyperlinked process name in your Processes dashlet. Please
note that the dashlet will not differentiate between Approval processes and
Routed processes. The process type will become apparent on the next
screen.

Alternatively, navigate to Processes list view and choose "Show Process"
from the Actions menu of the record:
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2. The process landing page is the record view of the routed Sugar record.
Expand the record's Actions menu to browse the available process options.
For an overview of process-specific features and options that are available
here, please refer to the Approval Process Actions Menu section of this
page.

3. When a flow has been routed to you for review, the only required action is
to acknowledge receipt. However, you may first choose to edit the affected
record. Review the details of the Sugar record and inspect the process
notes for any critical information that your colleagues may have shared.
For information about viewing process Notes, please refer to the Viewing
Process Notes section of this page.

4. When you have completed making edits and reviewing the record, click
"Route" to complete the process. This will redirect you to your dashboard,
where the executed process will no longer be visible in your Processes
dashlet.

Self-Service Processes

Some user-facing processes will not have a designated process owner. Instead,
users will be empowered to claim responsibility for them. These processes will
appear in the Self Service Processes tab of the Processes dashlet. Self-service
processes may require either an approval/rejection response or review of a routed
action.

Self-Service Process Actions Menu

Self-service processes may require either an approval/rejection response or review
of a routed record, but first, a user must claim the process. When a user claims a
self-service process, the process' record view will display the record that is waiting
to be claimed.
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Below the process details are the process' Claim button and Actions menu, which
allow you to perform the following operations: 

Menu Item Description
Claim Volunteer to execute this process and

remove it from view of other team
members. The process can be
immediately executed after claiming it,
or you can navigate away and find the
process later in the My Processes tab of
your Processes dashlet.

Cancel Navigate back to the home page without
claiming this process

History Opens a popup window that displays the
entire time-stamped history of all
transitions, user engagements, and
automated occurrences for this process

Status Opens a popup window that displays an
image of this process' overall flow
including the approval and rejection
paths for this approval step

Claiming a Self-Service Process

Follow these steps to claim and then execute a self-service process:

1. Click on the hyperlinked process name in the Self Service Processes tab of
your Processes dashlet.
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2. The process landing page is the record view of the affected Sugar record.
Expand the record's Actions menu to browse the available process options.
For an overview of process-specific features and options that are available
here, please refer to the Self-Service Process Actions Menu section of this
page.

3. Click on "Claim" to indicate your intention to execute this process and
remove it from the view of other team members. After clicking the Claim
button, the page will reload and expose the Approve/Reject or Route
buttons, depending on what type of process activity has been configured.
The process can be immediately executed after claiming it, or you can
navigate away and find the process later in the My Processes tab of your
Processes dashlet.

4. Execute the process as explained in either the Executing Approval
Processes or Executing Routed Processes sections of this page.

Choosing a New Process User

When a process is routed to you for review or approval, it may be possible to
designate a new user to execute the process. The administrator can enable or
disable this option on each process definition, so it may be possible to do this for
one process but not another. If the option is enabled, "Select New Process User"
will be available in the Actions menu on the process record view:

Follow these steps to reassign a process:

1. Click on the hyperlinked process name in your Processes dashlet. Please

                    1.036 / 1.116



 

note that the dashlet will not differentiate between Approval processes and
Routed processes. The process type will become apparent on the next
screen.

Alternatively, navigate to Processes list view and choose "Show Process"
from the Actions menu of the record:

2. The process landing page is the record view of the affected Sugar record.
Note: Legacy user-interface modules will display the record's edit view.

3. Click on the triangle next to the Edit button to reveal the Actions menu.
Click on "Select New Process User".

Note: If "Select New Process User" is not displayed, then the administrator
has not enabled reassignments for this type of process. Please contact the
administrator and ask them to reassign the process for you.

4. The "Select New Process User" window will appear.
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There are three options:
User : Choose a user to complete this step of the process. The
administrator will have specified one Sugar team from which you
may choose any member.
Type : Choose a reassignment method:

Round Trip : Choose "Round Trip" to make the process
route back to you when the new user has completed this
step.
One Way : Choose "One-Way" to direct the process to a new
user, and then have it continue to its next step without
routing back to you.

Note : As a best practice, add a note explaining why you are
choosing a new user to execute this process. The new user will see
your note when she clicks on "View Notes".

5. Click on "Save" to be redirected to your dashboard where the reassigned
process will no longer be visible on your Processes dashlet.

Choosing a New Assigned To User

When a process is routed to you for review or approval, it may be possible to
choose a new assigned user for the affected Sugar record without affecting the
flow of the process. The administrator can enable or disable this option for each
process definition, so it may be possible to reassign the Sugar record for one
process but not another. If the option is enabled, "Change Assigned To User" will
be available in the Actions menu on the process record view:
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Follow these steps to designate a new assigned user:

1. Click on the hyperlinked process name in your Processes dashlet. Please
note that the dashlet will not differentiate between Approval processes and
Routed processes. The process type will become apparent on the next
screen.

Alternatively, navigate to Processes list view and choose "Show Process"
from the Actions menu of the record:

2. The process landing page is the record view of the affected Sugar record.
Note: Legacy user-interface modules will display the record's edit view.

3. Click on the triangle next to the Edit button to reveal the Actions menu.
Click on "Change Assigned To User".
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Note: If "Change Assigned To User" is not displayed, then the
administrator has not enabled reassignments for this type of process.
Please contact the administrator and ask them to reassign it for you.

4. The "Change Assigned To User" window will appear:

There are two options:
User : The user chosen here will become the "Assigned To" user of
the related Sugar record. The administrator will have specified a
Sugar team from which you may choose any member. No other
users will be displayed in the User dropdown.
Note : As a best practice, insert an explanation of why you are
choosing a new assigned user. The next process user will see your
note when he or she clicks on "View Notes".

5. Click on "Save" to update the Sugar record. The page will reload to reflect
the change. You can now execute the process as explained in either the 
Executing Approval Processes or Executing Routed Processes sections of
this page.

Viewing Details About a Running Process

When executing a running process, there are three options available that will help
you gain valuable insight into the past, present, and future state of the process:
History, Show Notes, Show Status. These options are accessible via the Actions
menu on the process record view. Click on the triangle to the right of the edit
button to expand the Actions menu:
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In processes targeting legacy user-interface modules, these options are
represented by icons in the upper right area of the process record view:

The three icons on a legacy record view represent the following actions:

Action Icon Description
Show History View the entire time-

stamped history of all
process transitions, user
engagements, and
automated occurrences
that were executed by the
SugarBPM engine.

Show Notes Read messages from users
who have already engaged
in the process and send
messages to users who
will engage in the process
later.

Show Status Reveal an image of the
process' visual design
layout in a pop-up window.
The image will reveal key
information regarding the
stages that have already
been completed, the
current stage of the
process, and the stages
that have yet to execute.
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Viewing Process History

All process records retain a timeline of events that have occurred throughout the
process. This timeline can be displayed in a popup window by the process user or
by a SugarBPM administrator.

To review the entire time-stamped history of all transitions, user engagements, and
automated occurrences for a particular process, follow these steps:

1. From the Processes dashlet, click on the hyperlinked process name to view
the process record view.

2. Click on the triangle next to the Edit button to reveal the Actions menu,
and then click "History". In legacy user-interface modules, click on the
History icon in the corner of the screen. A popup window will appear over
the current page outlining the transition history of the current process.
Each process History entry will include the following components:

The profile image and name of the process user who executed the
transition
Note: Automated events will be executed by the SugarBPM (AW)
engine.
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Explanation of the transition that occurred:

Transition status indicator (checkmark):

Checkmark ✔ : The action has been executed.
No Checkmark : The action has not yet been executed.

3. Click on the X in the corner of the window to return to the process record
view.

Viewing Process Notes

A process user who is engaged in a process activity can add notes for people who
will engage with the process later in its flow. When a different user engages in that
same process later, he can see the earlier user notes and choose to add his own.
Users who executed process activities at the beginning will not see the notes
added by subsequent process users unless the process is routed back to them for
review or approval later.

Note: Admin users can see all notes and add notes to any running process at any
time from the Process Management page.

To create a note and view process notes from other users, follow these steps:

1. From the Processes dashlet, click on the hyperlinked process name to view
the process record view.

2. Click on the triangle next to the Edit button to reveal the Actions menu,
and then click "Show Notes".
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Note: In legacy user-interface modules, click on the Notes  icon in the
corner of the screen.

3. A popup window will appear over the current page that displays time-
stamped notes from earlier users of the current process.

4. At the top of the window, there is also a composition area where you can
add more notes. Simply type a message in the empty field and then click on
"Add Note" to add it to the Notes window.

5. Click on the X in the corner of the window to return to the process' record
view.

Every person that may be involved in a process will not see the process throughout
its entire flow. Regular users can only see the process in list view when they have
a record to approve, reject, or review. Therefore, only one regular user (non-
admin) can see the notes at any given time. In other words, the notes will only be
seen by users who approve/reject/review the process after the note is added.

Previewing the Process Design

Users can view the progression of a process within the overall flow directly from
the process' record view. Click on the triangle next to the Edit button to reveal the
Actions menu, and then click "Show Process".

Note: In legacy user-interface modules, click the Status  icon in the upper right
corner.

The process' visual design layout will open in a pop-up window, providing key
information regarding the stages that have already been completed, the current
stage of the process, and the stages that have yet to execute. The executed and in-
progress stages of the process will be displayed in color, while bypassed or not-yet-
executed stages will be presented in a grayed-out style.
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Visual Element Example Description
Colorized shapes This element has been

executed or is in progress
Gray shapes This element has been

bypassed or occurs in the
future

Green-outlined activity The activity is waiting for
you (the viewing user) to
respond

Red-outlined activity The activity is waiting for
a user to respond, but not
the viewing user

Red glowing shape This element is in
progress

Shape containing a small
crossed-out circle

The process was
terminated or canceled on
this element

Numeric value in
parentheses

This element was
triggered by multiple
events concurrently

Note: This parenthetical
notice may indicate that
there is a flaw in the
design of the process
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definition. Please review
the conditions on the
triggering event to
eliminate the possibility of
overlapping triggers.

Terminated vs. Cancelled Processes

The SugarBPM automatically terminates a process when the record related to the
process' Start event is deleted. The associated process will be removed from the
Processes dashlet and the process record will display "Terminated" in the Status
column of the administrator's Process Management list view.

Cancelled processes, on the other hand, have been intentionally stopped by the
administrator. The associated process will be removed from the Processes dashlet
and the process record will display "Canceled" in the Status column of the
administrator's Process Management list view.

Last Modified: 2020-03-26 13:11:42

Export

Overview

There may be times in which users will want to access, review, or manipulate
information from their Sugar database in another format outside of Sugar. To
facilitate this process, users have two options on ways to export their data from
Sugar. Upon exporting data from Sugar, a CSV ("Comma Separated Value") format
file will be downloaded to the users computer. This file can be reviewed in
Microsoft Excel, Notepad, or other spreadsheet tools and text editors.

Exporting restrictions can be controlled by a System Administrator via Admin >
Locale. For more information on the Locale menu, please refer to the Locale
section of the Administration guide. An administrator also has the option to create
a Role hindering regular users' access to the export functionality. Please refer to
the Role Management section of the Administration guide for more information on
setting roles for users.
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Exporting From Module List Views

The first type of export that will be covered is exporting from the module list view.
When exporting this way, the downloaded file contains every field from the
database within the given module for the specified record or records. This export
will not include any information from records which are associated via
relationships to this module. Please note that the export method varies slightly
between modules using the Sidecar user interface (e.g. Accounts, Contacts, Leads,
etc.) and Legacy user interface (e.g. Calls, Meetings, Quotes, etc.).

This export method is most useful when performing a type of data migration,
needing an excess of detail, or performing a comprehensive import and update of
the data, since this method exports all fields within a module. It is recommended
the Export From Reports functionality be used for any other export use case to
isolate the specific information needed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a large number of records. If you encounter
an error when performing this action, we recommend selecting the records in
smaller batches.

Exporting From Sidecar Module List Views

The following steps cover exporting from the Accounts module as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the Module Search to find the Account records you wish to export.
3. Select the desired account records individually by marking the checkbox on

the left of each row.
Note: You can also use the Select All feature in the list view to
select the first 1000 records in the result set. If you wish to export
more than 1000 records or export a specific group of records on the
list view, please use the filter option in module search to perform
the exports in smaller batches.

4. Choose "Export" from the Actions menu.
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The CSV file will be downloaded to your local machine to a location defined by
your browser settings. The file can be read and manipulated as necessary.

Exporting From Legacy Module List Views

The following steps cover exporting from the Calls module as an example:

1. Navigate to the Calls list view by clicking the Calls module tab.
2. Use the Basic or Advanced Search functionality to find the records you

wish to export.
3. Select the desired call records individually or by using the checkbox

dropdown's options.

4. Choose "Export" from the Actions menu.
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The CSV file will be downloaded to your local machine to a location defined by
your browser settings. The file can be read and manipulated as necessary.

Exported Files From List View

When data is exported from Sugar, the file that is produced is a CSV, or "Comma
Separated Value" file. When viewed in a plain text editor, a CSV file looks like a
long string of text with groupings of text separated with quotation marks and
commas (e.g. "First Name","Last Name","Title"). The file first lists out all columns
that are in the file, and then the corresponding rows follow, also separated by
quotation marks and commas (e.g. "Dusty","Connor","IT Developer").

However, most spreadsheet software, such as Microsoft Excel, will read this file
and convert the quotation marks and commas into rows and columns. This makes
your data much easier to read and turns it into a useful format that can be
manipulated and re-purposed as need be.

The records that appear in your spreadsheet are dependent on what type of
search, if any, you did prior to your export.

When exporting from list view, the user is left with every part of the module
database information, which is often not all readable by the user. This file will only
contain information specific to the module where the export was performed. This
exported data will be comprised of all stock and custom fields from the module. No
data that would normally be found in a subpanel will appear on this export. 

Exports from modules with team-based permissions enabled will contain two
additional columns:

Selected Teams : A comma-delimited list of the team names that are
selected for extra access
Selected Team Set ID : A unique identifier that references the group of
teams contained in the Selected Teams field

Exporting From Reports

In addition to exporting from a list view, users also have the option to export data
from a report. Because reports allow you to select the specific fields you would like
to see, users can narrow down what they see on the export file and filter the
module data however they would like. The advantage to using reports is that users
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will only be presented with the data that they need, and no excess data. In
addition, users can also export data from related modules using reports, which is
not possible when Exporting From Module List Views. Finally, because the reports
are much more focused and specific, there is a higher threshold of the number of
records that can be exported before encountering a timeout or any other such
issues.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while exporting a report with a large amount of data. If you
encounter an error when performing this action, we recommend breaking up the
report in smaller batches.

For more information on creating your report, please refer to the Reports
documentation.

Use the following steps to complete an export from a report:

1. Select an existing report from the Report module's list view, or create a
new one based on the information that you would like to export.

2. Click on the actions menu of the report details and select "Export".

3. The CSV file will be downloaded to your computer to a location defined by
your browser settings. The file can then be read and manipulated at will.

When exporting from a report, the data is more well-rounded for a user to review.
The user can determine which fields should be included on the export by
configuring the report. This means that while reviewing it in a spreadsheet, the
information appears exactly as it does in Sugar. This makes for a more positive
user experience and a more focused export file. In addition, the user is able to use
modules related to the reported-on module. This makes the report more useful in a
business sense for individual users.

Exported Files From Reports

When data is exported from Sugar, the file that is produced is a CSV, or "Comma
Separated Value" file. When viewed in a plain text editor, a CSV file looks like a
long string of text with groupings of text separated with quotation marks and
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commas (e.g. "First Name","Last Name","Title"). The file first lists out all columns
that are in the file, and then the corresponding rows follow, also separated by
quotation marks and commas (e.g. "Dusty","Connor","IT Developer").

However, most spreadsheet software, such as Microsoft Excel, will read this file
and convert the quotation marks and commas into rows and columns. This makes
your data much easier to read and turns it into a useful format that can be
manipulated and repurposed as need be.

The information that appears in your spreadsheet is dependent on which filters
and display columns you added to your report. Only the information shown in the
display columns when you view your final report will be included in your CSV
export.

Last Modified: 2020-02-04 00:12:57

Import

Overview

For most modules, Sugar allows users to transfer data from an external source
(usually a comma-separated-values file) into the database via import. Sugar's
import wizard is a quick and easy way to create or update many records at once.
The import tool can be used to add a list of new customers or leads to the
database, update existing data, migrate from a previous CRM system, or for any
process that requires manipulating many records at once.

Your system's Sugar administrator may enable importing for the following
modules:

Accounts
Bugs
Calls
Campaigns
Cases
Contacts
Contracts
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Custom modules (if applicable)
Leads
Meetings
Notes
Opportunities
Revenue Line Items
Targets
Tasks

Users with an administrator or developer role can import records into the
following admin-only modules:

SugarBPM modules:
Process Definitions
Process Business Rules
Process Email Templates

Products modules:
Manufacturers
Products
Product Catalog
Product Category
Product Types
Tax Rates

Users
Note: The Import Users option is not available for instances that use
SugarIdentity. Administrators will need to access SugarIdentity via the
Cloud Settings console in order to import users.

When importing through any of the above modules, Sugar presents users with a
wizard to help guide users through the process of creating and updating records.

Import Guidelines

Importing is a very important process for both new Sugar users and those who
have been using Sugar for years. Depending on your business needs, you may run
imports anywhere from multiple times per week to only once or twice per year.
Regardless of the import frequency, all users follow the same import guidelines:

File Delimitation : Sugar accepts files that are delimited by a given
separator, such as commas or tabs. The most common type of import will
be using a CSV (Comma Separate Value) file, but Sugar will accept other
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file types as long as it recognizes the delimiter.
Imposed Limitations : Sugar, by default, does not impose any type of
import limitations. However, System Administrators can impose a limit on
the number of rows or records that can be imported at one time. This
limitation is found in Admin > System Settings > Advanced > Import -
Maximum Number of Rows. Administrators can also limit what modules
users are allowed to import into through the use of Roles.
Scrub Data Before Import : It is strongly recommended that all data is
reviewed and scrubbed before importing. It is much easier to see if you are
importing good data or that you have removed all duplicates before
importing than finding them after they are already in Sugar and are already
in use by other users. In addition, you want to ensure standardized fields
such as dates, phone numbers, etc. adhere to a common format so that the
import will run as smooth as possible.
Parent Records First : When importing any records that use a
relationship to another module, such as the Account - Contact relationship,
it is best to try importing the parent, or higher level, records first. This is
demonstrated with a one-to-many relationship between the two modules. In
this case, it is best to import accounts first and then contacts, which rely on
account records.

Importing New Records

The first type of import that will be covered is importing new records. Whether you
are just starting a migration from another CRM to Sugar or if you are adding a
new list of records that you have received, such as a new list of leads or accounts,
this process will help to get the data into Sugar without having to manually enter
each record. After preparing your import file, follow these steps to import the list
into Sugar:

1. Navigate to the module tab for the module that you are importing into and
select the import option. This will open the Import Wizard and bring you to
the"Upload Import File" screen.
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2. If you would like to review the Import File Template, you can download it
from this page. This will give you a template of the format Sugar is going to
be using to import your data. For more information on the template, please
review the Import File Template section of this documentation.

3. Select the import file that you are going to use to import by clicking the
Choose File button. When prompted, select the file from your computer and
it will appear in this box.

4. Ensure that "Create new records only" is selected.
5. If you have preformed imports before and have previously saved your

import settings, you can select your setting at the bottom of the page using
the "To use pre-set import settings, select from below" option. If you do not
have any saved import settings, this section will not appear. For more
information on saving mapping, please review the Saving Field Mappings
section of this documentation.

6. Click "Next" to access the "Confirm Import File Properties" screen.
7. This screen will show you the first two rows that Sugar is going to try to

import as an example to let you know that your file was read properly by
Sugar.

8. The Import Wizard automatically detects the properties of the file that has
been uploaded to ensure the best import possible. If you notice any
mistakes or need to set up any advanced configuration, click "View Import
File Properties". These changes are specific to the import and do not affect
your standard user preferences.

9. If the file was exported from either Salesforce.com or Microsoft Outlook,
select the corresponding option under "If the import file data was exported
from any of the following sources, select which one". If not, leave this as
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"None". This option will set up your mapping properly on the next screen.
10. Click "Next" to access the Confirm Field Mappings screen.
11. Click the View Notes button for any relevant information, specific to this

module, to the import that you are performing.

12. This screen presents you with four columns:
Header Row : This is the column header from your import file. This
column will let you reference your file to make sure your column
mapping is correct. If your import file does not have a header row,
this column will not show.
Module Field : This column contains a dropdown list of all
importable fields for the module. The Import Wizard tries to match
the Header Row with the corresponding Sugar field. If the
suggested mapping is incorrect, use the dropdown list to change
the mapping. Required fields are marked with an asterisk (*).
Row 1 : This column contains the values from the first row of data
in your import file. This is another aid to help ensure you have your
mapping correct, so that you can see the mapping using real data
and not just the headers. If your import file does not have column
headers, there will be an additional column for Row 2.
Default Value : This column is hidden by default, but can be
expanded if needed. When expanded, you have the option to fill in a
value that will populate all records where a value for that field does
not exist. For example, if you do not have anything populated in the
Accounts Industry field, but you know this is a list of Technology
companies, you can populate all blank values in the Industry field
with the value of "Technology".

13. Click "Add Field" if any data needs to be added to the import that is not on
your import file. This can be used if you would like to assign a value to a
record when the column is not on your import file. This is used in
conjunction with the Default Value column. For example, if you are
importing these accounts, but would like to assign them all to another user,
John Smith, you would click the Add Field button, select the field from the
Module Field column, and populate the desired value in the Default Value
column. Now, all records will be assigned to John Smith upon import.
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14. Click "Next" to access the Check for Possible Duplicates screen.
15. This menu allows users to check if there are duplicated values on the

import to records that already exist in Sugar. This menu will vary
depending on what module you are importing into as the fields will be
specific to this module. The fields available to the Import Wizard are
determined based on the system-defined indexes. This is why you will not
see all fields shown on this list, but only a subset of fields from the module.
If you would like to cross reference existing Sugar records against what is
being imported, simply drag and drop the field name from the right
column, "Available Fields", to the left column, "Fields to Check". For more
information on duplicate checking, please review the Detecting Duplicates
section of this documentation.

16. If the import configuration that you have set up is going to be used again in
the future for additional imports, add a name at the button of the page so
that it can be referenced later. For more information on saved field
mappings, please review the Saving Field Mappings section of this
documentation.

17. When your duplicate checking settings are complete, click "Import Now" to
begin the import.

18. After the import completes, you are brought to the "View Import Results"
page. Here, you are provided with a summary of the import.
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19. The summary will tell you how many records were created, how many were
not created due to an error, and how many were found as duplicates.

20. There are three buttons below the Summary:

Undo Import : If there was a mistake in the import that you
realized after importing, you can check this button. All records that
were created via the import will be deleted. This button cannot be
re-accessed for this import. As soon as you navigate away from this
page, the import is considered complete.
Import Again : Click this button if you would like to go back to the
first step of the Import Wizard and perform additional imports.
Clicking this button will consider the import to be complete.
Exit : This button will also consider the import to be complete, but
will bring you back to the module's list view to be able to further
review or search your records.

21. There are also three tabs on the summary page under the action buttons:
Created Records : This tab will show you a list view of all of the
records that were properly imported on this import.
Duplicates : This tab will present you with any records that were
not imported due to the Import Wizard finding duplicates from Step
15. There is an option to download a list of the duplicates, which
produces a new CSV file. You have the option to download this list,
make any changes, and import again following this same process.

Errors : This tab will show you any records that were not imported
due to an error during the import process. This is usually seen when
there is a problem with data that is on one of the records or rows in
the CSV file. For instance, if you are missing a value for a required
field, or a field is formatted incorrectly.

Note: Similar to the option to download duplicate records, you also
have the option to download the list of errors using the two links
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provided:
The "Download list of errors" option will produce a new CSV
file with columns showing (from left to right) the error, the
field affected, the value, and the line in your original import
file where the error occurred.

The "Download list of rows that were not imported" option
will download a new CSV file with the same format of your
original one, containing only the rows that were not
imported so that you can clean them up and then re-import.

22. Once you have downloaded the desired lists and reviewed the import, the
buttons mentioned in Step 20 can be used to complete your import.

Importing Updates to Existing Records

In addition to importing new records, Sugar's Import Wizard also has the
functionality to use an import file to update existing Sugar records. The process
runs very similarly to the new record import process described above.

The most important aspect to importing updates to existing records is that Sugar
will only update records where there is a matching ID in the import file. Every
Sugar record, regardless of what module it is in, is defined with an alphanumeric
ID field. This field is typically a 36-character alphanumeric value but may be less if
imported from a previous CRM. This field is the only way that the Import Wizard
will know which record to update.

Note: All other fields (name, email address, etc.) are not considered unique and
can have duplicates, so only the ID field will work to differentiate records for an
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update from import.

The ID field is not usually shown in Sugar and must be found either by running a
report or an export within the module.

During the import, if there are any other records without ID fields and they are in
the import file, they will create new records, which will create duplicates in your
database.

To import updates, follow the steps below.

1. To prepare the import file, you must have the ID numbers for all of the
records that you are going to be updating. The most common methods are
either by exporting a list of records from the module list view or by running
a report and exporting the results. For more information on exporting,
please review the Export documentation.

Export from List View : This option will include the record ID
field, but it is recommended that you open the file in a spreadsheet
editor (Microsoft Excel) and delete any columns that you are not
updating. Be sure to leave the ID field and any required fields, such
as Name, as the import will not complete without these.
Export from Report : If you choose to run a report, be sure to
include the ID field in your display columns so that the records can
be matched up. You will also want to include any required fields,
such as Name, as the import will not complete without these. Please
note that only Rows and Columns reports can be used for exports.
After you have your file ready for import, you can proceed with
working through the Import Wizard.

2. Navigate to the module tab for the module that you are updating and select
the import option. This will open the Import Wizard and bring you to
the "Upload Import File" screen.

3. If you would like to review the Import File Template, you can download it
from this page. This will give you a template of the format Sugar is going to
be using to import your data. For more information on the template, please
review the Import File Template section of this documentation.
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4. Select the import file that you are going to use to import by clicking the
"Choose File" button. When prompted, select the file from your computer
and it will appear in this box.

5. Select the option "Create new records and update existing records".
6. If you have performed imports before and have previously saved your

import settings, you can select your setting at the bottom of the page using
the "To use pre-set import settings, select from below" option. If you do not
have any saved import settings, this section will not appear. If your CSV file
was exported from Sugar, this is likely not a necessary step. For more
information on saving mapping, please review the Saving Field Mappings
section of this documentation.

7. Click "Next" to access the "Confirm Import File Properties" screen. Before
the "Confirm Import File Properties" screen opens, you will be prompted
with an alert informing you that updates made to existing records cannot
be undone. Read, and then click "OK" to proceed.

8. This screen will show you the first two rows that Sugar is going to try to
import as an example to let you know that your file was read properly by
Sugar.

9. The Import Wizard automatically detects the properties of the file that has
been uploaded to ensure the best import possible. If you notice any
mistakes or need to set up any advanced configuration, click "View Import
File Properties". These changes are specific to the import and do not affect
your standard user preferences.

10. If the file was exported from either Salesforce.com or Microsoft Outlook,
select the corresponding option under "If the import file data was exported
from any of the following sources, select which one". If not, leave this as
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"None". This option will set up your mapping properly on the next screen. If
this file was exported from Sugar, keep it set to "None".

11. Click "Next" to access theConfirm Field Mappings screen.
12. Click the View Notes button for any relevant information, specific to this

module, to the import that you are performing.

13. This screen presents you with four columns:
Header Row : This is the column header from your import file. This
column will let you reference your file to make sure your column
mapping is correct. If your import file does not have a header row,
this column will not show.
Module Field : This column contains a dropdown list for each row
that contains the name of a field in Sugar. The Import Wizard tries
to match the Header Row with the corresponding Sugar field. If the
suggested mapping is incorrect, use the dropdown list to change
the mapping. Required fields are marked with an asterisk (*).
Row 1 : This column contains the values from the first row of data
in your import file. This is another aid to help ensure you have your
mapping correct, so that you can see the mapping using real data
and not just the headers. If your import file does not have column
headers, there will be an additional column for Row 2.
Default Value : This column is hidden by default, but can be
expanded if needed. When expanded, you have the option to fill in a
value that will populate all records where a value for that field does
not exist. For example, if you do not have anything populated in the
Accounts Industry field, but you know this is a list of Technology
companies, you can populate all blank values in the Industry field
with the value of "Technology".

14. Click "Add Field" if any data needs to be added to the import that is not on
your import file. This can be used if you would like to assign a value to a
record when the column is not on your import file. This is used in
conjunction with the Default Value column. For example, if you are
importing these accounts, but would like to assign them all to another user,
John Smith, you would click Add Field button, select the field from the
Module Field column, and populate the desired value in the Default Value
column. Now, all records will be assigned to John Smith upon import.
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15. Click "Next" to access the Check for Possible Duplicates screen.
16. This menu allows users to check if there are duplicated values on the

import to records that already exist in Sugar. Duplicate checking will only
apply to new records created by the import. For more information on
detecting duplicates, please review the Detecting Duplicates section of this
documentation.

17. If the import configuration that you have set up is going to be used again in
the future, add a name at the button of the page so that it can be
referenced later. For more information on saving mapping, please review
the Saving Field Mappings section of this documentation.

18. Click "Import Now" to begin the import.
19. After the import completes, you are brought to the "View Import Results"

page. Here, you are provided with a summary of the import.

20. The summary will tell you how many records were updated, how many
were created, how many were not created due to an error, and how many
were found as duplicates, as applicable.

21. There are three buttons below the Summary:

Undo Import : If there was a mistake in the import of any new
records that you realized after importing, you can check this button.
All new records that were created via the import will be deleted.
After updating, no changes to updated records can be reverted. This
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button cannot be re-accessed for this import. As soon as you
navigate away from this page, the import is considered complete.
This button will not show if there were no new records created.
Import Again : Click this button if you would like to go back to the
first step of the Import Wizard and perform additional imports.
Clicking this button will consider the import to be complete.
Exit : This button will also consider the import to be complete, but
will bring you back to the module's list view to be able to further
review or search your records.

22. There are also three tabs on the summary page under the action buttons:

Created Records : This tab will show you a list view of all of the
records that were properly imported on this import. If this was only
an update, there will not be any records showing on this tab as it
does not show updated records.
Duplicates : This tab will present you with any records that were
not imported due to the Import Wizard finding duplicates from Step
16. There is an option to download a list of the duplicates, which
produces a new CSV file. You have the option to download this list,
make any changes, and import again following this same process. If
you did not use any duplicate settings, this tab will be empty.

Errors : This tab will show you any records that were not imported
due to an error during the import process. This is usually seen when
there is a problem with data that is on one of the records or rows in
the import file. For instance, if you are missing a value for a
required field, or a field is formatted incorrectly.

Note: Similar to the option to download duplicate records, you also
have the option to download the list of errors using the two links
provided:

The "Download list of errors" option will produce a new CSV
file with columns showing (from left to right) the error, the
field affected, the value, and the line in your original import
file where the error occurred.

The "Download list of rows that were not imported" option
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will download a new CSV file with the same format of your
original one, containing only the rows that were not
imported so that you can correct the errors and then re-
import.

23. Once you have downloaded the desired lists and reviewed the import, the
buttons mentioned in Step 21 can be used to complete your import.

Importing Fields With Multiple Values

Multiselect fields allow for the input of multiple values. When importing data to
these fields, it is possible to import multiple field values using a comma delimiter
within the field.

Importing Multiselect Fields to New Records

To import multiple values to a multiselect field on a new record, the import data
file's mapped column should contain exact character matches to existing dropdown
values separated by commas. For example, a multiselect field for Flavors contains
the options Chocolate, Pistachio, Rocky Road, Spumoni, and Vanilla.
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To import a new record that contains both "Vanilla" and "Chocolate" in the Flavors
field, the import data file's Flavors column should contain Vanilla,Chocolate with a
comma separating the values and no extra spaces. If one of the imported
multiselect options is a phrase, such as "Rocky Road", then the imported data field
should contain a space character only within that value: Vanilla,Chocolate,Rocky
Road.

Note: The dropdown option display labels are not required to be unique, so best
practice is to import the database values if they are known. For more information
about how admin users can see database values and display labels for dropdown
options, please refer to the Dropdown Editor documentation.

Importing Multiselect Fields to Existing Records

Importing updates to a multiselect field of a record already existing in Sugar will
erase any previous values and replace them with the imported values. If you wish
to append new values to the existing values via import, you must first export the
contents of the field for each record you will be updating, add the desired values to
the existing values in by modifying the exported CSV file, then import the modified
export file to Sugar.

For example, imagine you would like to update 100 existing contact records. Each
of the 100 contacts should have "Chocolate" added to the multiselect field
"Flavors" without losing the data that is stored in the multiselect field already. The
following steps explain how to append a multiselect field via import:

1. Export the list of 100 contacts that need to be updated.
2. Preserve (at least) the Last Name, ID, and Flavors fields in the export file.

The other field columns may be deleted.
3. Sort the spreadsheet data by the Flavors column.
4. Remove any rows from the file that already contain "Chocolate" as a value

in the Flavors column.
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5. If the Flavors column contains any empty cells, type the word Chocolate in
those cells. In the remaining cells of the Flavors column, add ,Chocolate
(with a leading comma but no extra spaces) to the end of the existing
character string.

6. Save this file for import.
7. Follow the steps in the Importing Updates to Existing Records section of

this documentation to complete the import and update process.

Importing Relationships

There are many situations where imports need to forge a relationship between two
modules. A common example of this would be how importing contacts without an
account name would leave the contacts orphaned and not linked to any parent
account. To solve this problem, Sugar allows one-to-many and one-to-one
relationships to be imported during the standard import process. The available
fields will vary depending on the module being imported and will show on the 
Import Template.

Please note that when an opportunity is imported into Sugar, a revenue line item
must also be imported and related to the opportunity in order to populate the
amounts (e.g. best, likely, etc.) on the opportunity record. Be sure to include the
opportunity ID and amounts on the revenue line item import file.
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When importing a relationship, Sugar will need the related record's unique ID, or,
in some cases, will accept the record's Name field. Examples of the fields that
relate one module to another are explained below. For additional tips and steps to
import related records, please refer to the Importing Related Records article.

Module Module Related
To

Field(s) Used For
Relationship

Instructions For
Import

Accounts Accounts Member Of On the import file,
add a column for
"Member Of". You
can use either the
Sugar record ID or
the exact name of
the parent account.
This will cause the
imported record to
be related to the
parent account on
the "Member Of"
field.

Using an account
name that Sugar
does not recognize
will create an
additional new
account record.

Note: If you are
using the account
name, it must be
exactly as it shows
in Sugar. For
example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar
CRM" or
"SugarCRN", the
account will not
relate properly.

Parent Account Id On the import
template, there is a
column for "Parent
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Account". Use the
existing Sugar
record ID of the
parent account.
The dropdown
option for this is
Parent Account Id.
This will cause the
imported record to
be related to the
parent account on
the "Member Of"
field.

Campaigns Campaign Use the existing
Sugar campaign
name or campaign
record ID to relate
the account to the
campaign record.

Note: If you are
using the campaign
name, it must be
exactly as it shows
in Sugar. For
example, if your
campaign in Sugar
is "End of Year
Newsletter", but
your import file
contains "End of
Year News" or "End
of Year Promotion",
the account will not
relate properly.

Campaign ID Use the existing
Sugar campaign
record ID number
to connect the
campaign name
into the new
account record.

Calls Contacts Contact ID Use the existing
Sugar contact
record ID number
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to connect the
contact name into
the new call record.

Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both
"Related To
Module" and
"Related To ID".
Both need to be
used to form the
proper relationship.

Related To
Module: The Sugar
module's plural
name for the
record that you are
going to relate
(Accounts,
Contacts, etc.).

Related To ID:
The ID for the
record you are
relating.

Cases Accounts Account ID Use the existing
Sugar account
record ID to relate
the case to the
account record.

Account Name Use the existing
Sugar account
name or record ID
to relate the
contact to the
account record.

Note: If you are
using the account
name, it must be
exactly as it shows
in Sugar. For
example, if your
account in Sugar is
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"SugarCRM", but
your import file
contains "Sugar
CRM" or
"SugarCRN", the
account will not
relate properly.

Contacts Accounts Account ID Use the existing
Sugar account
record ID to relate
the contact to the
account record.

Account Name Use the existing
Sugar account
name or record ID
to relate the
contact to the
account record.

Using an account
name that Sugar
does not recognize
will create a new
account record
with a relationship
to the contact. 

Note: If you are
using the account
name, it must be
exactly as it shows
in Sugar. For
example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar
CRM" or
"SugarCRN", the
account will not
relate properly.

Campaigns Campaign Use the existing
Sugar campaign
name or campaign
record ID to relate
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the contact to the
campaign record.

Note: If you are
using the campaign
name, it must be
exactly as it shows
in Sugar. For
example, if your
campaign in Sugar
is "End of Year
Newsletter", but
your import file
contains "End of
Year News" or "End
of Year Promotion",
the contact will not
relate properly.

Campaign ID Use the existing
Sugar campaign
record ID number
to connect the
campaign name
into the new
contact record.

Contacts Reports To Use the existing
Sugar contact
record ID number
to connect the new
contact and the
existing one.

Emails Email Address

Non-Primary Email
Address

Importing an
existing email
address into
Sugar's Contacts
module will cause
all email messages
related to that
email address may
match the contact's
primary or non-
primary email
address and must
be exact for the
relationship to form
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properly.

Note: Importing an
update to a contact
with an existing
email address, the
Opt-Out and Invalid
checkboxes will not
be disabled if they
are checked on the
existing email
address.

Leads Accounts Account ID Use the existing
Sugar account
record ID to relate
the lead to an
existing account
record. This is not a
relationship that
can be forged from
the Leads module
in Sugar. This can
be created from an
Account record,
though. This
relationship is
usually formed
through the Lead
Conversion
process.

Account Name In Leads, this is
just a text field.
This will not create
any relationships.
Upon conversion,
an Account can be
created. For more
information on
converting leads,
please review the 
Lead Conversion
documentation.

Campaigns Campaign Use the existing
Sugar campaign
name or campaign
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record ID to relate
the lead to the
campaign record.

Note: If you are
using the campaign
name, it must be
exactly as it shows
in Sugar. For
example, if your
campaign in Sugar
is "End of Year
Newsletter", but
your import file
contains "End of
Year News" or "End
of Year Promotion",
the lead will not
relate properly.

Campaign ID Use the existing
Sugar campaign
record ID number
to connect the
campaign name
into the new lead
record.

Contacts Contact ID Use the existing
Sugar contact
record ID to relate
the lead to an
existing contact
record. This is not a
relationship that
can be forged from
the Leads module
in Sugar. This can
be created from a
contact record,
though. This
relationship is
usually formed
through the Lead
Conversion
process. For more
information on
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converting leads,
please review the 
Lead Conversion
documentation.

Opportunities Opportunity ID Use the existing
Sugar opportunity
record ID to relate
the lead to an
existing
opportunity record.
This is not a
relationship that
can be forged from
the Leads module
in Sugar. This can
be created from an
opportunity record,
though. This
relationship is
usually formed
through the Lead
Conversion
process. For more
information on
converting leads,
please review the 
Lead Conversion
documentation.

Opportunity Name In Leads, this is
just a text field.
This will not create
any relationships.
Upon conversion,
an opportunity can
be created. For
more information
on converting
leads, please
review the Lead
Conversion
documentation.

Emails Email Address

Non-Primary Email
Address

Importing an
existing email
address into
Sugar's Leads
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module will cause
all email messages
related to that
email address may
match the lead's
primary or non-
primary email
address and must
be exact for the
relationship to form
properly.

Note: Importing an
update to a contact
with an existing
email address, the
Opt-Out and Invalid
checkboxes will not
be disabled if they
are checked on the
existing email
address.

Meetings Contacts Contact ID
Use the existing
Sugar contact
record ID number
to connect the
contact name into
the new meeting
record.

Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both
"Related To
Module" and
"Related To ID".
Both need to be
used to form the
proper relationship.

Related To
Module: The Sugar
module's plural
name for the
record that you are
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going to relate
(Accounts,
Contacts, etc.).

Related To ID:
The ID for the
record you are
relating.

Notes Contacts Contact ID Use the existing
Sugar contact
record ID number
to connect the
contact name into
the new note
record.

Flex Relate Related To Module

Related To ID

On the import
template, there are
columns for both
"Related To
Module" and
"Related To ID".
Both need to be
used to form the
proper relationship.

Related To: The
Sugar module's
plural name for the
record that you are
going to relate
(Accounts,
Contacts, etc.).

Related To ID:
The ID for the
record you are
relating.

Opportunities Accounts Account ID Use the existing
Sugar account
record ID to relate
the opportunity to
the account record.

Account Name Use the existing
Sugar account
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name or record ID
to relate the
opportunity to the
account record.

Using an account
name that Sugar
does not recognize
will create a new
account record
with a relationship
to the opportunity. 

Note: If you are
using the account
name, it must be
exactly as it shows
in Sugar. For
example, if your
account in Sugar is
"SugarCRM", but
your import file
contains "Sugar
CRM" or
"SugarCRN", the
account will not
relate properly.

Campaigns Campaign Use the existing
Sugar campaign
name or campaign
record ID to relate
the opportunity to
the campaign
record. 

Note: If you are
using the campaign
name, it must be
exactly as it shows
in Sugar. For
example, if your
campaign in Sugar
is "End of Year
Newsletter", but
your import file
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contains "End of
Year News" or "End
of Year Promotion",
the opportunity will
not relate properly.

Campaign ID Use the existing
Sugar campaign
record ID number
to connect the
campaign name
into the new
opportunity record.

Revenue Line Items Accounts Account ID Use the existing
Sugar account
record ID to which
the revenue line
item's opportunity
belongs
Note: The Account
Name field in
revenue line items
is normally
populated based on
the selected
opportunity's
related account and
cannot be manually
modified on the
record view. If you
import using the
Opportunity ID and
Opportunity Name,
the related account
name will
automatically
populate in the
Account Name
field.

Account Name Use the existing
account name
related to the
revenue line item's
opportunity
Note: The account
name must be
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entered exactly as
it appears in Sugar
in order for the
records to be
related properly.

Campaigns Campaign ID Use the existing
Sugar campaign
record ID number
from which the
revenue line item's
opportunity
originated

Campaign Use the existing
Sugar campaign
name that is
related to the
revenue line item's
opportunity

Note: The
campaign name
must be entered
exactly as it shows
in Sugar. For
example, if your
campaign in Sugar
is "End of Year
Newsletter", but
your import file
contains "End of
Year News" or "End
of Year Promotion",
the revenue line
item will not relate
properly.

Opportunities Opportunity ID Use the existing
Sugar opportunity
record ID number
to relate the
revenue line item
to the opportunity
record

Opportunity Name Use the existing
opportunity name
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as it appears in
Sugar to relate the
revenue line item

Products Product Template
ID

Use the existing
Sugar product
catalog record ID
number to relate to
the revenue line
item

Product Use the existing
product catalog
name as it appears
in Sugar to relate
to the revenue line
item

Targets Accounts Account Name In Targets, this is
just a text field.
This will not create
any relationships.

Campaigns Campaign ID Use the existing
Sugar campaign
record ID number
to connect the
campaign name
into the new target
record.

Leads Lead ID Use the existing
Sugar lead record
ID to relate the
target to an
existing lead
record. This is not a
relationship that
can be forged from
either module in
Sugar. This
relationship is
usually formed
through the target
conversion process.
For more
information on
converting targets,
please review the 
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Lead Conversion
documentation.

Tasks Contacts Contact ID
Use the existing
Sugar contact
record ID number
to connect the
contact name into
the new Task
record.

Flex Relate Related To ID

Related To Module

On the import
template, there are
columns for both
"Related To ID" and
"Related To
Module". Both need
to be used to form
the proper
relationship.

Related To ID:
The ID for the
record you are
relating.

Related To
Module: The Sugar
module's plural
name for the
record that you are
going to relate
(Accounts,
Contacts, etc.).

Importing Team-Based Permissions

Modules with team-based permissions enabled support two additional columns for
imports:

Selected Teams : A comma-delimited list of the team names that are
selected for extra access
Selected Team Set ID : A unique identifier that references the group of
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teams contained in the Selected Teams field

When importing a list of new records or record updates, include one of these
columns in the import file to set record-level access to the records. If known, the
Selected Team Set ID field is the most efficient way to communicate the data to
Sugar. In the more common scenario that the ID is unknown, simply insert the
name of the selected team (or teams separated by commas) in the Selected Teams
field.

Import File Template

The Import File Template is a very useful tool for building your import file from
another source or from scratch. The template for any module can be found on the
Upload Import File page, which is either the first or second page of the wizard,
depending on the module.

The purpose of this file is to let you know what format Sugar is going to be looking
for when you perform your import. The file contains all fields for a given module,
regardless of if they show on any of your layouts. The file is also properly
formatted and all settings are ready for the import. Upon opening the template,
you will see a few example lines of either actual records from your instance, or,
"demo data" if you have not yet performed an import. The template also contains
instructions on how it is used.

It is best to use the format supplied in this template whenever possible to make
your import process as seamless as possible.

Saving Field Mappings

When importing data, there can be times where you will be using the same import
file format. If this file was not exported from Sugar, that likely means that you
have to re-map most of the fields on the Confirm Field Mappings screen of the
Import Wizard. To save time in the future, you can use the Import Wizard's pre-set
import settings.

On the "Check for Possible Duplicates" page of the wizard, which is the last page
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before performing your import, there is a text box where you can name the import
settings that you have used on this import.

Once you click "Import Now", this mapping will be saved and available for your use
in future imports.

This mapping is now saved for your user and will appear on the Upload Import File
page of the Import Wizard. This will include two buttons for "Publish" and "Delete".

Publish : Clicking this option will make your mapping available to all
users. The Publish button will change to "Un-Publish" so that you can stop
other users from using the template mapping. When it is published, it will
appear as an option in the same section for other users when they perform
an import.
Delete : This button will remove the pre-set import mapping for all users.
This action cannot be undone.

Detecting Duplicates

During an Import, Sugar's Import Wizard includes the functionality to check for
duplicate records. When enabled, Sugar will check to see if a record already exists
in Sugar with the given criteria. When checking for duplicates, Sugar will mark
any record as a duplicate if it cross-references against any of the duplicate fields.
For example, when importing Contacts, if you select Last Name and Email Address
as your duplicate check fields, any record that has a matching last name or a
matching email address to an existing contact in Sugar will be marked as a
duplicate.
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The duplicate check fields used in each module differ depending on what fields are
available to the module. Not all fields are used or available in the duplicate check
and are pre-determined based on system-defined indexes.

If your import file has any duplicate records based on the fields you elect to verify
against, the first record will be imported, and then all subsequent records in the
file matching the duplicate criteria will be flagged.

Any duplicates will show as such on the final page of the import. You will also have
the option to download the duplicates so that they can be manually cross-
referenced to verify if they are actually duplicates. If they are not, simply re-run
the import process without selecting any fields on the "Check for Possible
Duplicates" page.

External Data Sources

When importing data to Sugar, there are other options than importing a data file
exported from another source. Sugar offers an option to directly connect to an
outside application or service through the Import Wizard and have Sugar pull the
information directly from the source. This functionality is currently only available
for Google Contacts.

The import process is very similar to what is described above, but with some
differences to speed up the process for users who would like to import all contact
data into Sugar

Importing Data From Google

1. Navigate to the module tab for the person-type module (e.g. Contacts) that
you are importing into and select the import option. This will open the
Import Wizard and bring you to the "Select Data Source" screen.

2. On the Select Data Source screen, navigate to the "My data is in:" section
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and choose the option for "an external application or service". This will
activate a "Sign In" button for you to sign in to your Google account.

3. Fill in your user name and password for the Google account you would like
to connect to and click "Connect".

4. Upon connecting, you will be brought to your user profile, on the "External
Accounts" tab. Navigate back to the import screen, repeating steps 1 and 2
above. Click "Next" this time, instead of Sign In.

5. This will direct you to the "Confirm External Source Properties" page,
which is very similar to the mapping screen from a data import from a file
on your computer. Change any mapping necessary specific to your Google
account and your Sugar instance. Any field in the Module Field column
marked with an asterisk (*) is a required field and must be imported.

6. There is no duplicate check for this type of import, but names and email
addresses are automatically checked for duplicates.

7. Click "Import Now" after you have completed your mapping.
8. On the "View Import Results" screen, you will see that all of your Google

contacts have been successfully imported into Sugar.
9. Any records that were not imported due to error can be exported from

Sugar and then re-imported if need be using the "Download list of rows that
were not imported" link
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10. To review the standard import process to re-import any additional records
please review the Importing New Records section of this documentation.

Admin Import Wizard

Administrators have special functionality available in Sugar that may not be
available for all other users. One of these is access to the Admin Import Wizard. In
the "Admin" menu, under the "System" panel, there is a link for "Import Wizard".

Clicking this option will bring you to the Import Wizard, similar to the one for
specific modules. However, the first step here is for "Select Data Source", where
you will need to select the module you wish to import data. The dropdown provided
includes options for all importable modules in one convenient location. Once you
select the module from the list, click "Next" and you will be directed to the
standard import wizard where you can import new records or update existing ones.

Last Modified: 2020-03-11 01:11:35

Employees

Overview

Sugar's Employees module consists of individual people within your organization.
The Employees module allows you to see a list of all employees, their contact
information, and their employment status in one convenient location. Employee
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records are typically created when a user record is created, but users with
administrative access can also add non-user employees. This means that, typically,
all users will be listed as employees, but not all employees are necessarily Sugar
users.

For more information on having administrators create employee records in Sugar,
please refer to the Employee Management documentation in the Administration
guide.

For more information on having administrators create user records in Sugar,
please refer to the User Management documentation in the Administration guide.

To access the Employees module, click your profile icon on the upper right of any
page in Sugar then select "Employees" in the user menu.

Employee Fields

The Employees module contains a number of stock fields which come out-of-the-
box with Sugar. The below definitions are suggested meanings for the fields, but
the fields can be leveraged differently to best meet your organization's needs.
Users with administrator or developer access have the ability to alter, add, or
remove fields via Admin > Studio. For more information on configuring fields,
please refer to the Studio documentation in the Administration guide.

Field Description
City The city of the employee's address
Country The country of the employee's address
Department The department where this employee

works
Email Address The employee's email address
Employee Status The employee's employment status in

the organization, either: Active,
Terminated, or Leave of Absence
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Fax The employee's fax number
First Name The employee's first name
Home Phone The employee's home phone number
IM Name The employee's instant message screen

name
IM Type The employee's instant message client

type
Last Name The employee's last name
Mobile The employee's mobile phone number
Notes A description or other information about

this employee
Office Phone The employee's office phone number

and extension
Other An additional phone number for the

employee
Picture A picture, headshot, or identifying

image of the employee
Primary Address The number and street of the

employee's address
Postal Code The postal code of the employee's

address
Reports to This field can be related to the Sugar

user who is the employee's supervisor
State The state of the employee's address
Title The employee's job title

Employees Module Tab

The Employees module tab can be accessed by clicking your profile icon and
selecting "Employees" in the user menu. Once in the Employees list view, you can
click the triangle in the Employees module tab to display the Actions and Recently
Viewed menus. The Actions menu allows you to perform important actions within
the module. The Recently Viewed menu displays the list of employees you last
viewed in the module.
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Viewing Employees

There are various options available for viewing employee records in Sugar
including via Employees list view, Employees detail view, and the Employees
Recently Viewed menu. Please note that you will only be able to access these views
by first clicking on the Employees button after clicking on your user name on the
top right side of Sugar.

Viewing Via List View

The Employees list view displays all employee records meeting the current search
criteria. To access the list view, simply click the Employees option under your user
name on the module tab bar. While list view shows key employee fields, you can
click the employee's name to open the record in detail view. For more information
on viewing employees via list view, please refer to the Employees List View section
of this documentation.

Viewing Via Detail View

The Employees detail view displays thorough employee information by showing all
employee fields. The detail view can be reached by clicking an employee record's
link from the Employees list view. For more information on viewing employees via
detail view, please refer to the Employees Detail View section of this
documentation.

Viewing Via Recently Viewed

As you work, Sugar will keep track of which employees you have recently viewed.
Click the triangle in the Employees module tab to see a list of the 3 records you
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most recently viewed in the module. Clicking the record's name (e.g. Will Westin)
within the list will open the record in detail view.

Searching Employees

The Employees list view includes a Basic and Advanced Search to help you locate
records easily and effectively in a module-specific manner. Once the search is
performed, the relevant results will be displayed in the Employees list view below.
Please note that Sugar automatically appends the wildcard character (%) to the
end of your search phrase. This allows the system to retrieve all records that start
with the keyword entered in the search. If you would like to broaden the search,
you can use the wildcard at the beginning of your text as well (e.g. %services). This
will pull up any record that has the word "services" in the name, regardless of how
it starts or ends.

For more information on using the various search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

Basic Search

Basic search offers a few, commonly used fields for a simplified search experience.
From the Basic Search panel, you can click "Advanced Search" to access additional
search functionality as needed.

The buttons and checkboxes available in Basic Search panel have the following
functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
Active Employees : Select this box to return only records where Employee
Status is Active.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
employee records with a matching name that are active. Once the search is
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complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear on the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the
Advanced search panel, you can click "Basic Search" for simplified searching.

The buttons, checkboxes, and dropdowns available in Advanced Search have the
following functions:

Search : Click the Search button or press your Return/Enter key to
perform the search.
Clear : Click the Clear button to clear all criteria from the searchable
fields.
Active Employees : Select this box to return only records where Employee
Status is Active.
Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.
Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "Active Employees" and enter an employee's name, Sugar will only return
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employee records with a matching name that are active. Once the search is
complete, the relevant results will populate in the list view below the search panel.
To see all employee records, simply click "Clear" and then "Search" to perform a
blank search with no filters.

Administrators can configure what fields appear o n the Employees Basic Search
via Admin > Studio. For more information on editing layouts, please refer to the 
Studio documentation in the Administration guide.

Employees List View

The Employees list view displays all employee records meeting the current search
criteria. You can view the basic details of each employee within the field columns.

You have the option to change what fields are displayed in list view by configuring
your layout options in the Employees Advanced Search. For more information on
configuring your list view, please refer to the Layout Options section of the Search
documentation. Users with administrator or developer access also have the ability
to change what fields are visible in the list view via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation in the
Administration guide.

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the 
System documentation in the Administration guide.

Column Sorting
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List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, click the column header, noting that the fields which allow sorting
will have a pair of arrows. The list view may be sorted by only one column at a
time. You can also set a default order-by column using the layout options in
Advanced Search. For more information on setting a default column sort, please
refer to the Layout Options section of the Search documentation.

Employees Detail View

The Employees detail view displays thorough employee information by way of all
employee fields grouped into one page.

Users with administrator or developer access have the ability to change the detail
view by configuring the layout via Admin > Studio. For more information on
editing layouts, please refer to the Studio documentation in the Administration
guide.

Next or Previous Record

On the upper right of the Employees detail view, there are two buttons that allow
you to page through each employee in the Employees list view's current search
results. Clicking the Previous button displays the previous employee of the current
search results while clicking the Next button displays the next employee of the
current search results. The text in between shows which employee result you are
currently viewing within the total number of current results.

Last Modified: 2020-02-13 14:46:25
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Mobile Browser
Sugar can be accessed via browsers on mobile devices (i.e. Android, iOS) as a
means of working with your Sugar instance without installing the Sugar mobile
app. To access your Sugar instance via browsers in a mobile view, simply enter
your instance URL and append /?mobile=1 to the end of the URL as follows:
https://example.sugarondemand.com/?mobile=1.

For more information on navigating and utilizing your Sugar instance in a mobile
view, please refer to the Sugar Mobile User Guide for your specific mobile device
(i.e. Android, iOS).

Note: Please be aware that some features covered in the Sugar Mobile user guides
may be unavailable in the mobile browser view. 

Last Modified: 2020-03-11 01:13:27

Tags

Overview

Tags are user-created keywords or phrases that can help users find, group, and
classify large amounts of data by common attributes that may not already be
defined via basic database fields. Sugar stores tags as individual records in the
Tags module. Modules (e.g. Accounts, Contacts, etc.) using the Sidecar user
interface contain a Tags field where users can create and share tags that can be
used to identify records in filters, dashlets, and reports.

Users can easily create tags from any tags-enabled module's (e.g. contact's) record
view. Once the tag is created, it may then be related to other Sugar records such
as meetings, cases, opportunities, and many others. One Sugar record can have
multiple tags. This documentation will cover how users can create new tags and
use existing tags by interacting with the system-wide tag repository.

While tags can be created and used by regular Sugar users, some actions in the
Tags module are only available to administrators and users with developer-level
role access. This documentation will cover the actions available to all users. For
information about tag administration options which allow you to manage the
system-wide tag repository, please refer to the Tag Management documentation in
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the Administration Guide. For instructions concerning views and actions which are
common across most Sugar modules, please refer to the Working With Tags
section of this page.

Unlike other Sugar modules, users can see all tag records regardless of their team
membership, but visibility may be affected by user access and assigned roles. For
more information on access types and roles, please refer to the Role Management
documentation in the Administration guide.

Understanding Tag Behavior

The act of relating a tag to a Sugar record is referred to as "tagging". A user can
tag any Sidecar module record in Sugar via the Tags field. Please refer to the User
Interface documentation for a list of Sidecar modules. If you do not see the Tags
field but expect that you should, reach out to your system administrator to discuss
tag visibility and access settings for your user.

Use cases for effective tagging include:

Use Case Example Tags
Classifying high-value or urgent
business

Connecting specific events and activities
with clients

Assigning role-based attributes

Noting interest-based and demographic
classifications

When working with tags in Sugar, keep in mind the following rules of tag behavior:

Tags may be a single word or a short phrase.
Differentiate between single-word tags and multi-word phrases by using a
comma between tags.
Inserting a space character will result in a single, multi-word tag.
Tags are not case-sensitive, but take care to prevent unintentional
duplicates due to misspellings or unnecessary punctuation.
Tags are shared by every user in an instance and across all tags-enabled
modules. When you create and save a new tag, all users will immediately
be able to use that tag regardless of team restrictions.
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Clicking on Tags

Clicking on a tag in Sugar may take you to the tag's record view or to the global
search's View All Results page, depending on where you are in the application
when you click the tag. If you click on a tag that links to its own record view, the
Sugar records related to the tag will be visible, grouped by module, in the tag's
related-record subpanels.

Note: Users cannot remove the tag-to-record relationship via a tag's related-
record subpanels. To remove a tag relationship, edit the tagged record's Tags field
as explained in the Tagging via Record View section of this page.

For more information on viewing a tag record's related-record subpanels, please
refer to the User Interface page. If a tag links to the global search's View All
Results page, you will see the records related to the tag in search-result form. For
more information on navigating and viewing global search's View All Results page,
please refer to the Search documentation.

When clicking on a tag to view related records, only modules (e.g. Accounts,
Contacts) that are enabled for global search will appear in the View All Results
page. Please note that the Reports module is not enabled for global search.

Note: When viewing related records via the tag's record view or global search's
View All Results page, please keep in mind that you will only be able to see records
as allowed by your team membership, user access, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation in the Administration guide.

The following table summarizes what you can expect when clicking on a tag from
various locations in Sugar:

Tag Location Tag Format Tag Appearance Result
Tags List View Hyperlink Opens the tag's

record viewReport Results Hyperlink

My Tags Dashlet Hyperlink

Related Module
List View Dashlet

Hyperlink Opens global
search View All
Results pageRelated Module

List View
Hyperlink

Related Module
Record View

Pill

Intelligence Pane Pill
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(Preview)
Subpanel List View Hyperlink

Global Search Bar Tag Ribbon Adds the tag as a 
Global Search filter

Note: When editing a record, the tag pills displayed in the Tags field are not
clickable.

Tag Fields

The Tags module contains a number of stock fields which come out-of-the-box with
Sugar. The following definitions are suggested meanings for the fields, but the
fields can be leveraged differently to best meet your organization's needs.

Field Description
Name The name or designation of the tag
Assigned To The Sugar user assigned to the tag

record
Date Created The date the tag record was created
Date Modified The date the tag record was last

modified
Description A description or other information about

the tag

Working With Tags

When working with tags, common data management tasks such as editing,
merging, and deleting are restricted to administrator users and users with
administrator- or developer-role access to the Tags module. For more information
on these administrative options, please refer to the Tag Management
documentation in the Administration guide.

Tags can be created, added to records, and removed from records without visiting
the Tags module by performing those actions directly in a Sugar record. Regular
users need only access the Tags module to view tags and their related records in
list view and record view. The Tags module offers tag administrators additional
functionality that is covered in the Tag Management page of the Administration
Guide.
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Content Link Description
Viewing Tags
Viewing via List View
Viewing via Record View
Viewing via Recently Viewed
Viewing via Dashlets
Viewing via Reports

There are various options available for
viewing tag records in Sugar including
via Tags list view, Tags record view,
Tags Recently Viewed menu, dashlets,
and reports. Unlike other Sugar
modules, users can see all tag records
regardless of their team membership,
but visibility may be affected by user
access and assigned roles. For more
information on access types and roles,
please refer to the Role Management
documentation in the Administration
guide.

Searching for Tags
List View Search
Creating a Filter
Saving a Filter

The Searching for Records section
provides an introduction to searching
for tag records via list view search,
which searches and filters within the
Tags module. Tags can also be used to
narrow global search results for records
in other modules. For more information,
please refer to the Using Tags in Global
Search section of this page.

Tags List View
Total Record Count
List View Search
Checkbox Selection
Favorite Designation
Column Reordering
Column Resizing
Column Sorting
Column Selection
Preview
More Tags
Dashboards

The List View section walks through the
many elements of the Tags List View
layout, which contains a filterable list of
all tag records in Sugar.

Tags Record View
Favorite Designation
Next or Previous Record
Subpanels
Related Record Subpanels
Filtering Subpanels
Reordering Subpanels
Dashboards

The Record View section walks through
the many elements of the Tags Record
View layout, which contains detailed
information about a single tag record.
While the generic menu options are
described in the User Interface sections
linked to the left, the options specifically
available in the Tags record view are
described in the Record View Actions
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Menu section of this page.
Exporting Tags The Exporting Records section provides

an introduction to the export
functionality which allows you to
download a list of tags and all their data
as a .csv file for use outside of Sugar
(e.g. in Microsoft Excel).

Viewing Tag Audit Logs The Viewing Record Audit Logs section
describes the View Audit Log record
view option which displays a history of
changes to the tag's audited fields.

Note: Only the Assigned User Id field is
audited for the Tags module and will,
therefore, be the only field displayed in
the audit log.

Favoriting Tags
Favoriting via List View
Favoriting via Record View
Favoriting via Subpanel

The Favoriting Records section
describes the various methods of
marking tags as favorites, including via
the Tags list view and Tags record view.
Favoriting a tag allows you to easily
access it from list views, dashlets, or the
Tags module tab.

Sharing Tags The Sharing Records section provides
instructions for the Share record view
option, which composes an email with a
link to the tag record. If the recipient is
logged into Sugar, clicking the link will
bring them directly to the tag's record
view.

Tag Menus

The following sections describe the various menu options in the Tags module with
links to more information about each option in the User Interface documentation
or, for tag-specific functionality, within this page.

Module Tab Menus

The Tags module tab is typically found by clicking the "More" icon represented by
three vertical dots to the right of the module tabs on the navigation bar at the top
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of any Sugar screen. The additional modules will appear on the list and you can
click "Tags" to access the list view. 

Once the Tags module tab displays on the navigation bar, click the triangle within
the tab to display the Actions, Recently Viewed, and Favorites menu. The Actions
menu allows you to perform important actions within the module. The Recently
Viewed menu displays the list of tags you last viewed in the module. The Favorites
menu displays the list of tags you most recently marked as favorites in the module.
For information about favoriting records in Sugar, please refer to the User
Interface documentation.

The Actions menu allows you to perform the following operation:

Menu Item Description
View Tags Opens the list view layout to search and

display tags

If you do not see the Tags module tab in Sugar, please check the following:

The Tags module may be marked as hidden in your user preferences which
will prevent the module tab from being displayed. Navigate to your user
profile (upper right of Sugar), click the Advanced tab, and check the Layout
Options section. If you see the Tags module in the Hide Modules list, simply
move it to the Display Modules list and save. For more information on
hiding and displaying modules, please refer to the Layout Options section
of the Getting Started documentation.
The administrator may have disabled the Tags module for your entire
Sugar instance. Reach out to your Sugar administrator to have the Tags
module displayed and the Tags field added to Sidecar module layouts. For
more information on displaying and hiding modules throughout Sugar,
please refer to the Developer Tools documentation in the Administration
guide.
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Record View Actions Menu

The tag's record view displays the fields relevant to the Tags module. To access a
tag's record view, refer to the table within the Clicking on Tags section of this
page. The record view's Actions menu appears on the top right of the record.

The Actions menu allows you to perform the following operations: 

Menu Item Description
Share Share a link to this tag in Sugar via

email
View Audit Log View a record of changes to this tag's

audited fields

Creating Tags

Regular users can create new tags by tagging records via the Tags field, mass
update, and import within Sugar Sidecar modules. Users with administrator or
developer access can create Tag records in various ways directly via the Tags
module. Please note that when a new tag is created and saved, all users will
immediately be able to use that tag in any Sidecar module regardless of team
restrictions.

Creating via Tags Field

All users can create new tags on the fly from the Tags field in any Sidecar module
(Accounts, Contacts, etc.). This will automatically create a relationship between
the record and the tag. Simply enter the name of the tag (e.g. skiing) in the Tags
field to create the new tag record. Please note that the other fields (e.g. Assigned
To, Date Created, etc.) in the Tags record view will automatically populate by
default. For more information on creating tags via record view, please refer to the 
Tagging via Record View section of this documentation.

Note: Users will be able to edit the Tags field to create new tags regardless of any
role restrictions the user has for the Tags module. 
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Creating via Tags Module

Another way to create tags is by using the Create Tag option in the Tags module.
Only users with administrator or developer access to the Tags module will see the
Create Tag option and Create button. For more information on creating tags via
the Tags module, please refer to the Tag Management documentation in the
Administration guide.

Tagging Records

Users can tag any record that contains a Tags field. By default, every Sidecar
module (Accounts, Contacts, etc.) will contain the Tags field on its record view.
When you create and save a new tag on any Sugar record, all users will
immediately be able to use that tag in any tags-enabled module regardless of team
restrictions. Please note that users will be able to edit the Tags field to add
existing tags or create new tags regardless of any role restrictions the user has for
the Tags module.

Only administrator and developer users can merge, delete, or update records
within the Tags module. To assign a tag management role to a Sugar User, please
refer to the Creating a Tags Administrator section of the Tag Management page in
the Administration Guide.

Tagging via Record View
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Tagging a record will automatically create a relationship between that record and
the tag. Simply type the name of the tag into the Tags field and then click "Save" to
tag a record. If the tag does not already exist, the tag will automatically be created
including setting the Date Created field and assigning the tag to you. For more
information on available Tag fields, please refer to the Tag Fields section of this
documentation.

Follow these steps to tag an account record as an example:

1. Navigate to an account's record view.
2. Click the Edit button on the upper right of the page or click inside the Tags

field.

3. Type the word or phrase that you would like to use as a tag. When you
enter the first letter of a tag, Sugar will begin to display recommended tags
that begin with the same letter.

To choose an existing tag, select it from the list of recommended
tags by clicking on the appropriate menu option.

To ignore the recommendations and create an entirely new tag,
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completely type out the word or phrase and then click on the New
Tag menu option. Alternatively, use a comma or the Enter key to
indicate the end of a tag. Take care not to create duplicate or
synonymous tags unintentionally. Please note that new tags will not
be saved to the database until you save the record that contains the
new tag.

To remove a tag or tags from a record, click the "x" on the tag to
remove it from the Tags field and then save the current record.
Alternatively, place the mouse cursor to the right of the tag and use
the keyboard's backspace to highlight it. Press the backspace key
again to remove the highlighted tag from the Tags field. Please note
that removing an existing tag from a record will not remove it from
the database; the tag will still exist, but it will no longer be related
to this particular record.

4. Once you have entered the desired tag or tags, click the record's Save
button to commit the changes to the record and save any new tags to the
database.

If the saved record contains any new tags, those tags will be saved as new records
in the Tags module. Users can now find the newly created tag when adding tags to
any tags-enabled module record, and may also search and browse the list of
available tags via the Tags module list view.

Tagging via Mass Update

Users can also use the mass update function on a tags-enabled module to tag many
records at one time. Mass update provides the following conveniences:

Add one or many tags to a group of records
Use any combination of new and existing tags
Replace existing tags or append additional tags to existing tag lists

Follow these steps to tag multiple contact records via mass update as an example:

1. Navigate to the Contacts list view.
2. Filter or search for the set of records you would like to tag. For example,

create a filter for all contacts whose titles start with "vp".
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3. Select all results or select the checkboxes next to the appropriate records.
For more information about selecting multiple records at once, please refer
to the Checkbox Selection section of the User Interface documentation.

4. Click on the list view Actions menu and select "Mass Update".

5. In the mass update bar, choose the Tags field and begin typing the phrases
you would like to use as tags one at a time in the empty text box. When you
enter the first letter of a tag, Sugar will begin to display recommended tags
that begin with the same letter.

6. Click on the tag suggestion to add the pill to the mass-update text box, or
click the New Tag suggestion to create a new tag. Alternatively, press
enter or the comma key. Continue adding tags if desired. For more
information on tagging records, please refer to the Tagging via Record
View section of this documentation.

7. Decide if you would like to replace the existing tags on the selected records
or if you prefer to append the specified tags to the records without
removing their existing tags. By default, the Append Tag(s) checkbox is
selected so that Sugar will not remove existing tags. Deselect this option to
overwrite all existing data in the Tags field of the selected records.
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8. Click "Update" to add the tag to all selected records.

Tagging via Import

Users can tag new or existing Sugar records by including the Tags field as a
column in an import file. For more information on tagging via import, please refer
to the Importing Fields With Multiple Values section of the Import documentation. 

Please note that importing an update to the Tags field of a record that already
exists in Sugar will erase any previous tags on the record and replace them with
the imported tags. For more information on importing tags to existing records,
please refer to Importing Multiselect Fields to Existing Records in the Import
documentation.

Formatting Tag Imports

Tags are not case sensitive, but they must be entered as an exact character match
in the import file when adding existing tags to records in order to prevent creating
duplicate variations of the same tag. For example, if there is an existing tag named
"rocky road" in Sugar, importing the tag "ROCKY ROAD" as all uppercase will
successfully find and relate the existing tag. However, if the import file contains
"rocky-road" with a hyphen, an unintentional synonymous tag will be created.

When importing tags to related module records (e.g. contacts), multiple tags being
added to one record should be separated with a comma. For example, to create or
update a contact record tagged as both "vanilla" and "chocolate", the import data
file's Tags column should contain vanilla,chocolate with a comma separating the
tags and no extra spaces between the tags. If one of the imported tags is a multi-
word phrase, such as "rocky road", then the imported data field should contain a
space character only within that tag value: vanilla,chocolate,rocky road.

For more information on importing records with the Tags field, please refer to the 
Import documentation in the Application Guide.
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Using Tags in Global Search

Global Search allows users to search for information across their entire Sugar
database as opposed to restricting results to a specific module. The Global Search
bar displays on the upper right of every Sugar page and utilizes full-text search to
search throughout many fields and modules for an enhanced search experience.

Users can locate and select tags as global search filters to easily locate groups of
records that are tagged by common attributes. For example, if you have a set of
leads that were acquired from a specific conference (e.g. 2015 Western
Conference) and you wish to locate all the lead records tagged with this value, you
can perform a search using the tag value. As you type the tag's name, a list of
matching tags will appear in the tag ribbon beneath the search box and display up
to five matching tags.

Click on the desired tag to apply it as a filter for the Global Search results. You can
append additional search terms or tags in the search box to further narrow your
search. Simply enter the keyword to the right of the current criteria and the
matching result(s) will display below.
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If you search using multiple tags, the system will look for records that match any
one of the tags in the search box using the "or" operator. For more information on
using Global Search, please refer to the Search documentation.

Last Modified: 2020-02-20 14:54:34

Data Privacy

Overview

The Data Privacy module allows users to record and take action on data privacy
requests and events in Sugar. This module is one portion of a feature set aimed at
supporting your ability to carry out your organization's data privacy policies.
Sugar's Data Privacy Guide provides information which spans the entire data
privacy feature set and presents consolidated information and instructions for
leveraging these tools to accomplish your organization's data privacy procedures.
This Data Privacy Guide will describe these enhancements, the configuration steps
an admin must complete before users can access the new functionality, as well as
provide guidance for end users and Data Privacy Managers. This documentation
will instead focus on the mechanics of using the module including its fields,
options, menus, and how to perform common actions on data privacy records.

Data Privacy Fields

The Data Privacy module contains a number of stock fields that come out-of-the-
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box with Sugar. For information on using and editing various field types, refer to
the User Interface documentation. The definitions below are suggested meanings
for the fields, but the fields can be leveraged differently to best meet your
organization's needs. Administrators or users with developer-level role access have
the ability to alter, add, or remove fields via Admin > Studio. For more information
on configuring fields, please refer to the Studio documentation in the
Administration Guide.

Field Description
Assigned To The Sugar user assigned to the data

privacy record
Business Hours to Resolution 1 The calculated duration in business

hours from the moment the data privacy
record is created until an admin or a
user in the Data Privacy Manager role
clicks the "Complete" or "Reject"
buttons at the top of the record.

Business Purposes Consented for Available when Type is set to "Consent
to Process" or "Withdraw Consent, the
various business purposes the individual
is being asked to consent to or for which
the individual is withdrawing consent.
For more information about tracking
consent, refer to the Data Privacy
Guide.

Comment Log A shared log of messages, comments, or
other text, including the name of the
user that added the log entry and the
date and time it was added. It is possible
to tag other users and link to other
Sugar records in Comment Log entries
by inserting a clickable pill; see the User
Interface documentation for more
details.

Date Closed User-populated recording of when the
data privacy record was rejected or
completed

Date Created The date the data privacy record was
created

Date Modified The date the data privacy record was
last modified

Date Opened The date the data privacy record was
created. This field will default to today's
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date upon creation but can be modified
by users if the actual request date
differs from the creation date of the
record

Description A description or other information about
the data privacy record

Due Date For request types with time limits, the
date by which the request must be
completed

Follow Up Date The internal follow-up date by which the
data privacy request should be acted
upon

Hours to Resolution 1 The calculated duration in calendar
hours from the moment the data privacy
record is created until an admin or a
user in the Data Privacy Manager role
clicks the "Complete" or "Reject"
buttons at the top of the record.

Number An automatically incremented number,
uneditable by users, which identifies
each data privacy record

Priority The relative importance of the request
or data privacy activity

Requested By For request types, the individual who
made the request to your organization

Resolution Freeform field to record how the
request or activity was handled

Source How the request or data privacy need
originated (e.g. "Email from subject",
"Gaining consent per policy", etc.)

Status The status of the record which is
automatically changed from "Open" to
"Rejected" or "Completed" when an
admin or a user in the Data Privacy
Manager role clicks the "Complete" or
"Reject" buttons at the top of the record.

Subject A brief description of the request of
activity that appears at the top of the
record

Tags User-created keywords that can be used
to identify records in filters, dashlets,
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and reports
Note: For more information on creating
and using tags, please refer to the Tags
documentation.

Teams The Sugar team(s) assigned to the data
privacy record

Type The type of request or activity being
handled in this record. For more
information, refer to the Data Privacy
Types section below.

Work Log Free form field to add activities and
notable events while working on the
request or activity

1 This field's value is only visible to Sugar Serve and Sugar Sell users; when this
field appears on layouts, users without a supported license type will see a
placeholder containing the text "License Required" instead of the field's value. See
the User Management page for more details on license types.

Data Privacy Types

The Data Privacy module includes a Type field that captures the nature of the
privacy event or request. You may wish to add, edit, or remove Type field values in
order to match the kinds of activities and requests you will need to process and
record, according to your organization's needs. 

Three of the out-of-the-box Type values enable additional functionality in the Data
Privacy module. You can edit their display labels, but the Item Name portions of
the following options must remain unchanged in order to retain the full capabilities
of the module:

Item Name* Display Label Functionality Enabled

Request to Erase
Information

Request to Erase
Information

Allows users in the Data
Privacy Manager role to
permanently erase
personal information fields
on records related to the
data privacy record

Consent to Process Consent to Process Enables the "Business
Purposes Consented for"
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field on the data privacy
record

Withdraw Consent Withdraw Consent Enables the "Business
Purposes Consented for"
field on the data privacy
record

* The item names cannot be changed.

For more information about modifying the available type values, refer to the Data
Privacy Guide.

Working With Sugar Modules

While the Data Privacy module has some features that only apply to data privacy
records, it also uses the Sidecar user interface that most Sugar modules are based
on. In the table below, the left column contains links to the User Interface page
covering topics that are applicable to all Sidecar modules. The right column has
links to sections of the current page that cover topics specific to data privacy.

General Instructions for Working
With Sugar Modules

Data-Privacy-Specific Instructions

Use the links below to navigate to the
User Interface page which covers topics
generic to many Sugar modules.

When Data-Privacy-specific help exists
for each topic, use the links below to
navigate to sections of the current page.

Creating Records
Viewing Records
Searching for Records
List View List View Mass Actions Menu

List View Record Actions Menu
Record View Record View Actions Menu
Intelligence Pane
Editing Records
Deleting Records
Exporting Records
Viewing Record Audit Logs
Favoriting Records
Following Records
Sharing Records
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Data Privacy Menus

The Data Privacy module contains various options and functionality which are
available via menus in the module tab, list view, and record view. The following
sections present each menu and its options with links to more information about
each option in the User Interface documentation or, for Data Privacy-specific
functionality, within this page.

Module Tab Menus

The Data Privacy module tab is typically located under the More tab on the
navigation bar at the top of any Sugar screen. Sugar normally displays the top six
modules shown in the Display Modules list of your user preferences with the
remaining displayed modules grouped under the More tab. For more information
on displayed modules for the navigation bar, please refer to the Layout Options
section of the Getting Started documentation.

Note: By default, the Data Privacy module is hidden in Sugar and the system
administrator must enable the module via Admin > Display Modules and
Subpanels. For more information on displaying modules in Sugar, please refer to
the Developer Tools documentation in the Administration Guide.

Click the tab to access the Data Privacy list view. You may also click the triangle in
the Data Privacy module tab to display the Actions, Recently Viewed, and Favorites
menus. The Actions menu allows you to perform important operations within the
module. The Recently Viewed menu displays the list of data privacy activities you
most recently viewed. The Favorites menu displays the list of data privacy
activities you most recently marked as favorites.
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The module tab's Actions menu allows you to perform the following operations:

Menu Item Description
Create Data Privacy Activity Opens the record view layout to create a

new data privacy activity
View Data Privacy Activities Opens the list view layout to search and

display data privacy activities

If you do not see the Data Privacy module tab in Sugar, please check the following:

The Data Privacy module may be marked as hidden in your user
preferences which will prevent the module tab from being displayed.
Navigate to your user profile (upper right of Sugar), click the Advanced
tab, and check the Layout Options section. If you see the Data Privacy
module in the Hide Modules list, simply move it to the Display Modules list.
For more information on hiding and displaying modules, please refer to the 
Layout Options section of the Getting Started documentation.
The administrator may have disabled the Data Privacy module for your
entire Sugar instance. Reach out to your Sugar administrator to have the
Data Privacy module displayed. For more information on displaying and
hiding modules throughout Sugar, please refer to the Developer Tools
documentation in the Administration Guide.

List View Menus

The Data Privacy list view displays all data privacy records and allows for
searching and filtering to locate specific data privacy activities. You can view the
basic details of each record within the field columns of the list view or click a data
privacy activity's name to open the record view. To access a module's list view,
simply click the module's tab in the navigation bar at the top of any Sugar page.

List View Mass Actions Menu

The Mass Actions menu to the right of the checkbox option in the list header
allows you to perform mass actions on all currently selected records. You can use
the checkbox on each record's row to select individual data privacy activities or
click the checkbox in the list header to select all records displayed on the current
set of list view results.
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The Mass Actions menu allows you to perform the following operations:

Menu Item Description
Mass Update Mass update one or more data privacy

records at a time
Export Export one or more data privacy records

to a CSV file

List View Record Actions Menu

The Record Actions menu to the far right of each record's row allows you to
perform actions on the individual data privacy record directly from the list view.

The list view's Record Actions menu allows you to perform the following
operations:

Menu Item Description
Preview (Eye icon) Preview this data privacy in the

intelligence pane
Edit Edit this data privacy

Record View Actions Menu

The Data Privacy record view displays a single data privacy in full detail including
its fields and subpanels of related records. To access a data privacy's record view,
simply click a hyperlinked data privacy name from anywhere within Sugar. The
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record view's Actions menu appears on the top right of the page and allows you to
perform various operations on the current record.

The Actions menu allows you to perform the following operations: 

Menu Item Description
Edit Edit this data privacy
Share Share a link to this data privacy via

email
View Audit Log View a record of changes to this data

privacy

Managing Data Privacy in Sugar

The Data Privacy module is one portion of a feature set aimed at supporting your
ability to carry out your organization's data privacy policies. Sugar's Data Privacy
Guide provides information that spans the entire data privacy feature set and
presents consolidated information and instructions for leveraging these tools to
accomplish your organization's data privacy procedures. This guide will describe
these enhancements, the configuration steps an admin must complete before users
can access the new functionality, as well as provide guidance for end users and
Data Privacy Managers.
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